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Preface

This book is aimed at the reader who wishes to gain a working knowledge of time series
and forecasting methods as applied in economics, engineering, and the natural and
social sciences. Unlike our more advanced book, Time Series: Theory and Methods,
Brockwell and Davis (1991), this one requires only a knowledge of basic calculus,
matrix algebra and elementary statistics at the level, for example, of Mendenhall et al.
(1990). It is intended for upper-level undergraduate students and beginning graduate
students.

The emphasis is on methods and the analysis of data sets. The professional version
of the time series package I'TSM2000, for Windows-based PC, enables the reader to
reproduce most of the calculations in the text (and to analyze further data sets of the
reader’s own choosing). It is available for download, together with most of the data
sets used in the book, from http://extras.springer.com. Appendix E contains a detailed
introduction to the package.

Very little prior familiarity with computing is required in order to use the computer
package. The book can also be used in conjunction with other computer packages for
handling time series. Chapter 14 of the book by Venables and Ripley (2003) describes
how to perform many of the calculations using S and R. The package ITSMR of Weigt
(2015) can be used in R to reproduce many of the features of ITSM2000. The package
Yuima, also for R, can be used for simulation and estimation of the Lévy-driven
CARMA processes discussed in Section 11.5 (see lacus and Mercuri (2015)). Both
of these packages can be downloaded from https://cran.rproject.org/web/packages.

There are numerous problems at the end of each chapter, many of which involve
use of the programs to study the data sets provided.

To make the underlying theory accessible to a wider audience, we have stated some
of the key mathematical results without proof, but have attempted to ensure that the
logical structure of the development is otherwise complete. (References to proofs are
provided for the interested reader.)

There is sufficient material here for a full-year introduction to univariate and
multivariate time series and forecasting. Chapters 1 through 6 have been used for sev-
eral years in introductory one-semester courses in univariate time series at Columbia
University, Colorado State University, and Royal Melbourne Institute of Technology.
The chapter on spectral analysis can be excluded without loss of continuity by readers
who are so inclined.

In view of the explosion of interest in financial time series in recent decades, the
third edition includes a new chapter (Chapter 7) specifically devoted to this topic. Some
of the basic tools required for an understanding of continuous-time financial time series
models (Brownian motion, Lévy processes, and It6 calculus) have also been added as
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Preface

Appendix D, and a new Section 11.5 provides an introduction to continuous parameter
ARMA (or CARMA) processes.

The diskette containing the student version of the package ITSM2000 is no longer
included with the book since the professional version (which places no limit on the
length of the series to be studied) can now be downloaded from http://extras.springer.
com as indicated above. A tutorial for the use of the package is provided as Appendix E
and a searchable file, ITSM_HELP.pdf, giving more detailed instructions, is included
with the package.

We are greatly indebted to the readers of the first and second editions of the book
and especially to Matthew Calder, coauthor of the computer package ITSM2000 and
to Anthony Brockwell, both of whom made many valuable comments and suggestions.
We also wish to thank Colorado State University, Columbia University, the National
Science Foundation, Springer-Verlag, and our families for their continuing support
during the preparation of this third edition.

Fort Collins, CO, USA Peter J. Brockwell
New York, NY, USA Richard A. Davis
April, 2016
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In this chapter we introduce some basic ideas of time series analysis and stochastic
processes. Of particular importance are the concepts of stationarity and the autocovari-
ance and sample autocovariance functions. Some standard techniques are described
for the estimation and removal of trend and seasonality (of known period) from
an observed time series. These are illustrated with reference to the data sets in
Section 1.1. The calculations in all the examples can be carried out using the time
series package ITSM, the professional version of which is available at http://extras.
springer.com. The data sets are contained in files with names ending in .TSM. For
example, the Australian red wine sales are filed as WINE.TSM. Most of the topics
covered in this chapter will be developed more fully in later sections of the book. The
reader who is not already familiar with random variables and random vectors should
first read Appendix A, where a concise account of the required background is given.

1.1 Examples of Time Series

A time series is a set of observations x;, each one being recorded at a specific time 7.
A discrete-time time series (the type to which this book is primarily devoted) is one
in which the set Ty of times at which observations are made is a discrete set, as is the
case, for example, when observations are made at fixed time intervals. Continuous-
time time series are obtained when observations are recorded continuously over some
time interval, e.g., when T, = [0, 1].

© Springer International Publishing Switzerland 2016 1
P.J. Brockwell, R.A. Davis, Introduction to Time Series and Forecasting,
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Chapter 1

Introduction

Figure 1-1
The Australian red wine
sales, Jan. 1980-Oct. 1991

Example 1.1.1

Example 1.1.2

Example 1.1.3

3.0

25

2.0
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(thousands)
1.5

1.0

0.5

I
1980 1982 1984 1986 1988 1990 1992

Australian Red Wine Sales; WINE. TSM

Figure 1-1 shows the monthly sales (in kiloliters) of red wine by Australian winemak-
ers from January 1980 through October 1991. In this case the set T, consists of the
142 times {(Jan. 1980), (Feb. 1980), ...,(Oct. 1991)}. Given a set of n observations
made at uniformly spaced time intervals, it is often convenient to rescale the time axis
in such a way that T becomes the set of integers {1, 2, ..., n}. In the present example
this amounts to measuring time in months with (Jan. 1980) as month 1. Then T is the
set {1, 2, ..., 142}. It appears from the graph that the sales have an upward trend and
a seasonal pattern with a peak in July and a trough in January. To plot the data using
ITSM, run the program by double-clicking on the ITSM icon and then select the option
File>Project>Open>Univariate, click OK, and select the file WINE.TSM.
The graph of the data will then appear on your screen.

O

All-Star Baseball Games, 1933-1995

Figure 1-2 shows the results of the all-star games by plotting x;, where

1 if the National League won in year ¢,
Xy =
—1 if the American League won in year ¢.

This is a series with only two possible values, 1. It also has some missing values,
since no game was played in 1945, and two games were scheduled for each of the
years 1959-1962.

O

Accidental Deaths, U.S.A., 1973-1978; DEATHS.TSM

Like the red wine sales, the monthly accidental death figures show a strong seasonal
pattern, with the maximum for each year occurring in July and the minimum for each
year occurring in February. The presence of a trend in Figure 1-3 is much less apparent
than in the wine sales. In Section 1.5 we shall consider the problem of representing
the data as the sum of a trend, a seasonal component, and a residual term.

g
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Figure 1-2

Results of the

all-star baseball games,
1933-1995

Figure 1-3
The monthly accidental
deaths data, 1973-1978

Example 1.1.4
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A Signal Detection Problem; SIGNAL.TSM

Figure 1-4 shows simulated values of the series

t
Xt=00s<1—0>+Nt, r=1,2,....200,

where {N,} is a sequence of independent normal random variables, with mean 0
and variance 0.25. Such a series is often referred to as signal plus noise, the signal
being the smooth function, S, = cos(ﬁ) in this case. Given only the data X,, how
can we determine the unknown signal component? There are many approaches to
this general problem under varying assumptions about the signal and the noise. One
simple approach is to smooth the data by expressing X; as a sum of sine waves of
various frequencies (see Section 4.2) and eliminating the high-frequency components.
If we do this to the values of {X;} shown in Figure 1-4 and retain only the lowest 3.5 %
of the frequency components, we obtain the estimate of the signal also shown as the
red dashed line in Figure 1-4. The waveform of the signal is quite close to that of the

true signal in this case, although its amplitude is somewhat smaller.
0
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Example 1.1.5 Population of the U.S.A., 1790-1990; USPOP.TSM

The population of the U.S.A., measured at 10-year intervals, is shown in Figure 1-5.
The graph suggests the possibility of fitting a quadratic or exponential trend to the
data. We shall explore this further in Section 1.3.

g

Example 1.1.6  Number of Strikes Per Year in the U.S.A., 1951-1980; STRIKES.TSM

The annual numbers of strikes in the U.S.A. for the years 1951-1980 are shown in
Figure 1-6. They appear to fluctuate erratically about a slowly changing level.
g
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(thousands)

Figure 1-6
Strikes in the
U.S.A., 1951-1980

1.2 Objectives of Time Series Analysis

The examples considered in Section 1.1 are an extremely small sample from the
multitude of time series encountered in the fields of engineering, science, sociology,
and economics. Our purpose in this book is to study techniques for drawing inferences
from such series. Before we can do this, however, it is necessary to set up a hypothetical
probability model to represent the data. After an appropriate family of models has
been chosen, it is then possible to estimate parameters, check for goodness of fit to
the data, and possibly to use the fitted model to enhance our understanding of the
mechanism generating the series. Once a satisfactory model has been developed, it
may be used in a variety of ways depending on the particular field of application.

The model may be used simply to provide a compact description of the data. We
may, for example, be able to represent the accidental deaths data of Example 1.1.3 as
the sum of a specified trend, and seasonal and random terms. For the interpretation
of economic statistics such as unemployment figures, it is important to recognize
the presence of seasonal components and to remove them so as not to confuse
them with long-term trends. This process is known as seasonal adjustment. Other
applications of time series models include separation (or filtering) of noise from signals
as in Example 1.1.4, prediction of future values of a series such as the red wine
sales in Example 1.1.1 or the population data in Example 1.1.5, testing hypotheses
such as global warming using recorded temperature data, predicting one series from
observations of another, e.g., predicting future sales using advertising expenditure data,
and controlling future values of a series by adjusting parameters. Time series models
are also useful in simulation studies. For example, the performance of a reservoir
depends heavily on the random daily inputs of water to the system. If these are modeled
as a time series, then we can use the fitted model to simulate a large number of
independent sequences of daily inputs. Knowing the size and mode of operation
of the reservoir, we can determine the fraction of the simulated input sequences that
cause the reservoir to run out of water in a given time period. This fraction will then be
an estimate of the probability of emptiness of the reservoir at some time in the given
period.
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Introduction

1.3 Some Simple Time Series Models

Definition 1.3.1

Example 1.3.1

An important part of the analysis of a time series is the selection of a suitable proba-
bility model (or class of models) for the data. To allow for the possibly unpredictable
nature of future observations it is natural to suppose that each observation x, is a
realized value of a certain random variable X;.

A time series model for the observed data {x;} is a specification of the joint
distributions (or possibly only the means and covariances) of a sequence of random
variables {X;} of which {x;} is postulated to be a realization.

Remark. We shall frequently use the term time series to mean both the data and the
process of which it is a realization. U

A complete probabilistic time series model for the sequence of random variables
{X1, X5, ...} would specify all of the joint distributions of the random vectors
Xy, ..., X)), n=1,2,..., or equivalently all of the probabilities

PIXi<x,....X, <x,], —00<x|,....,x5, <00, n=1,2,....

Such a specification is rarely used in time series analysis (unless the data are generated
by some well-understood simple mechanism), since in general it will contain far too
many parameters to be estimated from the available data. Instead we specify only the
first- and second-order moments of the joint distributions, i.e., the expected values
EX, and the expected products E(X, 1, X;), t = 1,2,..., h = 0,1,2,..., focusing
on properties of the sequence {X;} that depend only on these. Such properties of {X,}
are referred to as second-order properties. In the particular case where all the joint
distributions are multivariate normal, the second-order properties of {X;} completely
determine the joint distributions and hence give a complete probabilistic characteri-
zation of the sequence. In general we shall lose a certain amount of information by
looking at time series “through second-order spectacles”; however, as we shall see
in Chapter 2, the theory of minimum mean squared error linear prediction depends
only on the second-order properties, thus providing further justification for the use
of the second-order characterization of time series models.

Figure 1-7 shows one of many possible realizations of {S;,# = 1, ..., 200}, where
{S:} is a sequence of random variables specified in Example 1.3.3 below. In most
practical problems involving time series we see only one realization. For example,
there is only one available realization of Fort Collins’s annual rainfall for the years
1900-1996, but we imagine it to be one of the many sequences that might have
occurred. In the following examples we introduce some simple time series models.
One of our goals will be to expand this repertoire so as to have at our disposal a broad
range of models with which to try to match the observed behavior of given data sets.

1.3.1 Some Zero-Mean Models
iid Noise
Perhaps the simplest model for a time series is one in which there is no trend or seasonal

component and in which the observations are simply independent and identically
distributed (iid) random variables with zero mean. We refer to such a sequence
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of random variables X, X5, ... as iid noise. By definition we can write, for any
positive integer n and real numbers x1, . . ., X,

PIXy <xi,..., Xy =] = PIXy <]+ PIXy < x,] = F(xy) -+ - F(x),
where F(-) is the cumulative distribution function (see Section A.1) of each of
the identically distributed random variables X;, X5, .... In this model there is no
dependence between observations. In particular, for all 4 > 1 and all x, xq, ..., x,,

P[Xn+h =< X|X1 = X1y aXn = xn] = P[Xn—i-h =< x],
showing that knowledge of X, ..., X, is of no value for predicting the behavior of
X, Given the values of X1, ..., X,, the function f that minimizes the mean squared

Example 1.3.2

Example 1.3.3

error E [(X,,+h —f(Xq,..., X,,))z] is in fact identically zero (see Problem 1.2). Although
this means that iid noise is a rather uninteresting process for forecasters, it plays an

important role as a building block for more complicated time series models.
g

A Binary Process

As an example of iid noise, consider the sequence of iid random variables {X;,t =
1,2,...,} with

PIX;=1l=p, PIXi=-11=1-p,

where p = % The time series obtained by tossing a penny repeatedly and scoring +1
for each head and —1 for each tail is usually modeled as a realization of this process.
A priori we might well consider the same process as a model for the all-star baseball
games in Example 1.1.2. However, even a cursory inspection of the results from 1963—
1982, which show the National League winning 19 of 20 games, casts serious doubt
on the hypothesis P[X, = 1] = %

g

Random Walk

The random walk {S;,t = 0, 1, 2, ...} (starting at zero) is obtained by cumulatively
summing (or “integrating”) iid random variables. Thus a random walk with zero mean
is obtained by defining Sy = 0 and

S=X1+Xo+---+X,, fort=1,2,...,

where {X;} is iid noise. If {X;} is the binary process of Example 1.3.2, then {S;,t =
0,1,2,...,}is called a simple symmetric random walk. This walk can be viewed
as the location of a pedestrian who starts at position zero at time zero and at each
integer time tosses a fair coin, stepping one unit to the right each time a head appears
and one unit to the left for each tail. A realization of length 200 of a simple symmetric
random walk is shown in Figure 1-7. Notice that the outcomes of the coin tosses can
be recovered from {S;, t = 0, 1, ...} by differencing. Thus the result of the 7th toss can
be found from §; — S;_; = X,.

O

1.3.2 Models with Trend and Seasonality

In several of the time series examples of Section 1.1 there is a clear trend in the data.
An increasing trend is apparent in both the Australian red wine sales (Figure 1-1) and
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Figure 1-7

One realization of a sim-
ple random walk {S¢,t =
0,1,2,...,200}

Example 1.3.4
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the population of the U.S.A. (Figure 1-5). In both cases a zero-mean model for the data
is clearly inappropriate. The graph of the population data, which contains no apparent
periodic component, suggests trying a model of the form

X, =m; + Y,

where m;, is a slowly changing function known as the trend component and Y, has
zero mean. A useful technique for estimating m; is the method of least squares (some
other methods are considered in Section 1.5).

In the least squares procedure we attempt to fit a parametric family of functions,

e.g.

m; =a0+a1t+a2t2, (1.3.1)

to the data {x, ..., x,,} by choosing the parameters, in this illustration ay, a;, and a,, to
minimize ) _, (x, — m;,)?. This method of curve fitting is called least squares regres-
sion and can be carried out using the program ITSM and selecting the Regression
option.

Population of the U.S.A., 1790-1990

To fit a function of the form (1.3.1) to the population data shown in Figure 1-5 we
relabel the time axis so that + = 1 corresponds to 1790 and r = 21 corresponds
to 1990. Run ITSM, select File>Project>Open>Univariate, and open the
file USPOP.TSM. Then select Regression>Specify, choose Polynomial
Regression with order equal to 2, and click OK. Finally, selecting the option
Regression>Estimations>Least Squares, gives the following estimated
parameter values in the model (1.3.1):

ao = 6.9579 x 10°,
a; = —2.1599 x 10°,
and

a, = 6.5063 x 10°.
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Example 1.3.5
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A graph of the fitted function is shown with the original data in Figure 1-8. The
estimated values of the noise process Y;, 1 < ¢t < 21, are the residuals obtained by
subtraction of 7, = ag + a;t + a,t* from x,.

The estimated trend component 7, furnishes us with a natural predictor of future
values of X,. For example, if we estimate the noise Y, by its mean value, i.e., zero,
then (1.3.1) gives the estimated U.S. population for the year 2000 as

My = 6.9579 x 10 — 2.1599 x 10° x 22 4 6.5063 x 10° x 227 = 274.35 x 10°.

However, if the residuals {Y;} are highly correlated, we may be able to use their values
to give a better estimate of Y5, and hence of the population X»; in the year 2000.
g

Level of Lake Huron 1875-1972; LAKE.DAT

A graph of the level in feet of Lake Huron (reduced by 570) in the years 1875-1972
is displayed in Figure 1-9. Since the lake level appears to decline at a roughly linear
rate, ITSM was used to fit a model of the form

X, =ap+ajt+Y, t=1,...,98 (1.3.2)

(with the time axis relabeled as in Example 1.3.4). The least squares estimates of the
parameter values are

ap=10.202 and a; = —0.0242.

(The resulting least squares line, ap+a;t, is also displayed in Figure 1-9.) The estimates
of the noise, Y;, in the model (1.3.2) are the residuals obtained by subtracting the
least squares line from x, and are plotted in Figure 1-10. There are two interesting
features of the graph of the residuals. The first is the absence of any discernible trend.
The second is the smoothness of the graph. (In particular, there are long stretches of
residuals that have the same sign. This would be very unlikely to occur if the residuals
were observations of iid noise with zero mean.) Smoothness of the graph of a time
series is generally indicative of the existence of some form of dependence among the
observations.

Such dependence can be used to advantage in forecasting future values of the
series. If we were to assume the validity of the fitted model with iid residuals {Y;}, then
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Figure 1-9

Level of Lake Huron
1875-1972 showing the
line fitted by least squares

Figure 1-10

Residuals from fitting a line
to the Lake Huron

data in Figure 1-9
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the minimum mean squared error predictor of the next residual (Yq99) would be zero
(by Problem 1.2). However, Figure 1-10 strongly suggests that Yo will be positive.
How then do we quantify dependence, and how do we construct models
for forecasting that incorporate dependence of a particular type? To deal with
these questions, Section 1.4 introduces the autocorrelation function as a measure
of dependence, and stationary processes as a family of useful models exhibiting a
wide variety of dependence structures.
O

Harmonic Regression

Many time series are influenced by seasonally varying factors such as the weather,
the effect of which can be modeled by a periodic component with fixed known period.
For example, the accidental deaths series (Figure 1-3) shows a repeating annual pattern
with peaks in July and troughs in February, strongly suggesting a seasonal factor with
period 12. In order to represent such a seasonal effect, allowing for noise but assuming
no trend, we can use the simple model,
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Example 1.3.6

Figure 1-11

The estimated harmonic
component of the
accidental deaths

data from ITSM

X, =s5+Y,

where s, is a periodic function of ¢ with period d (s;—_ys = s;). A convenient choice for
s; s a sum of harmonics (or sine waves) given by

k
si=ao+ Y _(gjcos(ht) + by sin(a;h)), (1.3.3)
j=1
where ay, ai, ..., a; and by, . .., by are unknown parameters and A4, ..., A; are fixed

frequencies, each being some integer multiple of 27 /d. To carry out harmonic regres-
sion using ITSM, select Regression>Specify, and check the two boxes,
Include intercept termand Harmonic Regression. Then specify the
number of harmonics [k in equation (1.3.3)] and enter k integer-valued Fourier indices
fi, ..., fx. For a sine wave with period d, set fi = n/d, where n is the number of
observations in the time series. (If n/d is not an integer, you will need to delete a few
observations from the beginning of the series to make it so.) The other k — 1 Fourier
indices should be positive integer multiples of the first, corresponding to harmonics
of the fundamental sine wave with period d. Thus to fit a single sine wave with
period 365 to 365 daily observations we would choose k=1 and f; = 1. To fit a linear
combination of sine waves with periods 365/j,j=1, ..., 4, we would choose k =4 and
fi=J,j=1,...,4. Once k and the frequencies fi, ..., f; have been specified, click
OK and then select Regression>Estimation>Least Squares to obtain the
required coefficients. To see how well the fitted function matches the data, select
Regression>Show fit.

Accidental Deaths

To fit a sum of two harmonics with periods 12 months and 6 months to the monthly
accidental deaths data xy, ..., x, with n = 72, we choose k = 2, fj = n/12 = 6, and
f» = n/6 = 12. Using ITSM as described above, we obtain the fitted function shown
in Figure 1-11. As can be seen from the figure, the periodic character of the series is
captured reasonably well by this fitted function. In practice, it is worth experimenting
with several different combinations of harmonics in order to find a satisfactory estimate
of the seasonal component. The program ITSM also allows fitting a linear combination

10 11

(thousands)
9
T

1973 1974 1975 1976 1977 1978
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of harmonics and polynomial trend by checking both Harmonic Regression
and Polynomial Regressioninthe Regression>Specificationdialog
box. Other methods for dealing with seasonal variation in the presence of trend are
described in Section 1.5.

O

1.3.3 A General Approach to Time Series Modeling

The examples of the previous section illustrate a general approach to time series
analysis that will form the basis for much of what is done in this book. Before
introducing the ideas of dependence and stationarity, we outline this approach to
provide the reader with an overview of the way in which the various ideas of this
chapter fit together.

* Plot the series and examine the main features of the graph, checking in particular
whether there is
(a) atrend,
(b) a seasonal component,
(c) any apparent sharp changes in behavior,
(d) any outlying observations.

¢ Remove the trend and seasonal components to get stationary residuals (as defined
in Section 1.4). To achieve this goal it may sometimes be necessary to apply
a preliminary transformation to the data. For example, if the magnitude of the
fluctuations appears to grow roughly linearly with the level of the series, then
the transformed series {InXj, ..., InX,} will have fluctuations of more constant
magnitude. See, for example, Figures 1-1 and 1-17. (If some of the data are
negative, add a positive constant to each of the data values to ensure that all
values are positive before taking logarithms.) There are several ways in which
trend and seasonality can be removed (see Section 1.5), some involving estimating
the components and subtracting them from the data, and others depending on
differencing the data, i.e., replacing the original series {X;} by {¥; := X, — X,_4}
for some positive integer d. Whichever method is used, the aim is to produce a
stationary series, whose values we shall refer to as residuals.

* Choose a model to fit the residuals, making use of various sample statistics
including the sample autocorrelation function to be defined in Section 1.4.

* Forecasting will be achieved by forecasting the residuals and then inverting the
transformations described above to arrive at forecasts of the original series {X;}.

* An extremely useful alternative approach touched on only briefly in this book is to
express the series in terms of its Fourier components, which are sinusoidal waves
of different frequencies (cf. Example 1.1.4). This approach is especially important
in engineering applications such as signal processing and structural design. It is
important, for example, to ensure that the resonant frequency of a structure does
not coincide with a frequency at which the loading forces on the structure have a
particularly large component.
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1.4 Stationary Models and the Autocorrelation Function

Definition 1.4.1

Definition 1.4.2

Definition 1.4.3

Loosely speaking, a time series {X;, t=0, 1, ...} is said to be stationary if it has sta-
tistical properties similar to those of the “time-shifted” series {X;,,,t = 0, £1, ...},
for each integer h. Restricting attention to those properties that depend only on the
first- and second-order moments of {X;}, we can make this idea precise with the
following definitions.

Let {X;} be a time series with £ (X,z) < 00. The mean function of {X;} is

px(t) = E(X;).

The covariance function of {X;} is

yx(r, 5) = Cov(Xy, Xy) = E[(X, — ux () (Xs — px(s))]

for all integers r and s.

{X;} is (weakly) stationary if
(1) ux(r) is independent of ¢,
and

(1) yx(t + h, 1) is independent of ¢ for each h.

Remark 1. Strict stationarity of a time series {X;,¢ = 0, &1, ...} is defined by the
condition that (X, ..., X,,) and (X144, ..., X,4s) have the same joint distributions for
all integers i and n > 0. It is easy to check that if {X,} is strictly stationary and EX? <
oo for all 7, then {X;} is also weakly stationary (Problem 1.3). Whenever we use the
term stationary we shall mean weakly stationary as in Definition 1.4.2, unless we
specifically indicate otherwise. U

Remark 2. In view of condition (ii), whenever we use the term covariance function
with reference to a stationary time series {X;} we shall mean the function yy of one
variable, defined by

vx(h) :=yx(h,0) = yx(t + h, 1).

The function yx(-) will be referred to as the autocovariance function and yx(h) as its
value at lag h. ]

Let {X;} be a stationary time series. The autocovariance function (ACVF) of
{X;} atlag h is

yx(h) = Cov(Xpip, Xy).
The autocorrelation function (ACF) of {X,} at lag & is

yx(h)

h) =
px (h) 2 (0)

= Cor(XT"l‘ha Xl‘)
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Example 1.4.1

Example 1.4.2

Example 1.4.3

In the following examples we shall frequently use the easily verified linearity prop-
erty of covariances, that if EX?> < oo, EY? < 0o, EZ?> < oo and a, b, and c are any
real constants, then

Cov(aX +bY +c¢,Z) =aCov(X,Z) + bCov(Y, Z).

iid Noise
If {X;} is iid noise and E(th) = 02 < oo, then the first requirement of Def-
inition 1.4.2 is obviously satisfied, since E(X;) = O for all . By the assumed
independence,
o2, ifh=0,
yx(t+h, 1) =
0, ifh#0,

which does not depend on . Hence iid noise with finite second moment is stationary.
We shall use the notation

{X;} ~1ID (0, o)

to indicate that the random variables X; are independent and identically distributed

random variables, each with mean 0 and variance o2.

O
White Noise

If {X,} is a sequence of uncorrelated random variables, each with zero mean and
variance o2, then clearly {X,} is stationary with the same covariance function as the
iid noise in Example 1.4.1. Such a sequence is referred to as white noise (with mean
0 and variance o?). This is indicated by the notation

{X;} ~WN(0,0%).

Clearly, every IID (0, 02) sequence is WN(O, 02) but not conversely (see Problem 1.8
and the ARCH(1) process of Section 11.3).

O
The Random Walk

If {S;} is the random walk defined in Example 1.3.3 with {X,} as in Example 1.4.1,
then ES; = 0, E(Stz) = to? < oo for all ¢, and, for h > 0,
ys(t+ h, t) = Cov(Siin, St)
= Cov(S; + Xipq + -+ + Xen, S1)
= Cov(S;, S;)
= to”.

Since ys(t + h, t) depends on ¢, the series {S;} is not stationary.
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Example 1.4.4

Example 1.4.5

First-Order Moving Average or MA(1) Process
Consider the series defined by the equation
Xt:Zt+GZt_1, t:(),:i:l,..., (1.4.1)

where {Z,} ~ WN (0, 02) and 0 is a real-valued constant. From (1.4.1) we see that
EX, =0, EXI2 =0?(1 +6%) < oo, and

o2 (1+6%), ifh=0,
yx(t+h, 1) = { o?0, ifh =41,
0, if |h] > 1.

Thus the requirements of Definition 1.4.2 are satisfied, and {X,} is stationary. The
autocorrelation function of {X,} is

1, if h =0,
ox(h) =416/ (1+92), if h =+£1, (1.4.2)
0, if |h| > 1.
g
First-Order Autoregression or AR(1) Process
Let us assume now that {X,} is a stationary series satisfying the equations
X=X, 1+ 7, t=0,%1,..., (1.4.3)

where {Z,} ~ WN(0, 62), |¢| < 1, and Z, is uncorrelated with X, for each s < ¢. (We
shall show in Section 2.2 that there is in fact exactly one such solution of (1.4.3).) By
taking expectations on each side of (1.4.3) and using the fact that EZ, = 0, we see at
once that

EXt - 0

To find the autocorrelation function of {X;} we multiply each side of (1.4.3) by X,_,,
(h > 0) and then take expectations to get

yx(h) = Cov(X;, X;—n)
= Cov(¢X,_1, X;—p) + Cov(Z;, X;—p)
=¢yx(h—1) + 0= =¢"y,(0).

Observing that y (h) = y (—h) and using Definition 1.4.3, we find that

_ nx®
— yx(0)
It follows from the linearity of the covariance function in each of its arguments and
the fact that Z, is uncorrelated with X,_ that

yx(0) = Cov(X,, X;) = Cov(¢X,_1 + Z, $X,—1 + Z) = ¢*yx(0) + o>
and hence that yx(0) = 02/ (1 — ¢2).

ox(h) =¢", h=0+I1,....
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Definition 1.4.4

Example 1.4.6

1.4.1 The Sample Autocorrelation Function

Although we have just seen how to compute the autocorrelation function for a few
simple time series models, in practical problems we do not start with a model, but
with observed data {x1, x,, ..., x,}. To assess the degree of dependence in the data
and to select a model for the data that reflects this, one of the important tools we use
is the sample autocorrelation function (sample ACF) of the data. If we believe that
the data are realized values of a stationary time series {X,}, then the sample ACF will
provide us with an estimate of the ACF of {X,}. This estimate may suggest which of
the many possible stationary time series models is a suitable candidate for representing
the dependence in the data. For example, a sample ACF that is close to zero for all
nonzero lags suggests that an appropriate model for the data might be iid noise. The
following definitions are natural sample analogues of those for the autocovariance and
autocorrelation functions given earlier for stationary time series models.

Let xy, ..., x, be observations of a time series. The sample mean of xy, ..., x;, is
1 n
xX= - E Xt.
n
=1

The sample autocovariance function is
n—|h|
y(h) ==n"" Z Xppip) = X)(x; —X), —n<h<n.
t=1
The sample autocorrelation function is
y (h)

oh)="—=, -—-n<h<n.
Y (0)

Remark 3. Forh > 0, y (h) is approximately equal to the sample covariance of the n—
h pairs of observations (x1, xi41), (X2, X244), - - . » (Xu—p, X,). The difference arises from
use of the divisor n instead of n — & and the subtraction of the overall mean, x, from
each factor of the summands. Use of the divisor n ensures that the sample covariance
matrix I',, := [y (i — DIF =1 is nonnegative definite (see Section 2.4.2).

Remark 4. Like the sample covariance matrix defined in Remark 3, the sample
correlation matrix R, := [p(i — DI =1 is nonnegative definite. Each of its diagonal
elements is equal to 1, since p(0) = 1. ]

Figure 1-12 shows a simulated sequence of 200 iid normal random variables with
mean 0 and variance 1 (called an IID N(O, 1) sequence). Figure 1-13 shows the
corresponding sample autocorrelation function atlags 0, 1, ..., 40. Since p (h) = O for
h > 0, one would also expect the corresponding sample autocorrelations to be near 0. It
can be shown, in fact, that for iid noise with finite variance, the sample autocorrelations
o(h), h > 0, are approximately IID N(0, 1/n) for n large (see Brockwell and
Davis (1991) p. 222). Hence, approximately 95 % of the sample autocorrelations
should fall between the bounds £1.96/./n (since 1.96 is the 0.975 quantile of the
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Figure 1-12
200 simulated values of [ID
N(O,1) noise

Figure 1-13

The sample autocorrelation
function for the data of
Figure 1-12 showing the
bounds +1.96/./n
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standard normal distribution). Therefore, in Figure 1-13 we would expect roughly
40(0.05) = 2 values to fall outside the bounds. To simulate IID N(0O, 1) noise in
ITSM, select File>Project>New>Univariate then Model>Simulate. In
the resulting dialog box, enter 200 for the required Number of Observations.
(The remaining entries in the dialog box can be left as they are, since the model
assumed by ITSM, until you enter another, is IID N(O, 1) noise. If you wish to
reproduce exactly the same sequence at a later date, record the Random Number
Seed for later use. By specifying different values for the random number seed you can
generate independent realizations of your time series.) Click on OK and you will see the
graph of your simulated series. To see its sample autocorrelation function together with
the autocorrelation function of the model that generated it, click on the third yellow
button at the top of the screen and you will see the two graphs superimposed (with the
latter in red.) The horizontal lines on the graph are the bounds +1.96/./n.

0
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Figure 1-14

The sample autocorrelation
function for the Australian
red wine sales showing the
bounds +1.96/./n
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Remark 5. The sample autocovariance and autocorrelation functions can be com-
puted for any data set {xi,...,x,} and are not restricted to observations from a
stationary time series. For data containing a trend, | (k)| will exhibit slow decay as
h increases, and for data with a substantial deterministic periodic component, |5 (k)]
will exhibit similar behavior with the same periodicity. (See the sample ACF of the
Australian red wine sales in Figure 1-14 and Problem 1.9.) Thus p(-) can be useful as
an indicator of nonstationarity (see also Section 6.1). ]

1.4.2 A Model for the Lake Huron Data

As noted earlier, an iid noise model for the residuals { yy, ..., yog} obtained by fitting
a straight line to the Lake Huron data in Example 1.3.5 appears to be inappropriate.
This conclusion is confirmed by the sample ACF of the residuals (Figure 1-15), which
has three of the first 40 values well outside the bounds -1.96/ A/98.

The roughly geometric decay of the first few sample autocorrelations (with
o(h+ 1)/p(h) = 0.7) suggests that an AR(1) series (with ¢ ~ 0.7) might pro-
vide a reasonable model for these residuals. (The form of the ACF for an AR(1) process
was computed in Example 1.4.5.)

To explore the appropriateness of such a model, consider the points (yq, y2),
(¥2,53), .., (Y97, Yo3) plotted in Figure 1-16. The graph does indeed suggest a linear
relationship between y, and y,_;. Using simple least squares estimation to fit a straight
line of the form y, = ay,_;, we obtain the model

Yt == 0'791Yt—1 + Zl’ (1.4.4)

where {Z,} is iid noise with variance Z?ﬁz(y, —0.791y,_1)?/97 = 0.5024. The sample
ACF of the estimated noise sequence z;, = y, — 0.791y,_;,t = 2, ..., 98, is slightly
outside the bounds £1.96/ V97 at lag 1 (6(1) = 0.216), but it is inside the bounds for
all other lags up to 40. This check that the estimated noise sequence is consistent with
the iid assumption of (1.4.3) reinforces our belief in the fitted model. More goodness
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Figure 1-15

The sample autocorrelation
function for the Lake
Huron residuals of

Figure 1-10 showing the
bounds +1.96/./n

Figure 1-16

Scatter plot of (yi—1, yt),
t=2,...,98,

for the data in Figure 1-10
showing the least squares
regression line y = 0.791x
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of fit tests for iid noise sequences are described in Section 1.6. The estimated noise
sequence {z;} in this example passes them all, providing further support for the model
(1.4.3).

A better fit to the residuals in equation (1.3.2) is provided by the second-order
autoregression

Yi=¢1Yi1 +dY, 0 + 27, (1.4.5)

where {Z,} is iid noise with variance o'2. This is analogous to a linear model in which Y,
is regressed on the previous two values Y, and Y, , of the time series. The least
squares estimates of the parameters ¢; and ¢,, found by minimizing 2?23( v —
P1yi—1 — ¢ayin)?, are ¢ = 1.002 and ¢ = —0.2834. The estimate of o2 is
62 =3 (= P1yi_1 — Payi2)?/96 = 0.4460, which is approximately 11 % smaller
than the estimate of the noise variance for the AR(1) model (1.4.3). The improved fit
is indicated by the sample ACF of the estimated residuals, y, — qAﬁl Vi1 — ¢A>2y,,2, which
falls well within the bounds +1.96/+/96 for all lags up to 40.
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1.5 Estimation and Elimination of Trend and Seasonal Components

Figure 1-17
The natural logarithms
of the red wine data

The first step in the analysis of any time series is to plot the data. If there are any
apparent discontinuities in the series, such as a sudden change of level, it may be
advisable to analyze the series by first breaking it into homogeneous segments. If
there are outlying observations, they should be studied carefully to check whether
there is any justification for discarding them (as for example if an observation has
been incorrectly recorded). Inspection of a graph may also suggest the possibility
of representing the data as a realization of the process (the classical decomposition
model)

Xi=m+s+Y, (1.5.1)

where m;, is a slowly changing function known as a trend component, s; is a function
with known period d referred to as a seasonal component, and Y; is a random noise
component that is stationary in the sense of Definition 1.4.2. If the seasonal and noise
fluctuations appear to increase with the level of the process, then a preliminary trans-
formation of the data is often used to make the transformed data more compatible
with the model (1.5.1). Compare, for example, the red wine sales in Figure 1-1 with
the transformed data, Figure 1-17, obtained by applying a logarithmic transformation.
The transformed data do not exhibit the increasing fluctuation with increasing level
that was apparent in the original data. This suggests that the model (1.5.1) is more
appropriate for the transformed than for the original series. In this section we shall
assume that the model (1.5.1) is appropriate (possibly after a preliminary transforma-
tion of the data) and examine some techniques for estimating the components m;, s;,
and Y, in the model.

Our aim is to estimate and extract the deterministic components m, and s; in the
hope that the residual or noise component Y; will turn out to be a stationary time series.
We can then use the theory of such processes to find a satisfactory probabilistic model
for the process Y;, to analyze its properties, and to use it in conjunction with m, and s,
for purposes of prediction and simulation of {X;}.

Another approach, developed extensively by Box and Jenkins (1976), is to apply
differencing operators repeatedly to the series {X,} until the differenced observations
resemble a realization of some stationary time series {W,}. We can then use the theory
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of stationary processes for the modeling, analysis, and prediction of {W,} and hence
of the original process. The various stages of this procedure will be discussed in detail
in Chapters 5 and 6.

The two approaches to trend and seasonality removal, (1) by estimation of m, and s;
in (1.5.1) and (2) by differencing the series {X,}, will now be illustrated with reference
to the data introduced in Section 1.1.

1.5.1 Estimation and Elimination of Trend in the Absence of Seasonality

In the absence of a seasonal component the model (1.5.1) becomes the following.

Nonseasonal Model with Trend:
Xt=mt+Yt, t=1,...,”l, (152)
where EY; = 0.

(If EY, # 0, then we can replace m, and Y; in (1.5.2) with m, + EY, and Y; — EY,,
respectively.)

Method 1: Trend Estimation

Moving average and spectral smoothing are essentially nonparametric methods for
trend (or signal) estimation and not for model building. Special smoothing filters can
also be designed to remove periodic components as described under Method S1 below.
The choice of smoothing filter requires a certain amount of subjective judgment, and
it is recommended that a variety of filters be tried in order to get a good idea of the
underlying trend. Exponential smoothing, since it is based on a moving average of past
values only, is often used for forecasting, the smoothed value at the present time being
used as the forecast of the next value.

To construct a model for the data (with no seasonality) there are two
general approaches, both available in ITSM. One is to fit a polynomial trend
(by least squares) as described in Method 1(d) below, then to subtract the fitted trend
from the data and to find an appropriate stationary time series model for the residuals.
The other is to eliminate the trend by differencing as described in Method 2 and then to
find an appropriate stationary model for the differenced series. The latter method has
the advantage that it usually requires the estimation of fewer parameters and does not
rest on the assumption of a trend that remains fixed throughout the observation period.
The study of the residuals (or of the differenced series) is taken up in Section 1.6.

(a) Smoothing with a finite moving average filter. Let g be a nonnegative integer
and consider the two-sided moving average

q
W,=Qq+ 1! Z‘ X, (1.5.3)
Jj==q

of the process {X,} defined by (1.5.2). Thenforg+1 <t <n—gq,

q q
Wi=Qq+ D' Y m+ Qg+ D7 Y Y ~m, (15.4)

J=—q J=—q

assuming that m;, is approximately linear over the interval [t — g, t 4+ ¢] and that the
average of the error terms over this interval is close to zero (see Problem 1.11).
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The moving average thus provides us with the estimates

q
m=Qq+1)"' Y Xy, q+1<t<n—gq (1.5.5)
j=—q
Since X, is not observed for t < 0 or r > n, we cannot use (1.5.5) for t < ¢ or
t > n — g. The program ITSM deals with this problem by defining X, := X; for
t<land X; =X, fort > n.

The result of applying the moving-average filter (1.5.5) with ¢ = 2 to the strike data
of Figure 1-6 is shown in Figure 1-18. The estimated noise terms f’, = X, — m, are
shown in Figure 1-19. As expected, they show no apparent trend. To apply this filter
using ITSM, open the project STRIKES.TSM, select Smooth>Moving Average,
specify 2 for the filter order, and enter the weights 1,1,1 for Theta(0), Theta(1),
and Theta(2) (these are automatically normalized so that the sum of the weights is
one). Then click OK.

0
It is useful to think of {/;} in (1.5.5) as a process obtained from {X;} by application
of a linear operator or linear filter i, = Y . _ a;X,; with weights a; = (2q +

1)~!, —g < j < q. This particular filter is a low-pass filter in the sense that it takes the
data {X;} and removes from it the rapidly fluctuating (or high frequency) component
{IA/ .} to leave the slowly varying estimated trend term {r7,} (see Figure 1-20).

The particular filter (1.5.5) is only one of many that could be used for smoothing.
For large g, provided that (2¢ + 1)~! ;1:_ o Yi—j = 0, it not only will attenuate noise
but at the same time will allow linear trend functions m, = ¢y + c;t to pass without
distortion (see Problem 1.11). However, we must beware of choosing ¢ to be too large,
since if m, is not linear, the filtered process, although smooth, will not be a good
estimate of m,. By clever choice of the weights {a;} it is possible (see Problems 1.12—
1.14 and Section 4.3) to design a filter that will not only be effective in attenuating
noise in the data, but that will also allow a larger class of trend functions (for example
all polynomials of degree less than or equal to 3) to pass through without distortion.
The Spencer 15-point moving average is a filter that passes polynomials of degree 3
without distortion. Its weights are

a=0, |[jl>7,
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Figure 1-19
Residuals ¥; = X; — Ay after
subtracting the
5-term moving average from
the strike data

Figure 1-20
Smoothing with a low-pass
linear filter
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with
a=a, |jI=T,
and
1
lag, a1, ...,a7] = %[74, 67,46,21,3, -5, —6, —3]. (1.5.6)

Applied to the process (1.5.2) with m, = ¢y + ¢t + oof? + o3t it gives

7 7 7 7
E aX,_j= E ajm;_; + E a;Y;_; E ajm;_j = my,

=7 =7 =7 =7

where the last step depends on the assumed form of m;, (Problem 1.12). Further details
regarding this and other smoothing filters can be found in Kendall and Stuart (1976,

Chapter 46).
(b) Exponential smoothing. For any fixed « € [0, 1], the one-sided moving
averages my, t = 1, ..., n, defined by the recursions
m=aX,+ (1 —o)m_y, t=2,...,n, (1.5.7)
and
m; = X, (1.5.8)

can be computed using ITSM by selecting Smooth>Exponential and specifying
the value of «. Application of (1.5.7) and (1.5.8) is often referred to as exponential
smoothing, since the recursions imply that for ¢t > 2, m;, = Z]’;g a(l — ayX,; +
(1 — a)~'X;, a weighted moving average of X;, X,_1, ..., with weights decreasing
exponentially (except for the last one).

(c) Smoothing by elimination of high-frequency components. The option

Smooth>FFT in the program ITSM allows us to smooth an arbitrary series
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by elimination of the high-frequency components of its Fourier series expansion
(see Section 4.2). This option was used in Example 1.1.4, where we chose to retain
the fraction f = 0.035 of the frequency components of the series in order to estimate
the underlying signal. (The choice f = 1 would have left the series unchanged.)

In Figures 1-21 and 1-22 we show the results of smoothing the strike data by ex-
ponential smoothing with parameter « = 0.4 [see (1.5.7)] and by high-frequency
elimination with f = 0.4, i.e., by eliminating a fraction 0.6 of the Fourier components
at the top of the frequency range. These should be compared with the simple 5-term
moving average smoothing shown in Figure 1-18. Experimentation with different
smoothing parameters can easily be carried out using the program ITSM. The expo-
nentially smoothed value of the last observation is frequently used to forecast the next
data value. The program automatically selects an optimal value of « for this purpose
if « is specified as —1 in the exponential smoothing dialog box.

O



1.5

Estimation and Elimination of Trend and Seasonal Components 25

Example 1.5.3

(d) Polynomial fitting. In Section 1.3.2 we showed how a trend of the form
m, = ay + at + a,t* can be fitted to the data {xi, ..., x,} by choosing the parameters
ap, a1, and a, to minimize the sum of squares, Z:':l(x, — my)? (see Example 1.3.4).
The method of least squares estimation can also be used to estimate higher-order
polynomial trends in the same way. The Regression option of ITSM allows least
squares fitting of polynomial trends of order up to 10 (together with up to four
harmonic terms; see Example 1.3.6). It also allows generalized least squares estimation
(see Section 6.6), in which correlation between the residuals is taken into account.

1.5.1.1 Method 2: Trend Elimination by Difterencing

Instead of attempting to remove the noise by smoothing as in Method 1, we now
attempt to eliminate the trend term by differencing. We define the lag-1 difference
operator V by

VX, =X, — X,_.1 = (1 - B)X, (1.5.9)
where B is the backward shift operator,
BX; = X;_;1. (1.5.10)

Powers of the operators B and V are defined in the obvious way, i.e., B/(X,) = Xi—j
and V/(X,) = V(V(X)), j > 1, with V°(X,) = X,. Polynomials in B and V are
manipulated in precisely the same way as polynomial functions of real variables. For
example,

VX, = V(V(X)) = (1 — B)(1 — B)X, = (1 — 2B + B*)X,

= Xl - 2Xt—l + XI—Z‘

If the operator V is applied to a linear trend function m, = ¢y + ct, then we obtain the
constant function Vm, = m, — m;_; = co + c1t — (co + c1(t — 1)) = c;. In the same
way any polynomial trend of degree k can be reduced to a constant by application of
the operator V* (Problem 1.10). For example, if X; = m, + Y,, where m, = Zﬁ:o cjt-/
and Y, is stationary with mean zero, application of V* gives

V*X, = klc, + VFY,,

a stationary process with mean k!c,. These considerations suggest the possibility,
given any sequence {x,} of data, of applying the operator V repeatedly until we find
a sequence {kat} that can plausibly be modeled as a realization of a stationary
process. It is often found in practice that the order k of differencing required is quite
small, frequently one or two. (This relies on the fact that many functions can be
well approximated, on an interval of finite length, by a polynomial of reasonably low
degree.)

Applying the operator V to the population values {x,,t = 1, ..., 20} of Figure 1-5, we
find that two differencing operations are sufficient to produce a series with no apparent
trend. (To do the differencing in ITSM, select Transform>Difference,enter the
value 1 for the differencing lag, and click OK.) This replaces the original series {x;}
by the once-differenced series {x; — x,_;}. Repetition of these steps gives the twice-
differenced series V2x, = x, — 2%, + X;_2, plotted in Figure 1-23. Notice that the
magnitude of the fluctuations in V2x, increases with the value of x,. This effect can be
suppressed by first taking natural logarithms, y, = In x;, and then applying the operator
V2 to the series {y,}. (See also Figures 1-1 and 1-17.)

g
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Figure 1-23

The twice-differenced series
derived from the population
data of Figure 1-5
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1.5.2 Estimation and Elimination of Both Trend and Seasonality

The methods described for the estimation and elimination of trend can be adapted in
a natural way to eliminate both trend and seasonality in the general model, specified
as follows.

Classical Decomposition Model
X;=m+s,+Y, t=1,...,n, (1.5.11)

where EY, =0, s.4=13s5;, and 27:1 s; = 0.

We shall illustrate these methods with reference to the accidental deaths data of
Example 1.1.3, for which the period d of the seasonal component is clearly 12.

1.5.2.1 Method S1: Estimation of Trend and Seasonal Components
The method we are about to describe is used in the Transform>Classical option
of ITSM.

Suppose we have observations {xi, ..., x,}. The trend is first estimated by app-
lying a moving average filter specially chosen to eliminate the seasonal component
and to dampen the noise. If the period d is even, say d = 2q, then we use

my = (0.5%_g + X—gy1 + - - + Xppg—1 +0.5x,49)/d, g <t<n—gq. (1.5.12)

If the period is odd, say d = 2¢g + 1, then we use the simple moving average (1.5.5).

The second step is to estimate the seasonal component. For each k = 1, ..., d,
we compute the average wy of the deviations {(Xiju — Mtja), ¢ < k+jd < n — q}.
Since these average deviations do not necessarily sum to zero, we estimate the seasonal
component s; as

d
§k=wk—d*zwi, k=1,....d, (1.5.13)
i=1

and gk = gk,d, k>d.
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The deseasonalized data is then defined to be the original series with the estimated
seasonal component removed, i.e.,

dt:xt_§t, = 1,...,n. (1.5.14)

Finally, we reestimate the trend from the deseasonalized data {d,} using one of
the methods already described. The program ITSM allows you to fit a least squares
polynomial trend 7 to the deseasonalized series. In terms of this reestimated trend and
the estimated seasonal component, the estimated noise series is then given by

Yt:xt—ﬁ’l,—gt, l=1,...,l’l.

The reestimation of the trend is done in order to have a parametric form for the trend
that can be extrapolated for the purposes of prediction and simulation.

Figure 1-24 shows the deseasonalized accidental deaths data obtained from ITSM
by reading in the series DEATHS.TSM, selecting Transform>Classical,check-
ing only the box marked Seasonal Fit,entering 12 for the period, and clicking OK.
The estimated seasonal component §,, shown in Figure 1-25, is obtained by selecting
Transform>Show Classical Fit. (Except for having a mean of zero, this
estimate is very similar to the harmonic regression function with frequencies 27 /12
and 27 /6 displayed in Figure 1-11.) The graph of the deseasonalized data suggests
the presence of an additional quadratic trend function. In order to fit such a trend
to the deseasonalized data, select Transform>Undo Classical to retrieve the
original data and then select Transform>Classical and check the boxes marked
Seasonal Fit and Polynomial Trend, entering 12 for the period and select-
ing Quadratic for the trend. Then click OK and you will obtain the trend function

iy, = 9952 — 71.82r + 0.82607, 1 <t <72.
At this point the data stored in ITSM consists of the estimated noise
?,:xt—ﬁ’l,—gt, tzl,...,72,

obtained by subtracting the estimated seasonal and trend components from the original
data.
0
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Figure 1-25

The estimated seasonal
component of the
accidental deaths data from
ITSM

Example 1.5.5
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1.5.2.2 Method S2: Elimination of Trend and Seasonal Components

by Differencing
The technique of differencing that we applied earlier to nonseasonal data can be
adapted to deal with seasonality of period d by introducing the lag-d differencing
operator V, defined by

ViX, =X, — X,—g = (1 — BHX,. (1.5.15)

(This operator should not be confused with the operator V¢ = (1 —B)¢ defined earlier.)
Applying the operator V, to the model

Xi=m+s+Y,
where {s;} has period d, we obtain
VaXe =my —my_q+ Y, =Yg,

which gives a decomposition of the difference VX, into a trend component (1, —m;,_,)
and a noise term (Y; — Y;_4). The trend, m, — m,_4, can then be eliminated using the
methods already described, in particular by applying a power of the operator V.

Figure 1-26 shows the result of applying the operator Vj, to the accidental deaths
data. The graph is obtained from ITSM by opening DEATHS.TSM, selecting Trans -
form>Difference, entering lag 12, and clicking OK. The seasonal component
evident in Figure 1-3 is absent from the graph of Vi,x;, 13 < ¢ < 72. However,
there still appears to be a nondecreasing trend. If we now apply the operator V to
{V12x,} by again selecting Transform>Difference, this time with lag one, we
obtain the graph of VV,x;, 14 <t < 72, shown in Figure 1-27, which has no apparent
trend or seasonal component. In Chapter 5 we show that this doubly differenced series
can in fact be well represented by a stationary time series model.
O
In this section we have discussed a variety of methods for estimating and/or
removing trend and seasonality. The particular method chosen for any given data
set will depend on a number of factors including whether or not estimates of the
components of the series are required and whether or not it appears that the data contain
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Figure 1-26

The differenced series
{Vioxe, t=13,...,72}
derived from the monthly
accidental deaths
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Figure 1-27
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a seasonal component that does not vary with time. The program ITSM allows two
options under the Transform menu:

1. “classical decomposition,” in which trend and/or seasonal components are esti-
mated and subtracted from the data to generate a noise sequence, and

2. “differencing,” in which trend and/or seasonal components are removed from the
data by repeated differencing at one or more lags in order to generate a noise
sequence.

A third option is to use the Regression menu, possibly after applying a Box—Cox
transformation. Using this option we can (see Example 1.3.6)

3. fit a sum of harmonics and a polynomial trend to generate a noise sequence that
consists of the residuals from the regression.



30

Chapter 1

Introduction

In the next section we shall examine some techniques for deciding whether or not the
noise sequence so generated differs significantly from iid noise. If the noise sequence
does have sample autocorrelations significantly different from zero, then we can take
advantage of this serial dependence to forecast future noise values in terms of past
values by modeling the noise as a stationary time series.

1.6 Testing the Estimated Noise Sequence

The objective of the data transformations described in Section 1.5 is to produce a
series with no apparent deviations from stationarity, and in particular with no apparent
trend or seasonality. Assuming that this has been done, the next step is to model the
estimated noise sequence (i.e., the residuals obtained either by differencing the data
or by estimating and subtracting the trend and seasonal components). If there is no
dependence among between these residuals, then we can regard them as observations
of independent random variables, and there is no further modeling to be done except to
estimate their mean and variance. However, if there is significant dependence among
the residuals, then we need to look for a more complex stationary time series model
for the noise that accounts for the dependence. This will be to our advantage, since
dependence means in particular that past observations of the noise sequence can assist
in predicting future values.

In this section we examine some simple tests for checking the hypothesis that
the residuals from Section 1.5 are observed values of independent and identically
distributed random variables. If they are, then our work is done. If not, then we must
use the theory of stationary processes to be developed in later chapters to find a more
appropriate model.

(a) The sample autocorrelation function. For large n, the sample autocorrela-
tions of an iid sequence Y1, ..., Y, with finite variance are approximately iid with
distribution N(0, 1/n) (see Brockwell and Davis (1991) p. 222). Hence, if y1, ..., ¥,
is a realization of such an iid sequence, about 95 % of the sample autocorrelations
should fall between the bounds +1.96/./n. If we compute the sample autocorrelations
up to lag 40 and find that more than two or three values fall outside the bounds, or
that one value falls far outside the bounds, we therefore reject the iid hypothesis. The
bounds +1.96/./n are automatically plotted when the sample autocorrelation function
is computed by the program ITSM.

(b) The portmanteau test. Instead of checking to see whether each sample
autocorrelation o(j) falls inside the bounds defined in (a) above, it is also possible
to consider the single statistic

h
Q=n) p(j).
j=1

IfYy,..., Y, is a finite-variance iid sequence, then by the same result used in (a), Q
is approximately distributed as the sum of squares of the independent N(0, 1) random
variables, \/np(j),j = 1,...,h, i.e., as chi-squared with & degrees of freedom. A
large value of Q suggests that the sample autocorrelations of the data are too large for
the data to be a sample from an iid sequence. We therefore reject the iid hypothesis
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at level o if QO > X127a (h), where X127a (h) is the 1 — o quantile of the chi-squared
distribution with & degrees of freedom. The program ITSM conducts a refinement of
this test, formulated by Ljung and Box (1978), in which Q is replaced by

h
O =n(n+2) Y p*(j)/(n—)),

J=1

whose distribution is better approximated by the chi-squared distribution with A
degrees of freedom.

Another portmanteau test, formulated by McLeod and Li (1983), can be used as
a further test for the iid hypothesis, since if the data are iid, then the squared data are
also iid. It is based on the same statistic used for the Ljung—Box test, except that the
sample autocorrelations of the data are replaced by the sample autocorrelations of the
squared data, pyw(h), giving

h
O =n(n+2) Y pryk)/(n— k).

k=1

The hypothesis of iid data is then rejected at level « if the observed value of Oy is
larger than the 1 — & quantile of the x?(h) distribution.

(c) The turning point test. If y,...,y, is a sequence of observations, we say
that there is a turning point at time i, 1 < i < n, if y; 1 < y; and y; > y;; or if
vi-1 > yiand y; < yiyq. If T is the number of turning points of an iid sequence of

length n, then, since the probability of a turning point at time i is %, the expected value
of T is

ur =ET) =2(n-2)/3.
It can also be shown for an iid sequence that the variance of T is
07 = Var(T) = (16n — 29)/90.

A large value of T — u7 indicates that the series is fluctuating more rapidly than
expected for an iid sequence. On the other hand, a value of T — wr much smaller
than zero indicates a positive correlation between neighboring observations. For an iid
sequence with n large, it can be shown that

T is approximately N(,uT, a%).

This means we can carry out a test of the iid hypothesis, rejecting it at level o if
|T — prl/or > ®1_g/2, Where ®|_, 5 is the 1 — /2 quantile of the standard normal
distribution. (A commonly used value of « is 0.05, for which the corresponding value
of CDI—(X/Z is 196)

(d) The difference-sign test. For this test we count the number S of values of i
such that y; > y;_1,i = 2, ..., n, or equivalently the number of times the differenced
series y; — y;_1 is positive. For an iid sequence it is clear that

1
us = ES = E(n —1).
It can also be shown, under the same assumption, that
og = Var(§) = (n+ 1)/12,
and that for large n,

S is approximately N(,us, 052).
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A large positive (or negative) value of S — ug indicates the presence of an increasing
(or decreasing) trend in the data. We therefore reject the assumption of no trend in the
data if |S — ug|/os > q)l,a/z.

The difference-sign test must be used with caution. A set of observations exhibit-
ing a strong cyclic component will pass the difference-sign test for randomness, since
roughly half of the observations will be points of increase.

(e) The rank test. The rank test is particularly useful for detecting a linear trend
in the data. Define P to be the number of pairs (i, j) such that y; > y; and j > i,
i=1,...,n— 1. There is a total of (’21) = %n(n — 1) pairs (i, j) such that j > i. For
an iid sequence {Yi, ..., Y,}, each event {¥; > Y;} has probability %, and the mean
of P is therefore

1
Up = Zn(n —1).
It can also be shown for an iid sequence that the variance of P is
of =n(n—1D(@2n+5)/72
and that for large n,
P is approximately N(,u P 0,%)

(see Kendall and Stuart 1976). A large positive (negative) value of P — up indicates the
presence of an increasing (decreasing) trend in the data. The assumption that {y;} is a
sample from an iid sequence is therefore rejected at level « = 0.05 if |P — up|/op >
q)lfa/z = 1.96.

(f) Fitting an autoregressive model. A further test that can be carried out using
the program ITSM is to fit an autoregressive model to the data using the Yule—Walker
algorithm (discussed in Section 5.1.1) and choosing the order which minimizes the
AICC statistic (see Section 5.5). A selected order equal to zero suggests that the data
is white noise.

(g) Checking for normality. If the noise process is Gaussian, i.e., if all of its
joint distributions are normal, then stronger conclusions can be drawn when a model
is fitted to the data. The following test enables us to check whether it is reasonable
to assume that observations from an iid sequence are also Gaussian.

Let Yy < Y < -+ < Y, be the order statistics of a random sample Y1, ..., Y,
from the distribution N(u, 0%). If Xy < X2y < --+ < Xy are the order statistics
from a N(0O, 1) sample of size n, then

EY(]') =M+ij,

where m; = EX(;),j = 1,...,n. The graph of the points (ml, Y(l)), R (mn, Y(,,))
is called a Gaussian qq plot) and can be displayed in ITSM by clicking on the yellow
button labeled QQ. If the normal assumption is correct, the Gaussian qq plot should
be approximately linear. Consequently, the squared correlation of the points (m;, Y(;),
i=1,...,n,should be near 1. The assumption of normality is therefore rejected if the
squared correlation R? is sufficiently small. If we approximate m; by ®~!((i — 0.5)/n)
(see Mage 1982 for some alternative approximations), then R* reduces to

LYy —no! (#))2
YL Yo =12 (07 (52))

where Y = n~'(Y; + - - - +Y,). Percentage points for the distribution of R?, assuming
normality of the sample values, are given by Shapiro and Francia (1972) for sample

R> =

27



1.6 Testing the Estimated Noise Sequence 33
QL
@
o
© L
o
L
Qs
N
o
o [ ‘ ‘ ’V r | | | | 1 :
. g | T T
igure 1-28
The sample autocorrelation LS 5 [ Y I A R
function for the data of L. ! ! ! !
Example 1.1.4 showing 0 10 20 30 40
the bounds +1.96/./n Lag

Example 1.6.1

sizes n < 100. For n = 200, P(R*> < 0.987) = 0.05 and P(R*> < 0.989) = 0.10. For
larger values of n the Jarque-Bera test (Jarque and Bera, 1980) for normality can be
used (see Section 5.3.3).

If w

e did not know in advance how the signal plus noise data of Example 1.1.4 were

generated, we might suspect that they came from an iid sequence. We can check this
hypothesis with the aid of the tests (a)—(f) introduced above.

(a)

(b)

(0

(d)

The sample autocorrelation function (Figure 1-28) is obtained from ITSM by
opening the project SIGNAL.TSM and clicking on the second yellow button at the
top of the ITSM window. Observing that 25 % of the autocorrelations are
outside the bounds +1.96/+/200, we reject the hypothesis that the series is iid.

The remaining tests (b), (c), (d), (e), and (f) are performed by choosing the
option Statistics>Residual Analysis>Tests of Randomness.
(Since no model has been fitted to the data, the residuals are the same as the data
themselves.)

The sample value of the Ljung-Box statistic Or g with & = 20 is 51.84. Since the
corresponding p-value (displayed by ITSM) is 0.00012 < 0.05, we reject the iid
hypothesis at level 0.05. The p-value for the McLeod—Li statistic Q. is 0.717. The
McLeod-Li statistic does therefore not provide sufficient evidence to reject the iid
hypothesis at level 0.05.

The sample value of the turning-point statistic 7" is 138, and the asymptotic distri-
bution under the iid hypothesis (with sample size n = 200) is N(132, 35.3). Thus
|T—ur|/or = 1.01, corresponding to a computed p-value of 0.312. On the basis of
the value of T there is therefore not sufficient evidence to reject the iid hypothesis
at level 0.05.

The sample value of the difference-sign statistic S is 101, and the asymptotic
distribution under the iid hypothesis (with sample size n = 200) is N(99.5, 16.7).
Thus |S—us|/os =0.38, corresponding to a computed p-value of 0.714. On the
basis of the value of S there is therefore not sufficient evidence to reject the iid
hypothesis at level 0.05.
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(e) The sample value of the rank statistic P is 10,310, and the asymptotic distribu-
tion under the iid hypothesis (with n=200) is N(9950, 2.239x 105). The statistic
|P — up|/op, is therefore equal to 0.76, corresponding to a p-value of 0.447. On
the basis of the value of P there is therefore not sufficient evidence to reject the
iid hypothesis at level 0.05.

(f) The minimum-AICC Yule-Walker autoregressive model for the data is of
order seven, supporting the evidence provided by the sample ACF and Ljung—Box
tests against the iid hypothesis.

Thus, although not all of the tests detect significant deviation from iid behavior, the
sample autocorrelation, the Ljung—Box statistic, and the fitted autoregression provide
strong evidence against it, causing us to reject it (correctly) in this example.

O

The general strategy in applying the tests described in this section is to check them
all and to proceed with caution if any of them suggests a serious deviation from the iid
hypothesis. (Remember that as you increase the number of tests, the probability that
at least one rejects the null hypothesis when it is true increases. You should therefore
not necessarily reject the null hypothesis on the basis of one test result only.)

1.1 Let X and Y be two random variables with E(Y) = p and EY? < oo.
a. Show that the constant ¢ that minimizes E(Y — ¢)? is ¢ = pu.

b. Deduce that the random variable f(X) that minimizes E [(Y —f (X))2|X] is

f(X) = E[Y|X].
c. Deduce that the random variable £(X) that minimizes E(Y — f(X))? is also
f(X) = E[Y|X].
1.2 (Generalization of Problem 1.1.) Suppose that X;, X5, ... is a sequence of ran-
dom variables with E(th) < oo and E(X;) = u.
a. Show that the random variable (X1, ..., X,) that minimizes the conditional

mean squared error, E[(X,,+1 — Xy, . X)) X, ,X,,], is
fXi, ..., X)) = E[ X1l X1, .- -, Xl

b. Deduce that the random variable f(Xi, ..., X,) that minimizes the uncondi-
tional mean squared error, E [(Xn+1 —fXy,... ,Xn))z], is also

f&Xi, . X)) = E[Xp X, . X

c. If X1, X,, ... 1siid with E(Xl.z) < oo and EX; = u, where u is known, what
is the minimum mean squared error predictor of X,,,; in terms of X;, ..., X,,?

d. Under the conditions of part (c) show that the best linear unbiased estimator
of winterms of Xi, ..., X, is X = ’—11(X1 +---+X,). (i said to be an unbiased
estimator of p if Egn = u for all w.)

e. Under the conditions of part (c) show that X is the best linear predictor of
X+ that is unbiased for u.

f. If X1, X, ... is iid with E(Xlz) < ooand EX; = u,and if §o = 0, S, =
X1+ -4+X,,n =1, 2, ..., whatis the minimum mean squared error predictor
of S+ in terms of Sy, ..., S,?
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1.3
14

1.5

1.6

1.7

1.8

1.9

Show that a strictly stationary process with E(X?) < oo is weakly stationary.

Let {Z,} be a sequence of independent normal random variables, each with
mean 0 and variance o2, and let a, b, and ¢ be constants. Which, if any, of the
following processes are stationary? For each stationary process specify the mean
and autocovariance function.

. X;=a+bZ,+cZ;_»

a
b. X; = Z, cos(ct) + Z, sin(ct)
c. X; = Z;cos(ct) + Z,_; sin(ct)
d X, =a+ b7

e. X; = Zycos(ct)

f. X, =27_,

Let {X;} be the moving-average process of order 2 given by
X =7+ 07 _,,

where {Z;} is WN(O, 1).
a. Find the autocovariance and autocorrelation functions for this process when
6 =0.8.

b. Compute the variance of the sample mean (X;4+X,+X3+X4)/4 when6 = 0.8.

c. Repeat (b) when & = —0.8 and compare your answer with the result obtained
in (b).
Let {X;} be the AR(1) process defined in Example 1.4.5.

a. Compute the variance of the sample mean (X; +X,+X3+X4)/4 when ¢ = 0.9
and o2 = 1.

b. Repeat (a) when ¢ = —0.9 and compare your answer with the result obtained
in (a).
If {X;} and {Y;} are uncorrelated stationary sequences, i.e., if X, and Y are uncor-

related for every r and s, show that {X, + Y,} is stationary with autocovariance
function equal to the sum of the autocovariance functions of {X;} and {Y;}.

Let {Z;} be IID N(O, 1) noise and define

Z;, if ¢ is even,
XI =
(Z%, —1)//2, iftisodd.
a. Show that {X,} is WN(O, 1) but not iid(0, 1) noise.
b. Find E(X,,.1|X1, ..., X,) for n odd and »n even and compare the results.

Let {x;, ..., x,} be observed values of a time series at times 1, ..., n, and let

0 (h) be the sample ACF at lag & as in Definition 1.4.4.

a. If x;, = a + bt, where a and b are constants and b # 0, show that for each
fixed h > 1,

o(h) — lasn — oo.

b. If x;, = ccos(wt), where ¢ and w are constants (¢ # 0 and w € (—m, 7)),
show that for each fixed A,

0(h) — cos(wh) as n — oo.
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1.10

1.11

1.12

1.13

1.14

1.15

1.16

1.17

Ifm =3"_, ct*,t =0, %1, ..., show that Vm; is a polynomial of degree p— 1
in 7 and hence that V”*!m, = 0.

Consider the simple moving-average filter with weights a; = (2g+1)7!, —¢ <
J=4q

a. If m, = ¢y + ct, show that > 7

j=—q
b. If Z,t = 0,%1,£2, ..., are independent random variables with mean O

. 2 . _ q oS¢ ”
and variance o -, show that the moving average A, = ijf g @Zi—j 1s “small

for large ¢ in the sense that EA, = 0 and Var(4,) = 02/(2q + 1).

ajmy—j = m;.

a. Show that a linear filter {a;} passes an arbitrary polynomial of degree k without
distortion, i.e., that

m; = E ajmt_j
J

for all kth-degree polynomials n; = ¢y + c1t + - - - + ¢, if and only if
Ya=1 and
J

Y jag=0, forr=1,... k.
J

b. Deduce that the Spencer 15-point moving-average filter {a;} defined by (1.5.6)
passes arbitrary third-degree polynomial trends without distortion.

Find a filter of the form 1 + aB + BB> + yB? (i.e., find «, B, and y) that
passes linear trends without distortion and that eliminates arbitrary seasonal
components of period 2.

Show that the filter with coefficients [a_», a_1, ag, a1, az] = é[—l, 4,3, 4, —1]
passes third-degree polynomials and eliminates seasonal components with pe-
riod 3.

Let {Y,} be a stationary process with mean zero and let a and b be constants.

a. If X, = a+bt+s,4Y,;, where s, is a seasonal component with period 12, show
that VV,X, = (1—B)(1 —B'?)X, is stationary and express its autocovariance
function in terms of that of {Y,}.

b. If X, = (a + bt)s, + Y,;, where s, is a seasonal component with period 12,
show that szXt = (1 — B'?)2X, is stationary and express its autocovariance
function in terms of that of {Y,}.

(Using ITSM to smooth the strikes data.) Double-click on the ITSM icon,
select File>Project>Opens>Univariate, click OK, and open the file
STRIKES. TSM. The graph of the data will then appear on your screen. For
smoothing select either Smooth>MovingAve,Smooth>Exponential, or
Smooth>FFT. Try using each of these to reproduce the results shown in
Figures 1-18, 1-21, and 1-22.

(Using ITSM to plot the deaths data.) In ITSM select File>Project >Open>
Univariate, click OK, and open the project DEATHS.TSM. The graph of
the data will then appear on your screen. To see a histogram of the data, click
on the sixth yellow button at the top of the ITSM window. To see the sample
autocorrelation function, click on the second yellow button. The presence of a
strong seasonal component with period 12 is evident in the graph of the data and
in the sample autocorrelation function.
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1.18

1.19

(Using ITSM to analyze the deaths data.) Open the file DEATHS.TSM, select
Transform>Classical,check the box marked Seasonal Fit,and enter
12 for the period. Make sure that the box labeled Polynomial Fit is not
checked, and click, OK. You will then see the graph (Figure 1-24) of the
deseasonalized data. This graph suggests the presence of an additional quadratic
trend function. To fit such a trend, select Transform>Undo Classicalto
retrieve the original data. Then select Transform>Classical and check the
boxes marked Seasonal Fitand Polynomial Trend,entering 12 for the
period and Quadratic for the trend. Click OK to obtain the trend function

My = 9952 — 71.82¢ + 0.82607%, 1 <1 <72.
At this point the data stored in ITSM consists of the estimated noise
?t=xt—ﬁ1t—3‘,, t=1,...,72,

obtained by subtracting the estimated seasonal and trend components
from the original data. The sample autocorrelation function can be plotted
by clicking on the second yellow button at the top of the ITSM window.
Further tests for dependence can be carried out by selecting the options
Statistics>Residual Analysis>Tests of Randomness. These
show clearly the substantial dependence in the series {Y;}.

To forecast the data without allowing for this dependence, select the
option Forecasting>ARMA. Specify 24 for the number of values to be
forecast, and the program will compute forecasts based on the assumption
that the estimated seasonal and trend components are true values and that {Y;}
is a white noise sequence with zero mean. (This is the default model assumed
by ITSM until a more complicated stationary model is estimated or specified.)
The original data are plotted with the forecasts appended. Later we shall see
how to improve on these forecasts by taking into account the dependence in the
series {Y,}.

Use a text editor to construct and save a text file named TEST.TSM, which
consists of a single column of 30 numbers, {xi, ..., x30}, defined by

X1, ..., X0 : 486,474,434, 441,435,401, 414, 414, 386, 405;
X1, -..,%0 2 411,389, 414,426,410, 441, 459, 449, 486, 510;
X1, ..., Xx30 : 506,549, 579, 581, 630, 666, 674, 729, 771, 785.

This series is in fact the sum of a quadratic trend and a period-three seasonal
component. Use the program ITSM to apply the filter in Problem 1.14 to this
time series and discuss the results.

(Once the data have been typed, they can be imported directly into ITSM
by highlighting the data to be imported, using the Windows command Select
and Copy and then, in ITSM, selecting the option File>Project>New>
Univariate,clicking on OK and selecting File>Import Clipboard.)
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2.1 Basic Properties

2.2 Linear Processes

2.3 Introduction to ARMA Processes

2.4 Properties of the Sample Mean and Autocorrelation Function
2.5 Forecasting Stationary Time Series

2.6 The Wold Decomposition

A key role in time series analysis is played by processes whose properties, or some
of them, do not vary with time. If we wish to make predictions, then clearly we
must assume that something does not vary with time. In extrapolating deterministic
functions it is common practice to assume that either the function itself or one of its
derivatives is constant. The assumption of a constant first derivative leads to linear
extrapolation as a means of prediction. In time series analysis our goal is to predict
a series that typically is not deterministic but contains a random component. If this
random component is stationary, in the sense of Definition 1.4.2, then we can develop
powerful techniques to forecast its future values. These techniques will be developed
and discussed in this and subsequent chapters.

2.1 Basic Properties
In Section 1.4 we introduced the concept of stationarity and defined the autocovari-
ance function (ACVF) of a stationary time series {X;} as
y(h) = Cov(Xyqn, Xy), h=0,%£1,£2,....

The autocorrelation function (ACF) of {X;} was defined similarly as the function p(-)
whose value at lag 4 is

v (h)
ph) = —=.
v (0)
© Springer International Publishing Switzerland 2016 39
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The ACVF and ACF provide a useful measure of the degree of dependence among
the values of a time series at different times and for this reason play an important role
when we consider the prediction of future values of the series in terms of the past and
present values. They can be estimated from observations of X, ..., X, by computing
the sample ACVF and ACF as described in Section 1.4.1.

The role of the autocorrelation function in prediction is illustrated by the following
simple example. Suppose that {X;} is a stationary Gaussian time series (see Defi-
nition A.3.2) and that we have observed X,,. We would like to find the function of
X,, that gives us the best predictor of X,.,, the value of the series after another &
time units have elapsed. To define the problem we must first say what we mean by
“best.” A natural and computationally convenient definition is to specify our required
predictor to be the function of X, with minimum mean squared error. In this illustration,
and indeed throughout the remainder of this book, we shall use this as our criterion
for “best.” Now by Proposition A.3.1 the conditional distribution of X, given that
X, = x, 18

N( + o), — ). > (1 = p()?)),

where 1 and o? are the mean and variance of {X,}. It was shown in Problem 1.1 that
the value of the constant ¢ that minimizes E(X,4, — ¢)? is ¢ = E(X,4») and that the
function m of X,, that minimizes E(X,,., — m(X,))? is the conditional mean

m(Xy) = EXynlXn) = p + p(W) (X — ). 2.1.1)
The corresponding mean squared error is
EXun —mXa)* = o*(1 = p(h)?). (2.1.2)

This calculation shows that at least for stationary Gaussian time series, prediction of
X+, in terms of X, is more accurate as | o (k)| becomes closer to 1, and in the limit as
p(h) — =1 the best predictor approaches @ + (X,, — 1) and the corresponding mean
squared error approaches 0.

In the preceding calculation the assumption of joint normality of X,., and X,
played a crucial role. For time series with nonnormal joint distributions the correspond-
ing calculations are in general much more complicated. However, if instead of looking
for the best function of X,, for predicting X1, we look for the best linear predictor,
i.e., the best predictor of the form £(X,,) = aX, + b, then our problem becomes that of
finding @ and b to minimize E(X,, 1, — aX, — b)?. An elementary calculation (Problem
2.1), shows that the best predictor of this form is

LX) =+ p(HX, — 1) (2.1.3)
with corresponding mean squared error
EXyin — LX) = 0*(1 = p(h)?). (2.1.4)

Comparison with (2.1.1) and (2.1.3) shows that for Gaussian processes, £(X,) and
m(X,) are the same. In general, of course, m(X,) will give smaller mean squared
error than ¢(X,,), since it is the best of a larger class of predictors (see Problem 1.8).
However, the fact that the best linear predictor depends only on the mean and ACF of
the series {X,} means that it can be calculated without more detailed knowledge of the
joint distributions. This is extremely important in practice because of the difficulty of
estimating all of the joint distributions and because of the difficulty of computing the
required conditional expectations even if the distributions were known.
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Definition 2.1.1

Theorem 2.1.1

Proof

As we shall see later in this chapter, similar conclusions apply when we consider
the more general problem of predicting X,,,, as a function not only of X,,, but also of
X,_1,Xu_2, . ... Before pursuing this question we need to examine in more detail the
properties of the autocovariance and autocorrelation functions of a stationary time
series.

Basic Properties of ~(-):

y(0) =0,

ly (W] < y(0) for all A,
and y (-) is even, i.e.,

y(h) = y (—h) for all h.

The first property is simply the statement that Var(X;) > 0, the second is an immediate
consequence of the fact that correlations are less than or equal to 1 in absolute value
(or the Cauchy—Schwarz inequality), and the third is established by observing that

y (h) = Cov(Xiin, Xi) = Cov(X,, X, 1n) = y (—h). u

Autocovariance functions have another fundamental property, namely that of
nonnegative definiteness.

A real-valued function « defined on the integers is nonnegative definite if

n
> aik(i - j)a; = 0 (2.1.5)
i, j=1
for all positive integers n and vectors a = (ay, ..., a,)’ with real-valued compo-

nents a;.

A real-valued function defined on the integers is the autocovariance function of a
stationary time series if and only if it is even and nonnegative definite.

To show that the autocovariance function y (-) of any stationary time series {X;} is
nonnegative definite, let a be any n x 1 vector with real components ay, ..., a, and let
X, = (X,, ..., X1)'. Then by equation (A.2.5) and the nonnegativity of variances,
n
Var@X,) =aT,a= Y ay(i—ja >0,
i,j=1
where I',, is the covariance matrix of the random vector X,,. The last inequality,
however, is precisely the statement that ¢ (-) is nonnegative definite. The converse
result, that there exists a stationary time series with autocovariance function « if
k is even, real-valued, and nonnegative definite, is more difficult to establish (see
Brockwell and Davis (1991), Theorem 1.5.1 for a proof). A slightly stronger statement
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can be made, namely, that under the specified conditions there exists a stationary
Gaussian time series {X;} with mean 0 and autocovariance function « (-). |

Remark 1. An autocorrelation function o (-) has all the properties of an autocovari-
ance function and satisfies the additional condition p(0) = 1. In particular, we can say
that p(-) is the autocorrelation function of a stationary process if and only if p(-) is an
ACVF with p(0) = 1. O

Remark 2. To verify that a given function is nonnegative definite it is often simpler
to find a stationary process that has the given function as its ACVF than to verify the
conditions (2.1.5) directly. For example, the function « (h) = cos(wh) is nonnegative
definite, since (see Problem 2.2) it is the ACVF of the stationary process

X; = A cos(wt) 4+ Bsin(wt),
where A and B are uncorrelated random variables, both with mean O and variance 1.

Another illustration is provided by the following example. U

We shall show now that the function defined on the integers by
1, ifh=0,
k(h) = {p, ifh==l1,

0, otherwise,

is the ACVF of a stationary time series if and only if |p| < % Inspection of the ACVF
of the MA(1) process of Example 1.4.4 shows that « is the ACVF of such a process if
we can find real # and nonnegative o2 such that

o?(1+6%) =1
and
020 = p.
If |p] < %, these equations give solutions 6 = (2,0)_1(1 + 1-— 4,02) and 02 =

(1 + 02)71. However, if |p| > %, there is no real solution for 6 and hence no MA(1)
process with ACVF k. To show that there is no stationary process with ACVF k,
we need to show that « is not nonnegative definite. We shall do this directly from the
definition (2.1.5). First, if p > %, K=[x(—)DI =1 and a is the n-component vector
a=(1,-1,1,—1,...), then

aKa=n—-2(n—1)p <0forn>2p/2p — 1),

showing that « (-) is not nonnegative definite and therefore, by Theorem 2.1.1, is not
an autocovariance function. If p < —%, the same argument witha = (1,1, 1,1,...)
again shows that « (-) is not nonnegative definite.

If {X;} is a (weakly) stationary time series, then the vector (X1, ..., X,)" and thDe
time-shifted vector (Xyys,..., X,.1,) have the same mean vectors and covariance
matrices for every integer & and positive integer n. A strictly stationary sequence is
one in which the joint distributions of these two vectors (and not just the means and
covariances) are the same. The precise definition is given below.
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Proof

{X;} is a strictly stationary time series if
d
(le ceey Xn)/ - (X1+h’ D) X}’H-h)/

. d . o
for all integers 4 and n > 1. (Here = is used to indicate that the two random vectors
have the same joint distribution function.)

For reference, we record some of the elementary properties of strictly stationary
time series.

Properties of a Strictly Stationary Time Series {X,}:

a. The random variables X, are identically distributed.
b. (X;, X,1p) < (X1, X14) for all integers ¢ and A.
c. {X;}is weakly stationary if E (Xf) < oo for all z.
d. Weak stationarity does not imply strict stationarity.
e

. An iid sequence is strictly stationary.

Properties (a) and (b) follow at once from Definition 2.1.2. If EXt2 < 00, then by
(a) and (b) EX; is independent of ¢ and Cov(X,, X,,) = Cov(Xi, X;41), which is
also independent of ¢, proving (c). For (d) see Problem 1.8. If {X,} is an iid sequence
of random variables with common distribution function F, then the joint distribution
function of (X4, ..., X,y evaluated at (xi,...,x,) is F(x;)--- F(x,), which is
independent of A. |

One of the simplest ways to construct a time series {X,} that is strictly stationary
(and hence stationary if EX? < 00) is to “filter” an iid sequence of random variables.
Let {Z,} be an iid sequence, which by (e) is strictly stationary, and define

Xl‘ = g(Zl" thlv R} thq) (216)
for some real-valued function g(-,...,-). Then {X;} is strictly stationary, since
Zishs -+ s Zivn—g) 4 (Z;, ..., Z;_y) for all integers h. It follows also from the

defining equation (2.1.6) that {X,} is g-dependent, i.e., that X; and X, are independent
whenever |t — s| > ¢. (An iid sequence is O-dependent.) In the same way, adopting
a second-order viewpoint, we say that a stationary time series is g-correlated if
y(h) = 0 whenever |h| > ¢g. A white noise sequence is then O-correlated, while
the MA(1) process of Example 1.4.4 is 1-correlated. The moving-average process of
order g defined below is g-correlated, and perhaps surprisingly, the converse is also
true (Proposition 2.1.1).

The MA(gq) Process:
{X;} is a moving-average process of order q if
t = Zt + 912,_1 + e + qut_q, (2.1.7)

where {Z,} ~ WN(O, 02) and 0y, ..., 0, are constants.
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Proposition 2.1.1

It is a simple matter to check that (2.1.7) defines a stationary time series that is strictly
stationary if {Z,} is iid noise. In the latter case, (2.1.7) is a special case of (2.1.6) with
g a linear function.

The importance of MA(g) processes derives from the fact that every g-correlated
process is an MA(g) process. This is the content of the following proposition, whose
proof can be found in Brockwell and Davis (1991), Section 3.2. The extension of this
result to the case ¢ = oo is essentially Wold’s decomposition (see Section 2.6).

If {X;} is a stationary g-correlated time series with mean O, then it can be represented
as the MA(q) process in (2.1.7).

2.2 Linear Processes

Definition 2.2.1

The class of linear time series models, which includes the class of autoregressive
moving-average (ARMA) models, provides a general framework for studying
stationary processes. In fact, every second-order stationary process is either a linear
process or can be transformed to a linear process by subtracting a deterministic com-
ponent. This result is known as Wold’s decomposition and is discussed in Section 2.6.

The time series {X;} is a linear process if it has the representation

Xo= Y WZy, 2.2.1)

j=—00

for all ¢, where {Z,} ~ WN(O, 02) and {y;} is a sequence of constants with
Z;i—oo [V] < oo.

In terms of the backward shift operator B, (2.2.1) can be written more compactly as
Xi =¥ (B)Z;, (2.2.2)

where ¥ (B) = Zfi_m ¥;B/. A linear process is called a moving average or MA (c0)

if yj =0forallj <O0,i.e., if
o0
Xl‘ = Z l//]thj
j=0

Remark 1. The condition Z;i_oo |j| < oo ensures that the infinite sum in (2.2.1)
converges (with probability one), since E|Z;| < o and

o0

Ex|< > (WEZ-) < | D Iyl | o < oo
j=—00

Jj=—00

It also ensures that Zj'i_ o ij < oo and hence (see Appendix C, Example C.1.1) that
the series in (2.2.1) converges in mean square, i.e., that X; is the mean square limit
of the partial sums Z/’.':_n YiZ;,_;. The condition Z/’.':_n [¥j] < oo also ensures
convergence in both senses of the more general series (2.2.3) considered in
Proposition 2.2.1 below. In Section 11.4 we consider a more general class of linear
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Proposition 2.2.1

Proof

processes, the fractionally integrated ARMA processes, for which the coefficients are
not absolutely summable but only square summable. (]

The operator ¥ (B) can be thought of as a linear filter, which when applied to
the white noise “input” series {Z;} produces the “output” {X,} (see Section 4.3). As
established in the following proposition, a linear filter, when applied to any stationary
input series, produces a stationary output series.

Let {Y,} be a stationary time series with mean 0 and covariance function yy. If

o | < 00, then the time series
Yoo ¥l then the t,

X, =Y YY;=v®BY, (2.2.3)

j=—00

is stationary with mean 0 and autocovariance function

vy =Y Y Yy +k— ). (2.2.4)

Jj=—00 k=—00

In the special case where {X,} is the linear process (2.2.1),

yx(h) = Z Yivino . (2.2.5)

j=—00

The argument used in Remark 1, with o replaced by /yy(0), shows that the series in
(2.2.3) is convergent. Since EY; = 0, we have

EX)=E| Y Y| =Y %EY. ;) =0

j=—00 j=—00

and

EXi X)) = E Z ViYiinj ( Z l/katk>
k=—00

j=—00

= Z Z ViVkE (Y n—Yi—k)

Jj=—00 k=—00
00

= > D Y h—j+h),

j=—00 k=—00

which shows that {X,} is stationary with covariance function (2.2.4). (The interchange
of summation and expectation operations in the above calculations can be justified by
the absolute summability of 1;.) Finally, if {Y;} is the white noise sequence {Z;} in
(2.2.1), then yy(h — j + k) = o2 if k = j — h and O otherwise, from which (2.2.5)
follows. |

Remark 2. The absolute convergence of (2.2.3) implies (Problem 2.6) that filters of
the form a(B) = > = a;B’ and B(B) = > X B;B’ with absolutely summable
coefficients can be applied successively to a stationary series {Y;} to generate a new

stationary series
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Example 2.2.1

o
W, = Z 1//th7j,
j=—00
where
o0 o
vi= Y, aBii= ) B (2.2.6)
k=—00 k=—0o0

These relations can be expressed in the equivalent form
W, =vB)Y,
where

¥ (B) = a(B)B(B) = B(B)a(B), (2.2.7)
and the products are defined by (2.2.6) or equivalently by multiplying the series
yr B/ and Zfifoo B;B’ term by term and collecting powers of B. It is clear

j=—00

from (2.2.6) and (2.2.7) that the order of application of the filters «(B) and B(B) is
immaterial. ]

An AR(1) Process

In Example 1.4.5, an AR(1) process was defined as a stationary solution {X;} of the
equations

X — ¢Xt71 =12, (2.2.8)

where {Z,} ~ WN(O0, 62), |¢| < 1, and Z, is uncorrelated with X; for each s < ¢. To
show that such a solution exists and is the unique stationary solution of (2.2.8), we
consider the linear process defined by

X, =) ¢'7. (2.2.9)
j=0

(The coefficients ¢/ for j > 0 are absolutely summable, since |¢| < 1.) It is easy to
verify directly that the process (2.2.9) is a solution of (2.2.8), and by Proposition 2.2.1
it is also stationary with mean 0 and ACVF

02¢h

1 —¢2’

yx(h) =) ¢plp/Ho” =
j=0

forh > 0.
To show that (2.2.9) is the only stationary solution of (2.2.8) let {Y,} be any
stationary solution. Then, iterating (2.2.8), we obtain

Yt = ¢Yt—l +Zt
=Z+¢Zi + %Y,

=Z+¢Za+- -+ P2+ Y
If {Y,} is stationary, then EY? is finite and independent of ¢, so that
k
E(Y, =Y ¢Z,)* = ¢*E(¥, 1)
j=0

— 0ask — oo.
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This implies that Y; is equal to the mean square limit Z,?io $7Z,_; and hence that the
process defined by (2.2.9) is the unique stationary solution of equation (2.2.8).

It the case |¢| > 1, the series in (2.2.9) does not converge. However, we can rewrite
(2.2.8) in the form

X, =—¢""Zip1 + 07 Xip. (2.2.10)
Iterating (2.2.10) gives
Xi=—¢""Zi1 — ¢ Zia + ¢ X

=—¢""Z1— =0 Zir + 07 Kigsg,
which shows, by the same arguments used above, that
(0.¢]
X, ==Y ¢7Zy (2.2.11)
j=1

is the unique stationary solution of (2.2.8). This solution should not be confused with
the nonstationary solution {X;} of (2.2.8) obtained when Xj is any specified random
variable that is uncorrelated with {Z;}.

The solution (2.2.11) is frequently regarded as unnatural, since X; as defined by
(2.2.11) is correlated with future values of Z;, contrasting with the solution (2.2.9),
which has the property that X, is uncorrelated with Z; for all s > . It is customary
therefore in modeling stationary time series to restrict attention to AR(1) processes
with |¢| < 1. Then X, has the representation (2.2.8) in terms of {Z;, s < ¢}, and we
say that {X,} is a causal or future-independent function of {Z;}, or more concisely that
{X;} is a causal autoregressive process. It should be noted that every AR(1) process with
|¢| > 1 can be reexpressed as an AR(1) process with |¢| < 1 and a new white noise
sequence (Problem 3.8). From a second-order point of view, therefore, nothing is lost
by eliminating AR(1) processes with |¢| > 1 from consideration.

If ¢ = £1, there is no stationary solution of (2.2.8) (see Problem 2.8).

0

Remark 3. It is worth remarking that when |¢| < 1 the unique stationary solution
(2.2.9) can be found immediately with the aid of (2.2.7). To do this let ¢ (B) = 1 — ¢B
and 7 (B) = Z;io ¢/B/. Then

V(B) :=¢B)w(B) = 1.
Applying the operator 7 (B) to both sides of (2.2.8), we obtain

(o)
X, =aB)Z =) ¢'Z;
j=0

as claimed. O

2.3 Introduction to ARMA Processes

In this section we introduce, through an example, some of the key properties of an
important class of linear processes known as ARMA (autoregressive moving average)
processes. These are defined by linear difference equations with constant coefficients.
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Definition 2.3.1

As our example we shall consider the ARMA(1,1) process. Higher-order ARMA
processes will be discussed in Chapter 3.

The time series {X;} is an ARMA(1, 1) process if it is stationary and satisfies (for
every t)

Xy — ¢Xi—1 = Z; + 07y, (2.3.1)
where {Z;} ~ WN(0, 0) and ¢ + 6 # 0.

Using the backward shift operator B, (2.3.1) can be written more concisely as
¢(B)X, = 06(B)Z,, (2.3.2)
where ¢ (B) and 6(B) are the linear filters
¢B)=1—¢Band H(B) = 1 + 6B,

respectively.

We first investigate the range of values of ¢ and 8 for which a stationary solution
of (2.3.1) exists. If |¢| < 1, let x(z) denote the power series expansion of 1/¢(z),
ie., Zf:oqﬁjzj , which has absolutely summable coefficients. Then from (2.2.7) we
conclude that x (B)¢(B) = 1. Applying x (B) to each side of (2.3.2) therefore gives

X, = x(B)Y(B)Z, = ¥ (B)Z,

where
B = B = (1+¢B+¢*B> +---) (1+6B).
Jj=0

By multiplying out the right-hand side or using (2.2.6), we find that
Vo= 1and ¥ = (¢ +0)¢’~" for j > 1.
As in Example 2.2.1, we conclude that the MA(c0) process

X, =Z+@+0))Y ¢z (2.3.3)

=1

is the unique stationary solution of (2.3.1).
Now suppose that |¢| > 1. We first represent 1/¢ (z) as a series of powers of z with
absolutely summable coefficients by expanding in powers of ™!, giving (Problem 2.7)

1 o0
- _ ¢*j 7.
9@ ;
Then we can apply the same argument as in the case where |¢| < 1 to obtain the

unique stationary solution of (2.3.1). We let x(B) = — ;L ¢7/B~/ and apply x(B)
to each side of (2.3.2) to obtain

X, = x(BOBZ =—0¢"'2,— O +¢) Y 7' Zy;. (2.3.4)

J=1
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If ¢ = =+1, there is no stationary solution of (2.3.1). Consequently, there is no
such thing as an ARMAC(1,1) process with ¢ = 1 according to our definition.

We can now summarize our findings about the existence and nature of the sta-
tionary solutions of the ARMA(1,1) recursions (2.3.2) as follows:

* A stationary solution of the ARMA(1,1) equations exists if and only if ¢ # £1.

e If |¢| < 1, then the unique stationary solution is given by (2.3.3). In this case we
say that {X;} is causal or a causal function of {Z;}, since X, can be expressed in
terms of the current and past values Z;, s < .

e If |¢| > 1, then the unique stationary solution is given by (2.3.4). The solution is
noncausal, since X; is then a function of Z;, s > t.

Just as causality means that X, is expressible in terms of Z;, s < ¢, the dual concept
of invertibility means that Z, is expressible in terms of X, s < ¢. We show now that
the ARMA(1,1) process defined by (2.3.1) is invertible if |#| < 1. To demonstrate
this, let £ (z) denote the power series expansion of 1/0(z), i.e., Zfio(—e)fzj , which has
absolutely summable coefficients. From (2.2.6) it therefore follows that £(B)0(B) = 1,
and applying &(B) to each side of (2.3.2) gives

Z, = §(B)p(B)X; = m(B)X;,

where
oo
w(B) = Z?Tij= (1 — 6B + (—9)232+...)(1 — ¢B).
j=0
By multiplying out the right-hand side or using (2.2.6), we find that

Zi=Xi—(@+0)) (=0)'X,;. (2.3.5)

j=1

Thus the ARMA(1,1) process is invertible, since Z; can be expressed in terms of the
present and past values of the process X, s < f. An argument like the one used to
show noncausality when |¢| > 1 shows that the ARMA(1,1) process is noninvertible
when |0 > 1, since then

Zi=—¢07' X, + O+ )Y (—0)7 X,y (2.3.6)

j=1

We summarize these results as follows:

e If 0| < 1, then the ARMA(1,1) process is invertible, and Z; is expressed in terms
of X;, s <t, by (2.3.5).

e If |#| > 1, then the ARMA(1,1) process is noninvertible, and Z, is expressed in
terms of X, s > ¢, by (2.3.6).

Remark 1. In the cases & = +1, the ARMA(1,1) process is invertible in the more
general sense that Z; is a mean square limit of finite linear combinations of X;, s < ¢,
although it cannot be expressed explicitly as an infinite linear combination of X, s <
t (see Section 4.4 of Brockwell and Davis (1991)). In this book the term invertible

will always be used in the more restricted sense that Z, = Z;io 7;X;—j, where
> o lmjl < oo O
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Remark 2. Ifthe ARMA(1,1) process {X;} is noncausal or noninvertible with |6| > 1,
then it is possible to find a new white noise sequence {W,} such that {X,} is a causal
and noninvertible ARMA(1,1) process relative to {W,;} (Problem 4.10). Therefore,
from a second-order point of view, nothing is lost by restricting attention to causal
and invertible ARMA(1,1) models. This last sentence is also valid for higher-order
ARMA models. ]

2.4 Properties of the Sample Mean and Autocorrelation Function

Proposition 2.4.1

A stationary process {X;} is characterized, at least from a second-order point of view,
by its mean u and its autocovariance function y (-). The estimation of u, y (-), and the
autocorrelation function p(-) = y(-)/y(0) from observations Xi, ..., X, therefore
plays a crucial role in problems of inference and in particular in the problem of
constructing an appropriate model for the data. In this section we examine some of
the properties of the sample estimates x and p(-) of u and p(-), respectively.

2.4.1 Estimation of u
The moment estimator of the mean w of a stationary process is the sample mean
Xo=n'X + X+ + Xp). (2.4.1)
It is an unbiased estimator of pu, since
EX,) =n"'(EX) + - + EX,) = i,
The mean squared error of X,, is
EX, — 1) = Var(X,)

=n? Z Z Cov(X;, X))

i=1 j=1

=n Y (n—li—jDyi—J)

i—j=—n

o (I
=n Z(l n>y(h). (2.4.2)

h=—n

Now if y(h) — 0 as h — o0, the right-hand side of (2.4.2) converges to zero,
so that X, converges in mean square to . If Zf;foo ly(h)| < oo, then (2.4.2)
gives lim,,_, nVar(}_(n) = Z‘ hl<co y (h). We record these results in the following
proposition.

If {X;} is a stationary time series with mean | and autocovariance function y (-),
then as n — 00,

Var(X,) = EX, — n)? — 0 if y(n) > 0,

nEX, — )’ — Yy if Y Iy < oo,

|h|<oco h=—00
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Example 2.4.1

To make inferences about i1 using the sample mean X,,, it is necessary to know the
distribution or an approximation to the distribution of X,,. If the time series is Gaussian
(see Definition A.3.2), then by Remark 2 of Section A.3 and (2.4.2),

n'?(X, — ) ~N |0, Z <1 — lnﬂ) y(h)

|h|<n

It is easy to construct exact confidence bounds for p using this result if y(-) is
known, and approximate confidence bounds if it is necessary to estimate y (-) from
the observations.

For many time series, in particular for linear and ARMA models, X, is approxi-
mately normal with mean p and variance n~! Z‘ n<oo ¥ (h) for large n (see Brockwell
and Davis (1991), p. 219). An approximate 95 % confidence interval for u is then

(X, — 1.96v'/2//n, X, +1.96v'/?//n), (2.4.3)

where v = ZI hl<oo ¥ (M) Of course, v is not generally known, so it must be estimated
from the data. The estimator computed in the program ITSM is v = Z|h|< ﬁ(l —
|h)/ ﬁ))? (h). For ARMA processes this is a good approximation to v for large n.

An AR(1) Model

Let {X;} be an AR(1) process with mean u, defined by the equations
Xi—pn=¢Xio1 — ) +74,

where |¢| < 1 and {Z;} ~ WN(O, 02). From Example 2.2.1 we have y(h) =

p"o?/(1—¢*) andhence v = (1+2Y ;2 ¢")o?/(1 —¢?) = 0/(1 — $)*. Approx-

imate 95 % confidence bounds for y are therefore given by X, & 1.960n~'/2 /(1 — ¢).

Since ¢ and ¢ are unknown in practice, they must be replaced in these bounds by

estimated values.
O

2.4.2 Estimation of ~(-) and p(-)

Recall from Section 1.4.1 that the sample autocovariance and autocorrelation functions
are defined by

n—|h|
Py =n"" Y (Xesy — Xa) (X, — X,.) (2.4.4)
t=1
and
AL
h) = ——. 2.4.5
p(h) 2 0) (2.4.5)

Both the estimators (k) and / (k) are biased even if the factor n~! in (2.4.4) is replaced
by (n — h)~!. Nevertheless, under general assumptions they are nearly unbiased for
large sample sizes. The sample ACVF has the desirable property that for each k > 1
the k-dimensional sample covariance matrix
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7(0) y) e pk—1)
. v (1 7 (0 e Pk—2
F, = V(:) y(:) y( | ) (2.4.6)
yk—=1) ypk-=2) ---  p(0)

is nonnegative definite. To see this, first note that if [, is nonnegative definite, then
'k is nonnegative definite for all k < m. So assume k > n and write

[y =n 7T,
where T is the k x 2k matrix
0O --- 0 0 Y Y, e Y
0 - 0 Y Y, - Y, O
T == . . )
0O Y Y - Y 0--- 0

Y,~=X,~—}_(n,i= I,...,n,and Y; =0fori =n+1, ...,k Then for any real k x 1
vector a we have

aTwa=n"aT)(Ta) >0, (2.4.7)

and consequently the sample autocovariance matrix ['; and sample autocorrelation
matrix

R, =T}/v(0) (2.4.8)

are nonnegative definite. Sometimes the factor n~! is replaced by (n — h)~! in the
definition of 9 (h), but the resulting covariance and correlation matrices f‘,, and IA?,,
may not then be nonnegative definite. We shall therefore use the definitions (2.4.4)
and (2.4.5) of p (h) and p(h).

Remark 1. The matrices fk and IAik are in fact nonsingular if there is at least one
nonzero Y;, or equivalently if  (0) > 0. To establish this result, suppose that y (0) > 0
and I} is singular. Then there is equality in (2.4.7) for some nonzero vector a, implying
that a’T = 0 and hence that the rank of T is less than k. Let Y; be the first nonzero
value of Y1, Y», ..., Y, and consider the k x k submatrix of T consisting of columns
(i + 1) through (i + k). Since this matrix is lower right triangular with each diagonal
element equal to Y;, its determinant has absolute value |Y;|* # 0. Consequently, the
submatrix is nonsingular, and 7 must have rank k, a contradiction. O

Without further information beyond the observed data Xi, ..., X,, it is impos-
sible to give reasonable estimates of y (k) and p(h) for h > n. Even for h slightly
smaller than n, the estimates 7 (h) and p(h) are unreliable, since there are so few pairs
(X;1n, X;) available (only one if # = n — 1). A useful guide is provided by Jenkins
(1976), p. 33 who suggest that n should be at least about 50 and & < n/4.

The sample ACF plays an important role in the selection of suitable models for
the data. We have already seen in Example 1.4.6 and Section 1.6 how the sample ACF
can be used to test for iid noise. For systematic inference concerning p(h), we need
the sampling distribution of the estimator 6 (k). Although the distribution of o(h) is
intractable for samples from even the simplest time series models, it can usually be
well approximated by a normal distribution for large sample sizes. For linear models
and in particular for ARMA models (see Theorem 7.2.2 of Brockwell and Davis (1991)
for exact conditions) p, = (o(1), ..., p(k))’ is approximately distributed for large n
as N(og, n~'W), ie.,
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Example 2.4.2

Example 2.4.3

p~N(p,n'W), (2.4.9)

where p = (p(1), ..., p(k)), and W is the covariance matrix whose (i, j) element
is given by Bartlett’s formula

Wij = Z {pk+Dptk+j) + ptk = Dptk+)) +2p0)p(j)p* (k)
=20 Mpk ) — 20()p K)ok + D)),
Simple algebra shows that

wi =Y {plk+i) + plk—i) —2p(0)pk)}
k=1
x {plk+j) + ple— ) = 2p(Dp ()}, (2.4.10)

which is a more convenient form of w;; for computational purposes.

iid Noise
If {X;} ~ HD(O, 02), then p(h) = 0 for |h| > 0, so from (2.4.10) we obtain

1 ifi=j,
W,‘j =
0 otherwise.
For large n, therefore, p(1), ..., 6(h) are approximately independent and identically

distributed normal random variables with mean 0 and variance n~'. This result is the
basis for the test that data are generated from iid noise using the sample ACF described
in Section 1.6. (See also Example 1.4.6.)

O

An MA(1) Process
If {X,} is the MA(1) process of Example 1.4.4, i.e., if

Xt=Zt+GZt71, t=0,:i:1,...,
where {Z;} ~ WN(0, ¢2), then from (2.4.10)
1—3p2(1) +4p*(1), ifi=1,

Wi =
1+ 20%(1), ifi > 1,
is the approximate variance of n='/2(p(i) — p(i)) for large n. In Figure 2-1 we have
plotted the sample autocorrelation function p(k), k = 0, ..., 40, for 200 observations
from the MA(1) model
Xl == Zt - .8Zt_1, (2.4.11)

where {Z,} is a sequence of iid N(0, 1) random variables. Here p(1) = —0.8/1.64 =
—0.4878 and p(h) = O for h > 1. The lag-one sample ACF is found to be o6(1) =
—0.4333=—6.1281n""/2, which would cause us (in the absence of our prior knowledge
of {X;}) to reject the hypothesis that the data are a sample from an iid noise sequence.
The fact that |p(h)|<1.96n='/2 for h=2, ..., 40 strongly suggests that the data are
from a model in which observations are uncorrelated past lag 1. Figure 2-1 shows
the bounds 1.96n'/2(14 2p%(1))!/2, indicating the compatibility of the data with
the model (2.4.11). Since, however, p(1) is not normally known in advance, the
autocorrelations 6(2), ..., p(40) would in practice have been compared with the more
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Figure 2-1

The sample autocorrelation
function of n = 200
observations of the MA(1)
process in Example 2.4.3,
showing the bounds
+1.96n~1/2(14252(1))1/2

Example 2.4.4
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0.4

ACF

0.0

-0.2
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stringent bounds 31.96n'/2? or with the bounds £1.96n~'/2(14+252(1))!/? in order
to check the hypothesis that the data are generated by a moving-average process
of order 1. Finally, it is worth noting that the lag-one correlation —0.4878 is well
inside the 95 % confidence bounds for p(1) given by p(1) & 1.96n'/2(1 — 35%(1) +
45*(1))"/?2 = —0.4333 £ 0.1053. This further supports the compatibility of the data
with the model X; = Z; — 0.8Z,_;.

([l
An AR(1) Process
For the AR(1) process of Example 2.2.1,
Xi = ¢Xi1 + 7,
where {Z,} is iid noise and |¢| < 1, we have, from (2.4.10) with p(h) = ¢!,
i oo
if 45— 2 —i i\2
wi =Y ¢ (¢ ="+ Y % (p7 — ¢
k=1 k=i+1
= (1-¢¥)(1+¢)(1—¢) " —2ip*, (2.4.12)

i = 1,2,.... In Figure 2-2 we have plotted the sample ACF of the Lake Huron

residuals yi, ..., yog from Figure 1-10 together with 95 % confidence bounds for
p(), i=1,...,40, assuming that data are generated from the AR(1) model
Yt = 0'791Yt—1 + Zt (2.4.13)

[see equation (1.4.3)]. The confidence bounds are computed from 5 (i) £ 1.96n~!/2

wi/?, where wy; is given in (2.4.12) with ¢ = 0.791. The model ACF, p(i) =
(0.791)/, is also plotted in Figure 2-2. Notice that the model ACF just touches
the confidence bounds at lags 2—4. This suggests some incompatibility of the data with
the model (2.4.13). A much better fit to the residuals is provided by the second-order
autoregression defined by (1.4.4).

O
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2.5 Forecasting Stationary Time Series

We now consider the problem of predicting the values X,,,;, 2 > 0, of a stationary
time series with known mean u and autocovariance function y in terms of the

values {X,, ..., X1}, up to time n. Our goal is to find the linear combination of
1, X,, X,_1, ..., Xj, that forecasts X,,,;, with minimum mean squared error. The best
linear predictor in terms of 1, X, ..., X; will be denoted by P, X, and clearly has
the form

Pan+h = day +611Xn + .. +ClnX1.

It remains only to determine the coefficients ag, a;, .
minimize

(2.5.1)
.., ay,, by finding the values that

S(ag, ..., an) = EXyon — ap — a1 X, — - - - — a,X))>. (2.5.2)
(We already know from Problem 1.1 that PoY = E(Y).) Since S is a quadratic function

of aq, ..., a, and is bounded below by zero, it is clear that there is at least one value of
(agp, ..., a,) that minimizes S and that the minimum (ay, . . ., a,) satisfies the equations
dS(ay, ..., a, )
(@ )=o, ji=0,...,n. (2.5.3)
aaj
Evaluation of the derivatives in equation (2.5.3) gives the equivalent equations
E [Xn+h —ap— ) aan+1i] =0, (2.5.4)
i=1
E |:(Xn+h —ay — Z Clan+1_i)Xn+1_j:| = 0, ] = 1, e, N (255)
i=1
These equations can be written more neatly in vector notation as
ap = (1 — Za,.) (2.5.6)
i=1



56

Chapter 2

Stationary Processes

and
Lpa, = va(h), (2.5.7)
where
a, = (ar,....a), =[rG-pl
and
Yu(h) = (y (), y(h+ 1), ..., y(h+n—1)".
Hence,

PiXoen =+ Y aiXusii — 1), (2:5.8)
i=1

where a, satisfies (2.5.7). From (2.5.8) the expected value of the prediction error
Xpen — PuX,yh 1s zero, and the mean square prediction error is therefore

EXyon— PuXon) = v(©0) = 2> ay(h+i— 1)+ Y > ay(i—ja

i=1 i=1 j=1
=y (0) —a,y.(h), (2.5.9)
where the last line follows from (2.5.7).
Remark 1. To show that equations (2.5.4) and (2.5.5) determine P,X, . uniquely,

let { o ,j=0,. ,n} and { @ ,j=0,. } be two solutions and let Z be the
dlfference between the correspondmg predlctors, ie.,

Z=a —a® +Z( M _ (2>> .
Then

1 2 1 2
22=7d" - (>+Z<() ()) 1

But from (2.5.4) and (2.5.5) we have EZ = O and E(Z X)) = Oforj =1, ...,
Consequently, £(Z%) = 0 and hence Z = 0.

0=

Properties of P, X,,.:

=

P, X, = ;H—Z?Zl a;(X,11-;i—u), where a,, = (ay, ..., a,) satisfies (2.5.7).
2. EXpin — PuXon)* = v (0) — a7y, (h), where ~,(h) = (y (h), ...,y (h+n—
1)).

E(Xn+h - Pan+h) = 0.

4. E[(Xp4n — PuXon)Xj1=0,j=1,...,n

@

Remark 2. Notice that properties 3 and 4 are exactly equivalent to (2.5.4) and (2.5.5).
They can be written more succinctly in the form
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Example 2.5.1

E[(Error) x (PredictorVariable)] = 0. (2.5.10)

The equations (2.5.10), one for each predictor variable, therefore uniquely determine
P an+h- U

One-Step Prediction of an AR(1) Series
Consider now the stationary time series defined in Example 2.2.1 by the equations
Xt:¢Xt—l+Zl7 IIO,:EI,...,

where |¢| < 1 and {Z,} ~ WN(O, 02). From (2.5.7) and (2.5.8), the best linear
predictor of X, in terms of {1, X,,, ..., X;} is (forn > 1)

Pan+1 = a;Xn,
where X, = (X,,, ..., X;) and

1L 9 ¢ ¢ [a ¢
¢ 1 ¢ ¢ @ ¢*

2.5.11)

o ¢ 9 1 [ La] Lo
A solution of (2.5.11) is clearly
a, = (¢,0,...,0),
and hence the best linear predictor of X, in terms of {X, ..., X,,} is
P, X1 = a X, = ¢X,,

with mean squared error

2
EXps1 — PuXpy1)> = y(0) — al (1) = 1i—¢2 —¢y() =0

A simpler approach to this problem is to guess, by inspection of the equation defining
X,.+1, that the best predictor is ¢X,,. Then to verify this conjecture, it suffices to check
(2.5.10) for each of the predictor variables 1, X,,, ..., X;. The prediction error of the
predictor ¢X, is clearly X,,,; — ¢X,, = Z, 1. But E(Z,.1Y) = O for Y = 1 and for
Y = X;,j = 1,...,n Hence, by (2.5.10), ¢X, is the required best linear predictor
interms of 1, Xi, ..., X,.

]

2.5.1 Prediction of Second-Order Random Variables

Suppose now that Y and W, ..., W; are any random variables with finite second
moments and that the means © = EY, u; = EW,; and covariances Cov(Y,Y),
Cov(Y, W;), and Cov(W;, W)) are all known. It is convenient to introduce the random
vector W = (W,, ..., Wy)/, the corresponding vector of means Ly, = (U, - - -, 11)/,
the vector of covariances

Y= COV(Y7 W) = (COV(Ya vvn)a COV(Y7 Wn—l)a B COV(Y7 Wl))/a
and the covariance matrix

' = Cov(W, W) = [Cov(W,11-i, Way1))]

n

i,j=1"



58

Chapter 2

Stationary Processes

Example 2.5.2

Then by the same arguments used in the calculation of P, X, the best linear predictor
of Y in terms of {1, W,,, ..., W;} is found to be

P(YIW) = puy +a' (W — pny), (2.5.12)
where a = (ay, ..., a,)’ is any solution of

a=-~. (2.5.13)
The mean squared error of the predictor is

E[(Y — P(Y|W))*] = Var(Y) — a'. (2.5.14)

Estimation of a Missing Value
Consider again the stationary series defined in Example 2.2.1 by the equations
Xl=¢lel+Zl’ t=0,:l':1,...,

where |¢| < 1 and {Z;} ~ WN(O, 02). Suppose that we observe the series at times 1
and 3 and wish to use these observations to find the linear combination of 1, X;, and X3
that estimates X, with minimum mean squared error. The solution to this problem can
be obtained directly from (2.5.12) and (2.5.13) by setting ¥ = X, and W = (X1, X3)'.
This gives the equations

N
a= )
o 1 ¢
with solution
__ L e
T [qﬁ] '

The best estimator of X, is thus

¢

P(X,|W) = X+ X3),
(X2|W) 1+¢2(1+ 3)
with mean squared error
po’
o’ 1 —¢? o?
E[(X; — P(X2]W))?] = —a = :
[0 = POGIW)] = 1= vo? |~ Tig
1—¢? O
2.5.2 The Prediction Operator P(-|W)
For any given W = (W,,, ..., W;)" and Y with finite second moments, we have seen
how to compute the best linear predictor P(Y|W) of Y in terms of 1, W,, ..., W,

from (2.5.12) and (2.5.13). The function P(-|W), which converts Y into P(Y|W),
is called a prediction operator. (The operator P, defined by equations (2.5.7) and
(2.5.8) is an example with W = (X, X,,_1, ..., X)) Prediction operators have a
number of useful properties that can sometimes be used to simplify the calculation of
best linear predictors. We list some of these below.
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Example 2.5.3

Example 2.5.4

Properties of the Prediction Operator P( -| W):
Suppose that EU? < o0, EV? < oo, ' = Cov(W, W), and B, oy, ...,q, are
constants.

P(UW) = EU + a'(W — EW), where I'a = Cov(U, W).
E[(U—-PWUW)W]=0and E[U — P(UW)] =0.

E[(U — P(UIW))?] = Var(U) — a’Cov(U, W).

Pl U+ arV + BIW) = o1 P(U|W) + ap P(VIW) + B.

P(X_ aiWi+ BIW) = S, aiW; + B.

P(U|W) = EU if Cov(U, W) = 0.

P(UIW) = P(P(U|W, V)|W) if V is a random vector such that the compo-
nents of E(VV’) are all finite.

AR S ol M e

One-Step Prediction of an AR(p) Series
Suppose now that {X,} is a stationary time series satisfying the equations
Xl=¢1Xl71+“'+¢le‘fp+Zﬁ t:()vj:la"'v

where {Z;} ~ WN(O, 02) and Z; is uncorrelated with X for each s < t. Then if
n > p, we can apply the prediction operator P, to each side of the defining equations,
using properties (4), (5), and (6) to get

Pan+l = ¢1Xn +--+ d)an+l—p-

An AR(1) Series with Nonzero Mean

The time series {Y;} is said to be an AR(1) process with mean u if {X; =Y, — u}isa
zero-mean AR(1) process. Defining {X;} as in Example 2.5.1 and letting ¥, = X, + p,
we see that Y; satisfies the equation

Yi—pnu=¢ 1 —wn +72. (2.5.15)

If P,Y,, is the best linear predictor of Y, in terms of {1, Y,, ..., Y}, then appli-
cation of P, to (2.5.15) witht =n+ 1,n+ 2, ... gives the recursions

P Yyin—p=¢PpYppn—1— ), h=172,....

Noting that P,Y, = Y,, we can solve these equations recursively for P,Y,.s,
h=1,2,...,toobtain

PYuin = p+¢" (Y, — ). (2.5.16)
The corresponding mean squared error is [from (2.5.14)]

EYusn — PaYoin)® = y O)[1 —a,p0,()]. (2.5.17)

From Example 2.2.1 we know that y (0) = 02/(1 — ¢2) and p(h) = ¢", h > 0. Hence,
substituting a, = (¢", 0, ..., 0)’ [from (2.5.16)] into (2.5.17) gives

E(Ypin — PoYoin)® = 0 (1= ¢™) /(1 - ¢°). (25.18)
g
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Remark 3. In general, if {Y;} is a stationary time series with mean w and if {X,} is
the zero-mean series defined by X; = Y, — u, then since the collection of all linear
combinations of 1, Y,,, ..., Y7 is the same as the collection of all linear combinations of
1, X, ..., X1, the linear predictor of any random variable W in termsof 1, Y,, ..., ¥}
is the same as the linear predictor in terms of 1, X,,, ..., X;. Denoting this predictor by
P,W and applying P, to the equation Y, = X, + u gives

PYoin = b+ PuXoin. (2.5.19)

Thus the best linear predictor of Y, , can be determined by finding the best linear
predictor of X,,,, and then adding w. Note from (2.5.8) that since E(X;) = 0, P, X, 11
is the same as the best linear predictor of X,,,; in terms of X,,, ..., X; only. ]

2.5.3 The Durbin-Levinson Algorithm

In view of Remark 3 above, we can restrict attention from now on to zero-mean
stationary time series, making the necessary adjustments for the mean if we wish to
predict a stationary series with nonzero mean. If {X,} is a zero-mean stationary series
with autocovariance function y (-), then in principle the equations (2.5.12) and (2.5.13)
completely solve the problem of determining the best linear predictor P,X;,+ of X, 1
in terms of {X,, ..., X;}. However, the direct approach requires the determination
of a solution of a system of n linear equations, which for large n may be difficult
and time-consuming. In cases where the process is defined by a system of linear
equations (as in Examples 2.5.2 and 2.5.3) we have seen how the linearity of P, can
be used to great advantage. For more general stationary processes it would be helpful
if the one-step predictor P,X, . based on n previous observations could be used to
simplify the calculation of P,;X,,, the one-step predictor based on n + 1 previous
observations. Prediction algorithms that utilize this idea are said to be recursive. Two
important examples are the Durbin-Levinson algorithm, discussed in this section, and
the innovations algorithm, discussed in Section 2.5.4 below.
We know from (2.5.12) and (2.5.13) that if the matrix [',, is nonsingular, then

P Xpi1 = ¢, X, = Xy + - + duaXi,

where
¢ =T, ",

Vo = (y(1), ..., y(m), and the corresponding mean squared error is
vy 1= EXst = PuXur1)® = v (0) = %

A useful sufficient condition for nonsingularity of all the autocovariance matrices
['1,,,...i18 y(0) > 0and y(h) — 0 as h — oo. (For a proof of this result see
Brockwell and Davis (1991), Proposition 5.1.1.)
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The Durbin-Levinson Algorithm:

The coefficients ¢, ..., ¢, can be computed recursively from the equations
n—1
b= | () =Y burjy(n—Jj) | v, (2.5.20)
J=1
d)nl (bn—l,l ¢n—l,n—l
¢n,n71 ¢n71,n71 ¢n71,1
and
Vo =Vt [1 — by, (2.5.22)

where ¢1; = y(1)/y(0) and vo = ¥ (0).

Proofs 1 The definition of ¢;; ensures that the equation

Rn(pn = Py (2523)

(where p, = (p(1), ..., p(n))’) is satisfied for n = 1. The first step in the proof is to
show that ¢,,, defined recursively by (2.5.20) and (2.5.21), satisfies (2.5.23) for all n.
Suppose this is true for n = k. Then, partitioning Ry and defining

i) = (pk), pk = 1), ..., p(1)Y

and

lgr) = (Pues Prok—ts - - Pr1)'s

we see that the recursions imply

R, p. _ ")
Rit 10141 =[ ) p,{ ”:‘pk ¢¢k+1,k+1¢k
P k+1,k+1

_ |: — G141y F Drsrxs1 0y :|
(r)/ (r), r)
Ok — Pit1,k+1Py, + Drt1.h+1

= Pr+t1>

as required. Here we have used the fact that if Ry¢, = p,, then qu‘)(r) = (r). This is
easily checked by writing out the component equations in reverse order. Slnce (2.5.23)
is satisfied for n = 1, it follows by induction that the coefficient vectors ¢, defined
recursively by (2.5.20) and (2.5.21) satisfy (2.5.23) for all n.

It remains only to establish that the mean squared errors

vy i= EXpyr — ¢,X,,)?

satisfy vy = y(0) and (2.5.22). The fact that vy = y (0) is an immediate consequence
of the definition PoX; := E(X;) = 0. Since we have shown that ¢/ X, is the best linear
predictor of X,,,1, we can write, from (2.5.9) and (2.5.21),

Vp = V(O) - ¢,/,)/n = V(O) - ¢;1—1’7ﬂ—1 + ¢nn¢,(1?/17n—1 - ¢nny(n)-
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Applying (2.5.9) again gives

Vp = Vy—1 + ¢nn <¢,(,}2/1’7an - ]/(l’l)) s
and hence, by (2.5.20),
Vo = Vo1 = G, (¥ (0) = & yu 1) = vu (1= 07, - u

Remark 4. Under the conditions of the proposition, the function defined by «(0) =
1 and a(n) = ¢, n = 1,2,...,1s known as the partial autocorrelation function
(PACF) of {X,}, discussed further in Section 3.2. Equation (2.5.22) shows the relation
between «(n) and the reduction in the one-step mean squared error as the number of
predictors is increased from n — 1 to n. O

2.5.4 The Innovations Algorithm

The recursive algorithm to be discussed in this section is applicable to all series with

finite second moments, regardless of whether they are stationary or not. Its application,

however, can be simplified in certain special cases.
Suppose then that {X;} is a zero-mean series with E|X;,

EX: X)) =« (i, j)- (2.5.24)

|> < oo for each 7 and

We denote the best one-step linear predictors and their mean squared errors by
. 0, ifn=1,
X

P,1X,, ifn=23...,
and

Vp = E(Xn+l - Pan+1)2-

We shall also introduce the innovations, or one-step prediction errors,

U, = X, — X,..
In terms of the vectors U,, = (U4, ..., U,) and X,, = (X1, ..., X,)’ the last equations
can be written as

U, =A,X,, (2525)
where A,, has the form

1 0 0 ]
an 1 0
A, = a asy 1

- o O O O

L An—1,n—1 ap—1,n-2 ap—1,n-3

(If {X,} is stationary, then a;; = —a; with a; as in (2.5.7) with & = 1.) This implies that
A, is nonsingular, with inverse C, of the form

1 0 0 0
011 1 0 0
C, = ) 621 1 0
: 0
[ On—1n—1 On—1n—2  Ou—1.n-3 1]
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The vector of one-step predictors X,, = (X1, P X,, ..., P,_1X,) can therefore be
expressed as

Xn = Xn - Un = CnUn - Un = ®n <Xn - Xn) s (2526)
where
0 0 0 07]
011 0 0 0
0, = 02 621 0 0
: 0
_911—1,11—1 9n—l,n—2 9n—l,n—3 0_
and X, itself satisfies
X, = C, (X,, — X) . (2.5.27)
Equation (2.5.26) can be rewritten as
0, ifn =0,
Xpp1= 12 . 2.5.28
! Zen] (X}’H“l*j_X}’H»l*j) ’ lfn: 1727 L | ( )
J=1
from which the one-step predictors X1, X5, ... can be computed recursively once

the coefficients 6; have been determined. The following algorithm generates these

. a\2 .
coefficients and the mean squared errors v; = E (Xl-+1 — Xi+1) , starting from the
covariances « (I, j).

The Innovations Algorithm:

The coefficients 6,,, ..., 6,, can be computed recursively from the equations
vo =k (1, 1),
k-1
Gn.n—k = V,:l K(n +1,k+ 1) — ZGk,k_jGn,n_jvj , 0<k<n,
j=0
and

n—1
vy = K(n +Ln+ 1) - Zein—jvj‘

Jj=0
(It is a trivial matter to solve first for vy, then successively for 6, v;; 622,
021, va; 033, 032, 031, v35 ....)

Proof See Brockwell and Davis (1991), Proposition 5.2.2. [ |

Remark 5. While the Durbin-Levinson recursion gives the coefficients of X,,, ..., X;
in the representation X, = 2721 ®njX,+1-j, the innovations algorithm gives the
coefficients of (X,, — X,,), e, (X1 - X 1), in the alternative expansion X, =
Z]rf:l GW»(X,,H,]- — )A(nﬂ,j). The latter expansion has a number of advantages deriving
from the fact that the innovations are uncorrelated (see Problem 2.20). It can also be

greatly simplified in the case of ARMA(p, g) series, as we shall see in Section 3.3.
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An immediate consequence of (2.5.28) is the innovations representation of X, itself.
Thus (defining 6,9 := 1),

Xn+l = Xn-i—l _)A(n+l +5\(n+1 = Zenj <Xn+l—j - }A(il—i-l—j) s n= 0, 1, 2, e
j=0
]

Recursive Prediction of an MA(1)
If {X,} is the time series defined by
Xl‘ = ZI + 021‘71’ {Zt} ~ WN (Ov 02) )

thenk (i, j) = Ofor |i—j| > 1,k (i, i) = 0*(1+6?),and k (i, i+1) = 6o>. Application
of the innovations algorithm leads at once to the recursions

6y=0,2<j<n,
O = v, 007,
vo = (1+6%)07,
and
vo = [1+6% =, 0%0%] 0.
For the particular case
X, =27,—09Z,_,, {Z]}~ WN(Q,1),

the mean squared errors v, of X, and coefficients 6,;, 1 < j < n, in the innovations
representation

XnJrl = Z an (Xn+17j - XnJrlfj) = Uni (Xn - Xn)
j=1

are found from the recursions to be as follows:

vo = 1.8100,

011 = —0.4972, v, =1.3625,

921 = —06606, 922 = 0, V) = 12155,

031 = —0.7404, 03 =0, 033 =0, vy = 1.1436,

041 = —0.7870, 04 =0, 043 = 0, 044 = 0, vq = 1.1017.

If we apply the Durbin—Levinson algorithm to the same problem, we find that the
mean squared errors v, of X, and coefficients ¢,;, 1 <j < n, in the representation

n
Xn+l = E (bann—i-l—j
j=1

are as follows:

vo = 1.8100,
¢11 = —0.4972, vi = 1.3625,
@1 = —0.6606, ¢y = —0.3285, vy = 1.2155,
@31 = —0.7404, @3 = —0.4892, ¢33 = —0.2433, vz = 1.1436,
P41 = —0.7870, P40 = —0.5828, g3 = —0.3850, g4 = —0.1914, v4 =1.1017.
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Notice that as n increases, v, approaches the white noise variance and 6,,; approaches 6.
These results hold for any MA(1) process with |#| < 1. The innovations algorithm
is particularly well suited to forecasting MA(g) processes, since for them 6,; = 0
for n — j > g. For AR(p) processes the Durbin-Levinson algorithm is usually more
convenient, since ¢,; = 0 forn —j > p.

O

2.5.5 Recursive Calculation of the h-Step Predictors
For h-step prediction we use the result

Py(Xpk — Prx—1Xun) =0, k> 1. (2.5.29)
This follows from (2.5.10) and the fact that

E[(Xptk — Pusk—1Xnrk — 0)Xpyj—11=0, j=1,...,n
Hence,

PpXoin = PuPryn—1Xnyn

= Pnf(n-kh

n+h—1
= Pn( Z Ontn—1.j (Xn+h7j - n+h7j> )
=1

Applying (2.5.29) again and using the linearity of P, we find that

n+h—1
Py Xyin = Z Onh—1, (Xn+h7j - Xn+h7j> , (2.5.30)
j=h

where the coefficients 6,; are determined as before by the innovations algorithm.
Moreover, the mean squared error can be expressed as

EXpin — PiXoin)” = EXz oy — E(PuXnin)’

n+h—1
=km+hn+h) = Y 07, a1, (2.531)
Jj=h

2.5.6 Prediction of a Stationary Process in Terms of Infinitely
Many Past Values

It is often useful, when many past observations X,,, ..., Xo, X1,..., X, (m < 0)
are available, to evaluate the best linear predictor of X, in terms of 1, X,,, ..., Xo,
..., Xn. This predictor, which we shall denote by P, ,X,+», can easily be evaluated
by the methods described above. If |m| is large, this predictor can be approximated by
the sometimes more easily calculated mean square limit

Pan+h = lim Pm,an+h-
m—>—00

We shall refer to P, as the prediction operator based on the infinite past, {X,,
—00 < t < n}. Analogously we shall refer to P, as the prediction operator based
on the finite past, {Xy, ..., X,,}. (Mean square convergence of random variables is
discussed in Appendix C.)
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2.5.7 Determination of i’,,X,,+h

If {X,,} is a zero-mean stationary process with autocovariance function y (-) then, just as
P, X, is characterized by equation (2.5.10), P,X,1 is characterized by the equations

E [(XH,, — 13,,Xn+,,) X,,H,l] —0, i=1,2,....

If we can find a solution to these equations, it will necessarily be the uniquely defined
predictor P,X, ;. An approach to this problem that is often effective is to assume that
P,X, 1+, can be expressed in the form

o
Pan—i-h = Zann+l—j’
j=1
in which case the preceding equations reduce to
o
E| | Xuen =Y aXurio | Xupioi | =0, i=1,2,...,
j=1
or equivalently,

o
Y yli—pey=yh+i—1), i=12....

Jj=1

This is an infinite set of linear equations for the unknown coefficients «; that determine
P.X,1n, provided that the resulting series converges.

Properties of P,:
Suppose that EU? < o0, EV? < o0, a,b, and ¢ are constants, and I' =
Cov(W, W).

L. E[(U—P,(U)X;] =0, j<n.

2. P,(aU + bV + ¢) = aP,(U) + bP,(V) +c.

3. P,(U) = U if U is a limit of linear combinations of X, j < n.
4. P,(

2(U) = EU if Cov(U, X;) =0forallj <n.

_ These properties can sometimes be used to simplify the calculation of
P,X,r, notably when the process {X;} is an ARMA process.

Consider the causal invertible ARMA(1,1) process {X;} defined by

X, — X1 =Z,+0Z_, {Z}~WN(0,0?).
We know from (2.3.3) and (2.3.5) that we have the representations
o0
Xos1 =Zop1 + (0 +0) Y ¢/ Z1
j=1
and

o
Zo1 =Xup1 — (0 +0) > (=)' X1y

Jj=1
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Applying the operator P, to the second equation and using the properties of P, gives

PXoy1 = (¢ +6) ) (=0) "Xy,

j=1

Applying the operator P, to the first equation and using the properties of P, gives

o
PXoyi =@ +60)) ¢ ' Zip1

j=1
Hence,

X1 — PuXos1 = Zuy1s

and so the mean squared error of the predictor f’,,XnH 18 EZ}% = o2

2.6 The Wold Decomposition

Consider the stationary process
X; = A cos(wt) + Bsin(wt),

where w € (0, ) is constant and A, B are uncorrelated random variables with mean 0
and variance o 2. Notice that

X, = (2cosw)X,_ | — Xpp =P,_1X,, n=0,%+1,...,

so that X,, — P,_1X,, = O for all n. Processes with the latter property are said to be
deterministic.

The Wold Decomposition:
If {X;} is a nondeterministic stationary time series, then

X, =Y ¥iZij+ Ve (2.6.1)

J=0

where

Yo =1and Y %) ¥} < oo,
{Z} ~WN (0,0?),

Cov(Zg, V;) = 0for all s and ¢,
Z, = IBIZ, for all ¢,

V, = IBS V, for all s and ¢, and
{V;} is deterministic.

AR N e

Here as in Section 2.5, P,Y denotes the best predictor of Y in terms of linear com-
binations, or limits of linear combinations of 1, X;, —co < s < t. The sequences
{Z}, {;}, and {V;} are unique and can be written explicitly as Z, = X, — f’,_lX,,
Yy = E(X,.Z)|E(Z]), and V, = X, — 32 ¥;Z, ;. (See Brockwell and Davis (1991),
p. 188.) For most of the zero-mean stationary time series dealt with in this book
(in particular for all ARMA processes) the deterministic component V, is 0 for all
t, and the series is then said to be purely nondeterministic.
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Problems

IfX, = U, + Y, where {U;} ~ WN (0, vz), E(U,;Y) = 0 for all #, and Y has mean
0 and variance 72, then 13t,1X, = Y, since Y is the mean square limit as s — oo of
[Xi—1 + -+ Xi—1/s, and E[(X; — Y)X,] = O for all s < ¢t — 1. Hence the sequences
in the Wold decomposition of {X,} are given by Z;, = U, Yo = 1, ; = O forj > 0,
andV, =Y.

2.1

2.2

2.3

24

2.5

2.6

O

Suppose that X;, X5, ..., is a stationary time series with mean p and ACF p(-).
Show that the best predictor of X, of the form aX,, + b is obtained by choosing

a=p(h)and b = (1l — p(h)).
Show that the process
X; = Acos(wt) + Bsin(wt), t=0,=*£1,...

(where A and B are uncorrelated random variables with mean O and variance 1
and w is a fixed frequency in the interval [0, 7]), is stationary and find its mean
and autocovariance function. Deduce that the function x(h) = cos(wh), h =
0, £1, ..., is nonnegative definite.

a. Find the ACVF of the time series X; = Z, + 0.3Z,_; — 0.4Z,_,, where {Z,} ~
WN(, 1).

b. Find the ACVF of the time series Y, = Z — 1.22,,1 — 1.62,,2, where {Z} ~
WN(O0, 0.25). Compare with the answer found in (a).

It is clear that the function « (k) = 1, h = 0, &1, ..., is an autocovariance func-
tion, since it is the autocovariance function of the process X; = Z,t =0, £1, .. .,
where Z is a random variable with mean O and variance 1. By identifying
appropriate sequences of random variables, show that the following functions
are also autocovariance functions:

a. k(h) = (="

wh mh
b. k(h) =1+ cos (7> + cos <T)

I, ifh=0,
c. k(h)y=1404, ifh==%l,

0, otherwise.

Suppose that {X,,t = 0, £1, ...} is stationary and that |#| < 1. Show that for
each fixed n the sequence

Sy = Xm: 0/X,_;
j=1

is convergent absolutely and in mean square (see Appendix C) as m — oo.

Verify the equations (2.2.6).
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2.7

2.8

2.9

2.10

2.11

2.12

2.13

Show, using the geometric series 1/(1 — x) = Zfioxj for |x| < 1, that 1/(1—
¢z) = — Zf:l ¢z for |¢p| > 1 and |z| > 1.
Show that the autoregressive equations

XI=¢1XI71+ZI7 t=07:l:17"'7

where {Z,} ~ WN(O, 02) and |¢| = 1, have no stationary solution. HINT:
Suppose there does exist a stationary solution {X,} and use the autoregressive
equation to derive an expression for the variance of X; — d)’fHX,_n_l that con-
tradicts the stationarity assumption.

Let {Y;} be the AR(1) plus noise time series defined by
Yi=X,+W,

where {W,} ~ WN(O, ai), {X;} is the AR(1) process of Example 2.2.1, i.e.,
X — ¢Xio1 = Zi, {Z) ~ WN(0,07)

and E(W,Z,) = 0 for all s and t.
a. Show that {Y;} is stationary and find its autocovariance function.
b. Show that the time series U, := Y; — ¢Y,_; is 1-correlated and hence, by
Proposition 2.1.1, is an MA(1) process.
c. Conclude from (b) that {Y;} is an ARMA(1,1) process and express the
three parameters of this model in terms of ¢, ‘7»%’ and azz.
Use the program ITSM to compute the coefficients ¥; and j, j = 1,...,5, in
the expansions

oo
X = Z 1/ijtfj
j=0

and

(0.¢]
Zt == Z anf—l
j=0

for the ARMA(1,1) process defined by the equations
X, —0.5X,_1 = Z + 0.5Z,_1, {Z}~ WN(0,07).

(Select File>Projects>News>Univariate, then Model>Specify.
In the resulting dialog box enter 1 for the AR and MA orders, specify
¢(1) = 6() = 0.5, and click OK. Finally, select Model>AR/MA
Infinity>Default lag and the values of ¥; and 7r; will appear on the
screen.) Check the results with those obtained in Section 2.3.
Suppose that in a sample of size 100 from an AR(1) process with mean u, ¢ = .6,
and o2 = 2 we obtain X;o9 = 0.271. Construct an approximate 95 % confidence
interval for p. Are the data compatible with the hypothesis that u = 0?
Suppose that in a sample of size 100 from an MA(1) process with mean ,
0 = —0.6, and 6> = 1 we obtain X0 = 0.157. Construct an approximate
95 % confidence interval for . Are the data compatible with the hypothesis that
w =07
Suppose that in a sample of size 100, we obtain 6(1) = 0.438 and 6(2) = 0.145.
a. Assuming that the data were generated from an AR(1) model, construct
approximate 95 % confidence intervals for both p (1) and p(2). Based on these
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2.14

2.15

2.16

2.17

2.18

two confidence intervals, are the data consistent with an AR(1) model with
¢ =0.8?

b. Assuming that the data were generated from an MA(1) model, construct
approximate 95% confidence intervals for both p(1) and p(2). Based on these
two confidence intervals, are the data consistent with an MA(1) model with
6 =0.6?

Let {X;} be the process defined in Problem 2.2.

a. Find PX, and its mean squared error.

b. Find P,X3 and its mean squared error.

c. Find 13an+1 and its mean squared error.

Suppose that {X;, r = 0, £1, ...} is a stationary process satisfying the equations

X, = ¢1Xt—l +- 4+ ¢pXt—p +Z;,

where {Z,} ~ WN(O, 02) and Z, is uncorrelated with X for each s < r. Show
that the best linear predictor P, X, of X,,1 interms of 1, X1, ..., X,,, assuming
n > p,is

PanJrl = ¢1Xn +--+ ¢an+17p-

What is the mean squared error of P, X, 1?

Use the program ITSM to plot the sample ACF and PACF up to lag 40 of the
sunspot series D;,t = 1, 100, contained in the ITSM file SUNSPOTS.TSM.
(Open the project SUNSPOTS.TSM and click on the second yellow button at the
top of the screen to see the graphs. Repeated clicking on this button will toggle
between graphs of the sample ACF, sample PACF, and both. To see the numerical
values, right-click on the graph and select Info.) Fit an AR(2) model to the
mean-corrected data by selecting Model>Estimation>Preliminaryand
click Yes to subtract the sample mean from the data. In the dialog box that
follows, enter 2 for the AR order and make sure that the MA order is zero and that
the Yule-Walker algorithm is selected without AICC minimization. Click OK
and you will obtain a model of the form

Xi =1 Xi1 + X0+ 7, where {Z;} ~ WN (0, 02) )

for the mean-corrected series X, = D, —46.93. Record the values of the estimated
parameters ¢, ¢,, and o2. Compare the model and sample ACF and PACF by
selecting the third yellow button at the top of the screen. Print the graphs by
right-clicking and selecting Print.

Without exiting from ITSM, use the model found in the preceding problem to
compute forecasts of the next ten values of the sunspot series. (Select Fore-
casting>ARMA, make sure that the number of forecasts is set to 10 and the box
Add the mean to the forecasts is checked, and then click OK. You
will see a graph of the original data with the ten forecasts appended. Right-click
on the graph and then on Info to get the numerical values of the forecasts. Print
the graph as described in Problem 2.16.) The details of the calculations will be
taken up in Chapter 3 when we discuss ARMA models in detail.

Let {X;} be the stationary process defined by the equations

Xt:Zt_QZt_l, IIO,:EI,...,

where |#| < 1 and {Z;} ~ WN (O, 02). Show that the best linear predictor 13an+1
of X, 11 based on {Xj, —00 < j < n}is
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00
Pan+1 = - Ze'/XrH»lfj-
j=1

What is the mean squared error of the predictor P, X, ?

2.19 If {X,} is defined as in Problem 2.18 and & = 1, find the best linear predictor
P,X, 1 0of X,y interms of Xy, ..., X,,. What is the corresponding mean squared
error?

2.20 In the innovations algorithm, show that for each n > 2, the innovation X, — Xn
is uncorrelated with Xy, ..., X,,_;. Conclude that X,, — )A(,, is uncorrelated with
the innovations X; — )Afl, ey Xy — Xn,l.

2.21 Let X;, X5, X4, X5 be observations from the MA(1) model

X, =Z+0Z_,, {Z}~WN(0,07).

a. Find the best linear estimate of the missing value X3 in terms of X; and X,.
b. Find the best linear estimate of the missing value X3 in terms of X4 and Xs.
c. Find the best linear estimate of the missing value X3 in terms of Xi, X», X4,
and Xs.
d. Compute the mean squared errors for each of the estimates in (a)—(c).
2.22 Repeat parts (a)—(d) of Problem 2.21 assuming now that the observations X, X5,
X4, X5 are from the causal AR(1) model

X, =¢X1+Z, {Z}~WN(0,07%).



ARMA Models

3.1 ARMAC(p, g) Processes
3.2 The ACF and PACF of an ARMA(p, g) Process
3.3 Forecasting ARMA Processes

In this chapter we introduce an important parametric family of stationary time
series, the autoregressive moving-average, or ARMA, processes. For a large class of
autocovariance functions y (-) it is possible to find an ARMA process {X;} with ACVF
yx (+) such that y (-) is well approximated by yx(-). In particular, for any positive integer
K, there exists an ARMA process {X;} such that yx(h) = y(h) forh = 0,1, ..., K.
For this (and other) reasons, the family of ARMA processes plays a key role in the
modeling of time series data. The linear structure of ARMA processes also leads to a
substantial simplification of the general methods for linear prediction discussed earlier
in Section 2.5.

3.1 ARMA(p, q) Processes

In Section 2.3 we introduced an ARMA(1,1) process and discussed some of its key
properties. These included existence and uniqueness of stationary solutions of the
defining equations and the concepts of causality and invertibility. In this section we
extend these notions to the general ARMA(p, g) process.

© Springer International Publishing Switzerland 2016 73
P.J. Brockwell, R.A. Davis, Introduction to Time Series and Forecasting,
Springer Texts in Statistics, DOI 10.1007/978-3-319-29854-2_3
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Definition 3.1.1

{X;} is an ARMA(p, ¢q) process if {X;} is stationary and if for every ¢,
Xe =i Xi 1 — = QpXe p=Z+01Zi 1 + -+ 047y, (3.1.1)

where {Z;,} ~ WN (0, 02) and the polynomials (1 —P1z—...— d)pzp) and (1+
bhz+...+ quq) have no common factors.

The process {X;} is said to be an ARMA (p, q) process with mean . if {X, — i}
is an ARMA(p, g) process.
It is convenient to use the more concise form of (3.1.1)

¢(B)X, = 0(B)Z,, (3.1.2)
where ¢ (-) and 6(-) are the pth and gth-degree polynomials
¢p@=1—¢z—- — ¢z’

and
0(2) =1401z+---+6,2%,

and B is the backward shift operator (B/X, = Xi—j, BiZ, = Zi_j,j = 0,%1,...).
The time series {X,} is said to be an autoregressive process of order p (or AR(p)) if
0(z) = 1, and a moving-average process of order ¢ (or MA(g)) if ¢(2) = 1.

An important part of Definition 3.1.1 is the requirement that {X,} be stationary.
In Section 2.3 we showed, for the ARMA(1,1) equations (2.3.1), that a stationary
solution exists (and is unique) if and only if ¢y # =£1. The latter is equivalent to
the condition that the autoregressive polynomial ¢(z) = 1 — ¢p1z 7% 0 for z = 1. The
analogous condition for the general ARMA(p, g) processis ¢(z) =1 —¢p1z—--- —
¢pzP # 0 for all complex z with |z| = 1. (Complex z is used here, since the zeros of a
polynomial of degree p > 1 may be either real or complex. The region defined by the
set of complex z such that |z] = 1 is referred to as the unit circle.) If ¢ (z) # O for all z
on the unit circle, then there exists § > 0 such that

o
_¢(z) = Z ijj forl —6 < |zl < 14386,

J=—0

and Zfifoo |xj| < oo. We can then define 1/¢(B) as the linear filter with absolutely
summable coefficients

1 .
@~ 2

Jj=—00

o]

Applying the operator x (B) := 1/¢(B) to both sides of (3.1.2), we obtain
Xi = xB)p(B)X: = x(B)O(B)Z, = y(B)Z, = Z ViZ—j, (3.1.3)
j=—00

where ¥ (2) = x(2)0(2) = Zf:7 ~ 1//jz-/ . Using the argument given in Section 2.3 for

the ARMA(1,1) process, it follows that v (B)Z, is the unique stationary solution of
(3.1.1).
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Existence and Uniqueness:

A stationary solution {X;} of equation (3.1.1) exists (and is also the unique sta-
tionary solution) if and only if

p@) =1—z—-—¢z” £0 forall|z] =1. (3.1.4)

In Section 2.3 we saw that the ARMA(1,1) process is causal, i.e., that X; can be
expressed in terms of Z;, s < ¢, if and only if |¢;| < 1. For a general ARMA(p, q)
process the analogous condition is that ¢(z) # 0 for |z] < 1, i.e., the zeros of the
autoregressive polynomial must all be greater than 1 in absolute value.

Causality:

An ARMA(p, q) process {X;} is causal, or a causal function of {Z]}, if there
exist constants {v;} such that Zfio |¥j| < oo and

X, =) ;Zjforallt. (3.1.5)

Jj=0
Causality is equivalent to the condition

¢@) =1—d1z— - —dpz” £ 0forall |z] < 1. (3.1.6)

The proof of the equivalence between causality and (3.1.6) follows from elemen-
tary properties of power series. From (3.1.3) we see that {X;} is causal if and only if
x@) =1/¢p() = Z,ﬁo ijj (assuming that ¢ (z) and 6(z) have no common factors).
But this, in turn, is equivalent to (3.1.6).

The sequence {;} in (3.1.5) is determined by the relation ¥ (z) = Z;:o Yzl =
0(z)/¢(z), or equivalently by the identity

(1=¢rz—---=¢2") o+ iz +---) =1+ 0z + -+ 0,27,
Equating coefficients of 7/,j=0,1, ..., we find that

1 = o,

01 = Y1 — Yoo,

0 = Vo — Y11 — Vo2,

or equivalently,

P
V=D bWk =0, j=0.1,..., (3.1.7)
k=1

where 6y := 1, 6; := 0 forj > g, and ; := 0 forj < 0.
Invertibility, which allows Z; to be expressed in terms of X, s < ¢, has a similar
characterization in terms of the moving-average polynomial.
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Example 3.1.2

Invertibility:
An ARMA(p, g) process {X;} is invertible if there exist constants {r;} such that

Z;io |7j| < oo and

o
Z, = Z 7; X, for all z.
j=0
Invertibility is equivalent to the condition

G(Z): 1+91Z+...+9qzq7£0f0rall |Z| < 1.

Interchanging the roles of the AR and MA polynomials, we find from (3.1.7) that
the sequence {7;} is determined by the equations

q
T+ Y Ot =—¢j, j=0,1,..., (3.1.8)
k=1

where ¢ := —1, ¢; :== 0 forj > p, and 7; := 0 for j < 0.
An ARMA(1,1) Process Consider the ARMA(1,1) process {X;} satisfying the equa-
tions

X, —0.5X,_1 =Z,+04Z_,, {Z}~WN(0,0?%). (3.1.9)

Since the autoregressive polynomial ¢(z) = 1 — 0.5z has a zero at z = 2, which is
located outside the unit circle, we conclude from (3.1.4) and (3.1.6) that there exists
a unique ARMA process satisfying (3.1.9) that is also causal. The coefficients {v;} in
the MA (00) representation of {X;} are found directly from (3.1.7):

Yo =1,

¥ =0.4+0.5,

Y2 = 0.5(0.4 +0.5),

¥ =057104+05), j=12,....

The MA polynomial 6(z) = 1 4 0.4z has azero atz = —1/0.4 = —2.5, which is also
located outside the unit circle. This implies that {X;} is invertible with coefficients {m;}
given by [see (3.1.8)]

o =1,

7 = —(0.4+0.5),

1y = —(0.4 +0.5)(—0.4),

7= —(0.4+05)(-04)" j=1,2,....

(A direct derivation of these formulas for {1/;} and {7;} was given in Section 2.3 without
appealing to the recursions (3.1.7) and (3.1.8).)
O

An AR(2) Process
Let {X;} be the AR(2) process
X, =0.7X-1 — 01X, 2 + Z,, {Z} ~WN(0,0?).
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The autoregressive polynomial for this process has the factorization ¢(z) = 1—0.7z+
0.122 = (1 — 0.52)(1 — 0.2z), and is therefore zero at z = 2 and z = 5. Since these
zeros lie outside the unit circle, we conclude that {X,} is a causal AR(2) process with
coefficients {1} given by

Yo =1,
Y1 =0.7,
Vv, =0.77 - 0.1,

Y =079 1 — 0.1, 5, j=2.3,....

While it is a simple matter to calculate ; numerically for any j, it is possible also
to give an explicit solution of these difference equations using the theory of linear
difference equations (see Brockwell and Davis (1991), Section 3.6).
O
The option Model >Specifyof the program ITSM allows the entry of any causal
ARMA(p, g) model with p < 28 and g < 28. This option contains a causality check
and will immediately let you know if the entered model is noncausal. (A causal model
can be obtained by setting all the AR coefficients equal to 0.001.) Once a causal model
has been entered, the coefficients v; in the MA (00) representation of the process can be
computed by selecting Model>AR/MA Infinity. This option will also compute
the AR(o0) coefficients 7;, provided that the model is invertible.

Example 3.1.3 An ARMA(2,1) Process
Consider the ARMA(2,1) process defined by the equations
X, — 0.75X,_1 + 0.5625X, > = Z,+ 1.25Z,_,, {Z}~ WN(0,0?).

The AR polynomial ¢(z) = 1 — 0.75z + 0.5625z> has zeros at 7 = 2 (1 + i«/g)/3,
which lie outside the unit circle. The process is therefore causal. On the other hand,
the MA polynomial 8(z) = 1 4+ 1.25z has a zero at z = —0.8, and hence {X;} is not

invertible.
O

Remark 1. It should be noted that causality and invertibility are properties not of {X;}
alone, but rather of the relationship between the two processes {X;} and {Z;} appearing
in the defining ARMA equations (3.1.1). U

Remark 2. If {X;} is an ARMA process defined by ¢ (B)X, = 6 (B)Z;, where (z) # 0
if |z| = 1, then it is always possible (see Brockwell and Davis (1991), p. 127) to find
polynomials q7>(z) and 6 (z) and a white noise sequence {W,} such that q;(B)X, =6(B)W,
and 6 (z) and q~5 (z) are nonzero for |z| < 1. However, if the original white noise sequence

{Z:} is iid, then the new white noise sequence will not be iid unless {Z;} is Gaussian.
O

In view of Remark 2, we will focus our attention principally on causal and
invertible ARMA processes.

3.2 The ACF and PACF of an ARMA(p, q) Process

In this section we discuss three methods for computing the autocovariance function
y (-) of a causal ARMA process {X;}. The autocorrelation function is readily found
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from the ACVF on dividing by «(0). The partial autocorrelation function (PACF) is
also found from the function ~y(-).

3.2.1 Calculation of the ACVF
First we determine the ACVF y (-) of the causal ARMA(p, g) process defined by
¢(BX, = 0(B)Z, {Z}~WN(0,0°), (3.2.1)

where ¢(z2) =1 —¢1z— - —¢pzP and 0(z) = 1 + 612+ - - - + 0,z9. The causality
assumption implies that

X, =Y ¥iZj. (3.2.2)
j=0

where Y ) 92/ = 6(2)/$(2), |z| < 1. The calculation of the sequence {1;} was
discussed in Section 3.1.

First Method. From Proposition 2.2.1 and the representation (3.2.2), we obtain
o
y(h) = EXnX) = 0> Vit (32.3)
j=0
The ARMAC(1,1) Process
Substituting from (2.3.3) into (3.2.3), we find that the ACVF of the process defined by
X, — X1 =Z,+0Z_, {Z}~WN(0,0%), (3.2.4)
with |¢| < 1 is given by

y(0) =0y v}
j=0

=o’ |1+ @ +0)° ) ¢Y

j=0

(0 +¢)2}
1—¢2 |

=o?|1+

y() =0 Yy
Jj=0

=0’ |0+ + O+ ) ¢¥
J=0
©+ ¢)2¢>]
1—¢2 |’

=0’|0+¢+

and

y(h)y =¢"'y(), h=2.
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Example 3.2.2

Example 3.2.3

The MA(g) Process
For the process
X =Z+0Zi1+ -+ Qth—q, {Z} ~WN (0, 02) s

Equation (3.2.3) immediately gives the result

i
o? Z 9j9j+‘h‘, if |h| <gq,

y(h) = =0
0, if |h| > gq,

where 6 is defined to be 1. The ACVF of the MA(g) process thus has the distinctive
feature of vanishing at lags greater than g. Data for which the sample ACVF is
small for lags greater than g therefore suggest that an appropriate model might be a
moving average of order ¢ (or less). Recall from Proposition 2.1.1 that every zero-mean
stationary process with correlations vanishing at lags greater than g can be represented
as a moving-average process of order g or less.

]
Second Method. 1If we multiply each side of the equations
X — ¢1Xt—1 -t ¢pXt—p =Zi+60Zi1+---+ Qth—q,
by X,_, k =0,1,2,..., and take expectations on each side, we find that
o
y () —¢ry k=)= =@y (k=p) = 6> Ojy, 0<k<m, (325)
j=0
and
Yy —grytk—1) —---—¢pyk—p) =0, k=m, (3.2.6)

where m = max(p,q + 1), ¢j :=0forj < 0,60 :=1,and 6, := O forj ¢ {0, ..., q}.
In calculating the right-hand side of (3.2.5) we have made use of the expansion (3.2.2).
Equations (3.2.6) are a set of homogeneous linear difference equations with constant
coefficients, for which the solution is well known (see, e.g., Brockwell and Davis
(1991), Section 3.6) to be of the form

y(h) =& +ong "+ e h>m—p, (3.2.7)
where &, ..., &, are the roots (assumed to be distinct) of the equation ¢ (z) = 0, and
ai, ..., o, are arbitrary constants. (For further details, and for the treatment of the

case where the roots are not distinct, see Brockwell and Davis (1991), Section 3.6.)
Of course, we are looking for the solution of (3.2.6) that also satisfies (3.2.5). We
therefore substitute the solution (3.2.7) into (3.2.5) to obtain a set of m linear equations
that then uniquely determine the constants oy, ..., «, and the m — p autocovariances
y(h),0<h<m-—np.

The ARMAC(1,1) Process
For the causal ARMA(1,1) process defined in Example 3.2.1, equations (3.2.5) are

y(0) — ¢y (1) =o*(1 460 + ¢)) (3.2.8)

and

y(1) — ¢y (0) = 6. (3.2.9)
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Figure 3-1

The model ACF of the AR(2)
series of Example 3.2.4 with
%’1 =2 and %’2 =5

Equation (3.2.6) takes the form

yk) —¢ytk—=1) =0, k=2 (3.2.10)
The solution of (3.2.10) is

y(h) =a¢”", h>1.

Substituting this expression for y (h) into the two preceding equations (3.2.8) and
(3.2.9) gives two linear equations for & and the unknown autocovariance y (0). These
equations are easily solved, giving the autocovariances already found for this process
in Example 3.2.1.

O

The General AR(2) Process
For the causal AR(2) process defined by

(1-&'B)(1-&'B)X, =7, &l 16l > 1,6 #&,
we easily find from (3.2.7) and (3.2.5) using the relations

¢ =& +&"
and
¢ = -8
that
262452
y (h) %) [EF—-D7'e " — @& - D7'g ™. (3.2.11)

NCEEDCED

Figures 3-1, 3-2, 3-3, and 3-4 illustrate some of the possible forms of y (-) for different
values of £, and &,. Notice that in the case of complex conjugate roots £, = re’” and
& =re ™, 0 <6 < m, we can write (3.2.11) in the more illuminating form

or* - rsin(hé + )

y(h) = 2 — 1)(r* —2r2cos26 + 1)sinf ’

(3.2.12)

1.0

ACF
0.4 0.6 0.8
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where
41
tan y = o tan 6 (3.2.13)
e —

and cos ¥ has the same sign as cos 6. Thus in this case y () has the form of a damped
sinusoidal function with damping factor 7~ and period 27 /6. If the roots are close
to the unit circle, then r is close to 1, the damping is slow, and we obtain a nearly
sinusoidal autocovariance function.

O
Third Method. The autocovariances can also be found by solving the first p + 1
equations of (3.2.5) and (3.2.6) for y(0)..., y(p) and then using the subsequent
equations to solve successively for y(p + 1), y(p + 2),.... This is an especially
convenient method for numerical determination of the autocovariances y (h) and is
used in the option Model >ACF/PACF>Model of the program ITSM.
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Consider again the causal ARMAC(1,1) process of Example 3.2.1. To apply the third
method we simply solve (3.2.8) and (3.2.9) for y(0) and y(1). Then y (2), y(3), ...
can be found successively from (3.2.10). It is easy to check that this procedure gives

the same results as those obtained in Examples 3.2.1 and 3.2.3.
0

3.2.2 The Autocorrelation Function

Recall that the ACF of an ARMA process {X,} is the function p(-) found immediately
from the ACVF y (-) as

y (h)
ph) = ——.
y(0)
Likewise, for any set of observations {xi, ..., x,}, the sample ACF /(-) is computed as
. y (h)
p(h) = .
Y (0)

The Sample ACF of an MA(q) Series. Given observations {xi,...,x,} of a time
series, one approach to the fitting of a model to the data is to match the sample ACF
of the data with the ACF of the model. In particular, if the sample ACF 6(h) is sig-
nificantly different from zero for 0 < h < ¢ and negligible for 4 > ¢, Example
3.2.2 suggests that an M A(g) model might provide a good representation of the data.
In order to apply this criterion we need to take into account the random variation
expected in the sample autocorrelation function before we can classify ACF values
as “negligible.” To resolve this problem we can use Bartlett’s formula (Section 2.4),
which implies that for a large sample of size n from an MA(g) process, the sample
ACF values at lags h greater than g are approximately normally distributed with
means 0 and variances wy,/n = (1 + 20%(1) + -+ + 2p2(q))/n. This means
that if the sample is from an MA(q) process and if & > ¢, then p(h) should fall
between the bounds 31.96./wy;,/n with probability approximately 0.95. In practice
we frequently use the more stringent values £1.96/,/n as the bounds between which
sample autocovariances are considered “negligible.” A more effective and systematic
approach to the problem of model selection, which also applies to ARMA( p, ¢) models
with p > 0 and g > 0, will be discussed in Section 5.5.
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3.2.3 The Partial Autocorrelation Function

The partial autocorrelation function (PACF) of an ARMA process {X;} is the
function «(-) defined by the equations

a(0) =1
and
a(h) =¢p, h=1,

where ¢y, is the last component of

¢, =T;" v (3.2.14)
. ~1h ’
Ly=[yG D] ,_pandy, = [y, y@),....y(®)].
For any set of observations {xi, ..., x,} with x; # x; for some i and j, the sample
PACF &(h) is given by
a(0) =1

and
&(h) = g, h =1,
where q@hh is the last component of
¢, =177, (3.2.15)

We show in the next example that the PACF of a causal AR(p) process is zero for
lags greater than p. Both sample and model partial autocorrelation functions can be
computed numerically using the program ITSM. Algebraic calculation of the PACF is
quite complicated except when ¢ is zero or p and g are both small.

It can be shown (Brockwell and Davis (1991), p. 171) that ¢y, is the correlation
between the prediction errors X, — P(X;|X1, ..., Xp—1) and Xo — P(Xo|X1, ..., Xp_1).

The PACF of an AR(p) Process
For the causal AR(p) process defined by
Xi—pi Xy — - — ¢pXt—p =7, {Z}~WN (0, 02),

we know (Problem 2.15) that for 4 > p the best linear predictor of X;; in terms of
I,Xl,..., XhiS

X1 = 01X + ¢ Xp 1+ + GpXnt1-p-

Since the coefficient ¢, of X is ¢, if h = p and 0 if h > p, we conclude that the
PACF «(-) of the process {X;} has the properties

O{(p) :¢p
and
a(h) =0for h > p.

For i < p the values of a(h) can easily be computed from (3.2.14). For any
specified ARMA model the PACF can be evaluated numerically using the option
Model>ACF/PACF>Model of the program ITSM.

O
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Figure 3-5
Time series of the overshorts
in Example 3.2.8

The PACF of an MA(1) Process

For the MA(1) process, it can be shown from (3.2.14) (see Problem 3.12) that the PACF
at lag h is

a(h) = ¢ = —(—0)" /(1 + 6%+ - +67).

O
The Sample PACF of an AR(p) Series. 1f {X,} is an AR(p) series, then the sample
PACF based on observations {xi, ..., x,} should reflect (with sampling variation) the

properties of the PACF itself. In particular, if the sample PACF & (h) is significantly
different from zero for 0 < & < p and negligible for & > p, Example 3.2.6 suggests
that an AR(p) model might provide a good representation of the data. To decide what
is meant by “negligible” we can use the result that for an AR(p) process the sample
PACEF values at lags greater than p are approximately independent N (0, 1/n) random
variables. This means that roughly 95 % of the sample PACF values beyond lag p
should fall within the bounds +1.96/./n. If we observe a sample PACF satisfying
la(h)| > 1.96//nfor0 < h < pand |a(h)| < 1.96/./n for h > p, this suggests
an AR( p) model for the data. For a more systematic approach to model selection, see
Section 5.5.

3.2.4 Examples

The time series plotted in Figure 3-5 consists of 57 consecutive daily overshorts from
an underground gasoline tank at a filling station in Colorado. If y, is the measured
amount of fuel in the tank at the end of the rth day and 4, is the measured amount sold
minus the amount delivered during the course of the 7th day, then the overshort at the
end of day ¢ is defined as x, = y; — y;—1 + a;. Due to the error in measuring the current
amount of fuel in the tank, the amount sold, and the amount delivered to the station, we
view y,, a;, and x, as observed values from some set of random variables Y;, A;, and X,
fort =1, ...,57. (In the absence of any measurement error and any leak in the tank,
each x, would be zero.) The data and their ACF are plotted in Figures 3-5 and 3-6. To
check the plausibility of an MA(1) model, the bounds +1.96 (1 +242(1))"/* /n'/2 are
also plotted in Figure 3-6. Since p(h) is well within these bounds for 4 > 1, the data
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appear to be compatible with the model
X,=pw+2Z+0Z_1, {Z}~WN(0,0?). (3.2.16)

The mean p may be estimated by the sample mean xs57 = —4.035, and the parameters
6, o> may be estimated by equating the sample ACVF with the model ACVF at lags
0 and 1, and solving the resulting equations for # and 2. This estimation procedure
is known as the method of moments, and in this case gives the equations

(14 6%)0% = P(0) = 3415.72,
fo? = p(1) = —1719.95.

Using the approximate solution # = —1 and o> = 1708, we obtain the noninvertible
MA(1) model

X, =—-4.035+7Z —Z_, {Z}~ WN(0,1708).

Typically, in time series modeling we have little or no knowledge of the underlying
physical mechanism generating the data, and the choice of a suitable class of models
is entirely data driven. For the time series of overshorts, the data, through the graph
of the ACF, lead us to the MA(1) model. Alternatively, we can attempt to model
the mechanism generating the time series of overshorts using a structural model. As
we will see, the structural model formulation leads us again to the MA(1) model. In
the structural model setup, write Y;, the observed amount of fuel in the tank at time 7, as

Y, =y + U, (3.2.17)

where y7 is the true (or actual) amount of fuel in the tank at time # (not to be confused
with y, above) and U, is the resulting measurement error. The variable y; is an ide-
alized quantity that in principle cannot be observed even with the most sophisticated
measurement devices. Similarly, we assume that

A =a +V, (3.2.18)

where a is the actual amount of fuel sold minus the actual amount delivered during
day t, and V, is the associated measurement error. We further assume that {U,} ~



86

Chapter 3

ARMA Models

Example 3.2.9

WN (0, 0[2,), {V:} ~ WN (0, 03), and that the two sequences {U,} and {V,} are uncor-
related with one another (E(U,V,) = 0 for all s and ). If the change of level per day
due to leakage is u gallons (1 < O indicates leakage), then

Vi =n+y —a. (3.2.19)

This equation relates the actual amounts of fuel in the tank at the end of days ¢ and
t — 1, adjusted for the actual amounts that have been sold and delivered during the day.
Using (3.2.17)—(3.2.19), the model for the time series of overshorts is given by

X=Y-Y 0+A=u+U—-U_1+V,.
This model is stationary and 1-correlated, since
EX,=E(u+U—-U_1+V)=pn
and
y(h) = E[(Xipn — ) (X; — ]
= E[(Urtn — Urpn—1 + Vien) (U — U1 + V)1
20 +0p, ifh=0,
=1 -0, if [n] = 1,
0, otherwise.
It follows from Proposition 2.1.1 that {X;} is the MA(1) model (3.2.16) with
0, —0[2]

)= = :
o) 1467 207 +o0}

From this equation we see that the measurement error associated with the adjustment
{A;} is zero (i.e., 03 = 0) if and only if p(1) = —0.5 or, equivalently, if and only
if 6, = —1. From the analysis above, the moment estimator of 6; for the overshort
data is in fact —1, so that we conclude that there is relatively little measurement error
associated with the amount of fuel sold and delivered.
We shall return to a more general discussion of structural models in Chapter 8.
O

The Sunspot Numbers

Figure 3-7 shows the sample PACF of the sunspot numbers S, . .., Sjgo (for the years
1770-1869) as obtained from ITSM by opening the project SUNSPOTS.TSM and
clicking on the second yellow button at the top of the screen. The graph also shows the
bounds +1.96/+4/100. The fact that all of the PACF values beyond lag 2 fall within
the bounds suggests the possible suitability of an AR(2) model for the mean-corrected
data set X; = S, — 46.93. One simple way to estimate the parameters ¢, ¢,, and o?
of such a model is to require that the ACVF of the model at lags O, 1, and 2 should
match the sample ACVF at those lags. Substituting the sample ACVF values

7(0) =1382.2, p()=11144, p(2)=591.73,

for y(0), y (1), and y (2) in the first three equations of (3.2.5) and (3.2.6) and solving
for ¢y, ¢, and o2 gives the fitted model

X, — 1.318X,_ | +0.634X, , = Z,, {Z) ~ WN(0, 289.2). (3.2.20)

(This method of model fitting is called Yule—Walker estimation and will be discussed
more fully in Section 5.1.1.)
0
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3.3 Forecasting ARMA Processes

The innovations algorithm (see Section 2.5.4) provided us with a recursive method for
forecasting second-order zero-mean processes that are not necessarily stationary. For
the causal ARMA process

¢(B)X, =0(B)Z, {Z}~WN(0,07),

itis possible to simplify the application of the algorithm drastically. The idea is to apply
it not to the process {X;} itself, but to the transformed process [cf. Ansley (1979)]

W, =o"1X,, t=1,...,m,
(3.3.1)
W, =0c"l¢B)X, t>m,
where
m = max(p, q). (3.3.2)
For notational convenience we define 6 := 1 and 6; := 0 for j > g. We shall also

assume that p > 1 and ¢ > 1. (There is no loss of generality in these assumptions,
since in the analysis that follows we may take any of the coefficients ¢; and 6; to be
Zero.)

The autocovariance function yx(-) of {X,} can easily be computed using any of the
methods described in Section 3.2.1. The autocovariances « (i, j) = E(W;W)), i, j > 1,
are then found from

o 2yx(i =), l<ij=m

p
o [Vx(i =) = 2 bryx(r—1li —jl)] ., min(,j) <m < max(i, j) < 2m,

r=1

cip=1, (3.3.3)

Z 9r0r+|i—j\a min<ia .]) >m,
r=0

0, otherwise.
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Applying the innovations algorithm to the process {W,} we obtain

n+l Z Gn/(vVn+l—J Wn+l—j)’ 1 =n<m,

1
~ (3.3.4)
n+l Z Gn/(‘/Vn+1—J - n+l—j), nz=m,
Jj=1
. . 2
where the coefficients 6,; and the mean squared errors r, = E <Wn+1 — Wn+1) are

found recursively from the innovations algorithm with « defined as in (3.3.3). The
notable feature of the predictors (3.3.4) is the vanishing of 6,; when both n > m and
Jj > g. This is a consequence of the innovations algorithm and the fact that « (r, s) = 0
ifr>mand |r—s| > gq.

Observe now that the equations (3.3.1) allow each X,,, n > 1, to be written as a
linear combination of W;, 1 < j < n, and, conversely, each W,, n > 1, to be written as
a linear combination of Xj, 1 < j < n. This means that the best linear predictor of any
random variable Y in terms of {1, X, ..., X} is the same as the best linear predictor
of Y in terms of {1, Wy, ..., W,}. We shall denote this predictor by P, Y. In particular,
the one-step predictors of W,,, | and X, are given by

Wn+l = PnVVn—H
and
),\(n+l = Pan+l-

Using the linearity of P, and the equations (3.3.1) we see that

Wtzo-ilj\(t, t:1,...,m,
R R (3.3.5)
Wo=o ! [K— X = —@X, | 1=m,
which, together with (3.3.1), shows that
X,-X =0 [W, - W,] forall 7 > 1. (3.3.6)

Replacing (W] — W]) by 07! (X] — )A(]) in (3.3.3) and then substituting into (3.3.4),
we finally obtain

E 0n/< n+l—j — n+l—/) 1 =n<m,

Xn-i-l (337)

0 X+ + ¢p n+1—p + ZG"/ ( n+l—j — Xn+1—j) , h=zm,
j=1

and
N 2 n 2
E (X1 = Xp1) = 0% (Wasr = Wot) = 0r,, (3.3.8)

where 6,; and r, are found from the innovations algorithm with « as in (3.3.3).
Equations (3.3.7) determine the one-step predictors X;, X3, ... recursively.

Remark 1. It can be shown (see Brockwell and Davis (1991), Problem 5.6) that if
{X,} is invertible, then as n — o0,

~ 2
E(X,,—Xn—z,,) -0,

9n1—>9j,j:1,...,q,
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and
r, — 1.

Algebraic calculation of the coefficients 6,; and r,, is not feasible except for very simple
models, such as those considered in the following examples. However, numerical
implementation of the recursions is quite straightforward and is used to compute
predictors in the program ITSM. U

Prediction of an AR(p) Process
Applying (3.3.7) to the ARMA(p, 0) process, we see at once that

},\(n+l = d)an +---+ d)ﬂXVH-l—pa n=> p.

Prediction of an MA(g) Process
Applying (3.3.7) to the ARMAC(1, g) process with ¢y = 0 gives

min(n,q)

Xpp1 = E Opj <Xn+l—j_ n+1—j>, n>1,
Jj=1

where the coefficients 6,; are found by applying the innovations algorithm to the co-
variances « (i, j) defined in (3.3.3). Since in this case the processes {X;} and {0 ~'W,}
are identical, these covariances are simply

q—li—jl

ki, ) =0 yxli—= Y 08y,
r=0

Prediction of an ARMA(1,1) Process
It

X, — ¢Xio1 =Z,+0Z_1, {Z} ~WN(0,07),
and |¢| < 1, then equations (3.3.7) reduce to the single equation
XnJrl :¢Xn+9nl(Xn_5(n)a n=>1l.

To compute 6,; we use Example 3.2.1 to obtain yx(0) =c (1 + 20¢ + 02)/(1 - (1)2).
Substituting in (3.3.3) then gives, for i,j > 1,

(14209 +6%)/(1—¢%), i=j=1,

. 1+62, i=j>=2,

k(@ j) =
0, li—jl=1,i>1,
0, otherwise.

With these values of « (i, j), the recursions of the innovations algorithm reduce to
ro=(1+20¢+6%)/(1 —¢%),
Ot = 0/1u-1, (3.3.9)
=146 =0%/r,1,

which can be solved quite explicitly (see Problem 3.13).
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Table 3.1

Numerical Prediction of an ARMA(2,3) Process

In this example we illustrate the steps involved in numerical prediction of an
ARMA(2,3) process. Of course, these steps are shown for illustration only.
The calculations are all carried out automatically by I'TSM in the course of computing
predictors for any specified data set and ARMA model. The process we shall consider
is the ARMA process defined by the equations

X — X1 +024X, » =7,+047,_, +0.2Z,_», + 0.1Z;_3, (3.3.10)

where {Z,} ~ WN(O0, 1). Ten values of Xy, ..., Xjo simulated by the program ITSM
are shown in Table 3.1. (These were produced using the option Model>Specify
to specify the order and parameters of the model and then Model>Simulate to
generate the series from the specified model.)

The first step is to compute the covariances yx(h), h = 0, 1, 2, which are easily
found from equations (3.2.5) with k = 0, 1, 2 to be

yx(0) = 7.17133,  yx(1) = 6.44139, and yx(2) = 5.0603.

From (3.3.3) we find that the symmetric matrix K = [« (i, j)]; j=1,2,.. is given by

[7.1713

6.4414 7.1713

5.0603 6.4414 7.1713
0.10 034 0816 1.21

K = 0 0.10 034 050 1.21
0 0 0.10 024 050 1.21
0 0 0.10 024 050 1.21
0 0 0.10 024 050 1.21

The next step is to solve the recursions of the innovations algorithm for 6,; and r,
using these values for « (i, j). Then

)A(,,H for the ARMA(2,3) Process of Example 3.3.4

n Xn+1 'n On1 On2 On3 Xn+1

0 1.704 7.1713 O

1 0.527 1.3856 0.8982 1.5305

2 1.041 1.0057 1.3685 0.7056 —0.1710

3 0.942 1.0019 0.4008 0.1806 0.0139 1.2428
4 0.555 1.0019 0.3998 0.2020 0.0732 0.7443
5 —1.002 1.0005 0.3992 0.1995 0.0994 0.3138
6 —0.585 1.0000 0.4000 0.1997 0.0998 —1.7293
7 0.010 1.0000 0.4000 0.2000 0.0998 —0.1688
8 —0.638 1.0000 0.4000 0.2000 0.0999 0.3193
9 0.525 1.0000 0.4000 0.2000 0.1000 —0.8731
10 1.0000 0.4000 0.2000 0.1000 1.0638
11 1.0000 0.4000 0.2000 0.1000

12 1.0000 0.4000 0.2000 0.1000
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n
E enj (Xn+1—j - n+1—j> s n= 1» 2»
— ) j=1

Xn+1 =

3 A
Xy = 024X, 1+ 3 0y (X1 = Kurr ), n=3.4..,
=1

and
~ 2
E(Xn+1 _Xn+1) = azrn =TIy

The results are shown in Table 3.1.

3.3.1 h-Step Prediction of an ARMA(p, q) Process

As in Section 2.5, we use P,Y to denote the best linear predictor of Y in terms of

X1, ..., X, (which, as pointed out after (3.3.4), is the same as the best linear predictor
of Y in terms of Wy, ..., W,). Then from (2.5.30) we have
n+h—1 n+h—1

. s N
PWyin = E Ontn—1,j <Wn+h—j — Wn+h—j) =0 E Onth—1,j (Xn+h—j — Xn+h—j) .
J=h j=h

Py Xpin =

Example 3.3.5

Using this result and applying the operator P, to each side of equation (3.3.1), we
conclude that the h-step predictors P,X, satisfy

n+h—1

Z Ontn—1,; (Xn+h—j — )A(n+h—j) , I<h<m-n,
' i1 (3.3.11)
Z GiPpXpin—i + Z Onth—1,j <Xn+h—j — An+h—j> , h>m—n.
i=1 j=h
If, as is almost always the case, n > m = max(p, g), then for all 1 > 1,
p q
Py Xyin = Z GiPnXyin—i + Z Ontn—1.j (XnJrhfj - XnJrhfj) . (3.3.12)

i=1 Jj=h

Once the predictors X Ly .. )A(,, have been computed from (3.3.7), it is a straightforward
calculation, with n fixed, to determine the predictors P,X,i1, P, Xni2, PuXit3, - ..
recursively from (3.3.12) (or (3.3.11) if n < m). The calculations are performed
automatically in the Forecasting>ARMA option of the program ITSM.

h-Step Prediction of an ARMA(2,3) Process

To compute h-step predictors, & = 1,..., 10, for the data of Example 3.3.4 and
the model (3.3.10), open the project E334.TSM in ITSM and enter the model using the
option Model>Specify.Then select Forecasting>ARMA and specify 10 for the
number of forecasts required. You will notice that the white noise variance is au-
tomatically set by ITSM to an estimate based on the sample. To retain the model
value of 1, you must reset the white noise variance to this value. Then click OK and
you will see a graph of the original series with the ten predicted values appended.
If you right-click on the graph and select Info, you will see the numerical results
shown in the following table as well as prediction bounds based on the assumption
that the series is Gaussian. (Prediction bounds are discussed in the last paragraph of
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Example 3.3.6

Table 3.2

this chapter.) The mean squared errors are calculated as described below. Notice how
the predictors converge fairly rapidly to the mean of the process (i.e., zero) as the lead
time & increases. Correspondingly, the one-step mean squared error increases from
the white noise variance (i.e., 1) at # = 1 to the variance of X; (i.e., 7.1713), which is
virtually reached at 7 = 10.

O
The Mean Squared Error of P, X1y,
The mean squared error of P,X,. is easily computed by ITSM from the formula
h—1 / J 2
a;lz(h) = E(Xn+h - Pan+h)2 = Z (Z Xr9n+hr1,jr> Vith—j—1,
j=0 r=0
(3.3.13)
where the coefficients x; are computed recursively from the equations xo = 1 and
min(p, j)
XN= D> Gtk J=12,.... (3.3.14)
k=1

h-Step Prediction of an ARMA(2,3) Process

We now illustrate the use of (3.3.12) and (3.3.13) for the h-step predictors and their
mean squared errors by manually reproducing the output of ITSM shown in Table 3.2.
From (3.3.12) and Table 3.1 we obtain

2 3
ProX1y = Z ¢iP1oX12—i + Z 011, <X127j - 5(127]')

i=1 J=2
= &1 X1 + X104+ 0.2 (Xm _ 5(10) +0.1 (Xg _ 5(9)

=1.1217

and

h-step predictors for
the ARMA(2,3)
Series of Example 3.3.4

h PioX104h MSE
1 1.0638 1.0000
2 1.1217 1.7205
3 1.0062 2.1931
4 0.7370 2.4643
5 0.4955 2.5902
6 0.3186 2.6434
7 0.1997 2.6648
8 0.1232 2.6730
9 0.0753 2.6761
10  0.0457 2.6773
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PioXi3 = Z¢1P10X13 i+ 2912 j <X13—/ Xl3—j)

j=3
= ¢1P10X12 + ¢ X1y +0.1 <X1o — XlO)
= 1.0062.
For k > 13, P1oX} is easily found recursively from
P1oXik = $1P10Xi—1 + P2P10Xk—2-

To find the mean squared errors we use (3.3.13) with xo = 1, x; = ¢; = 1, and
X2 = ¢1x1 + ¢ = 0.76. Using the values of 6,; and v;(= r;) in Table 3.1, we obtain

05(2) = E(X12 — P1oX12)* = 2.960
and
0iy(3) = E(X13 — P1oX13)* = 4.810,

in accordance with the results shown in Table 3.2.

Large-Sample Approximations
Assuming as usual that the ARMA(p, g) process defined by ¢ (B)X; = 6(B)Z;, {Z,} ~
WN (0, 02), is causal and invertible, we have the representations

n+h Z wj n+h—j (3315)
and
o
AVED AVED %D AT (3.3.16)
j=1

where {v;} and {r;} are uniquely determined by equations (3.1.7) and (3.1.8), respec-
tively. Let P,Y denote the best (i.e., minimum mean squared error) approximation to
Y that is a linear combination or limit of linear combinations of X;, —o0 < t < n,
or equivalently [by (3.3.15) and (3.3.16)] of Z, —oo < ¢ < n. The properties
of the operator P, were discussed in Section 2.5.6. Applying P, to each side of
equations (3.3.15) and (3.3.16) gives

oo
PuXuin =) ViZuin-i (3.3.17)
j=h
and
oo
PuXyon ==Y mPuXosny. (3.3.18)
j=1

For h = 1 the jth term on the right of (3.3.18) is just X,;_;. Once 13an+1 has
been evaluated, 13,,X,,+2 can then be computed from (3.3.18). The predictors 13,,X,,+3,
P,X,14, ... can then be computed successively in the same way. Subtracting (3.3.17)
from (3.3.15) gives the h-step prediction error as
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Problems

h—1
Xn+h - Pan+h = E ijn+h—j’
j=0

from which we see that the mean squared error is

h—1

&) =0 Y. (3.3.19)

j=0
The predictors obtained in this way have the form

o]

ﬁan—i-h = Z Can_j. (3320)
j=0
In practice, of course, we have only observations Xi, ..., X, available, so we must

truncate the series (3.3.20) after n terms. The resulting predictor is a useful approx-
imation to P,X,; if n is large and the coefficients ¢; converge to zero rapidly as j
increases. It can be shown that the mean squared error (3.3.19) of 13an+;, can also be
obtained by letting n — oo in the expression (3.3.13) for the mean squared error of
P, X, n, so that 5%(h) is an easily calculated approximation to anz(h) for large n.

Prediction Bounds for Gaussian Processes

If the ARMA process {X;} is driven by Gaussian white noise (i.e., if {Z;} ~
IIDN (0, 02)), then for each 4 > 1 the prediction error X,,; — P,X,+; is normally
distributed with mean O and variance anz (h) given by (3.3.19).

Consequently, if ®_,/, denotes the (1—a/2) quantile of the standard normal dis-
tribution function, it follows that X, lies between the bounds P, X,, ., &+ ®1_y /20, (h)
with probability (1 — o). These bounds are therefore called (1 — «) prediction bounds
for X, 1.

3.1 Determine which of the following ARMA processes are causal and which of
them are invertible. (In each case {Z;} denotes white noise.)
(a) Xl + 0‘2Xt—l - 0.48Xt_2 = Zt‘

(b) X, + 1.9X,_; +0.88X,_» = Z, + 0.2Z,_; + 0.7Z,_».
©) X, +0.6X,_; = Z + 1.2Z,_,.

(d) X, + 1.8X,1 +0.81X,_, = Z,.

) X, + 1.6X,_1 = Z, — 0.4Z,_; + 0.04Z,_,.

3.2 For those processes in Problem 3.1 that are causal, compute and graph their
ACF and PACEF using the program ITSM.

3.3 For those processes in Problem 3.1 that are causal, compute the first six co-
efficients vy, ¥, ..., ¥s in the causal representation X; = Zfio YiZ,_j of {X;}.

3.4 Compute the ACF and PACF of the AR(2) process
X, =08X,2+Z:, {Z}~WN(0,0%).
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3.5 Let {Y;} be the ARMA plus noise time series defined by
Yi=X,+ W,
where {W,} ~ WN (0, av%), {X;} is the ARMA(p, q) process satisfying
¢ (B)X, =0(B)Z;, {Z}~WN(0,07),

and E(W,Z,) = 0 for all s and r.

(a) Show that {Y;} is stationary and find its autocovariance function in terms of
0‘%, and the ACVF of {X,}.

(b) Show that the process U, := ¢ (B)Y; is r-correlated, where r = max(p, q)
and hence, by Proposition 2.1.1, is an MA(r) process. Conclude that {Y,} is
an ARMA(p, r) process.

3.6 Show that the two MA(1) processes

X, =Z+6Z_1, {Z}~WN(0,07)
Y, =7+ éZ_l, {Z} ~ WN (0, 0%6?),
where 0 < |0| < 1, have the same autocovariance functions.
3.7 Suppose that {X,} is the noninvertible MA(1) process
X, =Z+0Z_1, {Z}~WN(0,07),

where |6] > 1. Define a new process {W,} as
o
Wi=) (=6)7X.
j=0

and show that {W,} ~ WN (0, a&,). Express o, in terms of # and o? and show
that {X,} has the invertible representation (in terms of {W,})

1
Xt = Wl‘ + EWt_l.

3.8 Let {X,} denote the unique stationary solution of the autoregressive equations
X=X, 1+ 72, t=0,=%1,...,
where {Z,} ~ WN(O, 02) and |¢| > 1. Then X; is given by the expression
(2.2.11). Define the new sequence
W, =X, — lXt—l,
¢

show that {W,} ~ WN (0, a%,), and express avzv in terms of o2 and ¢. These
calculations show that {X;} is the (unique stationary) solution of the causal AR
equations

1
XIZEX[71+W[, t:O,:tl,....

3.9(a) Calculate the autocovariance function y (-) of the stationary time series

Yi=pu+Z+0Z_1+ 601715, {Z}~WN (0, 02)-
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3.10

3.11

3.12

3.13

(b) Use the program ITSM to compute the sample mean and sample autocovari-
ances y(h), 0 < h < 20, of {VV,X;}, where {X,,t = 1,...,72} is the
accidental deaths series DEATHS.TSM of Example 1.1.3.

(¢) By equating y (1), y(11), and y (12) from part (b) to ¥ (1), y(11), and y (12),
respectively, from part (a), find a model of the form defined in (a) to represent
{VViaXi}

By matching the autocovariances and sample autocovariances at lags 0 and 1, fit
a model of the form

X, —p=0Xi1— ) +2Z, {Z}~WN(0,0?),

to the data STRIKES.TSM of Example 1.1.6. Use the fitted model to compute
the best predictor of the number of strikes in 1981. Estimate the mean squared
error of your predictor and construct 95 % prediction bounds for the number of
strikes in 1981 assuming that {Z;} ~ iid N(O, 02).

Show that the value at lag 2 of the partial ACF of the MA(1) process
Xi=7+0Z_;, t=0,=%1,...,

where {Z;} ~ WN(O, 02), is
a(2) = -0/ (146> +06%).

For the MA(1) process of Problem 3.11, the best linear predictor of X,,,; based
onXi,...,X,1s

),\(n+l = d)n,lxn +---+ ¢n,nX1,

where ¢, = (q&,,l, e ¢,,,,)/ satisfies R,¢, = p, [equation (2.5.23)]. By sub-
stituting the appropriate correlations into R, and p, and solving the resulting
equations (starting with the last and working up), show that for 1 < j < n,
Onn—j = (=)~ (1 +6% 4.+ 92j)¢nn and hence that the PACF «(n) := ¢,,, =
—(=0)"/(L+ 6>+ ---+6™).

The coefficients 6,; and one-step mean squared errors v, = rpo? for the general

causal ARMAC(1,1) process in Example 3.3.3 can be found as follows:

(a) Show that if y, := r,/(r, — 1), then the last of equation (3.3.9) can be
rewritten in the form

Yn = G_Zyn—l +1, n>1

(b) Deduce that yn=0*2"yo+z;': ,072U7D and hence determine r, and
Gnl,l’l: 1,2,....

(¢c) Evaluate the limits as n — oo of r, and 6,; in the two cases |0| < 1 and
o] > 1.



Spectral Analysis

4.1 Spectral Densities

4.2 The Periodogram

4.3 Time-Invariant Linear Filters

4.4 The Spectral Density of an ARMA Process

This chapter can be omitted without any loss of continuity. The reader with no back-
ground in Fourier or complex analysis should go straight to Chapter 5. The spectral
representation of a stationary time series {X,} essentially decomposes {X;} into a sum of
sinusoidal components with uncorrelated random coefficients. In conjunction with this
decomposition there is a corresponding decomposition into sinusoids of the autoco-
variance function of {X;}. The spectral decomposition is thus an analogue for stationary
processes of the more familiar Fourier representation of deterministic functions. The
analysis of stationary processes by means of their spectral representation is often
referred to as the “frequency domain analysis” of time series or “spectral analysis.”
It is equivalent to “time domain” analysis based on the autocovariance function, but
provides an alternative way of viewing the process, which for some applications may
be more illuminating. For example, in the design of a structure subject to a randomly
fluctuating load, it is important to be aware of the presence in the loading force of a
large sinusoidal component with a particular frequency to ensure that this is not a
resonant frequency of the structure. The spectral point of view is also particularly
useful in the analysis of multivariate stationary processes and in the analysis of
linear filters. In Section 4.1 we introduce the spectral density of a stationary process
{X:;}, which specifies the frequency decomposition of the autocovariance function,
and the closely related spectral representation (or frequency decomposition) of the
process {X,} itself. Section 4.2 deals with the periodogram, a sample-based function
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from which we obtain estimators of the spectral density. In Section 4.3 we discuss
time-invariant linear filters from a spectral point of view and in Section 4.4 we use the
results to derive the spectral density of an arbitrary ARMA process.

4.1 Spectral Densities

Suppose that {X,} is a zero-mean stationary time series with autocovariance function
y () satisfying > 72|y (h)| < oo. The spectral density of {X,} is the function f(-)
defined by

fo) = % ;ooe""“y(h), —00 < A < 00, (4.1.1)

where ¢ = cos(X) 4 isin(1) and i = +/—1. The summability of |y (-)| implies that
the series in (4.1.1) converges absolutely (since |ei“|2 = cos?(hA) + sinz(h)L) =1).
Since cos and sin have period 27, so also does f, and it suffices to confine attention
to the values of f, on the interval (—m, ].

Basic Properties of f:
(a) fiseven,i.e., f(L) =f(—A), 4.1.2)
() f(A) =0forall A € (—m, 7], and 4.1.3)
) yk) = / ’ e dr = / i cos(kM)f (L) d. 4.1.4)

Proof Since sin(-) is an odd function and cos(-) and y (-) are even functions, we have

- .
FO) = h;m(cos(hk) — isin(h)))y (h)

1 o
=5 Z cos(—hA)y(h) +0
h=—00

= (D).

For each positive integer N define

N
1 —irk
o3 = 5= (\;‘Xre

)
1 N ' N '
_ mE (; Xre—trk ;XSetsk)

1

=5 2 (V= lhDe ™y (h).

|h| <N
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Definition 4.1.1

Proposition 4.1.1

Proof

Clearly, the function fy is nonnegative for each N, and since fy(A) — % Yo
e "y (h) = f(L)asN — oo, f must also be nonnegative. This proves (4.1.3). Turning
to (4.1.4),

/n e’“f()») dx _/ Z et(k h))»y(h) d

-7

e¢]

Z )/(h) l(k h)A dn

= y(k),

since the only nonzero summand in the second line is the one for which & = k (see
Problem 4.1). |

Equation (4.1.4) expresses the autocovariances of a stationary time series with
absolutely summable ACVF as the Fourier coefficients of the nonnegative even func-
tion on (—z, 7] defined by (4.1.1). However, even if Zf;foo |y (h)| = oo, there may
exist a corresponding spectral density defined as follows.

A function f is the spectral density of a stationary time series {X;} with ACVF
y () if
(i) f(A) =0forall A € (—m, w], and

s
(i) y(h) = / ¢™f (%) d for all integers h.
—TT

Remark 1. Spectral densities are essentially unique. That is, if f and g are two
spectral densities corresponding to the autocovariance function y (-), i.e., y(h) =

ST e f(x)dr = [T €M g()) d forall integers h, then f and g have the same Fourier
coefficients and hence are equal (see, for example, Brockwell and Davis (1991),
Section 2.8). ]

The following proposition characterizes spectral densities.

A real-valued function f defined on (—m, ] is the spectral density of a real-valued
stationary process if and only if

1) f) =f(=2),
(i) f(1) >0, and
(i) /7 f(A)dAr < oo.

If y () is absolutely summable, then (i)—(iii) follow from the basic properties of f,
(4.1.2)—(4.1.4). For the argument in the general case, see Brockwell and Davis (1991),
Section 4.3.

Conversely, suppose f satisfies (i)—(iii). Then it is easy to check, using (i), that the
function defined by

y (h) = / ")
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Corollary 4.1.1

Proof

Example 4.1.1

is even. Moreover, ifa, e R, r =1, ..., n, then

n T n
D ay(r—s)a; = f D aase™0f () da

r,s=1 r,s=1

-/,

>0,

2
(1) dr

n

E arel)»r

r=1

so that y(-) is also nonnegative definite and therefore, by Theorem 2.1.1, is an
autocovariance function. |

An absolutely summable function y (-) is the autocovariance function of a stationary
time series if and only if it is even and

_ 1l m _
fo) = o h;ooe y(h) >0, foral e (—m, ], 4.1.5)

in which case f(-) is the spectral density of y (-).

We have already established the necessity of (4.1.5). Now suppose (4.1.5) holds.
Applying Proposition 4.1.1 (the assumptions are easily checked) we conclude that f
is the spectral density of some autocovariance function. But this ACVF must be y (-),
since y (k) = f ”n e f(1) dx for all integers k. |

Using Corollary 4.1.1, it is a simple matter to show that the function defined by

1, ifh=0,
k(h)y=1p, ifh==+l,

0, otherwise,

is the ACVF of a stationary time series if and only if [p| < % (see Example 2.1.1).
Since « (-) is even and nonzero only at lags 0, +1, it follows from the corollary that «
is an ACVF if and only if the function

I S I
f()»)ZEh;ooe y(h)ZE[l+2,ocos)L]

is nonnegative for all A € (—m, 7r]. But this occurs if and only if [p| < %
O

As illustrated in the previous example, Corollary 4.1.1 provides us with a powerful
tool for checking whether or not an absolutely summable function on the integers is
an autocovariance function. It is much simpler and much more informative than direct
verification of nonnegative definiteness as required in Theorem 2.1.1.

Not all autocovariance functions have a spectral density. For example, the sta-
tionary time series

X; = A cos(wt) + Bsin(wt), 4.1.6)

where A and B are uncorrelated random variables with mean O and variance 1, has
ACVF y (h) = cos(wh) (Problem 2.2), which is not expressible as [”_e"*f(1)dA,
with f a function on (—m, w]. Nevertheless, y(-) can be written as the Fourier
transform of the discrete distribution function
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0 if A < —w,
FO) =105 if —w<A<ow,
1.0 if X > w,
ie.,

Theorem 4.1.1

Example 4.1.2

cos(wh) = / e™dF (),
(=m,m]

where the integral is as defined in Section A.l. As the following theorem states
(see Brockwell and Davis (1991), p. 117), every ACVF is the Fourier transform of
a (generalized) distribution function on [—m, 7w]. This representation is called the
spectral representation of the ACVF.

(Spectral Representation of the ACVF) A function y(-) defined on the integers is
the ACVF of a stationary time series if and only if there exists a right-continuous,
nondecreasing, bounded function F on [—m, w] with F(—m) = 0 such that

y (h) = / ¢ dF () @17
(=m,m]

for all integers h. (For real-valued time series, F is symmetric in the sense that
f(u b dF(x) = f[fb g dF (x) for all a and b such that 0 < a < b.)

Remark 2. The function F is a generalized distribution function on [—x, 7] in the
sense that G(A) = F())/F (i) is a probability distribution function on [—, 7 ]. Note
that since F'(r) = y (0) =Var(X;), the ACF of {X,} has spectral representation

p(h) = f eM™dG(1).
(—m,m]

The function F in (4.1.7) is called the spectral distribution function of y (-). If F(X)
can be expressed as F(A) = f_kn fO)dy for all A € [—m, ], then fis the spectral
density function and the time series is said to have a continuous spectrum. If F is a
discrete distribution function (i.e., if G is a discrete probability distribution function),
then the time series is said to have a discrete spectrum. The time series (4.1.6) has a
discrete spectrum. O

Linear Combination of Sinusoids

Consider now the process obtained by adding uncorrelated processes of the type
defined in (4.1.6), i.e.,

k
X, = Z(Af cos(wjt) + Bjsin(wjt)), 0 <w; <---<w <, 4.1.8)
j=1

where Ay, By, ..., A, By are uncorrelated random variables with E(A;) = E(B;) = 0
and Var(A;) = Var(B)) = ajz,j = 1,...,k By Problem 4.5, the ACVF of this time
series is y (h) = Zjl;l sz cos(w;h) and its spectral distribution function is F(A) =
Z/]'; | asz (1), where

0 if A < —wj,

1.0 if A > .
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Figure 4-1

A sample path of size
100 from the time series
in Example 4.1.2

Figure 4-2

The spectral distribution
function F\), —r <A <,
of the time series

in Example 4.1.2

0 20 40 60 80 100

| | | | | | |
-3 -2 -1 0 1 2 3
Frequency

A sample path of this time series with k = 2, 0| = 7/4, w, = 7/6, 0} = 9, and
o3 = 1is plotted in Figure 4-1. Not surprisingly, the sample path closely approximates
a sinusoid with frequency w; = 7 /4 (and period 27 /w; = 8). The general features of
this sample path could have been deduced from the spectral distribution function (see
Figure 4-2), which places 90% of its total mass at the frequencies £ /4. This means
that 90% of the variance of X; is contributed by the term A cos(w;f) + B cos(w;1),
which is a sinusoid with period 8.
O
The remarkable feature of Example 4.1.2 is that every zero-mean stationary pro-
cess can be expressed as a superposition of uncorrelated sinusoids with frequencies
o € [0, ]. In general, however, a stationary process is a superposition of infinitely
many sinusoids rather than a finite number as in (4.1.8). The required generalization
of (4.1.8) that allows for this is called a stochastic integral, written as

X, = / eMdz(n), (4.1.9)
(=m,m]
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Example 4.1.3

Example 4.1.4

where {Z(A), —mr < A < m}is a complex-valued process with orthogonal (or un-
correlated) increments. The representation (4.1.9) of a zero-mean stationary process
{X:} is called the spectral representation of the process and should be compared with
the corresponding spectral representation (4.1.7) of the autocovariance function y (-).
The underlying technical aspects of stochastic integration are beyond the scope of this
book; however, in the simple case of the process (4.1.8) it is not difficult to see that it
can be reexpressed in the form (4.1.9) by choosing

A; +iB;
-/+l_'/, lf)L:—a)landJE{l,,k},

_Ja —iB
dZ(x) = ;LTLA if 1 =awjand je{l,... K},
0, otherwise.

For this example it is also clear that

2
o
- A=+
E@zoyazoy =12 ! “p
0, otherwise.

In general, the connection between dZ()) and the spectral distribution function of the
process can be expressed symbolically as

F(A) — F(A—), for adiscrete spectrum,

EdZ(\)dZ())) = (4.1.10)

fA)dx, for a continuous spectrum.

These relations show that a large jump in the spectral distribution function (or a large
peak in the spectral density) at frequency Fw indicates the presence in the time series
of strong sinusoidal components with frequencies at (or near) w radians per unit time.
The period of a sinusoid with frequency w radians per unit time is 27 /®.

White Noise

If {X;,} ~ WN (0, 02), then y (0) = o and y (h) = O for all || > 0. This process has
a flat spectral density (see Problem 4.2)

0_2
fA) =7, —-m=<i=m.
2

A process with this spectral density is called white noise, since each frequency in the
spectrum contributes equally to the variance of the process.
O

The Spectral Density of an AR(1) Process

If {X,} is a causal AR(1) process satisfying the equation,
X =¢X 1+ 7,
where {Z;} ~ WN(O, 02), then from (4.1.1), {X;} has spectral density

_ o’ - h(—iha i
ﬂm_gwqﬁc+;¢@ + )
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Figure 4-3

The spectral density
f(A),0 <A <m, of

Xt = 0.7X¢_1 + Z¢, where
{Zi} ~ WN(0,02)

Figure 4-4

The spectral density
f(A),0<Ai<m,of

Xt = —0.7X;—1 + Zt, where
{Z) ~ WN(0, 02)
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_ 0,2 ¢ei)\ d)eft)\
2w (1—¢?) (1 + 1 — ¢pe* + 1 —¢e‘“>
2

-2 1= 2)7!
_2n(1 2pcosh+¢%) .

Graphs of f(A), 0 < A < &, are displayed in Figures 4-3 and 4-4 for ¢ = 0.7 and
¢ = —0.7. Observe that for ¢ = 0.7 the density is large for low frequencies and small
for high frequencies. This is not unexpected, since when ¢ = 0.7 the process has a
positive ACF with a large value at lag one (see Figure 4-5), making the series smooth
with relatively few high-frequency components. On the other hand, for ¢ = —0.7 the
ACF has a large negative value at lag one (see Figure 4-6), producing a series that
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Example 4.1.5

fluctuates rapidly about its mean value. In this case the series has a large contribution
from high-frequency components as reflected by the size of the spectral density near
frequency .

0
Spectral Density of an MA(1) Process
If
Xi =7 +0Z_4,
where {Z,} ~ WN(O, 02), then from (4.1.1),
o’ 2 7} o’ 2
MN=—(14+60"+0(e" ")) =—(1+20cosA+67).
F) 27_[(4— + 0 (e7* +€")) 2ﬂ(+ cos A + 0%)
This function is shown in Figures 4-7 and 4-8 for the values 6 = 0.9 and
0 = —0.9. Interpretations of the graphs analogous to those in Example 4.1.4 can

again be made.
0
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4.2 The Periodogram

If {X;} is a stationary time series {X,;} with ACVF y () and spectral density f(-), then
just as the sample ACVF y(-) of the observations {xi, ..., x,} can be regarded as a
sample analogue of y (-), so also can the periodogram I,(-) of the observations be
regarded as a sample analogue of 27 f(-).

To introduce the periodogram, we consider the vector of complex numbers
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Definition 4.2.1

where C" denotes the set of all column vectors with complex-valued components. Now
let w, = 2mk/n, where k is any integer between —(n — 1)/2 and n/2 (inclusive), i.e.,

_2nk = n—1 [n] @2.1)
Wi = n’ = ) ,...,2, WL

where [ y] denotes the largest integer less than or equal to y. We shall refer to the set F),
of these values as the Fourier frequencies associated with sample size n, noting that
F, is a subset of the interval (—m, 7 ]. Correspondingly, we introduce the n vectors

eia)k
o S Ly N 422
e, — — s = — N e D L
AV 2 2
eniwk
Now ey, ..., e, are orthonormal in the sense that
1, ifj=k,
ej*ek = (423)
0, ifj#k,
where ;" denotes the row vector whose kth component is the complex conjugate of
the kth component of e; (see Problem 4.3). This implies that {ey, ..., e,} is a basis for
C", so that any x € C" can be expressed as the sum of n components,
[n/2]
X = Z aiey. (4.2.4)
k=—[(n—1)/2)

The coefficients ay are easily found by multiplying (4.2.4) on the left by e;* and using
(4.2.3). Thus,

1 « .
a=ex=—> xe "™ (4.2.5)
ﬁ =1

The sequence {a;} is called the discrete Fourier transform of the sequence
(o X

Remark 1. The tth component of (4.2.4) can be written as

[n/2]
X = Z aglcos(ayt) +isin(wgt)], t=1,...,n, (4.2.6)
k=—[(n—1)/2]

showing that (4.2.4) is just a way of representing x;, as a linear combination of sine
waves with frequencies wy € F),. O

The periodogram of {xi, ..., x,} is the function

2
n
I,(A) = the—"“ 4.2.7)
=1

1
n

Remark 2. If X is one of the Fourier frequencies wy, then I,,(wy) = |ax|?, and so from
(4.2.4) and (4.2.3) we find at once that the squared length of x is
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Proposition 4.2.1

Proof

n [n/2] [n/2]

2 2
E x| =x"x = E lag|” = E L(wp).
=1 k=—[(n—1)/2] k=—[(n—1)/2]

The value of the periodogram at frequency wy is thus the contribution to this sum of
squares from the “frequency w;” term ayey, in (4.2.4). U

The next proposition shows that /,,(A) can be regarded as a sample analogue of
27 f()). Recall that if Z;’; w Y (M) < 00, then

o
2rf(0) = Y y(he ™, ie(-mxl (4.2.8)
h=—00
If x1,...,x, are any real numbers and wy, is any of the nonzero Fourier frequencies
2rwk/nin (—m, ), then
Liw) =Y phye "™, (42.9)
|h|<n

where y (h) is the sample ACVF of xy, ..., xp.

Since Y ', e7"* = 0 if w; # 0, we can subtract the sample mean X from x, in the
defining equation (4.2.7) of I,(wy). Hence,

In(a)k) = n—l Z Z(XS . J_C) (-xt _ X)e—i(s—t)wk

s=1 t=1
= Z P (e~ e, [
|h|<n

In view of the similarity between (4.2.8) and (4.2.9), a natural estimate of the
spectral density f(}) is 1,(1)/(27). For a very large class of stationary time series
{X;} with strictly positive spectral density, it can be shown that for any fixed frequencies

Ay..., Ay such that 0 < Ay < -+ < XA, < m, the joint distribution function
F,(xy, ..., x,) of the periodogram values (I,(1y), ..., I,(A,;)) converges, as n — 00,
to F(xy, ..., x,), where
{RIES A
— exp , ifx, ..., x, >0,
F(x1, ... %) = {i=1 2mf (%) (4.2.10)
0, otherwise.
Thus for large n the periodogram ordinates (I,,(A;), ..., I,(1,)) are approximately

distributed as independent exponential random variables with means 27f (1), ...,
21 f(Am), respectively. In particular, for each fixed A € (0, ) and € > 0,

PlI,(A) —2xf(A)| > €] —> p >0, asn — oo,

so the probability of an estimation error larger than € cannot be made arbitrarily small
by choosing a sufficiently large sample size n. Thus, 1,(X) is not a consistent estimator
of 2 f(M).

Since for large n the periodogram ordinates at fixed frequencies are approximately
independent with variances changing only slightly over small frequency intervals, we
might hope to construct a consistent estimator of f(1) by averaging the periodogram
estimates in a small frequency interval containing A, provided that we can choose the
interval in such a way that its width decreases to zero while at the same time the number



4.2

The Periodogram 109

Definition 4.2.2

of Fourier frequencies in the interval increases to oo as n — oo. This can indeed be
done, since the number of Fourier frequencies in any fixed frequency interval increases
approximately linearly with n. Consider, for example, the estimator

Fo) = — 2m+ 1)~ 1) + 27j 4.2.11
FOy = 5= 3 @m+ D7 (g, 4) + 27j/m), 42.11)

lil<m

where m = +/n and g(n, A) is the multiple of 27 /n closest to A. The number of
periodogram ordinates being averaged is approximately 2./n, and the width of the
frequency interval over which the average is taken is approximately 47 //n. It can be
shown (see Brockwell and Davis (1991), Section 11.4) that this estimator is consistent
for the spectral density f. The argument in fact establishes the consistency of a whole
class of estimators defined as follows.

A discrete spectral average estimator of the spectral density f(A) has the form

2 1 . .
FOy= 5= 3 WaDIn(g(n ) +27j/m), (42.12)
T
| jl<mp
where the bandwidths m,, satisfy

m, — oo and m,/n — 0 asn — oo, 4.2.13)

and the weight functions W, (-) satisfy

Wn(j) = Wu(=)), Wu(j) = 0 for all j, (4.2.14)
> Wa(p) =1, 4.2.15)
‘jlfmn
and
> W2(j) > 0asn — 0. (4.2.16)
|j‘§mn

Remark 3. The conditions imposed on the sequences {m,} and {W,(-)} ensure
consistency of f(k) for f()) for a very large class of stationary processes
(see Brockwell and Davis (1991), Theorem 10.4.1) including all the ARMA
processes considered in this book. The conditions (4.2.13) simply mean that the
number of terms in the weighted average (4.2.12) goes to co as n — oo while
at the same time the width of the frequency interval over which the average
is taken goes to zero. The conditions on {W,(-)} ensure that the mean and
variance of f(k) converge as n — o0 to f(A) and O, respectively. Under the
conditions of Brockwell and Davis (1991), Theorem 10.4.1, it can be shown, in
fact, that

lim Ef(h) = f(1)

and

- 22(A) ifA=v=0o0rm,

lim [ > Wi() | Cov(F). FON =10y ifo<r=v <7,
0 if A #v.

[j1<mn



110 Chapter 4

Spectral Analysis

Figure 4-9

The spectral density
estimate, I1go(A)/(27),

0 < A < 7, of the sunspot
numbers, 1770-1869

Example 4.2.1

Example 4.2.2

1000 1500 2000
T

500
T

For the simple moving average estimator with m, = /n and W, (j) = 2m, + 1 )1
|j| < m,, Remark 3 gives

A 2f2(A) if A =0orm,
2 1) V: A
(ﬁ+ ) ar(f( )>_)[f2()») if0 < A < .

O

In practice, when the sample size n is a fixed finite number, the choice of m and
{W(-)} involves a compromise between achieving small bias and small variance for
the estimator f (A). A weight function that assigns roughly equal weights to a broad
band of frequencies will produce an estimate of f(A) that, although smooth, may have
a large bias, since the estimate of f(A) depends on the values of I, at frequencies distant
from X. On the other hand, a weight function that assigns most of its weight to a narrow
frequency band centered at zero will give an estimator with relatively small bias, but
with a larger variance. In practice it is advisable to experiment with a range of weight
functions and to select the one that appears to strike a satisfactory balance between
bias and variance.

The option Spectrum>Smoothed Periodogram in the program ITSM
allows the user to apply up to 50 successive discrete spectral average filters with
weights W(j) = 1/C2m + 1), j = —m,—m + 1, ..., m, to the periodogram. The
value of m for each filter can be specified arbitrarily, and the weights of the filter
corresponding to the combined effect (the convolution of the component filters) is
displayed by the program. The program computes the corresponding discrete spectral
average estimators f A),0<x<m.

The Sunspot Numbers, 1770-1869

Figure 4-9 displays a plot of (27r)~! times the periodogram of the annual sunspot
numbers (obtained by opening the project SUNSPOTS.TSM in ITSM and selecting
Spectrums>Periodogram). Figure 4-10 shows the result of applying the discrete
spectral weights {%, %, %} (corresponding tom = 1, W(j) = 1/2m + 1), |j| < m).
It is obtained from ITSM by selecting Spectrum>Smoothed Periodogram,
entering 1 for the number of Daniell filters, 1 for the order m, and clicking on Apply.
As expected, with such a small value of m, not much smoothing of the periodogram

occurs. If we change the number of Daniell filters to 2 and set the order of the first
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Figure 4-10

The spectral density
estimate, ?(k)/ O<i<m,
of the sunspot numbers,
1770-1869, with  ©

weights {;— % %}
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500

Figure 4-11

The spectral density
estimate, ?(A), O<A<m,
of the sunspot numbers,
1770-1869, with weights

42 3 3 3 2 1
75> 15> 15° 757 15> 15> 15

filter to 1 and the order of the second filter to 2, we obtain a combined filter with a
more dispersed set of weights, W(0) = W(l) = %, wW2) = %, W@3) = %
Clicking on Apply will then give the smoother spectral estimate shown in Figure 4-11.
When you are satisfied with the smoothed estimate click OK, and the dialog box will
close. All three spectral density estimates show a well-defined peak at the frequency
w0 = 27 /10 radians per year, in keeping with the suggestion from the graph of the
data itself that the sunspot series contains an approximate cycle with period around 10

or 11 years.
g

4.3 Time-Invariant Linear Filters

In Section 1.5 we saw the utility of time-invariant linear filters for smoothing the data,
estimating the trend, eliminating the seasonal and/or trend components of the data, etc.
A linear process is the output of a time-invariant linear filter (TLF) applied to a white
noise input series. More generally, we say that the process {Y;} is the output of a linear
filter C = {c;4,t, k =0+ 1, ...} applied to an input process {X,} if
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Example 4.3.1

Example 4.3.2

Proposition 4.3.1

o
Y=Y X t=0,%l.... (4.3.1)

k=—00

The filter is said to be time-invariant if the weights ¢, ,_ are independent of ¢, i.e., if

Cri—k = Wk-

In this case,

o
Yt= Z 1/katfk
k=—00

and

00
Y s = Z kat—s—k’

k=—00

so that the time-shifted process {Y;_,,t = 0, £1,...} is obtained from {X,_;,t =
0, &1, ...} by application of the same linear filter ¥ = {y;,j = 0, %1, ...}. The
TLF v is said to be causal if

Y =0for j <O,

since then Y, is expressible in terms only of X;, s < t.

The filter defined by
Y,=aX,t, t:O,:tl,...,

is linear but not time-invariant, since ¢, ,—y = 0 except when 2t = k. Thus, ¢, ,_
depends on the value of ¢.

O
The Simple Moving Average
The filter
Yi=Q2q+ 1)_1 Z Xi—j
ljl=q
is a TLF with ¢; = (29 + 1)*1,j = —q, ..., q, and ¥; = 0 otherwise.
O

Spectral methods are particularly valuable in describing the behavior of time-
invariant linear filters as well as in designing filters for particular purposes such as
the suppression of high-frequency components. The following proposition shows how
the spectral density of the output of a TLF is related to the spectral density of the
input—a fundamental result in the study of time-invariant linear filters.

Let {X;} be a stationary time series with mean zero and spectral density fx()L).
Suppose that ¥V = {y;,j = 0,%1,...} is an absolutely summable TLF (i.e.,

Zfi_oo |¥j| < 00). Then the time series

o
Y, = Z VX
j=—00
is stationary with mean zero and spectral density

Fr0) = [W(e™)|’ ) = W (e M)W () 0,
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Proof

where W(e™™) = Y°F e 7. (The function W(e™") is called the transfer

function of the filter, and the squared modulus |\IJ(e”") |2 is referred to as the power
transfer function of the filter.)

Applying Proposition 2.2.1, we see that {Y;} is stationary with mean 0 and ACVF

yr(h) = Y Yyxh+k —j). (43.2)

Jk=—00

Since {X,} has spectral density fx (1), we have

yx(h+k —j) = / IR (V) d, (4.3.3)

—TT

which, when substituted into (4.3.2), gives

J/Y(h) = Z wjl//k/ ei(h_j—i_k)kfx()«) dxr
Jrk=—00 -

_ /n Z 1//je_’:’1 ( Z wkeikk> €ihkfx()h) dxr
Jj=—00 k=—00

-7

2
0

:/n el’hx Z wje—ij)» fX()\)d)\-
—7 oo

The last expression immediately identifies the spectral density function of {Y;} as
—in |2 —i i
@) = Y () Gy = v (™) (e™) fr (). ]

Remark 4. Proposition 4.3.1 allows us to analyze the net effect of applying one or
more filters in succession. For example, if the input process {X;} with spectral density
fx is operated on sequentially by two absolutely summable TLFs ¥, and W, then
the net effect is the same as that of a TLF with transfer function (e‘“)lllz (e‘“) and
the spectral density of the output process

W = ¥1(B)y2(B) X;

is |1 (e7™) Y2 (e ™) |2fx(k). (See also Remark 2 of Section 2.2.) O

As we saw in Section 1.5, differencing at lag s is one method for removing a
seasonal component with period s from a time series. The transfer function for this
filter is 1 — e~*, which is zero for all frequencies that are integer multiples of 27 /s
radians per unit time. Consequently, this filter has the desired effect of removing all
components with period s.

The simple moving-average filter in Example 4.3.2 has transfer function

Y (e™™) = D,(),



114

Chapter 4

Spectral Analysis

Figure 4-12
The transfer function
D19 (1) for the simple
moving-average filter
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where D, (1) is the Dirichlet kernel

sin[(g + 0.5)A] £ 20
D,(M) =g+ 1)" Z e =1 2¢+ )sin(r/2)’ i #0,
ljl<q L, if A =0.

A graph of D, is given in Figure 4-12. Notice that |[D,(A)| is near 1 in a neighborhood
of 0 and tapers off to O for large frequencies. This is an example of a low-pass filter.
The ideal low-pass filter would have a transfer function of the form

1, if [A] < .,
Ve ™) =
0, if|A] > .,

where w, is a predetermined cutoff value. To determine the corresponding linear filter,
we expand W (e*’*) as a Fourier series,

v(e™) =Y we (4.3.4)

j=—00

with coefficients

e ) ifj =0,
wj:—f erdr =1 o
21 J o, W—wC), if [j| > 0.
jm

We can approximate the ideal low-pass filter by truncating the series in (4.3.4) at some
large value ¢, which may depend on the length of the observed input series. In Fig-
ure 4-13 the transfer function of the ideal low-pass filter with w.=m /4 is plotted with
the approximations W@ (e=*)=3"" ;e for g=2 and g=10. As can be seen in
the figure, the approximations do not mirror W very well near the cutoff value w, and
behave like damped sinusoids for frequencies greater than w,. The poor approximation
in the neighborhood of w, is typical of Fourier series approximations to functions with

discontinuities, an effect known as the Gibbs phenomenon. Convergence factors may
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be employed to help mitigate the overshoot problem at w, and to improve the overall
approximation of W (e_i') to \I!(e_i') (see Bloomfield 2000).

4.4 The Spectral Density of an ARMA Process

In Section 4.1 the spectral density was computed for an MA(1) and for an AR(1)
process. As an application of Proposition 4.3.1, we can now easily derive the spectral
density of an arbitrary ARMA(p, g) process.

Spectral Density of an ARMA(p,q) Process: If {X;} is a causal ARMA(p, ¢)
process satisfying ¢ (B)X; = 6 (B)Z;, then

219 N
oy = 2L

= — <A<m. (4.4.1)
2 |¢(e—m)|2

Because the spectral density of an ARMA process is a ratio of trigonometric polyno-
mials, it is often called a rational spectral density.

Proof From (3.1.3), {X;} is obtained from {Z;} by application of the TLF with transfer

function
) 0 (e ™
1/f(e_“\) _ ( _M)‘
¢(e)
Since {Z;} has spectral density f,(A\) = o2/(2m), the result now follows from
Proposition 4.3.1. |
For any specified values of the parameters ¢y, ..., ¢,,0;,...,60, and o2, the

Spectrum>Model option of ITSM can be used to plot the model spectral density.
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Figure 4-14

The spectral density
fx(A),0 < A < 7 of the
AR(2) model (3.2.20) fitted
to the mean-corrected
sunspot series

Example 4.4.1

Example 4.4.2
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The Spectral Density of an AR(2) Process

For an AR(2) process (4.4.1) becomes

o2

(1 _ d)le—’* _ (]526_2’7‘)(1 _ ¢16’"’\ _ ¢262ix)

O.2

" 2 (1 + 62 + 22 + B2 + 2(b1ha — 1) COS & — 4ehy cOS? )

fx) = 7

Figure 4-14 shows the spectral density, found from the Spectrum>Model option
of ITSM, for the model (3.2.20) fitted to the mean-corrected sunspot series. Notice
the well-defined peak in the model spectral density. The frequency at which this peak
occurs can be found by differentiating the denominator of the spectral density with
respect to cos A and setting the derivative equal to zero. This gives

cost. = NP2 P _ 849,
4¢,
The corresponding frequency is A = 0.556 radians per year, or equivalently

¢ = A/(2m) = 0.0885 cycles per year, and the corresponding period is therefore
1/0.0885 = 11.3 years. The model thus reflects the approximate cyclic behavior of the
data already pointed out in Example 4.2.2. The model spectral density in Figure 4-14
should be compared with the rescaled periodogram of the data and the nonparametric
spectral density estimates of Figures 4-9, 4-10, and 4-11.

O

The ARMAC(1,1) Process

In this case the expression (4.4.1) becomes
o2(1 4 0e™)(1 + e™*)
2 (1 — ge™)(1 — pe™™)

. o2(1 4+ 6> +26cos)) 0
" 2m(1 4+ @2 —2¢pcosA)’

Sx() =
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Problems

4.4.1 Rational Spectral Density Estimation

An alternative to the spectral density estimator of Definition 4.2.2 is the estimator
obtained by fitting an ARMA model to the data and then computing the spectral density
of the fitted model. The spectral density shown in Figure 4-14 can be regarded as such
an estimate, obtained by fitting an AR(2) model to the mean-corrected sunspot data.

Provided that there is an ARMA model that fits the data satisfactorily, this proce-
dure has the advantage that it can be made systematic by selecting the model according
(for example) to the AICC criterion (see Section 5.5.2). For further information see
Brockwell and Davis (1991), Section 10.6.

4.1 Show that

T 2m, ifk=h,
/ Gk=IA gy — {

b 0, otherwise.

4.2 If {Z,} ~ WN(O, 02), apply Corollary 4.1.1 to compute the spectral density of
{Z}.

4.3 Show that the vectors ey, ..., e, are orthonormal in the sense of (4.2.3).

4.4 Use Corollary 4.1.1 to establish whether or not the following function is the
autocovariance function of a stationary process {X,}:

1 ifh=0,

—0.5 ifh =42,
y(h) = .

—0.25 if h = 43,

0 otherwise.

4.5 If {X;} and {Y,} are uncorrelated stationary processes with autocovariance func-
tions yx(-) and yy(-) and spectral distribution functions Fx(-) and Fy(-), respec-
tively, show that the process {Z;, = X, + Y;} is stationary with autocovariance
function y; = yx + yy and spectral distribution function F; = Fx + Fy.

4.6 Let {X,} be the process defined by
X, = Acos(wt/3) + Bsin(wt/3) + Y;,
where Y; = Z; + 2.5Z,_1,{Z;} ~ WN(O, 02), A and B are uncorrelated with

mean 0 and variance v2, and Z, is uncorrelated with A and B for each ¢. Find
the autocovariance function and spectral distribution function of {X,}.

4.7 Let {X,} denote the sunspot series filed as SUNSPOTS.TSM and let {Y,} denote
the mean-corrected series Y; = X; — 46.93, ¢t = 1, ..., 100. Use ITSM to find
the Yule-Walker AR(2) model

Yi=¢\Y1+ Yo+ Z, {Z)~WN(0,07),

i.e., find ¢1, ¢, and o>. Use ITSM to plot the spectral density of the fitted model
and find the frequency at which it achieves its maximum value. What is the
corresponding period?
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4.8

4.9

4.10

(a) Use ITSM to compute and plot the spectral density of the stationary series
{X;} satisfying

Xt - 0'99Xt—3 == Zt, {Zt} ~ WN(O, 1).
(b) Does the spectral density suggest that the sample paths of {X;} will exhibit
approximately oscillatory behavior? If so, then with what period?

(c) Use ITSM to simulate a realization of X1, ..., Xeo and plot the realization.
Does the graph of the realization support the conclusion of part (b)? Save the
generated series as X.TSM by clicking on the window displaying the
graph, then on the red EXP button near the top of the screen. Select Time
Series and File in the resulting dialog box and click OK. You will then
be asked to provide the file name, X. TSM.

(d) Compute the spectral density of the filtered process

1
Yt = E(thl +Xt +Xt+1)

and compare the numerical values of the spectral densities of {X;} and {Y;}
at frequency @ = 27 /3 radians per unit time. What effect would you expect
the filter to have on the oscillations of {X;}?

(e) Open the project X. TSM and use the option Smooth>Moving Ave.
to apply the filter of part (d) to the realization generated in part (c). Comment
on the result.

The spectral density of a real-valued time series {X,} is defined on [0, 7] by

100, if 7/6 —0.01 < A < 7/6+0.01,
f) =

0, otherwise,

and on [—m, 0] by f(X) = f(—A).

(a) Evaluate the ACVF of {X,} at lags 0 and 1.
(b) Find the spectral density of the process {Y;} defined by
Yi:=VpXi =X, — X 1n.

(c) What is the variance of Y;?

(d) Sketch the power transfer function of the filter Vi, and use the sketch to
explain the effect of the filter on sinusoids with frequencies (i) near zero and
(i1) near /6.

Suppose that {X;} is the noncausal and noninvertible ARMA(1,1) process sat-
isfying

X, — ¢Xio1 =Z,+0Z_y,  {Z} ~WN(0,07),
where |¢| > 1 and |0] > 1. Define ¢(B) = 1 — ;B and 6(B) = 1+ 1B and let
{W,} be the process given by

W, := 60" (B)¢p(B)X,.
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(a) Show that {W;} has a constant spectral density function.
(b) Conclude that {W,} ~ WN(O, av%). Give an explicit formula for 0»3 in terms
of ¢, 6, and 2.

(c) Deduce that (Z)(B)Xt = é(B)W,, so that {X,} is a causal and invertible
ARMA(1,1) process relative to the white noise sequence {W;}.
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5.1 Preliminary Estimation

5.2 Maximum Likelihood Estimation
5.3 Diagnostic Checking

5.4 Forecasting

5.5 Order Selection

The determination of an appropriate ARMA(p, g) model to represent an observed
stationary time series involves a number of interrelated problems. These include
the choice of p and ¢ (order selection) and estimation of the mean, the coefficients
{¢;i = 1,...,p}, {6,,i = 1,...,q}, and the white noise variance o2. Final
selection of the model depends on a variety of goodness of fit tests, although it can
be systematized to a large degree by use of criteria such as minimization of the
AICC statistic as discussed in Section 5.5. (A useful option in the program ITSM
is Model>Estimation>Autofit, which automatically minimizes the AICC
statistic over all ARMA(p, g) processes with p and ¢ in a specified range.)

This chapter is primarily devoted to the problem of estimating the parameters
¢ =(bi,....9,),0 =(6,...,0,), and 0% when p and ¢ are assumed to be known,
but the crucial issue of order selection is also considered. It will be assumed throughout
(unless the mean is believed a priori to be zero) that the data have been “mean-
corrected” by subtraction of the sample mean, so that it is appropriate to fit a zero-mean
ARMA model to the adjusted data xy, ..., x,. If the model fitted to the mean-corrected
data is

$(B)X, = 0(B)Z:, {Z) ~ WN(0,0%),

then the corresponding model for the original stationary series {Y;} is found on
replacing X, for each t by ¥, — y, where y = n~! ;.':1 y; is the sample mean of the
original data, treated as a fixed constant.

When p and ¢ are known, good estimators of ¢ and 0 can be found by imagining
the data to be observations of a stationary Gaussian time series and maximizing
the likelihood with respect to the p + g + 1 parameters ¢y, ..., ¢,,0,...,6,

© Springer International Publishing Switzerland 2016 121
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and o2, The estimators obtained by this procedure are known as maximum likelihood
(or maximum Gaussian likelihood) estimators. Maximum likelihood estimation is
discussed in Section 5.2 and can be carried out in practice using the ITSM option
Model>Estimation>Max likelihood, after first specifying a preliminary
model to initialize the maximization algorithm. Maximization of the likelihood and
selection of the minimum AICC model over a specified range of p and g values can
also be carried out using the option Model>Estimation>Autofit.

The maximization is nonlinear in the sense that the function to be maximized is not
a quadratic function of the unknown parameters, so the estimators cannot be found by
solving a system of linear equations. They are found instead by searching numerically
for the maximum of the likelihood surface. The algorithm used in ITSM requires the
specification of initial parameter values with which to begin the search. The closer the
preliminary estimates are to the maximum likelihood estimates, the faster the search
will generally be.

To provide these initial values, a number of preliminary estimation algorithms
are available in the option Model>Estimation>Preliminary of ITSM. They
are described in Section 5.1. For pure autoregressive models the choice is between
Yule-Walker and Burg estimation, while for models with ¢ > 0 it is between the
innovations and Hannan—Rissanen algorithms. It is also possible to begin the search
with an arbitrary causal ARMA model by using the option Model>Specify and
entering the desired parameter values. The initial values are chosen automatically in
the option Model >Estimation>Autofit.

Calculation of the exact Gaussian likelihood for an ARMA model (and in fact for
any second-order model) is greatly simplified by use of the innovations algorithm. In
Section 5.2 we take advantage of this simplification in discussing maximum likelihood
estimation and consider also the construction of confidence intervals for the estimated
coefficients.

Section 5.3 deals with goodness of fit tests for the chosen model and Section 5.4
with the use of the fitted model for forecasting. In Section 5.5 we discuss the theoretical
basis for some of the criteria used for order selection.

For an overview of the general strategy for model-fitting see Section 6.2.

5.1 Preliminary Estimation

In this section we shall consider four techniques for preliminary estimation of the

parameters ¢ = (¢1,...,¢,), 0 = (61,...,¢,), and o? from observations xj,. . ., X,
of the causal ARMA(p, g) process defined by
¢(B)X, = 0(B)Z;, {Z}~ WN(0,57). (5.1.1)

The Yule—-Walker and Burg procedures apply to the fitting of pure autoregressive
models. (Although the former can be adapted to models with ¢ > 0, its performance is
less efficient than when ¢ = 0.) The innovation and Hannan—Rissanen algorithms are
used in ITSM to provide preliminary estimates of the ARMA parameters when g > 0.

For pure autoregressive models Burg’s algorithm usually gives higher likelihoods
than the Yule—Walker equations. For pure moving-average models the innovations
algorithm frequently gives slightly higher likelihoods than the Hannan—Rissanen
algorithm (we use only the first two steps of the latter for preliminary estimation). For
mixed models (i.e., those with p > 0 and ¢ > 0) the Hannan—Rissanen algorithm is
usually more successful in finding causal models (which are required for initialization
of the likelihood maximization).
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5.1.1 Yule~Walker Estimation

For a pure autoregressive model the moving-average polynomial 6(z) is identically 1,
and the causality assumption in (5.1.1) allows us to write X; in the form

(0.¢]
X, =Y ViZij, (5.1.2)
=0

where, from Section 3.1, ¥ (z) = Z;:o l//jz-/ = 1/¢(z). Multiplying each side of (5.1.1)
by X,_j, j=0,1,2, ..., p, taking expectations, and using (5.1.2) to evaluate the right-

hand side of the first equation, we obtain the Yule—Walker equations

Ly =1, (5.1.3)

and

o’ =y(0) — ¢, (5.1.4)

where I', is the covariance matrix [y (i —j)]ﬁ =1 and v, = (y(1), ..., y(p)). These
equations can be used to determine y (0), ..., y (p) from o and ¢.

On the other hand, if we replace the covariances y(j), j = O, ..., p, appearing
in (5.1.3) and (5.1.4) by the corresponding sample covariances y (j), we obtain a set
of equations for the so-called Yule—Walker estimators é and 62 of ¢ and o2, namely,

T, =4, (5.1.5)
and
62 =7(0) — 7y, (5.1.6)
where I', = [P (i —pJ} . and A, = (D), ..., ().
If 7(0) > 0, then I',, is nonsingular for every m = 1,2, ... (see Brockwell and

Davis (1991), Problem 7.11), so we can rewrite equations (5.1.5) and (5.1.6) in the
following form:

Sample Yule—Walker Equations:

¢ = («il,...,ép) =R 'p, (5.1.7)
and
&= 7O [1- ik by . (5.1.8)

where p, = (A(1), ..., A(p)) = 4,/7(0).

With q?) as defined by (5.1.7), it can be shown that 1 — (f)lz — = q@pz” # 0 for
|z] <1 (see Brockwell and Davis (1991), Problem 8.3). Hence the fitted model

X, — Xt — - — Xy =Z,  {Z} ~ WN(0,6?)

is causal. The autocovariances y,. (h),h = 0, ..., p, of the fitted model therefore satisfy
the p + 1 linear equations

A A 0, h=1,...,p,
Vo(h) = iy, (h=1) = =Gy, (h—p) =1 P
o°, h=0.
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However, from (5.1.5) and (5.1.6) we see that the solution of these equations is y,.(h) =
y(h),h =0, ..., p, so that the autocovariances of the fitted model at lags 0, 1, ..., p
coincide with the corresponding sample autocovariances.

The argument of the preceding paragraph shows that for every nonsingular
covariance matrix of the form I, = [y (i — j)]ﬁ J/r:ll there is an AR(p) process whose
autocovariances at lags 0, ...,p are y(0), ..., y(p). (The required coefficients and
white noise variance are found from (5.1.7) and (5.1.8) on replacing p(j) by v (j)/y (0),
j=0,...,p,and y(0) by y(0).) There may not, however, be an MA(p) process with
this property. For example, if ¥(0) = 1 and y (1) = y(—1) = B, the matrix ['; is a
nonsingular covariance matrix for all 8 € (—1, 1). Consequently, there is an AR(1)
process with autocovariances 1 and g at lags O and 1 for all § € (—1, 1). However,
there is an MA(1) process with autocovariances 1 and 8 at lags 0 and 1 if and only if

18] < % (See Example 2.1.1).

It is often the case that moment estimators, i.e., estimators that (like (}b) are obt-
ained by equating theoretical and sample moments, have much higher variances than
estimators obtained by alternative methods such as maximum likelihood. However,
the Yule—Walker estimators of the coefficients ¢, ..., ¢, of an AR(p) process have
approximately the same distribution for large samples as the corresponding maximum
likelihood estimators. For a precise statement of this result see Brockwell and Davis
(1991), Section 8.10. For our purposes it suffices to note the following:

Large-Sample Distribution of Yule-Walker Estimators:
For a large sample from an AR( p) process,

é~N (9, n_lasz_l) .

If we replace o2 and I, by their estimates 6% and f‘,,, we can use this result to find
large-sample confidence regions for ¢ and each of its components as in (5.1.12) and
(5.1.13) below.

Order Selection

In practice we do not know the true order of the model generating the data. In fact, it
will usually be the case that there is no true AR model, in which case our goal is simply
to find one that represents the data optimally in some sense. Two useful techniques for
selecting an appropriate AR model are given below. The second is more systematic
and extends beyond the narrow class of pure autoregressive models.

* Some guidance in the choice of order is provided by a large-sample result (see
Brockwell and Davis (1991), Section 8.10), which states that if {X,} is the causal
AR(p) process defined by (5.1.1) with {Z,} ~ iid(O, 02) and if we fit a model with
order m > p using the Yule—Walker equations, i.e., if we fit a model with coefficient
vector

then the last component, Bums Of the vector (Abm is approximately normally dis-
tributed with mean O and variance 1/n. Notice that ¢,,, is exactly the sample partial
autocorrelation at lag m as defined in Section 3.2.3.

Now, we already know from Example 3.2.6 that for an AR( p), process the partial
autocorrelations ¢,,,, m > p, are zero. By the result of the previous paragraph,
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Definition 5.1.1

if an AR(p) model is appropriate for the data, then the values bk, k > p, should
be compatible with observations from the distribution N(0, 1/n). In particular, for
k > p, qgkk will fall between the bounds £1.96n~!/2 with probability close to 0.95.
This suggests using as a preliminary estimator of p the smallest value m such that
|q7>kk| < 1.96n~'2 for k > m.

The program I'TSM plots the sample PACF {qgmm m=172,... } together with the
bounds +1.96/,/n. From this graph it is easy to read off the preliminary estimator
of p defined above.

* A more systematic approach to order selection is to find the values of p and ¢, that
minimize the AICC statistic (see Section 5.5.2 below)

AICC = —21In L(¢,, S(¢pp)/n) +2(p + Dn/(n — p — 2),

where L is the Gaussian likelihood defined in (5.2.9) and S is defined in (5.2.11).
The Preliminary Estimationdialog box of ITSM (opened by pressing the
blue PRE button) allows you to search for the minimum AICC Yule-Walker (or
Burg) models by checking Find AR model with min AICC. This causes
the program to fit autoregressions of orders 0, 1, ..., 27 and to return the model
with smallest AICC value.

The fitted Yule—Walker AR(m) model is

X, — G Xict = = GunXiom = Zi, {Z} ~WN(0,9,),  (5.1.9)
where

b = (éml, - (z;mm)/ =R, o, (5.1.10)
and

B = 7(0) [1 — ,3;11%;1,5,,1] . (5.1.11)

For both approaches to order selection we need to fit AR models of gradually
increasing order to our given data. The problem of solving the Yule—Walker equations
with gradually increasing orders has already been encountered in a slightly different
context in Section 2.5.3, where we derived a recursive scheme for solving the
equations (5.1.3) and (5.1.4) with p successively taking the values 1, 2, . ... Here we
can use exactly the same scheme (the Durbin—Levinson algorithm) to solve the Yule—
Walker equations (5.1.5) and (5.1.6), the only difference being that the covariances
in (5.1.3) and (5.1.4) are replaced by their sample counterparts. This is the algorithm
used by ITSM to perform the necessary calculations.

Confidence Regions for the Coefficients

Under the assumption that the order p of the fitted model is the correct value, we can
use the asymptotic distribution of (}b,, to derive approximate large-sample confidence
regions for the true coefficient vector ¢, and for its individual components ¢,;. Thus,
if X127a (p) denotes the (1 — o) quantile of the chi-squared distribution with p degrees
of freedom, then for large sample-size n the region

:qb ER: (<}>,, - ¢)/ P, (&5,, — ¢) < nlﬁ,,xfa(p)} (5.1.12)
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Example 5.1.1

contains ¢, with probability close to (1 — o). (This follows from Problem A.7 and
the fact that ﬁ((Abp — q,’)p) is approximately normally distributed with mean 0 and
covariance matrix f/pf‘p_ ') Similarly, if ®,_, denotes the (1 — «) quantile of the

standard normal distribution and V;; is the jth diagonal element of ¥, f; ! then for large
n the interval bounded by

Bpj = P1_appn 20 (5.1.13)

contains ¢,; with probability close to (1 — ).

The Dow Jones Utilities Index, Aug. 28-Dec. 18, 1972; DOWIJ.TSM

The very slowly decaying positive sample ACF of the time series contained in the
file DOWJ.TSM this time series suggests differencing at lag 1 before attempting to
fit a stationary model. One application of the operator (1 — B) produces a new series
{Y;} with no obvious deviations from stationarity. We shall therefore try fitting an AR
process to this new series

Y,=D;— D,

using the Yule—Walker equations. There are 77 values of Y;, which we shall denote
by Y1, ..., Y77. (We ignore the unequal spacing of the original data resulting from
the five-day working week.) The sample autocovariances of the series yy, ..., y77 are
y(0) = 0.17992, (1) = 0.07590, y (2) = 0.04885, etc.

Applying the Durbin—Levinson algorithm to fit successively higher-order autore-
gressive processes to the data, we obtain

¢ = p(1) = 04219,

b =70)[1-p*1)] =0.1479,

b2 = [P = dup ()] /i = 0.1138,
b21 = 11 — dr1¢ = 0.3739,

by =91 [1 - ¢ ] = 0.1460.

The sample ACF and PACF of the data can be displayed by pressing the second
yellow button at the top of the ITSM window. They are shown in Figures 5-1 and 5-2,
respectively. Also plotted are the bounds £1.96/+/77. Since the PACF values at lags
greater than 1 all lie between the bounds, the first order-selection criterion described
above indicates that we should fit an AR(1) model to the data set {Y,}. Unless we wish
to assume that {Y,} is a zero-mean process, we should subtract the sample mean from
the data before attempting to fit a (zero-mean) AR(1) model. When the blue PRE
(preliminary estimation) button at the top of the ITSM window is pressed, you will be
given the option of subtracting the mean from the data. In this case (as in most) click
Yes to obtain the new series

Xl = Yt - 0.1336.

You will then see the Preliminary Estimationdialog box. Enter 1 for the AR
order, zero for the MA order, select Yule-Walker, and click OK. We have already
computed $11 and 9; above using the Durbin-Levinson algorithm. The Yule—Walker
AR(1) model obtained by ITSM for {X,} is therefore (not surprisingly)

X, —0.4219X,_, = Z;, {Z;} ~ WN(0, 0.1479), (5.1.14)
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and the corresponding model for {Y}} is

Y, —0.1336 — 0.4219(Y,—; — 0.1336) = Z,, {Z:} ~ WN(O0, 0.1479).
(5.1.15)

Assuming that our observed data really are generated by an AR process with
p = 1, (5.1.13) gives us approximate 95 % confidence bounds for the autoregressive
coefficient ¢,

(1.96)(0.1479)'/2
+
(0.17992)1/2/77

Besides estimating the autoregressive coefficients, ITSM computes and prints out
the ratio of each coefficient to 1.96 times its estimated standard deviation. From these
numbers large-sample 95 % confidence intervals for each of the coefficients are easily

0.4219

— (0.2194, 0.6244).
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Example 5.1.2

obtained. In this particular example there is just one coefficient estimate, $1 = 0.4219,
with ratio of coefficient to 1.96xstandard error equal to 2.0832. Hence the required
95 % confidence bounds are 0.4219 4 0.4219/2.0832 = (0.2194, 0.6244), as found
above.

A useful technique for preliminary autoregressive estimation that incorporates
automatic model selection (i.e., choice of p) is to minimize the AICC [see equa-
tion (5.5.4)] over all fitted autoregressions of orders O through 27. This is achieved
by selecting both Yule-Walkerand Find AR model with min AICCinthe
Preliminary Estimation dialog box. (The MA order must be set to zero, but
the AR order setting is immaterial.) Click OK, and the program will search through
all the Yule-Walker AR (p) models, p = 0, 1, ..., 27, selecting the one with smallest
AICC value. The minimum-AICC Yule-Walker AR model turns out to be the one
defined by (5.1.14) with p = 1 and AICC value 74.541.

O

Yule-Walker Estimation with g > 0; Moment Estimators

The Yule—Walker estimates for the parameters in an AR(p) model are examples
of moment estimators: The autocovariances at lags 0, 1, ..., p are replaced by the
corresponding sample estimates in the Yule—Walker equations (5.1.3), which are then
solved for the parameters ¢ = (¢1,...,¢,) and o2. The analogous procedure
for ARMA(p, g) models with ¢ > 0 is easily formulated, but the corresponding
equations are nonlinear in the unknown coefficients, leading to possible nonexistence
and nonuniqueness of solutions for the required estimators.

From (3.2.5), the equations to be solved for ¢y, ..., ¢,, 01, ...,6, and o? are
q
Pl —prpk—1) = =Pk —p)=0>) 6w, 0<k<p+g
=k
(5.1.16)

where v/; must first be expressed in terms of ¢ and @ using the identity ¥ (z) =
0(2)/¢(z) (6p :==1and 6§, = ; = 0 forj < 0).

For the MA(1) model the equation (5.1.16) are equivalent to

70) =5 (1+67), (5.1.17)
b
p(l) = — . (5.1.18)
1+06;

If |,5(1)| > 0.5, there is no real solution, so we define 8, = ,6(1)/|,5(1)|. If |,5(1)| <
0.5, then the solution of (5.1.17)—(5.1.18) (with |é| <1is

b= (1-(1-4520)"") / (25 (D).
62 =70/ (1+6}).

For the overshort data of Example 3.2.8, 0(1) = —0.5035 and y (0) = 3416, so the
fitted MA(1) model has parameters §; = —1.0 and 62 = 1708.
]
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Relative Efficiency of Estimators
The performance of two competing estimators is often measured by computing their
asymptotic relative efficiency. In a general statistics estimation problem, suppose 61

and 5,52) are two estimates of the parameter 0 in the parameter space ® based on the
observations X1, ..., X,,. If é,fi) is approximately N(Q, aiz (9)) forlarge n,i = 1, 2, then
the asymptotic efficiency of 41 relative to 0 is defined to be

¢ (9, FI08 é(2)) — @.

ol (0)
If 6(0, 0 M 0 (2)) < 1 for all 6 € ®, then we say that 9:52) is a more efficient estimator
of 6 than 9:51) (strictly more efficient if in addition, 6(9, é(l), 5(2)) < 1 for some 6 €
®). For the MA(1) process the moment estimator Orfl) discussed in Example 5.1.2 is
approximately N(@l, 012(01) /n) with

o2(61) = (1467 + 40! + 6 +6%)/(1 — 67)°

(see Brockwell and Davis (1991), p. 254). On the other hand, the innovations estimator
érfz) discussed in the next section is distributed approximately as N(Gl, nil). Thus,
6(01, é(l), 5(2)) = 01_2(01) < 1forall |6;] < 1, with strict inequality when 8 £ 1. In
particular,

0.82. 0, =025,
e(el,é(“, é(z)) = 1037, 6, =050,
0.06. 0, = 0.75,

demonstrating the superiority, at least in terms of asymptotic relative efficiency, of é,fz)
over 81, On the other hand (Section 5.2), the maximum likelihood estimator 8> of
0, is approximately N(0;, (1 — 012)/ n). Hence,

0.94, 6, = 0.25,
e (91, 60, é<3>) =10.75. 6, =050,
044, 6, = 0.75.

While éf) is more efficient, 9:52) has reasonably good efficiency, except when |0] is
close to 1, and can serve as initial value for the nonlinear optimization procedure in
computing the maximum likelihood estimator.

While the method of moments is an effective procedure for fitting autoregressive
models, it does not perform as well for ARMA models with ¢ > 0. From a computa-
tional point of view, it requires as much computing time as the more efficient estimators
based on either the innovations algorithm or the Hannan—Rissanen procedure and is

therefore rarely used except when g = 0.

5.1.2 Burg’s Algorithm

The Yule—Walker coefficients q?)l,l, ey ¢A>pp are precisely the coefficients of the best
linear predictor of X, in terms of {X,, ..., X;} under the assumption that the ACF

of {X;} coincides with the sample ACF atlags 1, ..., p.

Burg’s algorithm estimates the PACF {¢,1, ¢, ...} by successively minimizing
sums of squares of forward and backward one-step prediction errors with respect to the
coefficients ¢;;. Given observations {xi, ..., x,} of a stationary zero-mean time series
{X;} we define u;(1),t = i+ 1,...,n,0 < i < n, to be the difference between
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Xn+1+i—r and the best linear estimate of x,,,;;_, in terms of the preceding i observations.
Similarly, we define v;(¢),t =i+ 1,...,n,0 < i < n, to be the difference between
Xn+1—r and the best linear estimate of x,,,;_, in terms of the subsequent i observations.
Then it can be shown (see Problem 5.6) that the forward and backward prediction
errors {u;()} and {v;(#)} satisfy the recursions

MO(I) = VO(I) = Xn4+1—t»

ui(t) = w1 (t — 1) — ¢yvi—1 (1), (5.1.19)
and
vi(t) = vi_1 (1) — Qi (£ — 1). (5.1.20)
Burg’s estimate d)flf) of ¢1; is found by minimizing
1 n
2 2 2
o= ——— Y [ + )
LT 2(n-1) ; L 0]

with respect to ¢;;. This gives corresponding numerical values for «; (¢) and v, (f) and
012 that can then be substituted into (5.1.19) and (5.1.20) with i = 2. Then we minimize

1 n
% = 5D Y (B0 +v0)]

t=3

with respect to ¢, to obtain the Burg estimate qz‘)g) of ¢, and corresponding values
of uy (1), vo(¢), and 022. This process can clearly be continued to obtain estimates ¢,(£)
and corresponding minimum values, 0,53)2, p < n — 1. Estimates of the coefficients
¢pj, 1 <j < p — 1, in the best linear predictor

Ppo+1 = ¢p1Xp +---+ ¢pr1

are then found by substituting the estimates d)i(iB), i=1,...,p,for ¢;in the recursions

(2.5.20)—(2.5.22). The resulting estimates of ¢,;, j = 1,...,p, are the coefficient
estimates of the Burg AR(p) model for the data {xi, ..., x,}. The Burg estimate of the
white noise variance is the minimum value 0153)2 found in the determination of ¢l§§>.

The calculation of the estimates of ¢, and sz described above is equivalent (Problem
5.7) to solving the following recursions:

Burg’s Algorithm:

d(l) = (up(t — 1) +v3(2).

=2

2 n
o= 2 2 vim1 O = 1,

t=i+1

di+1) = (1= ¢P%) di) = v+ 1) — (o),

o =[(1-0"?) dd] /1200 — 1.
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Example 5.1.3

Example 5.1.4

Figure 5-3
The sample ACF of the lake
data in Example 5.1.4

The large-sample distribution of the estimated coefficients for the Burg estimators
of the coefficients of an AR(p) process is the same as for the Yule—Walker estimators,
namely, N(q‘), n_lazl“p_ 1). Approximate large-sample confidence intervals for the
coefficients can be found as in Section 5.1.1 by substituting estimated values for o>
and I',.

The Dow Jones Utilities Index

The fitting of AR models using Burg’s algorithm in the program ITSM is completely
analogous to the use of the Yule—Walker equations. Applying the same transformations
as in Example 5.1.1 to the Dow Jones Ultilities Index and selecting Burg instead
of Yule-Walkerinthe Preliminary Estimation dialog box, we obtain the
minimum AICC Burg model

X, —04371X,_ =Z,, {Z;} ~ WN(0, 0.1423), (5.1.21)

with AICC = 74.492. This is slightly different from the Yule—Walker AR(1) model
fitted in Example 5.1.1, and it has a larger likelihood L, i.e., a smaller value of
—21InL (see Section 5.2). Although the two methods give estimators with the same
large-sample distributions, for finite sample sizes the Burg model usually has smaller
estimated white noise variance and larger Gaussian likelihood. From the ratio of the
estimated coefficient to (1.96 x standard error) displayed by ITSM, we obtain the 95 %
confidence bounds for ¢: 0.4371 £ 0.4371/2.1668 = (0.2354, 0.6388).

g

The Lake Data

This series {Y,,t = 1,...,98} has already been studied in Example 1.3.5. In this
example we shall consider the problem of fitting an AR process directly to the data
without first removing any trend component. A graph of the data was displayed in
Figure 1-9. The sample ACF and PACF are shown in Figures 5-3 and 5-4, respectively.

The sample PACF shown in Figure 5-4 strongly suggests fitting an AR(2) model
to the mean-corrected data X; = Y, — 9.0041. After clicking on the blue preliminary
estimation button of ITSM select Yes to subtract the sample mean from {Y,}. Then

1.0

0.6 0.8

ACF
0.4

0.2
T

0.0

-0.2
!

Lag
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specify 2 for the AR order, O for the MA order, and Burg for estimation. Click OK to
obtain the model

X, —1.0449X,_, + 0.2456X,_, = Z,, {Z;} ~ WN(0, 0.4706),
with AICC value 213.55 and 95 % confidence bounds

¢ : 1.0449 £ 1.0449/5.5295 = (0.8559, 1.2339),

¢y 1 —0.2456 £ 0.2456/1.2997 = (—0.4346, —0.0566).
Selecting the Yule—Walker method for estimation, we obtain the model

X, —1.0538X,_; + 0.2668X,_, = Z,, {Z;} ~ WN(0, 0.4920),
with AICC value 213.57 and 95 % confidence bounds

¢ : 1.0538 £1.0538/5.5227 = (0.8630, 1.2446),

¢, : —0.2668 £ 0.2668/1.3980 = (—0.4576, —0.0760).

We notice, as in Example 5.1.3, that the Burg model again has smaller white noise
variance and larger Gaussian likelihood than the Yule—Walker model.

If we determine the minimum AICC Yule—Walker and Burg models, we find that
they are both of order 2. Thus the order suggested by the sample PACF coincides again
with the order obtained by AICC minimization.

O

5.1.3 The Innovations Algorithm

Just as we can fit autoregressive models of orders 1, 2, ... to the data {x, ..., x,} by
applying the Durbin—Levinson algorithm to the sample autocovariances, we can also
fit moving average models

X, =Zi+6mZir 4+ bumZiom, {2}~ WN(0,9y,) (5.1.22)

of orders m = 1,2, ... by means of the innovations algorithm (Section 2.5.4). The
estimated coefficient vectors 6,, := (9,,,1, e, Qmm)/ and white noise variances Vv,,,
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Definition 5.1.2

m = 1,2, ..., are specified in the following definition. (The justification for using
estimators defined in this way is contained in Remark 1 following the definition.)

The fitted innovations MA (i) model is
Xo =Z+0mZioy + -+ OwnZiem. {2} ~ WN(O, D),

where ém and V,, are obtained from the innovations algorithm with the ACVF
replaced by the sample ACVFE.

Remark 1. It can be shown (see Brockwell and Davis 1988) that if {X;} is an invertible
MA(g) process

X =Z+0Zi1+ -+ Qth—q, {Z,} ~1ID (0, 02) s

with EZ} < oo, and if we define ) = 1 and §; = 0 for j > ¢, then the innovation
estimates have the following large-sample properties. If n — oo and m(n) is any
sequence of positive integers such that m(n) — oo but n=!/3m(n) — 0, then for each
positive integer k the joint distribution function of

n'/? (éml — 01,0 — 0, ... O — 9k)

converges to that of the multivariate normal distribution with mean 0 and covariance
matrix A = [a,;,]i.‘jzl, where

min(i, j)

aj= Y 0,0 (5.1.23)
r=1

This result enables us to find approximate large-sample confidence intervals for the
moving-average coefficients from the innovation estimates as described in the exam-
ples below. Moreover, the estimator 7, is consistent for o2 in the sense that for every
€>0,P(|\3m—02|>6)—>0asm—>oo. O

Remark 2. Although the recursive fitting of moving-average models using the inno-
vations algorithm is closely analogous to the recursive fitting of autoregressive models
using the Durbin-Levinson algorithm, there is one important distinction. For an
AR(p) process the Yule—Walker and Burg estimators (}b,, are consistent estimators of
(@1, ..., ¢,) as the sample size n — oo. However, for an MA(g) process the estimator

0, = (941, ..., 0,)" is not consistent for (6, ..., 6,)". For consistency it is necessary
to use the estimators (6,1, . . ., O,,y)" With m(n) satisfying the conditions of Remark 1.
The choice of m for any fixed sample size can be made by increasing m until the vector
(O, - - - Omg)' stabilizes. It is found in practice that there is a large range of values of
m for which the fluctuations in 6,,; are small compared with the estimated asymptotic

standard deviation n~!/? (Z’ 62 )1/ ? as found from (5.1.23) when the coefficients 6;

i=0 “mi
are replaced by their estimated values 6,,;. O

Order Selection

Three useful techniques for selecting an appropriate MA model are given below. The
third is more systematic and extends beyond the narrow class of pure moving-average
models.
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Example 5.1.5

*  We know from Section 3.2.2 that for an MA(g) process the autocorrelations p (),
m > g, are zero. Moreover, we know from Bartlett’s formula (Section 2.4) that the
sample autocorrelation p(m), m > g, is approximately normally distributed with
mean p(m) = 0 and variance n~! [1 +20%(1) + -+ 2,02(q)]. This result enables
us to use the graph of p(m), m = 1,2, ..., both to decide whether or not a given
data set can be plausibly modeled by a moving-average process and also to obtain
a preliminary estimate of the order g as the smallest value of m such that p (k) is not
significantly different from zero for all £ > m. For practical purposes “significantly
different from zero” is often interpreted as “larger than 1.96/./n in absolute value”
(cf. the corresponding approach to order selection for AR models based on the
sample PACF and described in Section 5.1.1).

 If in addition to examining p(m), m = 1, 2, ..., we examine the coefficient vectors
b, m = 1,2, ..., we are able not only to assess the appropriateness of a moving-
average model and estimate its order ¢, but at the same time to obtain preliminary
estimates Oy, ..., émq of the coefficients. By inspecting the estimated coefficients

éml, R émm for m = 1,2,... and the ratio of each coefficient estimate émj to

1.96 times its approximate standard deviation o; = n~!/ 2[21 —0 ml]l/ > we can
see which of the coefficient estimates are most significantly different from zero,
estimate the order of the model to be fitted as the largest lag j for which the ratio is
larger than 1 in absolute value, and at the same time read off estimated values for
each of the coefficients. A default value of m is set by the program, but it may be
altered manually. As m is increased the values ém Ly oens émm stabilize in the sense
that the fluctuations in each component are of order n~'/2, the asymptotic standard
deviation of 6,,;.

* As for autoregressive models, a more systematic approach to order selection for

moving-average models is to find the values of ¢ and 9 (le, ey qu) that
minimize the AICC statistic

AICC = —21nL(8,, S(6,)/n) + 2(q + Dn/(n — g — 2),

where L is the Gaussian likelihood defined in (5.2.9) and S is defined in (5.2.11).
(See Section 5.5 for further details.)

Confidence Regions for the Coefficients

Asymptotic confidence regions for the coefficient vector 8, and for its individual
components can be found with the aid of the large-sample distribution specified in
Remark 1. For example, approximate 95 % confidence bounds for ¢; are given by

1/2

j—1
O & 1.96n71/ (Z %) : (5.1.24)
i=0

The Dow Jones Utilities Index

In Example 5.1.1 we fitted an AR(1) model to the differenced Dow Jones Utilities
Index. The sample ACF of the differenced data shown in Figure 5-1 suggests that
an MA(2) model might also provide a good fit to the data. To apply the innovation
technique for preliminary estimation, we proceed as in Example 5.1.1 to difference
the series DOWJ.TSM to obtain observations of the differenced series {Y;}. We then
select preliminary estimation by clicking on the blue PRE button and subtract the mean
of the differences to obtain observations of the differenced and mean-corrected series
{X;}. Inthe Preliminary Estimation dialog box enter O for the AR order and
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2 for the MA order, and select Innovations as the estimation method. We must
then specify a value of m, which is set by default in this case to 17. If we accept the
default value, the program will compute 917,1, e 517,17 and print out the first two
values as the estimates of #; and 6,, together with the ratios of the estimated values to
their estimated standard deviations. These are

MA COEFFICIENT
0.4269 0.2704
COEFFICIENT/(1.96*STANDARD ERROR)
1.9114 1.1133

The remaining parameter in the model is the white noise variance, for which two
estimates are given:

WN VARIANCE ESTIMATE = (RESID SS)/N
0.1470

INNOVATION WN VARIANCE ESTIMATE
0.1122

The first of these is the average of the squares of the rescaled one-step prediction errors

under the fitted MA(2) model, i.e., % ZJZI(XJ — )A(J)z /ri—1. The second value is the
innovation estimate, v;7. (By default ITSM retains the first value. If you wish instead
to use the innovation estimate, you must change the white noise variance by selecting
Model>Specify and setting the white noise value to the desired value.) The fitted
model for X;(= Y, — 0.1336) is thus

X, =7,+04269Z,_, +0.2704Z,_,, {Z,} ~ WN(0, 0.1470),

with AICC =77.467.

To see all 17 estimated coefficients 917, j»J =1,..., 17, we repeat the preliminary
estimation, this time fitting an MA(17) model with m = 17. The coefficients and ratios
for the resulting model are found to be as follows:

MA COEFFICIENT

0.4269 0.2704  0.1183 0.1589  0.1355  0.1568 0.1284  —0.0060
0.0148 —0.0017 0.1974 —0.0463 0.2023  0.1285 —0.0213  —0.2575
0.0760

COEFFICIENT/(1.96*STANDARD ERROR)

19114 1.1133  0.4727 0.6314 0.5331 0.6127 0.4969  —0.0231
0.0568 —0.0064 0.7594 —0.1757 0.7667 0.4801 —0.0792 —0.9563
0.2760

The ratios indicate that the estimated coefficients most significantly different from zero
are the first and second, reinforcing our original intention of fitting an MA(2) model to
the data. Estimated coefficients émj for other values of m can be examined in the same
way, and it is found that the values obtained for m > 17 change only slightly from the
values tabulated above.

By fitting MA(g) models of orders O, 1, 2, ..., 26 using the innovations algorithm
with the default settings for m, we find that the minimum AICC model is the one with
g = 2 found above. Thus the model suggested by the sample ACF again coincides
with the more systematically chosen minimum AICC model.

g
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Innovations Algorithm Estimates when p > 0 and q > 0
The causality assumption (Section 3.1) ensures that

(@]
X, =Y iz,
j=0

where the coefficients ; satisfy

min(j, p)
=6+ Y ¢ j=0.1,..., (5.1.25)
i=1
and we define 6y := 1 and 0; := 0 for j > q. To estimate v, ..., ¥,4, We can use
the innovation estimates 6, . . . , ém,,,Jrq, whose large-sample behavior is specified in

Remark 1. Replacing ; by émj in (5.1.25) and solving the resulting equations

min(j,p)
ij:0j+ Z ¢i0m,j7i’ J= 1,...,p+q, (5126)
i=1

for ¢ and 6, we obtain initial parameter estimates (}.’) and 6. To solve (5.1.26) we first
find ¢ from the last g equations:

9m,q+l qu em,q—l U 9m,q+l—p ¢1
O 6 0 - 0 [0}

,q+2 m,q+1 m,q m,q+2—p 2

. = . . . (5.1.27)
9m,q+p 0m,q+p71 9m,q+p72 o Qm,q ¢I’

Having solved (5.1.27) for (},’) (which may not be causal), we can easily determine the
estimate of 6 from

min(j, p)
=0y~ D> Gbuj— j=1...q
i=1

Finally, the white noise variance o>

n . 2
62 = ! Z (Xt _Xt> /T 1,
=1

where X, is the one-step predictor of X; computed from the fitted coefficient vectors (2)
and 0, and r,_; is defined in (3.3.8).

The above calculations can all be carried out by selecting the ITSM option Model >
Estimation>Preliminary. This option also computes, if p = ¢, the ratio of
each estimated coefficient to 1.96 times its estimated standard deviation. Approximate
95 % confidence intervals can therefore easily be obtained in this case. If the fitted
model is noncausal, it cannot be used to initialize the search for the maximum
likelihood estimators, and so the autoregressive coefficients should be set to some
causal values (e.g., all equal to 0.001) using the Model >Specify option. If both the
innovation and Hannan—Rissanen algorithms give noncausal models, it is an indication
(but not a conclusive one) that the assumed values of p and ¢ may not be appropriate
for the data.

is estimated by
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Example 5.1.6

Order Selection for Mixed Models

For models with p > 0 and ¢ > 0, the sample ACF and PACF are difficult to recognize
and are of far less value in order selection than in the special cases where p = 0 or
q = 0. A systematic approach, however, is still available through minimization of the
AICC statistic

AICC = —2InL(,, 0,, S(¢p, 0,)/n) +2(p + g+ Dn/(n —p — g — 2),

which is discussed in more detail in Section 5.5. For fixed p and ¢ it is clear from the
definition that the AICC value is minimized by the parameter values that maximize the
likelihood. Hence, final decisions regarding the orders p and g that minimize AICC
must be based on maximum likelihood estimation as described in Section 5.2.

The Lake Data

In Example 5.1.4 we fitted AR(2) models to the mean-corrected lake data using the
Yule—Walker equations and Burg’s algorithm. If instead we fit an ARMA(1,1) model
using the innovations method in the option Model>Estimation>Preliminary
of ITSM (with the default value m = 17), we obtain the model

X, —0.7234X,_, = Z, + 0.3596Z,_,, {Z;} ~ WN(O, 0.4757),

for the mean-corrected series X; = Y, — 9.0041. The ratio of the two coefficient
estimates (13 and 6 to 1.96 times their estimated standard deviations are given by ITSM
as 3.2064 and 1.8513, respectively. The corresponding 95 % confidence intervals are
therefore

¢ 1 0.7234 £ 0.7234/3.2064 = (0.4978, 0.9490),
0 :0.3596 £ 0.3596/1.8513 = (0.1654, 0.5538).

It is interesting to note that the value of AICC for this model is 212.89, which is
smaller than the corresponding values for the Burg and Yule-Walker AR(2) mod-
els in Example 5.1.4. This suggests that an ARMA(1,1) model may be superior to
a pure autoregressive model for these data. Preliminary estimation of a variety of
ARMA(p, q) models shows that the minimum AICC value does in fact occur when
p = g = 1. (Before committing ourselves to this model, however, we need
to compare AICC values for the corresponding maximum likelihood models. We shall
do this in Section 5.2.)

O

5.1.4 The Hannan-Rissanen Algorithm

The defining equations for a causal AR (p) model have the form of a linear regression
model with coefficient vector ¢ = (¢, ..., ¢,)". This suggests the use of simple
least squares regression for obtaining preliminary parameter estimates when g = 0.
Application of this technique when ¢ > 0 is complicated by the fact that in
the general ARMA(p, g) equations X, is regressed not only on X;_y, ..., X,_,, but also
on the unobserved quantities Z,_, ..., Z,_,. Nevertheless, it is still possible to apply
least squares regression to the estimation of ¢ and @ by first replacing the unobserved
quantities Z;_i, ..., Z_4in (5.1.1) by estimated values Z,,l, e Z,q. The parameters
¢ and 6 are then estimated by regressing X, onto X;_1, ..., X,_, Z,l, e Z,q. These
are the main steps in the Hannan—Rissanen estimation procedure, which we now
describe in more detail.
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Step 1. A high-order AR(m) model (with m > max(p, q)) is fitted to the data using the
Yule—Walker estimates of Section 5.1.1. If (qul, .. d)mm) is the vector of estimated
coefficients, then the estimated residuals are computed from the equations

Zt:Xt_q?)letfl_"'_ngthfmv t:m+1’---’n

Step 2. Once the estimated residuals Z.,t =m+1,...,n, have been computed as
in Step 1, the vector of parameters, 3 = (¢> o ) is estlmated by least squares linear

regression of X; onto (X,_l, - X,_,,,Z_l, .. Z, q) t=m+1+4g¢q,...,n,ie., by
minimizing the sum of squares

- . A \2
SB =Y (X=X = =Xy =021 = = 0,2,

t=m+1+q

with respect to 3. This gives the Hannan—Rissanen estimator
B= 227X,
where X,, = (Xju4144> - .-, Xy) and Z is the (n —m — q) x (p + ¢g) matrix

Xm+q Xm+q—l toe Xm+q+l—p Zm+q Zm+q—l to Zm+1
7 Xm+q+1 Xm+q T Xm+q+2fp Zm+q+1 Zm+q e m+2
Xn—1 Xn—2 T anp Zn— Zn— to anq

(If p = 0, Z contains only the last g columns.) The Hannan—Rissanen estimate of the
white noise variance is

5(8)
6l = ——2

HR n—m—g
The Lake Data

In Example 5.1.6 an ARMA(1,1) model was fitted to the mean corrected lake data
using the innovations algorithm. We can fit an ARMA(1,1) model to these data using
the Hannan—Rissanen estimates by selecting Hannan-Rissanenin the Preliminary
Estimation dialog box of ITSM. The fitted model is

X, —0.6961X,_, =Z,+0.3788Z,_;, {Z;} ~ WN(O0, 0.4774),

for the mean-corrected series X; = Y; —9.0041. (Two estimates of the white noise vari-
ance are computed in ITSM for the Hannan—Rissanen procedure, 8§R and ZJLI X; —

X,_1)? /n. The latter is the one retained by the program.) The ratios of the two co-
efficient estimates to 1.96 times their standard deviation are 4.5289 and 1.3120,
respectively. The corresponding 95 % confidence bounds for ¢ and 6 are

¢ :0.6961 £ 0.6961/4.5289 = (0.5424, 0.8498),
0 :0.3788 £ 0.3788/1.3120 = (0.0901, 0.6675).

Clearly, there is little difference between this model and the one fitted using the
innovations method in Example 5.1.6. (The AICC values are 213.18 for the current
model and 212.89 for the model fitted in Example 5.1.6.)
O
Hannan and Rissanen include a third step in their procedure to improve the
estimates.



5.2 Maximum Likelihood Estimation 139

Step 3. Using the estimate B = (qAbl, el <f>p, él, el éq)/ from Step 2, set

0, if £ < max(p, q),
ZT = P . q . - .
X — Y X — Y 6iZ,_;, ift>max(p,q).
j=1 j=1
Now fort=1,...,nput
0, if t < max(p, q),

~

Z

Vt == p ~
Vij+ 24, ift> max(p,q),

j=1

and

0, if 1 < max(p, q),

Wl‘ = P . ~
— > Wi+ 7, ift>max(p,q).
j=1

(Observe that both V; and W, satisfy the AR recursions (;B(B) V, = Z and 0 B)W, = Z
fort = 1,...,n) If 3" is the regression estimate of 3 found by regressing Z, on
Vet oo s Vi, Wi, oo, Wig), e i 3" minimizes

2
n q

p
S'Br= Y, Z-DBVii— D BeWik |
j=1

t=max(p,q)+1 k=1

then the improved estimate of 3 is B = BT + B The new estimator B then has the
same asymptotic efficiency as the maximum likelihood estimator. In ITSM, however,
we eliminate Step 3, using the model produced by Step 2 as the initial model for the
calculation (by numerical maximization) of the maximum likelihood estimator itself.

5.2 Maximum Likelihood Estimation

Suppose that {X,} is a Gaussian time series with mean zero and autocovariance function
K(i,j) = EXX)). Let X, = (X1, ..., X,) and let X, = (X, ..., X,)/, where X; = 0
and )A(] = EXj|X,...,Xj—1) = Pj_1Xj,j = 2. Let I'), denote the covariance matrix
I, = E(X, X)), and assume that I',, is nonsingular.

The likelihood of X, is

n-n

1
L(T",) = 2m)™"?(detT',) "% exp (—EX’F‘IXn) . (5.2.1)

As we shall now show, the direct calculation of detI", and "' can be avoided by
expressing this in terms of the one-step prediction errors X; — X; and their variances

vi—1,j =1, ..., n, both of which are easily calculated recursively from the innovations
algorithm (Section 2.5.4).
Let 6;,j = 1,...,i;i = 1,2,..., denote the coefficients obtained when the

innovations algorithm is applied to the autocovariance function « of {X;}, and let C,
be the n x n lower triangular matrix defined in Section 2.5.4. From (2.5.27) we have
the identity
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X, = C, <X,, — X) . (5.2.2)

We also know from Remark 5 of Section 2.5.4 that theA components of X, — X,, are
uncorrelated. Consequently, by the definition of v;, X,,—X,, has the diagonal covariance
matrix

D, = diag{vy, ..., v,_1}.
From (5.2.2) and (A.2.5) we conclude that

r,=C,.D,C,. (5.2.3)
From (5.2.2) and (5.2.3) we see that

R , R n R 2
X% = (% -X) 0 (X -%) =2 (G-%) o 524

j=1
and
det T, = (det C,)(det D)) = vovy - -+ V1. (5.2.5)
The likelihood (5.2.1) of the vector X,, therefore reduces to

1 1 n R 2
LT,) = exp i —- (X» - X-) v b (5.2.6)
V@Yo - vy 12 FZI 17 4) S
If '), is expressible in terms of a finite number of unknown parameters gy, ..., 8,

(as is the case when {X,} is an ARMA(p, q) process), the maximum likelihood
estimators of the parameters are those values that maximize L for the given data
set. When Xi, X5, ..., X, are iid, it is known, under mild assumptions and for n
large, that maximum likelihood estimators are approximately normally distributed
with variances that are at least as small as those of other asymptotically normally
distributed estimators (see, e.g., Lehmann 1983).

Even if {X;} is not Gaussian, it still makes sense to regard (5.2.6) as a mea-
sure of goodness of fit of the model to the data, and to choose the parameters
Bi, ..., Brinsuch a way as to maximize (5.2.6). We shall always refer to the estimators
ﬁl, el ﬁ, so obtained as “maximum likelihood” estimators, even when {X;} is not
Gaussian. Regardless of the joint distribution of X1, ..., X,, we shall refer to (5.2.1)
and its algebraic equivalent (5.2.6) as the “likelihood” (or “Gaussian likelihood™)
of X1, ..., X,. A justification for using maximum Gaussian likelihood estimators of
ARMA coefficients is that the large-sample distribution of the estimators is the same
for {Z;} ~ IID(O, 02), regardless of whether or not {Z;} is Gaussian (see Brockwell

and Davis (1991), Section 10.8).
The likelihood for data from an ARMA( p, g) process is easily computed from the

innovations form of the likelihood (5.2.6) by evaluating the one-step predictors X,
and the corresponding mean squared errors v;. These can be found from the recursions
(Section 3.3)

n A
D O (Xn+l—j - Xn+l—j) , l<n<m,
. j=1
Xnp1 = . (5.2.7)
G1Xn+ A OpXngip+ 3 O (Xn+1—j - n+1-j) » nzm,
J=1
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and
~ 2 ) ~ 2 2
E(X,,+1 —Xn+1) —q E(Wn+1 - W,,+1> — o1, (5.2.8)

where 6,; and r,, are determined by the innovations algorithm with « as in (3.3.3) and
m = max(p, g). Substituting in the general expression (5.2.6), we obtain the following:

The Gaussian Likelihood for an ARMA Process:

~\2
L(¢,0.0%) = : exp —%Zm . (529
\/(2n02)nr0"'r11—1 20 Jj=1 fi-1

Differentiating In L (¢, 0, 02) partially with respect to o> and noting that }A(j and 7;

are independent of o2, we find that the maximum likelihood estimators (;S, é, and 62
satisfy the following equations (Problem 5.8):

Maximum Likelihood Estimators:

62 =n"'s (&s, ?)) , (5.2.10)
where
5(4.0) = Z (% - X,)z Jrioi, (5.2.11)
j=1

and (;S, 0 are the values of ¢, 0 that minimize

0@.0) =In(n"'S(.0) +n"" > Inr,. (5.2.12)

j=1

Minimization of £(¢, ) must be done numerically. Initial values for ¢ and 0 can
be obtained from ITSM using the methods described in Section 5.1. The program then
searches systematically for the values of ¢ and 0 that minimize the reduced likelihood
(5.2.12) and computes the corresponding maximum likelihood estimate of o2 from
(5.2.10).

Least Squares Estimation for Mixed Models
The least squares estimates ¢ and 6 of ¢ and 0 are obtained by minimizing the function
S as defined in (5.2.11) rather than £ as defined in (5.2.12), subject to the constraints
that the model be causal and invertible. The least squares estimate of o2 is

~2 5 (¢’ 9)

0-=—+.

n—p—gq

Order Selection

In Section 5.1 we introduced minimization of the AICC value as a major criterion for
the selection of the orders p and ¢q. This criterion is applied as follows:
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AICC Criterion:
Choose p, g, ¢,,, and 6, to minimize

AICC = —-2InL(¢,, 04, S($,, 0,)/n) +2(p + g+ Dn/(n—p — g = 2).

For any fixed p and g it is clear that the AICC is minimized when ¢, and 6, are
the vectors that minimize —2 In L(qu, 0,,5(¢,,0,)/n), ie., the maximum likelihood
estimators. Final decisions with respect to order selection should therefore be made on
the basis of maximum likelihood estimators (rather than the preliminary estimators of
Section 5.1, which serve primarily as a guide). The AICC statistic and its justification
are discussed in detail in Section 5.5.

One of the options in the program ITSM is Model>Estimation>Autofit.
Selection of this option allows you to specify a range of values for both p and ¢, after
which the program will automatically fit maximum likelihood ARMA(p, g) values
for all p and ¢ in the specified range, and select from these the model with smallest
AICC value. This may be slow if a large range is selected (the maximum range is from
0 through 27 for both p and g), and once the model has been determined, it should
be checked by preliminary estimation followed by maximum likelihood estimation
to minimize the risk of the fitted model corresponding to a local rather than a global
maximum of the likelihood. (For more details see Section E.3.1.)

Confidence Regions for the Coefficients

For large sample size the maximum likelihood estimator B of B = (¢1,..., Pp,
61, ...,6,) is approximately normally distributed with mean 3 and covariance matrix
[n*IV(B)] which can be approximated by 2H~'(3), where H is the Hessian matrix

[828 (B)/08; 8,3,]? ;r=111 ITSM prints out the approximate standard deviations and corre-
lations of the coefficient estimators based on the Hessian matrix evaluated numerically
at B unless this matrix is not positive definite, in which case ITSM instead computes
the theoretical asymptotic covariance matrix in Section 9.8 of Brockwell and Davis
(1991). The resulting covariances can be used to compute confidence bounds for the

parameters.

Large-Sample Distribution of Maximum Likelihood Estimators:

For a large sample from an ARMA (p, q) process,
BRN(Bn'V(@B)).

The general form of V(3) can be found in Brockwell and Davis (1991), Section 9.8.
The following are several special cases.

An AR(p) Model

The asymptotic covariance matrix in this case is the same as that for the Yule—Walker
estimates given by

V(g) =0T, "

In the special cases p = 1 and p = 2, we have
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Example 5.2.2

Example 5.2.3

Example 5.2.4

AR(1) :V(¢) = (1 - 7).

T =@ —p(+ )
ARE) ‘V(¢)_[—¢1<1+2¢2> 1 @2 ] -

An MA(g) Model

Let F; be the covariance matrix of Y1, ..., Y, where {Y;} is the autoregressive process
with autoregressive polynomial 6(z), i.e.,

Y +60Y+---+0,Y =2, {Z}~WN(Q,]1.

Then it can be shown that
V) =r;"".

Inspection of the results of Example 5.2.1 and replacement of ¢; by —6; yields
MA(1) :V(0) = (1 —67),

Sy _
MA(2) :V(0) = [9111 _9292) 6, 1(1_ 02422)] ‘

O
An ARMAC(1, 1) Model
For a causal and invertible ARMA(1,1) process with coefficients ¢ and 6.
Vip.0) = 1+ ¢0 [ (1 -9 +¢8) —(1 -6 — ¢2)}
’ (@+0)?2[-(1—-6H1—¢> 1—-6)A+¢0) |
O

The Dow Jones Utilities Index

For the Burg and Yule-Walker AR(1) models derived for the differenced and mean-
corrected series in Examples 5.1.1 and 5.1.3, the ModelsEstimations>
Preliminary option of ITSM gives —2In(L) =70.330 for the Burg model and
—21In(L) =70.378 for the Yule-Walker model. Since maximum likelihood estimation
attempts to minimize —2 In L, the Burg estimate appears to be a slightly better initial
estimate of ¢. We therefore retain the Burg AR(1) model and then select Model >
Estimation>Max Likelihood and click OK. The Burg coefficient estimates
provide initial parameter values to start the search for the minimizing values. The
model found on completion of the minimization is

Y, —0.4471Y,_, = Z;, {Z;} ~ WN(O0, 0.02117). (5.2.13)

This model is different again from the Burg and Yule-Walker models. It has
—21In(L) = 70.321, corresponding to a slightly higher likelihood. The standard
error (or estimated standard deviation) of the estimator (13 is found from the program to
be 0.1050. This is close to the estimated standard deviation \/ (1—1(0.4471)2)/77 =
0.1019, based on the large-sample approximation given in Example 5.2.1. Using
the value computed from ITSM, approximate 95 % confidence bounds for ¢ are
0.4471 £ 1.96 x 0.1050 = (0.2413, 0.6529). These are quite close to the bounds
based on the Yule—Walker and Burg estimates found in Examples 5.1.1 and 5.1.3.
To find the minimum-AICC model for the series {Y;} using ITSM, choose the
option Model>Estimation>Autofit. Using the default range for both p and
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g, and clicking on Start, we quickly find that the minimum AICC ARMA(p, q)
model with p < 5 and ¢ < 5 is the AR(1) model defined by (5.2.13). The
corresponding AICC value is 74.483. If we increase the upper limits for p and ¢,
we obtain the same result.

O

The Lake Data

Using the option Model>Estimation>Autofit as in the previous example, we
find that the minimum-AICC ARMA( p, g) model for the mean-corrected lake data,
X, =Y, —9.0041, of Examples 5.1.6 and 5.1.7 is the ARMA(1,1) model

X, —0.7446X,_; = Z, + 0.3213Z,_;, {Z,} ~ WN(O0, 0.4750). (5.2.14)

The estimated standard deviations of the two coefficient estimates qAﬁ and  are found
from ITSM to be 0.0773 and 0.1123, respectively. (The respective estimated standard
deviations based on the large-sample approximation given in Example 5.2.3 are 0.0788
and 0.1119.) The corresponding 95 % confidence bounds are therefore

¢ :0.7446 £ 1.96 x 0.0773 = (0.5941, 0.8961),

0 :0.3208 £ 1.96 x 0.1123 = (0.1007, 0.5409).

The value of AICC for this model is 212.77, improving on the values for the prelim-
inary models of Examples 5.1.4, 5.1.6, and 5.1.7.
0

5.3 Diagnostic Checking

Typically, the goodness of fit of a statistical model to a set of data is judged by
comparing the observed values with the corresponding predicted values obtained from
the fitted model. If the fitted model is appropriate, then the residuals should behave in
a manner that is consistent with the model.

When we fit an ARMA(p, g) model to a given series we determine the maximum
likelihood estimators (2), é, and 62 of the parameters ¢, 8, and 2. In the course of this
procedure the predicted values Xt(&), 9) of X; based on X1, ..., X;_; are computed for
the fitted model. The residuals are then defined, in the notation of Section 3.3, by

Wt=< — X (&, @)))/(r,,1 (&, é))m, t=1,...n (5.3.1)

If we were to assume that the maximum likelihood ARMA(p, ¢) model is the true
process generating {X;}, then we could say that {Wt} ~ WN (0, 62). However,
to check the appropriateness of an ARMA(p, g) model for the data we should
assume only that X, ..., X,, are generated by an ARMA(p, g) process with unknown
parameters ¢, 0, and o2, whose maximum likelihood estimators are (}b, 9, and 62,
respectively. Then it is not true that {W,} is white noise. Nonetheless VAVt, t=1,...,n,
should have properties that are similar to those of the white noise sequence

Wi, 0) = (X, — X, (¢, 0)) /(ri_1(p, ON'?, 1=1,....n.

Moreover, W, (¢, 8) approximates the white noise term in the defining equation (5.1.1)
in the sense that E(W,(¢, 0) — Z,)> — 0 ast — oo (Brockwell and Davis (1991),
Section 8.11). Consequently, the properties of the residuals {W,} should reflect those
of the white noise sequence {Z;} generating the underlying ARMA(p, ¢g) process. In
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Figure 5-5

The rescaled residuals after
fitting the ARMA(T,1) model
of Example 5.2.5 to the lake
data

particular, the sequence {Wt} should be approximately (1) uncorrelated if {Z;} ~
WN(0, 02), (2) independent if {Z;} ~ IID(0, 0?), and (3) normally distributed if
Z, ~N(0, o?).

The rescaled residuals IAQ,, t = 1,...,n, are obtained by dividing the residuals

W.t=1,...,n, by the estimate 6 = ,/ (Z'::l VAVE)/n of the white noise standard

deviation. Thus,
R =W,/6. (5.3.2)

If the fitted model is appropriate, the rescaled residuals should have properties similar
to those of a WIN(0, 1) sequence or of an iid(0,1) sequence if we make the stronger
assumption that the white noise {Z;} driving the ARMA process is independent white
noise.

The following diagnostic checks are all based on the expected properties of the
residuals or rescaled residuals under the assumption that the fitted model is correct
and that {Z;} ~ IID (0, 02). They are the same tests introduced in Section 1.6.

5.3.1 The Graph of {kt, t=1,...,n}

If the fitted model is appropriate, then the graph of the rescaled residuals {f?t, t =
1,..., n} should resemble that of a white noise sequence with variance one. While it is

difficult to identify the correlation structure of {i?,} (or any time series for that matter)
from its graph, deviations of the mean from zero are sometimes clearly indicated by
a trend or cyclic component and nonconstancy of the variance by fluctuations in R,
whose magnitude depends strongly on ¢.

The rescaled residuals obtained from the ARMA(1,1) model fitted to the mean-
corrected lake data in Example 5.2.5 are displayed in Figure 5-5. The graph gives no
indication of a nonzero mean or nonconstant variance, so on this basis there is no
reason to doubt the compatibility of Ry, ..., R, with unit-variance white noise.

0 20 40 60 80 100
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The next step is to check that the sample autocorrelation function of {Wt} (or

equivalently of {f?,}) behaves as it should under the assumption that the fitted model
is appropriate.

5.3.2 The Sample ACF of the Residuals

We know from Section 1.6 that for large n the sample autocorrelations of
an iid sequence Y, ..., Y, with finite variance are approximately iid with distribution
N(0, 1/n). We can therefore test whether or not the observed residuals are consistent
with iid noise by examining the sample autocorrelations of the residuals and rejecting
the iid noise hypothesis if more than two or three out of 40 fall outside the bounds
+1.96//n or if one falls far outside the bounds. (As indicated above, our estimated
residuals will not be precisely iid even if the true model generating the data is as
assumed. To correct for this the bounds +1.96/+/n should be modified to give a more
precise test as in Box and Pierce (1970) and Brockwell and Davis (1991), Section 9.4.)
The sample ACF and PACF of the residuals and the bounds £1.96/,/n can be viewed
by pressing the second green button (Plot ACF/PACF of residuals) at the
top of the ITSM window. Figure 5-6 shows the sample ACF of the residuals after
fitting the ARMA(1,1) of Example 5.2.5 to the lake data. As can be seen from the
graph, there is no cause to reject the fitted model on the basis of these autocorrelations.

5.3.3 Tests for Randomness of the Residuals

The tests (b), (c), (d), (e), and (f) of Section 1.6 can be carried out using the
program ITSM by selecting Statistics>Residual Analysis>Tests of
Randomness.

Applying these tests to the residuals from the ARMA(1,1) model for the mean-
corrected lake data (Example 5.2.5), and using the default value 7 = 22 suggested
for the portmanteau tests, we obtain the following results:



5.4

Forecasting 147

5.4 Forecasting

Example 5.4.1

RANDOMNESS TEST STATISTICS

LJUNG-BOX PORTM. = 10.23 CHISQUR(20) p=0.964
MCLEOD-LI PORTM. = 16.55 CHISQUR(22) p=0.788
TURNING POINTS = 69 ANORMAL(64.0, 4.14*%%2) p=0.227
DIFFERENCE-SIGN = 50 ANORMAL(48.5, 2.87%*2) p=0.602
RANK TEST = 2083 ANORMAL(2376, 488.7%*2) p=0.072
JARQUE-BERA=0.285 CHISQUR(2) p=0.867

ORDER OF MIN AICC YW MODEL FOR RESIDUALS =0

This table shows the observed values of the statistics defined in Section 1.6, with each
followed by its large-sample distribution under the null hypothesis of iid residuals,
and the corresponding p-values. The observed values can thus be checked easily for
compatibility with their distributions under the null hypothesis. Since all of the p-
values are greater than 0.05, none of the test statistics leads us to reject the null
hypothesis at this level. The order of the minimum AICC autoregressive model for
the residuals also suggests the compatibility of the residuals with white noise.

A rough check for normality is provided by visual inspection of the histogram
of the rescaled residuals, obtained by selecting the third green button at the top of the
ITSM window. A Gaussian qq-plot of the residuals can also be plotted by selecting
Statistics > Residual Analysis > QQ-Plot (normal). No obvi-
ous deviation from normality is apparent in either the histogram or the qq-plot. The
Jarque-Bera statistic, n[m3 / (6m3)+(my/m3—3)? /24], where m, = > (Y;—Y)"/n,is
distributed asymptotically as x2(2) if {¥,} ~ IID N(u, o2). This hypothesis is rejected
if the statistic is sufficiently large (at level « if the p-value of the test is less than «). In
this case the large p-value computed by ITSM provides no evidence for rejecting the
normality hypothesis.

Once a model has been fitted to the data, forecasting future values of the time series
can be carried out using the method described in Section 3.3. We illustrate this method
with one of the examples from Section 3.2.

For the overshort data {X;} of Example 3.2.8, selection of the options Model>
Estimation >Preliminary, the innovations algorithm, and then Model>
Estimation>Max likelihood, gives the maximum likelihood MA(1) model
for {Xl‘}9

X, +4.035=2,—-0.818Z_,, {Z}~ WN(O0,2040.75). (5.4.1)

To predict the next 7 days of overshorts, we treat (5.4.1) as the true model for the data,
and use the results of Example 3.3.3 with ¢ = 0. From (3.3.11), the predictors are
given by

1

Ps7Xs5745 = —4.035 + Z O574n-1, (X57+h7j — 5(57+h7j>
i=h

4035 + 057, (X7 — Xs7) . ifh=1,
4,035, ifh>1,
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Table 5.1

Forecasts of the next seven observations
of the overshort data of Example 3.2.8
using model (5.4.1)

# XHAT SQRT (MSE)  XHAT +MEAN
58 1.0097 45.1753 —3.0254
59 0.0000 58.3602 —4.0351
60 0.0000 58.3602 —4.0351
61 0.0000 58.3602 —4.0351
62 0.0000 58.3602 —4.0351
63 0.0000 58.3602 —4.0351
64 0.0000 58.3602 —4.0351

with mean squared error

2040.75rs7, ifh=1,

E(Xs74n — P57Xs5741)" = .
2040.75(1 4 (—0.818)2), ifh > 1,

where 6057 1 and rs;7 are computed recursively from (3.3.9) with 8 = —0.818.

These calculations are performed with ITSM by fitting the maximum likeli-
hood model (5.4.1), selecting Forecasting>ARMA, and specifying the number of
forecasts required. The 1-step, 2-step, ..., and 7-step forecasts of X; are shown in
Table 5.1. Notice that the predictor of X, for > 59 is equal to the sample mean, since
under the MA(1) model {X;, t > 59} is uncorrelated with {X,, t < 57}.

Assuming that the innovations {Z,} are normally distributed, an approximate 95 %
prediction interval for Xg4 is given by

—4.0351 £1.96 x 58.3602 = (—118.42, 110.35).
O
The mean squared errors of prediction, as computed in Section 3.3 and the example
above, are based on the assumption that the fitted model is in fact the true model for
the data. As a result, they do not reflect the variability in the estimation of the model
parameters. To illustrate this point, suppose the data Xy, ..., X,, are generated from
the causal AR(1) model

X=X +7Z, {Z)~iid(0,07).

If q?) is the maximum likelihood estimate of ¢, based on X, ..., X, then the one-step
ahead forecast of X, is ¢X,,, which has mean squared error

E (X 9%) =E((0-8) Xt Z0n) = E@ ~ $)%0 + 0
(5.4.2)

~ /!
The second equality follows from the independence of Z,; and <¢, X,,) . To evaluate
the first term in (5.4.2), first condition on X,, and then use the approximations

E ((¢ —¢) |Xn) ~E(p—4) ~(1-0")/n

where the second relation comes from the formula for the asymptotic variance of é
given by azFl_l = (1 — ¢2) (see Example 5.2.1). The one-step mean squared error is
then approximated by
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E(¢- ¢) EX; + o mn (1-¢7) (1-¢7) o’ 40" = —
Thus, the error in parameter estimation contributes the term o-2/n to the mean squared
error of prediction. If the sample size is large, this factor is negligible, and so for the
purpose of mean squared error computation, the estimated parameters can be treated
as the true model parameters. On the other hand, for small sample sizes, ignoring
parameter variability can lead to a severe underestimate of the actual mean squared
error of the forecast.

5.5 Order Selection

Once the data have been transformed (e.g., by some combination of Box—Cox and
differencing transformations or by removal of trend and seasonal components) to the
point where the transformed series {X;} can potentially be fitted by a zero-mean ARMA
model, we are faced with the problem of selecting appropriate values for the orders p
and gq.

It is not advantageous from a forecasting point of view to choose p and g arbi-
trarily large. Fitting a very high order model will generally result in a small estimated
white noise variance, but when the fitted model is used for forecasting, the mean
squared error of the forecasts will depend not only on the white noise variance of
the fitted model but also on errors arising from estimation of the parameters of the
model (see the paragraphs following Example 5.4.1). These will be larger for higher-
order models. For this reason we need to introduce a “penalty factor” to discourage
the fitting of models with too many parameters.

Many criteria based on such penalty factors have been proposed in the literature,
since the problem of model selection arises frequently in statistics, particularly in
regression analysis. We shall restrict attention here to a brief discussion of the FPE,
AIC, and BIC criteria of Akaike and a bias-corrected version of the AIC known as the
AICC.

5.5.1 The FPE Criterion

The FPE criterion was developed by Akaike (1969) to select the appropriate order of
an AR process to fit to a time series {X1, ..., X,}. Instead of trying to choose the order
p to make the estimated white noise variance as small as possible, the idea is to choose
the model for {X;} in such a way as to minimize the one-step mean squared error when
the model fitted to {X;} is used to predict an independent realization {Y;} of the same

process that generated {X,}.
Suppose then that {Xj, ..., X,} is a realization of an AR(p) process with coef-
ficients ¢y, ..., ¢,, p < n, and that {Yy, ..., Y,} is an independent realization of the

same process. If (13 Ly oves (]3,,, are the maximum likelihood estimators of the coefficients
based on {Xi, ..., X,} and if we use these to compute the one-step predictor ¢;Y, +
~++ ¢pY,q1-p of ¥, 1y, then the mean square prediction error is

~ ~ 2
E(YVusi=d1¥u— - =p¥ui1-p)
= E[Yair =it —tp¥asrp (b1 =01 Ya o= (=) Vi |

:oz+E[<¢P ¢P) [Yosr-i¥uri]7 1(¢p ¢)}
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Table 5.2

Example 5.5.1

&5 and FPE,, for AR(p)
models fitted to the

lake data

p o FPEp

0 1.7203  1.7203
1 0.5097  0.5202
2 0.4790  0.4989
3 0.4728  0.5027
4 04708 0.5109
5 0.4705  0.5211
6  0.4705 0.5318
7 0.4679 0.5399
8  0.4664 0.5493
9  0.4664 0.5607
10 0.4453  0.5465

A ~ ~ /7
where q‘)l’, = (¢1,.... ), ¢1’, = (¢1, e ¢p> , and o? is the white noise variance
of the AR(p) model. Writing the last term in the preceding equation as the expecta-

tion of the conditional expectation given X1, ..., X,, and using the independence of
{Xy,...,X,}and {Yy, ..., Y,}, we obtain

E(Yo = bita = = bpaiy) = 0>+ E [(c}b,, — ) Ty (6 - ¢)} ,

where I', = E[Y,-Yj]‘z j=1- We can approximate the last term by assuming that the

random variable n~!/? ((}5,, — qb,,) has its large-sample distribution N(O, 02F; 1) as
given in Example 5.21. Using Problem 5.13, we then find that

E (Y =ity == dyaery) ~o2 (1 +2). (55.1)

If 62 is the maximum likelihood estimator of o2, then for large n, n6? /0% is distributed
approximately as chi-squared with (n — p) degrees of freedom (see Brockwell and
Davis (1991), Section 8.9). We therefore replace o2 in (5.5.1) by the estimator
né?/(n — p) to get the estimated mean square prediction error of Y, 1,

FPE, = 62217 (5.5.2)

n—p
To apply the FPE criterion for autoregressive order selection we therefore choose the
value of p that minimizes FPE, as defined in (5.5.2).

FPE-Based Selection of an AR Model for the Lake Data

In Example 5.1.4 we fitted AR(2) models to the mean-corrected lake data, the order 2
being suggested by the sample PACF shown in Figure 5-4. To use the FPE criterion to
select p, we have shown in Table 5.2 the values of FPE for values of p from 0 to 10.
These values were found using ITSM by fitting maximum likelihood AR models with
the option Model>Estimation>Max likelihood. Also shown in the table
are the values of the maximum likelihood estimates of o for the same values of p.
Whereas 6,,2 decreases steadily with p, the values of FPE, have a clear minimum at
p = 2, confirming our earlier choice of p = 2 as the most appropriate for this data set.

g
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5.5.2 The AICC Criterion

A more generally applicable criterion for model selection than the FPE is the infor-
mation criterion of Akaike (1973), known as the AIC. This was designed to be an
approximately unbiased estimate of the Kullback-Leibler index of the fitted model
relative to the true model (defined below). Here we use a bias-corrected version of the
AIC, referred to as the AICC, suggested by Hurvich and Tsai (1989).

If X is an n-dimensional random vector whose probability density belongs to
the family {f(-; ¥), ¥ € W}, the Kullback—Leibler discrepancy between f(-; ) and
f(-; 0) is defined as

AW 16) = AGHIO) — A©19),
where
AWIO) = Eo(-21nf(X: ¥) = [ ~2Infxi )/ (x: 0) dx

is the Kullback—Leibler index of f(-; ¥) relative to f(-; 8). (Note that in general,
A(Y10) # AO|y).) By Jensen’s inequality (see, e.g., Mood et al., 1974),

d(y10) = / —21n (f(x; l'/’)>f(x; 0) dx

f(x;0)
> o ([ L5 0y ax
= f(x;0)
= —2In </ fx; ) dx)
]Rf’l
=0,
with equality holding if and only if f(x; V) = f(x; 0).
Given observations X, ..., X,, of an ARMA process with unknown parameters

0 = (,8, 02), the true model could be identified if it were possible to compute the
Kullback-Leibler discrepancy between all candidate models and the true model. Since
this is not possible, we estimate the Kullback—Leibler discrepancies and choose the
model whose estimated discrepancy (or index) is minimum. In order to do this, we
assume that the true model and the alternatives are all Gaussian. Then for any given
0 = (B, 02),f(~; 0) is the probability density of (Y1, ..., ¥,)’, where {Y;} is a Gaussian
ARMA(p, g) process with coefficient vector 3 and white noise variance o2. (The
dependence of 6 on p and ¢ is through the dimension of the autoregressive and moving-
average coefficients in 3.)

Suppose, therefore, that our observations Xy, ..., X, are from a Gaussian ARMA
process with parameter vector = (,8, 02) and assume for the moment that the true

order is (p, g). Let 6 = (B , 82) be the maximum likelihood estimator of 6 based on
Xi,..., Xyand let Yy, ..., Y, be an independent realization of the true process (with
parameter 6). Then

—2InLy (B, &2) — 2Inly (B, &2) +6728y (ﬁ) —n,
where Ly, Ly, Sx, and Sy are defined as in (5.2.9) and (5.2.11). Hence,

Eo(A(10)) = Eg 2 <—21nLY (B’ 52))
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- v (B)
= Ej (-21an (ﬂ, & )) +Eg e | —5 | -

(5.5.3)

It can be shown using large-sample approximations (see Brockwell and Davis (1991),
Section 10.3 for details) that

5 (B)\ _ 200+ g+ n
62 n—p—q-2’

E,@’GZ

from which we see that —21nLX(B, 62) +2(p+qg+ Dn/(n—p — g — 2) is an ap-
proximately unbiased estimator of the expected Kullback-Leibler index Ej (A(é |9))
in (5.5.3). Since the preceding calculations (and the maximum likelihood estimators
,@ and &2) are based on the assumption that the true order is (p, ¢), we therefore select
the values of p and ¢ for our fitted model to be those that minimize AICC (B), where

AICC(B) := —2InLx(3, Sx(B)/n) +2(p+q+ 1n/(n—p —q—2).
(5.5.4)
The AIC statistic, defined as

AIC(B) := —2InLx(B, Sx(B)/n) +2(p + g + 1),

can be used in the same way. Both AICC(,B, 02) and AIC(,B, 02) can be defined
for arbitrary o by replacing Sx(3)/n in the preceding definitions by o2. The value
Sx(B)/nisusedin (5.5.4), since AICC(,B, 02) (like AIC (B, 02)) is minimized for any
given (3 by setting 0> = Sx(B)/n.

For fitting autoregressive models, Monte Carlo studies (Jones 1975; Shibata 1976)
suggest that the AIC has a tendency to overestimate p. The penalty factors 2(p + g +
Dn/(n—p—qg—2) and 2( p+q-+1) for the AICC and AIC statistics are asymptotically
equivalent as n — oo. The AICC statistic, however, has a more extreme penalty for
large-order models, which counteracts the overfitting tendency of the AIC. The BIC
is another criterion that attempts to correct the overfitting nature of the AIC. For a
zero-mean causal invertible ARMA( p, g) process, it is defined (Akaike 1978) to be

BIC = (n—p—q)In[n6*/(n—p—q)] +n(1+1nm)

+(P+¢n [(Zxﬁ — n&2> /(p+q)i|, (5.5.5)
=1

where 62 is the maximum likelihood estimate of the white noise variance.

The BIC is a consistent order-selection criterion in the sense that if the data
{Xi1,..., X,} are in fact observations of an ARMA(p, g) process, and if p and g are
the estimated orders found by minimizing the BIC, then p — p and § — ¢ with
probability 1 as n — oo (Hannan 1980). This property is not shared by the AICC or
AIC. On the other hand, order selection by minimization of the AICC, AIC, or FPE
is asymptotically efficient for autoregressive processes, while order selection by BIC
minimization is not (Shibata 1980; Hurvich and Tsai 1989). Efficiency is a desirable
property defined in terms of the one-step mean square prediction error achieved by the
fitted model. For more details see Brockwell and Davis (1991), Section 10.3.
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Example 5.5.2

Problems

In the modeling of real data there is rarely such a thing as the “true order.” For
the process X; = Z;io ViZ;_; there may be many polynomials 6(z), ¢ (z) such that the
coefficients of Z in 6(z) /¢ (z) closely approximate v; for moderately small values of ;.
Correspondingly, there may be many ARMA processes with properties similar to {X;}.
This problem of identifiability becomes much more serious for multivariate processes.
The AICC criterion does, however, provide us with a rational criterion for choosing
among competing models. It has been suggested (Duong 1984) that models with AIC
values within ¢ of the minimum value should be considered competitive (with ¢ = 2
as a typical value). Selection from among the competitive models can then be based
on such factors as whiteness of the residuals (Section 5.3) and model simplicity.

We frequently need, particularly in analyzing seasonal data, to fit ARMA(p, q)
models in which all except m(< p + ¢q) of the coefficients are constrained to be zero.
In such cases the definition (5.5.4) is replaced by

AICC(B) := —2InLx(3, Sx(B)/n) + 2(m + Dn/(n — m — 2). (5.5.6)
Models for the Lake Data

In Example 5.2.4 we found that the minimum-AICC ARMA(p, g) model for the mean-
corrected lake data is the ARMA(1,1) model (5.2.14). For this model ITSM gives the
values AICC = 212.77 and BIC = 216.86. A systematic check on ARMA(p, g) mod-
els for other values of p and g shows that the model (5.2.14) also minimizes the BIC
statistic. The minimum-AICC AR(p) model is found to be the AR(2) model satisfying

X, —1.0441X,_, + 0.2503X;_», = Z;, {Z;} ~ WN(O, 0.4789),

with AICC = 213.54 and BIC = 217.63. Both the AR(2) and ARMA(1,1) models
pass the diagnostic checks of Section 5.3, and in view of the small difference between
the AICC values there is no strong reason to prefer one model or the other.

O

5.1 The sunspot numbers {X;,t = 1,...,100}, filed as SUNSPOTS.TSM, have
sample autocovariances y(0) = 1382.2, y(1) = 1114.4, y(2) = 591.73, and
7(3) = 96.216. Use these values to find the Yule-Walker estimates of ¢, ¢,
and o2 in the model

Yi=¢ Yo+ ¢Yio+Z, {Z}~WN(0,6°),

for the mean-corrected series ¥; = X, — 46.93,r = 1,...,100. Assuming
that the data really are a realization of an AR(2) process, find 95 % confidence
intervals for ¢; and ¢,.

5.2 From the information given in the previous problem, use the Durbin—Levinson
algorithm to compute the sample partial autocorrelations (13 11, (1322, and (1333 of the
sunspot series. Is the value of b33 compatible with the hypothesis that the data
are generated by an AR(2) process? (Use significance level 0.05.)
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5.3 Consider the AR(2) process {X,} satisfying

a.
b.

X, — X1 — ¢’ X2 =27, {Z}~ WN(0,07).
For what values of ¢ is this a causal process?

The following sample moments were computed after observing Xi, ..., X»0o:

7(0) =6.06, H(1) =0.687.

Find estimates of ¢ and o2 by solving the Yule-Walker equations. (If you
find more than one solution, choose the one that is causal.)

5.4 Two hundred observations of a time series, X, ..., X200, gave the following
sample statistics:

sample mean: X200 = 3.82;
sample variance:  p(0) = 1.15;
sample ACF: 0(1) = 0.427;
0(2) = 0.475;
0(3) = 0.169.

Based on these sample statistics, is it reasonable to suppose that {X; — u} is
white noise?

Assuming that {X; — ©} can be modeled as the AR(2) process
Xi— =1 X1 — ) — (X2 — ) =7y,

where {Z;} ~ IID(O, 02), find estimates of , ¢;, ¢», and o>

Would you conclude that 1 = 0?

d. Construct 95 % confidence intervals for ¢; and ¢,.

. Assuming that the data were generated from an AR(2) model, derive esti-

mates of the PACF for all lags & > 1.

5.5 Use the program ITSM to simulate and file 20 realizations of length 200 of the
Gaussian MA(1) process

Xi=2+0Z_,, {Z}~WN(Q,ID,

with 6 = 0.6.

a.
b.

For each series find the moment estimate of 6 as defined in Example 5.1.2.

For each series use the innovations algorithm in the ITSM option Model >
Estimation>Preliminary to find an estimate of 6. (Use the default
value of the parameter m.) As soon as you have found this preliminary
estimate for a particular series, select Model>Estimations>Max
likelihood to find the maximum likelihood estimate of 6 for the series.

Compute the sample means and sample variances of your three sets of esti-
mates.

Use the asymptotic formulae given at the end of Section 5.1.1 (with n =
200) to compute the variances of the moment, innovation, and maximum
likelihood estimators of@ Compare with the corresponding sample variances
found in (c).

. What do the results of (c) suggest concerning the relative merits of the three

estimators?
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5.6

5.7
5.8

5.9

5.10

5.11

5.12

5.13

Establish the recursions (5.1.19) and (5.1.20) for the forward and backward
prediction errors u;(¢) and v;(¢) in Burg’s algorithm.

Derive the recursions for the Burg estimates d)i(iB) and ai(B)z.

From the innovation form of the likelihood (5.2.9) derive the equations (5.2.10),
(5.2.11), and (5.2.12) for the maximum likelihood estimators of the parameters
of an ARMA process.

Use equation (5.2.9) to show that for n > p, the likelihood of the observations
{X1, ..., X} of the causal AR(p) process defined by

X, =¢ X1+ +@Xp+Z, {Z}~WN(0,07%),

is

L($,0%) = (2702 ™" (detG,) 2
1 ;o .
xexp ) —o— | X,6, X, + Z X=X = — X)) | ¢
t=p+1

where X, = (X;,...,X,) and G, = a‘sz = a‘zE(XpX;,).

Use the result of Problem 5.9 to derive a pair of linear equations for the least
squares estimates of ¢, and ¢, for a causal AR(2) process (with mean zero).
Compare your equations with those for the Yule—Walker estimates. (Assume that
the mean is known to be zero in writing down the latter equations, so that the
sample autocovariances are y (h) = % Z:’;lh X1 X; for h > 0.)

Given two observations x; and x, from the causal AR(1) process satisfying
Xt = ¢Xt—l + Zta {Zt} ~ WN (Oa 02) )

and assuming that |x;| # |xp|, find the maximum likelihood estimates of ¢

and o2.

Derive a cubic equation for the maximum likelihood estimate of the coefficient
¢ of a causal AR(1) process based on the observations Xi, ..., X,.

Use the result of Problem A.7 and the approximate large-sample normal distri-
bution of the maximum likelihood estimator ¢, to establish the approximation
(5.5.1).
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6.1 ARIMA Models for Nonstationary Time Series
6.2 ldentification Techniques

6.3 Unit Roots in Time Series Models

6.4 Forecasting ARIMA Models

6.5 Seasonal ARIMA Models

6.6 Regression with ARMA Errors

In this chapter we shall examine the problem of finding an appropriate model for a
given set of observations {xi, ..., x,} that are not necessarily generated by a stationary
time series. If the data (a) exhibit no apparent deviations from stationarity and (b) have
arapidly decreasing autocovariance function, we attempt to fit an ARMA model to the
mean-corrected data using the techniques developed in Chapter 5. Otherwise, we look
first for a transformation of the data that generates a new series with the properties
(a) and (b). This can frequently be achieved by differencing, leading us to consider
the class of ARIMA (autoregressive integrated moving-average) models, defined in
Section 6.1. We have in fact already encountered ARIMA processes. The model fitted
in Example 5.1.1 to the Dow Jones Ultilities Index was obtained by fitting an AR model
to the differenced data, thereby effectively fitting an ARIMA model to the original
series. In Section 6.1 we shall give a more systematic account of such models.

In Section 6.2 we discuss the problem of finding an appropriate transformation for
the data and identifying a satisfactory ARMA((p, g) model for the transformed data.
The latter can be handled using the techniques developed in Chapter 5. The sample
ACF and PACF and the preliminary estimators (f)m and ém of Section 5.1 can provide
useful guidance in this choice. However, our prime criterion for model selection will
be the AICC statistic discussed in Section 5.5.2. To apply this criterion we compute
maximum likelihood estimators of ¢, 6, and o2 for a variety of competing p and ¢
values and choose the fitted model with smallest AICC value. Other techniques, in
particular those that use the R and S arrays of Gray et al. (1978), are discussed in
the survey of model identification by de Gooijer et al. (1985). If the fitted model is
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satisfactory, the residuals (see Section 5.3) should resemble white noise. Tests for this
were described in Section 5.3 and should be applied to the minimum AICC model
to make sure that the residuals are consistent with their expected behavior under the
model. If they are not, then competing models (models with AICC value close to the
minimum) should be checked until we find one that passes the goodness of fit tests. In
some cases a small difference in AICC value (say less than 2) between two satisfactory
models may be ignored in the interest of model simplicity. In Section 6.3 we consider
the problem of testing for a unit root of either the autoregressive or moving-average
polynomial. An autoregressive unit root suggests that the data require differencing, and
a moving-average unit root suggests that they have been overdifferenced. Section 6.4
considers the prediction of ARIMA processes, which can be carried out using an
extension of the techniques developed for ARMA processes in Sections 3.3 and 5.4.
In Section 6.5 we examine the fitting and prediction of seasonal ARIMA (SARIMA)
models, whose analysis, except for certain aspects of model identification, is quite
analogous to that of ARIMA processes. Finally, we consider the problem of regression,
allowing for dependence between successive residuals from the regression. Such
models are known as regression models with time series residuals and often occur
in practice as natural representations for data containing both trend and serially
dependent errors.

6.1 ARIMA Models for Nonstationary Time Series

Definition 6.1.1

Example 6.1.1

We have already discussed the importance of the class of ARMA models for represent-
ing stationary series. A generalization of this class, which incorporates a wide range of
nonstationary series, is provided by the ARIMA processes, i.e., processes that reduce
to ARMA processes when differenced finitely many times.

If d is a nonnegative integer, then {X;} is an ARIMA(p,d,q) process if ¥; =
(1 — B)4X, is a causal ARMA(p, g) process.

This definition means that {X,} satisfies a difference equation of the form
¢*(B)X; = ¢(B)(1 — B)'X, = 0(B)Z:, {Z}~ WN(0,0%), (6.1.1)

where ¢ (z) and 0(z) are polynomials of degrees p and ¢, respectively, and ¢ (z) % 0
for |z] < 1. The polynomial ¢*(z) has a zero of order d at z = 1. The process {X;} is
stationary if and only if d = 0, in which case it reduces to an ARMA(p, g) process.

Notice that if d > 1, we can add an arbitrary polynomial trend of degree
(d — 1) to {X,} without violating the difference equation (6.1.1). ARIMA models
are therefore useful for representing data with trend (see Sections 1.5 and 6.2). It
should be noted, however, that ARIMA processes can also be appropriate for modeling
series with no trend. Except when d = 0, the mean of {X;} is not determined by
equation (6.1.1), and it can in particular be zero (as in Example 1.3.3). Since ford > 1,
equation (6.1.1) determines the second-order properties of {(1—B)?X,} but not those of
{X;} (Problem 6.1), estimation of ¢, 8, and o> will be based on the observed differences
(1 — B)X,. Additional assumptions are needed for prediction (see Section 6.4).

{X;} is an ARIMA(1,1,0) process if for some ¢ € (—1, 1),
(1-¢B)(1—B)X, =2, {Z}~WN(0,0%).
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We can then write

t
Xt=X0+ZY-, t>1,

j=1
where
o0
Yi=(1-BXi=) ¢'Z;
j=0
A realization of {X, ..., Xy} with Xo = 0, ¢ = 0.8, and 6> = 1 is shown in

Figure 6-1, with the corresponding sample autocorrelation and partial autocorrelation
functions in Figures 6-2 and 6-3, respectively.

O

A distinctive feature of the data that suggests the appropriateness of an ARIMA

model is the slowly decaying positive sample autocorrelation function in Figure 6-2.
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Figure 6-4

199 observations of the
series Yy = VX; with
{X¢} as in Figure 6-1

If, therefore, we were given only the data and wished to find an appropriate model, it
would be natural to apply the operator V = 1 — B repeatedly in the hope that for some
7> {V¥/X,} will have a rapidly decaying sample autocorrelation function compatible
with that of an ARMA process with no zeros of the autoregressive polynomial
near the unit circle. For this particular time series, one application of the operator
V produces the realization shown in Figure 6-4, whose sample ACF and PACF
(Figures 6-5 and 6-6) suggest an AR(1) [or possibly AR(2)] model for {VX;}. The
maximum likelihood estimates of ¢ and 0% obtained from ITSM under the assumption
that E(VX;) = 0 (found by not subtracting the mean after differencing the data) are
0.808 and 0.978, respectively, giving the model

(1-0.808B)(1 — B)X, =27,, {Z;}~ WN(O0,0.978), (6.1.2)
which bears a close resemblance to the true underlying process,

(1-0.8B)(1 -B)X, =2, {Z}~ WN(Q,1I1). (6.1.3)
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Instead of differencing the series in Figure 6-1 we could proceed more directly by
attempting to fit an AR(2) process as suggested by the sample PACF of the original
series in Figure 6-3. Maximum likelihood estimation, carried out using ITSM after
fitting a preliminary model with Burg’s algorithm and assuming that EX, = 0, gives
the model

(1 — 1.808B + 0.811B%)X, = (1 — 0.825B)(1 — 0.983B)X, = Z,,
{Z,} ~ WN(0, 0.970), (6.1.4)

which, although stationary, has coefficients closely resembling those of the true
nonstationary process (6.1.3). (To obtain the model (6.1.4), two optimizations were
carried out using the Model>Estimation>Max likelihood option of ITSM,
the first with the default settings and the second after setting the accuracy parameter
to 0.00001.) From a sample of finite length it will be extremely difficult to distinguish
between a nonstationary process such as (6.1.3), for which ¢*(1) = 0, and a process
such as (6.1.4), which has very similar coefficients but for which ¢* has all of its
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zeros outside the unit circle. In either case, however, if it is possible by differencing
to generate a series with rapidly decaying sample ACF, then the differenced data set
can be fitted by a low-order ARMA process whose autoregressive polynomial ¢* has
zeros that are comfortably outside the unit circle. This means that the fitted parameters
will be well away from the boundary of the allowable parameter set. This is desirable
for numerical computation of parameter estimates and can be quite critical for some
methods of estimation. For example, if we apply the Yule—Walker equations to fit an
AR(2) model to the data in Figure 6-1, we obtain the model

(1 —1.282B 4 0.290B>) X, = Z,, {Z;} ~ WN(0, 6.435), (6.1.5)

which bears little resemblance to either the maximum likelihood model (6.1.4) or the
true model (6.1.3). In this case the matrix R, appearing in (5.1.7) is nearly singular.

An obvious limitation in fitting an ARIMA(p, d, q) process {X,} to data is that
{X;} is permitted to be nonstationary only in a very special way, i.e., by allowing the
polynomial ¢*(B) in the representation ¢*(B)X; = Z; to have a zero of multiplicity
d at the point 1 on the unit circle. Such models are appropriate when the sample ACF
is a slowly decaying positive function as in Figure 6-2, since sample autocorrelation
functions of this form are associated with models ¢*(B)X; = 6(B)Z; in which ¢* has a
zero either at or close to 1.

Sample autocorrelations with slowly decaying oscillatory behavior as in Fig-
ure 6-8 are associated with models ¢*(B)X, = 6(B)Z, in which ¢* has a zero close to
¢'® for some w € (—m, 7] other than 0. Figure 6-8 is the sample ACF of the series of
200 observations in Figure 6-7, obtained from ITSM by simulating the AR(2) process

X, — Qricose) X1 +r X, =27, {Z}~ WN(, 1), (6.1.6)
with » = 1.005 and w = /3, i.e.,
X, — 0.9950X,_; +0.9901X,_, = Z,, {Z} ~ WN(0, 1).

The autocorrelation function of the model (6.1.6) can be derived by noting that
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1— (erl cos a)) B+ r 2B = (1 - rile"“’B) (1 - rile*i‘”B) (6.1.7)

and using (3.2.12). This gives
_psin(ho + )

ph) =r . h >0, (6.1.8)
sin Y
where
|
tanyr = 5 tan w. (6.1.9)
r-—1
It is clear from these equations that
p(h) — cos(hw) asr | 1. (6.1.10)

With r = 1.005 and @ = 7/3 as in the model generating Figure 6-7, the model
ACEF (6.1.8) is a damped sine wave with damping ratio 1/1.005 and period 6. These
properties are reflected in the sample ACF shown in Figure 6-8. For values of r closer
to 1, the damping will be even slower as the model ACF approaches its limiting form
(6.1.10).

If we were simply given the data shown in Figure 6-7, with no indication of the
model from which it was generated, the slowly damped sinusoidal sample ACF with
period 6 would suggest trying to make the sample ACF decay more rapidly by applying
the operator (6.1.7) with r = 1 and w = /3, i.e., (1 — B+ Bz). If it happens, as in
this case, that the period 27 /w is close to some integer s (in this case 6), then the
operator 1 — B® can also be applied to produce a series with more rapidly decaying
autocorrelation function (see also Section 6.5). Figures 6-9 and 6-10 show the sample
autocorrelation functions obtained after applying the operators 1 — B+ B? and 1 — B®,
respectively, to the data shown in Figure 6-7. For either one of these two differenced
series, it is then not difficult to fit an ARMA model ¢ (B)X; = 6(B)Z, for which the
zeros of ¢ are well outside the unit circle. Techniques for identifying and determining
such ARMA models have already been introduced in Chapter 5. For convenience we
shall collect these together in the following sections with a number of illustrative
examples.
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6.2 Identification Techniques

(a) Preliminary Transformations. The estimation methods of Chapter 5 enable us to
find, for given values of p and ¢, an ARMA( p, g) model to fit a given series of data.
For this procedure to be meaningful it must be at least plausible that the data are in
fact a realization of an ARMA process and in particular a realization of a stationary
process. If the data display characteristics suggesting nonstationarity (e.g., trend and
seasonality), then it may be necessary to make a transformation so as to produce a new
series that is more compatible with the assumption of stationarity.

Deviations from stationarity may be suggested by the graph of the series itself or
by the sample autocorrelation function or both.
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Figure 6-11

The Australian red
wine data after taking
natural logarithms and
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Inspection of the graph of the series will occasionally reveal a strong dependence
of variability on the level of the series, in which case the data should first be
transformed to reduce or eliminate this dependence. For example, Figure 1-1 shows
the Australian monthly red wine sales from January 1980 through October 1991,
and Figure 1-17 shows how the increasing variability with sales level is reduced
by taking natural logarithms of the original series. The logarithmic transformation
Vi, = In U, used here is in fact appropriate whenever {U,} is a series whose standard
deviation increases linearly with the mean. For a systematic account of a general class
of variance-stabilizing transformations, we refer the reader to Box and Cox (1964).
The defining equation for the general Box—Cox transformation f; is

AN UM-1), U >0,1>0,
SHiUy) =
In U;, U;> 0,1 =0,

and the program ITSM provides the option (Transform>Box-Cox) of applying f;
(with 0 < A < 1.5) prior to the elimination of trend and/or seasonality from the data.
In practice, if a Box—Cox transformation is necessary, it is often the case that either f;
or fy 5 is adequate.

Trend and seasonality are usually detected by inspecting the graph of the (possibly
transformed) series. However, they are also characterized by autocorrelation functions
that are slowly decaying and nearly periodic, respectively. The elimination of trend
and seasonality was discussed in Section 1.5, where we described two methods:

(i) “classical decomposition” of the series into a trend component, a seasonal
component, and a random residual component, and
(ii) differencing.

The program ITSM (in the Transform option) offers a choice between these tech-
niques. The results of applying methods (i) and (ii) to the transformed red wine data
V; = In U, in Figure 1-17 are shown in Figures 6-11 and 6-12, respectively. Figure 6-11
was obtained from ITSM by estimating and removing from {V;} a linear trend
component and a seasonal component with period 12. Figure 6-12 was obtained by
applying the operator (1 — Blz) to {V;}. Neither of the two resulting series displays
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any apparent deviations from stationarity, nor do their sample autocorrelation func-
tions. The sample ACF and PACF of {(1 — Bl2) Vt} are shown in Figures 6-13 and
6-14, respectively.

After the elimination of trend and seasonality, it is still possible that the sample
autocorrelation function may appear to be that of a nonstationary (or nearly nonsta-
tionary) process, in which case further differencing may be carried out.

In Section 1.5 we also mentioned a third possible approach:

(iii) fitting a sum of harmonics and a polynomial trend to generate a noise sequence
that consists of the residuals from the regression.

In Section 6.6 we discuss the modifications to classical least squares regression
analysis that allow for dependence among the residuals from the regression. These
modifications are implemented in the ITSM option Regression>Estimation>
GeneralizedLsS.

(b) Identification and Estimation. Let {X;} be the mean-corrected transformed
series found as described in (a). The problem now is to find the most satisfactory
ARMA(p, g) model to represent {X,}. If p and g were known in advance, this would
be a straightforward application of the estimation techniques described in Chapter 5.
However, this is usually not the case, so it becomes necessary also to identify
appropriate values for p and g.

It might appear at first sight that the higher the values chosen for p and ¢, the
better the resulting fitted model will be. However, as pointed out in Section 5.5,
estimation of too large a number of parameters introduces estimation errors that
adversely affect the use of the fitted model for prediction as illustrated in Section 5.4.
We therefore minimize one of the model selection criteria discussed in Section 5.5 in
order to choose the values of p and g. Each of these criteria includes a penalty term
to discourage the fitting of too many parameters. We shall base our choice of p and
q primarily on the minimization of the AICC statistic, defined as

AICC(¢,0) = —2InL(¢,0,5(¢,0)/n) +2(p+q+ n/(n —p — g —2),
(6.2.1)
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Figure 6-13
The sample ACF of the
data in Figure 6-12

Figure 6-14
The sample PACF of
the data in Figure 6-12
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where L(¢, 0, 0?) is the likelihood of the data under the Gaussian ARMA model with
parameters (qb, 0, 02), and S(¢, 0) is the residual sum of squares defined in (5.2.11).
Once a model has been found that minimizes the AICC value, it is then necessary to
check the model for goodness of fit (essentially by checking that the residuals are like
white noise) as discussed in Section 5.3.

For any fixed values of p and ¢, the maximum likelihood estimates of ¢ and
0 are the values that minimize the AICC. Hence, the minimum AICC model (over
any given range of p and g values) can be found by computing the maximum
likelihood estimators for each fixed p and ¢ and choosing from these the maximum
likelihood model with the smallest value of AICC. This can be done with the program
ITSM by using the option Model>Estimation>Autofit. When this option
is selected and upper and lower bounds for p and g are specified, the program
fits maximum likelihood models for each pair (p, g) in the range specified and
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selects the model with smallest AICC value. If some of the coefficient estimates are
small compared with their estimated standard deviations, maximum likelihood subset
models (with those coefficients set to zero) can also be explored.

The steps in model identification and estimation can be summarized as follows:

* After transforming the data (if necessary) to make the fitting of an ARMA(p, q)
model reasonable, examine the sample ACF and PACF to get some idea of potential
p and g values. Preliminary estimation using the ITSM option Model>Esti-
mation>Preliminary is also useful in this respect. Burg’s algorithm with
AICC minimization rapidly fits autoregressions of all orders up to 27 and selects the
one with minimum AICC value. For preliminary estimation of models with g > 0,
each pair (p, g) must be considered separately.

e Select the option Model>Estimation>Autofit of ITSM. Specify the
required limits for p and ¢, and the program will then use maximum likelihood
estimation to find the minimum AICC model with p and ¢ in the range specified.

* Examination of the fitted coefficients and their standard errors may suggest that
some of them can be set to zero. If this is the case, then a subset model can be
fitted by clicking on the button Constrain optimizationin the Maximum
Likelihood Estimation dialog box and setting the selected coefficients to
zero. Optimization will then give the maximum likelihood model with the chosen
coefficients constrained to be zero. The constrained model is assessed by comparing
its AICC value with those of the other candidate models.

e Check the candidate model(s) for goodness of fit as described in Section 5.3.
These tests can be performed by selecting the option Statistics>Residual
Analysis.

The Australian Red Wine Data

Let {X, ..., Xy30} denote the series obtained from the red wine data of Example 1.1.1
after taking natural logarithms, differencing at lag 12, and subtracting the mean
(0.0681) of the differences. The data prior to mean correction are shown in Figure 6-12.
The sample PACF of {X,}, shown in Figure 6-14, suggests that an AR(12) model
might be appropriate for this series. To explore this possibility we use the ITSM
option Model>Estimation>Preliminary with Burg’s algorithm and AICC
minimization. As anticipated, the fitted Burg models do indeed have minimum AICC
when p = 12. The fitted model is

(1 —0.245B — 0.0698> — 0.012B° — 0.021B* — 0.200B°+0.025B°+0.004B’
— 0.133B* + 0.010B° — 0.095B'"° 4 0.118B'" + 0.384B'*)X, = Z,

with {Z,} ~ WN(0, 0.0135) and AICC value —158.77. Selecting the option Model >
Estimation>Max likelihood then gives the maximum likelihood AR(12)
model, which is very similar to the Burg model and has AICC value —158.87.
Inspection of the standard errors of the coefficient estimators suggests the possibility
of setting those at lags 2,3,4,6,7,9,10, and 11 equal to zero. If we do this by click-
ing on the Constrain optimization button in the Maximum Likelihood
Estimation dialog box and then reoptimize, we obtain the model,

(1 —0.270B — 0.224B° — 0.149B® + 0.099B"' + 0.353B"*)X, = Z,

with {Z;} ~ WN(O0, 0.0138) and AICC value —172.49.
In order to check more general ARMA(p, g) models, select the option Model >
Estimation>Autofit and specify the minimum and maximum values of p and
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q to be zero and 15, respectively. (The sample ACF and PACF suggest that these limits
should be more than adequate to include the minimum AICC model.) In a few minutes
(depending on the speed of your computer) the program selects an ARMA(1,12) model
with AICC value —172.74, which is slightly better than the subset AR(12) model
just found. Inspection of the estimated standard deviations of the MA coefficients at
lags 1, 3,4, 6,7,9, and 11 suggests setting them equal to zero and reestimating the
values of the remaining coefficients. If we do this by clicking on the Constrain
optimization button in the Maximum Likelihood Estimation dialog
box, setting the required coefficients to zero and then reoptimizing, we obtain the
model,

(1 —0.286B)X; = (1 +0.127B% 4 0.183B° + 0.177B% + 0.181B'" — 0.554312) Z,

with {Z;} ~ WN(O0, 0.0120) and AICC value —184.09.
The subset ARMA(1,12) model easily passes all the goodness of fit tests
in the Statistics>Residual Analysis option. In view of this and its small

AICC value, we accept it as a plausible model for the transformed red wine series.
O

Example 6.2.2 The Lake Data

Let {Y;,t = 1,...,99} denote the lake data of Example 1.3.5. We have seen already
in Example 5.2.5 that the ITSM option Model>Estimation>Autofit gives the
minimum-AICC model

X,—0.7446X,_1=7,+0.3213Z,_, {Z,} ~ WN(0, 0.4750),

for the mean-corrected series X; = Y, — 9.0041. The corresponding AICC value is
212.77. Since the model passes all the goodness of fit tests, we accept it as a reasonable
model for the data.

O

6.3 Unit Roots in Time Series Models

The unit root problem in time series arises when either the autoregressive or moving-
average polynomial of an ARMA model has a root on or near the unit circle. A
unit root in either of these polynomials has important implications for modeling.
For example, a root near 1 of the autoregressive polynomial suggests that the data
should be differenced before fitting an ARMA model, whereas a root near 1 of
the moving-average polynomial indicates that the data were overdifferenced. In this
section, we consider inference procedures for detecting the presence of a unit root in
the autoregressive and moving-average polynomials.

6.3.1 Unit Roots in Autoregressions

In Section 6.1 we discussed the use of differencing to transform a nonstationary time
series with a slowly decaying sample ACF and values near 1 at small lags into one
with a rapidly decreasing sample ACF. The degree of differencing of a time series {X,}
was largely determined by applying the difference operator repeatedly until the sample
ACF of {V"X,} decays quickly. The differenced time series could then be modeled by
a low-order ARMA(p, q) process, and hence the resulting ARIMA(p, d, g) model
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for the original data has an autoregressive polynomial (1 —p1z— =’ ) (1—2)¢ [see
(6.1.1)] with d roots on the unit circle. In this subsection we discuss a more systematic
approach to testing for the presence of a unit root of the autoregressive polynomial in
order to decide whether or not a time series should be differenced. This approach was
pioneered by Dickey and Fuller (1979).

Let Xi, ..., X, be observations from the AR(1) model

Xi—pn=¢ X1 =) +Z,  {Z}~WN(0,0?), (6.3.1)

where |¢;| < 1 and u = EX,. For large n, the maximum likelihood estimator q@l of ¢,
is approximately N(¢>1, (1 — ¢>12) / n). For the unit root case, this normal approximation
is no longer applicable, even asymptotically, which precludes its use for testing the
unit root hypothesis Hy : ¢; = 1 vs. H; : ¢ < 1. To construct a test of Hy, write the
model (6.3.1) as

VX, =X, — X1 =g+ d{ X1+ Z, {Z} ~ WN(0,07), (6.3.2)

where ¢ = u(l — ¢1) and @7 = ¢; — 1. Now let (ZA)T be the ordinary least squares
(OLS) estimator of ¢ found by regressing VX, on 1 and X;_,. The estimated standard

error of ¢f is

" —1/2

— N2

(5) = (Lt 7)

t=2
~ ~ 2 _

where $* = Y ", (VX, — @5 — qbet_l) /(n — 3) and X is the sample mean of
X1, ..., X,—1. Dickey and Fuller derived the limit distribution as n — oo of the #-
ratio

#, .= ¢t/SE (q@f) (63.3)

under the unit root assumption ¢; = 0, from which a test of the null hypothesis
Hy : ¢1=1 can be constructed. The 0.01, 0.05, and 0.10 quantiles of the limit
distribution of fu (see Table 8.5.2 of Fuller 1976) are —3.43, —2.86, and —2.57,
respectively. The augmented Dickey—Fuller test then rejects the null hypothesis of a
unit root, at say, level 0.05 if 7, < —2.86. Notice that the cutoff value for this test
statistic is much smaller than the standard cutoff value of —1.645 obtained from the
normal approximation to the #-distribution, so that the unit root hypothesis is less likely
to be rejected using the correct limit distribution.

The above procedure can be extended to the case where {X;} follows the AR(p)
model with mean w given by

Xi—pn=¢1 X1 — )+ + & (Xep — 1) +Z:,  {Z} ~ WN(0,0?).

This model can be rewritten as (see Problem 6.2)

VXi=¢ +d1 X1 + VX1 + -+ 0 VX + 2, (6.3.4)
where ¢o = (1 =1 —---=¢,), ¢f = 20 ¢ — Land ¢* = =37 ¢, j =
2, ..., p.If the autoregressive polynomial has a unit root at 1, then 0 = ¢ (1) = —¢7,

and the differenced series {VX,} is an AR(p — 1) process. Consequently, testing the
hypothesis of a unit root at 1 of the autoregressive polynomial is equivalent to testing
@] = 0. Asin the AR(1) example, ¢ can be estimated as the coefficient of X;_; in the
OLS regression of VX, onto 1, X,_;, VX,_y, ..., VX,_,,:. For large n the t-ratio

#, := ¢t/SE (J);*), (6.3.5)
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where SE (]Abf is the estimated standard error of (]31“, has the same limit distribution as

the test statistic in (6.3.3). The augmented Dickey—Fuller test in this case is applied in
exactly the same manner as for the AR(1) case using the test statistic (6.3.5) and the
cutoff values given above.

Consider testing the time series of Example 6.1.1 (see Figure 6-1) for the presence
of a unit root in the autoregressive operator. The sample PACF in Figure 6-3 sug-
gests fitting an AR(2) or possibly an AR(3) model to the data. Regressing VX, on
1,X,—1, VX1, VX, fort =4, ..., 200 using OLS gives

VX, =0.1503 — 0.0041X,_; 4+ 0.9335VX,_; — 0.1548VX,_, + Z,,

(0.1135) (0.0028) (0.0707) (0.0708)
where {Z;} ~ WN(O0, 0.9639). The test statistic for testing the presence of a unit root is
—0.0041
T, = ———— = —1.464.
= 70,0028

Since —1.464 > —2.57, the unit root hypothesis is not rejected at level 0.10. In
contrast, if we had mistakenly used the ¢-distribution with 193 degrees of freedom
as an approximation to 7, then we would have rejected the unit root hypothesis at
the 0.10 level (p-value is 0.074). The t-ratios for the other coefficients, ¢, ¢;, and
@3, have an approximate z-distribution with 193 degrees of freedom. Based on these
t-ratios, the intercept should be 0, while the coefficient of VX,_, is barely significant.
The evidence is much stronger in favor of a unit root if the analysis is repeated without
a mean term. The fitted model without a mean term is

VX, =0.0012X,_; + 0.9395VX,_; — 0.1585VX,_, + Z,,
(0.0018) (0.0707) (0.0709)

where {Z,} ~ WN(0,0.9677). The 0.01, 0.05, and 0.10 cutoff values for the
corresponding test statistic when a mean term is excluded from the model are —2.58,
—1.95, and —1.62 (see Table 8.5.2 of Fuller 1976). In this example, the test statistic is

—0.0012
T=———=-0.667,
0.0018
which is substantially larger than the 0.10 cutoff value of —1.62.
O
Further extensions of the above test to AR models with p = O(nl/ 3) and to

ARMA(p, g) models can be found in Said and Dickey (1984). However, as reported
in Schwert (1987) and Pantula (1991), this test must be used with caution if the
underlying model orders are not correctly specified.

6.3.2 Unit Roots in Moving Averages

A unit root in the moving-average polynomial can have a number of interpretations
depending on the modeling application. For example, let {X,} be a causal and invertible
ARMA(p, g) process satisfying the equations

$BX, =0(B)Z,  (Z)~WN(0.0%).

Then the differenced series Y, := VX, is a noninvertible ARMA(p, g + 1) process
with moving-average polynomial 6(z)(1 — z). Consequently, testing for a unit root in
the moving-average polynomial is equivalent to testing that the time series has been
overdifferenced.
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As asecond application, it is possible to distinguish between the competing models
VX, =a+V,
and
X;=co+cit+-+ ot + W,

where {V;} and {W,} are invertible ARMA processes. For the former model the
differenced series {VkXt} has no moving-average unit roots, while for the latter model
{V*X,} has a multiple moving-average unit root of order k. We can therefore distinguish
between the two models by using the observed values of {V"Xt} to test for the presence
of a moving-average unit root.

We confine our discussion of unit root tests to first-order moving-average models,
the general case being considerably more complicated and not fully resolved. Let
Xy, ..., X, be observations from the MA(1) model

X, =27 +6Z_,, {Z} ~ 1D (0,0%).

Davis and Dunsmuir (1996) showed that under the assumption 6 = —1, n(é +1) (é is
the maximum likelihood estimator) converges in distribution. A test of Hy : 6 = —1
vs. H; : & > —1 can be fashioned on this limiting result by rejecting Hy when

6>—1 + co/n,

where ¢, is the (1 — «) quantile of the limit distribution of n(é + 1). (From
Table 3.2 of Davis et al. (1995), coo1 = 11.93, cpo5 = 6.80, and cpj10 =
4.90.) In particular, if n = 50, then the null hypothesis is rejected at level 0.05 if
0 > —1+46.80/50 = —0.864.

The likelihood ratio test can also be used for testing the unit root hypothesis. The
likelihood ratio for this problem is L(—1, S(—1)/n)/L (é , &2), where L (6, o) is the
Gaussian likelihood of the data based on an MA(1) model, S(—1) is the sum of squares
given by (5.2.11) when # = —1, and 6 and 62 are the maximum likelihood estimators
of @ and o2. The null hypothesis is rejected at level « if

L(—1,5(=1)/n) - e
L(é, 52) ’

where the cutoff value is chosen such that Po—_i[A, > cLro] = o. The limit
distribution of 1, was derived by Davis et al. (1995), who also gave selected quantiles
of the limit. It was found that these quantiles provide a good approximation to their
finite-sample counterparts for time series of length n > 50. The limiting quantiles for
)\n under H() are CLr,0.01 = 441, CLR,0.05 = 194, and CLR,0.10 = 1.00.

A= —2In

For the overshort data {X;} of Example 3.2.8, the maximum likelihood MA(1) model
for the mean corrected data {Y, = X, 4+ 4.035} was (see Example 5.4.1)

Y, =7,-0.818Z,_,, {Z;}~ WN(0,2040.75).

In the structural formulation of this model given in Example 3.2.8, the moving-average
parameter 6 was related to the measurement error variances 05 and 03 through the
equation

2
0 -0y

14+62 2054—03'
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(These error variances correspond to the daily measured amounts of fuel in the tank
and the daily measured adjustments due to sales and deliveries.) A value of 8 = —1
indicates that there is no appreciable measurement error due to sales and deliveries
(i.e., of = 0), and hence testing for a unit root in this case is equivalent to testing
that 07 = 0. Assuming that the mean is known, the unit root hypothesis is rejected
at o = 0.05, since —0.818 > —1 4 6.80/57 = —0.881. The evidence against Hy is
stronger using the likelihood ratio statistic. Using ITSM and entering the MA(1) model
6 = —1 and 02 = 2203.12, we find that —2InL(—1,2203.12) = 604.584, while
—21In L(é ,6%) = 597.267. Comparing the likelihood ratio statistic A, = 604.584 —
597.267 = 7.317 with the cutoff value cLr 001, We reject Hy at level « = 0.01 and
conclude that the measurement error associated with sales and deliveries is nonzero.

In the above example it was assumed that the mean was known. In practice, these
tests should be adjusted for the fact that the mean is also being estimated.

Tanaka (1990) proposed a locally best invariant unbiased (LBIU) test for the unit
root hypothesis. It was found that the LBIU test has slightly greater power than the
likelihood ratio test for alternatives close to & = —1 but has less power for alternatives
further away from —1 (see Davis et al. 1995). The LBIU test has been extended to
cover more general models by Tanaka (1990) and Tam and Reinsel (1995). Similar
extensions to tests based on the maximum likelihood estimator and the likelihood ratio

statistic have been explored in Davis et al. (1996).
O

6.4 Forecasting ARIMA Models

In this section we demonstrate how the methods of Sections 3.3 and 5.4 can be
adapted to forecast the future values of an ARIMA(p, d, q) process {X;}. (The required
numerical calculations can all be carried out using the program ITSM.)

If d > 1, the first and second moments EX; and E(X,,;X;) are not determined by
the difference equations (6.1.1). We cannot expect, therefore, to determine best linear
predictors for {X;} without further assumptions.

For example, suppose that {Y;} is a causal ARMA( p, q) process and that X is any
random variable. Define

t
X, =Xo+» Y, t=12..
Jj=1

Then {X;, t > 0} is an ARIMA(p, 1, g) process with mean EX, = EX, and autocovari-
ances E(X,41X;) — (EX,)? that depend on Var(X,) and Cov(Xo, Y),j=1,2,.... The
best linear predictor of X,,,; based on {1, Xy, X1, ..., X,,} is the same as the best linear
predictor in terms of the set {1, Xy, Y1, ..., Y,}, since each linear combination of the
latter is a linear combination of the former and vice versa. Hence, using P, to denote
best linear predictor in terms of either set and using the linearity of P,, we can write

Pan+1 :Pn(X0+ Yl +-- 4+ Yn+1) = Pn(Xn + Yn+1) :Xn+PnYn+1-

To evaluate P,Y, it is necessary (see Section 2.5) to know E(XyY)),j=1,...,n+1,
and EXS. However, if we assume that X, is uncorrelated with {Y;,r > 1}, then
P,Y, is the same (Problem 6.5) as the best linear predictor IA/HH of Y,1 in terms of
{1,Y,...,Y,}, which can be calculated as described in Section 3.3. The assumption
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that X, is uncorrelated with Y, Y, ... is therefore sufficient to determine the best
linear predictor P,X, . in this case.

Turning now to the general case, we shall assume that our observed process {X;}
satisfies the difference equations

(1-B)¥X, =Y, t=12,...,

where {Y;} is a causal ARMA(p, g) process, and that the random vector (X;_g, ..., Xp)
is uncorrelated with Y;, ¢ > 0. The difference equations can be rewritten in the form

d

X, =Y -y <‘?>(—1)1th, r=1,2,.... (6.4.1)
j

J=1

It is convenient, by relabeling the time axis if necessary, to assume that we observe
Xi_4,Xo_4, ..., X,. (The observed values of {Y;} are then Yi, ..., Y,.) As usual, we
shall use P, to denote best linear prediction in terms of the observations up to time n
(in this case 1, X;_g4, ..., X, or equivalently 1, X;_g4, ..., X0, Y1, ..., Yy).

Our goal is to compute the best linear predictors P, X, ,. This can be done by
applying the operator P, to each side of (6.4.1) (with t = n+ h) and using the linearity
of P, to obtain

d

d .
PuXosn = PaYurs— 3 (J) (=D PuXrn-i. (6:4.2)
j=1
Now the assumption that (X;_g4, ..., Xp) is uncorrelated with Y;, # > 0, enables us to
identify P,Y, ., with the best linear predictor of Y, in terms of {1, ¥y, ..., Y,}, and

this can be calculated as described in Section 3.3. The predictor P,X, is obtained
directly from (6.4.2) by noting that P,X,|_j = X,.+1—; for each j > 1. The predictor
P,X,.,» can then be found from (6.4.2) using the previously calculated value of
P, X, 1. The predictors P,X, 3, P,X,14, ... can be computed recursively in the same
way.

To find the mean squared error of prediction it is convenient to express P,Y,1 in
terms of {X;}. For n > 0 we denote the one-step predictors by IA/HH = P,Y,; and

A

Xnt1 = P,X,+1. Then from (6.4.1) and (6.4.2) we have

A A

Xn+1_Xn+1=Yn+1_Yn+1a n= 17

and hence from (3.3.12), if n > m = max(p, ¢) and & > 1, we can write

p q
PiYoin =Y ¢iPu¥uin-i+ I Onin-1; (XnJrhfj - XnJrhfj) : (6.4.3)
i=1 j=h
Setting ¢*(z) = (1 — 2)%(z) =1 — diz— - — ¢;§+dzp+d, we find from (6.4.2) and
(6.4.3) that
p+d q
Pan—i-h = Z ¢;(Pan+h—j + Z en+h—l,j (Xn+h—j - Xn+h—j> ’
j=1 j=h
(6.4.4)

which is analogous to the A-step prediction formula (3.3.12) for an ARMA process.
As in (3.3.13), the mean squared error of the A-step predictor is
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2

h—1 J
O_nz(h) = E(Xn+h - Pan+h)2 = Z (Z Xr0n+h—r—l,j—r> Vindh—j—15

=0 \r=0

(6.4.5)

where 6, = 1,

o
10 =307 = (1= e = )
r=0
and

~ 2 ~ 2
Vnth—j—1 = E <Xn+h—j - Xn+h—j) =E <Yn+h—j - n+h—j) .

The coefficients x; can be found from the recursions (3.3.14) with qbf replacing ¢;. For
large n we can approximate (6.4.5), provided that 6(-) is invertible, by

h—1
ol(h) =) Yo’ (6.4.6)
j=0
where

V@ =) i = 0"2) 0.
j=0

6.4.1 The Forecast Function

Inspection of equation (6.4.4) shows that for fixed n > m = max(p, q), the h-step
predictors

g(h) = PanJrha

satisfy the homogeneous linear difference equations
gh) —¢pigth—1) —--- =@ ;gth—p—d) =0, h>gq, (6.4.7)

where ¢}, ..., ¢%, , are the coefficients of z, ..., 27/ in

¢*@) = (1 —2% ().

The solution of (6.4.7) is well known from the theory of linear difference equations
(see Brockwell and Davis (1991), Section 3.6). If we assume that the zeros of ¢ (z)
(denoted by &1, ..., §,) are all distinct, then the solution is

gy =ay+ath+ - +ag1h" " +bi&" +-- -+ b ", h>q—p—d,
(6.4.8)

where the coefficients ao, ..., as—; and by, ..., b, can be determined from the p + d
equations obtained by equating the right-hand side of (6.4.8) forqg —p —d < h < ¢
with the corresponding value of g(h) computed numerically (for & < 0, P, X,.; =
X, and for 1 < h < g, P,X,,4+ can be computed from (6.4.4) as already described).
Once the constants a; and b; have been evaluated, the algebraic expression (6.4.8)
gives the predictors for all # > g — p — d. In the case ¢ = 0, the values of g(h) in
the equations for a, ..., aq—1, b1, ..., b, are simply the observed values g(h) =X, 11,
—p —d < h <0, and the expression (6.4.6) for the mean squared error is exact.
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The calculation of the forecast function is easily generalized to deal with more
complicated ARIMA processes. For example, if the observations X 13, X_12, ..., X,
are differenced atlags 12 and 1, and (1 —B) (1 —B 1Z)X, is modeled as a causal invertible
ARMA(p, g) process with mean p and max(p, g) < n, then {X,} satisfies an equation
of the form

¢B)[(1 —B)(1 —B")X, — ul = 0(B)Z, {Z}~ WN (0,07, (6.4.9)
and the forecast function g(h) = P, X, satisfies the analogue of (6.4.7), namely,

¢B)(1 —B)(1 —B®)gh) = p(Du, h>gq. (6.4.10)

To find the general solution of these inhomogeneous linear difference equations, it
suffices (see Brockwell and Davis (1991), Section 3.6) to find one particular solution
of (6.4.10) and then add to it the general solution of the same equations with the right-
hand side set equal to zero. A particular solution is easily found (by trial and error)
to be

h?
h) = —,
8h) =~
and the general solution is therefore
/,L//lz 11
gy == +ao+ah+ D e f by by
j=1
h>qg—p—13. (6.4.11)

(The terms ay and ah correspond to the double root z = 1 of the equation ¢ (z)(1 —
7)(1 —z'?) = 0, and the subsequent terms to each of the other roots, which we assume
to be distinct.) Forq — p — 13 < h < 0, g(h) = X144, and for 1 < h < g, the values
of g(h) = P, X+, can be determined recursively from the equations

Pan+h =u+ Pan,1 + Pan712 - Pan713 + PnYn+h’

where {Y;} is the ARMA process ¥; = (1 — B)(l — BIZ)X, — . Substituting these
values of g(h) into (6.4.11), we obtain a set of p + 13 equations for the coefficients
a;, b;, and c. Solving these equations then completes the determination of g(h).

The large-sample approximation to the mean squared error is again given by
(6.4.6), with ; redefined as the coefficient of Z in the power series expansion of

0(2)/[(1—2(1 —z"%)p@)].
An ARIMAC(1,1,0) Model

In Example 5.2.4 we found the maximum likelihood AR(1) model for the mean-
corrected differences X, of the Dow Jones Ultilities Index (August 28-December 18,
1972). The model was

X, —04471X,_, =Z,, {Z;} ~ WN(0, 0.1455), (6.4.12)

where X, = D, — D,_; —0.1336, t =1,...,77,and {D,,t = 0,1,2,...,77} is the
original series. The model for {D,} is thus

(1-0.4471B)[(1 — B)D, — 0.1336] = Z,, {Z;} ~ WN(O0, 0.1455).
The recursions for g(h) therefore take the form

(1-0.4471B)(1-B)g(h) = 0.5529x0.1336 = 0.07387, h > 0. (6.4.13)
A particular solution of these equations is g(h) = 0.13364, so the general solution is

g(h) = 0.1336h + a + b(0.447D)", h > —2. (6.4.14)
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Substituting g(—1) = D¢ = 122 and g(0) = D77 = 121.23 in the equations with
h = —1 and & = 0, and solving for a and b gives

g(h) = 0.1366h + 120.50 + 0.7331(0.4471)".
Setting h = 1 and h = 2 gives
P77D78 = 120.97 and P77D79 = 120.94.
From (6.4.5) we find that the corresponding mean squared errors are
03;(1) = vy = 0% = 0.1455
and
04(2) = vig + @1 vy = o (1 + 1.44712) = 0.4502.

(Notice that the approximation (6.4.6) is exact in this case.) The predictors and their
mean squared errors are easily obtained from the program ITSM by opening the file
DOWIJ.TSM, differencing at lag 1, fitting a preliminary AR(1) model to the mean-
corrected data with Burg’s algorithm, and selecting Model>Estimation>Max
likelihood to find the maximum likelihood AR(1) model. Predicted values and
their mean squared errors are then found using the option Forecasting>ARMA.

g

6.5 Seasonal ARIMA Models

Definition 6.5.1

We have already seen how differencing the series {X;} at lag s is a convenient way
of eliminating a seasonal component of period s. If we fit an ARMA(p, g) model
¢(B)Y; = 0(B)Z; to the differenced series Y; = (1 — B*)X;, then the model for the
original series is ¢(B) (1 — B*) X, = 0(B)Z,. This is a special case of the general
seasonal ARIMA (SARIMA) model defined as follows.

If d and D are nonnegative integers, then {X;} is a seasonal ARIMA(p, d, q) x
(B D, Q), process with period s if the differenced series Y; = (1-B)4(1-B%Px,
is a causal ARMA process defined by

pBYD (B') Y, =0B)O (B)Z,  (Z)~WN(0,02), (6.5.1)

where ¢(z) = 1 — 1z — -+ — $p, P(2) = 1 —®iz—--- —dpzf, 0(2) =
1+6iz4+ - +0,z27,and O(z) = 1 + Oz 4 - - - + Opz2.

Remark 1. Note that the process {Y;} is causal if and only if ¢ (z) % 0 and ®(z) # 0
for |z| < 1. In applications D is rarely more than one, and P and Q are typically less

than three. g
Remark 2. Equation (6.5.1) satisfied by the differenced process {Y;} can be rewritten
in the equivalent form

¢*(B)Y, = 0*(B)Z,, (6.5.2)

where ¢*(-), 6% (-) are polynomials of degree p + s P and g + sQ, respectively, whose
coefficients can all be expressed in terms of ¢y, ..., ¢,, ®1,..., Pp, 6y,...,0,, and
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Example 6.5.1

Example 6.5.2

1, ..., ®p.Provided that p < s and g < s, the constraints on the coefficients of ¢*(-)
and 6*(-) can all be expressed as multiplicative relations

qb;kHj:d);;d)?‘, i=12,...; j=1,...,s—1,
and

0i’§+j=0i’§0j*, i=1,2,...; j=1,...,5s—1.

In Section 1.5 we discussed the classical decomposition model incorporating trend,
seasonality, and random noise, namely, X, = m; + s; + Y,. In modeling real data
it might not be reasonable to assume, as in the classical decomposition model, that
the seasonal component s, repeats itself precisely in the same way cycle after cycle.
Seasonal ARIMA models allow for randomness in the seasonal pattern from one cycle
to the next. g

Suppose we have r years of monthly data, which we tabulate as follows:

Year/Month 1 2 e 12
1 Y, Y, . Yo
2 Yi3 Yia eee You
3 Y25 Y26 oo Y36
r Yirioo—y Yori2e—y o Yioqi20-n

Each column in this table may itself be viewed as a realization of a time series. Suppose
that each one of these twelve time series is generated by the same ARMA(P, Q)
model, or more specifically, that the series corresponding to the jth month, Y; o,
t=0,...,r— 1, satisfies a difference equation of the form

Yirie =P Yjig-n+ -+ PrYir2¢-p) + Upp12s

+01Ujr12¢-1) + -+ + OgUj12¢-0), (6.5.3)

where
{Uppront=...,—1,0,1,...} ~WN(0,07) . (6.5.4)
Then since the same ARMA(P, Q) model is assumed to apply to each month, (6.5.3)
holds for each j = 1, ..., 12. (Notice, however, that E(U,U,,;) is not necessarily

zero except when £ is an integer multiple of 12.) We can thus write (6.5.3) in the
compact form

@ (B?)Y, =0 (B?) U, (6.5.5)

where @(z) = 1 —@1z— - — Dpz", O(2) = 1 + O1z2+ -+ Opz2, and (U110, 1 =
...,—1,0,1,...} ~ WN (0, alz,) for each j. We refer to the model (6.5.5) as the

between-year model.
g

Suppose P =0, Q = 1, and ®; = —0.4 in (6.5.5). Then the series for any particular
month is a moving-average of order 1. If E(U,U,;,)=0 for all 4, i.e., if the white noise
sequences for different months are uncorrelated with each other, then the columns
themselves are uncorrelated. The correlation function for such a process is shown in
Figure 6-15.

O
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Example 6.5.3

Suppose P = 1, Q = 0, and ®; = 0.7 in (6.5.5). In this case the 12 series (one for
each month) are AR(1) processes that are uncorrelated if the white noise sequences
for different months are uncorrelated. A graph of the autocorrelation function of this

process is shown in Figure 6-16.
0

In each of the Examples 6.5.1-6.5.3, the 12 series corresponding to the dif-
ferent months are uncorrelated. To incorporate dependence between these series
we allow the process {U;} in (6.5.5) to follow an ARMA( p, ¢) model,

o (B)U, = 0(B)Z,, {Z} ~ WN(0,07). (6.5.6)

This assumption implies possible nonzero correlation not only between consecutive
values of U, but also within the 12 sequences {Uj12,t = ..., —1,0, 1, ...}, each of
which was assumed to be uncorrelated in the preceding examples. In this case (6.5.4)
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Example 6.5.4

may no longer hold; however, the coefficients in (6.5.6) will frequently have values
such that E(U,U,415)) is small for j = &1, £2, ... . Combining the two models (6.5.5)
and (6.5.6) and allowing for possible differencing leads directly to Definition 6.5.1 of
the general SARIMA model as given above.

The first steps in identifying SARIMA models for a (possibly transformed) data
set are to find d and D so as to make the differenced observations

Y, =(1-B)71-B)X,

stationary in appearance (see Sections 6.1-6.3). Next we examine the sample ACF
and PACF of {Y;} at lags that are multiples of s for an indication of the orders P and
Q in the model (6.5.5). If p(-) is the sample ACF of {Y;}, then P and Q should be
chosen such that p(ks), k = 1,2, ..., is compatible with the ACF of an ARMA(P, Q)
process. The orders p and ¢ are then selected by trying to match p(1),..., o(s — 1)
with the ACF of an ARMA( p, ¢q) process. Ultimately, the AICC criterion (Section 5.5)
and the goodness of fit tests (Section 5.3) are used to select the best SARIMA model
from competing alternatives.

For given values of p, d, g, P, D, and Q, the parameters ¢, 6, ®, ®, and o2 can
be found using the maximum likelihood procedure of Section 5.2. The differences
Y= (1 - B)d(l — BS)DX, constitute an ARMA(p + sP, g + sQ) process in which
some of the coefficients are zero and the rest are functions of the (p + P + g + Q)-
dimensional vector 3’ = (¢’, @', 6’, ®'). For any fixed 3 the reduced likelihood ¢(3)
of the differences Y, 41sp, - . ., ¥, is easily computed as described in Section 5.2. The
maximum likelihood estimator of 3 is the value that minimizes ¢(3), and the
maximum likelihood estimate of o is given by (5.2.10). The estimates can be found
using the program ITSM by specifying the required multiplicative relationships among
the coefficients as given in Remark 2 above.

A more direct approach to modeling the differenced series {Y;} is simply to fit a
subset ARMA model of the form (6.5.2) without making use of the multiplicative form
of ¢*(-) and 6*(-) in (6.5.1).

Monthly Accidental Deaths

In Figure 1-27 we showed the series { Y, = (1 —Blz) (1 —B)Xt} obtained by differencing
the accidental deaths series {X;} once at lag 12 and once at lag 1. The sample ACF of
{Y;} is shown in Figure 6-17.

O

The values p(12) = —0.333, p(24) = —0.099, and p(36) = 0.013 suggest a
moving-average of order 1 for the between-year model (i.e., P = O and O = 1).
Moreover, inspection of p(1),..., p(11) suggests that po(1) is the only short-term

correlation different from zero, so we also choose a moving-average of order 1 for
the between-month model (i.e., p = 0 and ¢ = 1). Taking into account the sample
mean (28.831) of the differences {Y,}, we therefore arrive at the model

Y, =28.831+(1+6:B)(1+©,B"Z, {Z}~WN(0,07%),

(6.5.7)
for the series {Y;}. The maximum likelihood estimates of the parameters are obtained
from ITSM by opening the file DEATHS.TSM and proceeding as follows. After
differencing (at lags 1 and 12) and then mean-correcting the data, choose the option
Model>Specify. In the dialog box enter an MA(13) model with 8; = —0.3,
01, = —0.3, 0;3 = 0.09, and all other coefficients zero. (This corresponds to the initial
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guess ¥; = (1 — O.3B)(1 — O.3Blz)Zt.) Then choose Model >Estimation>Max
likelihood and click on the button Constrain optimization. Specify the
number of multiplicative relations (one in this case) in the box provided and define the
relationship by entering 1, 12, 13 to indicate that 6; x 6y, = 6;3. Click OK to return
to the Maximum Likelihood dialog box. Click OK again to obtain the parameter
estimates

A~

0, = —0.478,

®; = —-0.591,
and

6% = 94,255,

with AICC value 855.53. The corresponding fitted model for {X;} is thus the SARIMA
0,1,1) x (0,1, 1)1, process

VVoX, = 28.831 + (1 — 0.478B) (1 — 0.591B") Z,, (6.5.8)

where {Z;} ~ WN(0, 94390).

If we adopt the alternative approach of fitting a subset ARMA model to {Y;}
without seeking a multiplicative structure for the operators ¢*(B) and 6*(B) in (6.5.2),
we begin by fitting a preliminary MA(13) model (as suggested by Figure 6-17) to
the series {Y;}. We then fit a maximum likelihood MA(13) model and examine the
standard errors of the coefficient estimators. This suggests setting the coefficients at
lags 2, 3, 8, 10, and 11 equal to zero, since these are all less than one standard error from
zero. To do this select Model>Estimation>Max likelihood and click on the
button Constrain optimization. Then highlight the coefficients to be set to
zero and click on the button Set to zero. Click OK to return to the Maximum
Likelihood Estimation dialog box and again to carry out the constrained
optimization. The coefficients that have been set to zero will be held at that value, and
the optimization will be with respect to the remaining coefficients. This gives a model
with substantially smaller AICC than the unconstrained MA(13) model. Examining
the standard errors again we see that the coefficients at lags 4, 5, and 7 are promising
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candidates to be set to zero, since each of them is less than one standard error from
zero. Setting these coefficients to zero in the same way and reoptimizing gives a further
reduction in AICC. Setting the coefficient at lag 9 to zero and reoptimizing again gives
a further reduction in AICC (to 855.61) and the fitted model

VViX, = 28.831 +Z, — 0.596Z,_, — 0.407Z,_¢ — 0.685Z,_1» + 0.460Z,_,3,
{Z;} ~ WN(O0, 71240). (6.5.9)

The AICC value 855.61 is quite close to the value 855.53 for the model (6.5.8). The
residuals from the two models are also very similar, the randomness tests (with the
exception of the difference-sign test) yielding high p-values for both.

6.5.1 Forecasting SARIMA Processes

Forecasting SARIMA processes is completely analogous to the forecasting of ARIMA

processes discussed in Section 6.4. Expanding out the operator (1 — B)¢ (1 — BS)D in
powers of B, rearranging the equation

(1-B'(1-B)X =Y,
and setting t = n + h gives the analogue

d+Ds
Xogn = Yoin+ ) @Xninj (6.5.10)
J=1
of equation (6.4.2). Under the assumption that the first d 4+ Ds observations X_;_p,.1,
..., Xp are uncorrelated with {Y;, > 1}, we can determine the best linear predictors
P, X, of X;.pbasedon {1, X_y_pet1, ..., X,} by applying P, to each side of (6.5.10)
to obtain
d+Ds
P Xy =PyYupn + Z aanXn+h—j- (6.5.11)
Jj=1
The first term on the right is just the best linear predictor of the (possibly nonzero-
mean) ARMA process {Y;} in terms of {1, Yy, ..., Y,}, which can be calculated as
described in Section 3.3. The predictors P, X, can then be computed recursively for
h=1,2,...from (6.5.11), if we note that P, X, _; = X, foreachj > 1.
An argument analogous to the one leading to (6.4.5) gives the prediction mean
squared error as

2

h=1 / j
O_nZ(h) = E(Xn+h - Pan+h)2 = Z <Z Xr0n+hr1,jr> Vnth—j—15

j=0 r=0
(6.5.12)

where 6,; and v, are obtained by applying the innovations algorithm to the differenced
series {Y,} and

-1

x@ =Y 07" = [s@()1 -2/ (1-2)"] L <1
r=0
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Table 6.1

Example 6.5.5

Predicted values of the Accidental Deaths series for
t = 73,...,78, the standard deviations o; of the
prediction errors, and the corresponding observed
values of X; f r the same period

t 73 74 75 76 77 78

Model (6.5.8)
Predictors 8441 7704 8549 8885 9843 10279
ot 308 348 383 415 445 474

Model (6.5.9)
Predictors 8345 7619 8356 8742 9795 10179
ot 292 329 366 403 442 486

Observed values
Xy 7798 7406 8363 8460 9217 9316

For large n we can approximate (6.5.12), if 6(z)® (z*) is nonzero for all |z| < 1, by

h—1
ol(h) =Y Yo’ (6.5.13)
j=0
where
= 0(2)0 (z°)
— - , 1.
v FZOw,z pyEr Yy v—c

The required calculations can all be carried out with the aid of the program ITSM.
The mean squared errors are computed from the large-sample approximation (6.5.13)
if the fitted model is invertible. If the fitted model is not invertible, ITSM computes the
mean squared errors by converting the model to the equivalent (in terms of Gaussian
likelihood) invertible model and then using (6.5.13).

Monthly Accidental Deaths

Continuing with Example 6.5.4, we next use ITSM to predict six future values of
the Accidental Deaths series using the fitted models (6.5.8) and (6.5.9). First fit the
desired model as described in Example 6.5.4 or enter the data and model directly
by opening the file DEATHS.TSM, differencing at lags 12 and 1, subtracting the
mean, and then entering the MA(13) coefficients and white noise variance using the
option Model >Specify.Select Forecasting>ARMA,and you will see the ARMA
Forecast dialog box. Enter 6 for the number of predicted values required. You will
notice that the default options in the dialog box are set to generate predictors of the
original series by reversing the transformations applied to the data. If for some reason
you wish to predict the transformed data, these check marks can be removed. If you
wish to include prediction bounds in the graph of the predictors, check the appropriate
box and specify the desired coefficient (e.g., 95 %). Click OK, and you will see a
graph of the data with the six predicted values appended. For numerical values of
the predictors and prediction bounds, right-click on the graph and then on Info. The
prediction bounds are computed under the assumption that the white noise sequence in
the ARMA model for the transformed data is Gaussian. Table 6.1 shows the predictors
and standard deviations of the prediction errors under both models (6.5.8) and (6.5.9)
for the Accidental Deaths series.

O
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6.6 Regression with ARMA Errors

6.6.1 OLS and GLS Estimation

In standard linear regression, the errors (or deviations of the observations from the
regression function) are assumed to be independent and identically distributed. In
many applications of regression analysis, however, this assumption is clearly
violated, as can be seen by examination of the residuals from the fitted regression
and their sample autocorrelations. It is often more appropriate to assume that the
errors are observations of a zero-mean second-order stationary process. Since many
autocorrelation functions can be well approximated by the autocorrelation function of
a suitably chosen ARMA(p, g) process, it is of particular interest to consider the model

Yt:X;ﬁ+W[, l=1,...,l’l, (6.6.1)
or in matrix notation,

Y=XB+W, (6.6.2)
where Y = (Yq,...,Y,) is the vector of observations at times t = 1,...,n, X
is the design matrix whose tth row, X, = (x;,...,Xy), consists of the values of
the explanatory variables at time ¢, 3 = (8, ..., 3y is the vector of regression
coefficients, and the components of W = (Wy, ..., W,)’ are values of a causal zero-
mean ARMA( p, g) process satisfying

p(BYW, = 0(B)Z,, {Z}~ WN(0,07). (6.6.3)

The model (6.6.1) arises naturally in trend estimation for time series data. For
example, the explanatory variables x;; = 1,x» = ¢, and x3 = #* can be used to
estimate a quadratic trend, and the variables x,; = 1, x, = cos(wt), and x,;3 = sin(wt)
can be used to estimate a sinusoidal trend with frequency w. The columns of X are
not necessarily simple functions of ¢ as in these two examples. Any specified column
of relevant variables, e.g., temperatures at times ¢t = 1, ..., n, can be included in the
design matrix X, in which case the regression is conditional on the observed values of
the variables included in the matrix. A

The ordinary least squares (OLS) estimator of 3 is the value, Bors, Which
minimizes the sum of squares

n
Y-XB)(Y-XB) =) (¥,—x0)"
=1

Equating to zero the partial derivatives with respect to each component of 3 and
assuming (as we shall) that X'X is nonsingular, we find that

Bos = X'X)'X'Y. (6.6.4)

(If X’X is singular, ,BOLS is not uniquely determined but still satisfies (6.6.4) with
(X’X)~! any generalized inverse of X'X.) The OLS estimate also maximizes the
likelihood of the observations when the errors Wy, ..., W, are iid and Gaussian. If
the design matrix X is nonrandom, then even when the errors are non-Gaussian and
dependent, the OLS estimator is unbiased (i.e., E (BOLS) = @) and its covariance
matrix is

Cov(Bows) = (X'X)™' XT,X (X'X) ™", (6.6.5)

where I', = F (WW’) is the covariance matrix of W.
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The generalized least squares (GLS) estimator of 3 is the value ,E‘}GLS that
minimizes the weighted sum of squares

Y -XB)T (Y -XB). (6.6.6)

Differentiating partially with respect to each component of 3 and setting the deriva-
tives equal to zero, we find that

Bors = (X/F,ZIX)i

If the design matrix X is nonrandom, the GLS estimator is unbiased and has covariance
matrix

'xToly. (6.6.7)

Cov (Bavs) = (XT;'X) " (6.6.8)
It can be shown that the GLS estimator is the best linear unbiaseAd estimator of 3, i.e.,
for any k-dimensional vector ¢ and for any unbiased estimator 3 of 3 that is a linear
function of the observations Y, ..., Y,,

Var (C’BGL5> < Var <c’,[:}> )

In this sense the GLS estimator is therefore superior to the OLS estimator. However,
it can be computed only if ¢ and 6 are known.

Let V(¢, ) denote the matrix o ~2I", and let T'(¢, @) be any square root of V!
(i.e., a matrix such that 7'T = V~!). Then we can multiply each side of (6.6.2) by T
to obtain

TY = TXB + TW, (6.6.9)

aregression equation with coefficient vector 3, data vector 7Y, design matrix 7X, and
error vector TW. Since the latter has uncorrelated, zero-mean components, each with
variance o2, the best linear estimator of 3 in terms of TY (which is clearly the same
as the best linear estimator of 3 in terms of Y, i.e., BGLS) can be obtained by applying
OLS estimation to the transformed regression equation (6.6.9). This gives

Bos = (X'T'TX)” X'T'TY, (6.6.10)

which is clearly the same as (6.6.7). Cochran and Orcutt (1949) pointed out that if {W,}
is an AR( p) process satisfying

S$BW, = Z, (Z)~WN(0,0?),

then application of ¢ (B) to each side of the regression equations (6.6.1) transforms
them into regression equations with uncorrelated, zero-mean, constant-variance errors,
so that ordinary least squares can again be used to compute best linear unbiased
estimates of the components of 3 in terms of ¥ = ¢(B)Y;, t = p+ 1, ..., n. This
approach eliminates the need to compute the matrix 7 but suffers from the drawback
that Y* does not contain all the information in Y. Cochrane and Orcutt’s transformation
can be improved, and at the same generalized to ARMA errors, as follows.

Instead of applying the operator ¢ (B) to each side of the regression equations
(6.6.1), we multiply each side of equation (6.6.2) by the matrix 7' (¢, ) that maps {W,}
into the residuals [see (5.3.1)] of {W,} from the ARMA model (6.6.3). We have already
seen how to calculate these residuals using the innovations algorithm in Section 3.3.
To see that T is a square root of the matrix V as defined in the previous paragraph, we
simply recall that the residuals are uncorrelated with zero mean and variance o2, so
that

Cov(TW) = TT,,T' = oI,
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where [ is the n x n identity matrix. Hence

T'T=0T,'=Vv"
GLS estimation of 3 can therefore be carried out by multiplying each side of (6.6.2) by
T and applying ordinary least squares to the transformed regression model. It remains
only to compute 7Y and T7X.

Any data vectord = (dy, ..., d,)’ can be left-multiplied by 7 simply by reading it
into ITSM, entering the model (6.6.3), and pressing the green button labeled RES,
which plots the residuals. (The calculations are performed using the innovations
algorithm as described in Section 3.3.) The GLS estimator BGLS is computed as
follows. The data vector Y is left-multiplied by T to generate the transformed data

vector Y*, and each column of the design matrix X is left-multiplied by T to generate
the corresponding column of the transformed design matrix X*. Then

Bos = (X*'X*)AX*'Y*. (6.6.11)

The calculations of Y*, X*, and hence of BGLS, are all carried out by the program ITSM
in the option Regression>Estimation>Generalized LS.

6.6.2 ML Estimation

If (as is usually the case) the parameters of the ARMA(p, g) model for the errors
are unknown, they can be estimated together with the regression coefficients by
maximizing the Gaussian likelihood

L(B.¢,0,0%) = m) ™" *(detT,) ™" exp {—%(Y —XB) T, (Y — Xﬁ)} ,

where T, (¢, 0, 02) is the covariance matrix of W = Y — X(3. Since {W,} is an
ARMA(p, g) process with parameters (d), 9, 02), the maximum likelihood estimators

,@, dA), and @ are found (as in Section 5.2) by minimizing

0(B.¢.0)=In(n"'S(B.¢.0)) +n' > Inr_y, (6.6.12)
t=1

where

n R 2
$B.6.0) = (W= W) /r,
=1

W, is the best one-step predictor of W;, and 1,107 is its mean squared error. The func-
tion £(3, ¢, @) can be expressed in terms of the observations {Y;} and the parameters 3,
¢, and 0 using the innovations algorithm (see Section 3.3) and minimized numerically
to give the maximum likelihood estimators, 3, ¢, and 8. The maximum likelihood
estimator of o2 is then given, as in Section 5.2, by 6% = § (B, b, é) /n.

An extension of an iterative scheme, proposed by Cochran and Orcutt (1949) for
the case g = 0, simplifies the minimization considerably. It is based on the observation
that for fixed ¢ and 0, the value of 3 that minimizes £(3, ¢, 0) is BgLs(¢p, 8), which

can be computed algebraically from (6.6.11) instead of by searching numerically for
the minimizing value. The scheme is as follows.

(i) Compute BOLS and the estimated residuals Y, — X;BOLS, t=1,...,n
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(ii) Fit an ARMA(p.q) model by maximum Gaussian likelihood to the estimated
residuals.

(iii) For the fitted ARMA model compute the corresponding estimator ,@GLS from
(6.6.11). .

(iv) Compute the residuals Y; — x;8grs, t = 1, ..., n, and return to (ii), stopping
when the estimators have stabilized.

If {W,} is a causal and invertible ARMA process, then under mild conditions on
the explanatory variables x,, the maximum likelihood estimates are asymptotically
multivariate normal (see Fuller 1976). In addition, the estimated regression coefficients
are asymptotically independent of the estimated ARMA parameters.

The large-sample covariance matrix of the ARMA parameter estimators, suitably
normalized, has a complicated form that involves both the regression variables x, and
the covariance function of {W,}. It is therefore convenient to estimate the covariance
matrix as —H ™!, where H is the Hessian matrix of the observed log-likelihood
evaluated at its maximum.

The OLS, GLS, and maximum likelihood estimators of the regression coefficients
all have the same asymptotic covariance matrix, so in this sense the dependence does
not play a major role. However, the asymptotic covariance of both the OLS and GLS
estimators can be very inaccurate if the appropriate covariance matrix [, is not used in
the expressions (6.6.5) and (6.6.8). This point is illustrated in the following examples.

Remark 1. The use of the innovations algorithm for GLS and ML estimation extends
to regression with ARIMA errors (see Example 6.6.3 below) and FARIMA errors
(FARIMA processes are defined in Section 10.5). O

The Overshort Data
The analysis of the overshort data in Example 3.2.8 suggested the model
Y, =B8+W,

where — (3 is interpreted as the daily leakage from the underground storage tank and
{W,} is the MA(1) process

W, =Z+0Z_1, {Z}~WN(0,0%).

(Here k = 1 and x;; = 1.) The OLS estimate of 8 is simply the sample mean 30L5 =
Y, = —4.035. Under the assumption that {W,} is iid noise, the estimated variance
of the OLS estimator of 8 is ,(0)/57 = 59.92. However, since this estimate of the
variance fails to take dependence into account, it is not reliable.

To find maximum Gaussian likelihood estimates of B and the parame-
ters of {W,} using ITSM, open the file OSHORTS.TSM, select the option
Regression>Specify and check the box marked Include intercept
term only. Then press the blue GLS button and you will see the estimated value
of B. (This is in fact the same as the OLS estimator since the default model in ITSM
is WN(0,1).) Then select Model>Estimation>Autofit and press Start. The
autofit option selects the minimum AICC model for the residuals,

W, =2, —0.8182,_;, {Z;} ~ WN(0,2041), (6.6.13)

and displays the estimated MA coefficient 51(0) = —0.818 and the corresponding GLS

estimate Bélﬁs = —4.745, with a standard error of 1.188, in the Regression

estimates window. (If we reestimate the variance of the OLS estimator, using
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Table 6.2

Example 6.6.2

(6.6.5) with I's; computed from the model (6.6.13), we obtain the value 2.214, a drastic
reduction from the value 59.92 obtained when dependence is ignored. For a positively
correlated time series, ignoring the dependence would lead to underestimation of the
variance.)

Pressing the blue MLE button will reestimate the MA parameters using the
residuals from the updated regression and at the same time reestimate the regression
coefficient, printing the new parameters in the Regression estimates window.
After this operation has been repeated several times, the parameters will stabilize, as
shown in Table 6.2. Estimated 95 % confidence bounds for § using the GLS estimate
are —4.75 £ 1.96(1.408)'/2 = (—7.07, —2.43), strongly suggesting that the storage
tank has a leak. Such a conclusion would not have been reached without taking into
account the dependence in the data.

O

Estimates of B and 6,
for the overshort data of
Example 6.6.1

Iteration i (0] 31([)

0 0 —4.035
1 -0.818 —4.745
2 —-0.848 —4.780
3 —-0.848 —4.780

The Lake Data

In Examples 5.2.4 and 5.5.2 we found maximum likelihood ARMA(1,1) and AR(2)
models for the mean-corrected lake data. Now let us consider fitting a linear trend to
the data with AR(2) noise. The choice of an AR(2) model was suggested by an analysis
of the residuals obtained after removing a linear trend from the data using OLS. Our
model now takes the form

Y, = ,30 + ,Blt'" Wi,
where {W,} is the AR(2) process satisfying
Wi =g Wii + W0 + Z, {Z) ~ WN(0,07).

From Example 1.3.5, we find that the OLS estimate of 3 is ﬁOLS=(10.2O2, —0.0242)’.
If we ignore the correlation structure of the noise, the estimated covariance matrix I,
of W is p (0)I (where 1 is the identity matrix). The corresponding estimated covariance
matrix of ,BOLS is (from (6.6.5))

n -1
n YLt [0.07203 —0.00110
D |1 =0.00110 0.00002 |-

(6.6.14)

%@@M”z%@[

However, the estimated model for the noise process, found by fitting an AR(2) model
to the residuals Y, — B¢ Xy, iS

W, = 1.008W,_y — 0.295W,_» + Z;, {Z;} ~ WN(O0, 0.4571).
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Table 6.3

Example 6.6.3

Estimates of 3 and ¢ for the lake data
after 3 iterations

Iteration i ¢3§i) dA)g) ﬁ%i) 350
0 0 0 10.20 —0.0242
1 1.008 —0.295 10.09 -0.0216
2 1.005 —-0.291 10.09 -0.0216

Assuming that this is the true model for {W,}, the GLS estimate is found to be
(10.091, —0.0216)’, in close agreement with the OLS estimate. The estimated covari-
ance matrices for the OLS and GLS estimates are given by

A [ 0.22177 —0.00335]
C =
oY (ﬂOLS> | —0.00335 0.00007 |
and
A [ 0.21392 —0.00321]
va(ﬁmﬁ>"_—aomu1 0.00006 |

Notice how the estimated variances of the OLS and GLS estimators are nearly three
times the magnitude of the corresponding variance estimates of the OLS calculated
under the independence assumption [see (6.6.14)]. Estimated 95 % confidence bounds
for the slope B, using the GLS estimate are —0.021641.96(0.00006)'/? = —0.0216+
.0048, indicating a significant decreasing trend in the level of Lake Huron during the
years 1875-1972.

The iterative procedure described above was used to produce maximum likelihood
estimates of the parameters. The calculations using ITSM are analogous to those
in Example 6.6.1. The results from each iteration are summarized in Table 6.3.
As in Example 6.6.1, the convergence of the estimates is very rapid.

O

Seat-Belt Legislation; SBL.TSM

Figure 6-18 shows the numbers of monthly deaths and serious injuries Y, ¢t =
1,...,120, on UK roads for 10 years beginning in January 1975. They are filed
as SBL.TSM. Seat-belt legislation was introduced in February 1983 in the hope of
reducing the mean number of monthly “deaths and serious injuries,” (from t = 99
onwards). In order to study whether or not there was a drop in mean from that time
onwards, we consider the regression,

Y,=a+bf()+W, t=1,...,120, (6.6.15)

where f; = Ofor 1 <t < 98, and f; = 1 for t > 99. The seat-belt legislation
will be considered effective if the estimated value of the regression coefficient b
is significantly negative. This problem also falls under the heading of intervention
analysis (see Section 11.2).

OLS regression based on the model (6.6.15) suggests that the error sequence {W,}
is highly correlated with a strong seasonal component of period 12. (To do the regres-
sion using ITSM open the file SBL.TSM, select Regression>Specify, check
only Include intercept term and Include auxiliary variables,
press the Browse button, and select the file SBLIN.TSM, which contains the
function f; of (6.6.15) and enter 1 for the number of columns. Then select the
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option Regression>Estimation>Generalized LS. The estimates of the
coefficients a and b are displayed in the Regression estimates window, and
the data become the estimates of the residuals {W,}.) The graphs of the data and
sample ACF clearly suggest a strong seasonal component with period 12. In order to
transform the model (6.6.15) into one with stationary residuals, we therefore consider
the differenced data X; = Y; — Y,_;,, which satisfy

Xt:bgl+Nt’ = 13,..., 120, (6.6.16)

where g, = 1 for 98 < ¢ < 110, g, = 0 otherwise, and {N, = W, — W,_15} is a
stationary sequence to be represented by a suitably chosen ARMA model. The series
{X;} is contained in the file SBLD.TSM, and the function g, is contained in the file
SBLDIN.TSM.

The next step is to perform ordinary least squares regression of X; on g, following
steps analogous to those of the previous paragraph (but this time checking only the
box marked Include auxiliary variables in the Regression Trend
Function dialog box) and again using the option Regression>Estimation>
Generalized LS or pressing the blue GLS button. The model

X, = —346.92g, + N,, (6.6.17)

is then displayed in the Regression estimates window together with the
assumed noise model (white noise in this case). Inspection of the sample ACF
of the residuals suggests an MA(13) or AR(13) model for {A,}. Fitting AR
and MA models of order up to 13 (with no mean-correction) using the option
Model>Estimation>Autofit gives an MA(12) model as the minimum AICC
fit for the residuals. Once this model has been fitted, the model in the Regression
estimates window is automatically updated to

X, = —328.45g, + N, (6.6.18)

with the fitted MA(12) model for the residuals also displayed. After several iterations
(each iteration is performed by pressing the MLE button) we arrive at the model

X, = —328.45g, + N,, (6.6.19)
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Figure 6-19
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with
N; = Z,40.219Z,_,+0.098Z,_,+0.031Z,_3+0.064Z,_4+0.069Z,_s+0.111Z;_¢
+0.081Z;_7 + 0.057Z,_3+0.092Z;, _¢ — 0.028Z;_19+0.183Z,_11—0.627Z;_1,,

where {Z;} ~ WN(0, 12, 581). The estimated standard deviation of the regression
coefficient estimator is 49.41, so the estimated coefficient, —328.45, is very signifi-
cantly negative, indicating the effectiveness of the legislation. The differenced data are

shown in Figure 6-19 with the fitted regression function.
O

6.1 Suppose that {X,} is an ARIMA(p,d, q) process satisfying the difference
equations

¢(B)(1 —B)'X, =0(B)Z, {Z}~WN(0,07).

Show that these difference equations are also satisfied by the process W, = X, +
Ao+ At + -+ Ay 11", where Ay, ..., A _; are arbitrary random variables.

6.2 Verify the representation given in (6.3.4).

6.3 Test the data in Example 6.3.1 for the presence of a unit root in an AR(2) model
using the augmented Dickey—Fuller test.

6.4 Apply the augmented Dickey—Fuller test to the levels of Lake Huron data
(LAKE.TSM). Perform two analyses assuming AR(1) and AR(2) models.

6.5 If {Y;} is a causal ARMA process (with zero mean) and if X, is a random
variable with finite second moment such that X is uncorrelated with Y, for each
t = 1,2,..., show that the best linear predictor of Y, ;in terms of 1,
Xo, Y1, ..., Y, is the same as the best linear predictor of Y,.; in terms of
1,Yy,...,Y,.



192

Chapter 6

Nonstationary and Seasonal Time Series Models

6.6

6.7

6.8

6.9

6.10

6.11

6.12
6.13

Let {X;} be the ARIMA(2,1,0) process satisfying
(1-0.8B+0.25B*) VX, =Z,, {Z}~ WN(0, 1).

(a) Determine the forecast function g(h) = P,X, 1, for h > 0.
(b) Assuming that #n is large, compute anz (h)yforh=1,...,5.

Use a text editor to create a new data set ASHORT.TSM that consists of the data

in AIRPASS.TSM with the last 12 values deleted. Use ITSM to find an ARIMA

model for the logarithms of the data in ASHORT.TSM. Your analysis should

include

(a) alogical explanation of the steps taken to find the chosen model,

(b) approximate 95 % bounds for the components of ¢ and 0,

(¢) an examination of the residuals to check for whiteness as described in
Section 1.6,

(d) a graph of the series ASHORT.TSM showing forecasts of the next 12 values
and 95 % prediction bounds for the forecasts,

(e) numerical values for the 12-step ahead forecast and the corresponding 95 %
prediction bounds,

(f) a table of the actual forecast errors, i.e.,, the true value (deleted from
AIRPASS.TSM) minus the forecast value, for each of the 12 forecasts.
Does the last value of AIRPASS.TSM lie within the corresponding 95 % pre-

diction bounds?

Repeat Problem 6.7, but instead of differencing, apply the classical decomposi-
tion method to the logarithms of the data in ASHORT.TSM by deseasonalizing,
subtracting a quadratic trend, and then finding an appropriate ARMA model
for the residuals. Compare the 12 forecast errors found from this approach with
those found in Problem 6.7.

Repeat Problem 6.7 for the series BEER.TSM, deleting the last 12 values
to create a file named BSHORT.TSM.

Repeat Problem 6.8 for the series BEER.TSM and the shortened series
BSHORT.TSM.

A time series {X,} is differenced at lag 12, then at lag 1 to produce a zero-mean
series {Y;} with the following sample ACF:

p(12)) =~ (0.8)/, j=0,+1,42,...,
p(12j £ 1) ~ (0.4)(0.8)/, j=0,+1,42,...,
o(h) ~0, otherwise,

and y (0) = 25.

(a) Suggest a SARIMA model for {X;} specifying all parameters.

(b) For large n, express the one- and twelve-step linear predictors P, X, and
P.X, 1pinterms of X;, t = —12, —11,...,n,and ¥, — 17,, t=1,...,n.

(c) Find the mean squared errors of the predictors in (b).

Use ITSM to verify the calculations of Examples 6.6.1-6.6.3.

The file TUNDRA.TSM contains the average maximum temperature over the
month of February for the years 1895-1993 in an area of the USA whose
vegetation is characterized as tundra.
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(a) Fit a straight line to the data using OLS. Is the slope of the line significantly
different from zero?

(b) Find an appropriate ARMA model to the residuals from the OLS fit in (a).

(c) Calculate the MLE estimates of the intercept and the slope of the line and
the ARMA parameters in (a). Is the slope of the line significantly different
from zero?

(d) Use your model to forecast the average maximum temperature for the years
1994-2004.



Time Series Models
for Financial Data

7.1 Historical Overview

7.2 GARCH Models

7.3 Modified GARCH Processes

7.4 Stochastic Volatility Models

7.5 Continuous-Time Models

7.6 An Introduction to Option Pricing

In this chapter we discuss some of the time series models which have been found useful
in the analysis of financial data. These include both discrete-time and continuous-
time models, the latter being used widely, following the celebrated work of Black,
Merton and Scholes, for the pricing of stock options. The closing price on trading
day t, say P, of a particular stock or stock-price index, typically appears to be non-
stationary while the log asset price, X; := log(P;), has observed sample-paths like
those of a random walk with stationary uncorrelated increments, i.e., the differenced
log asset price, Z, := X; — X,_1, known as the log return (or simply return) for
day t, has sample-paths resembling those of white noise. Although the sequence Z,
appears to be white noise, there is strong evidence to suggest that it is not independent
white noise. Much of the analysis of financial time series is devoted to representing
and exploiting this dependence, which is not visible in the sample autocorrelation
function of {Z,}. The continuous time analogue of a random walk with independent
and identically distributed increments is known as a Lévy process, the most familiar
examples of which are the Poisson process and Brownian motion. Lévy processes
play a key role in the continuous-time modeling of financial data, both as models
for the log asset price itself and as building blocks for more complex models. We
give a brief introduction to these processes and some of the continuous-time models
constructed from them. Finally we consider the pricing of European stock options
using the geometric Brownian motion model for stock prices, a model which, in spite
of its limitations, has been found useful in practice.
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7.1

Historical Overview

For more than 30 years now, discrete-time models (including stochastic volatility,
ARCH, GARCH and their many generalizations) have been developed to reflect the
so-called stylized features of financial time series. These properties, which include tail
heaviness, asymmetry, volatility clustering and serial dependence without correlation,
cannot be captured with traditional linear time series models such as the ARMA
models considered earlier in this book. If P; denotes the price of a stock or other
financial asset at time ¢, ¢ € Z, then the series of log returns, {Z; := log P, —log P,_1},
is typically modeled as a stationary time series. An ARMA model for the series {Z,}
would have the property that the conditional variance h; of Z, given {Z;, s < t} is
independent of ¢ and of {Z;,s < t}. However even a cursory inspection of most
empirical log return series (see e.g., Figure 7-4) strongly suggests that this is not
the case in practice. The fundamental idea of the ARCH (autoregressive conditional
heteroscedasticity) model (Engle 1982) is to incorporate the sequence {/,} into the
model by postulating that

Z, = \/hye,, where {e,} ~ IID N(0, 1)

and A, (known as the volatility) is related to the past values of th via a relation of the
form,

p
ht =+ Z(X,’thii,
i=1
for some positive integer p, where o9 > Oand o; > 0, i = 1, ..., p. The GARCH
(generalized ARCH) model of Bollerslev (1986) postulates a more general relation,

p q
hy = ag + Z izl + Z Bihi—i,
i=1 i=1

withag > 0,0 > 0,i = 1,...,p,and §; > 0,i = 1, ..., q. These models have
been studied intensively since their introduction and a variety of parameter estimation
techniques have been developed. They will be discussed in Section 7.2 and some of
their extensions in Section 7.3.

An alternative approach to modeling the changing variability of log returns, due
to Taylor (1982), is to suppose that Z, = +/he;, where {¢;} ~ I1ID(0, 1) and the
volatility sequence {/,} is independent of {e,}. (Taylor originally allowed {e;} to be
an autoregression, but it is now customary to use the more restrictive definition just
given.) A critical difference from the ARCH and GARCH models is the fact that the
conditional distribution of &, given {h, s < t} is independent of {e;, s < t}. A widely
used special case of this model is the so-called log-normal stochastic volatility (SV)
model in which {e;} ~ IID N(O, 1), Inh, = yo + y1 Inh,_; + n;, {n;} ~ IID N(0, 0%)
and {n,} and {e,} are independent. We shall discuss this model in Section 7.4.

Continuous-time models for financial time series have a long history, going back
at least to Bachelier (1900), who used Brownian motion to represent the prices
{P(1), t = 0} of a stock in the Paris stock exchange. This model had the unfortunate
feature of permitting negative stock prices, a shortcoming which was eliminated in
the geometric Brownian motion model of Samuelson (1965), according to which P(¢)
satisfies an It6 stochastic differential equation of the form,

dP(t) = puP®t) dt + o P(r) dB(1),
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where 4 € R, o0 > 0 and B is standard Brownian motion. For any fixed positive value
of P(0) the solution (see Section 7.5.2 and Appendix D.4) is

P(t) = P(0)exp [(u — 0%/t + o B(1)], t > 0,

so that the log asset price, X (f) := log P(t), is Brownian motion and the log return over
the time-interval (¢, ¢t + A) is

Xt+A)-X1) =(n— %GZ)A +o0(B(t+ A) — B(1)).

For disjoint intervals of length A the log returns are therefore independent normally
distributed random variables with mean (u—o?/2) A and variance o> A. The normality
is a conclusion which can easily be checked against observed log returns, and it is
found that although the observed values are approximately normally distributed for
intervals A greater than 1 day, the deviations from normality are substantial for shorter
time intervals. This is one of the reasons for developing the more realistic models
described in Section 7.5. The parameter o is called the volatility parameter of the
geometric Brownian motion model and plays a key role in the celebrated option pricing
results (see Section 7.6) developed for this model by Black, Scholes and Merton,
earning the Nobel Economics Prize for Merton and Scholes in 1997 (unfortunately
Black died before the award was made). These results inspired an explosion of interest,
not only in the pricing of more complicated financial derivatives, but also in the
development of new continuous-time models which, like the discrete-time ARCH,
GARCH and stochastic volatility models, better reflect the observed properties of
financial time series.

7.2 GARCH Models

For modeling changing volatility as discussed above, Engle (1982) introduced the
ARCH(p) process {Z,} as a stationary solution of the equations

Z, = e, {e,} ~ TID N(O, 1), (7.2.1)
where /; is the (positive) function of {Z,, s < t}, defined by
P
ho=ay+ Y oz (7.2.2)
i=1
with g > Oand o; > 0,j = 1,...,p. The name ARCH signifies autoregressive

conditional heteroscedasticity and /4, is the conditional variance of Z; given {Z;, s < t}.
The simplest such process is the ARCH(1) process. In this case the recursions
(7.2.1) and (7.2.2) give
77 = ape? + a 7% e’
= ozoet2 + (xl(xoetzetz_l + athz_zetzetz_l

n
_ } : J 2.2 2 n+1-2 2 2 2
= Qo apee e +o Zt—n—let €1 €y
j=0
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If ¢y < 1 and {Z,} is stationary and causal (i.e., Z, is a function of {ey, s < t}), then
the last term has expectation o ! EZ? and converges to zero as n — o0o. The first term
converges as n — o0 since it is non-decreasing in n and its expected value is bounded
above by «(/(1 — «;). Hence

(o)
7P =a Za{etzef_l e etz_j (7.2.3)
and
EZ} = ap/(1 — ay). (7.2.4)
Since
Zi=¢ |aj |1+ Zalet 1 _. , (7.2.5)

it is clear that {Z,} is strictly stationary and hence, since EZ> < oo, also stationary
in the weak sense. We have now established the following result.

Solution of the ARCH(1) Equations:
If «; < 1, the unique causal stationary solution of the ARCH(1) equations is given
by (7.2.5). It has the properties

E(Z) = E(E(Z|es, s < 1) =0,
Var(Z,) = ap/(1 — 1),
and

E(Z1Z) = E(E(Zi1nZiles, s < t+h)) = 0forh > 0.

Thus the ARCH(1) process with o; < 1 is strictly stationary white noise. However,
it is not an iid sequence, since from (7.2.1) and (7.2.2),

E(Z}Zi-1) = (a0 + a1 Z2 VE(eHZi—1) = ap + a1 Z}]

This also shows that {Z,} is not Gaussian, since strictly stationary Gaussian white noise
is necessarily iid. From (7.2.5) it is clear that the distribution of Z; is symmetric, i.e.,
that Z, and —Z, have the same distribution. From (7.2.3) it is easy to calculate £ (Zf‘)
(Problem 7.1) and hence to show that £ (Zf) is finite if and only if 30(% < 1. More
generally (see Engle 1982), it can be shown that for every «; in the interval (0, 1),
E (ZZI‘) = oo for some positive integer k. This indicates the “heavy-tailed” nature of
the marginal distribution of Z,. If EZ} < oo, the squared process Y, = Z2 has the same
ACF as the AR(1) process W; = a1 W,_| + ¢,, a result that extends also to ARCH(p)
processes (see Problem 7.3).

The ARCH(p) process is conditionally Gaussian, in the sense that for given values
of {Z,,s = t—1,t—2,...,t — p}, Z, is Gaussian with known distribution. This
makes it easy to write down the likelihood of Z, 1, ..., Z, conditional on {Z;, ..., Z,}
and hence, by numerical maximization, to compute conditional maximum likelihood
estimates of the parameters. For example, the conditional likelihood of observations
{z2,...,z,} of the ARCH(1) process given Z; = z; is
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Example 7.2.1  An ARCH(1) Series

Figure 7-1 shows a realization of the ARCH(1) process with ¢p = 1 and &y = 0.5. The
graph of the realization and the sample autocorrelation function shown in Figure 7-2
suggest that the process is white noise. This conclusion is correct from a second-order
point of view.

However, the fact that the series is not a realization of iid noise is very strongly
indicated by Figure 7-3, which shows the sample autocorrelation function of the series
{th} (The sample ACF of {|Z;|} and that of {th} can be plotted in ITSM by selecting
Statistics>Residual Analysis>ACF abs values/Squares.)
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It is instructive to apply the Ljung-Box and McLeod-Li portmanteau tests for
white noise to this series (see Section 1.6). To do this using ITSM, open the file
ARCH.TSM, and then select Statistics>Residual Analysis>Tests of
Randomness. We find (with # = 20) that the Ljung-Box test (and all the others
except for the McLeod-Li test) are passed comfortably at level 0.05. However,
the McLeod-Li test gives a p-value of 0 to five decimal places, clearly reject-
ing the hypothesis that the series is iid.

O

The GARCH(p, q) process (see Bollerslev 1986) is a generalization of the
ARCH(p) process in which the variance equation (7.2.2) is replaced by

P q
hy = ao + Z OliZ,Z_i + Z Bihi—;, (7.2.6)
i=1 j=1

withag > 0and ), B, >0,/ =1,2,....

In the analysis of empirical financial data such as percentage daily stock returns
(defined as 100 In(P,/P,_;), where P, is the closing price on trading day ), it is usually
found that better fits to the data are obtained by relaxing the Gaussian assumption in
(7.2.1) and supposing instead that the distribution of Z, given {Z,, s < t} has a heavier-
tailed zero-mean distribution such as Student’s z-distribution. To incorporate such
distributions we can define a general GARCH(p, g) process as a stationary process
{Z;} satisfying (7.2.6) and the generalized form of (7.2.1),

Z; = /Eet, {e;} ~1ID(0, 1). (7.2.7)
For modeling purposes it is usually assumed in addition that either

e~ N(, 1), (7.2.8)
(as in (7.2.1)) or that

e;~t, VvV>2, (7.2.9)
v—2
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where ¢, denotes Student’s ¢-distribution with v degrees of freedom. (The scale factor
on the left of (7.2.9) is introduced to make the variance of e, equal to 1.) Other
distributions for e, can also be used.

One of the striking features of stock return data that is reflected by GARCH models
is the “persistence of volatility,” or the phenomenon that large (small) fluctuations in
the data tend to be followed by fluctuations of comparable magnitude. GARCH models
reflect this by incorporating correlation in the sequence {%,} of conditional variances.

Fitting GARCH Models to Stock Data

The top graph in Figure 7-4 shows the percentage daily returns of the Dow Jones
Industrial Index for the period July 1st, 1997, through April 9th, 1999, contained
in the file E1032.TSM. The graph suggests that there are sustained periods of both
high volatility (in October, 1997, and August, 1998) and of low volatility. The sample
autocorrelation function of this series, like that in Example 7.2.1, has very small values,
however the sample autocorrelations of the absolute values and squares of the data (like
those in Example 7.2.1) are significantly different from zero, indicating dependence in
spite of the lack of autocorrelation. (The sample autocorrelations of the absolute values
and squares of the residuals (or of the data if no transformations have been made and
no model fitted) can be seen by clicking on the third green button at the top of the
ITSM window.) These properties suggest that an ARCH or GARCH model might be
appropriate for this series.

g

The model

Y=a+ 72, (7.2.10)

where {Z,} is the GARCH(p, g) process defined by (7.2.6)—(7.2.8), can be fitted using
ITSM as follows. Open the project E1032. TSM and click on the red button labeled
GAR at the top of the ITSM screen. In the resulting dialog box enter the desired values
of p and ¢, e.g., 1 and 1 if you wish to fit a GARCH(1,1) model. You may also enter
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initial values for the coefficients «y, ..., @), and By, ..., B, or alternatively use the
default values specified by the program. Make sure that Use normal noise is
selected, click on OK and then click on the red MLE button. You will be advised to
subtract the sample mean (unless you wish to assume that the parameter a in (7.2.10)
is zero). If you subtract the sample mean it will be used as the estimate of a in
the model (7.2.10). The GARCH Maximum Likelihood Estimationbox will
then open. When you click on OK the optimization will proceed. Denoting by {Z;}
the (possibly) mean-corrected observations, the GARCH coefficients are estimated

by numerically maximizing the likelihood of ZPH, ..., Z, conditional on the known
values Zi, ..., Z,, and with assumed values O for each Z;, t < 0, and &2 for each A,
t < 0, where 62 is the sample variance of {Zl, . ,Z,}. In other words the program
maximizes
1 (7
Lo, ..., 0, B, ..., = —o| — ), 7.2.11
@00 Bra o B = [ ] ths(at) (7.2.11)
t=p+1

with respect to the coefficients ay, ..., o, and By, ..., B,, where ¢ denotes the stan-
dard normal density, and the standard deviations o; = JE,I > 1, are computed

recursively from (7.2.6) with Z, replaced by Z, and with Z, = 0 and h, = 62 for
t < 0. To find the minimum of —2In(L) it is advisable to repeat the optimization by
clicking on the red MLE button and then on OK several times until the result stabilizes.
It is also useful to try other initial values for ay, ..., ,, and By, ..., B,, to minimize
the chance of finding only a local minimum of —2In(L). Note that the optimization
is constrained so that the estimated parameters are all non-negative with

&1+...+&p+/§1+...+/§q<1, (7.2.12)

and &, > 0. Condition (7.2.12) is necessary and sufficient for the corresponding
GARCH equations to have a causal weakly stationary solution.

Comparison of models with different orders p and ¢ can be made with the aid of
the AICC, which is defined in terms of the conditional likelihood L as

n
n—p

The factor n/(n — p) multiplying the first term on the right has been introduced to
correct for the fact that the number of factors in (7.2.11) is only n — p. Notice also that
the GARCH(p, ¢) model has p + g + 1 coefficients.

The estimated mean is a = 0.0608 and the minimum-AICC GARCH model (with
Gaussian noise) for the residuals, Z, = Y, — a, is found to be the GARCH(1,1) with
estimated parameter values

&y = 0.1300, &, = 0.1266, B, = 0.7922,

and an AICC value [defined by (7.2.13)] of 1469.02. The bottom graph in Figure 7-4
shows the corresponding estimated conditional standard deviations, &;, which clearly
reflect the changing volatility of the series {Y;}. This graph is obtained from ITSM
by clicking on the red SV (stochastic volatility) button. Under the model defined by
(7.2.6)—(7.2.8) and (7.2.10), the GARCH residuals, {Z / 8t}, should be approximately
IID N(0,1). A check on the independence is provided by the sample ACF of the
absolute values and squares of the residuals, which is obtained by clicking on
the fifth red button at the top of the ITSM window. These are found to be not
significantly different from zero. To check for normality, select Garch>Garch
residuals>QQ-Plot (normal).If the model is appropriate the resulting graph
should approximate a straight line through the origin with slope 1. It is found that the

AICC := -2

InL+2@p+qg+2)n/(n—p—q—23). (7.2.13)
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deviations from the expected line are quite large for large values of |Z |, suggesting the
need for a heavier-tailed model, e.g., a model with conditional ¢-distribution as defined
by (7.2.9).

To fit the GARCH model defined by (7.2.6), (7.2.7), (7.2.9) and (7.2.10) (i.e.,
with conditional z-distribution), we proceed in the same way, but with the conditional
likelihood replaced by

L@, ..., op, B1s - B ) = [ ]

t=p+1

L
oV —2 oV —2
(7.2.14)

Maximization is now carried out with respect to the coefficients, ay, . .., ap, Bi,..., By
and the degrees of freedom v of the #-density, t,. The optimization can be performed
using ITSM in exactly the same way as described for the GARCH model with Gaussian
noise, except that the option Use t-distribution for noise should be
checked in each of the dialog boxes where it appears. In order to locate the minimum
of —2In(L) it is often useful to initialize the coefficients of the model by first fitting
a GARCH model with Gaussian noise and then carrying out the optimization using
t-distributed noise.

The estimated mean is a = 0.0608 as before and the minimum-AICC GARCH
model for the residuals, Z = Y, — a, is the GARCH(1,1) with estimated parameter
values

&y =0.1324, & =0.0672, A, =0.8400, »=5.714,

and an AICC value (as in (7.2.13) with g replaced by g + 1) of 1437.89. Thus from
the point of view of AICC, the model with conditional #-distribution is substantially
better than the conditional Gaussian model. The sample ACF of the absolute values
and squares of the GARCH residuals are much the same as those found using Gaussian
noise, but the qq plot (obtained by clicking on the red QQ button and based on the ¢-
distribution with 5.714 degrees of freedom) is closer to the expected line than was the
case for the model with Gaussian noise.

There are many important and interesting theoretical questions associated with
the existence and properties of stationary solutions of the GARCH equations and their
moments and of the sampling properties of these processes. As indicated above, in
maximizing the conditional likelihood, ITSM constrains the GARCH coefficients to
be non-negative and to satisfy the condition (7.2.12) with &, > 0. These conditions
are sufficient for the process defined by the GARCH equations to be stationary. It is
frequently found in practice that the estimated values of «;y,...,a, and By, ..., B,
have a sum which is very close to 1. A GARCH(p,q) model with oy + -+ + o, +
B1 + --- B, = 1is called -lGARCH (or integrated GARCH). Many generalizations
of GARCH processes (ARCH-M, E-GARCH, I-GARCH, T-GARCH, FI-GARCH,
etc., as well as ARMA models driven by GARCH noise, and regression models with
GARCH errors) can now be found in the econometrics literature see Andersen et al.
(2009).

ITSM can be used to fit ARMA and regression models with GARCH noise by
using the procedures described in Example 7.2.2 to fit a GARCH model to the residuals
{Z} from the ARMA (or regression) fit.

Jv (Zf)

Fitting ARMA Models Driven by GARCH Noise

If we open the data file SUNSPOTS.TSM, subtract the mean and use the option
Models>Estimation>Autofit with the default ranges for p and g, we obtain an
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ARMA(3,4) model for the mean-corrected data. Clicking on the second green button
at the top of the ITSM window, we see that the sample ACF of the ARMA residuals
is compatible with iid noise. However the sample autocorrelation functions of the
absolute values and squares of the residuals (obtained by clicking on the third green
button) indicate that they are not independent. To fit a Gaussian GARCH(1,1) model
to the ARMA residuals click on the red GAR button, enter the value 1 for both p and
q and click OK. Then click on the red MLE button, click OK in the dialog box, and
the GARCH ML Estimates window will open, showing the estimated parameter
values. Repeat the steps in the previous sentence two more times and the window will
display the following ARMA(3,4) model for the mean-corrected sunspot data and the
fitted GARCH model for the ARMA noise process {Z;},

Xy = 2.463X, 1 — 2.248X, » + 0.757X, 3 + Z;, — 0.948Z,_,
—0.296Z,_, 4+ 0.313Z,_3 + 0.136Z,_4,

where

Z = \/h7t8t

and
h, = 31.152 + 0.223Z7 | + 0.596h,_;.

The AICC value for the GARCH fit (805.12) should be used for comparing alternative
GARCH models for the ARMA residuals. The AICC value adjusted for the ARMA
fit (821.70) should be used for comparison with alternative ARMA models (with
or without GARCH noise). Standard errors of the estimated coefficients are also
displayed.

Simulation using the fitted ARMA(3,4) model with GARCH (1,1) noise can
be carried out by selecting Garch>Simulate Garch process. If you retain
the settings in the ARMA Simulation dialog box and click OK you will see a simulated
realization of the model for the original data in SUNSPOTS.TSM.

Some useful references for extensions and further properties of GARCH models arDe
Weiss (1986), Engle (1995), Shephard (1996), Gourieroux (1997), Lindner (2009) and
Francq and Zakoian (2010).

7.3 Modified GARCH Processes

The following are so-called “stylized features™ associated with observed time series
of financial returns:

(i) the marginal distributions have heavy tails,
(i) there is persistence of volatility,
(iii) the returns exhibit aggregational Gaussianity,
(iv) there is asymmetry with respect to negative and positive disturbances and
(v) the volatility frequently exhibits long-range dependence.

The properties (i), (ii) and (iii) are well accounted for by the GARCH models of
Section 7.2. Property (iii) means that the sum, S, = Y _, Z, of the daily returns,
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Z; = In P,—In P,_,, is approximately normally distributed if » is large. For the GARCH
model with EZ? = 0% < oo it follows from the martingale central limit theorem (see
e.g. Billingsley (1995)) that n='?(InP, — InPy) = n~'/? Z?:l Z; is asymptotically
N(0, ¢2), in accordance with (iii).

To account for properties (iv) and (v) the EGARCH and FIGARCH models were
devised.

7.3.1 EGARCH Models

To allow negative and positive values of e, in the definition of the GARCH process
to have different impacts on the subsequent volatilities, A;, (s > f), Nelson (1991)
introduced EGARCH models, illustrated in the following simple example.
EGARCH(1,1)

Consider the process {Z;} defined by the equations,

Z, = \/he,, {e} ~ 1D, 1), (7.3.1)
where {¢, := In 4} is the weakly and strictly stationary solution of
b=c+agle—) + b, (7.3.2)

ceR,a; €R, |y <1,
gle) = e; + A(le;] — Eles), (7.3.3)

and e, has a distribution symmetric about zero, i.e., e; < —ey.
The process is defined in terms of ¢, to ensure that i,(= e*) > 0. Equation (7.3.3)
can be rewritten as

(14 X)e; — AE|e;] if e; = 0,

gle) =
' (1 — A)e, — AE|e;| if e, < O.

showing that the function g is piecewise linear with slope (1 + A) on (0, oo) and slope
(1 = X) on (—o00, 0). This asymmetry in g allows ¢,, to respond differently to positive
and negative shocks e,_; of the same magnitude. If . = 0 there is no asymmetry.

When fitting EGARCH models to stock prices it is usually found that the estimated
value of A is negative, corresponding to large negative shocks having greater impact
on volatility than positive ones of the same magnitude.

Properties of {g(e;)}: (1) {g(e,)} is iid.
(i) Eg(e;) = 0.
(iii) Var(g(e,)) = 1+ A*Var(|e,).

(The symmetry of e; implies that ¢, and |e,| — E|e;| are uncorrelated.)

0
More generally, the EGARCH(p, q) process is obtained by replacing the equation
(7.3.2) for [, := In h; by

€ =c+aB)gle) + v (B, (7.3.4)
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where
P ] q )
a(B)=) B, y(B) =) yB.
i=1 i=1

Clearly {¢,}, {h,;} and {Z,} are all strictly stationary and causal if 1 — y (z) is non-zero
for all complex z such that |z| < 1.

Nelson also proposed the use of the generalized error distribution (GED) for e,
with density

vexpl[(—1/2)|x/&]"]

f(x) = S '21+1/”F(1/v) ’

where
2201 (1/v) ) 2
:: T3/v) }

and v > 0. The value of & ensures that Var(e;) = 1 and the parameter v determines
the tail heaviness. For v = 2, ¢, ~N(0, 1). Tail heaviness increases as v decreases.

Properties of the GED: (i) f is symmetric and %le, /&€|" has the gamma distribution
with parameters 1/v and 1 (see Appendix A.1, Example (d)).

(ii) The specified value of £ ensures that Var(e,;) = 1.

/2
k _ T(k+D/v) rd/v)
(1) Ele|* = OO [F(3/U)] .

Inference via Conditional Maximum Likelihood
As in Section 7.2 we initialize the recursions (7.3.1) and (7.3.4) by supposing that

) h, =62% t<O.
(ii) ¢, =0, r<0.

Then hy, e; (= Zi/~/h), hy, ey, ..., can be computed recursively from the
observations Z;, Z,, . . ., and the recursions defining the process.

The conditional likelihood is then computed as

Tl (%)

We therefore need to minimize

—2InL = anlnht + 2”:
=1 t=1

with respect to

2§

v

+2nln < 21/”F(1/v))

2z
v

C AV, U, ey Oy Vs e vy Vg

Since h, is automatically positive, the only constraints in this optimization are the
conditions

v>0
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and

1 — y(2) # 0 for all complex z such that |z] < 1.

7.3.2 FIGARCH and IGARCH Models

To allow for the very slow decay of the sample ACF frequently observed in long daily
squared return series, the FIGARCH (fractionally integrated GARCH) models were
developed. Before introducing them we first give a very brief account of fractionally
integrated ARMA processes. (For more details see Section 11.4 and Brockwell and
Davis (1991), Section 13.2.)

Fractionally Integrated ARMA Processes and “Long Memory”

The autocorrelation function p(-) of an ARMA process at lag i converges rapidly
to zero as i — oo in the sense that there exists r > 1 such that

rh,o(h) — 0, ash — oo.

The fractionally integrated ARMA (or ARFIMA) process of order (p, d, q), where
p and g are non-negative integers and 0 < d < 0.5, is a stationary time series with an
autocorrelation function which for large lags decays at a much slower rate. It is defined
to be the zero-mean stationary solution {X,} of the difference equations

(1 - B¢ (B)X, = 0(B)Z, (7.3.5)

where ¢ (z) and 6 (z) are polynomials of degrees p and ¢ respectively, with no common
zeroes, satisfying

¢(z) #0 and 6(z) # 0 for all complex z such that |z| <1,

{Z;} ~ WN(0, 6%), B is the backward shift operator, and (1 — B)", is defined via the
power series expansion,

Crr—1...r—j+1 .
(1—-2" ::1+Z ( ) j'( J )(—z)f, lz| <1, reR.
j=1 '

The zero-mean stationary process {X,} defined by (7.3.5) has the mean-square conver-
gent MA(oo) representation,

o0
X, =Y Wiz,
Jj=0

where ; is the coefficient of Z in the power series expansion,

V) =0-2"%0)/¢@), |zl <1.

The autocorrelations p(j) of {X;} at lag j and the coefficients ; both converge to zero
at hyperbolic rates as j — o0; specifically, there exist non-zero constants y and § such
that

JN =y and () — 8.
Thus v; and p(j) converge to zero as j — oo at much slower rates than the
corresponding coefficients and autocorrelations of an ARMA process. Consequently
fractionally integrated ARMA processes are said to have “long memory". The spectral
density of {X,} is given by
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2 —iny (2
0 .
) = O_M| _ e—l/\|—2d.
27 |p(e™)|?
The exact Gaussian likelihood L of observations x,, = (xi, ..., x,)" of a fraction-

ally integrated ARMA process is given by
—2In(L) = nln(27) + Indet T, + X, I, 'x,,

where I', = E(X,X/). Calculation and maximization with respect to the parameters
d,¢r,....,¢,01,...,0,and o2 is difficult. It is much easier to maximize the Whittle
approximation Ly (see (11.4.10)), i.e. to minimize

I n (a)j)
27'rf(a)/) ’

—2In(Ly) = nlnQm) + Y nQrf(@) + Y
J J

where I, is the periodogram, and Zj denotes the sum over all nonzero Fourier
frequencies, w; = 2nj/n € (—m,]. The program ITSM allows estimation of
parameters for ARIMA(p, d, g) models either by minimizing —2In(Ly), or by the
slower and more computationally intensive process of minimizing —2 In(L).

Fractionally Integrated GARCH Processes

In order to incorporate long memory into the family of GARCH models, (Baillie
et al. 1996) defined a fractionally integrated GARCH (FIGARCH) process as a causal
strictly stationary solution of the difference equations (7.3.9) and (7.3.10) specified
below.

To motivate the definition, we recall that the GARCH(p, g) process is the causal
stationary solution of the equations,

p q
Z, = \/Eet’ hy = ap + Z Oliztz,,- + Z Bihi—i, (7.3.6)
i=1 i=1
where g > 0, aq,...,a, > 0and By, ..., B, > 0. It follows (Problem 7.5) that
(1 —a(B) — BB)Z = ap+ (1 — B(B)W,, (7.3.7)

where {W, := th—h,} is white noise, «(B) = le a;B' and B(B) = 16'1:1 BiB'. There
is a causal weakly stationary solution for {Z,;} if and only if the zeroes of 1 — «a(z) —
B(z) have absolute value greater than 1 and there is then exactly one such solution
(Bollerslev 1986).

In order to define the IGARCH(p, ¢) (integrated GARCH(p, ¢)) process, Engle
and Bollerslev (1986) supposed that the polynomial (1 — «(z) — B(z)) has a simple
zero at z = 1, and that the other zeroes all fall outside the closed unit disc as in (7.3.6).
Under these assumptions we can write

(I1-5@ —a@)=~10-29¢(),

where ¢ (z) is a polynomial with all of its zeroes outside the unit circle. We then say
[cf. (7.3.6)] that {Z;} is an IGARCH(p, g) process if it satisfies

¢(B)(1 — B)Z? = ag + (1 — B(B)W,, (7.3.8)

with Z, = /he,, W, = Z? — h, and {e,} ~ 1ID(0, 1). Bougerol and Picard (1992)
showed that if the distribution of e, has unbounded support and no atom at zero then
there is a unique strictly stationary causal solution of these equations for {Z,}. The
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solution has the property that EZ> = oo. In practice, for GARCH models fitted to
empirical data, it is often found that « (1)+8(1) & 1, supporting the practical relevance
of the IGARCH model even though EZ? = oco.

Baillie et al. (1996) defined the FIGARCH(p, d, g) process {Z,} to be a causal
strictly stationary solution of the equations,

Z, = \/he,, (1.3.9)
and [cf. (7.3.8)]
¢B)(1 —B)Z> =ag+ (1 — BBYW,, 0<d <1, (7.3.10)

where W, = Z? — h,, {e,} ~ IID(0, 1) and the polynomials ¢(z) and 1 — B(z) are
non-zero for all complex z such that |z| < 1. Substituting W, = th — h;in (7.3.10) we
see that (7.3.10) is equivalent to the equation,

__ % - = _ By 22
h, = +[1=1 =8B 'oB(1 - B)?]Z, (7.3.11)
1 -8
which means that the FIGARCH(p, q) process can be regarded as a special case of the
TARCH(00) process defined by (7.3.9) and

oo
ho=ay+ Y aZ (7.3.12)
j=1

with ap > 0 and Zfil a; = 1. The questions of existence and uniqueness of causal
strictly stationary solutions of the IARCH(c0) (including FIGARCH) equations have
not yet been fully resolved. Any strictly stationary solution must have infinite variance
since if 02 = EZ,2 = FEh; < oo then, since Z;; a; = 1, it follows from (7.3.12)
that 02 = ag + o2, contradicting the finiteness of o2. Sufficient conditions for the
existence of causal strictly stationary solution of the IARCH)(c0), and in particular of
the FIGARCH equations, have been given by Douc et al. (2008).

Other models, based on changing volatility levels, have been proposed to explain
the “long-memory” effect in stock and exchange rate returns. Fractionally integrated E-
GARCH models have also been introduced (Bollerslev and Mikkelsen 1996) in order
to account for both long memory and asymmetry of the effects of positive and negative
shocks ¢, .

7.4 Stochastic Volatility Models

The general discrete-time stochastic volatility (SV) model for the log return sequence
{Z,} defined in Section 7.1 is [cf. (7.2.1)]

Z, = Vhe, t €L, (7.4.1)

where {e;} ~ IID(0, 1), {h,} is a strictly stationary sequence of non-negative random
variables, independent of {e,;}, and A, is known, like the corresponding quantity in the
GARCH models, as the volatility at time t. Note however that in the GARCH models,
the sequences {/,} and {e,} are not independent since %, depends on e, s < t through
the defining equation (7.2.6).

The independence of {#,} and {e,;} in the SV model (7.4.1) allows us to model the
volatility process with any non-negative strictly stationary sequence we may wish to
choose. This contrasts with the GARCH models in which the processes {Z;} and {,}
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are inextricably linked. Inference for the GARCH models, based on observations of
Zi, ..., Z,, can be carried out using the conditional likelihood, which is easily written
down, as in (7.2.14), in terms of the marginal probability density of the sequence {e,}.
Inference for an SV model based on observations of {Z;} however is considerably more
difficult since the process is driven by two independent random sequences rather than
one and only {Z;} is observed. The unobserved sequence {4,} is said to be latent.

A general account of the probabilistic properties of SV models can be found in
Davis and Mikosch (2009) and an extensive history and overview of both discrete-time
and continuous-time SV models in Shephard and Andersen (2009). In this section we
shall focus attention on an early, but still widely used, special case of the SV model
due to Taylor (1982, 1986) known as the lognormal SV model.

The lognormal SV process {Z;} is defined as,

Z, = /Eet, {e;} ~TID N(O, 1), (7.4.2)
where h, = e, {£,} is a (strictly and weakly) stationary solution of the equations
€ =vo+ yili-1 + i {0} ~ D N(O, 0%), (7.4.3)

[v1l < 1 and the sequences {e;} and {n,} are independent. The sequence {¢,} is clearly
a Gaussian AR(1) process with mean

e ;= El, = T (7.4.4)
-
and variance
2
ve := Var(¢;) = 5 (7.4.5)

Properties of {Z,}.

(1) {Z} is strictly stationary.

(i1)) Moments:
EZ; = E(e;)Eexp(rt,/2)
0, if r is odd,

m . m m2a? .
[ITZ,2i — Dlexp (1_—?1 + 2(17‘;12)) , if r=2m.

(ii1) Kurtosis:

EZ} 3 ( o? >>3
= 3exp > 3.
(EZ})? -y}

Kurtosis (defined by the ratio on the left) is a standard measure of tail heaviness.
For a normally distributed random variable it has the value 3, so, as measured by
kurtosis, the tails of the marginal distribution of the lognormal SV process are
heavier than those of a normally distributed random variable.

(iv) The autocovariance function of {Zf}:
‘We first observe that if t > s,

E(Zfoleu, Ny, U < 1) = hsh,efE(etzleu, Ny, U < 1) = hshtef,

since Ay, h; and ef are each functions of {e,, n,, u < t} and et2 is independent of
{e., nu, u < t}. Taking expectations on both sides of the last equation and using
the independence of {/,} and {e;} and the relation &, = exp(l;) gives

E(Z}Z}) = Eexp(t; + ¢,).
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Hence, for 1 > 0,
Cov(Z2,,,. Z7) = Eexp(€psn + £) — Eexp(£,1;)E exp({,)

= exp[2ite + ve(1 + )] — expl2ue + vel.
Here we have used the facts that ¢,,, is normally distributed with mean and
variance which are easily computed from (7.2.17) and that for a normally
distributed random variable X with mean u and variance v, E exp(X) = exp(u +
v/2). From (ii) we also have

Var(Z}) = EZ} — (EZ?)* = 3exp(2ue + 2v) — exp(Rite + v)).
Hence, for 1 > 0,
Cov(Z},), 2D expvey]) — 1 v

Var(Z?2) © 3exp(v) — 1 3exp(vy) — 1

Pz (h) = yi's asyr — 0,
suggesting the approximation of the autocorrelation function of {Z?} by that of
an ARMA(1,1) process. (Recall from Example 3.2.1 that the autocorrelation
function of an ARMA(1,1) process has the form p(h) = c¢”, h > 1, with
0(0) = 1.) There is a similarity here to the autocovariance function of the squared
GARCH(1,1) process which (see Problem 7.3) has the autocovariance function
of an ARMAC(1,1) process.

(v) The process {In th}:
InZ> = ¢, +Ine’. (7.4.6)

Ife; ~ N(0, 1) then E In et2 = —1.27 and Var(In 6,2) = 4.93. From (7.4.6) we find
at once that Var(In th) =v; 4+ 4.93 and COV(Zt2+h, Z,) = v,yllhl for h # 0. Hence
the process {In Z?} has the autocovariance function of an ARMA(1,1) process
with autocorrelation function

7]
iy,

——,  h#0
V[+4.93 ;é

Pz (h) =

Estimation for the lognormal SV model

The parameters to be estimated in the defining equations (7.4.2) and (7.4.3) are o2, y,
and y;. They can be estimated by maximization of the Gaussian likelihood which can
be calculated, for any specified values of the parameters, as follows.

By property (v) above, the process {Y; := In Z> — E In Z?} satisfies the ARMA(1,1)
equations,

Y, — ¢Y,1 =Z +6Z1. {Z} ~ WN(0, 07), (7.4.7)

for some coefficients ¢ and 6 in the interval (—1, 1) and white-noise variance 2.
Comparing the autocorrelation function of (7.4.7) with the autocorrelation function of
{InZ?} given above in Property (v), we find that

Vn=¢ (7.4.8)
and

ve (O +¢)1+0¢)
ve+493 14200 +02

To ensure that the right-hand side falls in the interval (0, 1) itis necessary and sufficient
(assuming that ¢ € (—1.1) and 8 € (—1,1)) that ¢ + 0 > 0. The maximum

(7.4.9)
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Gaussian likelihood estimators ¢ and 6 can be found using the program ITSM and
the corresponding estimators p; and v, on replacing ¢ and 6 by their estimators in
(7.4.8) and (7.4.9) respectively. From (7.4.5) the corresponding estimator of o2 is

o2 = (1 - P,
where p| = qAﬁ and, from (7.4.4) and (7.4.6), the corresponding estimator of y; is
Yo=(1—y)(UnZ}+1.27),

where In Z2 denotes the sample mean of the observations of In Z2. If it turns out that
the estimators (]3 and O satisfy (]3 + 0 < 0 then, from (7.4.9), v, < 0, suggesting that
the lognormal SV model is not appropriate in this case.

Forecasting the log volatility

The minimum mean-squared error predictor of £, conditional on {{;, s < ¢} is
easily found from (7.4.3) to be

_h

%
Pl =yl + v ; yl : (7.4.10)
— /1

with mean-squared error,

1—)/12}’

E(€isn — Piliyy) =0 ~.
1—)/1

(7.4.11)
We have seen how to estimate yy, y; and o2, but unfortunately ¢, is not observed.
In order to forecast ¢,,; using the observations {Z,, s < t}, we can however use the
Kalman recursions as described in Section 9.4, Example 9.4.2

7.5 Continuous-Time Models

7.5.1 Lévy Processes

Continuous-time models for asset prices have a long history, going back to Bachelier
(1900) who used Brownian motion to represent the movement of asset prices in
the Paris stock exchange. Continuous-time models have since moved to a central
place in mathematical finance, largely because of their use in the field of option-
pricing, initiated by the Nobel-Prize-winning work of Black, Scholes and Merton, and
partly also because of the current availability of high-frequency and irregularly-spaced
transaction data which are represented most naturally by continuous-time models.
We earlier defined the daily return on day ¢ of a stock whose closing price is P; as

Zi =X, — X1, (7.5.1)
where
X; = log P, (7.5.2)

is the log asset price at the close of day ¢. If the daily returns were iid this would mean
that the process {X;} is a random walk (Example 1.4.3). This is an over-simplified
model for daily asset prices as there is very strong evidence suggesting that the daily
returns, although exhibiting little or no autocorrelation, are not independent.
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Definition 7.5.1

Example 7.5.1

Example 7.5.2

Nevertheless it will be a useful starting point, in the construction of continuous-
time models to introduce the continuous-time analogue of a random walk, known as a
Lévy process. Like iid noise in discrete time, it is the building block for the construction
of a large family of more complex models for financial data.

A Lévy process, {L(), t € R} is a process with the following properties:

(i) L) =0.
(i1) L(r) — L(s) has the same distribution as L(¢f — s) for all s and ¢ such that s < r.

(iii) If (s, #) and (u, v) are disjoint intervals then L(f) — L(s) and L(v) — L(u) are
independent.

(v) {L(#)} is continuous in probability, i.e. for all € > 0 and for all r € R,
lim P(|L(¢) — L(s)| > €) =0.
s—>1

The essential properties of Lévy processes are discussed in Appendix D. For thorough
accounts of Lévy processes and their properties see the books of Applebaum (2004),
Protter (2010) and Sato (1999) and for an extensive account of their applications to
finance see Schoutens (2003) and Andersen et al. (2009). For now we restrict attention
to two of the most familiar examples of Lévy processes, Brownian motion, whose
sample-paths are continuous, and the compound Poisson process, whose sample-paths
are constant except for jumps.

Brownian Motion

This is a Lévy process for which L(f) ~ N(ut, %t), t > 0, with parameters © € R
and o > 0. The sample-paths are continuous and the characteristic function of L(?)
fort > O1is

EeLO — €0 g c R, (7.5.3)
where
£0) =i —6°07/2.

The defining properties (ii) and (iii) imply that for any finite collection of times #; <
th < --- <t the increments A; := L(t;y;) — L(t;,), i = 1, ..., n, are independent
random variables satisfying A; ~ N(u(tiy1 — t;), 0%(tip1 — t;)). Brownian motion
with 4 = 0 and 0 = 1 is known as standard Brownian motion. We shall denote it
henceforth as {B(f), t € R}. A realization of B(#), 0 < ¢t < 10, is shown in Figure 7-5.

O

The Poisson Process

The Poisson process {N(¢), t € R} with intensity or jump-rate A is a Lévy process such
that N(¢), for + > 0, has the Poisson distribution with mean Az. Its sample paths are
right-continuous functions which are constant except for jumps of size 1, the number
of jumps occurring in any time interval of length ¢ having the Poisson distribution with
mean A£. The characteristic function of N(¢) for ¢t > 0 is given by (7.5.3) with

£0) =€ — 1.
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Figure 7-5

A realization of standard
Brownian motion
B(t),0<t=<10

Figure 7-6

A realization of a Poisson
process N(t),0 <t < 10,
with jump-rate 5 per unit
time

Example 7.5.3

A sample-path of a Poisson process with A = 5 on the time-interval [0, 10] is shown
in Figure 7-6.
O

The Compound Poisson Process

The compound Poisson process {X(¢),t € R} with jump-rate A and jump-size
distribution function F is a Lévy process with sample-paths which are constant except
for jumps. The jump-times are those of a Poisson process {N(¢)} with jump-rate A and
the sizes of the jumps are independent random variables, independent of the process
{N(?)}, with a distribution function F assigning probability zero to the value zero. The
characteristic function of L(¢) for ¢ > 0 is again given by (7.5.3) but now with

E(0) = ifc + / (€™ — 1 — ifxI_y.1)(x))AdF (x), (7.5.4)
R

where ¢ = Af|x|<1xdF(x) and I_; n(x) = 11if |x] < 1 and zero otherwise.
A realization of a compound Poisson process on the interval [0,10] is shown in
Figure 7-7
O
The above examples give some idea of the immense variety in the class of Lévy
processes. The Lévy-1td6 decomposition implies that every Lévy process L can be
expressed as the sum of a Brownian motion and an independent pure-jump process.
The marginal distribution of L(¢) can be any distribution from the class of infinitely
divisible distributions (which includes the gamma, Gaussian, Student’s t, stable,
compound Poisson and many additional well-known distributions). See Appendix D
and the references given there for more details.
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Figure 7-7

A realization of a
compound Poisson process
X(),0 <t <10, with
jump-rate 5 per unit time
and jump-size distribution
normal with mean 0 and
variance 1

7.5.2 The Geometric Brownian Motion (GBM) Model for Asset Prices

In his pioneering mathematical analysis of stock prices, contained in his doctoral
thesis, Théorie de la speculation, Bachelier (1900) introduced a model in which
the price of an asset {P(¢)} is Brownian motion with parameters p and o (see
Example 7.5.1). Measuring time in units of 1 day, this implies in particular that the
daily closing prices, P(#),t = 0, 1, 2, ..., constitute a random walk with increments
P(t) — P(t — 1) which are independent and normally distributed with mean w and
variance o 2. The normality of these increments and the fact that P(f) takes negative
values with positive probability clearly limit the value of this model as a realistic
approximation to observed daily prices. However, interest in the work of Bachelier
and his use of the Brownian motion model to solve problems in mathematical finance
led (Samuelson 1965) to develop and apply the more realistic geometric Brownian
motion model for asset prices. A fascinating account of Bachelier’s work, including
an English translation of his thesis and comments on its place in the history of both
probability theory and mathematical finance is contained in the book of Davis and
Etheridge (2006). The geometric Brownian motion model is the one for which the
celebrated option-pricing formulae of Black, Scholes and Merton were first derived.

In the Brownian motion model the asset price {P(¢), t > 0} satisfies the stochastic
differential equation,

dP(t) = udt + odB(t), (7.5.5)

where {B(f)} is standard Brownian motion, i.e., Brownian motion with EB(#) = 0 and
VarB(f) = t, t > 0. Equation (7.5.5) is shorthand for the integrated form,

P(t) — P(0) = put + o B(?).

In addition to the obvious flaw that P(r) will take negative values for some values
of ¢, the increments P(¢#) — P(t — 1) are normally distributed, while in practice it is
observed that these increments have marginal distributions with heavier tails than the
normal distribution. The geometric Brownian motion model addresses both of these
shortcomings.

The geometric Brownian motion model for {P(¢), t > 0} is defined by the 1t6
stochastic differential equation,

dP(t) = P()[pdt + odB(?)], with P(0) > 0. (7.5.6)

Solution of this equation requires knowledge of Itd calculus, a brief introduction to
which is given in Appendix D. A more extensive and very readable account with
financial applications can be found in the book of Mikosch (1998). The solution of
(7.5.6) satisfies (see Appendix D)
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Figure 7-8

A realization of GBM,
P(H),0 <t <10, with
PO)=1.u=0and
o = 0.01

1-05 T T T T

0.95

2
P(t) = P(0) exp [(u — %)z + aB(t)] , (1.5.7)

from which it follows at once that the log asset price X(¢) = log P(¢) satisfies

2
X() = X(0) + (1 — %)z +oB(), (7.5.8)

or equivalently

2
dX (1) = (u _ %) dt + o dB(1). (7.5.9)

A realization of the process P(7),0 <t < 10, with P(0) = 1, u = 0 and 0 = 0.01 is
shown in Figure 7-8.
The return for the time interval (t — A, t) is

2
Zat) =X@) —X(t— A) = (u — %)A +o[B(H) —B(lt—A)].  (7.5.10)

For disjoint intervals of length A the returns are therefore independent normally
distributed random variables with mean (;t—o2/2) A and variance o> A. The normality
of the returns implied by this model is a property which can easily be checked against
observed returns. It is found from empirically observed returns that the deviations from
normality are substantial for time intervals of the order of a day or less, becoming less
apparent as A increases. This is one of the reasons for developing the more complex
models described in later sections.

Remark 1. An asset-price model which overcomes the normality constraint is the so-
called Lévy market model (LMM), in which the log asset price X is assumed to be a
Lévy process, not necessarily Brownian motion as in the GBM model. For a discussion
of such models see Eberlein (2009).

The parameter o2 in the GBM model is called the volatility parameter. It plays
a key role in the option pricing analysis of Black and Scholes (1973) and Merton
(1973) to be discussed in Section 7.6. Although o2 cannot be determined from discrete
observations of a GBM process it can be estimated from closely-spaced discrete
observations X(i/N),i = 1,...,N, with large N, as described in the following
paragraph.

From (7.5.8) we can write

(AX)? :=[X(i/N) — X((i — 1)/N)]* = (¢/N + 0 A;B)?, (7.5.11)
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where A;B = B(i/N) — B((i — 1)/N) and ¢ = u — 0>/2. A simple calculation then
gives

) o? c?
E[(AX) ] = —+ —,
[(A:X)7] N + N
and
) 4022 20*
Var[(AX)"] = ¥ + N

By the independence of the summands, vazl (A;X)? has mean o> +¢? /N and variance
20*/N + 40%c?/N?, showing that, as N — oo,

N 1
> (ax)? s 02:/ o2dr. (7.5.12)
i=1 0

This calculation shows that, for the GBM process, the sum on the left is a consistent
estimator of 02 as N — oo. The sum (for suitably large N) is known as the realized
volatility for the time interval [0, 1] and the integral on the right is known as the
integrated volatility for the same interval. o2 itself is known as the spot volatility.
The realized volatility is widely used as an estimator of the integrated volatility and
is consistent for a wide class of models in which the spot volatility is not necessarily
constant as it is in the GBM model. For a discussion of realized volatility in a more
general context see the article of Andersen and Benzoni (2009).

We shall denote the realized volatility, computed fordayn,n = 1,2, 3, ..., by 6"2.
It is found in practice to vary significantly from 1 day to the next. The sequence {62} of
realized volatilities exhibits clustering, i.e., periods of low values interrupted by bursts
of large values, and has the appearance of a positively correlated stationary sequence,
reinforcing the view that volatility is not constant as in the GBM model and suggesting
the need for a model in which volatility is stochastic. Such observations are precisely
those which led to the development in discrete time of stochastic volatility, ARCH,
and GARCH models, and suggest the need for analogous models with continuous time
parameter.

7.5.3 A Continuous-Time SV Model

In the discrete-time modeling of asset prices we have seen how both the GARCH
and SV models allow for the variation of the volatility with time by modeling {4,} as a
random process. A continuous-time analogue of this idea was introduced by Barndorff-
Niesen and Shephard (2001) in their celebrated continuous-time SV model for the log
asset price X () [cf. (7.5.9)],

dX(t) = [m+ bh(t)]dt + /h(t)dB(t), t > 0, with X(0) =0, (7.5.13)

where m € R, b € R, {B(t)} is standard Brownian motion and {h(#)} is a
stationary subordinator-driven Ornstein-Uhlenbeck process independent of {B(7)}.
The connection with discrete-time SV models is clear if we setm = b = 01in (7.5.13)
and compare with (7.4.1). Notice also that (7.5.13) has the same form as the GBM
equation (7.5.9) except that the constant volatility parameter o2 has been replaced by
the random volatility h(t).

A subordinator is a Lévy process with non-decreasing sample paths. The simplest
example of a subordinator is the Poisson process of Example 7.5.2. If the compound
Poisson process in Example 7.5.3 has non-negative jumps, i.e., if the jump-size
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distribution function F satisfies F(0) = 0, then it too is a subordinator. Other examples
of subordinators are the gamma process (see Appendix D), whose increments on
disjoint intervals have a gamma distribution, and the stable subordinators, whose
increments on disjoint intervals are independent non-negative stable random variables.

An Ornstein-Uhlenbeck process driven by the subordinator L satisfies the stochas-
tic differential equation,

dh(t) = Ah(t)dt + dL(t), t € R, (7.5.14)

where A < 0. If EL(1)" < oo for some r > 0 this equation has a unique strictly
stationary causal solution

t
h(t) = / AL (u). (7.5.15)
—0Q

(Causal here means that /() is independent of the increments {L(«) — L(¢) : u > t} for
every t.) A crucial feature of (7.5.15) is the non-negativity of i(#) which follows from
the non-decreasing sample-paths of the subordinator {L(¢)} and the non-negativity of
the integrand. Non-negativity is clearly a necessary property if h(¢) is to represent
volatility. For a detailed account of Lévy-driven stochastic differential equations and
integrals with respect to Lévy processes, see Protter (2010). In the case when L is a
subordinator, (7.5.15) has the very simple interpretation as a pathwise integral with
respect to the non-decreasing sample-path of L.

Quantities associated with the model (7.5.13) which are of particular interest are
the returns over time intervals of length A > 0, i.e.

Y, :=X(nA) —X((n—1)A), ne N,
and the integrated volatilities,
nA
I, = / h(t)dt, n € N.
(n—1)A

The interval A is frequently one trading day. The return for the day is an observ-
able quantity and the integrated volatility, although not directly observable, can
be estimated from high-frequency within-day observations of X(f), as discussed in
Section 7.5.2 for the GBM model.

For the model (7.5.13) with any second-order stationary non-negative volatility
process h which is independent of B and has the properties,

Eh(t) = &, Var(h(r)) = o?
and
Cov(h(t), h(t + 5)) = 0?p(s), s € R,
it can be shown (Problem 7.8) that the stationary sequence {/,} has mean,
El, =£A. (7.5.16)
and autocovariance function,
202r(A), if k=0,

vi(k) =
o [F((k+ DAY — 2r(kA) + r((k — DAY, ifk > 1.

(7.5.17)
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Example 7.5.4.

where

r(t) :=/ /y,o(u)du dy. (7.5.18)
0o Jo

The stationary sequence of log returns {Y,,} has mean m + b&§ and autocovariance
function,

by (0) +EA, ifk=0,
yy(k) = (7.5.19)
b2y (k), if k> 1.

If in addition m = b = 0 then the log returns {Y,,} are uncorrelated while the squared
sequence {Y,} (see Problem 7.11) has mean,

EY?=£A (7.5.20)
and autocovariance function,
w? [6r(A) +24%% /0], if k=0,

yy2(k) =
O [r((k+ D A) = 2r(kA) + r((k — DAY, ifk> 1.

(7.5.21)

Thus, under these assumptions, the log returns, Y, calculated from the model are
uncorrelated while the squares, Y2, are correlated, showing that the log returns are
uncorrelated but not independent, in keeping with the "“‘stylized facts” associated with

empirically observed log returns.
The Ornstein-Uhlenbeck SV Model withm = b =0

We can use the results (7.5.16)—(7.5.21) to determine properties of the sequences {Y,,},
{Y,%} and {/,} associated with the Ornstein-Uhlenbeck SV model,

dX(t) = Vh(t)dB(t), t > 0, with X(0) = 0, (7.5.22)
where
h(t) = / 0L (), (7.5.23)

A < 0and EL(1)? < 0.
In order to apply (7.5.16)—(7.5.21) we need to determine £ = Eh(f), w* =
Var(h(t)) and the autocorrelation function p of 4. To this end we rewrite (7.5.23) as

h(t) = /00 g(t —u)dL(u), (7.5.24)

o0
where

M, if x>0,

gx) = (7.5.25)
0, otherwise

The function g in the representation (7.5.24) is called a kernel function. If EL(1)? <
00, as we shall assume from now on, and if f and g are integrable and square-integrable
functions on R, we have (see Appendix D),

E/oof(t —uw)dL(u) = /oof(u)du (7.5.26)
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and

Cov (/Oof(t —u)dL(u), /00 gt — u)dL(u)) =0 /Oof(u)g(u)du,

(7.5.27)

where ;1 = EL(1) and 02 = Var(L(1)). Taking g asin (7.5.25) and f (x) = g(s+x), x €
R, we find from these equations that the mean and autocovariance function of the
volatility process {/(f)} defined by (7.5.23) are given by

7
3 () i
and

2
Covihr +5), h(t) = 50=¢" = 0?p(s), 520,
where w? = Var(h(t)) = 02/(2|A|) and p(s) = €**, s > 0. Substituting for p into
(7.5.17) gives

r(t) = % (e —1—x1).

We can now substitute for £, w?, p and r in equations (7.5.16)—(7.5.21) to get the
second-order properties of the sequences {Y,}, {Y,%} and {/,}. In particular we find that

{Y,} ~ WN(O, || ),
EY? =El, = |A|"'nA

and
1
Yy (k) = yi(k) = Emr%ze("*“mu — ) k> 1.

The validity of the latter expressions for k > 1 and not for k = 0 indicates that
both the squared return sequence {Y?} and the integrated volatility sequence {/,} have
the autocovariances of ARMAC(1, 1) processes. This demonstrates, for this particular
model, the covariance structure of the sequence {¥?} and the consequent dependence
of the white-noise returns sequence {Y,,}.

O

Remark 2. Since equations (7.5.16)—(7.5.19) (derived by Barndorff-Niesen and
Shephard 2001) apply to any second-order stationary non-negative stochastic volatility
process, h, independent of B in (7.5.13), they can be used to calculate the second order
properties of {Y,} and {I,} for more general models than the Ornstein-Uhlenbeck
model defined by (7.5.13) and (7.5.15). If m = b = 0 the second-order properties
of {Yf} can also be calculated using equations (7.5.20) and (7.5.21). In particular we
can replace the Ornstein-Uhlenbeck process, 4, in Example 7.5.4 by a non-negative
CARMA process (see Section 11.5) to allow a more general class of autocovariance
functions for the sequences {I,} and {¥Y?} in order to better represent empirically
observed financial data.

Remark 3. Continuous-time generalizations of the GARCH process have also been
developed (see Kliippelberg et al. (2004) and Brockwell et al. 2006). Details however
are beyond the scope of this book.
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7.6 An Introduction to Option Pricing

We saw in Section 7.5.2 that, under the geometric Brownian motion model, the asset
price P(t) satisfies the It equation,

dP(t) = P(t)[udt + odB(r)] with P(0) > 0, (7.6.1)
which leads to the relation,
P(t) = P(0)exp [(n — 0°/2)t + o B(1)]. (7.6.2)

In this section we shall determine the value of a European call option on an asset
whose price satisfies (7.6.2). The result, derived by Black and Scholes (1973) and
Merton (1973), clearly demonstrates the key role played by the volatility parameter o 2.

A European call option, if sold at time 0, gives the buyer the right, but not the
obligation, to buy one unit of the stock at the strike time 7 for the strike price K. At
time T the option has the cash value A(P(f)) = max(P(T) — K, 0) since the option
will be exercised only if P(T) > K, in which case the holder of the option can buy the
stock at the price K and resell it instantly for P(7"). However it is not clear at time 0,
since P(T) is random, what price the buyer should pay for this privilege. Assuming

(i) the existence of a risk-free asset with price process,
D(t) = D(0) exp(rt), r > 0, (7.6.3)

(i) the ability to buy and sell arbitrary (positive or negative) amounts of the stock and
the risk-free asset continuously with no transaction costs, and

(iii) an arbitrage-free market ( i.e., a market in which it is impossible to make a profit
which is non-negative with probability one and strictly positive with probability
greater than zero).

Black, Scholes and Merton showed that there is a unique value for the option in the
sense that both higher and lower prices introduce demonstrable arbitrage opportunities.
Details of the derivation can be found in most books dealing with mathematical
finance (e.g., Campbell et al. 1996; Mikosch 1998; Klebaner 2005). In the following
paragraphs we give a sketch of two arguments, following Mikosch (1998), which
determine this value under the assumption that the asset price follows the GBM model.

In the first argument, we attempt to construct a self-financing portfolio, consisting
at time ¢ of a, shares of the stock and b, shares of the risk-free asset, where a, and b,
are random variables which, for each ¢ are functions of {B(s), s < t}. We require the
value of this portfolio at time ¢, namely

V(t) = a,P(t) + b,D(1), (7.6.4)
to satisfy the self-financing condition,

dV(t) = a; dP(t) + b, dD(1), (7.6.5)
and to match the value of the option at time 7, i.e.,

V(T) = h(P(T)) = max(P(T) — K, 0). (7.6.6)

If such an investment strategy, {(a;, b,),0 < t < T} can be found, then V(0) must
be the value of the option at the purchase time ¢+ = 0. A higher price for the option
would allow the seller to pocket the difference § and invest the amount V(0) in such
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a way as to match the value of the option at time 7'. Then at time 7, if P(T)) < K the
option will not be exercised and the portfolio and the option will both have value zero.
If P(T) > K the seller sells the portfolio for P(T)) — K, then buys one stock for P(T)
and receives K for it from the holder of the option. Since there is no loss involved
in this transaction, the seller is left with a net profit of §. The seller of the option
therefore makes a profit which is certainly non-negative and strictly positive with non-
zero probability, in violation of the no arbitrage assumption. Similarly a lower price
than V(0) would create an arbitrage opportunity for the buyer. In order to determine
V (), a, and b; we look for a smooth function v(z, x), t € [0, T], x > 0, such that

V() =v(, P(n), 1 €[0,T], (7.6.7)

satisfies the conditions (7.6.4)—(7.6.6).
Writing x for P(¢) in v(¢, P(¢)) and applying It6’s formula (see Appendix D) gives

av av 19%
dv = —dt + —dx + = —(dv)* 7.6.8
Y ot +8x x+28x2(x) ( )
where, from (7.6.1),
dx = x(udt + odB(t)) (7.6.9)
and
(dx)? = X*o2dt. (7.6.10)
Applying Itd’s formula to (7.6.5) and using (7.6.3) and (7.6.4) gives
dv = a;,(udt + odB(t)) + r(v — ax)dt. (7.6.11)
Substituting (7.6.9) and (7.6.10) into (7.6.8) and comparing with (7.6.11), we find that
ad
a = (1, P(1)) (7.6.12)
ox
and that v(z, x) satisfies the equation,
0 1 0 ad
ad + = 2x2_V + rx—v = rv. (7.6.13)

The condition (7.6.6) yields the boundary condition,
w(T, x) = h(x) = max(x — K, 0), (7.6.14)

which, with (7.6.13), uniquely determines the function v and hence V(¢), a, and
b, = (V(t) — a,P(t))/D(¢t) for each t € [0, T]. The corresponding investment strategy
{(a;, b;), 0 <t < T} satisfies (7.6.5) and (7.6.6) and can, under the assumed idealized
trading conditions, be implemented in practice. Since at time T this portfolio has the
same value as the option, V(0) must be the fair value of the option at time r = 0,
otherwise an arbitrage opportunity would arise. The option is said to be hedged by the
investment strategy {(a,, b;)}. A key feature of this solution [apparent from (7.6.12)—
(7.6.14)] is that both the strategy and the fair price of the option are independent of .,

depending on the price process P only through the volatility parameter o>

Instead of attempting to solve (7.6.13) directly we now outline the martingale
argument which leads to the explicit solution for v(x, ), a, and b,. It is based on the fact
that for the GBM model with B(¢) defined on the probability space (2, .%, I1), there
is a unique probability measure Q on (2, .%) which is equivalent to IT (i.e., it has the
same null sets) and which, when substituted for I, causes the discounted price process
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f’(tz = e "P(¢), 0 <t < T, to be a B-martingale, i.e., to satisfy the conditions that
EoP(t) < oo and

Eo(P(H)|B(u),u < s) = P(s) forall0 <s<t<T. (7.6.15)

The measure Q and the relation (7.6.15) can be derived as follows. Applying It6’s
formula to the expression P(f) = ¢~ ""P(¢) and using (7.6.1) gives

dP()

——~ = (u—rdt + odB(r) = 0dB(1), (7.6.16)

P
where B(t) := (u — r)t/o + B(t). The solution of (7.6.16) satisfies

P(t) = P(0)e”BO="1/2, (7.6.17)
By Girsanov’s theorem (see Mikosch 1998), if we define Q by

_ ey
0A) = / exp (= “ ="y — L= am, (7.6.18)
N o 202

then, on the new probability space (22, .%#, Q), B is standard Brownian motion. A
simple calculation using (7.6.17) then shows that the discounted price process P is
a B-martingale on (2, .#, Q), i.e. EQP(I) < oo and (7.6.15) holds.

Assuming the existence of a portfolio (7.6.4) which satisfies the self-financing
condition (7.6.5) and the boundary condition (7.6.6), the discounted portfolio value is

V() = e "V(1). (7.6.19)
Applying Itd’s formula to this expression we obtain

dV(t) = e "(—=rV()dt + dV (1)) = ae”"(—rP(t)dt + dP(1)) = a,dP(?),
and hence, from (7.6.16),

V() = V(0) + / a,dP(s) = V(0) + o / a,P(s)dB(s). (7.6.20)
0 0

Since a,i’(t) is a functio~n of {B(s),s < t} for eacll t € [0, T] and since, under the
probability measure Q, B is Browniar} motion and B(¢) is a function of {B(s), s < t}
for each t € [0, T'], we conclude that V is a B-martingale. Hence

V(t) = EgIV(T)|B(s),s <11, t€[0,TI,
and
V(t) = "V(t) = Egle """ h(P(T))|B(s), s < 1], (7.6.21)

where h(P(T)) is the value of the option at time 7. For the European call option
h(P(T)) = max(P(T) — K, 0).

It only remains to calculate v(¢, x) from (7.6.21). To do this we define 0 := T —t.
Then, expressing P(T) in terms of P(¢),

02 n n
V(t) = Egle " h(P(t)e"~ DT BD=B0N p(s), s < 1] = v(t, P(1)),

where
f72
V(t,x) = e f h(xe =0+ 4 (1) dy (7.6.22)

and ¢ is the standard normal density function,
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Problems

() = exp(—y*/2).

1
21
Substituting max(x — K, 0) for 4(x) in (7.6.22) gives

v(t, x) = x®(z1) — Ke " T (z0), (7.6.23)

where @ is the standard normal cumulative distribution function, ® (x) = f f o & (w)du,

2
_ log(x/K) -;(\;%/D(T D nd b=z —oVT 1.
The value of the option at time 0 is V(0) = v(0, P(0)) and the investment strategy
{a;, b;,, 0 <t < T} required to hedge it is determined by the relations a, = %(t, P(t))
and b, = (v(¢, P(t) — a,P(t))/D(¢). It can be verified by direct substitution (Problem
7.12) that the function v given by (7.6.23) satisfies the partial differential equation
(7.6.13) and the boundary condition (7.6.14).

The quantity m = (i — r)/o which appears in the integrand in (7.6.18) is called
the market price of risk and represents the excess, in units of o, of the instantaneous
rate of return w of the risky asset S over that of the risk-free asset D. If m = 0 then
Q = I and the model is said to be risk-neutral.

Although the model (7.6.1) has many shortcomings as a representation of asset
prices, the remarkable achievement of Black, Scholes and Merton in using it to derive
a unique arbitrage-free option price has inspired enormous interest and progress in
the field of financial mathematics. As a result of their pioneering work, research
in continuous-time financial models has blossomed, with much of it directed at
the construction, estimation and analysis of more realistic continuous-time models for
the evolution of stock prices, and the pricing of options based on such models. A nice
account of option-pricing for a broad class of Lévy-driven stock-price models can be
found in the book of Schoutens (2003).

21

7.1 Evaluate EZf for the ARCH(1) process (7.2.5) with 0 < «; < 1 and {e;} ~
IID N(O, 1). Deduce that EX;1 < oo if and only if 30{% < 1.

7.2 Let {Z;} be a causal stationary solution of the ARCH(p) equations (7.2.1) and
(7.2.2) with EZ} < oo. Assuming that such a process exists, show that ¥, =
72 ay satisfies the equations

14
Yt = €t2 (1 + Zath’)

i=1

and deduce that {Y;} has the same autocorrelation function as the AR(p) process

p
Wi= aWei+en {e}~WNQ, D).
i=1
(In the case p = 1, a necessary and sufficient condition for existence of a causal

stationary solution of (7.2.1) and (7.2.2) with EZt4 <00 is 30{% < 1, as shown
by the results of Section 7.2 and Problem 7.1.)
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7.3

7.4

7.5
7.6

7.7

7.8

7.9

7.10

Suppose that {Z;} is a causal stationary GARCH(p, q) process Z, = +/h,e,, where
{e} ~TID(O,1), 377 @i + >, B; < 1 and

hy= oo+ Z )+ +0pZl + Phot + -+ Bohig.

a. Show that E(Z?|Z} |, Z} ,,...) = h,.
b. Show that the squared process {Z?} is an ARMA(m, q) process satisfying the
equations

Z2 =g+ (a1 + B)ZE, + -+ (@ + B Z2,,
+U —BiUiy— - — ,BqUt—qa

where m = max{p, g}, o; = 0 for j > p, B; = 0 forj > ¢, and U, = Z? — h,
is white noise if EZ; < oo.

c. For p > 1, show that the conditional variance process {/,} is an
ARMA((@m, p — 1) process satisfying the equations

hy = ag +(ar + B)hi—1 + - + (@ + B hi—m
+V: + aTthl +---+ O[;;thpflv

where V; = ozflUt,l and ozjf" =ajp /o forj=1,...,p— 1L

To each of the seven components of the multivariate time series filed as
STOCK7.TSM, fit an ARMA model driven by GARCH noise. Compare
the fitted models for the various series and comment on the differences.
(For exporting components of a multivariate time series to a univariate project,
see the topic Getting started in the PDF file ITSM_HELP which is included in
the ITSM software package.

Verify equation (7.3.7).

Show that the return, Z,(¢#) := logP(t) — logP(t — A), approximates the
fractional gain, F5(?) := (P(t) — P(t — A))/P(t — A), in the sense that

Za()

FA(1)

— las Fx(t) — 0.

For the GBM model (7.5.7) with P(0) = 1, evaluate the mean and variance of
P(t) and the mean and variance of the return, Z,(¢).

If & is any second-order stationary non-negative volatility process with mean &,
variance w? and autocorrelation function p, verify the relations (7.5.16)—(7.5.18).

Use (7.5.26) and (7.5.27) to evaluate the mean and autocovariance function of
the stationary Ornstein-Uhlenbeck process (7.5.23).

If & is the stationary Ornstein-Uhlenbeck process (7.5.23) and s is any fixed
value in [0, A], show that application of the operator ¢(B) := (1 — ¢**B) to
the sequence {h(nA + s), n € Z} gives

¢ (B)h(nA + 5) = Wy(s),

where {W,(s), n € Z} is the iid sequence,

nA+s
VVn(S) — / e)\(nAerfu)dL(u).
(

n—1)A+s
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Deduce that the integrated volatility sequence, [, = fi) A h(nA + s5)ds, satisfies

0
(1 =B, = / W,,(s)ds.
—A

Since the right-hand side is 1-correlated, it follows from Proposition 2.1.1 that
it is an MA(1) process and hence that the integrated volatility sequence is an
ARMAC(1,1) process.

7.11 For the stochastic volatility model (7.5.13) with m = b = 0 and second-order
stationary volatility process 4 independent of W, establish (7.5.20) and (7.5.21).

7.12 Verify that the expression (7.6.23) for v(z, s) satisfies (7.6.13) and (7.6.14) and
use it to write down the value of the option at time t = 0 and the corresponding
investment strategy {(a;, b;),0 <t < T}.



Multivariate Time Series

8.1 Examples

8.2 Second-Order Properties of Multivariate Time Series

8.3 Estimation of the Mean and Covariance Function

8.4 Multivariate ARMA Processes

8.5 Best Linear Predictors of Second-Order Random Vectors
8.6 Modeling and Forecasting with Multivariate AR Processes
8.7 Cointegration

Many time series arising in practice are best considered as components of some vector-
valued (multivariate) time series {X;} having not only serial dependence within each
component series {X,} but also interdependence between the different component
series {X;;} and {X,;}, i # j. Much of the theory of univariate time series extends in
a natural way to the multivariate case; however, new problems arise. In this chapter
we introduce the basic properties of multivariate series and consider the multivariate
extensions of some of the techniques developed earlier. In Section 8.1 we introduce
two sets of bivariate time series data for which we develop multivariate models later
in the chapter. In Section 8.2 we discuss the basic properties of stationary multivariate
time series, namely, the mean vector 4 = EX, and the covariance matrices I'(h) =
EX1X) — ppu',h = 0,£1,£2,..., with reference to some simple examples,
including multivariate white noise. Section 8.3 deals with estimation of g and I'(-)
and the question of testing for serial independence on the basis of observations of
X1, ..., X,. In Section 8.4 we introduce multivariate ARMA processes and illustrate
the problem of multivariate model identification with an example of a multivariate
AR(1) process that also has an MA(1) representation. (Such examples do not exist
in the univariate case.) The identification problem can be avoided by confining
attention to multivariate autoregressive (or VAR) models. Forecasting multivariate
time series with known second-order properties is discussed in Section 8.5, and in
Section 8.6 we consider the modeling and forecasting of multivariate time series
using the multivariate Yule-Walker equations and Whittle’s generalization of the

© Springer International Publishing Switzerland 2016 227
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Durbin-Levinson algorithm. Section 8.7 contains a brief introduction to the notion
of cointegrated time series.

8.1 Examples

In this section we introduce two examples of bivariate time series. A bivariate time
series is a series of two-dimensional vectors (X;;, X,») observed at times ¢ (usually
t=1,2,3,...). The two component series {X;;} and {X,»} could be studied indepen-
dently as univariate time series, each characterized, from a second-order point of view,
by its own mean and autocovariance function. Such an approach, however, fails to take
into account possible dependence between the two component series, and such cross-
dependence may be of great importance, for example in predicting future values of the
two component series.

We therefore consider the series of random vectors X, = (X;;, Xp2)’ and define
the mean vector

EX
I, = EX, = |: ’1:|

EX[2

and covariance matrices

Lt + h, 1) := Cov(Xyn, Xi) = |:COV(Xt+h,1,Xt1) cov(Xin1, th):| .

coV(Xiyn2, Xi1)  cov(Xipn 2, Xp2)

The bivariate series {X,} is said to be (weakly) stationary if the moments g, and
['(t + h, t) are both independent of ¢, in which case we use the notation

Eth]

2 t |:EX,2

and

yiu(h)  yiz(h)
IW)CWW%X)[m@ m@]
The diagonal elements are the autocovariance functions of the univariate series {X;}
and {X;,} as defined in Chapter 2, while the off-diagonal elements are the covariances
between X, ; and Xj;, i # j. Notice that yi2(h) = y21(—h).
A natural estimator of the mean vector g in terms of the observations X, ..., X,
is the vector of sample means

_ 1 <
n=;§x,

and a natural estimator of I' (%) is
n—h
f'(h) = n! Z (Xt+h _Xn) (Xr — X,,) forO<h<n-1,

ﬁ(—t;)l/ for —n+1<h<0.
The correlation p;(h) between X, ; and X, ; is estimated by
pi(h) = P;(h) ($u(0)7;(0) /2.
If i = j, then p; reduces to the sample autocorrelation function of the ith series.
These estimators will be discussed in more detail in Section 8.2.
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Example 8.1.1

0 50 100 150 200 250

Dow Jones and All Ordinaries Indices; DJAO2.TSM

Figure 8-1 shows the closing values Dy, . . ., Dso of the Dow Jones Index of stocks on
the New York Stock Exchange and the closing values Ay, ..., Asso of the Australian
All Ordinaries Index of Share Prices, recorded at the termination of trading on 251
successive trading days up to August 26th, 1994. (Because of the time difference
between Sydney and New York, the markets do not close simultaneously in both
places; however, in Sydney the closing price of the Dow Jones index for the previous
day is known before the opening of the market on any trading day.) The efficient
market hypothesis suggests that these processes should resemble random walks with
uncorrelated increments. In order to model the data as a stationary bivariate time series
we first reexpress them as percentage relative price changes or percentage returns
(filed as DJAOPC2.TSM)

D, —D,_
X,lzloou, t=1,...,250,
D,
and
A, —A,_
thzlooM, t=1,...,250.
A

The estimators p11(h) and py,(h) of the autocorrelations of the two univariate series
are shown in Figures 8-2 and 8-3. They are not significantly different from zero.

To compute the sample cross-correlations p1,(h) and g, (k) using ITSM, select
File>Project>Open>Multivariate. Then click OK and double-click on
the file name DJAOPC2.TSM. You will see a dialog box in which Number of
columns should be set to 2 (the number of components of the observation vectors).
Then click OK, and the graphs of the two component series will appear. To see the
correlations, press the middle yellow button at the top of the ITSM window. The
correlation functions are plotted as a 2 x 2 array of graphs with p1; (%), 012(h) in the
top row and 0y (h), pr(h) in the second row. We see from these graphs (shown in
Figure 8-4) that although the autocorrelations p;;(h), i = 1,2, are all small, there is
a much larger correlation between X;_; | and X;,. This indicates the importance of
considering the two series jointly as components of a bivariate time series. It also
suggests that the value of X,_; i, i.e., the Dow Jones return on day ¢ — 1, may be of
assistance in predicting the value of X, ,, the All Ordinaries return on day ¢. This last
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Figure 8-2

The sample ACF 511 of the
observed values of {X;1} in
Example 8.1.1, showing the
bounds +1.96n~1/2

Figure 8-3

The sample ACF 5,5 of the
observed values of {X;»} in
Example 8.1.1, showing
the bounds +1.96n=1/2

Example 8.1.2
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observation is supported by the scatterplot of the points (x;—; 1, X,2), t = 2, ..., 250,
shown in Figure 8-5.
]

Sales with a leading indicator; LS2.TSM

In this example we consider the sales data {Yy,, t = 1, ..., 150} with leading indicator
{Yn,t = 1,...,150} given by Box and Jenkins (1976, p. 537). The two series are
stored in the ITSM data files SALES.TSM and LEAD.TSM, respectively, and in
bivariate format as LS2.TSM. The graphs of the two series and their sample autocorre-
lation functions strongly suggest that both series are nonstationary. Application of the
operator (1 — B) yields the two differenced series {D;;} and {D,;}, whose properties
are compatible with those of low-order ARMA processes. Using ITSM, we find that
the models
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data in Examp|e 8.1.1 -2.5 -2.0 -1.5 -1.0 -0.5 0.0 0.5 1.0 1.5 2.0
Dy —0.0228 =Z,, —0.474Z,_1 1, {Zn} ~ WN(O0, 0.0779), (8.1.1)

Dy —0.838D,_1, — 0.0676 = Z;; — 0.610Z,_, 5,

{Zin} ~ WN(O, 1.754), (8.1.2)

provide good fits to the series {D;1} and {D;,}.

The sample autocorrelations and cross-correlations of {D,;} and {D,;}, are com-
puted by opening the bivariate ITSM file LS2.TSM (as described in Example 8.1.1).
The option Transform>Dif ference, with differencing lag equal to 1, generates
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Figure 8-6

The sample correlations
,6,~j(h) of the series {D;1} and
{Dpp} of Example 8.1.2,
showing the bounds
£1.96n~ /2. (pj(h) is
plotted as the jth graph in
the ith row, i,j =1,2.)
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the bivariate differenced series {(D;, D;2)}, and the correlation functions are then
obtained as in Example 8.1.1 by clicking on the middle yellow button at the top of the
ITSM screen. The sample auto- and cross-correlations ,5,~J~(h), i,j = 1,2, are shown
in Figure 8-6. As we shall see in Section 8.3, care must be taken in interpreting the
cross-correlations without first taking into account the autocorrelations of {D;;} and
{Dt2} .

([l

8.2 Second-Order Properties of Multivariate Time Series

Consider m time series {X;;,t = 0,%1,...,},i = 1,...,m, with Ethi < oo for all
t and i. If all the finite-dimensional distributions of the random variables {X;;} were
multivariate normal, then the distributional properties of {X,;} would be completely
determined by the means

//Ln‘ = EXn‘ (821)
and the covariances
Vit +h, 1) = E[(Xgn,i — i) (Xij — pgj) ] (8.2.2)

Even when the observations {X;;} do not have joint normal distributions, the quantities
Wi and y;;(t + h, 1) specify the second-order properties, the covariances providing us
with a measure of the dependence, not only between observations in the same series,
but also between the observations in different series.

It is more convenient in dealing with m interrelated series to use vector notation.
Thus we define
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Definition 8.2.1

th
Xp=1| |, t=0=%£1,.... (8.2.3)
Xtm
The second-order properties of the multivariate time series {X;} are then specified by
the mean vectors
M1
I, = EX, = : (8.2.4)
Mim
and covariance matrices
yun(t+h o - yint+h1
L+ht = : : , (8.2.5)
Ym @+ h,t) - Vum(t + h, 1)
where
Vit +h, 1) := Cov(Xiqnir X1 ).

Remark 1. The matrix I'(¢ 4 A, f) can also be expressed as
L +ht) = E[(Xipn — myp) X — n)'l,

where as usual, the expected value of a random matrix A is the matrix whose
components are the expected values of the components of A. U

As in the univariate case, a particularly important role is played by the class of
multivariate stationary time series, defined as follows.

The m-variate series {X;} is (weakly) stationary if
(i) px(?) is independent of ¢
and
(i) T'x(t+ h, 1) is independent of ¢ for each A.

For a stationary time series we shall use the notation

231
p=EX, = | : (8.2.6)
Hm
and
yuh) - yim(h)
L'(h) == E[Xipn — W)X — )] = : : . (8.2.7)
Ymi(R) -+ Vim(h)

We shall refer to g as the mean of the series and to I" (%) as the covariance matrix at
lag h. Notice that if {X,} is stationary with covariance matrix function I"(-), then for
each i, {X,;} is stationary with covariance function y;;(-). The function y;(-), i # j, is
called the cross-covariance function of the two series {X;;} and {X,;}. It should be noted
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Proof

that y;;(-) is not in general the same as y;;(-). The correlation matrix function R(-) is
defined by

puh) - pi(h)
R(h) := : : : (8.2.8)

where p;i(h) = y;(h)/[vi(0) y,;,(O)]l/ 2. The function R(-) is the covariance matrix
function of the normalized series obtained by subtracting u from X, and then dividing
each component by its standard deviation.

Consider the bivariate stationary process {X;} defined by
Xn =2,
Xpo =2, +0.75Z;_0,
where {Z;} ~ WN(0, 1). Elementary calculations yield u = 0,

0 0.75 11 0 0
F=1 = [o 075}’ ro = [1 15625] rao = [075 075}’

and I'(j) = 0 otherwise. The correlation matrix function is given by

0 0.60 1 08 0 0
R(_IO):[O 0.48]’ R(O)Z[O.S 1]’ R(10)=[0.60 0.48]’

and R(j) = 0 otherwise.

Basic Properties of I'(-):

1. I'(h) =T'(=h),
2. vy < vy 01,4, j,=1,...,m,
3. y:(+) is an autocovariance function, i =1, ..., m, and

4. Z;kzla;F(j— k)a, >O0forallne{l,2,...}anda,,...,a, € R".

The first property follows at once from the definition, the second from the fact that
correlations cannot be greater than one in absolute value, and the third from the
observation that y;;(-) is the autocovariance function of the stationary series {X;;, t =
0, £1, ...}. Property 4 is a statement of the obvious fact that

n 2
E(Z a/(X; — u)) > 0. O
j=1

Remark 2. The basic properties of the matrices I"(k) are shared also by the cor-
responding matrices of correlations R(h) = [p,-j(h)]?fj:l, which have the additional

property
0i(0) =1 foralli.
The correlation p;;(0) is the correlation between X,; and Xj;, which is generally not

equal to 1 if i # j (see Example 8.2.1). It is also possible that |y;;(h)| > [y;(0)| if i # j
(see Problem 7.1). O
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The simplest multivariate time series is multivariate white noise, the definition of
which is quite analogous to that of univariate white noise.

Definition 8.2.2. | The m-variate series {Z;} is called white noise with mean 0 and covariance
matrix 3, written
{Z:} ~ WN(0, X), (8.2.9)

if {Z,} is stationary with mean vector 0 and covariance matrix function

if h =0
ra=1% 1 ’ (8.2.10)
0, otherwise.

Definition 8.2.3. | The m-variate series {Z,} is called iid noise with mean 0 and covariance matrix
I, written
{Z;} ~ 1id(0, ), (8.2.11)

if the random vectors {Z,} are independent and identically distributed with mean 0
and covariance matrix .

Multivariate white noise {Z,} is used as a building block from which can be
constructed an enormous variety of multivariate time series. The linear processes are
generated as follows.

Definition 8.2.4. | The m-variate series {X;} is a linear process if it has the representation

x= Z:qLﬁ,{Lywwiju (8.2.12)

j==00

where {C;} is a sequence of m x m matrices whose components are absolutely
summable.

The linear process (8.2.12) is stationary (Problem 7.2) with mean 0 and covariance
function

(0.¢]
I'(h) = Z Cin%C/, h=0,%l1,.... (8.2.13)

Jj=—00

An MA(o0) process is a linear process with C; = 0 for j < 0. Thus {X;} is an
MA(o0) process if and only if there exists a white noise sequence {Z,} and a sequence
of matrices C; with absolutely summable components such that

(0.¢]
X, =Y CZ.;.
j=0

Multivariate ARMA processes will be discussed in Section 8.4, where it will be shown
in particular that any causal ARMA(p, q) process can be expressed as an MA(c0)
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process, while any invertible ARMA(p, q) process can be expressed as an AR(c0)
process, i.e., a process satisfying equations of the form

oo
X+ ) AXi; =17,

J=1

in which the matrices A; have absolutely summable components.

8.2.1 Second-Order Properties in the Frequency Domain

Provided that the components of the covariance matrix function I"(-) have the property
ZZ‘;OO lyj(h)| < oo,i,j=1,...,m,then I' has a matrix-valued spectral density
function

1 - —i\h
f) = Eh;f T(h)y, —-m<i<m,

and I can be expressed in terms of f as

I'(h) = / ’ eMf()d.

-7
The second-order properties of the stationary process {X,} can therefore be described

equivalently in terms of f(-) rather than I' (-). Similarly, {X,} has a spectral represen-
tation

T
X, = / eMdZ (M),
where {Z(A), —m < A < m} is a process whose components are complex-valued
processes satisfying

_ w(Ndr it =,
E (dZ/(0)dZu () = [Jé"( : ?“ ) g
i 7

and Z; denotes the complex conjugate of Z,. We shall not go into the spectral
representation in this book. For details see Brockwell and Davis (1991).

8.3 Estimation of the Mean and Covariance Function

As in the univariate case, the estimation of the mean vector and covariances of a
stationary multivariate time series plays an important role in describing and model-
ing the dependence structure of the component series. In this section we introduce
estimators, for a stationary m-variate time series {X,}, of the components w;, y;;(h), and
pij(h) of w, I'(h), and R(h), respectively. We also examine the large-sample properties
of these estimators.

8.3.1 Estimation of u

A natural unbiased estimator of the mean vector g based on the observations
X1, ..., X, is the vector of sample means
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Proposition 8.3.1.

— 1 <
XH:ZEX,.

The resulting estimate of the mean of the jth time series is then the univariate sample
mean (1/n) ) ), X,;. If each of the univariate autocovariance functions y;;(-),i =
1, ..., m, satisfies the conditions of Proposition 2.4.1, then the consistency of the
estimator X,, can be established by applying the proposition to each of the component
time series {X;;}. This immediately gives the following result.

If {X;} is a stationary multivariate time series with mean p and covariance function
I'(:), then as n — oo,

E(Xn—ﬂ)/(in—u)ﬁo if yi(n) - 0, 1<i<m,

and

m (0.¢] o
nE(Xy—p) Xo—p) > > Y yalhy if D lyal) <oo, 1<i<m.
h=—00

i=1 h=—00

Under more restrictive assumptions on the process {X;} it can also be shown that
X, is approximately normally distributed for large n. Determination of the covariance
matrix of this distribution would allow us to obtain confidence regions for u. However,
this is quite complicated, and the following simple approximation is useful in practice.

For each i we construct a confidence interval for u; based on the sample mean X;
of the univariate series Xy, . .., X;; and combine these to form a confidence region for
. If fi(w) is the spectral density of the ith process {X,;} and if the sample size n is
large, then we know, under the same conditions as in Section 2.4, that /n (Z — M,-) is
approximately normally distributed with mean zero and variance

o
2w fiO) = Y yalh).

k=—00

It can also be shown (see, e.g., Anderson 1971) that
A 1nly .
21 fi(0) =) (1 —— ) Puth)
hl=r 4

is a consistent estimator of 2rf;(0), provided that r = r, is a sequence of numbers
depending on # in such a way that r, — oo and r,/n — 0 as n — oo. Thus if X;
denotes the sample mean of the ith process and @, is the a-quantile of the standard
normal distribution, then the bounds

Xi £ ®_op <27T}Aci(0)/”) v

are asymptotic (1 — o) confidence bounds for ;. Hence

_ . 12
P(Wi —Xi|l £ P1_ap (27T f,-(O)/n) yi=1,..., m)

>1- ZP <|Mi —Xi| > ®1_qp <27T ]Ac,'(o)/n>l/2> ;

i=1
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Theorem 8.3.1.

where the right-hand side converges to 1 — ma as n — oco. Consequently, as n — oo,
the set of m-dimensional vectors bounded by

_ ) 12
ixi =X £ P1_(w/2m)) <27Tf5(0)/”) i=1,..., m} (8.3.1)

has a confidence coefficient that converges to a value greater than or equal to 1 — «
(and substantially greater if m is large). Nevertheless, the region defined by (8.3.1) is
easy to determine and is of reasonable size, provided that m is not too large.

8.3.2 Estimation of I'(h)

As in the univariate case, a natural estimator of the covariance I'(h) = E [(XHh —
w) (X — n) ] is

n—h
['h) = n! ; (Xt+h _Xn) (Xt - Xn)/ for0 <h < —1,

I (=h) for —n+1<h<0.

Writing y;;(h) for the (i, j)-component of f‘(h), i,j=1,2,..., we estimate the cross-
correlations by

pij(h) = V(R (7(0) 7;(0)) ™72
If i = j, then p;; reduces to the sample autocorrelation function of the ith series.
Derivation of the large-sample properties of p; and p;; is quite complicated in
general. Here we shall simply note one result that is of particular importance for testing

the independence of two component series. For details of the proof of this and related
results, see Brockwell and Davis (1991).

Let {X,} be the bivariate time series whose components are defined by

o
Xn = Z aZi—k1, {Za) ~1D(0,07),

k=—00

and

o0
Xo= Y BiZika {(Zo)~1D(0,07),

k=—00

where the two sequences {Z;1} and {Z;} are independent, ), |ay| < o0, and

2k 1Bl < oo

Then for all integers h and k with h # k, the random variables n'/?p,(h)
and n'?p,(k) are approximately bivariate normal with mean 0, variance

Yoo P11(NP22()), and covariance Y2 p11(j)paa(j + k — h), for n large.

[For a related result that does not require the independence of the two series {X;1} and
{X;»} see Bartlett’s Formula, Section 8.3.4 below.]

Theorem 8.3.1 is useful in testing for correlation between two time series. If one
of the two processes in the theorem is white noise, then it follows at once from the
theorem that p,(h) is approximately normally distributed with mean 0 and variance
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Example 8.3.1.

1/n, in which case it is straightforward to test the hypothesis that p;,(#) = 0. However,
if neither process is white noise, then a value of (/) that is large relative to n~'/? does
not necessarily indicate that p;,(h) is different from zero. For example, suppose that
{X,1} and {X,»} are two independent AR(1) processes with pi1(h) = pan(h) = 0.8/,
Then the large-sample variance of pi,(h) is n~! (1 +2 2,21(0.64)") =4.556n"". 1t
would therefore not be surprising to observe a value of p;,(h) as large as 3n~!/2 even
though {X,1} and {X,»} are independent. If on the other hand, p;;(h) = 0.8"! and
pn(h) = (—0.8)" then the large-sample variance of pi»(h) is 0.2195n~!, and an
observed value of 3n~!/2 for p1,(h) would be very unlikely.

8.3.3 Testing for Independence of Two Stationary Time Series

Since by Theorem 8.3.1 the large-sample distribution of p1,(h) depends on both py;(-)
and px(-), any test for independence of the two component series cannot be based
solely on estimated values of pj,(h), h = 0, £1, ..., without taking into account the
nature of the two component series.

This difficulty can be circumvented by “prewhitening” the two series before
computing the cross-correlations p1,(h), i.e., by transforming the two series to white
noise by application of suitable filters. If {X;;} and {X,;} are invertible ARMA (p, q)
processes, this can be achieved by the transformations

o0
Z;= Z ﬂj([)Xt—j,i,
j=0

where Z;:o rrj(i)z-" = ¢V(2)/60"(2) and ¢, 8 are the autoregressive and moving-
average polynomials of the ith series, i = 1, 2.

Since in practice the true model is nearly always unknown and since the data X,
t < 0, are not available, it is convenient to replace the sequences {Z,;} by the residuals
{Wn‘} after fitting a maximum likelihood ARMA model to each of the component
series (see (5.3.1)). If the fitted ARMA models were in fact the true models, the series
{Wn‘} would be white noise sequences fori =1, 2.

To test the hypothesis Hy that {X,;} and {X,;} are independent series, we observe
that under Hy, the corresponding two prewhitened series {Z;;} and {Z;,} are also inde-
pendent. Theorem 8.3.1 then implies that the sample cross-correlations p15(h), p12(k),
h # k, of {Z,} and {Z;,} are for large n approximately independent and normally dis-
tributed with means 0 and variances n~!. An approximate test for independence can
therefore be obtained by comparing the values of |p12(h)| with 1.96n~1/2, exactly as
in Section 5.3.2. If we prewhiten only one of the two original series, say {X,;}, then
under Hy Theorem 8.3.1 implies that the sample cross-correlations p1,(h), p12(k),
h # k, of {Z,} and {X;} are for large n approximately normal with means 0, vari-
ances n~! and covariance n~! py,(k — h), where py(-) is the autocorrelation function
of {X,»}. Hence, for any fixed &, p12(h) also falls (under H,) between the bounds
+1.96n~!/? with a probability of approximately 0.95.

The sample correlation functions ﬁU(-), i,j = 1,2, of the bivariate time series
E731A. TSM (of length n = 200) are shown in Figure 8-7. Without taking into
account the autocorrelations p;;(+), i = 1, 2, it is impossible to decide on the basis of
the cross-correlations whether or not the two component processes are independent
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Figure 8-7

The sample correlations

of the bivariate series
E731A.TSM of

Example 8.3.1, showing the
bounds +1.96n~1/2
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of each other. Notice that many of the sample cross-correlations p;;(h), i # j, lie
outside the bounds £1.96n~'2 = +0.139. However, these bounds are relevant
only if at least one of the component series is white noise. Since this is clearly
not the case, a whitening transformation must be applied to at least one of the
two component series. Analysis using ITSM leads to AR(1) models for each. The
residuals from these maximum likelihood models are stored as a bivariate series in
the file E731B.TSM, and their sample correlations, obtained from ITSM, are shown
in Figure 8-8. All but two of the cross-correlations are between the bounds £0.139,
suggesting by Theorem 8.3.1 that the two residual series (and hence the two original
series) are uncorrelated. The data for this example were in fact generated as two
independent AR(1) series with ¢ = 0.8 and 02 = 1.

O

8.3.4 Bartlett’s Formula

In Section 2.4 we gave Bartlett’s formula for the large-sample distribution of the
sample autocorrelation vector p = (,6(1), e ,5(k))/ of a univariate time series.
The following theorem gives a large-sample approximation to the covariances of the
sample cross-correlations p1»(h) and py,(k) of the bivariate time series {X;} under the
assumption that {X,} is Gaussian. However, it is not assumed (as in Theorem 8.3.1)
that {X;,} is independent of {X,}.
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Corollary 8.3.1.

Example 8.3.2.

Bartlett’s Formula:
If {X;} is a bivariate Gaussian time series with covariances satisfying
Yo v < oo, i,j=1,2, then

o]

nlggo nCov(pi2(h), pra(k)) = Z |:/011(j)/)22(j +k—h)+ pr(j+kpeal—h

Jj=—00

—pr2(W{p11()Hp12(j + k) + p22()) p21(j — k)}
—pr2(){p11(Ne12(j+h) + p22(Npe2(j—h)}

1 2 . 2 . 1 2 .
+,012(h),012(k)i§i011(J) + )012(]) + 5)022(]) H

If {X,} satisfies the conditions for Bartlett’s formula, if either {X,} or {Xy,} is white
noise, and if

pi12(h) =0, h ¢la,b],
then

lim nVar (p12(h)) =1, h ¢ [a,b].

Sales with a leading indicator

We consider again the differenced series {D,;} and {D,,} of Example 8.1.2, for which
we found the maximum likelihood models (8.1.1) and (8.1.2) using ITSM. The resid-
uals from the two models (which can be filed by ITSM) are the two “whitened” series
{th} and {Wtz} with sample variances 0.0779 and 1.754, respectively. This bivariate
series is contained in the file E732. TSM.

The sample auto- and cross-correlations of {D,;} and {D;;} were shown in
Figure 8-6. Without taking into account the autocorrelations, it is not possible to
draw any conclusions about the dependence between the two component series from
the cross-correlations.

Examination of the sample cross-correlation function of the whitened series {W, 1}
and {W,z }, on the other hand, is much more informative. From Figure 8-9 it is apparent
that there is one large-sample cross-correlation (between W,+3,2 and W,_l), while the
others are all between £1.96n~/2.

([l

If {th} and {W,z} are assumed to be jointly Gaussian, Corollary 8.3.1 indicates
the compatibility of the cross-correlations with a model for which

p12(=3) #0
and
pr2(h) =0, h#-3.
The value p1,(—3) = 0.969 suggests the model
Wi = 4.74W,_31 + N,, (83.2)

where the stationary noise {N,} has small variance compared with {W,z} and {th},
and the coefficient 4.74 is the square root of the ratio of sample variances of {Wtz} and
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{th}. A study of the sample values of {Wtz — 4.74W,_3,1} suggests the model
(14 0.345B)N, = U,, {U,} ~ WN(0, 0.0782) (8.3.3)

for {N,}. Finally, replacing VAVQ and VAVI,M in (8.3.2) by Z,; and Z,_3 |, respectively, and
then using (8.1.1) and (8.1.2) to express Z; and Z,_3; in terms of {D,;} and {D,;}, we
obtain a model relating {D;}, {Dy,}, and {U;;}, namely,

Dj +0.0773 = (1 — 0.610B)(1 — 0.838B) "' [4.74(1 — 0.474B)™'D,_3 ,
+(1+40.345B)"'U,].

This model should be compared with the one derived later in Section 11.1 by the more
systematic technique of transfer function modeling.

8.4 Multivariate ARMA Processes

Definition 8.4.1.

Example 8.4.1.

As in the univariate case, we can define an extremely useful class of multivari-
ate stationary processes {X;} by requiring that {X;} should satisfy a set of linear
difference equations with constant coefficients. Multivariate white noise {Z,} (see
Definition 8.2.2) is a fundamental building block from which these ARMA processes
are constructed.

{X;} is an ARMA( p, q) process if {X;} is stationary and if for every ¢,
X -0 X1 — - —DX p =2 +O1 L1+ -+ 042y, (84.1)

where {Z;} ~ WN(0, X). ({X;}is an ARMA (p, q) process with mean pu if {X,—u}
is an ARMA(p, q) process.)

Equations (8.4.1) can be written in the more compact form
P(B)X; = OB)Z;, {Z;} ~ WN(0, %), (8.4.2)

where @(2) =1 —®1z— - — ®,2% and O(z) := 1+ O1z2+ - - - + O,z are matrix-
valued polynomials, / is the m x m identity matrix, and B as usual denotes the backward
shift operator. (Each component of the matrices @ (z), ® (z) is a polynomial with real
coefficients and degree less than or equal to p, g, respectively.)

The multivariate AR(1) process
Setting p = 1 and ¢ = 0 in (8.4.1) gives the defining equations

X, =®X,.1 +Z;, {Z}~WN(Q,3), (8.4.3)

for the multivariate AR(1) series {X;}. By exactly the same argument as used in
Example 2.2.1, we can express X; as

(0.¢]
X, =) /7, (8.4.4)
j=0

provided that all the eigenvalues of @ are less than 1 in absolute value, i.e., provided
that
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det(/ — z&) £ 0 forall z € C such that |z] < 1. (8.4.5)

If this condition is satisfied, then the coefficients @/ are absolutely summable, and
hence the series in (8.4.4) converges; i.e., each component of the matrix Z]"’:O DL,
converges (see Remark 1 of Section 2.2). The same argument as in Example 2.2.1 also
shows that (8.4.4) is the unique stationary solution of (8.4.3). The condition that all
the eigenvalues of @ should be less than 1 in absolute value (or equivalently (8.4.5))
is just the multivariate analogue of the condition |¢| < 1 required for the existence of
a causal stationary solution of the univariate AR(1) equations (2.2.8).
g
Causality and invertibility of a multivariate ARMA(p, g) process are defined
precisely as in Section 3.1, except that the coefficients /;, ; in the representations
X, = Zj ~oViZi—j and Z, = Z/ o ;i X;—; are replaced by m x m matrices ¥;
and IT; whose components are required to be absolutely summable. The followmg
two theorerns (proofs of which can be found in Brockwell and Davis (1991)) provide
us with criteria for causality and invertibility analogous to those of Section 3.1.

Causality:
An ARMA (p, q) process {X;} is causal, or a causal function of {Z,}, if there
exist matrices {¥;} with absolutely summable components such that

oo
X, =Y WZ_; forallr. (8.4.6)

J=0
Causality is equivalent to the condition

det @(z) # 0 for all z € C such that |z] < 1. (8.4.7)

The matrices ¥; are found recursively from the equations

W, = ()+Zq>k e j=0,1,..., (8.4.8)
k=1

where we define ®) = I, ®; = O forj > g, &; = 0 forj > p, and ¥; = O for
j<O.

Invertibility:
An ARMA(p, q) process {X;} is invertible if there exist matrices {II;} with
absolutely summable components such that

o
Z,=) TIIX,forallt. (8.4.9)
j=0
Invertibility is equivalent to the condition
det ®(z) # 0 for all z € C such that |z| < 1. (8.4.10)

The matrices IT; are found recursively from the equations

o
Mj=—-®-Y Ol j=01,..., (8.4.11)
k=1

where we define @y = —I, ®; = 0 forj > p, ®; = 0forj > ¢, and I1; = O for
j<0.




8.4

Multivariate ARMA Processes 245

Example 8.4.2.

For the multivariate AR(1) process defined by (8.4.3), the recursions (8.4.8) give
Y =1,
U =Yy =,
U = QY =

W= oW =/, j>3,

as already found in Example 8.4.1.

Remark 3. For the bivariate AR(1) process (8.4.3) with

0 05
® =
o]

it is easy to check that ¥; = @/ = 0 for j > 1 and hence that {X,} has the alternative
representation

X, =2Z;+PL;,

as an MA(1) process. This example shows that it is not always possible to distinguish
between multivariate ARMA models of different orders without imposing further
restrictions. If, for example, attention is restricted to pure AR processes, the prob-
lem does not arise. For detailed accounts of the identification problem for general
ARMA(p, g) models see Hannan and Deistler (1988) and Liitkepohl (1993). ]

8.4.1 The Covariance Matrix Function of a Causal ARMA Process

From (8.2.13) we can express the covariance matrix I"(h) = E(X,4,X]) of the causal
process (8.4.6) as

o0
I'(h) =lelh+jﬂl!lf-’, h=0,=%1,..., (8.4.12)
j=0
where the matrices ¥; are found from (8.4.8) and ¥; := 0 for j < 0.

The covariance matrices I'(h), h = 0, £1, ..., can also be found by solving the
Yule—Walker equations

p
T =D ®T(G—nN=) 6I¥, j=012..,

r=1 Jj<r<q
(8.4.13)

obtained by postmultiplying (8.4.1) by X;fj and taking expectations. The first p+ 1 of
the equation (8.4.13) can be solved for the components of I'(0), ..., I'(p) using the
fact that I'(—h) = I'/(h). The remaining equations then give I'(p + 1), T'(p + 2), ...
recursively. An explicit form of the solution of these equations can be written down
by making use of Kronecker products and the vec operator (see e.g., Liitkepohl 1993).

Remark 4. If 7, is the root of det @ (z) = 0 with smallest absolute value, then it can
be shown from the recursions (8.4.8) that ¥;/ r/ — 0asj — oo for all r such that
lzo]~' < r < 1. Hence, there is a constant C such that each component of W, is smaller
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in absolute value than Cr/. This implies in turn that there is a constant K such that each
component of the matrix ¥,,; X ‘I/j/ on the right of (8.4.12) is bounded in absolute value
by Kr%. Provided that |zy| is not very close to 1, this means that the series (8.4.12) con-
verges rapidly, and the error incurred in each component by truncating the series after
the term with j = k — 1 is smaller in absolute value than Zfik Kr¥ = Kr?k/ (1 — rz).

8.5 Best Linear Predictors of Second-Order Random Vectors

Let {X, = Xi,..., Xum) } be an m-variate time series with means EX; = u, and
covariance function given by the m x m matrices

K, j) = E (XX)) — .

IfY = (Y, ...,Y,) is arandom vector with finite second moments and EY = u, we
define

Pn(Y) = (PnYl’---’PnYm)/y (851)
where P,Y; is the best linear predictor of the component Y; of Y in terms of all
of the components of the vectors X;,t = 1,...,n, and the constant 1. It follows
immediately from the properties of the prediction operator (Section 2.5) that

Py(Y) =p+A1(Xy — ) + -+ A(Xy — 1) (8.5.2)
for some matrices Ay, ..., A,, and that

Y-P,(Y) LX, 11, i=1,...,n, (8.5.3)

where we say that two m-dimensional random vectors X and Y are orthogonal (written
X 1Y) if E(XY’) is a matrix of zeros. The vector of best predictors (8.5.1) is uniquely
determined by (8.5.2) and (8.5.3), although it is possible that there may be more than

one possible choice for Ay, ..., A,.

As a special case of the above, if {X,} is a zero-mean time series, the best linear
predictor X,,H of X, in terms of X4, ..., X,, is obtained on replacing Y by X, in
(8.5.1). Thus

A 0, if n =0,
Xn+1 =

Pn(Xn+1)’ ifn > 1.

Hence, we can write

X1 = PuXp -+ @0 Xy, n=1,2,..., (8.5.4)
where, from (8.5.3), the coefficients ®,;, j =1, ..., n, are such that
E (X,,Hx;ﬂ_l.) —EXu X, ). i=1.....n (8.5.5)

ie.,

Y ®Kmn+1—jn+l—i)=Kn+ln+1—i), i=1_...n
Jj=1

In the case where {X,} is stationary with K (i, j) = I'(i — j), the prediction equations
simplify to the m-dimensional analogues of (2.5.7), i.e.,

Y @, Li—j)=C@. i=1....n (8.5.6)

J=1
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8.6 Modeling and

Provided that the covariance matrix of the nm components of Xj, ..., X, is nonsin-
gular for every n > 1, the coefficients {®,;} can be determined recursively using
a multivariate version of the Durbin-Levinson algorithm given by Whittle (1963)
(for details see Brockwell and Davis (1991), Proposition 11.4.1). Whittle’s recursions
also determine the covariance matrices of the one-step prediction errors, namely,
Vo =T'(0) and, forn > 1,

Vi = Eurt = X)) Kot — X))’
=I0) —®.I'(=1) =+ = Dy, ' (—n). (8.5.7)
Remark 5. The innovations algorithm also has a multivariate version that can be used

for prediction in much the same way as the univariate version described in Section 2.5.4
(for details see Brockwell and Davis (1991), Proposition 11.4.2). O

Forecasting with Multivariate AR Processes

If {X,} is any zero-mean second-order multivariate time series, it is easy to show from
the results of Section 8.5 (Problem 8.4) that the one-step prediction errors X; — X,
j=1,...,n, have the property

E (X,- - X,) (Xk — Xk) — 0 forj # k. (8.6.1)
Moreover, the matrix M such that
X, — X ] [X,]
X —Xo X
X3—X; | =M|Xs (8.6.2)
_Xn - Xn_ _Xn_

is lower triangular with ones on the diagonal and therefore has determinant equal to 1.

If the series {X,} is also Gaussian, then (8.6.1) implies that the prediction errors
U=X— X,,j = 1, ..., n, are independent with covariance matrices Vj, ..., V,_1,
respectively (as specified in (8.5.7)). Consequently, the joint density of the prediction
errors is the product

~1)2
n 1 n 3
fQuy, ..., u,) = Qmx)"? Hdeth_l exp ) Z“}ij“j
j=1 j=1

Since the determinant of the matrix M in (8.6.2) is equal to 1, the joint density of the
observations Xi, ..., X, at Xy, ..., X, is obtained on replacing uy, ..., u, in the last
expression by the values of X; — Xj corresponding to the observations xi, ..., X,.

If we suppose that {X;} is a zero-mean m-variate AR(p) process with coefficient
matrices ¢ = {®y, ..., D,} and white noise covariance matrix ¥, we can therefore
express the likelihood of the observations Xy, ..., X, as

—1/2

n 1 n o
L@, %) = @m)"> [ ][ detv;y exp —EZUjijlU, :

j=1 j=1
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where U; = X; — Xj,j =1,...,n, and X, and V; are found from (8.5.4), (8.5.6),
and (8.5.7).

Maximization of the Gaussian likelihood is much more difficult in the multivariate
than in the univariate case because of the potentially large number of parameters
involved and the fact that it is not possible to compute the maximum likelihood
estimator of @ independently of ¥ as in the univariate case. In principle, maximum
likelihood estimators can be computed with the aid of efficient nonlinear optimization
algorithms, but it is important to begin the search with preliminary estimates that are
reasonably close to the maximum. For pure AR processes good preliminary estimates
can be obtained using Whittle’s algorithm or a multivariate version of Burg’s algorithm
given by Jones (1978). We shall restrict our discussion here to the use of Whit-
tle’s algorithm (the multivariate option AR-Model>Estimation>Yule-Walker
in ITSM), but Jones’s multivariate version of Burg’s algorithm is also available
(AR-Model>Estimation>Burg). Other useful algorithms can be found in Liitke-
pohl (1993), in particular the method of conditional least squares and the method of
Hannan and Rissanen (1982), the latter being useful also for preliminary estimation in
the more difficult problem of fitting ARMA(p, g) models with ¢ > 0. Spectral meth-
ods of estimation for multivariate ARMA processes are also frequently used. A dis-
cussion of these (as well as some time-domain methods) is given in Anderson (1980).

Order selection for multivariate autoregressive models can be made by minimizing
a multivariate analogue of the univariate AICC statistic

2(pm? + )nm

AICC = —2InL(®Dy, ..., Dy, X) + 3 .
nm — pm* — 2

(8.6.3)

8.6.1 Estimation for Autoregressive Processes Using Whittle’s Algorithm

If {X,} is the (causal) multivariate AR( p) process defined by the difference equations

Xi =0 X1+ -+ P Xy +Zy,  {Z:) ~ WN(, ¥), (8.6.4)
then postmultiplying by X;fj, j =0, ..., p,and taking expectations gives the equations
p
L =T0) - &I(=) (8.6.5)
j=1
and
F(i):ZcDjF(i—j), i=1,...,p. (8.6.6)
J=1
Given the matrices I'(0), ..., ['(p), equation (8.6.6) can be used to determine the
coefficient matrices @y, ..., ®,. The white noise covariance matrix ¥ can then
be found from (8.6.5). The solution of these equations for @y, ..., ®,, and ¥ is
identical to the solution of (8.5.6) and (8.5.7) for the prediction coefficient matrices
Dy, ..., Dy, and the corresponding prediction error covariance matrix V,. Conse-

quently, Whittle’s algorithm can be used to carry out the algebra.

The Yule—Walker estimators qsl, e qﬁp, and j] for the model (8.6.4) fitted to
the data Xy, ..., X, are obtained by replacing I'(j) in (8.6.5) and (8.6.6) by f‘(j),
Jj = 0,...,p, and solving the resulting equations for &y, ..., ®,, and J. The
solution of these equations is obtained from ITSM by selecting the multivariate
option AR-Model>Estimation>Yule-Walker. The mean vector of the fitted
model is the sample mean of the data, and Whittle’s algorithm is used to solve the
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Example 8.6.1

Example 8.6.2

equations (8.6.5) and (8.6.6) for the coefficient matrices and the white noise covariance
matrix. The fitted model is displayed by ITSM in the form

Xi=¢o+ &1 X1+ + P Xop + Zi, {Z,} ~ WN(O, X).
Note that the mean u of this model is not the vector ¢y, but

p=(—Pr—- =P .

In fitting multivariate autoregressive models using ITSM, check the box Find
minimum AICC model to find the AR(p) model with 0 < p < 20 that mini-
mizes the AICC value as defined in (8.6.3).

Analogous calculations using Jones’s multivariate version of Burg’s algorithm can
be carried out by selecting AR-Model>Estimation>Burg.

The Dow Jones and All Ordinaries Indices

To find the minimum AICC Yule—Walker model (of order less than or equal to 20) for
the bivariate series {(X;1, Xp»)', t = 1, ..., 250} of Example 8.1.1, proceed as follows.
Select File>Project>Open>Multivariate,click OK, and then double-click
on the file name, DJAOPC2.TSM. Check that Number of columns is set to 2,
the dimension of the observation vectors, and click OK again to see graphs of the two
component time series. No differencing is required (recalling from Example 8.1.1 that
{X;1} and {X,} are the daily percentage price changes of the original Dow Jones and
All Ordinaries Indices). Select AR-Model>Estimation>Yule-Walker, check
the box Find minimum AICC Model, click OK, and you will obtain the model

(X, ] [ 0.0288 L [—0-0148 0.0357] X, 1] | [Zn
Xp |~ [0.00836 0.6589  0.0998 | | X,—1 Zn]’

[Z] 0] [0.3653 0.0224
~ WN .
A <[o]’[0.0224 0.6016D

where

Sales with a leading indicator

The series {Y;;} (leading indicator) and {Y,,} (sales) are stored in bivariate form
(Y;; in column 1 and Y, in column 2) in the file LS2.TSM. On opening this file
in ITSM you will see the graphs of the two component time series. Inspection of
the graphs immediately suggests, as in Example 8.2.2, that the differencing operator
V =1 — B should be applied to the data before a stationary AR model is fitted. Select
Transform>Difference and specify 1 for the differencing lag. Click OK and
you will see the graphs of the two differenced series. Inspection of the series and
their correlation functions (obtained by pressing the second yellow button at the top
of the ITSM window) suggests that no further differencing is necessary. The next
step is to select AR-model>Estimation>Yule-Walker with the option Find
minimum AICC model. The resulting model has order p = 5 and parameters
¢o = (0.0328 0.0156),

6 _[0517 00247 o [-0.192 —0018] 5 _[-0.073 0010
"7 120019 —0.051| 27| 0047 0250 |" " | 4678 0.207]"
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5 =

A [—0.032 —0.009] é

6, — 0.022 0.0117 = 0.076  —0.003
Y7 3.664  0.004 ’

1.300 0.029 k= —0.003 0.095

with AICC=109.49. (Analogous calculations using Burg’s algorithm give an AR(8)
model for the differenced series.) The sample cross-correlations of the residual
vectors Z, can be plotted by clicking on the last blue button at the top of the ITSM
window. These are nearly all within the bounds +1.96/./n, suggesting that the
model is a good fit. The components of the residual vectors themselves are plot-
ted by selecting AR Model>Residual Analysis>Plot Residuals. Sim-
ulated observations from the fitted model can be generated using the option AR
Model>Simulate.The fitted model has the interesting property that the upper right
component of each of the co- efficient matrices is close to zero. This suggests that {X,;}
can be effectively modeled independently of {X,,}. In fact, the MA(1) model

Xn =1 —-0474B)U;, {U;} ~WN(0, 0.0779), (8.6.7)

provides an adequate fit to the univariate series {X;;}. Inspecting the bottom rows of
the coefficient matrices and deleting small entries, we find that the relation between
{X;1} and {X;,} can be expressed approximately as

X = 0.250X,_5, +0.207X,_3, +4.678X,_3,1 + 3.664X,_4 1 + 1.300X,_51 + W,,
or equivalently,
_ 4.678B°(1 4+ 0.783B + 0.278B%) W,

o 1 — 0.250B% — 0.207B3 T 02508 — 02078
(8.6.8)

where {W;} ~ WN(0, 0.095). Moreover, since the estimated noise covariance matrix is
essentially diagonal, it follows that the two sequences {X;;} and {W,} are uncorrelated.
This reduced model defined by (8.6.7) and (8.6.8) is an example of a transfer function
model that expresses the “output” series {X,} as the output of a linear filter with “input”
{X;1} plus added noise. A more direct approach to the fitting of transfer function models

is given in Section 11.1 and applied to this same data set.
0

8.6.2 Forecasting Multivariate Autoregressive Processes

The technique developed in Section 8.5 allows us to compute the minimum mean
squared error one-step linear predictors )A(HH for any multivariate stationary time series
from the mean g and autocovariance matrices I' (%) by recursively determining the
coefficients @,;,i = 1, ..., n, and evaluating

A

Xop1 =+ @uXy — ) + -+ + @ (Xy — ). (8.6.9)

The situation is simplified when {X,} is the causal AR(p) process defined by
(8.6.4), since for n > p (as is almost always the case in practice)

Xpp1 = D X4 4 D, X1 (8.6.10)

To verify (8.6.10) it suffices to observe that the right-hand side has the required form
(8.5.2) and that the prediction error

Xn+l - ¢1Xn - cDp)(n+l—p = Zn+l
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is orthogonal to X, ..., X, in the sense of (8.5.3). (In fact, the prediction error is
orthogonal to all X;, —oo < j < n, showing that if n > p, then (8.6.10) is also the
best linear predictor of X,,1; in terms of all components of X;, —oco < j < n.) The
covariance matrix of the one-step prediction error is clearly E(Z,,Z; ) = X.

To compute the best h-step linear predictor P, X, based on all the components
of Xy, ..., X, we apply the linear operator P, to (8.6.4) to obtain the recursions

P Xoin = P1P Xppn—1+ -+ ¢anXn+h7p- (8.6.11)

These equations are easily solved recursively, first for P, X, ., then for P,X,.,,
P, X3, ..., etc. If n > p, then the h-step predictors based on all components of
Xj, —00 < j =< n, also satisfy (8.6.11) and are therefore the same as the h-step
predictors based on X1, ..., X,.

To compute the A4-step error covariance matrices, recall from (8.4.6) that

o0
Xoin =Y ¥Znin s (8.6.12)

J=0

where the coefficient matrices ¥; are found from the recursions (8.4.8) with g = 0.
From (8.6.12) we find that for n > p,

[e¢)
PXoin =Y YLy (8.6.13)

j=h

Subtracting (8.6.13) from (8.6.12) gives the h-step prediction error

h—1
Xoin = PuXuin = ) Wi, (8.6.14)
j=0
with covariance matrix
h—1
E[Xuin = PuXoin) Xsn = PuXopn) ] = )W R, nzp. (8615
j=0

For the (not necessarily zero-mean) causal AR(p) process defined by
Xi=¢o+ P21 X1+ + PpXi, + 7y, {Zi} ~ WN(O, ),

Equations (8.6.10) and (8.6.11) remain valid, provided that ¢, is added to each of their
right-hand sides. The error covariance matrices are the same as in the case ¢y = 0.

The above calculations are all based on the assumption that the AR(p) model
for the series is known. However, in practice, the parameters of the model are usually
estimated from the data, and the uncertainty in the predicted values of the series will be
larger than indicated by (8.6.15) because of parameter estimation errors. See Liitkepohl
(1993).

The Dow Jones and All Ordinaries Indices
The VAR (1) model fitted to the series {X;,# =1, ..., 250} in Example 8.6.1 was

(X, ] [ 0.0288 L [0-0148 0.03577 (X117 | [Zn
| X | [0.00836 0.6589  0.0998 | | X,—1 Zn]’

[Z,] 0] [0.3653 0.0224
~ WN )
Zn | <[o]’[0.0224 0.6016D

where
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The one-step mean squared error for prediction of Xj,, assuming the validity of this
model, is thus 0.6016. This is a substantial reduction from the estimated mean squared
error P»,(0) = 0.7712 when the sample mean (1, = 0.0309 is used as the one-step
predictor.

If we fit a univariate model to the series {X;;} using ITSM, we find that the
autoregression with minimum AICC value (645.0) is

Xp =0.0273 4+ 0.1180X,_1 2 + Z;,, {Z;} ~ WN(0, 0.7604).

Assuming the validity of this model, we thus obtain a mean squared error for one-
step prediction of 0.7604, which is slightly less than the estimated mean squared error
(0.7712) incurred when the sample mean is used for one-step prediction.

The preceding calculations suggest that there is little to be gained from the
point of view of one-step prediction by fitting a univariate model to {X,,}, while
there is a substantial reduction achieved by the bivariate AR(1) model for {X, =
(X1, Xp)'}.

To test the models fitted above, we consider the next forty values {X,,t =
251, ...,290}, which are stored in the file DJAOPCE.TSM. We can use these val-
ues, in conjunction with the bivariate and univariate models fitted to the data for
t=1,...,250, to compute one-step predictors of Xy, t = 251, ...,290. The results
are as follows:

Predictor ~ Average Squared Error

fi = 0.0309 0.4706
AR(1) 0.4591
VAR(]) 0.3962

It is clear from these results that the sample variance of the series {X,,, t = 251, ...,
290} is rather less than that of the series {X;», ¢ = 1,...,250}, and consequently,
the average squared errors of all three predictors are substantially less than expected
from the models fitted to the latter series. Both the AR(1) and VAR(1) models show
an improvement in one-step average squared error over the sample mean ji, but the
improvement shown by the bivariate model is much more pronounced.
O
The calculation of predictors and their error covariance matrices for multivari-
ate ARIMA and SARIMA processes is analogous to the corresponding univariate
calculation, so we shall simply state the pertinent results. Suppose that {Y,} is
a nonstationary process satisfying D(B)Y, = U, where D(z) = 1 —dijz—--- —d,7 is
a polynomial with D(1) = 0 and {U,} is a causal invertible ARMA process with mean
. Then X, = U, — p satisfies

®(B)X;, =OB)ZL,, {Z;} ~WN(, ). (8.6.16)

Under the assumption that the random vectors Y_,,1, ..., Yo are uncorrelated with
the sequence {Z,}, the best linear predictors 13an of Y;,j > n > 0, based on 1 and
the components of Y;, —r 4+ 1, < j < n, are found as follows. Compute the observed
values of U, = D(B)Y;,t = 1, ..., n, and use the ARMA model for X; = U, — u to
compute predictors P, U, ;. Then use the recursions

Py Yoin=PUpin+ Y diPoYuin (8.6.17)
j=1
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to compute successively i’,,YnH, f’,,Y,,+2, f’nY,,H, etc. The error covariance matrices
are approximately (for large n)

h—1
E | Yon = PaYasn) uen = B Yo | = D 459, (8.6.18)
j=0
where " is the coefficient of Z/ in the power series expansion

Y ¥ =DE ' @0@, <.
Jj=0

The matrices ¥;* are most readily found from the recursions (8.4.8) after replacing

®,j =1,...,p, by 451.*,j =1,...,p + r, where cDj?“ is the coefficient of 7/ in
D(2)P(2).

Remark 6. In the special case where ®(z) = I (i.e., in the purely autoregressive
case) the expression (8.6.18) for the h-step error covariance matrix is exact for all
n > p (i.e., if there are at least p 4 r observed vectors). The program ITSM allows
differencing transformations and subtraction of the mean before fitting a multivariate
autoregression. Predicted values for the original series and the standard deviations of
the prediction errors can be determined using the multivariate option Forecast -
ing>AR Model. O

Remark 7. In the multivariate case, simple differencing of the type discussed in this
section where the same operator D(B) is applied to all components of the random
vectors is rather restrictive. It is useful to consider more general linear transformations
of the data for the purpose of generating a stationary series. Such considerations lead
to the class of cointegrated models discussed briefly in Section 8.7 below. O

Sales with a leading indicator

Assume that the model fitted to the bivariate series {Y;,z = 0, ..., 149} in Exam-
ple 8.6.2 is correct, i.e., that

OBX, =2, {Z)~WN(0%),
where
X, =(1—-B)Y,—(0.0228,0.420)', t=1,..., 149,

dB) = I — qslB — e = 03535, and 031, el 035, ﬁ] are the matrices found
in Example 8.6.2. Then the one- and two-step predictors of X59 and X5, are obtained
from (8.6.11) as

A A 0.163
149X150 18949 + - + PsAys5 [_0‘217:|
and
A A A —0.027
P149Xi51 = D1P149X150 + P2 Xjg9 + -+ - + @5 X4 = |: 0.816 ]

with error covariance matrices, from (8.6.15),

g 0.076 —0.003
~ [=0.003 0.095
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and

P 0.096 —0.002
D], =
%+ P4 [—0.002 0.095 } ’
respectively.
Similarly, the one- and two-step predictors of Y59 and Y;5; are obtained from

(8.6.17) as

N [0.0228] 13.59

P149Y 150 = | 0.420 + P149Xi50 + Y149 = |:262.90:|
and

- [0.0228] . 13.59

Pi4oY151 = | 0.420 | + P149Xis; + Pi1aoY 150 = |:264.14:|

with error covariance matrices, from (8.6.18),

5 = 0.076  —0.003
~ | —0.003  0.095

and
we(ed)w (i) = G0 TR

respectively. The predicted values and the standard deviations of the predictors can
easily be verified with the aid of the program ITSM. It is also of interest to compare the
results with those obtained by fitting a transfer function model to the data as described

in Section 11.1 below.
OJ

We have seen that nonstationary univariate time series can frequently be made
stationary by applying the differencing operator V = 1 — B repeatedly. If {V"X,} is
stationary for some positive integer d but {Vd_lX,} is nonstationary, we say that {X,}
is integrated of order d, or more concisely, {X;} ~ I(d). Many macroeconomic
time series are found to be integrated of order 1.

If {X;} is a k-variate time series, we define {V"Xt} to be the series whose jth
component is obtained by applying the operator (1 — B)“ to the jth component of {X,},
j = 1,..., k. The idea of a cointegrated multivariate time series was introduced by
Granger (1981) and developed by Engle and Granger (1987). Here we use the slightly
different definition of Liitkepohl (1993). We say that the k-dimensional time series {X,}
is integrated of order d (or {X,} ~ I(d)) if d is a positive integer, {V"Xt} is stationary,
and {Vd_lXt} is nonstationary. The I(d) process {X,} is said to be cointegrated with
cointegration vector « if ac is a k x 1 vector such that {a/X} is of order less than d.

A simple example is provided by the bivariate process whose first component is the
random walk

t
X,=) 27, t=12.., (Z}~1D(0.07%),
j=1
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Example 8.7.2

Problems

and whose second component consists of noisy observations of the same random walk,
Yi=X+W, t=12,..., {W}~ID(0, 1%,

where {W,} is independent of {Z}. Then {(X,, Y,)’} is integrated of order 1 and
cointegrated with cointegration vector a = (1, —1).

The notion of cointegration captures the idea of univariate nonstationary time
series “moving together.” Thus, even though {X;} and {Y,} in Example 8.7.1 are both
nonstationary, they are linked in the sense that they differ only by the stationary
sequence {W,}. Series that behave in a cointegrated manner are often encountered in
economics. Engle and Granger (1991) give as an illustrative example the prices of
tomatoes U, and V; in Northern and Southern California. These are linked by the fact
that if one were to increase sufficiently relative to the other, the profitability of buying
in one market and selling for a profit in the other would tend to push the prices (U;, V;)’
toward the straight line v = u in R?. This line is said to be an attractor for (U,, V,)’,
since although U, and V, may both vary in a nonstationary manner as ¢ increases, the

points (U;, V;)’ will exhibit relatively small random deviations from the line v = u.
O

If we apply the operator V = 1 — B to the bivariate process defined in Example 8.7.1
in order to render it stationary, we obtain the series (U, V;)’, where

Ut == Zt
and
Vl‘ = ZI + Wl‘ —_ Wtfl.

The series {(U;, V;)'} is clearly a stationary multivariate MA(1) process

A | P o R P

However, the process {(U,, V;)'} cannot be represented as an AR(c0) process, since
the matrix [(1) (1)] — z[_ol 01] has zero determinant when z = 1, thus violating condition
(8.4.10). Care is therefore needed in the estimation of parameters for such models (and
the closely related error-correction models). We shall not go into the details here but
refer the reader to Engle and Granger (1987) and Liitkepohl (1993).

O

8.1 Let {Y;} be a stationary process and define the bivariate process X;; = Y;, Xpp =
Y;_4, where d # 0. Show that {(X,{, X))’} is stationary and express its cross-
correlation function in terms of the autocorrelation function of {Y;}. If py(h) — 0
as h — oo, show that there exists a lag k for which p1,(k) > p12(0).

8.2 Show that the covariance matrix function of the multivariate linear process defined
by (8.2.12) is as specified in (8.2.13).

8.3 Let {X,} be the bivariate time series whose components are the MA(1) processes
defined by

X1 =2,+08Z_11, {Zu}~1D(0,07),
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8.5

8.6

8.7

8.8

and
Xo=2,—0.6Z_15 {Zo} ~1D(0,07),

where the two sequences {Z,;} and {Z;,} are independent.

a. Find a large-sample approximation to the variance of n'/2,,(h).

b. Find a large-sample approximation to the covariance of n'/?p;,(h) and
n'2p1, (k) for h # k.

Use the characterization (8.5.3) of the multivariate best linear predictor of Y in
terms of {Xj,...X,} to establish the orthogonality of the one-step prediction
errors X; — X and X; — Xy, j # k, as asserted in (8.6.1).

Determine the covariance matrix function of the ARMA(1,1) process satisfying

X, — X1 =2, +0OZ,_,, {Z,)~WN(Q,DL),

0.5 0‘5].

where I, is the 2 x 2 identity matrix and @ = @' = [ 0 05

a. Let {X;} be a causal AR(p) process satisfying the recursions
X=X+ + DX, +Z;, {Z,} ~WN(Q, ).

For n > p write down recursions for the predictors P,X, s, & > 0, and
find explicit expressions for the error covariance matrices in terms of the AR
coefficients and ¥ when & = 1, 2, and 3.

b. Suppose now that {Y,} is the multivariate ARIMA(p, 1, 0) process satisfying
VY, = X,, where {X,} is the AR process in (a). Assuming that E(Y,X]) = 0,
for t > 1, show (using (8.6.17) with r = 1 and d = 1) that

h
Pn(Yn+h) =Y, + Z Pan—i-jy
Jj=1

and derive the error covariance matrices when 2 = 1, 2, and 3. Compare these
results with those obtained in Example 8.6.4.

Use the program ITSM to find the minimum AICC AR model of order less
than or equal to 20 for the bivariate series {(X;, X)',t = 1,...,200} with
components filed as APPJK2.TSM. Use the fitted model to predict (X;;, Xy2),
t = 201,202, 203 and estimate the error covariance matrices of the predictors
(assuming that the fitted model is appropriate for the data).

Let {X;;,t = 1,...,63} and {X»,t = 1, ..., 63} denote the differenced series
{VInY;} and {VIn Yy}, where {Y;;} and {Y,,} are the annual mink and muskrat
trappings filed as APPH.TSM and APPL.TSM, respectively).

a. Use ITSM to construct and save the series {X;;} and {X,} as univariate
data files X1.TSM and X2.TSM, respectively. (After making the required
transformations press the red EXP button and save each transformed series to
a file with the appropriate name.) To enter X1 and X2 as a bivariate series in
ITSM, open X1 as a multivariate series with Number of columns equal
to 1. Then open X2 as a univariate series. Click the project editor button (at
the top left of the ITSM window), click on the plus signs next to the projects
X1.TSM and X2.TSM, then click on the series that appears just below X2.TSM
and drag it to the first line of the project X1.TSM. It will then be added as a
second component, making X1.TSM a bivariate project consisting of the two
component series X1 and X2. Click OK to close the project editor and close
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the ITSM window labeled X2.TSM. You will then see the graphs of X1 and
X2. Press the second yellow button to see the correlation functions of {X;;} and
{X1»}. For more information on the project editor in ITSM consult the Project
Editor section of the PDF file ITSM_HELP.

b. Conduct a test for independence of the two series {X;;} and {X;;}.

8.9 Use ITSM to open the data file STOCK7.TSM, which contains the daily returns
on seven different stock market indices from April 27th, 1998, through April
9th, 1999. (Consult the Data Sets section of the PDF file ITSM_HELP for more
information.) Fit a multivariate autoregression to the trivariate series consisting
of the returns on the Dow Jones Industrials, All Ordinaries, and Nikkei indices.
Check the model for goodness of fit and interpret the results.
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9.1 State-Space Representations

9.2 The Basic Structural Model

9.3 State-Space Representation of ARIMA Models
9.4 The Kalman Recursions

9.5 Estimation for State-Space Models

9.6 State-Space Models with Missing Observations
9.7 The EM Algorithm

9.8 Generalized State-Space Models

In recent years state-space representations and the associated Kalman recursions
have had a profound impact on time series analysis and many related areas. The
techniques were originally developed in connection with the control of linear systems
(for accounts of this subject see Davis and Vinter 1985; Hannan and Deistler 1988).
An extremely rich class of models for time series, including and going well beyond
the linear ARIMA and classical decomposition models considered so far in this book,
can be formulated as special cases of the general state-space model defined below in
Section 9.1. In econometrics the structural time series models developed by Harvey
(1990) are formulated (like the classical decomposition model) directly in terms of
components of interest such as trend, seasonal component, and noise. However, the
rigidity of the classical decomposition model is avoided by allowing the trend and
seasonal components to evolve randomly rather than deterministically. An introduction
to these structural models is given in Section 9.2, and a state-space representation is
developed for a general ARIMA process in Section 9.3. The Kalman recursions, which
play a key role in the analysis of state-space models, are derived in Section 9.4. These
recursions allow a unified approach to prediction and estimation for all processes
that can be given a state-space representation. Following the development of the
Kalman recursions we discuss estimation with structural models (Section 9.5) and
the formulation of state-space models to deal with missing values (Section 9.6). In
Section 9.7 we introduce the EM algorithm, an iterative procedure for maximizing the
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likelihood when only a subset of the complete data set is available. The EM algorithm
is particularly well suited for estimation problems in the state-space framework. Gen-
eralized state-space models are introduced in Section 9.8. These are Bayesian models
that can be used to represent time series of many different types, as demonstrated by
two applications to time series of count data. Throughout the chapter we shall use the
notation

{W:} ~ WN(O, {R;})
to indicate that the random vectors W, have mean 0 and that

Rt, ifS = t,

E(W,W)) =
( ‘ t) 0, otherwise.

9.1 State-Space Representations

A state-space model for a (possibly multivariate) time series {Y,,t = 1,2,...}
consists of two equations. The first, known as the observation equation, expresses
the w-dimensional observation Y, as a linear function of a v-dimensional state variable
X, plus noise. Thus

Yl:Gle+Wt7 t:1,2,..., (9.1.1)

where {W,} ~ WN(0, {R;}) and {G,} is a sequence of w x v matrices. The second
equation, called the state equation, determines the state X, at time # 4 1 in terms of
the previous state X, and a noise term. The state equation is

Xl‘+1:Fl‘XI+VI7 r= 1727"'7 (912)

where {F,} is a sequence of v x v matrices, {V,} ~ WN(0,{Q,}), and {V,} is
uncorrelated with {W,} (i.e., E(W,V,) = 0 for all s and 7). To complete the
specification, it is assumed that the initial state X is uncorrelated with all of the noise
terms {V,} and {W,}.

Remark 1. A more general form of the state-space model allows for correlation
between V; and W, (see Brockwell and Davis (1991), Chapter 12) and for the addition
of a control term H,u, in the state equation. In control theory, H,u, represents the effect
of applying a “control” u, at time ¢ for the purpose of influencing X, ;. However, the
system defined by (9.1.1) and (9.1.2) with £ (WIV;) = O for all s and ¢ will be adequate
for our purposes. U

Remark 2. In many important special cases, the matrices Fy, G;, Q;, and R, will
be independent of ¢, in which case the subscripts will be suppressed. ([l

Remark 3. It follows from the observation equation (9.1.1) and the state equation
(9.1.2) that X, and Y, have the functional forms, forr =2, 3, .. .,
X, =F_ 1 X1+ Vi
=F_1(Fi2X; 2+ Vi) + Vi

=F - F)Xi +F—---F)Vi+- -+ F Vo + Vi
=fi(X1, Vi, ..., Vi) (9.1.3)
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Definition 9.1.1

Example 9.1.1

Example 9.1.2

and

Yt=gt(X17V1""’VI71’Wl‘)' D (914)

Remark 4. From Remark 3 and the assumptions on the noise terms, it is clear that
E(VX)=0  E(VY,))=0, 1=<s<t,
and

E(WX)) =0, 1=<s<t, EWY)=0, 1<s<t. O

A time series {Y,} has a state-space representation if there exists a state-space
model for {Y,} as specified by equations (9.1.1) and (9.1.2).

As already indicated, it is possible to find a state-space representation for a large
number of time-series (and other) models. It is clear also from the definition that
neither {X;} nor {Y,} is necessarily stationary. The beauty of a state-space representa-
tion, when one can be found, lies in the simple structure of the state equation (9.1.2),
which permits relatively simple analysis of the process {X;}. The behavior of {Y,}
is then easy to determine from that of {X,} using the observation equation (9.1.1).
If the sequence {X;, Vi, V,, ...} is independent, then {X,} has the Markov property;
i.e., the distribution of X, given X, ..., X is the same as the distribution of X, ;
given X,. This is a property possessed by many physical systems, provided that we
include sufficiently many components in the specification of the state X, (for example,
we may choose the state vector in such a way that X, includes components of X;_; for
each ).

An AR(1) Process

Let {Y;} be the causal AR(1) process given by
Yi=¢Y 1 +Z, {Z}~WN(0,0%). (9.1.5)

In this case, a state-space representation for {Y,} is easy to construct. We can, for
example, define a sequence of state variables X; by

Xt-’rl :¢XI+VI7 t= 172""a (916)

where X; = Y, = Z;io #’Z_; and V, = Z,,. The process {Y;} then satisfies the

observation equation
Y, =X,
which has the form (9.1.1) with G; = 1 and W, = 0.

O
An ARMAC(1,1) Process
Let {Y;} be the causal and invertible ARMA(1,1) process satisfying the equations
Yi=¢Y 1 +Z +0Z_1, {Z}~WN(0,0%). 9.1.7)

Although the existence of a state-space representation for {Y;} is not obvious, we can
find one by observing that

Y, =0B)X, =[0 1] [X}’(‘l], (9.1.8)



262

Chapter 9

State-Space Models

where {X;} is the causal AR(1) process satisfying
¢B)X, = Z,

or the equivalent equation

X; 01(]|X—, 0
- : 1.
|:Xt+1i| [0 ¢] [ X ] + |:Zt+l-i| (9 9)

Noting that X; = 3" °) ¢/Z,_;, we see that equations (9.1.8) and (9.1.9) fort = 1,2, . ..
furnish a state-space representation of {Y;} with

0 .
X 202
X, = [ )’(—1] and X; = | 5°
! 2 71
/=0
The extension of this state-space representation to general ARMA and ARIMA pro-
cesses is given in Section 9.3.
O
In subsequent sections we shall give examples that illustrate the versatility of state-
space models. (More examples can be found in Aoki 1987; Hannan and Deistler 1988;
Harvey 1990; West and Harrison 1989.) Before considering these, we need a slight
modification of (9.1.1) and (9.1.2), which allows for series in which the time index
runs from —oo to 0o. This is a more natural formulation for many time series models.

9.1.1 State-Space Models with t € {0, %1, ...}
Consider the observation and state equations

Yl:GXt+Wl7 t:(), :i:l,..., (9.1.10)

Xl‘-‘rl :FXt+Vt, IIO,:EI,..., (9.1.11)
where F and G are v X v and w X v matrices, respectively, {V,;} ~ WN(O0, Q), {W,} ~
WN(O0, R), and E(V,W}) = 0O for all s, and z.

The state equation (9.1.11) is said to be stable if the matrix F has all its eigen-

values in the interior of the unit circle, or equivalently if det(/ — Fz) # O for all z
complex such that |z| < 1. The matrix F is then also said to be stable.

In the stable case equation (9.1.11) has the unique stationary solution (Prob-
lem 9.1) given by

(0.¢]
Xl‘ = Z Fthfjfl.
j=0
The corresponding sequence of observations

o
Y, =W, +) GFV,_;_,

j=0

is also stationary.
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9.2 The Basic Structural Model

Example 9.2.1

Figure 9-1

Realization from a random
walk plus noise model.
The random walk is
represented by the solid
line and the data are
represented by boxes

A structural time series model, like the classical decomposition model defined by
(1.5.1), is specified in terms of components such as trend, seasonality, and noise,
which are of direct interest in themselves. The deterministic nature of the trend
and seasonal components in the classical decomposition model, however, limits its
applicability. A natural way in which to overcome this deficiency is to permit random
variation in these components. This can be very conveniently done in the framework
of a state-space representation, and the resulting rather flexible model is called a
structural model. Estimation and forecasting with this model can be encompassed in
the general procedure for state-space models made possible by the Kalman recursions
of Section 9.4.

The Random Walk Plus Noise Model

One of the simplest structural models is obtained by adding noise to a random walk.
It is suggested by the nonseasonal classical decomposition model

Y, =M, + W, where {W;} ~WN(0,07), (9.2.1)
and M, = m,, the deterministic “level” or “signal” at time 7. We now introduce
randomness into the level by supposing that M, is a random walk satisfying

My =M, +V,, and {V}~WN(0,0)), (9.2.2)

with initial value M; = m;. Equations (9.2.1) and (9.2.2) constitute the “local level” or
“random walk plus noise” model. Figure 9-1 shows a realization of length 100 of this
model with M; = 0, avz =4, and ‘7»% = 8. (The realized values m; of M, are plotted as
a solid line, and the observed data are plotted as square boxes.) The differenced data

D :=VY, =Y, -Y 1 =Vi+W,—-W_, t>2

constitute a stationary time series with mean 0 and ACF

0.2
W if =1,
ooty = {2072

0, if |h| > 1.
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o
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Since {D,} is 1-correlated, we conclude from Proposition 2.1.1 that {D,} is an MA(1)
process and hence that {Y;} is an ARIMA(O,1,1) process. More specifically,

D, =Z+6Z_,, {Z}~WN(0,0%), (9.2.3)
where 6 and o are found by solving the equations
0 _ 2
= Tw and 0o’ = —o?.

140602 202402

For the process {Y;} generating the data in Figure 9-1, the parameters # and o? of
the differenced series {D,} satisfy 8/(1 4+ 6%) = —0.4 and fo> = —8. Solving these
equations for A and o2, we find that = —0.5 and 0> = 16 (or § = —2 and 0> = 4).
The sample ACF of the observed differences D; of the realization of {Y;} in Figure 9-1
is shown in Figure 9-2.

The local level model is often used to represent a measured characteristic of the
output of an industrial process for which the unobserved process level {M,} is intended
to be within specified limits (to meet the design specifications of the manufactured
product). To decide whether or not the process requires corrective attention, it is
important to be able to test the hypothesis that the process level {M,} is constant. From
the state equation, we see that {M,} is constant (and equal to m;) when V, = 0 or
equivalently when o2 = 0. This in turn is equivalent to the moving-average model
(9.2.3) for {D,} being noninvertible with & = —1 (see Problem 8.2). Tests of the unit
root hypothesis & = —1 were discussed in Section 6.3.2.

O

The local level model can easily be extended to incorporate a locally linear trend
with slope B, at time ¢. Equation (9.2.2) is replaced by

M, =M, + B+ Vi1, 9.2.4)

where B;_; = f;_1. Now if we introduce randomness into the slope by replacing it
with the random walk

B,=B,_i+U_,, where{U}~WN(0,o0,), (9.2.5)

we obtain the “local linear trend” model.
To express the local linear trend model in state-space form we introduce the state
vector
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Xt = (Mta Bt)/~
Then (9.2.4) and (9.2.5) can be written in the equivalent form
11
X = 01 X, +V,, t=12..., (9.2.6)

Example 9.2.2

Example 9.2.3

where V, = (V,, U,)’. The process {Y;} is then determined by the observation equation
Y,=[1 01X;,+ W,. 9.2.7)

If {Xy, Uy, Vq, Wy, Uy, V,, Ws, ...} is an uncorrelated sequence, then equations (9.2.6)
and (9.2.7) constitute a state-space representation of the process {Y;}, which is a model
for data with randomly varying trend and added noise. For this model we have v =
2,w=1,

11 o2 0 2
F_|:01,i| G=[1 0], Q_[Oaz]’ and R = o,

u

A Seasonal Series with Noise

The classical decomposition (1.5.11) expressed the time series {X,} as a sum of trend,
seasonal, and noise components. The seasonal component (with period d) was a
sequence {s;} with the properties 5,14, = s; and Zle s; = 0. Such a sequence can
be generated, for any values of sy, sg, . .., S_g13, by means of the recursions

r=1,2,.... (9.2.8)

Se41 = =8 — 0 — St—d+42,

A somewhat more general seasonal component {Y;}, allowing for random deviations
from strict periodicity, is obtained by adding a term S; to the right side of (9.2.8), where
{V,} is white noise with mean zero. This leads to the recursion relations

Yt+l :_Yt_"'_Yt_d+2+St, t= 1,2,.... (9.2.9)

To find a state-space representation for {¥;} we introduce the (d — 1)-dimensional state
vector

X, =, Y 1,...,Ya).
The series {Y;} is then given by the observation equation
=01 0 0---01X,, t=1,2,..., (9.2.10)
where {X,} satisfies the state equation
X =FX,+V, t=1,2..., 9.2.11)
V:=(5,0,...,0),and
-1 —1 -~ —1 —17]
1 0 0 O
F=|0 1 0 0 (9.2.12)
| 0 O -1 0]
g

A Randomly Varying Trend with Random Seasonality and Noise
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A series with randomly varying trend, random seasonality and noise can be constructed
by adding the two series in Examples 9.2.1 and 9.2.2. (Addition of series with state-
space representations is in fact always possible by means of the following construction.
See Problem 9.9.) We introduce the state vector

Xl
X, =01,
- [x]
where th and Xf are the state vectors in (9.2.6) and (9.2.11). We then have the follow-

ing representation for {Y;}, the sum of the two series whose state-space representations
were given in (9.2.6)—(9.2.7) and (9.2.10)—(9.2.11). The state equation is

F, 0 V!
X, = X ! 2.1
s [ 0 F 2] o [Vf} ’ 0219

where Fy, F, are the coefficient matrices and {V!}, {V?} are the noise vectors in the
state equations (9.2.6) and (9.2.11), respectively. The observation equation is

Y,=[1 0 1 0---01X,+W, (9.2.14)

where {W;} is the noise sequence in (9.2.7). If the sequence of random vectors
{Xy, VI, V2, Wy, V1, V3, W,, .. .} is uncorrelated, then equations (9.2.13) and (9.2.14)
constitute a state-space representation for {Y;}.

g

9.3 State-Space Representation of ARIMA Models

Example 9.3.1

We begin by establishing a state-space representation for the causal AR (p) process and
then build on this example to find representations for the general ARMA and ARIMA
processes.

State-Space Representation of a Causal AR(p) Process

Consider the AR(p) process defined by

Yiin=¢oYi+¢Yia+-+¢Ypr1 + 24y, t=0,x1,..., (3.1
where {Z,} ~ WN(O, 02), and ¢(z) :=1— ¢z —--- — ¢pz” is nonzero for |z| < 1. To
express {Y;} in state-space form we simply introduce the state vectors

Yt7p+1
Yt—p+2
X; = . , t=0,%£1,.... (9.3.2)
YI?

From (9.3.1) and (9.3.2) the observation equation is
=0 0 0---1]X,, t=0,=1,..., (9.3.3)
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Example 9.3.2

while the state equation is given by

0 1 0 0 0
0 0 1 0 0
X =|: i o X+ || Zwr, r=0,%1, .
0O O o --- 1 0
| Py Dp—1 Pp2 - D1 [ 1

(9.3.4)

These equations have the required forms (9.1.10) and (9.1.11) with W, =0 and V, =
©0,0,...,Z4),t=0,%£1,....
([l

Remark 1. In Example 9.3.1 the causality condition ¢ (z) # Ofor |z] < 1isequivalent
to the condition that the state equation (9.3.4) is stable, since the eigenvalues of
the coefficient matrix in (9.3.4) are simply the reciprocals of the zeros of ¢(z)
(Problem 9.3). ]

Remark 2. If equations (9.3.3) and (9.3.4) are postulated to hold only for ¢+ =
1,2, ..., and if X, is a random vector such that {X;, Z;, Z,, ...} is an uncorrelated
sequence, then we have a state-space representation for {Y;} of the type defined
earlier by (9.1.1) and (9.1.2). The resulting process {Y;} is well-defined, regardless
of whether or not the state equation is stable, but it will not in general be stationary.
It will be stationary if the state equation is stable and if X is defined by (9.3.2) with

Yt = Z;:O vsztfj’ = 1707 ey 2 — D and 1//(2) = 1/¢(Z)v |Z| = 1. O

State-Space Form of a Causal ARMA(p, g) Process

State-space representations are not unique. Here we shall give one of the (infinitely
many) possible representations of a causal ARMA(p,q) process that can easily be
derived from Example 9.3.1. Consider the ARMA(p,q) process defined by

¢B)Y, =60B)Z, t=0,=%1,..., (9.3.5)
where {Z;} ~ WN(0, 02) and ¢ (z) # O for |z| < 1. Let
r=max(p,q+1), ¢ =0 forj>p, 6;=0 forj>g, and 6y =1.
If {U,} is the causal AR( p) process satisfying
oB U, = Z, (9.3.6)
then Y, = 6(B)U,, since
¢(B)Y, = (B (B)U; = 0(B)p(B)U; = 0(B)Z,.

Consequently,
Yi=160-1 6, - - 60]X;, (9.3.7)
where
U—rt1
X, = U”:’” . (9.3.8)

U
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But from Example 9.3.1 we can write

0 1 0 0 0

0O O 1 0 0
Xpi=|: ¢ X+ || Zy, r=0,%1, ..

0O O o --- 1 0

L ¢r b1 br2 - 1] L1

(9.3.9)

Equations (9.3.7) and (9.3.9) are the required observation and state equations. As in
Example 9.3.1, the observation and state noise vectors are again W, = 0 and V, =
©0,0,...,Z4),t=0,%£1, ....

([l

State-Space Representation of an ARIMA(p, d, q) Process

If {Y,} is an ARIMA(p, d, q) process with {V?Y,} satisfying (9.3.5), then by the
preceding example {Vd Y,} has the representation

VY, =GX, t=0%*l,..., (9.3.10)
where {X,} is the unique stationary solution of the state equation
Xt+1 =FX;+V,

F and G are the coefficients of X, in (9.3.9) and (9.3.7), respectively, and V, =
0,0,...,Z,1).Let Aand Bbe the d x 1 and d x d matrices defined by A = B =1
ifd =1 and

0 0 1 0 0
0 0 0 1 0
A=\, B= : : : .o
0 0 0 0 R |
1] LEDPE) DG o) e d]

if d > 1. Then since
d

d .
Y, = V¢y, — () —1YY,_;, 9.3.11
> )V (9.3.11)

j=1
the vector

Y 1= _4.... Y1)
satisfies the equation

Y, = AV?, + BY,_; = AGX, + BY,_;.

Defining a new state vector T, by stacking X, and Y,_;, we therefore obtain the state
equation

o Xt-‘rl _ F 0 Vt _
TIH'_|:YI:|_|:AGB:|TI+|:0:|’ t=1,2,..., (9.3.12)
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and the observation equation, from (9.3.10) and (9.3.11),

N a4\ af @ a4 X;
r=loent(G) o, ) e () a] (g

tr=1,2,...,
(9.3.13)
with initial condition
m .
F/V_;
T, = [Xl] = ,§) e (9.3.14)
Yo

Yo
and the assumption
E(YoZ) =0, t=0,%I,..., (9.3.15)

where Yo = (Yi_4, Yo—y4, ..., Yo)'. The conditions (9.3.15), which are satisfied in
particular if Y is considered to be nonrandom and equal to the vector of observed
values (yi_g, Y2_d, - --, o), are imposed to ensure that the assumptions of a state-
space model given in Section 9.1 are satisfied. They also imply that E (X1Y6) =0and
E(Y,V? Y)) = 0, ¢t > 1, as required earlier in Section 6.4 for prediction of ARIMA
processes.

State-space models for more general ARIMA processes (e.g., {Y;} such that
{VV,Y;}isan ARMA(p, g) process) can be constructed in the same way. See Problem
94.

O

For the ARIMAC(1, 1, 1) process defined by

(1-¢B)(1 —BY, = (1+6B)Z,, {Z}~WN(0,0%),

the vectors X, and Y,_; reduce to X, = (X,_;,X,) and Y,_; = Y,_;. From (9.3.12)
and (9.3.13) the state-space representation is therefore (Problem 9.8)

thl
Yi=[011]| X, |, (9.3.16)
thl
where
X; 0 1 0Of]X— 0
Xl‘+1 == 0 ¢ 0 Xl‘ + Zl‘+1 ) = 1, 2, ceey (9317)
Y; 6 1 1 Y1 0
and
- A
Y Y7
Xo j=0
J— 00 .
X, | = Z¢’Z1fj . (9.3.18)
Yy j=0
L Yo
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9.4 The Kalman Recursions

Definition 9.4.1

In this section we shall consider three fundamental problems associated with the state-
space model defined by (9.1.1) and (9.1.2) in Section 9.1. These are all concerned with
finding best (in the sense of minimum mean square error) linear estimates of the state-
vector X; in terms of the observations Y, Y, ..., and a random vector Y, that is
orthogonal to V; and W, for all ¢+ > 1. In many cases Y, will be the constant vector
(1,1, ..., 1). Estimation of X, in terms of:

a. Yy, ..., Y, defines the prediction problem,
b. Yy, ..., Y, defines the filtering problem,
c. Yo,..., Y, (n> 1) defines the smoothing problem.

Each of these problems can be solved recursively using an appropriate set of Kalman
recursions, which will be established in this section.

In the following definition of best linear predictor (and throughout this chapter)
it should be noted that we do not automatically include the constant 1 among the
predictor variables as we did in Sections 2.5 and 8.5. (It can, however, be included
by choosing Yo = (1, 1,...,1)".)

For the random vector X = (X1, ..., X,)’,
Pi(X) = (P(X1), ..., Pi(X)),

where P;(X;) := P(Xi|Yo, Y1, ..., Y,), is the best linear predictor of X; in terms
of all components of Yo, Yi,...,Y,.

Remark 1. By the definition of the best predictor of each component X; of X,
P,(X) is the unique random vector of the form

P(X) =AYo+---+AY,
with v x w matrices Ao, ..., A; such that
X-PX)]LY;, s=0,...,¢

[cf. (8.5.2) and (8.5.3)]. Recall that two random vectors X and Y are orthogonal

(written X 1L Y) if E(XY’) is a matrix of zeros. O
Remark 2. If all the components of X, Yy, ..., Y, are jointly normally distributed
and Yo = (1,...,1), then

P.X) =EX|Yy,...,Y), t>1. O

Remark 3. P; is linear in the sense that if A is any £ x v matrix and X, V are two
v-variate random vectors with finite second moments, then (Problem 9.10)

Pi(AX) = AP/(X)
and
P,(X+V)=P(X)+ P;(V).
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Proof.

Remark 4. If X and Y are random vectors with v and w components, respectively,
each with finite second moments, then

PX|Y) = MY,

where M is a v x w matrix, M = E(XY')[E(YY')]~! with [E(YY')]~! any generalized
inverse of E(YY’). (A generalized inverse of a matrix S is a matrix S~! such that
S§~'S = S. Every matrix has at least one. See Problem 9.11.)

In the notation just developed, the prediction, filtering, and smoothing problems
(a), (b), and (c) formulated above reduce to the determination of P,_; (X)), P;(X;), and
P,(Xy) (n > 1), respectively. We deal first with the prediction problem. U

Kalman Prediction: R

For the state-space model (9.1.1)—(9.1.2), the one-step predictors X, := P,_{(X,)
and their error covariance matrices §2;, = E [(Xt — )A(t) (Xt — )A(,)/] are uniquely
determined by the initial conditions

X, = P(X,|Yy), 2, =E[(Xi — Xl)(Xl — Xl)/]
and the recursions, fort =1, ...,

&H:E&+®A#<n—GXJ, (9.4.1)

Q1 =F2F, +Q,— 0,40, (9.4.2)
where

A = G,22,G, + R,

0, = F,.2,G,

and A7! is any generalized inverse of A,.

We shall make use of the innovations I; defined by Iy = Y, and

L=Y, -P Y=Y, ~GX, =G (X —X)+ W, r=12...
The sequence {I;} is orthogonal by Remark 1. Using Remarks 3 and 4 and the relation

Pi(-) = Po1 () + P(IL) 9.4.3)
(see Problem 9.12), we find that

Xii1 = ProiXi) + PXoptlL) = Py (F X + V) + 0,41,

= FX, + 0,41, (9.4.4)

where

At = E(It I;) = GtQtG; + Rh
&:E@mw=Ekﬂx+VJQX—X]Q+WO} = F,.2,G,
To verify (9.4.2), we observe from the definition of §2,, that

241 =E (X1 X),,) —E (Xt+1X;+1) .
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With (9.1.2) and (9.4.4) this gives
241 = FEXX)F + Q, — F.E (th(;) F — 0,470

:Ft.QtF;+Qt_®tAt_l®;. .

9.4.1 h-Step Prediction of {Y} Using the Kalman Recursions

The Kalman prediction equations lead to a very simple algorithm for recursive

calculation of the best linear mean square predictors P;Y, ,, n = 1,2,.... From
(9.4.4), (9.1.1), (9.1.2), and Remark 3 in Section 9.1, we find that
PtXt+1 = FP X, + ®tAt_l(Yt — P 1Y), (9.4.5)

PXiin = Fron1PXepn—1

=Frn1Foono - Fu)P Xy, h=2,3,..., (9.4.6)
and

PY.n =GP Xern, h=1,2,.... (9.4.7)
From the relation

Xivn — PXiwn = Fron1Xepno1 — PiXoyn—1) + Vegno1, h=2,3,...,
we find that Q,(h) = E[(Xin — PXoin) Xipn — P X, 1p)] satisfies the recursions

QP =Fin1 RV VF 4 Qnt, h=12,3,..., (9.4.8)

with 2" = 2,.1. Then from (9.1.1) and (9.4.7), A" := E[(Y,sn — P.Y1n) (Yiin —
P.Y,.;)] is given by

A" =Gy 2PG Ly + R, h=1,2,.... (9.4.9)

Consider the random walk plus noise model of Example 9.2.1 defined by
=X+ W, {W}~WN(0,o0,),

where the local level X, follows the random walk
Xep1 =X+ Vi, (V) ~WN(0,07).

Applying the Kalman prediction equations with ¥y := 1, R = 02, and Q = o2, we
obtain

N N ® N
Yt+l = Pth+1 =X + Zt <Yt - Yt)

t
=- at)?t + a/Y;

where
O, £2;

- A 2402

a;
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For a state-space model (like this one) with time-independent parameters, the solution
of the Kalman recursions (9.4.2) is called a steady-state solution if §2, is independent
of t. If £2, = £2 for all ¢, then from (9.4.2)

ok Qo?

[9) — Q=0 2 — w 2.
a LR IRy g

Solving this quadratic equation for 2 and noting that £2 > 0, we find that

1
Q2= 3 <av2 +,/o} +4G\120v%>

Since £2;,1 — $2, is a continuous function of £2; on §2, > 0, positive at £2, = 0,
negative for large £2;, and zero only at £2, = 2, it is clear that §2,,{ — 2, is negative
for £2, > §2 and positive for £2, < £2. A similar argument shows (Problem 9.14) that
(82;41 — £2)(£2, — 2) > O for all £2, > 0. These observations imply that £2,,; always
falls between §2 and £2,. Consequently, regardless of the value of £2,, £2, converges
to §2, the unique solution of £2,,; = £2,. For any initial predictors Y; = X; and any
initial mean squared error §2; = E (X1 — Xl)z, the coefficients a, := £2,/ (Qt + av%)
converge to
2
a=—,
2+o02

and the mean squared errors of the predictors defined by

f]tﬂ =- at)f]t + aY;

converge to 2 + o2.
If, as is often the case, we do not know £2;, then we cannot determine the sequence
{a,}. It is natural, therefore, to consider the behavior of the predictors defined by

Y1 = (1 — @)Y, +ay,

with a as above and arbitrary f’l. It can be shown (Problem 9.16) that this sequence
of predictors is also asymptotically optimal in the sense that the mean squared error

converges to £2 + o2 as t — oo.

As shown in Example 9.2.1, the differenced process D; = Y, — Y, is the MA(1)
process

D, =Z+60Z_, {Z} ~ WN(0,0?),

where 6/ (1 + 92) = —02/ (20£ + avz). Solving this equation for 6 (Problem 9.15),
we find that

1
0 =—=—— (20 +07— [0} + 40202
202

and that 9 = a — 1.

It is instructive to derive the exponential smoothing formula for Y, directly from
the ARIMA(0,1,1) structure of {Y;}. For t > 2, we have from Section 6.5 that

Yo =Y+ 0,(Y, = ¥) = —0,Y, 4+ (1 +6,)Y,

for t > 2, where 6, is found by application of the innovations algorithm to an MA(1)
process with coefficient 6. It follows that 1 — @, = —6,, and since 6,;, — 6
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Proof.

(see Remark 1 of Section 3.3) and a, converges to the steady-state solution a, we
conclude that

l—a=Ilm(l —a)=-— lim 6, = —6.
11— 00 —00

The lognormal stochastic volatility model

We can rewrite the defining equations (7.4.2) and (7.4.3) of the lognormal SV process
{Z;} in the following state-space form

Xi =Xt + 11, (9.4.10)
and
Yi=X + &, 9.4.11)
where the (one-dimensional) state and observation vectors are
oy p—— (9.4.12)
1=y
and
Y,=Inz2+127 - —2 (9.4.13)
’ ’ 21— 7)

respectively. The independent white-noise sequences {r;} and {¢;} have zero means
and variances o2 and 4.93 respectively.
Taking

Xo=EXy =0 9.4.14)
and
20 = Var(Xo) = 02/(1 — y2), (9.4.15)

and we can directly apply the Kalman prediction recursions (9.4.1), (9.4.2), (9.4.6) and
(9.4.8), to compute recursively the best linear predictor of X, in terms of {Y;, s < ¢},
or equivalently of the log volatility ¢, in terms of the observations {InZ?, s < t}.

]
Kalman Filtering:
The filtered estimates X,; = P;(X;) and their error covariance matrices £2,; =
E[(X; — X0 (X; — X;;)] are determined by the relations
PX, = P_X, + 2,G.A"! (Y, - G,f(,) (9.4.16)
and
Q= 82, — .QIG;A;IG,.Q;. 9.4.17)

From (9.4.3) it follows that
PX; =P X, +MI,
where
M =EX, DIEN ™ = E[X(G,X, — X)) + W4 = 2,647
(9.4.18)
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To establish (9.4.17) we write
X; — P X, =X, — PX; + PX; — P 1 X; = X; — PX; + MI,.

Using (9.4.18) and the orthogonality of X, — P,X, and MI,, we find from the last
equation that

‘Qt == Qllt + QtG;At_thQt/,

as required. |

Kalman Fixed-Point Smoothing:

The smoothed estimates X;, = P,X; and the error covariance matrices $2;, =
E[(X; — X4n) (X; — X{j)'] are determined for fixed ¢ by the following recursions,
which can be solved successively forn =1, 4+ 1,...:

PX, = PyiX, + 20,64, (Y, - GX, ) (9.4.19)
Qt,n+1 = Qt,n[Fn - @,,AJIG,,]/, (9.4.20)
Qun = Qun-1 — 2,,G,A,' G, 82/ . (9.4.21)

with initial conditions P,_;X; = Xt and §2;; = §2,,—1 = §2; (found from Kalman
prediction).

A

Proof. Using (9.4.3) we can write P, X, = P,_ X, + CIL,, where I, = G,(X, — X)) + W,.
By Remark 4 above,

C=E [xt <Gn(Xn - X,) + W)} [E(LL)] " =2.G,A;", (9422

where 2,, = E[(X; — X,)(X, — X,)']. It follows now from (9.1.2), (9.4.5), the
orthogonality of V,, and W, with X, — )A(t, and the definition of £2, , that

2 p1=E [(X, - Xt) (Xn - X) (F, — @nA;lG,,)/:| =2,,[F. — ©,4;'G,] ,

thus establishing (9.4.20). To establish (9.4.21) we write
X, —PX =X, —P,_1X;, — CI,.

Using (9.4.22) and the orthogonality of X, — P, X, and I, the last equation then gives
Qup = 2yt — 2,,G.A'G, 2, n=tt+1,...,

t,n?

as required. |

9.5 Estimation for State-Space Models

Consider the state-space model defined by equations (9.1.1) and (9.1.2) and suppose
that the model is completely parameterized by the components of the vector 8. The
maximum likelihood estimate of @ is found by maximizing the likelihood of the obser-
vations Y1, ..., Y, with respect to the components of the vector 6. If the conditional
probability density of Y, given Y;_1 = y,—1,..., Yo = Yo is f;(:]¥/—1, - - ., Yo), then
the likelihood of Y, = 1, ..., n (conditional on Y), can immediately be written as

LO: Y. ... Y,) = [ [AVYimr, . Yo (95.1)
=1
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The calculation of the likelihood for any fixed numerical value of 6 is extremely
complicated in general, but is greatly simplified if Yy, X; and W,, V,,t = 1,2, ...,
are assumed to be jointly Gaussian. The resulting likelihood is called the Gaussian
likelihood and is widely used in time series analysis (cf. Section 5.2) whether the time
series is truly Gaussian or not. As before, we shall continue to use the term likelihood
to mean Gaussian likelihood.

If Yo, X; and W,,V,, t = 1,2,..., are jointly Gaussian, then the conditional
densities in (9.5.1) are given by

_ 1., _
Fi(YY,_1, ..., Yo) = Qm)™"/? (detA,) ™ ? exp [—EI;At 1II} ,

where I, =Y, — P, Y, =Y, — G)z,, P,_1Y,, and A,, t > 1, are the one-step pre-
dictors and error covariance matrices found from the Kalman prediction recursions.
The likelihood of the observations Yy, ..., Y, (conditional on Y,) can therefore be
expressed as

—1/2
—nw, . 1 . / —
LO:Y,,....Y,) = Qrn)™™/? ]_[dem, exp —EZIJ.A]. '
j=1 j=1
(9.5.2)
Given the observations Yy, ..., Y,, the distribution of Y (see Section 9.4), and a

particular parameter value 6, the numerical value of the likelihood L can be computed
from the previous equation with the aid of the Kalman recursions of Section 9.4. To
find maximum likelihood estimates of the components of @, a nonlinear optimization
algorithm must be used to search for the value of 8 that maximizes the value of L.

Having estimated the parameter vector 8, we can compute forecasts based on the
fitted state-space model and estimated mean squared errors by direct application of
equations (9.4.7) and (9.4.9).

9.5.1 Application to Structural Models

The general structural model for a univariate time series {Y;} of which we gave
examples in Section 9.2 has the form

Y, =GX,+ W, {W}~WN(0,0,), (9.5.3)
X1 =FX; +V,, {Vi}~WN(QO,Q), 9.5.4)
fort = 1,2,..., where F and G are assumed known. We set Yy = 1 in order to

include constant terms in our predictors and complete the specification of the model
by prescribing the mean and covariance matrix of the initial state X;. A simple and
convenient assumption is that X; is equal to a deterministic but unknown parameter
o and that Xl = [, so that £2; = 0. The parameters of the model are then p, Q,
and o2

Direct maximization of the likelihood (9.5.2) is difficult if the dimension of the
state vector is large. The maximization can, however, be simplified by the following
stepwise procedure. For fixed Q we find (Q) and o;2(Q) that maximize the likelihood
L ([L, 0, aj). We then maximize the “reduced likelihood” L (fL(Q), 0, 8j(Q)) with
respect to Q.

To achieve this we define the mean-corrected state vectors, X} = X, — F =1 I, and
apply the Kalman prediction recursions to {X7} with initial condition Xj = 0. This
gives, from (9.4.1),



9.5

Estimation for State-Space Models 277

X =X +0,47 (v -6X), =12, 9.5.5)
with XT = 0. Since X, also satisfies (9.5.5), but with initial condition X, = M, it
follows that

X, =X+ Cn (9.5.6)

for some v x v matrices C;. (Note that although X, = P(X;|Yy, Y1, ..., Y,), the quantity
f(;* is not the corresponding predictor of X?¥.) The matrices C, can be determined
recursively from (9.5.5), (9.5.6), and (9.4.1). Substituting (9.5.6) into (9.5.5) and using
(9.4.1), we have

X =F (X - C) + 0,47 (¥, - G (X, - Cn))
=FX, + 0,47 (¥, - GX,) - (F - ©,47'G) G
=X, — (F - ©,4,'G) Cun,
so that

C1 = (F—0,47'G) C, (9.5.7)

with C; equal to the identity matrix. The quadratic form in the likelihood (9.5.2) is
therefore

~\2
S, 0,09 =Y @

=1

(9.5.8)

~ 2
! (Yt —GXr — GC,;L)
= Z . (9.5.9)
A,

=1

Now let O* := 0,20 and define L* to be the likelihood function with this new

parameterization, i.e., L* ([L, o, av%) =L ([L, an*, aj). Writing A} = aw_zAt and

QF = 0,282, we see that the predictors )A(t* and the matrices C, in (9.5.7) depend on
the parameters only through Q*. Thus,

S (n, Q,07) = 0,28 (1, 0%, 1),
so that

—2InL* (. 0%, 07) = nln@m) + Y In A, +0,°S (u. 0", 1)
t=1
=nlnQ2rm) + Zln Af+nlno) + 0,728 (r, 0%, 1).
t=1
For Q* fixed, it is easy to show (see Problem 9.18) that this function is minimized
when

-1 '~ &

" CGGC | GO (Yz—GXI)
Yoy 9.5.10
[ A } A ( )

=1 =1



278

Chapter 9

State-Space Models

Example 9.5.1.

Example 9.5.2.

and

~ 2
A2 AD (y RN (Y’_GXT_GC’”)

62=62(Q") =n Z‘ = . (9.5.11)
=1 !

Replacing u and o2 by these values in —21n L* and ignoring constants, the reduced
likelihood becomes

" (Y, — GX — GC,i)’ "
£(Q*)=In (n_1 Z -G tA* GG ) +n! Zln (det AY).
=1 !

=1

(9.5.12)

If Q* denotes the minimizer of (9.5.12), then the maximum likelihood estimator of the
parameters p, Q, o2 are fi, 6&@*, 62, where jt and 62 are computed from (9.5.10) and
(9.5.11) with Q* replaced by O*.

We can now summarize the steps required for computing the maximum likelihood
estimators of i, Q, and av% for the model (9.5.3)-(9.5.4).

1. For a fixed Q*, apply the Kalman prediction recursions with XT =0,2, =0,

Q = 0% and 02 = 1 to obtain the predictors Xf Let A} denote the one-step
prediction error produced by these recursions.

2. Set i = 1(Q") = [Y, C,G'GC,/A] ™ YL, CG(Y, — GX2)/Ar.

. Let Q* be the minimizer of (9.5.12).

4. The maximum likelihood estimators of u, Q, and av% are then given by ft, 6%@*,
and 62, respectively, where fi and &2 are found from (9.5.10) and (9.5.11)

evaluated at Q*

W

Random Walk Plus Noise Model

In Example 9.2.1, 100 observations were generated from the structural model

Y,=M,+W, {W}~WN(0,0,),
Mii =M+ Vi, {V}~WN(0,07),

with initial values u = M; = 0, 02 = 8, and 0> = 4. The maximum likelihood
estimates of the parameters are found by first minimizing (9.5.12) with & given by
(9.5.10). Substituting these values into (9.5.11) gives 63. The resulting estimates are
A = 0.906, 6> = 5.351, and 62 = 8.233, which are in reasonably close agreement
with the true values.

([l

International Airline Passengers, 1949-1960; AIRPASS. TSM

The monthly totals of international airline passengers from January 1949 to December
1960 (Box and Jenkins 1976) are displayed in Figure 9-3. The data exhibit both a
strong seasonal pattern and a nearly linear trend. Since the variability of the data
Y1, ..., Y144 increases for larger values of Y, it may be appropriate to consider a
logarithmic transformation of the data. For the purpose of this illustration, however,
we will fit a structural model incorporating a randomly varying trend and seasonal and
noise components (see Example 9.2.3) to the raw data. This model has the form
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Y, =GX,+ W, {W}~WN(0,o0p;),
X1 =FXi + Vi, {Vi}~WN(Q, 0),

where X, is a 13-dimensional state-vector,

11 0 0 - 0 07
01 0 O 0 0
00 -1 —1 -~ —1 -1
F=|0 0 1 0 0o 0|,
00 0 1 0 0
0 0 0 0 1 0]

G=[1010--- 0],

and
(02 0 0 0 0]
0 o2 0 O 0
0 0 of O 0
2=190 0 0 0 0
L0 0 0 0 --- 0]

The parameters of the model are pu, 012, 022, 032, and ‘7»%’ where u = X;. Minimizing

(9.5.12) with respect to Q* we find from (9.5.11) and (9.5.12) that
(62.65.65,6,) = (170.63,.00000, 11.338,.014179)

and from (9.5.10) that i =(146.9, 2.171, —34.92, —34.12, —47.00, —16.98, 22.99,
53.99, 58.34, 33.65, 2.204, —4.053, —6.894)’. The first component, X;;, of the state
vector corresponds to the local linear trend with slope X». Since 65 = 0, the slope at
time ¢, which satisfies

Xpo=X_1p+ Vo,
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must be nearly constant and equal to X1» = 2.171. The first three components of the
predictors X, are plotted in Figure 9-4. Notice that the first component varies like a
random walk around a straight line, while the second component is nearly constant as
a result of 65 ~ 0. The third component, corresponding to the seasonal component,
exhibits a clear seasonal cycle that repeats roughly the same pattern throughout the 12
years of data. The one-step predictors X + X3 of ¥, are plotted in Figure 9-5 (solid
line) together with the actual data (square boxes). For this model the predictors follow

the movement of the data quite well.
0

9.6 State-Space Models with Missing Observations

State-space representations and the associated Kalman recursions are ideally suited to
the analysis of data with missing values, as was pointed out by Jones (1980) in the
context of maximum likelihood estimation for ARMA processes. In this section we
shall deal with two missing-value problems for state-space models. The first is the



9.6

State-Space Models with Missing Observations 281

evaluation of the (Gaussian) likelihood based on {Y;,,...,Y;}, where ij, i, ..., i,
are positive integers such that 1 < i; < i < --- < i, < n. (This allows for
observation of the process {Y,} at irregular intervals, or equivalently for the possibility
that (n — r) observations are missing from the sequence {Y1, ..., Y,}.) The solution of
this problem will, in particular, enable us to carry out maximum likelihood estimation
for ARMA and ARIMA processes with missing values. The second problem to be
considered is the minimum mean squared error estimation of the missing values
themselves.

9.6.1 The Gaussian Likelihood of {Y;,,...,Y;}, 1 <ii <i2 <+ <ip <n

Consider the state-space model defined by equations (9.1.1) and (9.1.2) and suppose
that the model is completely parameterized by the components of the vector 8. If there
are no missing observations, i.e.,if r =nand i; = j,j = 1, ..., n, then the likelihood
of the observations {Yy, ..., Y,} is easily found as in Section 9.5 to be
n 71/2 n
LO: Yy, ....Y,) = @n) ™" [ []deta; | exp —% > LA,
j=1

J=1

where I; = Y; — P;_1Y; and A;, j > 1, are the one-step predictors and error
covariance matrices found from (9.4.7) and (9.4.9) with Yy = 1.

To deal with the more general case of possibly irregularly spaced observations
{Y;, ..., Y}, we introduce a new series {Y;}, related to the process {X,} by the
modified observation equation

Y, =GX,+W;, t=12,..., (9.6.1)
where
G, ifrefi,....i},
- 0  otherwise,

and {N;,} is iid with

Gy

B [wt ifre (i il oo

N; otherwise,

N, ~N@©,7,xv), N;LXi, NSJ_|: ’:|, s,t=0,%£1,....

(9.6.3)

Equations (9.6.1) and (9.1.2) constitute a state-space representation for the new series
{Y7}, which coincides with {Y,} at each ¢t € {i;, 1, ..., i}, and at other times takes
random values that are independent of {Y,} with a distribution independent of 6.

Let L, (0; Yijs oo yir) be the Gaussian likelihood based on the observed
values y;,...,y; of Y;,..., Y, under the model defined by (9.1.1) and (9.1.2).
Corresponding to these observed values, we define a new sequence, y7j, ..., y;, by

* YI ifte{il,...,ir},

y; (9.6.4)

0 otherwise.
Then it is clear from the preceding paragraph that
L, (9; Yis oo Yi,) = )L, (9; Yi oo, yZ) , (9.6.5)

where L, denotes the Gaussian likelihood under the model defined by (9.6.1) and
(9.1.2).
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In view of (9.6.5) we can now compute the required likelihood L; of the realized
values {y;, t =iy, ..., i,} as follows:

i. Define the sequence {y;,t=1,...,n} asin (9.6.4).

ii. Find the one-step predictors SA(;“ of Y}, and their error covariance matrices Ay,
using Kalman prediction and equations (9.4.7) and (9.4.9) applied to the state-
space representation (9.6.1) and (9.1.2) of {Y7}. Denote the realized values of the
predictors, based on the observation sequence {y;‘}, by {&f}

iii. The required Gaussian likelihood of the irregularly spaced observations {y;,, ...,
yi,} is then, by (9.6.5),

~1/2
n n
_ [ P
Li(6;yi,....y;,) = Qx)™™"? l_[det A7 eXp =3 E ii’A7 117 )
j=1 j=1
where ij’.k denotes the observed innovation y;‘ - §'J*, j=1,...,n

Example 9.6.1. An AR(1) Series with One Missing Observation

Let {Y;} be the causal AR(1) process defined by
Y, — oY, =2, {Z;} ~ WN (0, 02) .
To find the Gaussian likelihood of the observations yy, y3, 4, and ys of Yy, Y3, Y4, and

Y5 we follow the steps outlined above.

i Sety! =y, i=1,3,4,5andy; =0.
iil. We start with the state-space model for {Y;} from Example 9.1.1, i.e., ¥; =
X:, Xey1 = ¢X; + Zi11. The corresponding model for {Y;} is then, from (9.6.1),

Y/=GX,+W', t=12,...,
where

Xt+1:FtXt+Vt7 t:1a2a~~~7

1 ifr+2, 0 ifr#2,
Ft:(p’ G;k: Vt:Zt+lv Wt*z
0 ifr=2, N, ift=2,
0 ifr+#2,
0, =0 R= Sk =0,
1 ifr=2,

and X; = Zfio A —j. Starting from the initial conditions
X, =0, 21 =0/ (1 -¢%),
and applying the recursions (9.4.1) and (9.4.2), we find (Problem 9.19) that
i 02/(1—¢2) ift=1,
ot =10 =139 0 i) ires,
o ifr=2, 02( +¢7) .
and

X, =0, Xo=0¢Y, X;=¢7, Xi=¢Y;, Xs=q¢Y,
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From (9.4.7) and (9.4.9) with h = 1, we find that
Yi=0, Yi=0, Vi=¢,, YV i=¢Y; Vi=o¢Y,
with corresponding mean squared errors
Af=0*/(1-¢%), As=1, Ai=0>(1+¢%), Aj=0> Al=0".
iii. From the preceding calculations we can now write the likelihood of the original
data as
_ _ 1/2
Li(p, 0% yi,y3,ya, y5)=0 Q1) * [(1=¢°) / (1+¢%)]
1 2 2 @3_(1’2)’1)2 2 2
X exp{—— 1—¢?) + L 4 (yy— +(ys— .
Pi 7972 |:y1( ¢°) 92 a—@y3) " +(ys—¢ys)
]
Remark 1. If we are given observations yi_g, Y2—d, - - -, Y0, Yiys Yips - - - » ¥i, Of an
ARIMA(p, d, q) process at times 1 — d,2 —d,...,0,iy,...,i, where 1 < i} <
ip < --+ <1, < n,asimilar argument can be used to find the Gaussian likelihood of
Yis - -+ Vi, conditional on Y1_q = yi_q, Yo—q = Y24, ..., Yo = yo. Missing values
among the first d observations y,_4, y2—4, - - . , Yo can be handled by treating them as

Example 9.6.2.

unknown parameters for likelihood maximization. For more on ARIMA series with
missing values see Brockwell and Davis (1991) and Ansley and Kohn (1985). O

9.6.2 Estimation of Missing Values for State-Space Models

Given that we observe only Y;, Y;,, ..., Y, 1 <ij <ip <--- < i, < n, where {Y,}
has the state-space representation (9.1.1) and (9.1.2), we now consider the problem
of finding the minimum mean squared error estimators P (Y,lYo, Yi,..., Y,-r) of Y;,
1 <t < n, where Yy = 1. To handle this problem we again use the modified process
{Y]} defined by (9.6.1) and (9.1.2) with Y;; = 1. Since Y; = Y, for s € {if,..., i}

and Y7 L X, Yoforl <t <nands ¢ {0,i,...,i}, we immediately obtain the
minimum mean squared error state estimators
P(XiYo, Ys,....Y,) =P(XY; Y5, ..., X)), 1<r=<n (9.6.6)

The right-hand side can be evaluated by application of the Kalman fixed-point
smoothing algorithm to the state-space model (9.6.1) and (9.1.2). For computational
purposes the observed values of Yy, ¢ ¢ {0,i,...,i}, are quite immaterial. They
may, for example, all be set equal to zero, giving the sequence of observations of Y;
defined in (9.6.4).

To evaluate P (Y,lYo, Yi,..., Y,-r), 1 <t <n,weuse (9.6.6) and the relation
Y, =GX, +W,. (9.6.7)
Since E (V,W;) =S5 =0, t=1,...,n, wefind from (9.6.7) that
P(Y:Yo,Ys,....Y;) =GP (X/Y5, YI, ..., Y}). (9.6.8)

An AR(1) Series with One Missing Observation

Consider the problem of estimating the missing value Y, in Example 9.6.1 in terms of
Yo = 1, Y1, Y3, Yy, and Ys. We start from the state-space model X, = ¢X; + Z,41,
Y, = X,, for {¥,}. The corresponding model for {Y;'} is the one used in Example 9.6.1.
Applying the Kalman smoothing equations to the latter model, we find that
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¢ (Y1 +713)
P X, =Y, PXo=¢Y, PXp=—7-—7—,
1X2 = @Yy 2Xp = @Y =00

PyX5 = P3X5, PsX; = P3Xo,
2, =072, 2,3 =¢0%,  §2,,=0, >4,
and

O_2

= T t237
(1+9¢%

where P;(-) here denotes P (-|Y e Yt*) and $£2; ,, 24, are defined correspondingly.
We deduce from (9.6.8) that the minimum mean squared error estimator of the missing
value Y, is

2 2
=07, Shp=0", 2

Y| +7Y
PsY, = PsX; = s+ 13) 3),
(1+¢%)
with mean squared error
2
o
295 = 77—~
| (1 I ¢2) O
Remark 2. Suppose we have observations Y1_4, Yo_4, ..., Yo, Y, ..., Y, (1 <i; <
ip--+ < i, < n)of an ARIMA(p, d, q) process. Determination of the best linear
estimates of the missing values Y;, ¢ ¢ {i;,..., i}, interms of ¥, t € {iy,..., i},
and the components of Yo = (Yi_g4,Y2_4,...,Yy) can be carried out as in

Example 9.6.2 using the state-space representation of the ARIMA series {Y;} from
Example 9.3.3 and the Kalman recursions for the corresponding state-space model
for {Y;} defined by (9.6.1) and (9.1.2). See Brockwell and Davis (1991) for further
details. U

We close this section with a brief discussion of a direct approach to estimating
missing observations. This approach is often more efficient than the methods just
described, especially if the number of missing observations is small and we have
a simple (e.g., autoregressive) model. Consider the general problem of computing
E(X]Y) when the random vector (X', Y’)’ has a multivariate normal distribution with
mean 0 and covariance matrix X. (In the missing observation problem, think of X as
the vector of the missing observations and Y as the vector of observed values.) Then
the joint probability density function of X and Y can be written as

fX,Y (X’ Y) =fX\Y (le)fy (Y), (969)

where f , (X]y) is a multivariate normal density with mean E(X|Y) and covariance
matrix Xy, (see Proposition A.3.1). In particular,

1
Sy (X[Y) = —5(x = EX|y)) Tg, (x - E(XIY))} ;

1
— ¢CX
m)idet Ty T

(9.6.10)

where ¢ = dim(X). It is clear from (9.6.10) that f,,(x|y) (and also fx y(X,y))
is maximum when x = E(X|y). Thus, the best estimator of X in terms of Y can be
found by maximizing the joint density of X and Y with respect to x. For autoregressive
processes it is relatively straightforward to carry out this optimization, as shown in the
following example.
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Example 9.6.3.  Estimating Missing Observations in an AR Process

Suppose {Y;} is the AR(p) process defined by
Yi=¢1Yo1+ -+ Y p+Z, {Z}~WN(0,0%),

and Y = (¥;,...,Y;,) ,with1 <i; <--- <i, <n,are the observed values. If there
are no missing observations in the first p observations, then the best estimates of the
missing values are found by minimizing

Y=Y = —pYi,)’ 9.6.11)

t=p+1

with respect to the missing values (see Problem 9.20). For the AR(1) model in
Example 9.6.2, minimization of (9.6.11) is equivalent to minimizing

(Y2 — @Y1 + (Y3 — ¢Y2)?

with respect to Y,. Setting the derivative of this expression with respect to Y, equal to
0 and solving for Y, we obtain E(Y,|Y, Y3, Y4, Ys5) = ¢ (Y + Y3)/ (1 + ¢2).
O

9.7 The EM Algorithm

The expectation-maximization (EM) algorithm is an iterative procedure for computing
the maximum likelihood estimator when only a subset of the complete data set is
available. Dempster et al. (1977) demonstrated the wide applicability of the EM
algorithm and are largely responsible for popularizing this method in statistics. Details
regarding the convergence and performance of the EM algorithm can be found in Wu
(1983).

In the usual formulation of the EM algorithm, the “complete” data vector W is
made up of “observed” data Y (sometimes called incomplete data) and “unobserved”
data X. In many applications, X consists of values of a “latent” or unobserved process
occurring in the specification of the model. For example, in the state-space model of
Section 9.1, Y could consist of the observed vectors Yy, ...,Y, and X of the unob-
served state vectors Xy, ..., X,,. The EM algorithm provides an iterative procedure
for computing the maximum likelihood estimator based only on the observed data Y.
Each iteration of the EM algorithm consists of two steps. If ) denotes the estimated
value of the parameter 6 after i iterations, then the two steps in the (i + 1)th iteration
are

E-step. Calculate Q(01607) = Eyo [£(0; X, Y)|Y]
and
M-step. Maximize Q(6]6”) with respect to 6.

Then 6+ is set equal to the maximizer of Q in the M-step. In the E-step, £(0; X, y) =
Inf(x,y; 0), and Eyi» (-]Y) denotes the conditional expectation relative to the condi-
tional density f(x|y; 6%) = f(x,y; 0©) /f (y; 6).

It can be shown that E(Q(i); Y) is nondecreasing in i, and a simple heuristic

argument shows that if 6D has a limit § then § must be a solution of the likelihood
equations E’(Q; Y) = 0. To see this, observe that Inf(x, y; 8) = Inf(x|y; 6) + £(0; y),
from which we obtain

0 (010" = / (Inf(x|Y; 0) f (x|Y; 07) dx + £(0; Y)
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and
0'616") = / [%f(XIY; e>] JF I O)f (x]Y: 09) dx+ £'(6: Y).

Now replacing 6 with 94D noticing that Q' (8“+D]9?) = 0, and letting i — oo, we
find that

ozf%[f(xw; 0],y dx+ ¢ (9:Y) = (6:Y).

The last equality follows from the fact that

0 d 0
0= E(l) =39 [/(f(XIY, 9)dXL=é = / [@f(XIY, 9)]9=5 dx.

The computational advantage of the EM algorithm over direct maximization of the
likelihood is most pronounced when the calculation and maximization of the exact
likelihood is difficult as compared with the maximization of Q in the M-step. (There are
some applications in which the maximization of Q can easily be carried out explicitly.)

9.7.1 Missing Data

The EM algorithm is particularly useful for estimation problems in which there are

missing observations. Suppose the complete data set consists of Y7, ..., Y, of which
r are observed and n — r are missing. Denote the observed and missing data by Y =
Yi,....Y) and X = (Y}, ..., Y, ), respectively. Assuming that W = (X', Y')’

has a multivariate normal distribution with mean 0 and covariance matrix X, which
depends on the parameter 8, the log-likelihood of the complete data is given by

1 1
£(O; W) = —g In27) — 3 Indet(X) — EW/EW'

The E-step requires that we compute the expectation of £(8; W) with respect to the
conditional distribution of W given Y with =0, Writing () as the block matrix

X X
== [221 222] ’
which is conformable with X and Y, the conditional distribution of W given Y is
multivariate normal with mean [é] and covariance matrix [211(‘)2(0) 8], where X =
Eo(X|Y) = £12%5,'Y and Zy1p(0) = X;; — 2125, oy (see Proposition A.3.1).
Using Problem A.8, we have

Ego [(X. Y)Z 7' (0)(X', Y)|Y] = trace (21”2(0(0)2;11‘2(0)) +WEOW,
where W = <X’, Y’) . It follows that

. N 1 .
0(016”) = ¢ (0.W) - Strace (Zup (09) =5,®)) -

The first term on the right is the log-likelihood based on the complete data, but with
X replaced by its “best estimate” X calculated from the previous iteration. If the
increments @D — @ are small, then the second term on the right is nearly constant
(& n —r) and can be ignored. For ease of computation in this application we shall use
the modified version

0(016%) = ¢ (9; W).
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With this adjustment, the steps in the EM algorithm are as follows:

E-step. Calculate Egi» (X|Y) (e.g., with the Kalman fixed-point smoother) and form
£ (9; W) .
M-step. Find the maximum likelihood estimator for the “complete” data problem,
i.e., maximize E(O : W) For ARMA processes, ITSM can be used directly, with
the missing values replaced with their best estimates computed in the E-step.

Example 9.7.1. The Lake Data

It was found in Example 5.2.5 that the AR(2) model
W, — 1.0415W,_; + 0.2494W,_, = Z,, {Z;} ~ WN(0, .4790)

was a good fit to the mean-corrected lake data {W;}. To illustrate the use of the EM
algorithm for missing data, consider fitting an AR(2) model to the mean-corrected
data assuming that there are 10 missing values at times ¢ = 17, 24, 31, 38, 45, 52, 59,
66, 73, and 80. We start the algorithm at iteration O with ¢(0) (0) = 0. Since this
initial model represents white noise, the first E-step gives, in the notatlon used above,
Wn =...= Wgo = 0. Replacing the “missing” values of the mean-corrected lake data
with 0 and fitting a mean-zero AR(2) model to the resulting complete data set using
the maximum likelihood option in ITSM, we find that d)(l) = (.7252, d)él) = 0.0236.
(Examination of the plots of the ACF and PACF of this new data set suggests an AR(1)
as a better model. This is also borne out by the small estimated value of ¢,.) The
updated missing values at times ¢t = 17,24, ..., 80 are found (see Section 9.6 and
Problem 9.21) by minimizing

2
A N 2
> (Wt+./ — 1 Wiy — ¢§1)Wt+./—2)

J=0

with respect to W,. The solution is given by

B Wi+ Wi + (8" = 370" ) Wit + W)

n 2
)

The M-step of iteration 1 is then carried out by fitting an AR(2) model using
ITSM applied to the updated data set. As seen in the summary of the results reported
in Table 9.1, the EM algorithm converges in four iterations with the final parameter
estimates reasonably close to the fitted model based on the complete data set. (In
Table 9.1, estimates of the missing values are recorded only for the first three.)
Also notice how —2¢ (O(i), W) decreases at every iteration. The standard errors of
the parameter estimates produced from the last iteration of ITSM are based on a
“complete” data set and, as such, underestimate the true sampling errors. Formulae for
adjusting the standard errors to reflect the true sampling error based on the observed
data can be found in Dempster et al. (1977).

=

0

9.8 Generalized State-Space Models

Asin Section 9.1, we consider a sequence of state variables {X;, ¢ > 1} and a sequence
of observations {Y;, t > 1}. For simplicity, we consider only one-dimensional state and
observation variables, since extensions to higher dimensions can be carried out with



288

Chapter 9

State-Space Models

Table 9.1

Estimates of the missing observations at times t = 17,
24, 31 and the AR estimates using the EM algorithm in
Example 9.7.1

Iteration i W1 7 W24 W31 q@%i) q@é” —2¢ (0 o, W)
0 0 0 322.60
1 0 0 0 0.7252 0.0236 244.76
2 0.534 0.205 0.746 1.0729 —0.2838 203.57
3 0.458 0.393 0.821 1.0999 -0.3128 202.25
4 0.454 0.405 0.826 1.0999 —-0.3128 202.25

little change. Throughout this section it will be convenient to write Y® and X® for the
t dimensional column vectors Y® = (Y}, Y, ..., Y,) and X® = (X|, X5, ..., X,)'.

There are two important types of state-space models, “parameter driven” and
“observation driven,” both of which are frequently used in time series analysis. The
observation equation is the same for both, but the state vectors of a parameter-driven
model evolve independently of the past history of the observation process, while the
state vectors of an observation-driven model depend on past observations.

9.8.1 Parameter-Driven Models

In place of the observation and state equations (9.1.1) and (9.1.2), we now make the
assumptions that ¥, given (X,, X*~P, Y=V} is independent of (X“~V, Y“~V) with
conditional probability density

p(ytlxt) ::p(ytlxtax(t71)7 y(til))’ = 1a2a ceey (981)

and that X,;; given (X;, XD, Y®) is independent of (X“~", Y) with conditional
density function

PGt x) i= piale, xV y0) r=1,2,. 9.8.2)

We shall also assume that the initial state X; has probability density p;. The joint
density of the observation and state variables can be computed directly from (9.8.1)—
(9.8.2) as

p(yla---ayihxl""axn) :p(ynlxn’x(n_l)7 y(n_l))p(xn’X(n_l)’y(n_l))

(n—=1) (n—l)) (n—l), X(n—l))

p(y
("—1)’ X("—l))

= p(yulxa)p (xn|X >y

= P(}’n |-xn)p(xn |xn71)p (y

Hp(yﬂxj) Hp(xj|xj—l) pi(x1),
=1

Jj=2
and since (9.8.2) implies that {X;} is Markov (see Problem 9.22),

POyl x) = ([ [l | - 9.8.3)

j=1
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Example 9.8.1.

We conclude that Yy, ..., Y, are conditionally independent given the state variables
X1, ..., X,, so that the dependence structure of {Y;} is inherited from that of the state
process {X;}. The sequence of state variables {X,} is often referred to as the hidden or
latent generating process associated with the observed process.

In order to solve the filtering and prediction problems in this setting, we shall
determine the conditional densities p (x,ly(’)) of X, given Y, and p (x,ly(’*l)) of X,
given YU~ respectively. The minimum mean squared error estimates of X, based on
Y® and Y~V can then be computed as the conditional expectations, E (X,|Y(’)) and
E (X,[Y"D).

An application of Bayes’s theorem, using the assumption that the distribution of
Y; given (X,, XD, Y(’_l)) does not depend on (X(’_l), Y(’_l)), yields

p (xly?) = pOilx)p (xly" =) /p (relyD) (9.8.4)
and

p (i ly®) = / P (1Y) s ) dia (). 9.8.5)

(The integral relative to du(x,) in (9.8.4) is interpreted as the integral relative to dx;
in the continuous case and as the sum over all values of x; in the discrete case.) The
initial condition needed to solve these recursions is

p (xly?) == pi(x). (9.8.6)
The factor p (yt|y(’_1)) appearing in the denominator of (9.8.4) is just a scale factor,
determined by the condition [ p (xt|y(’)) du(x;) = 1. In the generalized state-

space setup, prediction of a future state variable is less important than forecasting a
future value of the observations. The relevant forecast density can be computed from
(9.8.5) as

p (yt+1|y(t)) = /P(yt+1|xt+l)]7 (xt+1|y(t)) dp(xey1)- 9.8.7)

Equations (9.8.1)—(9.8.2) can be regarded as a Bayesian model specification. A
classical Bayesian model has two key assumptions. The first is that the data Y1, ..., Y},
given an unobservable parameter (X in our case), are independent with specified
conditional distribution. This corresponds to (9.8.3). The second specifies a prior
distribution for the parameter value. This corresponds to (9.8.2). The posterior
distribution is then the conditional distribution of the parameter given the data. In
the present setting the posterior distribution of the component X, of X is determined
by the solution (9.8.4) of the filtering problem.

Consider the simplified version of the linear state-space model of Section 9.1,
Y, =GX,+ W, (W} ~iid N, R), (9.8.8)
X1 =FX, + 'V, {Vi} ~1id N(0, Q), (9.8.9)

where the noise sequences {W,} and {V,} are independent of each other. For this model
the probability densities in (9.8.1)—(9.8.2) become

p1(x1) = n(xy; EXy, Var(Xy)), (9.8.10)
pilx) = n(y; Gxi, R), (9.8.11)
PXey1lx) = n(xp1; Fxp, Q), (9.8.12)

where n (x; “w, 02) is the normal density with mean p and variance o> defined in
Example (a) of Section A.1.
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To solve the filtering and prediction problems in this new framework, we first
observe that the filtering and prediction densities in (9.8.4) and (9.8.5) are both normal.
We shall write them, using the notation of Section 9.4, as

p (xIY?) = n(x; Xyr, 240) (9.8.13)
and
p (xt+1|Y(’)) —n (X;-H; )A(H-l, -Qt+1) . (9.8.14)

From (9.8.5), (9.8.12), (9.8.13), and (9.8.14), we find that

o0
X :/ xt+1p(xt+l|Y(t))dxt+l

o]

o0 o0
= / Xi41 / PO YO p (g X)) dxy dxisy
—00 —00

/ P(xt|Y(t)) [/ Xep 1P (X1 |%7) dxt+l] dx;

oo oo

o0
_ / Fxp(a]Y®) d,

00
= FXy
and (see Problem 9.23)
Qi1 = F2 Q24+ 0.

Substituting the corresponding densities (9.8.11) and (9.8.14) into (9.8.4), we find by
equating the coefficient of x*> on both sides of (9.8.4) that

Q1'=G>R '+ Q;l =GR+ (F29t—1|t—1 +0)™!

t|t

and
Xy =%+ 2GR (¥, - GX,) .

Also, from (9.8.4) with p (x1 |y(0)) = n(x;; EX;, £21) we obtain the initial conditions
X1 = EX; + £2,,GR™' (Y, — GEX))

and
Q=GR+

The Kalman prediction and filtering recursions of Section 9.4 give the same results for
X, and X,;, since for Gaussian systems best linear mean square estimation is equivalent
to best mean square estimation.

O

Example 9.8.2. A non-Gaussian Example

In general, the solution of the recursions (9.8.4) and (9.8.5) presents substantial
computational problems. Numerical methods for dealing with non-Gaussian models
are discussed by Sorenson and Alspach (1971) and Kitagawa (1987). Here we shall
illustrate the recursions (9.8.4) and (9.8.5) in a very simple special case. Consider the
state equation

X, =aX;_y, (9.8.15)
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with observation density

() Ve

yi! ’

p(ytlxl) = yl‘ = Oa la ) (9816)

where 7 is a constant between O and 1. The relationship in (9.8.15) implies that the
transition density [in the discrete sense—see the comment after (9.8.5)] for the state
variables is

1, ifxy =ax,

P(Xey1lx) = .
0, otherwise.

We shall assume that X; has the gamma density function
I’ (o)
(This is a simplified model for the evolution of the number X; of individuals at time
t infected with a rare disease, in which X; is treated as a continuous rather than an
integer-valued random variable. The observation Y, represents the number of infected
individuals observed in a random sample consisting of a small fraction 7w of the

population at time ¢.) Because the transition distribution of {X;} is not continuous,
we use the integrated version of (9.8.5) to compute the prediction density. Thus,

pi(x) = glxs @, A) = , x> 0.

[e¢)
P(Xt = x|y(t_1)) = / P(X; < x[x;—1)p (xt—l|y(t_l)) dx,—y
0

x/a
-1
= / p (xtfl |y(t )) dx, ;.
0
Differentiation with respect to x gives

p(xly" V) =a "px_ yen (a ' xly"P). (9.8.17)

Now applying (9.8.4), we find that
pxilyn) = p(yilx)pi(x)/p(y1)

_((rtxl)yle_’”‘l) )»"‘x‘ffleflxl ( 1 )
B yi! () p(y1)

atyr =1 —(r+i
= c(y)x, e~ THhx

x; > 0,

where c(y1) is an integration factor ensuring that p(-|y;) integrates to 1. Since p(-|y;)
has the form of a gamma density, we deduce (see Example (d) of Section A.1) that

pxilyr) = glxy; ar, Ap), (9.8.18)

where oy = o 4+ y; and A; = A + 7. The prediction density, calculated from (9.8.5)
and (9.8.18), is

p (ely") = a ' pyyo (e 0ly?)

1, .
X2, U1, )"l)

= ailg (ai
= g(x; a1, A1 /a).
Iterating the recursions (9.8.4) and (9.8.5) and using (9.8.17), we find that for ¢ > 1,

p (xt|y(t)) = g(xs; oy Ay) (9.8.19)
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Example 9.8.3.

and

P (xs1ly?) = a” g (a  xprs o, Ay
= 8413 sy A/ a), (9.8.20)
where oy = a1+ vy, = a+y 1+ ---+yand A, = A_jJa+n = ra'"" +
b4 (1 — a") /(1 — a~"). In particular, the minimum mean squared error estimate of

x; based on y is the conditional expectation «;/A, with conditional variance «;/ )Ltz.
From (9.8.7) the probability density of ¥, given Y is

N .

(er 1)yr+le T Xr+1

POaly?) = / ( ’+y , 8(1; 1, /@) iy
0 t+1-

B F(at+yt+l) (1 B T )Olt( T )yr+1
I'(a) I (i1 + 1) Al Artl

:nb(yt-l—l;atal_ﬂ/}\’t'i-l)? yH-l:Oala--"

where nb(y; o, p) is the negative binomial density defined in example (i) of Sec-
tion A.1. Conditional on Y”, the best one-step predictor of Y, is therefore the mean,
o, /(A1 — 1), of this negative binomial distribution. The conditional mean squared
error of the predictor is Var(Y,H |Y(’)) = o, Arq1/ (A1 — )% (see Problem 9.25).

O

A Model for Time Series of Counts

We often encounter time series in which the observations represent count data. One
such example is the monthly number of newly recorded cases of poliomyelitis in the
U.S. for the years 1970-1983 plotted in Figure 9-6. Unless the actual counts are large
and can be approximated by continuous variables, Gaussian and linear time series
models are generally inappropriate for analyzing such data. The parameter-driven
specification provides a flexible class of models for modeling count data. We now
discuss a specific model based on a Poisson observation density. This model is similar
to the one presented by Zeger (1988) for analyzing the polio data. The observation
density is assumed to be Poisson with mean exp{x;}, i.e.,

Xtytp—¢€ i
pyilx) = ———, »=0,1,..., (9.8.21)
t-
while the state variables are assumed to follow a regression model with Gaussian
AR(1) noise. If u; = (uy1, . .., uy)’ are the regression variables, then
X =Bu + W, (9.8.22)

where 3 is a k-dimensional regression parameter and
W, =¢W,.1+Z, {Z}~I1DN(0,0?).
The transition density function for the state variables is then
PG lx) = n(xigrs B+ (v — By, 07). (9.8.23)

The case o> = 0 corresponds to a log-linear model with Poisson noise.

Estimation of the parameters 6 = (ﬁ’, ¢, 02)/ in the model by direct numerical
maximization of the likelihood function is difficult, since the likelihood cannot be
written down in closed form. (From (9.8.3) the likelihood is the n-fold integral,

/ / exp {Z(xtyr—ex’)]L(O; x™) (dxl---dxn)/]_[(yi!),
- - =1 i=1
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Figure 9-6

Monthly number of U.S.
cases of polio, January
1970-December 1983
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where L(0;x) is the likelihood based on Xi, ..., X,.) To overcome this difficulty,
Chan and Ledolter (1995) proposed an algorithm, called Monte Carlo EM (MCEM),
whose iterates 0? converge to the maximum likelihood estimate. To apply this
algorithm, first note that the conditional distribution of Y™ given X does not depend
on 0, so that the likelihood based on the complete data (X(”)’, Y(")’)/ is given by

L(6; X", Y") =f(Y?IX?)L(0;X™).
The E-step of the algorithm (see Section 9.7) requires calculation of
0(816?) = Egi (InL(6; X, Y")|Y™)
= Ego (In fF(Y™|X™)|Y™) + Ego (InL(8; X™)|Y™).

We delete the first term from the definition of Q, since it is independent of 8 and hence
plays no role in the M-step of the EM algorithm. The new Q is redefined as

0(016") = Ego (InL(; X™)|Y™). (9.8.24)

Even with this simplification, direct calculation of Q is still intractable. Suppose
for the moment that it is possible to generate replicates of X" from the conditional
distribution of X given Y when @ = 0" If we denote m independent replicates of
X®™ by X("), ..., X" then a Monte Carlo approximation to Q in (9.8.24) is given by

O (01609) = ZlnL ( x}’”) .

The M-step is easy to carry out using Q,, in place of Q (especially if we condition on
X; = 01in all the simulated replicates), since L is just the Gaussian likelihood of the
regression model with AR(1) noise treated in Section 6.6. The difficult steps in the
algorithm are the generation of replicates of X given Y and the choice of m. Chan
and Ledolter (1995) discuss the use of the Gibb’s sampler for generating the desired
replicates and give some guidelines on the choice of m.

In their analyses of the polio data, Zeger (1988) and Chan and Ledolter (1995)
included as regression components an intercept, a slope, and harmonics at periods of
6 and 12 months. Specifically, they took

u; = (1, /1000, cos(2rt/12), sin(2mt/12), cos(2mwt/6), sin(27wt/6)) .
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Figure 9-7

Trend estimate for the
monthly number of

U.S. cases of polio,
January 1970-December
1983
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The implementation of Chan and Ledolter’s MCEM method by Kuk and Cheng (1994)
gave estimates B =(0.247, —3.871, 0.162, —0.482, 0.414, —0.011)’, qAﬁ = 0.648, and
62 = 0.281. The estimated trend function ,[:}’ut is displayed in Figure 9-7. The negative
coefficient of #/1000 indicates a slight downward trend in the monthly number of polio
cases.

g

9.8.2 Observation-Driven Models

Again we assume that Y,, conditional on (X,,X(’*l),Y(t*U), is independent of
(X(’_l), Y(’_”). These models are specified by the conditional densities

pilx) =p(lx®,y* ), t=1,2,..., (9.8.25)

P ly?) = px,yo (e ly?),  1=0,1,..., (9.8.26)

where p(x1 |y(0)) := p1(xy) for some prespecified initial density p; (x;). The advantage
of the observation-driven state equation (9.8.26) is that the posterior distribution of
X, given Y can be computed directly from (9.8.4) without the use of the updating
formula (9.8.5). This then allows for easy computation of the forecast function
in (9.8.7) and hence of the joint density function of (Y1, ..., Y,),

POy = [ [ (v ). (9.8.27)
=1

On the other hand, the mechanism by which the state X, ; makes the transition to
X, is not explicitly defined. In fact, without further assumptions there may be state
sequences {X;} and {X;'} with different distributions for which both (9.8.25) and
(9.8.26) hold (see Example 9.8.6). Both sequences, however, lead to the same joint
distribution, given by (9.8.27), for Yy, ..., Y,. The ambiguity in the specification of
the distribution of the state variables can be removed by assuming that X,,; given
(X, Y®) is independent of X, with conditional distribution (9.8.26), i.e.,

p (X ¥0) =p, L (aly®). (9.8.28)

Xit1
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With this modification, the joint density of Y™ and X is given by (cf. (9.8.3))
p (Y, x") = p(yulx)p (xaly" ) p ("1, x"7D)
= 1_[ (P()’t|xt)l7 (xt|y(t_l))) .
=1
Example 9.8.4. An AR(1) Process
An AR(1) process with iid noise can be expressed as an observation driven model.
Suppose {Y;} is the AR(1) process
Yi=¢Y, 1+ 2,
where {Z;} is an iid sequence of random variables with mean 0 and some probability
density function f(x). Then with X, := Y;_; we have
Pelxe) = (ye — dx1)
and
1, ifxy =
"\ _ ’ t+1 Yt
pxenly”) =
( t+ ) 0, otherwise.
O
Example 9.8.5. Suppose the observation-equation density is given by
tyr —Xr
p(yilx) = NI y=01..., (9.8.29)
t.
and the state equation (9.8.26) is
p (xt+1 |y(t)) = g(x; an, Ay, (9.8.30)

where oy = a« +y; + --- + y; and A; = A + t. It is possible to give a parameter-
driven specification that gives rise to the same state equation (9.8.30). Let {X]'} be the
parameter-driven state variables, where X; = X* | and X} has a gamma distribution
with parameters o and A. (This corresponds to the model in Example 9.8.2 with &7 =
a = 1.) Then from (9.8.19) we see that p (xfly(’)) = g(x}; o, A;), which coincides
with the state equation (9.8.30). If {X;} are the state variables whose joint distribution is
specified through (9.8.28), then {X;} and {X;} cannot have the same joint distributions.
To see this, note that
* *\ 1’ ifx:(—i-l :x;k’
P (XIH |xt) B 0, otherwise,

while

p (xt+l |X(t)» y(t)) =p (xt+l |y(t)) = g(xs; oy Ag).

If the two sequences had the same joint distribution, then the latter density could take
only the values 0 and 1, which contradicts the continuity (as a function of x;) of this
density.

O
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Proof.

Example 9.8.6.

9.8.3 Exponential Family Models

The exponential family of distributions provides a large and flexible class of distribu-
tions for use in the observation equation. The density in the observation equation is
said to belong to an exponential family (in natural parameterization) if

P(Yilx:) = explyx: — b(x;) + c(y,)}, (9.8.31)

where b(-) is a twice continuously differentiable function and c(y;) does not depend
on x;. This family includes the normal, exponential, gamma, Poisson, binomial, and
many other distributions frequently encountered in statistics. Detailed properties of
the exponential family can be found in Barndorff-Nielsen (1978), and an excellent
treatment of its use in the analysis of linear models is given by McCullagh and Nelder
(1989). We shall need only the following important facts:

P = / exp{yx; + c)} v(dyy), (©.8.32)
b’(xt) = E(Y;|x,), (9.8.33)
B () = Var(Y, ) = / VGl vidy) — [0/ )] (9.8.34)

where integration with respect to v(dy,) means integration with respect to dy, in the
continuous case and summation over all values of y; in the discrete case.

The first relation is simply the statement that p(y,|x;) integrates to 1. The second rela-
tion is established by differentiating both sides of (9.8.32) with respect to x; and then
multiplying through by e~*" (for justification of the differentiation under the integral
sign see Barndorff-Nielsen 1978). The last relation is obtained by differentiating
(9.8.32) twice with respect to x, and simplifying. |

The Poisson Case

If the observation Y;, given X; = x;, has a Poisson distribution of the form (9.8.21),
then

pOilx) = exp{yx, —e® —Iny !}, »=0,1,..., (9.8.35)

which has the form (9.8.31) with b(x;) = e* and c(y;) = —Iny,!. From (9.8.33)
we easily find that E(Y;|x,) = b'(x;,) = e*'. This parameterization is slightly different
from the one used in Examples 9.8.2 and 9.8.5, where the conditional mean of Y, given
x; was mx, and not e*. For this observation equation, define the family of densities

flx; a,A) = explax — Ab(x) + A(x, )}, —00 < x < 00, (9.8.36)
where ¢ > 0 and A > 0O are parameters and A(e, A) = —InI'(¢) + alnA. Now
consider state densities of the form

Pty ?) = FOgrs eopre, v, (9.8.37)

where o, and A, are, for the moment, unspecified functions of y®. (The subscript
t+ 1]t on the parameters is a shorthand way to indicate dependence on the conditional
distribution of X, given Y®.) With this specification of the state densities, the
parameters o), are related to the best one-step predictor of Y, through the formula

Wit/ Aty = Yipr i= E (Y ly?) . (9.8.38)
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We have from (9.8.7) and (9.8.33) that
o 00

E(Yt+l|y(t)) = Z / Vet 1P Y1 [Xe1)P (xt+1|y(t)) dxi 11

Yer1=0" "%

oo
=/ b (xi41)p (Xr+1|y(t)) dxiy 1.

o]

Addition and subtraction of a4 1;/As41); then gives

o0
rt1 X1

E(Yi31ly") =/ (b/(x,ﬂ) - = I)P(xt+1|y(t)) dxey1 + asll

—o At1le Attt

* Orp 1y

= / _)L;rlwp/ (xt+1|y(t)) dx; 41 + 3
—00 t+1|t
Hi1=00 Ot 1)t

= [ hitiep (ealy®)]

Qg1

X41=—00 }\t+l|t
= .
t+1]t .

Letting A;;—1 = A(@—1, Ai—1), we can write the posterior density of X; given
Y® as

P (uly™) = explyi — b(x)) + ()} explo 1% — Ayi—1b(x,)
+ Age—1}/p (ely"P)
= exp{Ay; (a,hxt - b(x,)) — Ay,
= fx; o, Ar),

where we find, by equating coefficients of x, and b(x,), that the coefficients A, and «,
are determined by

A =14+ Ay-1, (9.8.39)
o =Y+ o1 (9.8.40)

The family of prior densities in (9.8.37) is called a conjugate family of priors for
the observation equation (9.8.35), since the resulting posterior densities are again
members of the same family.

As mentioned earlier, the parameters «;;—; and A,,—; can be quite arbitrary: Any
nonnegative functions of y“~! will lead to a consistent specification of the state
densities. One convenient choice is to link these parameters with the corresponding
parameters of the posterior distribution at time ¢ — 1 through the relations

A1) = OA; (: s(1+ )\,‘t_l)) , (9.841)
Q1) = 00 (: 3(y + Olm—l)) , (9.8.42)
where 0 < § < 1 (see Remark 4 below). Iterating the relation (9.8.41), we see that
Arpip =81+ A1) = 8 + SAq—1
=38+ 6(8 +Ai—o—2)
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=8+8+ - +8+8N0 (9.8.43)
— 8/(1 —6)
as t — oo. Similarly,
Qpp1)r = 0y + Sotge—1
= 8y + 8%yt 4 -+ + 8'y1 + 8o (9.8.44)
For large ¢, we have the approximations
Aiajp = 8/(1 = 8) (9.8.45)
and
—1
A1) = 6 Z 87y, (9.8.46)
j=0

which are exactif 1o = §/(1 —4) and a1 = 0. From (9.8.38) the one-step predictors
are linear and given by
. Wy gm0 80+ 8 e

P = - , . (9.8.47)
" )"H»l\t th;(l) 87 + (St_l)x”()

Replacing the denominator with its limiting value, or starting with A;p = §/(1 — §),
we find that Y, is the solution of the recursions

Yeor= (1 =8y, +8Y, r=12,..., (9.8.48)

with initial condition IA/l = (1 - 8)8*104”0. In other words, under the restrictions
of (9.8.41) and (9.8.42), the best one-step predictors can be found by exponential
smoothing.

g

Remark 1. The preceding analysis for the Poisson-distributed observation equation
holds, almost verbatim, for the general family of exponential densities (9.8.31). (One
only needs to take care in specifying the correct range for x and the allowable
parameter space for o and A in (9.8.37).) The relations (9.8.43)—(9.8.44), as well as
the exponential smoothing formula (9.8.48), continue to hold even in the more general
setting, provided that the parameters oy,—; and A,_; satisfy the relations (9.8.41)—
(9.8.42). g

Remark 2. Equations (9.8.41)—(9.8.42) are equivalent to the assumption that the prior
density of X, given y~! is proportional to the §-power of the posterior distribution of
X,_; given Y=V or more succinctly that

SO oty Aj—1) = f O dQ—1j—1, SAi—1—1)
o f2 (s O 1)—15 M—1ji—1)-
This power relationship is sometimes referred to as the power steady model (Grun-
wald et al. 1993; Smith 1979). O
Remark 3. The transformed state variables W, = e* have a gamma state density
given by

P (Wit Iy"?) = gWists @rries Agape)
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Example 9.8.7.

(see Problem 9.26). The mean and variance of this conditional density are

E (Wr+1|y(t)) =a,, and  Var (Wr+1|y(t)) = O‘t+1\t/)"t2+1|t' O

Remark 4. If we regard the random walk plus noise model of Example 9.2.1 as the
prototypical state-space model, then from the calculations in Example 9.8.1 with G =
F =1, we have

E (X11Y?) = E (X,|Y?Y)
and
Var (X,11]Y?) = Var (X,/Y?) + O > Var (X,[Y").

The first of these equations implies that the best estimate of the next state is the same
as the best estimate of the current state, while the second implies that the variance
increases. Under the conditions (9.8.41), and (9.8.42), the same is also true for the
state variables in the above model (see Problem 9.26). This was, in part, the rationale
behind these conditions given in Harvey and Fernandes (1989). O

Remark 5. While the calculations work out neatly for the power steady model,
Grunwald et al. (1994) have shown that such processes have degenerate sample paths
for large . In the Poisson example above, they argue that the observations Y; converge
to 0 as + — oo (see Figure 9-12). Although such models may still be useful in
practice for modeling series of moderate length, the efficacy of using such models
for describing long-term behavior is doubtful. U

Goals Scored by England Against Scotland

The time series of the number of goals scored by England against Scotland in soccer
matches played at Hampden Park in Glasgow is graphed in Figure 9-8. The matches
have been played nearly every second year, with interruptions during the war years. We
will treat the data yy, . . ., ys, as coming from an equally spaced time series model {Y;}.
Since the number of goals scored is small (see the frequency histogram in Figure 9-9),
a model based on the Poisson distribution might be deemed appropriate. The observed
relative frequencies and those based on a Poisson distribution with mean equal to
¥s2 = 1.269 are contained in Table 9.2. The standard chi-squared goodness of fit test,
comparing the observed frequencies with expected frequencies based on a Poisson
model, has a p-value of 0.02. The lack of fit with a Poisson distribution is hardly
unexpected, since the sample variance (1.652) is much larger than the sample mean,
while the mean and variance of the Poisson distribution are equal. In this case the
data are said to be overdispersed in the sense that there is more variability in the data
than one would expect from a sample of independent Poisson-distributed variables.
Overdispersion can sometimes be explained by serial dependence in the data.

Dependence in count data can often be revealed by estimating the probabilities of
transition from one state to another. Table 9.3 contains estimates of these probabilities,
computed as the average number of one-step transitions from state y, to state y;; . If
the data were independent, then in each column the entries should be nearly the same.
This is certainly not the case in Table 9.3. For example, England is very unlikely to be
shut out or score 3 or more goals in the next match after scoring at least three goals in
the previous encounter.
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Table 9.2

1870 1880 1890 1900 1910 1920 1930 1940 1950 1960 1970 1980 1990

15 20

frequency
10

m II.
_._
0 1 2 3 4 5

goals

Relative frequency and fitted Poisson distribution of goals scored
by England against Scotland

Number of goals

0 1 2 3 4 5

Relative frequency 0.288 0.423 0.154 0.019 0.096 0.019

Poisson distribution  0.281 0.356 0.226 0.096 0.030 0.008

Harvey and Fernandes (1989) model the dependence in this data using an
observation-driven model of the type described in Example 9.8.6. Their model assumes

a Poisson observation equation and a log-gamma state equation:

exp{yux; — e*}
pP(yilx) = py+, y=0,1,...,

1

P (xt|y(t_1)) =f(x; -1, Aji—1), —00 < X < 00,
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Table 9.3

Table 9.4

Transition probabilities for the number of goals
scored by England against Scotland

Yi+1

P(Yet1lye) 0 1 2 >3

0 0214 0500  0.214  0.072
Yt 1 0.409 0.272 0.136 0.182

2 0.250 0.375 0.125 0.250

>3 0 0.857 0.143 0

Prediction density of Y53 given Y2 for data in Figure 9-7

Number of goals

0 1 2 3 4 5

p(ys3ly®?) 0472 0326  0.138  0.046  0.013  0.004

fort = 1,2,..., where f is given by (9.8.36) and a9 = 0, Ao = 0. The power
steady conditions (9.8.41)—(9.8.42) are assumed to hold for o;;—; and A,—;. The only
unknown parameter in the model is §. The log-likelihood function for § based on the

conditional distribution of yy, ..., ys, given y; is given by [see (9.8.27)]
n—1
£(8,y") = Inp (isaly”), (9.8.49)

=1

where p ( Vit1 |y(’))) is the negative binomial density [see Problem 9.25(c)]

P (et ly?) = nb (Yets ety (L4 A ™),

with o4, and A4}, as defined in (9.8.44) and (9.8.43). (For the goal data, y; = 0,
which implies az;; = 0 and hence that p (yzly(l)) is a degenerate density with unit
mass at y, = 0. Harvey and Fernandes avoid this complication by conditioning the
likelihood on y(*, where 7 is the time of the first nonzero data value.)

Maximizing this likelihood with respect to §, we obtain § = 0.844. (Starting
equations (9.8.43)—(9.8.44) with ajp = 0 and A9 = 4/(1 — §), we obtain
§ = 0.732.) With 0.844 as our estimate of §, the prediction density of the next
observation Ys3 given y©? is nb(ys3; as3js2, (1 +A53|52)_1. The first five values of this
distribution are given in Table 9.4. Under this model, the probability that England
will be held scoreless in the next match is 0.471. The one-step predictors, Y, =
0,Y,,..., Y5, are graphed in Figure 9-10. (This graph can be obtained by using the
ITSM option Smooth>Exponential with o = 0.154.)

Figures 9-11 and 9-12 contain two realizations from the fitted model for the goal
data. The general appearance of the first realization is somewhat compatible with the
goal data, while the second realization illustrates the convergence of the sample path
to 0 in accordance with the result of Grunwald et al. (1994).

O
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Goals
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Example 9.8.8. The Exponential Case

Suppose Y, given X; has an exponential density with mean —1/X, (X; < 0). The
observation density is given by

pilx) = exp{yx; +In(—x)}, y; >0,

which has the form (9.8.31) with b(x) = — In(—x) and c(y) = 0. The state densities
corresponding to the family of conjugate priors (see (9.8.37)) are given by

P (xe11y?) = explovsiy Xrt — At bGey1) + Arpryed,  —00 < x < 0.

(Here p(x,41]y®) is a probability density when Qp1r > 0and Ay, > —1.) The
one-step prediction density is
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Figure 9-12

A second simulated time
series from the fited S [
model to the goal data 0

0
p ()’t+1 |y(t) — f ext+lyr+l+1n(*xr+l)+at+l|rx*)\t+l|rb(x)+Ar+1\t d-xt+1

—00

Ar1prt1 —Agap—2
= <}\'t+l|t + 1)“,+1|, Vo1 F @gy)) "0 v > 0

(see Problem 9.28). While E(Y,,1|y") = a1 it/ Ar+1)r> the conditional variance is finite
if and only if 4,41, > 1. Under assumptions (9.8.41)—(9.8.42), and starting with A1, =
8/(1 — §), the exponential smoothing formula (9.8.48) remains valid.

]

Problems

9.1 Show that if all the eigenvalues of F are less than 1 in absolute value (or
equivalently that F* — 0 as k — 00), the unique stationary solution of equation
(9.1.11) is given by the infinite series

(0.¢]
X, =Y FlV_
j=0

and that the corresponding observation vectors are

o
Yt = Wt + Z GFth_j_].

J=0

Deduce that {(X], Y})'} is a multivariate stationary process. (Hint: Use a vector
analogue of the argument in Example 2.2.1.)

9.2 In Example 9.2.1, show that & = —1 if and only if 02 = 0, which in turn is
equivalent to the signal M, being constant.

9.3 Let F be the coefficient of X, in the state equation (9.3.4) for the causal AR(p)
process

Xi—pi X —- — ¢pXt—p =2, {Z}~WN (0, 02) .
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94

9.5

9.6

9.7

9.8
9.9

Establish the stability of (9.3.4) by showing that
det(zl — F) = 2¢ ('),

and hence that the eigenvalues of F are the reciprocals of the zeros of the
autoregressive polynomial ¢(z) =1 — ¢z —--- — ¢pz’.

By following the argument in Example 9.3.3, find a state-space model for {Y;}
when {VV,Y;} is an ARMA(p, g) process.

For the local linear trend model defined by equations (9.2.6)—(9.2.7), show that
V?Y, = (1 — B)?Y, is a 2-correlated sequence and hence, by Proposition 2.1.1,
is an MA(2) process. Show that this MA(2) process is noninvertible if auz =0.
a. For the seasonal model of Example 9.2.2, show that VY, = Y, — Y¥;_4 is an
MAC(1) process.

b. Show that VV,Y; is an MA(d + 1) process where {Y;} follows the seasonal
model with a local linear trend as described in Example 9.2.3.

Let {Y;} be the MA(1) process
Yi=Z+0Z_, {Z}~WN(0,07).
Show that {Y;} has the state-space representation
Y, =01 0]X,

where {X,} is the unique stationary solution of

01 1
Xt+1 = |:O 0:| X, + |:0:| Zt+1-

In particular, show that the state vector X, can written as

e

Verify equations (9.3.16)—(9.3.18) for an ARIMA(1,1,1) process.

Consider the two state-space models

Xir1,1=F1 Xy + Vi,
Yiu =GXy+ Wy,

and

Xir12=F)Xpn + Vp,
Yo =GXp+ Wp,

where {(V/,, W/

t1° t1°

for {(Y!,, Y.,)'}.

t

Vi, W,,)'} is white noise. Derive a state-space representation

9.10 Use Remark 1 of Section 9.4 to establish the linearity properties of the operator

P; stated in Remark 3.

9.11 a. Show that if the matrix equation XS=B can be solved for X, then X=BS~!

is a solution for any generalized inverse S~! of S.

b. Use the result of (a) to derive the expression for P(X|Y) in Remark 4 of
Section 9.4.



9.8  Generalized State-Space Models 305

9.12

9.13

9.14

9.15

9.16

9.17

9.18

9.19
9.20

9.21

In the notation of the Kalman prediction equations, show that every vector of
the form

Y:A1X1 +"' +AlXt
can be expressed as
Y = BIXI +--+ Bt—lXt—l + CtIta

where By, ..., B;_1 and C, are matrices that depend on the matrices Ay, ..., A;.
Show also that the converse is true. Use these results and the fact that £(XI;) =
O for all s < ¢ to establish (9.4.3).

In Example 9.4.1, verify that the steady-state solution of the Kalman recursions

(9.1.2) is given by £2, = (af + o+ 40303) /2.

Show from the difference equations for §2, in Example 9.4.1 that (£2,; —
£2)(£2£2) > Oforall 2, > 0, where §2 is the steady-state solution for £2, given in
Problem 9.13.

Show directly that for the MA(1) model (9.2.3), the parameter 6 is equal to
. (205 tol— Joi T 40303) / (202), which in tum is equal to —o2/(£2 +
02), where £2 is the steady-state solution for £2, given in Problem 9.13.

Use the ARMA(0,1,1) representation of the series {Y;} in Example 9.4.1 to show
that the predictors defined by

Yoor=aYy+ (1 —a)Y,, n=12,...,
where a = 2/(£2 + o2), satisfy

A

Yori = Yo =Zyn + (1 —a)" <Y0 —Zy— f/l) .

Deduce that if 0 < a < 1, the mean squared error of fﬂ,H converges to §2 + o2
for any initial predictor Y, with finite mean squared error.

a. Using equations (9.4.1) and (9.4.16), show that )A(ﬂrl = F Xy

b. From (a) and (9.4.16) show that X, satisfies the recursions

X = FroiXim1j—1 + 2,GA7 (Y, — GF Xom1j—1)
forr=2,3,..., with Xy = Xi + 2,G,47" (Y1 - GiXy).
In Section 9.5, show that for fixed Q*, —2In L ([L, o, ‘7»%) 1s minimized when
p and o2 are given by (9.5.10) and (9.5.11), respectively.
Verify the calculation of ®,A " and §2, in Example 9.6.1.

Verify that the best estimates of missing values in an AR(p) process are found
by minimizing (9.6.11) with respect to the missing values.

Suppose that {Y;} is the AR(2) process
Yi=¢Y 1+ Y 2+Z, {Z}~WN(0,0?),

and that we observe Y, Y, Y4, Y5, Ys, Y7. Show that the best estimator of Y3 is
(@2(Y1 +Ys) + (91 — $12) (Y2 + Y) / (1 + ¢ + ¢3)
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9.22

9.23

9.24

9.25

9.26

9.27

Let X, be the state at time ¢ of a parameter-driven model (see (9.8.2)). Show that
{X;} is a Markov chain and that (9.8.3) holds.

For the generalized state-space model of Example 9.8.1, show that £2,,; =
F29t|t + Q.

If Y and X are random variables, show that
Var(Y) = E(Var(Y|X)) + Var(E(Y|X)).

Suppose that Y and X are two random variables such that the distribution of Y

given X is Poisson with mean 7X, 0 < 7w < 1, and X has the gamma density

g(x; a, A).

a. Show that the posterior distribution of X given Y also has a gamma density
and determine its parameters.

b. Compute E(X|Y) and Var(X|Y).
c. Show that Y has a negative binomial density and determine its parameters.
d. Use (c) to compute E(Y) and Var(Y).

e. Verify in Example 9.8.2 that E(Y,HlY(’)) = om/(My1 — m) and
Var(YH-llY(t)) = A1/ Mgy — )%

For the model of Example 9.8.6, show that
a. E(X111Y?) = E (X,]Y?), Var(X,41]Y?) >Var(X,|Y®), and
b. the transformed sequence W, = ¢ has a gamma state density.

Let {V;} be a sequence of independent exponential random variables with EV, =
t~! and suppose that {X,, t > 1} and {Y,, t > 1} are the state and observation
random variables, respectively, of the parameter-driven state-space system

X =V,
XT:XT*I_{—VT? t:2,3,...,

where the distribution of the observation Y;, conditional on the random variables

Y1, Y, ..., Y1, X,, is Poisson with mean X,.

a. Determine the observation and state transition density functions p(y,|x,) and
p(x;11]x,) in the parameter-driven model for {Y;}.

b. Show, using (9.8.4)—(9.8.6), that
pily) = glxisyr +1,2)

and
pOe2lyr) = g0xa;y1 +2,2),

where g(x; «, A) is the gamma density function (see Example (d) of Sec-
tion A.1).

c. Show that
p(uly?) =gl a + 1,04+ 1)
and
p(xp1ly?) = gsis o + 1+ 1,1+ 1),
where o, =y + - + y,.
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d. Conclude from (c) that the minimum mean squared error estimates of X, and
X, basedon Yy, ..., Y;are
t+Y +---+ Y,

X, =
1)t 1

and
N _t+1+Y1+---+Yt
+1 = P

’

respectively.

9.28 Let Y and X be two random variables such that Y given X is exponential with
mean 1/X, and X has the gamma density function with

o x* exp{—ax}
gr+1l,a) = , x>0,
F(A+1)

where A > —1 and @ > 0.
a. Determine the posterior distribution of X given Y.

b. Show that Y has a Pareto distribution
pO) =G+ D’y + )2 y>0.

c. Find the mean and variance of Y. Under what conditions on « and A does the
latter exist?

d. Verify the calculation of p(y,+1|y(’)) and E (Y,Hly(’)) for the model in
Example 9.8.8.

9.29 Consider an observation-driven model in which Y; given X, is binomial with
parameters n and X,, i.e.,

n 5
pOilx) = Q)x?’(l —x)", oy, =0,1,...,n.
'

a. Show that the observation equation with state variable transformed by the
logit transformation W, = In(X,/(1 — X;)) follows an exponential family

pilwy) = exp{yw; — b(w;) + c(y)}.

Determine the functions b(-) and c(-).
b. Suppose that the state X; has the beta density

p(xt+1|y(t)) = f(Xt15 Qi 11t Aig11) s
where

fOs o) = [Bla, )] ¥ -0, 0<x<l,

B(a, )) := I'(e)I" (M) /T (o + X) is the beta function, and «, A > 0. Show that
the posterior distribution of X; given Y is also beta and express its parameters in
terms of y, and otr—1, Agr—1.

c. Under the assumptions made in (b), show that E (X,lY(t)) = E (Xt+1 |Y(’))
and Var(thY(’)) <Var(X,+1|Y(’)).

d. Assuming that the parameters in (b) satisfy (9.8.41)—(9.8.42), show that the one-
step prediction density p(y,+ 1 |y(’)) is beta-binomial,

B(aiq1)r + Yea1s Arte + 10— Yey1)
(n4+ DByt + 1,0 =yt + DB@g1ys Aesry)

PO1ly?) =

and verify that IA/,JF | 1s given by (9.8.47).



Forecasting Techniques

10.1 The ARAR Algorithm

10.2 The Holt-Winters Algorithm

10.3 The Holt-Winters Seasonal Algorithm
10.4 Choosing a Forecasting Algorithm

We have focused until now on the construction of time series models for stationary
and nonstationary series and the determination, assuming the appropriateness of these
models, of minimum mean squared error predictors. If the observed series had in
fact been generated by the fitted model, this procedure would give minimum mean
squared error forecasts. In this chapter we discuss three forecasting techniques that
have less emphasis on the explicit construction of a model for the data. Each of the
three selects, from a limited class of algorithms, the one that is optimal according to
specified criteria.

The three techniques have been found in practice to be effective on wide ranges
of real data sets (for example, the economic time series used in the forecasting com-
petition described by Makridakis et al. 1984).

The ARAR algorithm described in Section 10.1 is an adaptation of the ARARMA
algorithm (Newton and Parzen 1984; Parzen 1982) in which the idea is to apply auto-
matically selected “memory-shortening” transformations (if necessary) to the data
and then to fit an ARMA model to the transformed series. The ARAR algorithm we
describe is a version of this in which the ARMA fitting step is replaced by the fitting
of a subset AR model to the transformed data.

The Holt—Winters (HW) algorithm described in Section 10.2 uses a set of simple
recursions that generalize the exponential smoothing recursions of Section 1.5.1 to
generate forecasts of series containing a locally linear trend.

© Springer International Publishing Switzerland 2016 309
P.J. Brockwell, R.A. Davis, Introduction to Time Series and Forecasting,
Springer Texts in Statistics, DOI 10.1007/978-3-319-29854-2_10



310

Chapter 10

Forecasting Techniques

The Holt—Winters seasonal (HWS) algorithm extends the HW algorithm to handle
data in which there are both trend and seasonal variation of known period. It is
described in Section 10.3.

Each of these three algorithms can be applied to specific data sets with the aid of
the ITSM options Forecasting>ARAR, Forecasting>Holt-Winters and
Forecasting>Seasonal Holt-Winters.

10.1 The ARAR Algorithm

10.1.1 Memory Shortening

Given adataset {Y,,t = 1,2, ..., n}, the first step is to decide whether the underlying
process is “long-memory,” and if so to apply a memory-shortening transformation be-
fore attempting to fit an autoregressive model. The differencing operations permit-
ted under the option Transform of ITSM are examples of memory-shortening
transformations; however, the ones used by the option Forecasting>ARAR selects
are members of a more general class. There are two types allowed:

Y=Y, — ¢ (%)Y (10.1.1)
and
?t =Y - (i)lyt—l - (lA)ZYt—Z- (10-1-2)

With the aid of the five-step algorithm described below, we classify {Y;} and take
one of the following three courses of action:

e L. Declare {Y;} to be long-memory and form {f’,} using (10.1.1).
* M. Declare {Y;} to be moderately long-memory and form {f/t} using (10.1.2).

e S. Declare {Y;} to be short-memory.

If the alternative L or M is chosen, then the transformed series {f/,} is again
checked. If it is found to be long-memory or moderately long-memory, then a further
transformation is performed. The process continues until the transformed series is
classified as short-memory. At most three memory-shortening transformations are
performed, but it is very rare to require more than two. The algorithm for deciding
among L, M, and S can be described as follows:

1. Foreacht =1, 2, ..., 15, we find the value (]3(7,’) of ¢ that minimizes
" Y, — ¢Y,_.]?
ERR(9, 7) = 2=rlli = O¥ie]
Zt=r+1 Yt
We then define

Err(r) = ERR(¢(7), 7)
and choose the lag 7 to be the value of 7 that minimizes Err(7).
2. If Err(‘f) <8/n,gotoL.
.If () >0.93and ¢ > 2, goto L.
4. If (ﬁ(f) > 0.93 and 7 = 1 or 2, determine the values ¢, and ¢, of ¢; and ¢, that
minimize Y . 5[Y; — ¢1Y,—1 — ¢ Y,_»]%; then go to M.
5. I (£) <0.93, goto S.

w
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10.1.2 Fitting a Subset Autoregression

Let {S;,t = k+ 1, ..., n} denote the memory-shortened series derived from {Y;} by
the algorithm of the previous section and let S denote the sample mean of Sy, . .., S,.

The next step in the modeling procedure is to fit an autoregressive process to the
mean-corrected series

X, =S-S5, t=k+1,...,n
The fitted model has the form
Xt = ¢1Xt—1 + ¢11Xt—11 + ¢12Xt—lz + ¢13Xt—13 + Zt’

where {Z,} ~ WN (0, 02), and for given lags, I, [, and /3, the coefficients ¢; and the
white noise variance o2 are found from the Yule—Walker equations

1 pli—1)  pb—=1)  plz—=17] [ p(1)
oy —1) 1 plo=1)  ps=0) | ¢y | _ |pM)
p—1)  plh—1h) 1 plz—10h) | | ¢, o)
plz—=1)  pls—=1) pls—1h) 1 b1 p(13)

and

o =90 [1—¢1p(1) — ¢, p(h) — o) — P, p(13)],

where p(j) and p(j),j = 0,1,2,..., are the sample autocovariances and autocor-
relations of the series {X,}.
The program computes the coefficients ¢; for each set of lags such that

l<li<bh<lz<m,

where m can be chosen to be either 13 or 26. It then selects the model for which the
Yule-Walker estimate o2 is minimal and prints out the lags, coefficients, and white
noise variance for the fitted model.

A slower procedure chooses the lags and coefficients (computed from the Yule—
Walker equations as above) that maximize the Gaussian likelihood of the observations.
For this option the maximum lag m is 13.

The options are displayed in the ARAR Forecasting dialog box, which
appears on the screen when the option Forecasting>ARAR is selected. It allows
you also to bypass memory shortening and fit a subset AR to the original (mean-
corrected) data.

10.1.3 Forecasting

If the memory-shortening filter found in the first step has coefficients Yy(= 1),
Y1, ..., Y (k> 0), then the memory-shortened series can be expressed as

S=vBY, =Y +¥Y o+ + WYy, (10.1.3)
where 1 (B) is the polynomial in the backward shift operator,
Y(B) =1+ vy B+ + B

Similarly, if the coefficients of the subset autoregression found in the second step are
o1, P, 5 P, and ¢y, then the subset AR model for the mean-corrected series {X, =

S, —S}is
d(B)X: = Z,, (10.1.4)
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Example 10.1.1

where {Z,} ~ WN (0, 02) and

¢(B) =1— ¢B — ¢y,B" — ¢,,B” — ¢,B".
From (10.1.3) and (10.1.4) we obtain the equations

§BY, = ¢S+ Z, (10.1.5)
where

EB) =y B)p(B) =1+ & B+ + &4, B

Assuming that the fitted model (10.1.5) is appropriate and that the white noise
term Z; is uncorrelated with {Y;, j < 1} for each 7, we can determine the minimum
mean squared error linear predictors P,Y,, of Y, in terms of {1, Y1, ..., Y,}, for
n > k + I3, from the recursions

k+13
PiYoin == ) &PuYurnj + ¢S, h=1, (10.1.6)
j=1
with the initial conditions

P.Yyn =Y, forh<O. (10.1.7)
The mean squared error of the predictor P, Y, is found to be (Problem 10.1)
h—1
E[(Ynin — PuYuin)?] = _ 1707, (10.1.8)
J=0
where Z;:o 77 is the Taylor expansion of 1/£(z) in a neighborhood of z = 0.

Equivalently the sequence {z;} can be found from the recursion

=1 g& ;=0 n=12... (10.1.9)
j=0

10.1.4 Application of the ARAR Algorithm

To determine an ARAR model for a given data set {Y;} using ITSM, select Fore-
casting>ARAR and choose the appropriate options in the resulting dialog
box. These include specification of the number of forecasts required, whether or
not you wish to include the memory-shortening step, whether you require prediction
bounds, and which of the optimality criteria is to be used. Once you have made
these selections, click OK, and the forecasts will be plotted with the original data.
Right-click on the graph and then Info to see the coefficients 1, vy, ..., ¥y of the
memory-shortening filter ¥ (B), the lags and coefficients of the subset autoregression

Xi— 0 Xy — O Xomyy — G, Xi—t, — G, Xi—1y = 2,
and the coefficients & of B/ in the overall whitening filter
EB)=(1+v1B+--+¥B") (1 —¢B—¢,B" — ¢,,B” — ¢,B").

The numerical values of the predictors, their root mean squared errors, and the pre-
diction bounds are also printed.

To use the ARAR algorithm to predict 24 values of the accidental deaths
data, open the file DEATHS.TSM and proceed as described above. Selecting
Minimize WN variance [max lag=26] gives the graph of the data and
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Figure 10-1

The data set DEATHS.TSM
with 24 values predicted by
the ARAR algorithm
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predictors shown in Figure 10-1. Right-clicking on the graph and then Info, we
find that the selected memory-shortening filter is (1 — 0.9779B12). The fitted subset
autoregression and the coefficients &; of the overall whitening filter §(B) are shown

below: U
Optimal lags 1 3 12 13
Optimal coeffs 0.5915 —-0.3822 —-0.3022 0.2970

WAN Variance: 0.12314E+06

COEFFICIENTS OF OVERALL WHITENING FILTER:
1.0000 —-0.5915 0.0000 —0.2093 0.0000
0.0000 0.0000 0.0000 0.0000 0.0000
0.0000 0.0000 —0.6757 0.2814 0.0000
0.2047 0.0000 0.0000 0.0000 0.0000
0.0000 0.0000 0.0000 0.0000 —0.2955
0.2904

O
In Table 10.1 we compare the predictors of the next six values of the accidental
deaths series with the actual observed values. The predicted values obtained from

ARAR as described in the example are shown together with the predictors obtained
by fitting ARIMA models as described in Chapter 6 (see Table 10.1). The observed

root mean squared errors (i.e., \/ Zizl(Y72+h—P72Y72+h)2 /6 ) for the three prediction
methods are easily calculated to be 253 for ARAR, 583 for the ARIMA model (6.5.8),
and 501 for the ARIMA model (6.5.9). The ARAR algorithm thus performs very
well here. Notice that in this particular example the ARAR algorithm effectively fits
a causal AR model to the data, but this is not always the case.
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10.2 The Holt-Winters Algorithm

Table 10.1

10.2.1 The Algorithm

Given observations Yi, Y;, ..., Y, from the “trend plus noise” model (1.5.2), the
exponential smoothing recursions (1.5.7) allowed us to compute estimates 7, of
the trend at times r = 1, 2, .. ., n. If the series is stationary, then m, is constant and the
exponential smoothing forecast of Y, based on the observations Y1, ..., Y, is

PYph =iy, h=12,.... (10.2.1)

If the data have a (nonconstant) trend, then a natural generalization of the forecast
function (10.2.1) that takes this into account is

PoYyin=an+boh, h=12,..., (10.2.2)

where @, and b, can be thought of as estimates of the “level” a, and “slope” b, of
the trend function at time n. Holt (1957) suggested a recursive scheme for computing
the quantities a, and bn in (10.2.2). Denoting by Yn+1 the one-step forecast P, Y, .1, we
have from (10.2.2)

Yn+1 = a, + by.

Now, as in exponential smoothing, we suppose that the estimated level at time n + 1
is a linear combination of the observed value at time n + 1 and the forecast value at
time n + 1. Thus,

apt = @Y1 + (1 — @) (@, + by,). (10.2.3)

We can then estimate the slope at time n + 1 as a linear combination of a,.; — a, and
the estimated slope b,, at time n. Thus,

bur1 = B (@n1 — ) + (1 = B)by. (10.2.4)
In order to solve the recursions (10.2.3) and (10.2.4) we need initial conditions.
A natural choice is to set

=Y (10.2.5)
and

by =Yy — Y. (10.2.6)

Then (10.2.3) and (10.2.4) can be solved successively for a; and I;i, i=3,...,n,and
the predictors P, Y, found from (10.2.2).

The forecasts depend on the “smoothing parameters” « and . These can either
be prescribed arbitrarily (with values between 0 and 1) or chosen in a more systematic
way to minimize the sum of squares of the one-step errors Y 7, (Y;—P;_¥;)?, obtained

Predicted and observed values of the accidental deaths series fort = 73,...,78
t 73 74 75 76 77 78
Observed Yt 7798 7406 8363 8460 9217 9316
Predicted by ARAR 8168 7196 7982 8284 9144 9465
Predicted by (6.5.8) 8441 7704 8549 8885 9843 10,279

Predicted by (6.5.9) 8345 7619 8356 8742 9795 10,179
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when the algorithm is applied to the already observed data. Both choices are available
in the ITSM option Forecasting>Holt-Winters.

Before illustrating the use of the Holt—Winters forecasting procedure, we discuss
the connection between the recursions (10.2.3) and (10.2.4) and the steady-state
solution of the Kalman filtering equations for a local linear trend model. Suppose {Y;}
follows the local linear structural model with observation equation

Y, =M+W,

and state equation

M, 1 _ 11 M, t + Vt
Bt+1 B 01 Bt Ut
[see (9.2.4)—(9.2.7)]. Now define a,, and l;n to be the filtered estimates of M, and B,,,
respectively, i.e.,
an = Mn\n =P,M,,
b, = By, == P,B,.
Using Problem 9.17 and the Kalman recursion (9.4.16), we find that

&n a b N ~
X +1 _ |:an j‘ bni| + A,ZI.QHG/ <Yn — &, — bn) , (1027)
bn+1 b”

where G = [1 O]. Assuming that .(2,;91:[9,;,],% =1 is the steady-state solution

of (9.4.2) for this model, then A,=£2; + ‘7»% for all n, so that (10.2.7) simplifies to
the equations

. ar 21 PO
R Sy I L (Yn —a— b,,) 10.2.8
Any1 = Gy + +Q“+0£ a ( )
and
l;n-i-l = l;n + L (Yn - an - Z’;n) . (1029)
11 +Gv%

Solving (10.2.8) for (Y,, —a, — l;n) and substituting into (10.2.9), we find that

&n+1 = aYn+l + (1 —a) (an + Z’;n) ’ (10210)
bui1 = B (anr1 — @) + (1 — B)by (10.2.11)
with o = £,/ (-Q n+ av%) and B = £2,,/521,. These equations coincide with the
Holt—Winters recursions (10.2.3) and (10.2.4). Equations relating o and 8 to the
variances auz, 03, and ay% can be found in Harvey (1990).

To predict 24 values of the accidental deaths series using the Holt—Winters algorithm,
open the file DEATHS.TSM and select Forecasting>Holt-Winters. In the
resulting dialog box specify 24 for the number of predictors and check the box marked
Optimize coefficients for automatic selection of the smoothing coefficients
a and B. Click OK, and the forecasts will be plotted with the original data as shown in
Figure 10-2. Right-click on the graph and then Info to see the numerical values of
the predictors, their root mean squared errors, and the optimal values of & and 8. The

predicted and observed values are shown in Table 10.2.
0

The root mean squared error (\/ 22:1(Y72+h—P72Y72+h)2 / 6) for the nonseasonal
Holt—Winters forecasts is found to be 1143. Not surprisingly, since we have not taken
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Figure 10-2

The data set DEATHS.TSM
with 24 values predicted by

the nonseasonal
Holt-Winters algorithm

seasonality into account, this is a much larger value than for the three sets of forecasts
shown in Table 10.1. In the next section we show how to modify the Holt—Winters
algorithm to allow for seasonality.

10.2.2 Holt-Winters and ARIMA Forecasting

The one-step forecasts obtained by exponential smoothing with parameter « (defined
by (1.5.7) and (10.2.1)) satisfy the relations

PnYn+l:Yn_(l_a)(Yn_Pn—lyn)’ nZ2

(10.2.12)

But these are the same relations satisfied by the large-sample minimum mean squared
error forecasts of the invertible ARIMA(0,1,1) process

Yo=Y 1 +Z—(0—-a)Z_i, {Z}~WN(0,0%). (10.2.13)

Forecasting by exponential smoothing with optimal & can therefore be viewed as fitting
a member of the two-parameter family of ARIMA processes (10.2.13) to the data and
using the corresponding large-sample forecast recursions initialized by PoY; = Y;. In
ITSM, the optimal « is found by minimizing the average squared error of the one-step
forecasts of the observed data Y, ..., Y,, and the parameter o2 is estimated by this
average squared error. This algorithm could easily be modified to minimize other error
measures such as average absolute one-step error and average 12-step squared error.
In the same way it can be shown that Holt—Winters forecasting can be viewed as

fitting a member of the three-parameter family of ARIMA processes,
1-B*Y,=Z - Q—a—af)Zi_1 + (1 —a)Z,_s, (10.2.14)

where {Z,} ~ WN(O, 6%). The coefficients o and B are selected as described after
(10.2.6), and the estimate of o2 is the average squared error of the one-step forecasts

of Ys,...,Y, obtained from the large-sample forecast recursions corresponding to
(10.2.14).
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Table 10.2

Predicted and observed values of the accidental deaths series

for t = 73,...,78 from the (nonseasonal) Holt-Winters algo-
rithm

t 73 74 75 76 77 78
Observed Y; 7798 7406 8363 8460 9217 9316

Predicted by HW 9281 9322 9363 9404 9445 9486

10.3 The Holt-Winters Seasonal Algorithm

Example 10.3.1

10.3.1 The Algorithm

If the series Y1, Y», ..., Y, contains not only trend, but also seasonality with period d
[as in the model (1.5.11)], then a further generalization of the forecast function (10.2.2)
that takes this into account is

PoYyin = Gp+ bph+ Cpeny, h=1,2,..., (10.3.1)

where a,,, I;n, and ¢, can be thought of as estimates of the “trend level” a,, “trend
slope” b, and “seasonal component” ¢, at time n. If k is the smallest integer such that
n+ h — kd < n, then we set

Cnah = Cpnahra» h=1,2,..., (10.3.2)
while the values of ;, lA)i, and ¢;,i = d+2, ..., n, are found from recursions analogous
to (10.2.3) and (10.2.4), namely,

Gy =@ (Yogr — Eupima) + (1 — @) (@ + by), (10.3.3)
buit = B (Gnp1 — @) + (1 — B)ba, (10.3.4)
and

Cnrt =Y Vo1 — Gny) + (1 = ¥)Cot1-as (10.3.5)
with initial conditions

g1 = Yay1, (10.3.6)
bar1 = Ygr1 = Y1)/d, (10.3.7)
and

Gi=Yi— (Yi+byii—1), i=1,....d+1 (10.3.8)

Then (10.3.3)—(10.3.5) can be solved successively for g;, bi,and &, i=d+1,...,n,
and the predictors P, Y, found from (10.3.1).

As in the nonseasonal case of Section 10.2, the forecasts depend on the parameters
o, B, and y. These can either be prescribed arbitrarily (with values between 0 and 1) or
chosen in a more systematic way to minimize the sum of squares of the one-step errors
Yoian(Yi—PiyY, 1)2, obtained when the algorithm is applied to the already observed
data. Seasonal Holt—Winters forecasts can be computed by selecting the ITSM option
Forecasting>Seasonal Holt-Winters.

As in Example 10.2.1, open the file DEATHS.TSM, but this time select Forecast -
ing>Seasonal Holt-Winters. Specify 24 for the number of predicted
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Table 10.3

values required, 12 for the period of the seasonality, and check the box marked
Optimize Coefficients. Click OK, and the graph of the data and predicted
values shown in Figure 10-3 will appear. Right-click on the graph and then on Info
and you will see the numerical values of the predictors and the optimal values of the
coefficients o, 8, and y (minimizing the observed one-step average squared error
ZZM(Yi — P;_1Y)?/59). Table 10.3 compares the predictors of Y73, ..., Y7g with the
corresponding observed values.

g

The root mean squared error (\/ 22:1(Y72+h — P Y7544)%/6 ) for the seasonal
Holt—Winters forecasts is found to be 401. This is not as good as the value 253
achieved by the ARAR model for this example but is substantially better than the
values achieved by the nonseasonal Holt—Winters algorithm (1143) and the ARIMA
models (6.5.8) and (6.5.9) (583 and 501, respectively).

10.3.2 Holt-Winters Seasonal and ARIMA Forecasting

As in Section 10.2.2, the Holt—Winters seasonal recursions with seasonal period d
correspond to the large-sample forecast recursions of an ARIMA process, in this
case defined by

A-BU-BY, =Z+ - +Zi g+ vy —)Zid— Zi—g_1)
—-QC-a—aBf)Zi1+ -+ Zi—g)
+A —-a)Zia+ -+ Zi—ag-1),

where {Z,} ~WN(0, 02). Holt—Winters seasonal forecasting with optimal &, 8, and y
can therefore be viewed as fitting a member of this four-parameter family of ARIMA
models and using the corresponding large-sample forecast recursions.

Predicted and observed values of the accidental deaths series for

t=73,...,78 from the seasonal Holt-Winters algorithm
t 73 74 75 76 77 78
Observed Y; 7798 7406 8363 8460 9217 9316

Predicted by HWS 8039 7077 7750 7941 8824 9329

10.4 Choosing a Forecasting Algorithm

Real data are rarely if ever generated by a simple mathematical model such as an
ARIMA process. Forecasting methods that are predicated on the assumption of such a
model are therefore not necessarily the best, even in the mean squared error sense. Nor
is the measurement of error in terms of mean squared error necessarily always the most
appropriate one in spite of its mathematical convenience. Even within the framework
of minimum mean squared-error forecasting, we may ask (for example) whether we
wish to minimize the one-step, two-step, or twelve-step mean squared error.
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Figure 10-3

The data set DEATHS.TSM
with 24 values predicted by
the seasonal Holt-Winters
algorithm
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The use of more heuristic algorithms such as those discussed in this chapter
is therefore well worth serious consideration in practical forecasting problems. But
how do we decide which method to use? A relatively simple solution to this problem,
given the availability of a substantial historical record, is to choose among competing
algorithms by comparing the relevant errors when the algorithms are applied to the
data already observed (e.g., by comparing the mean absolute percentage errors of the
12-step predictors of the historical data if 12-step prediction is of primary concern).

It is extremely difficult to make general theoretical statements about the relative
merits of the various techniques we have discussed (ARIMA modeling, exponential
smoothing, ARAR, and HW methods). For the series DEATHS.TSM we found on
the basis of average mean squared error for predicting the series at times 73-78
that the ARAR method was best, followed by the seasonal Holt—Winters algorithm,
and then the ARIMA models fitted in Chapter 6. This ordering is by no means
universal. For example, if we consider the natural logarithms {Y;} of the first 130
observations in the series WINE.TSM (Figure 1-1) and compare the average mean
squared errors of the forecasts of Y131, . . ., Y142, we find (Problem 10.2 that an MA(12)
model fitted to the mean corrected differenced series {Y; — Y;_1»} does better than
seasonal Holt—Winters (with period 12), which in turn does better than ARAR and
(not surprisingly) dramatically better than nonseasonal Holt—-Winters. An interesting
empirical comparison of these and other methods applied to a variety of economic time
series is contained in Makridakis et al. (1984).

The versions of the Holt—Winters algorithms we have discussed in Sections 10.2
and 10.3 are referred to as “additive,” since the seasonal and trend components enter the
forecasting function in an additive manner. “Multiplicative” versions of the algorithms
can also be constructed to deal directly with processes of the form

Y, = mysiZ;, (10.4.1)

where m;,, s;, and Z, are trend, seasonal, and noise factors, respectively (see, e.g.,
Makridakis et al. 1997). An alternative approach (provided that ¥; > O for all ¢) is
to apply the linear Holt—Winters algorithms to {In Y;} (as in the case of WINE.TSM in
the preceding paragraph). Because of the rather general memory shortening permitted
by the ARAR algorithm, it gives reasonable results when applied directly to series
of the form (10.4.1), even without preliminary transformations. In particular, if we
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consider the first 132 observations in the series AIRPASS.TSM and apply the ARAR
algorithm to predict the last 12 values in the series, we obtain (Problem 10.4) an
observed root mean squared error of 18.22. On the other hand if we use the same
data take logarithms, difference at lag 12, subtract the mean and then fit an AR(13)
model by maximum likelihood using ITSM and use it to predict the last 12 values, we
obtain an observed root mean squared error of 21.17. The data and predicted values
from the ARAR algorithm are shown in Figure 10-4.
Problems

10.1 Establish the formula (10.1.8) for the mean squared error of the A-step forecast
based on the ARAR algorithm.

10.2 Let {X;, ..., X142} denote the data in the file WINE.TSM and let {Y1, ..., Y4}
denote their natural logarithms. Denote by m the sample mean of the differenced
series {Y; — Y,_1p,t =13, ..., 130}.

(a) Use the program ITSM to find the maximum likelihood MA(12) model for
the differenced and mean-corrected series {Y; — Y;_1» —m, t = 13, ..., 130}.

(b) Use the model in (a) to compute forecasts of {Xj3, ..., X142}

(c) Tabulate the forecast errors {X; — P30 X;, t = 131, ..., 142}

(d) Compute the average squared error for the 12 forecasts.

(e) Repeat steps (b), (c), and (d) for the corresponding forecasts obtained by
applying the ARAR algorithm to the series {X;, =1, ..., 130}.

(f) Repeat steps (b), (c), and (d) for the corresponding forecasts obtained by
applying the seasonal Holt—Winters algorithm (with period 12) to the
logged data {Y;,t = 1,...,130}. (Open the file WINE.TSM, select
Transforms>Box-Coxwith parameter A = 0, then select Forecasting>
Seasonal Holt-Winters,and check Apply to original data
in the dialog box.)
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(g) Repeat steps (b), (c), and (d) for the corresponding forecasts obtained by
applying the nonseasonal Holt—Winters algorithm to the logged data {Y;, t =
1, ..., 130}. (The procedure is analogous to that described in part (f).)

(h) Compare the average squared errors obtained by the four methods.

10.3 In equations (10.2.10) and (10.2.11), show that aZQu/(Qu + Gv%) and
B=$221/%211.

10.4 Verify the assertions made in the last paragraph of Section 10.4, comparing the
forecasts of the last 12 values of the series AIRPASS.TSM obtained from the
ARAR algorithm (with no log transformation) and the corresponding forecasts
obtained by taking logarithms of the original series, then differencing at lag 12,
mean-correcting, and fitting an AR(13) model to the transformed series.
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11.1 Transfer Function Models

11.2 Intervention Analysis

11.3 Nonlinear Models

11.4 Long-Memory Models

11.5 Continuous-Time ARMA Processes

In this chapter we touch on a variety of topics of special interest. In Section 11.1
we consider transfer function models, designed to exploit for predictive purposes the
relationship between two time series when one acts as a leading indicator for the other.
Section 11.2 deals with intervention analysis, which allows for possible changes in
the mechanism generating a time series, causing it to have different properties over
different time intervals. In Section 11.3 we introduce the very fast growing area of
nonlinear time series analysis, and in Section 11.4 we discuss fractionally integrated
ARMA processes, sometimes called “long-memory” processes on account of the slow
rate of convergence of their autocorrelation functions to zero as the lag increases. In
Section 11.5 we discuss continuous-time ARMA processes which, for continuously
evolving processes, play a role analogous to that of ARMA processes in discrete time.
Besides being of interest in their own right, they have proved a useful class of models
in the representation of financial time series and in the modeling of irregularly spaced
data.

11.1 Transfer Function Models

In this section we consider the problem of estimating the transfer function of a linear
filter when the output includes added uncorrelated noise. Suppose that {X;;} and {X,,}
are, respectively, the input and output of the transfer function model

00
Xo =) 1Xj1+N, (11.1.1)

=0
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where T = {7;,j = 0,1,...} is a causal time-invariant linear filter and {N,} is a
zero-mean stationary process, uncorrelated with the input process {X;;}. We further
assume that {X;;} is a zero-mean stationary time series. Then the bivariate process
{(X:1, X1n)'} is also stationary. Multiplying each side of (11.1.1) by X, ; and then
taking expectations gives the equation

yark) =Y mynk — j). (11.1.2)
=0

Equation (11.1.2) simplifies a great deal if the input process happens to be white
noise. For example, if {X;;} ~ WN(O, 012), then we can immediately identify #, from
(11.1.2) as

o = ya (k) /of. (11.1.3)

This observation suggests that “prewhitening” of the input process might simplify the
identification of an appropriate transfer function model and at the same time provide
simple preliminary estimates of the coefficients #.

If {X;1} can be represented as an invertible ARMA (p, g) process

d(B)X; = 0(B)Z, {Z} ~ WN (0,07), (11.1.4)

then application of the filter 7 (B) = ¢(B)8~'(B) to {X,;} will produce the whitened
series {Z;}. Now applying the operator 7 (B) to each side of (11.1.1) and letting ¥; =
7 (B)X,,, we obtain the relation

o
Y, = 1Z;+N,
j=0

where
N,’ = n(B)N,,

and {N;} is a zero-mean stationary process, uncorrelated with {Z,}. The same arguments
that led to (11.1.3) therefore yield the equation

7, = pyz(j)oy/oz, (I1.1.5)

where py; is the cross-correlation function of {Y;} and {Z}, azz =Var(Z;), and
03 =Var(Y;).

Given the observations {(X;;, Xp)',t = 1,...,n}, the results of the previous
paragraph suggest the following procedure for estimating {z;} and analyzing the noise
{N;} in the model (11.1.1):

1. Fitan ARMA model to {X;;} and file the residuals (21, el Z,) (using the Export
button in ITSM to copy them to the clipboard and then pasting them into the first
column of an Excel file). Let (2) and 6 denote the maximum likelihood estimates
of the autoregressive and moving-average parameters and let 622 be the maximum
likelihood estimate of the variance of {Z,}.

2. Apply the operator 7 (B) = qAb(B)é ~1(B) to {X,»} to obtain the series (f/ Ly eens f/n)
(After fitting the ARMA model as in Step 1 above, highlight the window contain-
ing the graph of {X,} and replace {X,} by {Y;} using the option File>Import.The
residuals are then automatically replaced by the residuals of {¥;} under the model
already fitted to {X;}.) Export the new residuals to the clipboard, paste them into
the second column of the Excel file created in Step 1, and save this as a text file,
FNAME.TSM. The file FNAME.TSM then contains the bivariate series {(Z;, Y;)}.
Let 63 denote the sample variance of Y,
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3. Compute the sample auto- and cross-correlation functions of {Z;} and {Y,} by
opening the bivariate project FNAME.TSM in ITSM and clicking on the second
yellow button at the top of the ITSM window. Comparison of p,,(h) with the
bounds =4 1.96n~!/? gives a preliminary indication of the lags & at which p,, (h)
is significantly different from zero. A more refined check can be carried out by
using Bartlett’s formula in Section 8.3.4 for the asymptotic variance of p,, (h).
Under the assumptions that {Z} ~ WN (0, &2) and {(IA/I,Z)/} is a stationary
Gaussian process,

nVar(pyz(h)) ~ 1 = py,(h) [1.5 — > (pik) + piy(k)/2)}

k=—00

o
+ Z [,OYZ(h + k)pyz(h — k) — 2pyz(h) pyz(k + h)mz/y(k)] .
k=—0c0
In order to check the hypothesis Hy that pyz(h) = 0,h ¢ [a, b], where a and b
are integers, we note from Corollary 8.3.1 that under Hy,

Var (pyz(h)) ~n~'  forh ¢ [a, b].

We can therefore check the hypothesis Hy by comparing pyz, h ¢ [a, b], with the
bounds + 1.96n~'/2. Observe that pzy(h) should be zero for & > 0 if the model
(11.1.1) is valid.

4. Preliminary estimates of 7, for the lags A at which p,, (h) is significantly different
from zero are

Ty = pyrz(h)6y/o7.

For other values of & the preliminary estimates are 7, = 0. The numerical values
of the cross-correlations pyz(h) are found by right-clicking on the graphs of the
sample correlations plotted in Step 3 and then on Info. The values of 6 and 6y
are found by doing the same with the graphs of the series themselves. Let m > 0
be the largest value of j such that 7; is nonzero and let b > 0 be the smallest such
value. Then b is known as the delay parameter of the filter {7;}. If m is very large
and if the coefficients {fj} are approximately related by difference equations of the
form

A

T =1 — - — VT, =0, j=b+p,

then T(B) = Z;.”:b 7;B/ can be represented approximately, using fewer parame-
ters, as

T(B) =wo(1 —viB—---—v,B,)"'B".
In particular, if ; =0, j < b, and 7; = wov’i_b, j > b, then
T(B) = wo(1 —v;B)"'B. (11.1.6)

Box and Jenkins (1976) recommend choosing f(B) to be a ratio of two poly-
nomials. However, the degrees of the polynomials are often difficult to estimate
from {fj} The primary objective at this stage is to find a parametric function
that provides an adequate approximation to T(B) without introducing too large
a number of parameters. If f(B) is represented as f(B) = BwBWV '(B) =
B’ (wo+wiB+ -+ w,B7) (1 —viB—-- — va"’)71 with v(z) # 0 for |z] < 1,
then we define m = max(q + b, p).



326

Chapter 11

Further Topics

Example 11.1.1

5. The noise sequence {N,,t =m+ 1, ..., n} is estimated as
N, = Xp — T(B)X,1.

(We set Nt = 0, ¢t < m, in order to compute N,, t > m=max(b+ q,p)). The cal-
culations are done in ITSM by opening the bivariate file containing {(X;1, X;2)},
selecting Transfer>Specify Model, and entering the preliminary model
found in Step 4. Click on the fourth green button to see a graph of the residuals
{N,}. These should then be filed as, say, NOISE.TSM.

6. Preliminary identification of a suitable model for the noise sequence is carried
out by fitting a causal invertible ARMA model

»™(B)N, = 6™V (B)W,, {W,} ~ WN (0, 0y), (11.1.7)

to the estimated noise ]Vm+ Iy oens ]Vn filed as NOISE.TSM in Step 5.
7. At this stage we have the preliminary model

o™ BWV(B)X;, = B d™ (BYW(B)X1 + 0N (B)v(B)W,,

Vyhere f(B) = BPw(B)v"!(B) as in step (4). For this model we can compute
W, (w,v, ™, 0™), t > m* = max(p, + p, b + p» + q), by setting W, = 0
for t < m*. The parameters w, v, (b(N ). and @™) can then be reestimated (more
efficiently) by minimizing the sum of squares

S W2 (w.v, 6, 6V,

t=m*+1

(The calculations are performed in ITSM by opening the bivariate project {(X;,
Xn)}, selecting Transfer>Specify model, entering the preliminary model,
and clicking OK. Then choose Transfer>Estimation,click OK, and the least
squares estimates of the parameters will be computed. Pressing the fourth green
button at the top of the screen will give a graph of the estimated residuals W,.)

8. To test for goodness of fit, the estimated residuals {Wt, t > m*} and {Z.t > m*}
should be filed as a bivariate series and the auto- and cross correlations compared
with the bounds £1.96/,/n in order to check the hypothesis that the two series
are uncorrelated white noise sequences. Alternative models can be compared
using the AICC value that is printed with the estimated parameters in Step 7.
It is computed from the exact Gaussian likelihood, which is computed using a
state-space representation of the model, described in Brockwell and Davis (1991),
Section 13.1.

Sales with a Leading Indicator

In this example we fit a transfer function model to the bivariate time series of
Example 8.1.2. Let

Xqn=0-B)Y,—0.0228, r=2,...,150,
Xn =1 —B)Yn —0.420, t=2,...,150,

where {Y;1} and {Yp}, t = 1,...,150, are the leading indicator and sales data,
respectively. It was found in Example 8.1.2 that {X;;} and {X,;} can be modeled as
low-order zero-mean ARMA processes. In particular, we fitted the model

Xn =1 —0.474B)7,, {Z:} ~ WN(O0, 0.0779),

to the series {X;;}. We can therefore whiten the series by application of the filter
7(B) = (1 —0.474B)~'. Applying 7 (B) to both {X;;} and {X,»} we obtain
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Z,=(1—-0474B)"'X,, 62 =0.0779,
Y,=(1—-0474B)"'X,, &2

These calculations and the filing of the series {Z} and {f/t} were carried out using
ITSM as described in steps (1) and (2). Their sample auto- and cross-correlations,
found as described in step (3), are shown in Figure 11-1. The cross-correlations
Ozy(h) (top right) and pyz(h) (bottom left), when compared with the upper and lower
bounds 41.96(149)~!/2 = +£0.161, strongly suggest a transfer function model for
{X12} in terms of {X;;} with delay parameter 3. Since T; = pyz(j)6y/67 is decreasing
approximately geometrically for j > 3, we take 7'(B) to have the form (11.1.6), i.e.,

T(B) = wo(l —v;B)"'B>.

The preliminary estimates of wy and v are wy = 73 = 4.86 and v, = 74/7; = 0.698, the
coefficients 7; being estimated as described in step (4). The estimated noise sequence
is determined and filed using ITSM as described in step (5). It satisfies the equations

N, =X, —4.86B°(1 —0.698B)'X,;,  t=5,6,...,150.
Analysis of this univariate series with ITSM gives the MA(1) model
N, = (1 -0.364B)W,, {W,} ~ WN(O0, 0.0590).

Substituting these preliminary noise and transfer function models into equa-
tion (11.1.1) then gives

X, = 4.86B°(1—0.698B) ' X, + (1 —0.364B)W,, {W,} ~ WN(0, 0.0590).

Now minimizing the sum of squares (11.1.7) with respect to the parameters (wo, Vi,
QI(N)) as described in step (7), we obtain the least squares model

X, =4.717B3(1 — 0.724B) ' X,; + (1 — 0.582B)W,, (11.1.8)
where {W;} ~ WN(0, 0.0486) and
Xy = (1 —0474B)Z,, {Z} ~ WN(0, 0.0779).

Notice the reduced white noise variance of {W,} in the least squares model as compared
with the preliminary model.

The sample auto- and cross-correlation functions of the series Z and Wt,
t = 5,...,150, are shown in Figure 11-2. All of the correlations lie between the
bounds
+1.96/+/144, supporting the assumption underlying the fitted model that the residuals
are uncorrelated white noise sequences.

O

11.1.1 Prediction Based on a Transfer Function Model

When predicting X, » on the basis of the transfer function model defined by (11.1.1),
(11.1.4), and (11.1.7), with observations of X;; and X», t = 1, ..., n, our aim is to
find the linear combination of 1, Xy, ..., X,1, X12, ..., X;;» that predicts X,,;,» with
minimum mean squared error. The exact solution of this problem can be found with
the help of the Kalman recursions (see Brockwell and Davis (1991), Section 13.1 for
details). The program ITSM uses these recursions to compute the predictors and their
mean squared errors.

In order to provide a little more insight, we give here the predictors P,X,.
and mean squared errors based on infinitely many past observations X;; and X,
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Figure 11-1

The sample correlation

functions pij(h), of Example
11.1.1. Series 1 is {Z;) agd

Series 2 is {Yt}

—00 < t < n. These predictors and their mean squared errors will be close to those
based on X;; and X,», 1 <t < n, if n is sufficiently large.

The transfer function model defined by (11.1.1), (11.1.4), and (11.1.7) can be
rewritten as

Xn = T(B)th + ,B(B)Wt, (1119)
Xy =0(B)¢~ (B)Z, (11.1.10)
where B(B) = 6™ (B)/¢™ (B). Eliminating X,; gives

o (0.¢]
Xo=) aZj+ > BWe (11.1.11)
j=0 j=0

where o (B) = T(B)0(B)/¢(B).

Noting that each limit of linear combinations of {X;;, X, —00 < t < n}isa
limit of linear combinations of {Z,, W;, —oo < t < n} and conversely and that {Z;} and
{W,} are uncorrelated, we see at once from (11.1.11) that

(o) o0
Py Xptno = Z i Zpin—j + Z BiWuin—j- (11.1.12)
Jj=h j=h
Setting t = n+ hin (11.1.11) and subtracting (11.1.12) gives the mean squared error
5 h—1 h—1
E (X,Hh,2 - P,,XH,,,Q) =2y o top > B (11.1.13)
j=0 j=0
To compute the predictors i’anJrh,z we proceed as follows. Rewrite (11.1.9) as
AB)Xp = BPUB)X, + V(B)W,, (11.1.14)
Series 1 Series 1 x Series 2
1.00 1.00
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Figure 11-2

The sample correlation
functions of the estimated
residuals from the

model fitted in

Example 11.1.1. Series 1 is
{Z:} and Series 2 is {W;}

Example 11.1.2
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where A, U, and V are polynomials of the form
AB) =1—-AB—---—A,B",
UB) =Uy+UB+---+ U,B",
VB)=1+VB+---+V,B".

Applying the operator P, to equation (11.1.14) with # = n + h, we obtain

PiXoinz = ) APXusneio+ ) UPaXutn-pja + ) ViWasije  (11.1.15)
j=1 j=0 j=h

where the last sum is zero if & > v.

Since {X;1} is uncorrelated with {W,}, the predictors appearing in the second sum in
(11.1.15) are therefore obtained by predicting the univariate series {X,;} as described in
Section 3.3 using the model (11.1.10). In keeping with our assumption that # is large,
we can replace f’anl for each j by the finite-past predictor obtained from the program
ITSM. The values W, j < n, are replaced by their estimated values WJ from the least
squares estimation in step (7) of the modeling procedure.

_ Equation (11.1.15) can now be solved recursively for the predictors f’nX,,H,z,
P X022, PuXpy3 2, ...

Sales with a Leading Indicator

Applying the preceding results to the series {X1, Xr, 2 <t < 150} of Example 11.1.1,
and using the values X14g’1 = —0093, X150’2 = 008, W150 = —00706, W149 =
0.1449, we find from (11.1.8) and (11.1.15) that

P150X151,2 = 0.724X150,2 + 4.717X148,1 — 1.306W150 + 0-421W149 = —0.228
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and, using the value X ;49 | = 0.237, that

P150X150.2 = 0.724P 150X 512 + 4.717X 1401 + 0.421W,50 = 0.923.
In terms of the original sales data {Y,;} we have Y49, = 262.7 and

Yo=Y 12+ Xp +0.420.
Hence the predictors of actual sales are

PisoY1s51, 2 = 262.70 — 0.228 + 0.420 = 262.89,

PisoY1s2, 2 = 262.89 4 0.923 + 0.420 = 264.23,

where P7,, is based on {1, Yy, Y12, X1, X», —00 < s < 150}, and it is assumed that
Y11 and Yy, are uncorrelated with {X,;} and with {X;»}. The predicted values are in
close agreement with those based on the finite number of available observations that
are computed by ITSM. Since our model for the sales data is

(1-B)Y;, = 0.420+4.717B°(1—0.474B)(1—-0.724B) "' Z,4-(1-0.582B)W,,

it can be shown, using an argument analogous to that which gave (11.1.13), that the
mean squared errors are given by

h-1 h-1
2 2 2, 2 %2
E(Y1504n,2 — P150Y15044,2)" = 0 E o + oy E B,
=0 =0
where

o0
D afd = 47172 (1 - 04742)(1 — 0.724) 7' (1 — )7
j=0

and

o0
> Brd =(1—-0582)(1 —2)7"
j=0

For h = 1 and 2 we obtain

E(Yis1, 2 — PisoYis1,2)* = 0.0486,
E(Yis2, 2 — PisoY152, 2)* = 0.0570,

in close agreement with the finite-past mean squared errors obtained by ITSM.

It is interesting to examine the improvement obtained by using the transfer
function model rather than fitting a univariate model to the sales data alone. If we adopt
the latter course, we obtain the model

th — 0.249Xt,1’ 2 — 0.199Xt72,2 = Uta

where {U;} ~ WN(O0, 1.794) and X;, = Y» — Y;—1» — 0.420. The corresponding
predictors of Yis; » and Ys;, 5 are easily found from the program I'TSM to be 263.14
and 263.58 with mean squared errors 1.794 and 4.593, respectively. These mean

squared errors are much worse than those obtained using the transfer function model.
0
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11.2 Intervention Analysis

During the period for which a time series is observed, it is sometimes the case that a
change occurs that affects the level of the series. A change in the tax laws may, for
example, have a continuing effect on the daily closing prices of shares on the stock
market. In the same way construction of a dam on a river may have a dramatic effect
on the time series of streamflows below the dam. In the following we shall assume that
the time 7" at which the change (or “intervention”) occurs is known.

To account for such changes, Box and Tiao (1975) introduced a model for
intervention analysis that has the same form as the transfer function model

[e¢)
Y, = 1Xij+N, (11.2.1)
j=0

except that the input series {X;} is not a random series but a deterministic function of ¢.
It is clear from (11.2.1) that Z;io 7;,X,_; is then the mean of Y,. The function {X,} and
the coefficients {7;} are therefore chosen in such a way that the changing level of the
observations of {Y,} is well represented by the sequence Z;:o 7;X;_;. For a series {Y;}
with EY; = 0 fort < T and EY, — 0 as t — 00, a suitable input series is

1 ifr=T,
X =L =1 | (11.2.2)
0 ifr#T.
For a series {Y;} with EY, = O for t < T and EY, — a # 0 as t — 00, a suitable input
series is
o0 .
1 ift>T,
X, =H(T)=Y Lky={ "~ (11.2.3)
=T 0 iftr<T.

(Other deterministic input functions {X;} can also be used, for example when inter-
ventions occur at more than one time.) The function {X,} having been selected by
inspection of the data, the determination of the coefficients {7;} in (11.2.1) then reduces
to a regression problem in which the errors {N,} constitute an ARMA process. This
problem can be solved using the program ITSM as described below.

The goal of intervention analysis is to estimate the effect of the intervention
as indicated by the term Z;:o 7;X;—j and to use the resulting model (11.2.1) for
forecasting. For example, Wichern and Jones (1978) used intervention analysis to
investigate the effect of the American Dental Association’s endorsement of Crest
toothpaste on Crest’s market share. Other applications of intervention analysis can be
found in Box and Tiao (1975), Atkins (1979), and Bhattacharyya and Layton (1979). A
more general approach can also be found in West and Harrison (1989), Harvey (1990),
and Pole et al. (1994).

As in the case of transfer function modeling, once {X,} has been chosen (usually as
either (11.2.2) or (11.2.3)), estimation of the linear filter {z;} in (11.2.1) is simplified
by approximating the operator 7(B) = Z,?io 7;B with a rational operator of the
form

B°W(B)
V(B) ’
where b is the delay parameter and W(B) and V(B) are polynomials of the form

T(B) = (11.2.4)

W(B) =wy+wB+---+w,B?
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Figure 11-3

The differenced series

of Example 11.2.1
(showing also the

fitted intervention term
accounting for the seat-belt
legislation of 1983)

and
VB)=1—-viB—---—v,B".

By suitable choice of the parameters b, g, p and the coefficients w; and v;, the
intervention term 7' (B)X, can made to take a great variety of functional forms.

For example, if T(B) = wB?/(1 — vB) and X, = I,(T) as in (11.2.2), the
resulting intervention term is

wB? Sl Sl .
mlt(T) = Z vwl_; »(T) = Z Vwl(T 4+ 2 +j),
j=0 j=0
a series of pulses of sizes Vw attimes T +2+,j=0,1,2,....If |v| < 1, the effect

of the intervention is to add a series of pulses with size w at time T + 2, decreasing to
zero at a geometric rate depending on v as ¢+ — oo. Similarly, with X, = H,(T) as in
(11.2.3),

2

(0.¢] o
(lviivB)Ht(T) = D VwH,a(T) = Y (vt W + 24 ),
j=0 j=0
a series of pulses of sizes (1 +v 4 --- +V)wattimes T +2+j, j =0,1,2,....
If |v] < 1, the effect of the intervention is to bring about a shift in level of the series
X;, the size of the shift converging to w/(1 —v) as t — oo.

An appropriate form for X, and possible values of b, ¢, and p having been chosen
by inspection of the data, the estimation of the parameters in (11.2.4) and the fitting
of the model for {/V,} can be carried out using steps (6)—(8) of the transfer function
modeling procedure described in Section 11.1. Start with step (7) and assume that
{N,} is white noise to get preliminary estimates of the coefficients w; and v; by least
squares. The residuals are filed and used as estimates of {/V;}. Then go to step (6) and
continue exactly as for transfer function modeling with input series {X;} and output
series {Y;}.
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Example 11.2.1

Seat-Belt Legislation

In this example we reanalyze the seat-belt legislation data, SBL.TSM of Example 6.6.3
from the point of view of intervention analysis. For this purpose the bivariate series
{(f;, Y1)} consisting of the series filed as SBLIN.TSM and SBL.TSM respectively
has been saved in the file SBL2.TSM. The input series {f;} is the deterministic step-
function defined in Example 6.6.3 and Y, is the number of deaths and serious injuries
on UK roads inmonth ¢, =1, ..., 120, corresponding to the 10 years beginning with
January 1975.

To account for the seat-belt legislation, we use the same model (6.6.15) as in
Example 6.6.3 and, because of the apparent non-stationarity of the residuals, we
again difference both {f;} and {Y,} at lag 12 to obtain the model (6.6.15), i.e.,

X; = bg; + N, (11.2.4)

where X; = V1,Y;, g = Viof;, and {NV,} is a zero-mean stationary time series. This is
a particularly simple example of the general intervention model (11.2.1) for the series
{X;} with intervention {bg,}. Our aim is to find a suitable model for {/,} and at the
same time to estimate b, taking into account the autocorrelation function of the model
for {NV,}. To apply intervention analysis to this problem using ITSM, we proceed as
follows:

(1) Open the bivariate project SBL2.TSM and difference the series at lag 12.

(2) Select Transfer>Specify model and you will see that the default input
and noise are white noise, while the default transfer model relating the input g,
to the output X, is X, = bg; with b = 1. Click OK, leaving these settings as
they are. The input model is irrelevant for intervention analysis and estimation of
the transfer function with the default noise model will give us the ordinary least
squares estimate of b in the model (10.2.4), with the residuals providing estimates
of N;. Now select Transfer>Estimationand click OK. You will then see the
estimated value —346.9 for b. Finally, press the red Export button (top right in the
ITSM window) to export the residuals (estimated values of N,) to a file and call
it, say, NOISE.TSM.

(3) Without closing the bivariate project, open the univariate project NOISE.TSM.
The sample ACF and PACF of the series suggests either an MA(13) or AR(13)
model. Fitting AR and MA models of order up to 13 (with no mean-correction)
using the option Model>Estimation>Autofit gives an MA(12) model as
the minimum AICC fit.

(4) Return to the bivariate project by highlighting the window labeled SBL2.TSM
and select Transfer>Specify model. The transfer model will now show
the estimated value —346.9 for b. Click on the Residual Model tab, enter 12
for the MA order and click OK. Select Transfer>Estimationand again click
OK. The parameters in both the noise and transfer models will then be estimated
and printed on the screen. Repeating the minimization with decreasing step-sizes,
0.1, 0.01 and then 0.001, gives the model,

Xl‘ = _36258t + Nl"

where N, = W,40.207W,_1+0.311W,_,+0.105W,_340.040W,_44-0.194W,_s+
0.100W,_¢ + 0.299W,_74-0.080W,_g 4+ 0.125W,_9 + 0.210W,_;¢1+0.109W,_;+
0.501W,_1,, and {W,} ~ WN(0,17289). File the residuals (which are now esti-
mates of {W,}) as RES.TSM. The differenced series {X;} and the fitted intervention
term, —362.5g,, are shown in Figure 11-3.
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The sample ACF of the
residuals from the model in
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(5) Open the univariate project RES.TSM and apply the usual tests for ran-
domness by selecting Statistics>Residual Analysis. The tests are
all passed at level 0.05, leading us to conclude that the model found in step (4) is
satisfactory. The sample ACF of the residuals is shown in Figure 11-4.

11.3 Nonlinear Models

A time series of the form

X, =Y ¥iZij. {Z}~1D(0,07), (11.3.1)

j=0

where Z; is expressible as a mean square limit of linear combinations of {X;, oo < s <
t}, has the property that the best mean square predictor E(X;,,|X;, —00 < s < t) and
the best linear predictor IBIX,H, in terms of {X;, —00 < s < t} are identical. It can be
shown that if iid is replaced by WN in (11.3.1), then the two predictors are identical if
and only if {Z;} is a martingale difference sequence relative to {X;}, i.e., if and only
if E(Z;|X;, —00 < s <t) =0forall ¢.

The Wold decomposition (Section 2.6) ensures that every purely nondeterministic
stationary process can be expressed in the form (11.3.1) with {Z,} ~ WN (0, 02). The
process {Z;} in the Wold decomposition, however, is generally not an iid sequence,
and the best mean square predictor of X, , , may be quite different from the best linear
predictor.

In the case where {X;} is a purely nondeterministic Gaussian stationary process,
the sequence {Z;} in the Wold decomposition is Gaussian and therefore iid. Every
stationary purely nondeterministic Gaussian process can therefore be generated by
applying a causal linear filter to an iid Gaussian sequence. We shall therefore refer to
such a process as a Gaussian linear process.
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In this section we shall use the term linear process to mean a process {X;} of the
form (11.3.1). This is a more restrictive use of the term than in Definition 2.2.1.

11.3.1 Deviations from Linearity

Many of the time series encountered in practice exhibit characteristics not shown by
linear processes, and so to obtain good models and predictors it is necessary to look to
models more general than those satisfying (11.3.1) with iid noise. As indicated above,
this will mean that the minimum mean squared error predictors are not, in general,
linear functions of the past observations.

Gaussian linear processes have a number of properties that are often found to
be violated by observed time series. The former are reversible in the sense that
(th, e ,X,n)/ has the same distribution as (th, e ,X,l)/. (Except in a few special
cases, ARMA processes are reversible if and only if they are Gaussian (Breidt and
Davis 1992).) Deviations from this property by observed time series are suggested by
sample paths that rise to their maxima and fall away at different rates (see, for exam-
ple, the sunspot numbers filed as SUNSPOTS.TSM). Bursts of outlying values are
frequently observed in practical time series and are seen also in the sample paths of
nonlinear (and infinite-variance) models. They are rarely seen, however, in the sample
paths of Gaussian linear processes. Other characteristics suggesting deviation from
a Gaussian linear model are discussed by Tong (1990).

Many observed time series, particularly financial time series, exhibit periods
during which they are “less predictable” (or “more volatile”), depending on the past
history of the series. This dependence of the predictability (i.e., the size of the predic-
tion mean squared error) on the past of the series cannot be modeled with a linear time
series, since for a linear process the minimum /-step mean squared error is independent
of the past history. Linear models thus fail to take account of the possibility that
certain past histories may permit more accurate forecasting than others, and cannot
identify the circumstances under which more accurate forecasts can be expected.
Nonlinear models, on the other hand, do allow for this. The ARCH and GARCH
models considered in Section 7.2 are in fact constructed around the dependence of
the conditional variance of the process on its past history.

11.3.2 Chaotic Deterministic Sequences

To distinguish between linear and nonlinear processes, we need to be able to decide in
particular when a white noise sequence is also iid. Sequences generated by nonlinear
deterministic difference equations can exhibit sample correlation functions that are
very close to those of samples from a white noise sequence. However, the deterministic
nature of the recursions implies the strongest possible dependence between successive
observations. For example, the celebrated logistic equation (see May, 1976, and Tong
1990) defines a sequence {x,}, for any given x, via the equations

Xp =4x,1(1 —x,_1), O0<xy<1.

The values of x, are, for even moderately large values of n, extremely sensitive
to small changes in xy. This is clear from the fact that the sequence can be expressed
explicitly as

x, = sin’ (Z"arcsin (J)To)) , n=0,1,2,....

A very small change § in arcsin ( /xo) leads to a change 2"$ in the argument of the sine
function defining x,,. If we generate a sequence numerically, the generated sequence
will, for most values of xy in the interval (0,1), be random in appearance, with a
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Figure 11-5

A sequence generated by
the recursions

Xn = 4xp—1(1 = Xp—1)

Figure 11-6

The sample autocorrelation
function of the sequence in
Figure 11-5
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sample autocorrelation function similar to that of a sample from white noise. The
data file CHAOS.TSM contains the sequence xi, ..., Xsg0 (correct to nine decimal
places) generated by the logistic equation with xo = 7/10. The calculation requires
specification of x( to at least 70 decimal places and the use of correspondingly high
precision arithmetic. The series and its sample autocorrelation function are shown in
Figures 11-5 and 11-6. The sample ACF and the AICC criterion both suggest white
noise with mean 0.4954 as a model for the series. Under this model the best linear
predictor of X5y, would be 0.4954. However, the best predictor of X;; to nine decimal
places is, in fact, 4x;00(1 — x290) = 0.016286669, with zero mean squared error.
Distinguishing between iid and non-iid white noise is clearly not possible on the
basis of second-order properties. For insight into the dependence structure we can
examine sample moments of order higher than two. For example, the dependence in the
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data in CHAOS.TSM is reflected by a significantly nonzero sample autocorrelation at
lag 1 of the squared data. In the following paragraphs we consider several approaches
to this problem.

11.3.3 Distinguishing Between White Noise and iid Sequences

If {X;} ~ WN (0, 02) and E|X,|* < oo, a useful tool for deciding whether or not
{X,} is iid is the ACF py(h) of the process {X?}. If {X,} is iid, then px2(h) = O for
all & # 0, whereas this is not necessarily the case otherwise. This is the basis for the
test of McLeod and Li described in Section 1.6.

Now suppose that {X,} is a strictly stationary time series such that E|X,|¥ < K < oo

for some integer k > 3. The kth-order cumulant Cy(ry, ..., r—1) of {X;} is then
defined as the joint cumulant of the random variables, X, X, , ..., Xy, ,, 1.€., as
the coefficient of i*z,z, - - - zx in the Taylor expansion about (0, . .., 0) of

X (@i, z) == InElexp(izi X, + izoXoqr, + - + ik Xegr,_ )] (11.3.2)

(Since {X,} is strictly stationary, this quantity does not depend on ¢.) In particular, the
third-order cumulant function C; of {X,} coincides with the third-order central moment
function, i.e.,
C3(r7 S) = E[(Xt - M)(XH-F - I’L)(Xl-f‘s - I’L)]’ ra N E {Oa :tly .. '}a
where u = EX,. If ), ) |C3(r,s)| < oo, we define the third-order polyspectral
density (or bispectral density) of {X;} to be the Fourier transform
1

(2m)?

o0 (o8]
S, @) = YD Gy <o <

r=—00 §=—00

in which case
T T . .
Cs(r, 5) =/ / TN (w1, wr)dw; dw,.
—TT —TT

[More generally, if the kth order cumulants Ci(ry, - - - , r¢—1), of {X;} are absolutely
summable, we define the kth order polyspectral density as the Fourier transform of
Cy. For details see Rosenblatt (1985) and Priestley (1988).]

If {X;} is a Gaussian linear process, it follows from Problem 10.3 that the cumulant
function C3 of {X,} is identically zero. (The same is also true of all the cumulant
functions C; with k& > 3.) Consequently, f3(w;, w;) = 0 for all wy, w, € [—m, 7].
Appropriateness of a Gaussian linear model for a given data set can therefore be
checked by using the data to test the null hypothesis f; = 0. For details of such a
test, see Subba-Rao and Gabr (1984).

If {X,} is a linear process of the form (11.3.1) with E|Z|* < oo, EZf = n, and
Z;io || < o0, it can be shown from (11.3.2) (see Problem 11.3) that the third-order
cumulant function of {X,} is given by

(0.¢]
Cs(r,8) =0 Y Yithis Vi (11.3.3)
I=—00
(with ¢; = 0 for j < 0), and hence that {X;} has bispectral density
n i(w1+w —iw —iw
fr(@1, @) = —y (D) g () ¢ (772, (11.3.4)

4
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where ¥ (z) := 2./20 ¥;7. By Proposition 4.3.1, the spectral density of {X,} is

2

02 —iw
f@) == v ()"
Hence,

(w1, @) _ n?
floDf(@)f(w) +wy)  2mo®’

Appropriateness of the linear process (11.3.1) for modeling a given data set can
therefore be checked by using the data to test for constancy of ¢ (w;, ;) (Subba-Rao
and Gabr 1984).

o (w1, ) =

11.3.4 Three Useful Classes of Nonlinear Models

If it is decided that a linear Gaussian model is not appropriate, there is a choice of sev-
eral families of nonlinear processes that have been found useful for modeling purposes.
These include bilinear models, autoregressive models with random coefficients, and
threshold models. Excellent accounts of these are available in Subba-Rao and Gabr
(1984), Nicholls and Quinn (1982), and Tong (1990), respectively.

The bilinear model of order (p, g, r, s) is defined by the equations

14 q r s
X, =Z+Y aXe i+ Y bZj+> > X iZ (11.3.5)
i=1 j=1

i=1 j=1

where {Z,} ~ iid (0, 02). A sufficient condition for the existence of a strictly stationary
solution of these equations is given by Liu and Brockwell (1988).
A random coefficient autoregressive process {X;} of order p satisfies an equation
of the form
P
X = Z (¢z + U,(i)) Xi—i+ 2,

i=1

where {Z;} ~ 1ID (0, 02), {U,(i)} ~ IID (0, vz), {Z;} is independent of {Ut}, and

¢1,...,¢p e R.
Threshold models can be regarded as piecewise linear models in which the linear
relationship varies with the values of the process. For example, if RO j=1,... k,is

a partition of R?, and {Z;} ~ IID(0, 1), then the k difference equations

P
X =007+ Y 6"y Ko X)) €RY, i=1k (1136)
j=1
define a threshold AR(p) model. Model identification and parameter estimation for
threshold models can be carried out in a manner similar to that for linear models using
maximum likelihood and the AIC criterion.

11.4 Long-Memory Models

The autocorrelation function p(-) of an ARMA process at lag & converges rapidly to
zero as h — oo in the sense that there exists » > 1 such that

rlp(h)y >0  as h— oo. (11.4.1)
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Stationary processes with much more slowly decreasing autocorrelation function,
known as fractionally integrated ARMA processes, or more precisely as ARIMA
(p, d, q) processes with 0 < |d| < 0.5, satisfy difference equations of the form

(1 - B)'¢(B)X, = 0(B)Z, (11.4.2)
where ¢ (z) and 6(z) are polynomials of degrees p and g, respectively, satisfying
¢(z) #0 and 6(z) #0 forall zsuch that |z] <1,

B is the backward shift operator, and {Z;} is a white noise sequence with mean 0 and
variance 2. The operator (1 — B)? is defined by the binomial expansion

o
1-B)*=) mB
j=0

where nop = 1 and

k—1—-d )
JT/ZI_[T, ]:1,2,
O<k<j

The autocorrelation p(h) at lag h of an ARIMA(p, d, q) process with 0 < |d| < 0.5
has the property

p(Mh' ™ > c#£0 as h— oo. (11.4.3)

This implies (see (11.4.1)) that p (k) converges to zero as & — oo at a much slower
rate than p(h) for an ARMA process. Consequently, fractionally integrated ARMA
processes are said to have “long memory.” In contrast, stationary processes whose ACF
converges to 0 rapidly, such as ARMA processes, are said to have “short memory.”

A fractionally integrated ARIMA(p, d, g) process can be regarded as an ARMA
(p, g) process driven by fractionally integrated noise; i.e., we can replace equa-
tion (11.4.2) by the two equations

d(B)X; = 0(B)W, (11.4.4)
and
(1-B)'W, =Z,. (11.4.5)

The process {W,} is called fractionally integrated white noise and can be shown (see,
e.g., Brockwell and Davis (1991), Section 13.2) to have variance and autocorrelations
given by

,T(1—2d)

yw(0) =0 ) (11.4.6)
and
_Th+drd—d) k—1+d
pW(h)_F(h—d+1)F(d)_Oghik—d . h=1,2,...,
(11.4.7)

where I'(-) is the gamma function (see Example (d) of Section A.1). The exact
autocovariance function of the ARIMA(p, d, q) process {X,} defined by (11.4.2) can
therefore be expressed, by Proposition 2.2.1, as

[o. SR )

ye(h) =YY vnyw(h +j — k), (11.4.8)

j=0 k=0



340

Chapter 11

Further Topics

Example 11.4.1

Figure 11-7

Annual minimum water
levels of the Nile river
for the years 622-871

where Y 2 ¥z = 0(2)/$(2), |zI < 1, and yw(-) is the autocovariance function of
fractionally integrated white noise with parameters d and o2, i.e.,

yw(h) = yw(0) pw(h),

with yw (0) and pw (k) asin (11.4.6) and (11.4.7). The series (11.4.8) converges rapidly
as long as ¢ (z) does not have zeros with absolute value close to 1.
The spectral density of {X;} is given by

02|9(€_M)F
2 |¢(e—ix)|2
Calculation of the exact Gaussian likelihood of observations {xi, ..., x,} of a frac-
tionally integrated ARMA process is very slow and demanding in terms of computer
memory. Instead of estimating the parameters d, ¢1, ..., ¢, 0, ...,0,, and o’ by

maximizing the exact Gaussian likelihood, it is much simpler to maximize the Whittle
approximation Ly, defined by

o—i |—2d .

fo) = |1 — (11.4.9)

In (a)/)

—2In(Ly) =nln@Qn) + 2nlno +0>» )
;8

+Y Ing(e), (11.4.10)
J

where I, is the periodogram, o2g/(2m)(= f) is the model spectral density, and }_ j
denotes the sum over all nonzero Fourier frequencies w; = 2nj/n € (—m, m]. The
program ITSM estimates parameters for ARIMA(p, d, g) models in this way. It can
also be used to predict and simulate fractionally integrated ARMA series and to
compute the autocovariance function of any specified fractionally integrated ARMA
model.

Annual Minimum Water Levels; NILE.TSM

The data file NILE.TSM consists of the annual minimum water levels of the Nile
river as measured at the Roda gauge near Cairo for the years 622-871. These values
are plotted in Figure 11-7 with the corresponding sample autocorrelations shown in
Figure 11-8. The rather slow decay of the sample autocorrelation function suggests
the possibility of a fractionally intergrated model for the mean-corrected series Y;
X, —1119.
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Figure 11-8

The sample correlation
function of the data

in Figure 11-7
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The ARMA model with minimum (exact) AICC value for the mean-corrected
series {Y;} is found, using Model>Estimation>Autofit,to be

Y, = —0.323Y,_1 — 0.060Y,_, + 0.633Y,_3 + 0.069Y,_4 + 0.248Y,_s
+ 7, +0.702Z,_, + 0.350Z;_, — 0.419Z,_3, (11.4.11)

with {Z,} ~ WN(0, 5663.6) and AICC= 2889.9.

To fit a fractionally integrated ARMA model to this series, select the option
Model>Specify, check the box marked Fractionally integrated
model, and click on OK. Then select Model>Estimation>Autofit, and click
on Start. This estimation procedure is relatively slow so the specified ranges for p
and ¢ should be small (the default is from 0 to 2). When models have been fitted for
each value of (p, g), the fractionally integrated model with the smallest modified AIC
value is found to be

(1 — B)*3%%(1 — 0.1694B + 0.9704B>)Y, = (1 — 0.1800B + 0.9278B%)Z,,
(11.4.12)

with {Z;} ~ WN(O0, 5827.4) and modified AIC= 2884.94. (The modified AIC statis-
tic for estimating the parameters of a fractionally integrated ARMA(p, g) process is
defined in terms of the Whittle likelihood Ly as —2In Ly + 2(p + g + 2) if d is
estimated, and —2InLy + 2(p + g + 1) otherwise. The Whittle likelihood was defined
in (11.4.10).)

In order to compare the models (11.4.11) and (11.4.12), the modified AIC
value for (11.4.11) is found as follows. After fitting the model as described above,
select Model>Specify, check the box marked Fractionally integrated
model, set d = 0 and click on OK. Next choose Model>Estimation>Max
likelihood, check No optimization and click on OK. You will then see the
modified AIC value, 2884.58, displayed in the ML, estimates window together
with the value 2866.58 of —2InLy, .

The ARMA(5,3) model is slightly better in terms of modified AIC than the
fractionally integrated model and its ACF is closer to the sample ACF of the data than
is the ACF of the fractionally integrated model. (The sample and model autocorrelation
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functions can be compared by clicking on the third yellow button at the top of the ITSM
window.) The residuals from both models pass all of the ITSM tests for randomness.
Figure 11-9 shows the graph of {xyq, ..., X250} With predictors of the next 20

values obtained from the model (11.4.12) for the mean-corrected series.
0

11.5 Continuous-Time ARMA Processes

Figure 11-9

The minimum annual
Nile river levels for the
years 821-871, with
20 forecasts based on
the model (11.4.12)

Time series frequently consist of observations of a continuous-time process {Y (), t >
0} or {Y(?), t € R} at a discrete sequence of observation times. It is then natural, even
though the observations are made at discrete times, to model the data by fitting the
underlying continuous-time process.

Even if there is no underlying continuous-time process, it may still be advan-
tageous to model the data as observations of a continuous-time process sampled at
discrete times. For example, the analysis of time series data observed at irregularly
spaced times can be handled very conveniently by regarding the data as sampled values
of a continuous-time process (see Jones 1980 and equation (11.5.6) below).

Continuous-time models also provide a unifying framework for data collected
when a time series is observed at different frequencies, i.e., with different spacings
between the observation times. Instead of requiring different discrete-time models to
represent observations collected at different frequencies, continuous-time modelling
provides a single model which can be sampled at any frequency whatsoever.

When very high-frequency observations are available (as in many financial and
turbulence studies), the relation between the high-frequency sequence and the under-
lying continuous-time process is also of interest since the high-frequency observations
provide a natural source of information regarding the continuous-time process of
which the discrete observations are a sample.

Stationarity of a continuous-time process {Y (¢)} (cf. Definition 1.4.2) means that
EY(t) and Cov(Y (¢t + h), Y(t)) are defined and independent of ¢ for all 4~ > 0. Strict
stationarity means that (Y (#,), ..., Y(t,)) and (Y (¢, +h), ..., Y (¢, +h)) have the same
joint distributions for all ¢, ..., t,, all A > 0 and all positive integers n.
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Continuous-time ARMA (or CARMA) processes are defined as stationary solu-
tions of stochastic differential equations analogous to the difference equations that are
used to define discrete-time ARMA processes. They play a role in continuous-time
modelling analogous to that of ARMA processes in discrete time.

We shall begin with the Gaussian continuous-time AR(1) process, also known as
the stationary Gaussian Ornstein-Uhlenbeck process.

11.5.1 The Gaussian CAR(1) Process, {Y(t), t > 0}

The Gaussian CAR(1) process {Y (), t > 0} is defined as a strictly stationary solution
of the first-order stochastic differential equation,

DY(#) + aY(t) = oDB(t) + ¢, t > 0, (11.5.1)

where the operator D denotes differentiation with respect to ¢, {B(r), t € R} is
standard Brownian motion (see Example 7.5.1), a, ¢, and o are parameters and Y (0)
is a normally distributed random variable independent of {B(f) — B(s),0 < s <t <
oo}. The derivative DB(t) does not exist in the usual sense, so equation (11.5.1) is
interpreted as the It6 differential equation (see Appendix D.4),

dY(t) +aY(t)dt = odB(t) + cdt, >0, (11.5.2)

with dY (¢) and dB(¢) denoting the increments of Y and B in the time interval (¢, ¢+ dr).

Standard theory of deterministic linear differential equations suggests multiplying

this equation by e in which case the left-hand side would become d(e™Y (¢)). We

therefore apply It6’s formula (Appendix, equation (D.3.7)) to d(e™ Y (¢)) with g(z, x) :=

e x and we obtain exactly the same result since the second partial derivative g,, is zero.
Hence we can rewrite (11.5.2) as

d(eY (1)) = oe”dB(t) + ce”dt,

or equivalently,

t t
Yt —-Y0) =0 / e"dB(u) + c/ e“du.
0 0
Thus

t t
Y(t) = e “Y(0) + o / e "B (u) + ¢ / e dy. (11.5.3)
0 0

Remark 1. The It6 integral [; e=*“"dB(u) in (11.5.3) is of a special type in which
the integrand is deterministic. This permits the application of integration by parts to
obtain a pathwise representation of Y as

! t
Y(1) = e “Y(0) +0B(t) —0o / ae™ " B(u)du + c/ ey,
0

0 U

If a > 0 and Y(0) has mean c/a and variance o2/(2a), it is easy to check,
using the properties of Iy ,(f) = fot f(u)dB(u) in Remark 3 of Appendix D.3 and the
independence of Y (0) and {B(f) — B(s),0 < s < t < oo} (Problem 11.4), that {Y(¢)}
as defined by (11.5.3) is stationary with

2
E(Y (1) = 2 and  Cov(Y(r +h), Y(£)) = ;—ae_“h, th>0.  (11.5.4)
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Since {Y(#)} is Gaussian it is also strictly stationary. Conversely, if {Y(¢)} is strictly
stationary, then by equating the variances of both sides of (11.5.3), we find that
(1 — e*2‘”) Var(Y(0)) = 02f0t e 2% dy for all t > 0, and hence that ¢ > 0 and
Var(Y(0)) = o2/(2a). Equating the means of both sides of (11.5.3) then gives
E(Y(0)) = c/a. Necessary and sufficient conditions for {Y (¢)} to be strictly stationary
are therefore a > 0, E(Y(0)) = ¢/a, and Var(Y(0)) = 0%/(2a).

Ifa> 0and 0 < s <, it follows from (11.5.3) that Y (¢) satisfies the relation

t
Y(t) = ey (s) + < (1-e9) +o / e “dB(u), t>s5>0.
a N

(11.5.5)

This shows that the process is Markovian, i.e., that the distribution of Y(#) given
Y(u),u < s, is the same as the distribution of Y(¢) given Y(s). It also shows that
the conditional mean and variance of Y(¢) given Y (s) are

E(Y(t)|Y(S)) — e*a(tfx)Y(s) + C/Cl (1 _ efa(tfx))

and

o? ‘
Val‘(Y(t)|Y(s)) = Z [1 _ e*2£l(t7_x)] )

We can now use the Markov property and the moments of the stationary distri-
bution to write down the likelihood of observations y(¢), ..., y(¢,) at times #q, ..., t,
of the Gaussian CAR(1) process. This is just the joint density of (Y(z,), ..., Y(¢,)) at
(ty), ..., y(t,)), which can be expressed as the product of the stationary density at
y(t1) and the transition densities of Y (t;) given Y (t;_;) = y(t,_1),i = 2,...,n. The
joint density g is therefore given by

. 2N . L y(&) — m;
g()’(fl),---,y(fn),a, c, 0 ) — g ,\/V—lf( \/‘71 _> s (1156)

where f(y) = n(y; 0, 1) is the standard normal density, m; = c/a, v; = 0*/(2a), and
fori > 1,

e c —alti—t:
mi — e_a(tz tl—l)y(tiil) + _ (1 —e a(t; tt—l))
a

and
2
o
_ —2a(ti—ti—1)
vi=—I|1—e .
! 2a [ ]

The maximum likelihood estimators of a, ¢, and o2 are the values that maximize

g (y(tl), ooyt a, e, 02). These can be found with the aid of a nonlinear maximiza-

tion algorithm. Notice that the times #; appearing in (11.5.6) are quite arbitrarily spaced.
It is this feature that makes the CAR(1) process so useful for modeling irregularly
spaced data.

If the observations are regularly spaced, say t;, = i,i = 1, ..., n, then the joint
density g is exactly the same as the joint density of observations of the discrete-time
Gaussian AR(1) process

c _ c o’ (1 - e—2a)
Y=< =e (Yo = =)+ 2 (2} ~IDN (0, Z———= ).
a a

This shows that the “embedded” (or sampled) discrete-time process {Y (i), i =
1,2, ...} of the CAR(1) process is a discrete-time AR(1) process with coefficient e ™.
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This coefficient is clearly positive, immediately raising the question of whether there is
a continuous-time ARMA process for which the embedded process is a discrete-time
AR(1) process with negative coefficient. It can be shown (Chan and Tong 1987) that the
answer is yes and that given a discrete-time AR(1) process with negative coefficient,
it can always be embedded in a suitably chosen continuous-time ARMA(2,1) process.

11.5.2 The Gaussian CARMA(p, q) Process, {Y(t), t € R}

We define a zero-mean Gaussian CARMA(p, g) process {Y(¢),t € R} (with0 < g <
p) to be a strictly stationary Gaussian process satisfying the pth-order linear differential
equation,

DPY(t) + a\DP'Y (1) + - -+ a,Y (1)
= boDB(t) + biD*B(t) + - - - + b,D"'B(p), (11.5.7)

where D/ denotes j-fold differentiation with respect to ¢, {B(t), t € R} is standard
Brownian motion, and ay, ..., a, and by, . . ., b, are constants. We assume that b, # 0
and define b; := 0 for j > g. We shall also assume that the polynomials, a(z) :=
24rad M+ + a, and b(z) := by + b1z + - - - + byz?, have no common zeroes.
Since the derivatives D/B(t), j > 0, do not exist in the usual sense, we interpret (11.5.7)

as being equivalent (see Remark 2 below) to the observation and state equations

Y@ = b'’X(0, (11.5.8)
and
dX (1) = AX(1) df + e dB(1), (11.5.9)
where
0 1 0 0 7]
0 1 0
A= : : : i : )
0 0 0 1
L—4p —Ap-1 —Gp—2 - —dp, |
e = [0 0 - 0 1],b= [bo bi - bys bp,l],and(11.5.9) is an Tto

differential equation for the state vector X(#) (see Appendix D.4).
Remark 2. Denoting the components of X(7) by X;(r),j =0, ..., p—1, the first p— 1
component equations of (11.5.9) are

dXj(t) = X;(dt, j=0,...,p—2,

showing that X;(7) is just the j derivative of Xo(z), j = 1,...,p — 1. The last
component equation of (11.5.9) is

dXI,_l(t) = —(alX,,_l + (12Xp_2 + -+ a,,Xo(t))dt + dB(1),
which is the It6 form of the stochastic differential equation,
DPXo(t) + a;DP~ ' Xo(t) + - - - + a,Xo(t) = DB(1). (11.5.10)

The state equation (11.5.9) is thus the 1t6 equation for the vector whose first component
X (1) satisfies the CARMA(p, 0) (or CAR(p)) equation (11.5.10) and whose remaining
components are successively higher derivatives, up to order p — 1, of X (¢). It is clear
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from the linearity of equation (11.5.7) that if X(¢) satisfies (11.5.9) then X, (¢) satisfies
(11.5.10) and the linear combination,

Y (1) = boXo() + bi X, (1) + -+ + b1 X,—1 (1) = b'X(1),

of Xy(#) and its derivatives satisfies (11.5.7). This explains the replacement of (11.5.7)
by the observation and state equations (11.5.8) and (11.5.9). O

If X(0) is a normally distributed random vector independent of {B(f) — B(s), 0 <
s <t < 00}, then equation (11.5.9) is simply a vector form of equation (11.5.2) and
its unique solution for ¢ > 0, as specified in Appendix D.4, Theorem D.4.1, satisfies

t
X(1) = e4X(0) + / e e dB(u), 0 <1t < oo,
0

where the matrix ¢! is defined in the usual way as ¢! := ) ") ’;—frj .
More generally (see Appendix D, equation (D.4.6)), if for each S € R, X(S) has
finite second moments and is independent of {B(¢) — B(s), S <s <t < oo}, then the

unique solution of (11.5.9) specified by Theorem D.4.1 satisfies

t
X(1) = 7IX(S) + / A"e dB(u), t> S, forall S € R. (11.5.11)
S

If the real parts of the eigenvalues Ay, ..., A, of A (which are also the zeroes of
the autoregressive polynomial a(z)) satisfy
He(h,) <0, r=1,...,p, (11.5.12)

and if {X(#)} is a stationary solution of (11.5.11) then, taking mean square limits as
S — —ooin (11.5.11), we see that it must satisfy

X(1) = / e dB(u), teR. (11.5.13)

Conversely, if {X(¢)} is given by (11.5.13) then it is a stationary solution of (11.5.11)
and for each § € R, X(S) has finite second moments and is independent of
{B(t) — B(s), S < s < t < o00}. Hence it is the unique solution of the type
specified in Theorem D.4.1 with these properties. The property that, for each S, X(S)
is independent of {B(f) — B(s), S < s <t < 00}, corresponds to the discrete-time
concept of causality introduced in Section 3.1.

Assuming that condition (11.5.12) is satisfied, we define the zero-mean causal
Gaussian CARMA (p, q) process {Y (1), t € R}, with parameters (ay, ..., ap, by,
..., by), by

Y(1) = WX(), (11.5.14)

where {X(#)} is given by (11.5.13). A Gaussian CARMA process with mean m is
obtained by simply adding the constant value m to Y.

Remark 3. For the zero-mean causal Gaussian CAR(1) process defined by (11.5.1),
with ¢ = 0 and with index set R instead of [0, c0) as in Section 11.5.1, we have b = ¢
and A = —a, so that
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t
YO) =0 / e dBw), e R. O

e¢]

The autocovariance function of the process X(¢) at lag h is easily found from
(11.5.13) to be

Cov(X(t + h), X(1) = ez,

where
o0 ’
b)) :=/ eVeeetVdy.
0

The mean and autocovariance function of the CARMA(p, g) process {Y ()} are there-
fore given by

EY()=0
and

Cov(Y(t+ h), Y(©)) = b'eA" =b.

Inference for a CARMA (p, q) process with p > 1 is more complicated than for a
CAR(1) process because the former is not Markovian, so the simple argument that led
to (11.5.6) no longer holds. However, the Gaussian likelihood of observations at times
t,...,t, can still easily be computed using the discrete-time Kalman recursions as
pointed out by Jones (1980).

Simulation and estimation, not only for Gaussian, but also for Lévy-driven
CARMA processes (as introduced in the following subsection) can be carried out
using the Yuima package, a package for use in the R environment, which can be
downloaded from https://cran.r-project.org/web/packages/yuima. A detailed account
of its application to CARMA processes is contained in the paper of lacus and Mercuri
(2015). A simulated Gaussian (3,2) process and the components of its state-vector,
generated in R by the Yuima package, is shown in Figure 11-10.

Rather than examining Gaussian CARMA processes in more detail, we next
introduce the more general class of Lévy-driven CARMA(p, q) processes, whose
marginal distributions can be both heavy-tailed and asymmetric and whose sample-
paths are continuous if ¢ < p — 1 and have the same jumps as the driving Lévy process
ifg=p—1.

11.5.3 Lévy-driven CARMA Processes, {Y(t), t € R}

In Section 11.5.2, under the assumption (11.5.12), we defined the zero-mean causal
Gaussian CARMA process {Y (), t € R} as the strictly stationary linear combination
(11.5.14) of components of the state-vector X(¢) given by (11.5.13). In this section we
wish to extend the definition by replacing the driving process B by a Lévy process L
in order to allow a much broader class of possible marginal distributions for Y (7). As
in Section 11.5.2 we shall assume that the polynomials a(z) and b(z) in the defining
stochastic differential equation,

a(D)Y(t) = b(D)DL(2),

have no common zeroes. We use the same state-space representation of the process as
in Section 11.5.2 to obtain a rigorous interpretation of this equation.


https://cran.r-project.org/web/packages/yuima
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Figure 11-10
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Replacing the Brownian motion {B(¢)} in (11.5.11) by the Lévy process {L(t)}
gives

X =IXES) + | M VdLw), t> S, forall S € R. (11.5.15)
(.11
where the integral is now interpreted in the sense of Protter (2010). We then define the
CARMA (p, q) process driven by L, with coefficients (a,,...,a,, b1, ..., b,), to be
a strictly stationary solution {Y (¢)} of the equation (11.5.15) and

Y(t) = b'’X(0). (11.5.16)

The matrix A and the vector b are defined as in Section 11.5.2, except that we now
define b, := 1 since there is no variance constraint on L(1) as there was on B(1) in
the definition of the Gaussian special cases in Sections 11.5.1 and 11.5.2. In the case
when L is a subordinator (i.e., a Lévy process with non-decreasing sample paths), the
integral in (11.5.15) can also be interpreted as a pathwise Stieltjes integral with respect
to L.

Brockwell and Lindner (2009) have established necessary and sufficient condi-
tions for the existence of a strictly stationary solution {Y(¢), t € R} of (11.5.15)
and (11.5.16). If we assume that a(z) and b(z) have no common zeroes and L is not
deterministic, then the necessary and sufficient conditions are

Emax(0.log |[L(1)]) < o0 (11.5.17)
and

He(h) #0, r=1,...,p, (11.5.18)
where A1, ..., A, are the eigenvalues of A (which are also the zeroes of the autoregres-

sive polynomial a(z)).
The strictly stationary solution is unique, and under the stronger conditions,

FHe(r,) <0, r=1,...,p, (11.5.19)
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Example 11.5.1.

it is causal, i.e., for every s, t and u such that s < ¢ < u, Y(s) is independent of
L(u) — L(¢) and can be expressed as

Y(f) = / b’ edL(u). (11.5.20)
(—00,1]

(The representation (11.5.20) is easily obtained formally by letting § — —oo in
(11.5.15) and substituting the resulting expression for X(¢) in (11.5.16).) Thus, under
the causality condition (11.5.19), equations (11.5.15) and (11.5.16) have the unique
strictly stationary solution (11.5.20). This solution is the causal CARMA (p, g) process
with parameters (ay, ..., d,, by, ..., b, :== 1) driven by the Lévy process L.

From equation (11.5.20) we find that, if E(L(1)?) < oo, EY(f) = wbo/ay,, where
mn = EL(1), and

yy(h) := Cov[Y(t + h), Y(1)] = o°b' A b, (11.5.21)
where 02 = Var(L(1)) and & = [, eVee' NV dy.

Remark 4. A result of Eller (1987) was used by Brockwell and Lindner (2009) to
rewrite (11.5.20) as

m(A)—1
Y(t) = / Z Z et — w0 dL(w), (11.5.22)
(=00.1] A k=0

where X, denotes summation over the zeroes A of a(z), m(A) is the multiplicity of the
zero X and ZT:(%FI cyxtfe? is the residue at A of the mapping z — ¢“b(z)/a(z). If the
zeroes, A, ..., Ay, of a(z) each have multiplicity one, then the expression (11.5.22)

simplifies to
P
Y(r) = / D e T dL(w), (11.5.23)
(mootl

where o, = b(),)/a’(\,). Hence {Y(¢)} has a corresponding canonical representation
as a linear combination of (possibly complex-valued) CAR(1) processes,

P
Y(t) = Za,Y,(t), (11.5.24)

r=1

where Y, (1) = f(_ sout] e~ dI(u). Notice that the driving process L is the same for
each of the component processes {Y,(7)}, so they are not independent. Corresponding
to the canonical decomposition (11.5.24), if E(L(1)?) < oo, there is an analogous
representation of the autocovariance function when E(L(1)?) < oo, namely

P
y(h) =Y B, (11.5.25)
r=1
where B, = 02b()b(—=A,)/la(—1)d ()], 0

Stochastic Volatility

The stochastic volatility process, h, appearing in Example 7.5.4 was defined as

h(t) = f U dL(u), where A < 0, (11.5.26)
(—o0.t]
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i.e., as a Lévy-driven CARMAC(1, 0) process with a(z) = z — A and b(z) = 1. For
non-negativity of A, the Lévy process L is required to be a subordinator, for example,
a gamma process with characteristic function Ee” = (1 — if/B)~*!, EL(t) =
at/B and Var(L(1)) = at/B% Then Eh(f) = «at/(B|A]) and the autocovariance
function of A is, from (11.5.27), y;,(s) = e*la/(2B2%|1|). For any finite-variance Lévy-
driven CARMA(1,0) model for stochastic volatility, the autocorrelation function is
necessarily of the form p(s) = ¢*/¥! for some negative A. In order to relax this constraint
a non-negative CARMA (p, g) model for & can be employed (see e.g., Brockwell and
Lindner 2012).

O

Remark 5. Marginal distributions. The condition (11.5.17) clearly does not
require L(1) (and consequently Y(#)) to have finite variance. In fact the condition
E|L(1)|” < oo for some r > 0 is sufficient to ensure that (11.5.17) holds. Given
a CARMA(p, g) process Y driven by a Lévy process L with characteristic function
E(0) = exp(t£(0)), 6 € R, (see Appendix D.1), the joint characteristic function
of Y(t1), ..., Y(t,) can be expressed in terms of the coefficients of the polynomials a
and b and the characteristic exponent £(-) of L (see Brockwell (2014)). In particular
the logarithm of the marginal characteristic function of Y (¢) is

InEe?" D = /0 h E(Ob e e)du, 0 € R. (11.5.27)
For the CAR(1) process & defined by (11.5.26) this simplifies to

InEe""® = /Ooog(ee“)du =|r"! /Oeylé(y)dy, (11.5.28)
(where f09 = — f 00 if 6 < 0). If, for example, L(1) has a symmetric stable distribution

with InEe™ ™ = —¢|9|%, ¢ > 0,0 < a < 2, then E|L(1)|" < oo for all r € (0, a)
and from (11.5.28) we find at once (Problem 11.8) that,

InE™® = —_<_jg*, (11.5.29)
o | Al
in other words A(¢) has a symmetric stable distribution with the same exponent o as
L(1) but with the parameter c¢ replaced by c/(«|A|).

11.1 Find a transfer function model relating the input and output series X;; and X,
t =1,...,200, contained in the ITSM data files APPJ.TSM and APPK.TSM,
respectively. Use the fitted model to predict X501 2, X202,2, and X593 2. Compare
the predictors and their mean squared errors with the corresponding predictors
and mean squared errors obtained by modeling {X,;} as a univariate ARMA
process and with the results of Problem 8.7.

11.2 Verify the calculations of Example 11.2.1 to fit an intervention model to the
series SB.TSM.

11.3 If {X,} is the linear process (11.3.1) with {Z,} ~ IID (0, 02) and n = EZ,3, show
that the third-order cumulant function of {X,} is given by

Ci(r,) =n Y Vit Viss

i=—00
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11.6

11.7

11.8

Use this result to establish equation (11.3.4). Conclude that if {X,} is a Gaussian
linear process, then Cs5(r, s) = 0 and f3(w;, w;) = 0.

If a > 0 and Y(0) has mean b/a and variance o2/(2a), show that the pro-
cess defined by (11.5.3) is stationary and evaluate its mean and autocovariance
function.

The file TRINGS.TSM contains normalized tree-ring widths of a Colorado pine
for the years 525—774 (Donald Graybill 1984) from the file CO522.DAT at http://
www-personal.buseco.monash.edu.au/hyndman/TSDL/.

a. Use exact maximum likelihood estimation to fit a fractionally integrated
ARMA model to the first 230 tree-ring widths and use the model to generate
forecasts and 95% prediction bounds for the last 20 observations (correspond-
ing to t = 231,...,250). Plot the entire data set with the forecasts and
prediction bounds superposed on the graph of the data.

b. Repeat part (a), but this time fitting an appropriate ARMA model. Compare
the performance of the two sets of predictors.

The tent map with parameter s € (1, oo) is the function
s
g(x) = sxl, 1/ (x) + :(1 — X)),  x€[0,1],

where I, denotes the indicator function of the set A. If X, has the uniform

distribution on [0, 1] (written more concisely as Xy ~ U) and if {X,} is the

sequence defined by X, = g(X,,—1),n = 1,2, ..., then {X,} is a Markov chain
and X, ~ U foralln € {0,1,2,...}, so that {X,} is strictly (and weakly)
stationary.

a. Show that in the symmetric case (s = 2), {X,,} ~ WN(0, 1/12).

b. In the general case, X, — 0.5 = ¢(X,_1 — 0.5) +Z,,n = 1,2, ..., where
¢ = (2/s) — 1 and {Z,} is an uncorrelated (but strongly dependent) sequence
of random variables with mean zero and variance (1 —¢?)/12. (See Sakai and
Tokumaru 1980.)

A Lévy-driven CARMA(2,1) process is defined by the stochastic differential
equation,

(D> + 1.5D + 5)Y(t) = (D + .2)DL(1), 1 € R,

where L is a Poisson process with jump-rate p.

a. Calculate EY (7).

b. Use (11.5.23) to determine the canonical decomposition of {Y(¢)}.
c. Use (11.5.25) to determine the autocovariance function of {Y(¢)}.

Use (11.5.27) to verify (11.5.28) and (11.5.29). If L(1) ~ N(0, '), use (11.5.29)
to determine the distribution of A(¢), as defined by (11.5.26).


http://www-personal.buseco.monash.edu.au/hyndman/TSDL/
http://www-personal.buseco.monash.edu.au/hyndman/TSDL/

Random Variables
and Probability Distributions

A.1  Distribution Functions and Expectation
A.2  Random Vectors
A.3  The Multivariate Normal Distribution

Distribution Functions and Expectation

The distribution function F of a random variable X is defined by
F(x) = PIX <x] (A.1.1)

for all real x. The following properties are direct consequences of (A.1.1):

1. F is nondecreasing, i.e., F(x) < F(y)ifx < y.
2. F isright continuous, i.e., F(y) | F(x) asy | x.
3. F(x) > 1 and F(y) — 0 asx — oo and y — —o0, respectively.

Conversely, any function that satisfies properties 1-3 is the distribution function of
some random variable.

Most of the commonly encountered distribution functions F can be expressed
either as

F(x) = / fdy (A.12)
or
F) =) px, (A.13)
Jixj=<x

where {xg, x1, X, . ..} is a finite or countably infinite set. In the case (A.1.2) we shall
say that the random variable X is continuous. The function f is called the probability
density function (pdf) of X and can be found from the relation

f) =F'(x).

© Springer International Publishing Switzerland 2016 353
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In case (A.1.3), the possible values of X are restricted to the set {xg, x1, ...}, and we
shall say that the random variable X is discrete. The function p is called the probability
mass function (pmf) of X, and F is constant except for upward jumps of size p(x;) at
the points x;. Thus p(x;) is the size of the jump in F at x;, i.e.,

p(x) = F(x) — F(x;) = P[X = xjl,

where F (x;) = limyy,, F(y).

A.1.1 Examples of Continuous Distributions

(a) The normal distribution with mean w and variance o*>. We say that a random
variable X has the normal distribution with mean & and variance o2 (written more

concisely as X ~ N (M, 02)) if X has the pdf given by

2 2
n (x; “w, 02) = (27) 2o/ (207 — 00 < X < 0.

It follows then that Z = (X — w) /o ~ N(O, 1) and that

P[Xfx]:P[fo_M}sz(x_M>,

o o

where ®(x) = [*_ (2m)7 2¢=37 dz is known as the standard normal distribu-
tion function. The significance of the terms mean and variance for the parameters
w and o2 is explained below (see Example A.1.1).

(b) The uniform distribution on [a, b]. The pdf of a random variable uniformly dis-
tributed on the interval [a, b] is given by

1
u(x; a, b) = b—a’
0, otherwise.

ifa<x<hb,

(¢c) The exponential distribution with parameter \. The pdf of an exponentially dis-
tributed random variable with parameter A > 0 is

0, if x <0,
e(x; ) =
re™™ ifx > 0.

The corresponding distribution function is
0 if x <0,

F) =1~ ,
1 —e™™, ifx>0.

(d) The gamma distribution with parameters o and . The pdf of a gamma-distributed
random variable is

0, ifx <0,
g a,d) =
XA %™/ T(a), ifx >0,

where the parameters o and A are both positive and I' is the gamma function
defined as

o
F(a):/ X le ™ dx.
0
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Note that f is the exponential pdf when o = 1 and that when « is a positive integer

I'(@) = (¢ — 1)! with 0! defined to be 1.

(e) The chi-squared distribution with v degrees of freedom. For each positive integer
v, the chi-squared distribution with v degrees of freedom is defined to be the
distribution of the sum

X=Z+---+72

where Zi, ..., Z, are independent normally distributed random variables with
mean 0 and variance 1. This distribution is the same as the gamma distribution

with parameters ¢ = v/2 and A = %

A.1.2  Examples of Discrete Distributions

(f) The binomial distribution with parameters n and p. The pmf of a binomially
distributed random variable X with parameters n and p is

n . .
b(.]’nvp)=P[X=.]]:(J)p](l_p)nja J:()v 17---7”7

where 7 is a positive integer and 0 < p < 1.
(g) The uniform distribution on {1,2, ..., k}. The pmf of a random variable X uni-
formly distributed on {1, 2, ..., k} is

U =PIX=jl= 7. j=12..k
where k is a positive integer.
(h) The Poisson distribution with parameter A. A random variable X is said to have a
Poisson distribution with parameter A > 0 if
AN
p(j; M) =PX=j]= j—'ﬂ, i=0,1,....
We shall see in Example A.1.2 below that A is the mean of X.
(i) The negative binomial distribution with parameters o and p. The random variable
X is said to have a negative binomial distribution with parameters ¢ > 0 and
p € [0, 1] if it has pmf
J

_ k—14+a«a - _
k=1

where the product is defined to be 1 if j = 0.

Not all random variables can be neatly categorized as either continuous or discrete.
For example, consider the time you spend waiting to be served at a checkout counter
and suppose that the probability of finding no customers ahead of you is % Then the
time you spend waiting for service can be expressed as

1
0, with probability 3

W= |
Wi, with probability 7
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where W is a continuous random variable. If the distribution of W is exponential with
parameter 1, then the distribution function of W is

0, ifx <0,
Fx) =11 1 1
54_5(1_6*)6):1—56”6, ifx > 0.

This distribution function is neither continuous (since it has a discontinuity at x = 0)
nor discrete (since it increases continuously for x > 0). It is expressible as a mixture,

F =pFq+ (1 — p)F,,

with p = %, of a discrete distribution function
0, x<O,
Fq=
1, x>0,

and a continuous distribution function

0, x <0,
F. =
1—e™, x=>0.
Every distribution function can in fact be expressed in the form
F =p\Fq+ p2F. + p3F,

where 0 < p1, p2, p3 < 1, p1 + p2 + p3 = 1, Fq is discrete, F, is continuous, and F.
is singular continuous (continuous but not of the form A.1.2). Distribution functions
with a singular continuous component are rarely encountered.

A.1.3 Expectation, Mean, and Variance

The expectation of a function g of a random variable X is defined by

E(g(X)) = / g(x) dF (x),
where

o0
/ g(x)f(x)dx in the continuous case,

/g(x) dF(x) :=
Z g(x)p(xj) in the discrete case,
j=0

and g is any function such that E|g(x)| < oo. (If F is the mixture F = pF.+ (1 —p)Fyq,
then E(g(X)) = p [ g(x) dFe(x) + (1 — p) [ g(x) dF4(x).) The mean and variance of
X are defined as 4 = EX and 0> = E(X — )2, respectively. They are evaluated by
setting g(x) = x and g(x) = (x — w)? in the definition of E(g(X)).

It is clear from the definition that expectation has the linearity property

E@X+b)=aEX)+b

for any real constants a and b (provided that E|X| < 00).
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Example A.1.1  The Normal Distribution

If X has the normal distribution with pdf n (x; ", 02) as defined in Example (a) above,
then

]

EX—n) = /Oo(x— ,u)n(x; M,az) dx = —02/ n’(x : ,u,az) dx = 0.

o]

This shows, with the help of the linearity property of E, that
EX) =,

i.e., that the parameter w is in fact the mean of the normal distribution defined in
Example (a). Similarly,

oo oo
E(X—M)2 = / (x—u)zn(x; W, 02) dx = —02/ (x—u)n’(x; ", 02) dx.
—0o0 —0o0
Integrating by parts and using the fact that f is a pdf, we find that the variance of X is

EX — ,u)2 = 02/ n(x; “, 02) dx = o2,

—00

Example A.1.2  The Poisson Distribution

The mean of the Poisson distribution with parameter A (see Example (h) above) is

given by
7 = !
M:Z]Te_kz 1 'e_k_)ueke_’\_)u
= ‘= (-D
A similar calculation shows that the variance is also equal to A (see Problem A.2).

O

Remark. Functions and parameters associated with a random variable X will be
labeled with the subscript X whenever it is necessary to identify the particular random
variable to which they refer. For example, the distribution function, pdf, mean, and
variance of X will be written as Fy, fx, iy, and 0)%, respectively, whenever it is
necessary to distinguish them from the corresponding quantities Fy, fy, fy, and o}
associated with a different random variable Y.

A.2 Random Vectors

An n-dimensional random vector is a column vector X = (X, ..., X,,)’ each of whose
components is a random variable. The distribution function F of X, also called the
joint distribution of X, ..., X, is defined by

F(xp, ..., x) = PIXy, xp,eo, Xy < x0] (A.2.1)
for all real numbers xi, ..., x,. This can be expressed in a more compact form as
Fx) =PIX<x], x=(x1,...,X),

for all real vectors X = (xi,...,x,)". The joint distribution of any subcollection

Xi,, ..., X;, of these random variables can be obtained from F by setting x; = o0
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in (A.2.1)forallj ¢ {iy, ..., i}. In particular, the distributions of X; and (Xi, X,,)’ are
given by

Fx,(x1) = P[X; <x1] =F(x;,00,...,00)
and
Fx, x,(x1,x,) = P[X1 < x1, X, <x,] = F(x1,00,...,00,x,).

As in the univariate case, a random vector with distribution function F' is said to be
continuous if F has a density function, i.e., if

Xn X2 X1
F(xl,---,xn)=f f / fOL .y dyrdyy - - - dy,.

The probability density of X is then found from
"F(x1,...,X,)
Axy -+ 0x,

f(xlv---axn) =

The random vector X is said to be discrete if there exist real-valued vectors Xy, X, ...
and a probability mass function p(x;) = P[X = x;] such that

D opx) =1
j=0

The expectation of a function g of a random vector X is defined by

E (g(X)) =/g(X)dF(X) =/g(xl,---,xn)dF(xl,---,xn),

where

/g(xl,...,x,,)dF(xl,...,xn)

/ . /g(xl, ceesXy) f(x1, ..o, x,) dxy - - - dx,, in the continuous case,

Z . Zg(le, e X IPX s s X)), in the discrete case,
jl jn
and g is any function such that E|g(X)| < oo.

The random variables X, ..., X,, are said to be independent if

P[Xl Exla""Xn Exn] :P[Xl Exl]P[Xn Exn]a
ie.,
F(Xl,...,xn) =FX1(XI)"'FX,,(X")

for all real numbers x1, ..., x,. In the continuous and discrete cases, independence is
equivalent to the factorization of the joint density function or probability mass function
into the product of the respective marginal densities or mass functions, i.e.,

f(xla “e axn) :fX1 (xl) o 'fX,, (xn) (A22)

or
PO, -y ) = px, (x1) - - px, (Xn). (A.2.3)
For two random vectors X = (X,...,X,) and Y = (Y1,...,Y,) with joint

density function fx y, the conditional density of Y given X = x is
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Proposition A.2.1

Proof

M if fx(x) > 0,
Sx(ylx) = fx®)
fY(Y)» lffX(X) == 0

The conditional expectation of g (Y) given X = x is then
o

E(g(Y)|X = x) = / o) fux (¥ dy.

If X and Y are independent, then fyx (y|x) = fy(y) by (A.2.2), and so the conditional
expectation of g(Y) given X = x is

E@(Y)IX =x) = E(g(Y)),

which, as expected, does not depend on x. The same ideas hold in the discrete case
with the probability mass function assuming the role of the density function.

A.2.1 Means and Covariances

If E|X;] < oo for each i, then we define the mean or expected value of X =
X1, ...,X,) to be the column vector

iy = EX = (EX,, ..., EX,).

In the same way we define the expected value of any array whose elements are random
variables (e.g., a matrix of random variables) to be the same array with each random
variable replaced by its expected value (if the expectation exists).

IfX=X,...,X,)and Y = (Yy,...,Y,,) are random vectors such that each X;
and Y; has a finite variance, then the covariance matrix of X and Y is defined to be
the matrix

Yxy = Cov(X,Y) = E[(X — EX)(Y — EY)']
= EXY') — (EX)(EY)'.

The (i, j) element of Xxy is the covariance Cov(X;, ;) = E(X;Y;) — E(X;))E(Y)). In the
special case where Y = X, Cov(X, Y) reduces to the covariance matrix of the random
vector X.

Now suppose that Y and X are linearly related through the equation

Y = a + BX,

where a is an m-dimensional column vector and B is an m X n matrix. Then Y has
mean

EY = a+ BEX (A.2.4)
and covariance matrix

Yyy = BXxxB’ (A.2.5)
(see Problem A.3).

The covariance matrix Xxx of a random vector X is symmetric and nonnegative
definite, i.e., b’ Zxxb > 0 for all vectors b = (by, ..., b,)" with real components.

Since the (i, j) element of Xxx is Cov(X;, X;) =Cov(X;, X;), it is clear that Xxx is
symmetric. To prove nonnegative definiteness, let b = (b, ..., b,)’ be an arbitrary
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vector. Then applying (A.2.5) with a = 0 and B = b, we have
b/Exxb = Var(b’X) = Var(1X; +---+ b, X,) > 0. |
Proposition A.2.2  Every n x n covariance matrix X can be factorized as
Y = PAP
where P is an orthogonal matrix (i.e., P = P~') whose columns are an orthonormal
set of right eigenvectors corresponding to the (nonnegative) eigenvalues Ay, ..., A, of
Y, and A is the diagonal matrix
M 0 - 0
0 X --- 0
A= :
0 0 - A,
In particular, X is nonsingular if and only if all the eigenvalues are strictly positive.
Proof Every covariance matrix is symmetric and nonnegative definite by Proposition A.2.1,
and for such matrices the specified factorization is a standard result (see Graybill 1983
for a proof). The determinant of an orthogonal matrix is 1 or —1, so that det(X) =
det(P) det(A) det(P) = Aq - - - A,. It follows that ¥ is nonsingular if and only if A; > 0
for all i. |
Remark 1. Given a covariance matrix X, it is sometimes useful to be able to find a
square root A = X!/2 with the property that AA’ = X. It is clear from Proposition
A.2.2 and the orthogonality of P that one such matrix is given by
A =32 =pA'?P.
If ¥ is nonsingular, then we can define
' = PA'P, —00<s < 00.
The matrix ¥ ~'/? defined in this way is then a square root of £ ~! and also the inverse
of ©1/2, g
A.3 The Multivariate Normal Distribution

Definition A.3.1

The multivariate normal distribution is one of the most commonly encountered and
important distributions in statistics. It plays a key role in the modeling of time series
data. Let X = (X1, ..., X,,)’ be a random vector.

X has a multivariate normal distribution with mean u and nonsingular covari-
ance matrix ¥ = Xxy, written as X ~ N(u, %), if

fx(x) = 2m)"*(det )2 exp {—%(x —w'E (x - u)} :
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Example A.3.1.

If X ~ N(u, X), we can define a standardized random vector Z by applying the
linear transformation

Z=3'"’°X-p), (A3.1)

where ¥ 71/2 is defined as in the remark of Section A.2. Then by (A.2.4) and (A.2.5),
Z has mean 0 and covariance matrix Xzz = X~ /2X 272 =, where I, is the n x n
identity matrix. Using the change of variables formula for probability densities (see
Mood et al. 1974), we find that the probability density of Z is

fa(@) = (det )y (32 + p)
1
= (det X)"22m) " (det )" exp {_5(2‘1/2z)’2‘12—1/21}

1
= (2n) " ?exp { — EZ/Z}

_ ((27_[)—1/2 exp{ _ %ﬁ}) ... ((Zn)_l/zexp { — %Z,zl}) ,

showing, by (A.2.2), that Z;, ..., Z, are independent N(0, 1) random variables. Thus
the standardized random vector Z defined by (A.3.1) has independent standard normal
random components. Conversely, given any n x 1 mean vector f, a nonsingular n x n
covariance matrix X, and an n x 1 vector of standard normal random variables, we can
construct a normally distributed random vector with mean g and covariance matrix X
by defining

X =3x"2Z+ pu. (A.3.2)
(See Problem A.4.)

Remark 1. The multivariate normal distribution with mean g and covariance matrix
% can be defined, even when X is singular, as the distribution of the vector X in (A.3.2).
The singular multivariate normal distribution does not have a joint density, since
the possible values of X — u are constrained to lie in a subspace of R” with dimension
equal to rank(X). O

Remark 2. If X ~N(u, X), Bis an m x n matrix, and a is a real m x 1 vector, then
the random vector
Y =a+BX

is also multivariate normal (see Problem A.5). Note that from (A.2.4) and (A.2.5), Y
has mean a + Bp and covariance matrix BXB’. In particular, by taking B to be the

row vector b’ = (by, ..., b,), we see that any linear combination of the components
of a multivariate normal random vector is normal. Thus b’X = b X; + --- + b, X,, ~
N(b iy, b’ Sxxh). O

The Bivariate Normal Distribution
Suppose that X = (Xj, X»)' is a bivariate normal random vector with mean g =
(u1, m2)" and covariance matrix

2
Y= [p;’la "‘:2"2] ., 0>0,00>0 —1<p<l. (A.3.3)
102 2
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Proposition A.3.1.

Example A.3.2.

The parameters o1, 07, and p are the standard deviations and correlation of the compo-
nents X; and X,. Every nonsingular 2-dimensional covariance matrix can be expressed
in the form (A.3.3). The inverse of X is

-2 -1 _—1
_ -1 o —po, O
= (1-p° [ v 12 ]
( ) _pallazl 022

and so the pdf of X is given by

55 = (21010, (1 = p)"?)
1 2
X exp - <x1 - Ml)
2(1 — ,02) ol
—2p (Xl - Ml) (Xz - Mz) 4 (Xz - /Lz)z:“ ‘
(o8] (o)) (o))

Multivariate normal random vectors have the important property that the condi-
tional distribution of any set of components, given any other set, is again multivariate
normal. In the following proposition we shall suppose that the nonsingular normal
random vector X is partitioned into two subvectors

(]
X |

X =

Correspondingly, we shall write the mean and covariance matrix of X as

(D7
o= 12 and ¥ = [211 212],

i. X1 and X® are independent if and only if £, = 0.
ii. The conditional distribution of X" given X® = x® is N(u(l) + 2122521 (X(z) -
u(z)), Y- 21222_21221). In particular,

E(XVX® =x@) = u® 1 2,55 (x? — u®?).

The proof of this proposition involves routine algebraic manipulations of the
multivariate normal density function and is left as an exercise (see Problem A.6).

For the bivariate normal random vector X in Example A.3.1, we immediately deduce
from Proposition A.3.1 that X; and X, are independent if and only if poj0, = 0 (or
p = 0, since o7 and o, are both positive). The conditional distribution of X; given
X, = x, is normal with mean

EXi1Xz = x2) = i1 + poioy ' (x2 — ia)
and variance

Var(X;|X> = x) = of (1 — p%).
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Definition A.3.2.

Problems

{X;} is a Gaussian time series if all of its joint distributions are multivariate normal,
i.e., if for any collection of integers iy, . . . , iy, the random vector (X;,, .. ., Xi,)  has
a multivariate normal distribution.

Remark 3. If {X;} is a Gaussian time series, then all of its joint distributions are
completely determined by the mean function w(f) = EX; and the autocovariance
function «(s,r) = Cov(X;, X;). If the process also happens to be stationary, then
the mean function is constant (u, = w for all ¢) and «(t + h,t) = y(h) for all ¢.

In this case, the joint distribution of X1, ..., X,, is the same as that of X;,, ..., X,4p
for all integers 4 and n > 0. Hence for a Gaussian time series strict stationarity is
equivalent to weak stationarity (see Section 2.1). U

A.1 Let X have a negative binomial distribution with parameters o and p, where @ > 0
and0 <p < 1.
a. Show that the probability generating function of X (deﬁned asM(s) = FE (sX ))
is

M) =p*Q—s+sp)™% 0=<s=<I.
b. Using the property that M'(1) = E(X) and M" (1) = E(X?) — E(X), show that
EX)=a(l—p)/p and Var(X)=a(l—p)/p’.
A.2 If X has the Poisson distribution with mean A, show that the variance of X is also A.

A.3 Use the linearity of the expectation operator for real-valued random variables to

establish (A.2.4) and (A.2.5).
A4 If ¥ is an n x n covariance matrix, X !/? is the square root of ¥ defined in the
remark of Section A.2, and Z is an n-vector whose components are independent

normal random variables with mean 0 and variance 1, show that
X=3VZ+pn
is a normally distributed random vector with mean g and covariance matrix X.

A.5 Show that if X is an n-dimensional random vector such that X ~ N(u, ), B is
areal m x n matrix, and a is a real-valued m-vector, then

Y =a+BX

is a multivariate normal random vector. Specify the mean and covariance matrix
of Y.

A.6 Prove Proposition A.3.1.

A.7 Suppose that X = (Xi,...,X,) ~ N(0, X) with ¥ nonsingular. Using the
fact that Z, as defined in (A.3.1), has independent standard normal components,
show that (X — p)’S~!1(X — u) has the chi-squared distribution with n degrees
of freedom (Section A.1, Example (e)).
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A.8 Suppose that X = (Xy,...,X,) ~ N(u, X) with T nonsingular. If A is a
symmetric n X n matrix, show that E(X'AX) = trace(AX) + u'Z .

A.9 Suppose that {X,} is a stationary Gaussian time series with mean 0 and autoco-
variance function y (h). Find E(X,|X,) and Var(X;|X;), s # t.



Statistical Complements

B.1  Least Squares Estimation

B.2  Maximum Likelihood Estimation
B.3  Confidence Intervals

B.4  Hypothesis Testing

B.1 Least Squares Estimation

Consider the problem of finding the “best” straight line
y=0y+01x

to approximate observations yy, ..., y, of a dependent variable y taken at fixed values
X1, ..., X, of the independent variable x. The (ordinary) least squares estimates 6,
0, are defined to be values of 6y, 6; that minimize the sum

S0, 01) = Y (v — b — 1)’
i=1
of squared deviations of the observations y; from the fitted values 6y + 6;x;. (The

“sum of squares” S(6y, 61) is identical to the Euclidean squared distance between y
and 6y1 + 0;x, i.e.,

S0, 01) = Ily — 61 — 6,x]|?,

where X = (x1,...,x,), 1 =(1,...,1),andy = (y,...,y,) ) Setting the partial
derivatives of S with respect to 8y and 6; both equal to zero shows that the vector
0 = (6, 0,) satisfies the “normal equations”

X'X0 = Xy,
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Example B.1.1.

where X is the n x 2 matrix X = [1, x]. Since 0 < §(#) and S(@) — oo as ||@|| — oo,

. . (D) ~(2) .
the normal equations have at least one solution. If § " and § ~ are two solutions of the
normal equations, then a simple calculation shows that

<é(1) _ 9(2)>’X,X <é(1) _ 6(2)> —0,

i.e., that Xé(l) = Xé(Z). The solution of the normal equations is unique if and only if
the matrix X'X is nonsingular. But the preceding calculations show that even if XX is
singular, the vector y = X 9 of fitted values is the same for any solution @ of the normal
equations.

The argument just given applies equally well to least squares estimation for the
general linear model. Given a set of data points

(Xi1s Xi2s « + s Xims Vi) i=1,...,nwithm < n,
the least squares estimate, 6 = (él, e ém)/ of @ = (04, ...,0,) minimizes
n
2 1 2
S(0) = Z(yi — O1xip — -+ = Opxi)” = [y — XD — - = 6,x"||7,
i=1
wherey = (y1,...,y,) and x¥) = (x1j, ..., X)), j = 1,...,m. As in the previous
special case, 0 satisfies the equations
X'X6 =Xy,
where X is the n x m matrix X = [X(l), el X(’")]. The solution of this equation is

unique if and only if X’X nonsingular, in which case
0= X'X)"'XYy.
If AX/ X is singular, there are infinitely many solutions é, but the vector of fitted values
X0 is the same for all of them.
To illustrate the general case, let us fit a quadratic function
y =0+ 61x + 6,x°
to the data
X 01 2 3 4
y 1 0 3 5 8

The matrix X for this problem is

100
111 124 —108 20

X=|12 4|, giving(XX)"'= — | —=108 174 —40
139 1401 50 40 10
1416

The least squares estimate 0 = (éo, 6, 52)/ is therefore unique and given by
A 0.6
0 =XX)"'Xy=|-0.1
0.5
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The vector of fitted values is given by
y=X60=(0.6,1,2.4,4.8,82)

as compared with the observed values

y=(1,0,3,5,8)".
0
B.1.1 The Gauss—Markov Theorem
Suppose now that the observations yj, ..., y, are realized values of random variables

Y1, ..., Y, satisfying

Yi=0xi1 + - + OpXin + Z;,
where Z; ~ WN (0, 02). LettingY = (Yy,...,Y) and Z = (Z,,...,7Z,)’, we can
write these equations as

Y =X0+7Z.

Assume for simplicity that the matrix XX is nonsingular (for the general case see, e.g.,
Silvey 1975). Then the least squares estimator of @ is, as above,

= X'X)"'XY,
and the least squares estimator of the parameter o2 is the unbiased estimator

o 1 A

62 = — |y - xb|*.

n—m

It is easy to see that 0 is also unbiased, i.e., that
E@6) =9.

It follows at once that if ¢'@ is any linear combination of the parameters 6;, i =
1,...,m, then ¢'6 is an unbiased estimator of ¢'§. The Gauss—Markov theorem says
that of all unbiased estimators of ¢’@ of the form Z:’Zl a;Y;, the estimator ¢'0 has the
smallest variance.

In the special case where Zy, . . ., Z, are [ID N(O, 02), the least squares estimator )
has the distribution N(0, GZ(X’X)_I), and (n — m)6%2/o? has the x? distribution with
n — m degrees of freedom.

B.1.2 Generalized Least Squares

The Gauss—Markov theorem depends on the assumption that the errors Zy, ..., Z, are
uncorrelated with constant variance. If, on the other hand, Z = (Z,, ..., Z,)’ has mean
0 and nonsingular covariance matrix o>% where ¥ # I, we consider the transformed
observation vector U = R™'Y, where R is a nonsingular matrix such that RR' = .
Then

U=R'X0 +W =M +W,

where M = R~'X and W has mean 0 and covariance matrix o-2/. The Gauss—Markov
theorem now implies that the best linear estimate of any linear combination ¢'6 is ¢'6,
where 0 is the generalized least squares estimator, which minimizes

U — Mo,
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In the special case where Zy, ..., Z, are uncorrelated and Z; has mean 0 and variance
o%r?, the generalized least squares estimator minimizes the weighted sum of squares

n 1 5
Z—z(Yi — O1xin — -+ — OpXin)”.
i—1 i

In the general case, if X’X and X are both nonsingular, the generalized least squares
estimator is given by

6= MM 'MU.

Although the least squares estimator (X’X)~'X'Y is unbiased if E(Z) = 0, even when
the covariance matrix of Z is not equal to %/, the variance of the corresponding
estimate of any linear combination of 6y, ..., 6,, is greater than or equal to the
estimator based on the generalized least squares estimator.

B.2 Maximum Likelihood Estimation

Example B.2.1.

The method of least squares has an appealing intuitive interpretation. Its application
depends on knowledge only of the means and covariances of the observations. Maxi-
mum likelihood estimation depends on the assumption of a particular distributional
form for the observations, known apart from the values of parameters 6y, ..., 6,,.
We can regard the estimation problem as that of selecting the most appropriate
value of a parameter vector 6, taking values in a subset ® of R™. We suppose that
these distributions have probability densities p(x; #), 8 € ©. For a fixed vector of
observations x, the function L(0) = p(x; #) on O is called the likelihood function. A
maximum likelihood estimate 9(x) of 0 is a value of # € ® that maximizes the value
of L(@) for the given observed value x, i.e.,

L(é) =p(x; 9(x)) = rglg;(p(x; 0).

If X = (x1,...,x,) is a vector of observations of independent N(, o2) random
variables, the likelihood function is
L(u 02)=;exp —Li(x—u)z —0o<u<oo, o>0.
(27_[0_2)}1/2 20-2 =

Maximization of L with respect to i and o is equivalent to minimization of
1 n
_21nL(,u, o ) =nlnQ27) + 2nln(o) + P ._E 1 (xi — ).

Setting the partial derivatives of —21In L with respect to i and o both equal to zero
gives the maximum likelihood estimates

) B 1 n ) 1 n 3
M=x=;21:xi and 02=;Z;(xi—x)2.
= 1=
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B.2.1 Properties of Maximum Likelihood Estimators

The Gauss—Markov theorem lent support to the use of least squares estimation by
showing its property of minimum variance among unbiased linear estimators. Maxi-
mum likelihood estimators are not generally unbiased, but in particular cases they can
be shown to have small mean squared error relative to other competing estimators.
Their main justification, however, lies in their good large-sample behavior.

For independent and identically distributed observations with true probability
density p(-; @) satisfying certain regularity conditions, it can be shown that the
maximum likelihood estimator @ of 0, converges in probability to 6, and that the
distribution of v/n (@) — 00) is approximately normal with mean 0 and covariance matrix
1(8y)~", where I(0) is Fisher’s information matrix with (i, j) component

E dlnp(X;0)dlnp(X;0)
’ 30, 30, '

In time series analysis the situation is rather more complicated than in the case
of iid observations. “Likelihood” in the time series context is almost always used in
the sense of Gaussian likelihood, i.e., the likelihood computed under the (possibly
false) assumption that the series is Gaussian. Nevertheless, estimators of ARMA
coefficients computed by maximization of the Gaussian likelihood have good large-
sample properties analogous to those described in the preceding paragraph. For details
see Brockwell and Davis (1991), Section 10.8.

B.3 Confidence Intervals

Example B.3.1.

Estimation of a parameter or parameter vector by least squares or maximum likelihood
leads to a particular value, often referred to as a point estimate. It is clear that this
will rarely be exactly equal to the true value, and so it is important to convey some
idea of the probable accuracy of the estimator. This can be done using the notion of
confidence interval, which specifies a random set covering the true parameter value
with some specified (high) probability.

IfX = (Xy,...,X,) is a vector of independent N(M, 02) random variables, we saw

in Section B.2 that the random variable X,, = % Z;’Zl X; is the maximum likelihood
estimator of w. This is a point estimator of . To construct a confidence interval for
from X,,, we observe that the random variable

Xn - K
NG

has Student’s ¢-distribution with n — 1 degrees of freedom, where S is the sample
L =2
standard deviation, i.e., % = ﬁ Yo (Xi — X,,) . Hence,

P|—t = = <t =1-
—apn < < H_g o,
1—a/2 NG 1—a/2

where t,_, /> denotes the (1 — «/2) quantile of the r-distribution with n — 1 degrees of
freedom. This probability statement can be expressed in the form
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Example B.3.2.

P[X,—ti_apS/Vn<p <Xy +t_opS/Vn]=1-aq,

which shows that the random interval bounded by X, £t 28/ J/n includes the true
value p with probability 1 — «. This interval is called a (1 — «) confidence interval
for the mean .

O

B.3.1 Large-Sample Confidence Regions

Many estimators of a vector-valued parameter # are approximately normally dis-
tributed when the sample size n is large. For example, under mild regularity conditions,
the maximum likelihood estimator é(X) of @ = (6,...,6,) is approximately
N(O, %I (é)_l), where 1(0) is the Fisher information defined in Section B.2. Conse-
quently,

n(d - 6)1(8)(8 — 0)

is approximately distributed as x> with m degrees of freedom, and the random set of
0-values defined by

n(6 —6)1(6)(0 — 6) < x2,(m)

covers the true value of # with probability approximately equal to 1 — «.

For iid observations Xj, ..., X, from N(M, 02), a straightforward calculation gives,
for 6 = (M, 02)/,
o2 0
1(0) = .
©® [ 0 o742

Thus we obtain the large-sample confidence region for (M, 02)/,
=12 A N A
n(n—Xa) /6% +n(0® =697/ (26%) < xi_(.

which covers the true value of 6 with probability approximately equal to 1 — «. This
region is an ellipse centered at (X,,, 82).
O

B.4 Hypothesis Testing

Parameter estimation can be regarded as choosing one from infinitely many possible
decisions regarding the value of a parameter vector 8. Hypothesis testing, on the other
hand, involves a choice between two alternative hypotheses, a “null” hypothesis Hy
and an “alternative” hypothesis H, regarding the parameter vector 6. The hypotheses
Hy and H; correspond to subsets @y and @; of the parameter set ®. The problem
is to decide, on the basis of an observed data vector X, whether or not we should
reject the null hypothesis Hy. A statistical test of Hy can therefore be regarded as a
partition of the sample space into one set of values of X for which we reject Hy and
another for which we do not. The problem is to specify a test (i.e., a subset of the
sample space called the “rejection region”) for which the corresponding decision rule
performs well in practice.
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Example B.4.1.

IfX = (Xy,...,X,) is a vector of independent N(u, 1) random variables, we may
wish to test the null hypothesis Hy: & = 0 against the alternative H;: © # 0. A
plausible choice of rejection region in this case is the set of all samples X for which
|Y,,| > ¢ for some suitably chosen constant c. We shall return to this example after
considering those factors that should be taken into account in the systematic selection
of a “good” rejection region.

O

B.4.1 Error Probabilities

There are two types of error that may be incurred in the application of a statistical
test:

* type I error is the rejection of Hy when it is true.

» type Il error is the acceptance of Hy when it is false.

For a given test (i.e., for a given rejection region R), the probabilities of error can both
be found from the power function of the test, defined as

Py(R), 0 €0,

where Py is the distribution of X when the true parameter value is . The probabilities
of a type I error are

a(0) = Pg(R), 0 € O,
and the probabilities of a type II error are
BO)=1—Ps(R), 0¢€6,.

It is not generally possible to find a test that simultaneously minimizes « (@) and 8(8)
for all values of their arguments. Instead, therefore, we seek to limit the probability of
type I error and then, subject to this constraint, to minimize the probability of type 11
error uniformly on ®;. Given a significance level o, an optimum level-« test is a test
satisfying

a(f) <a, forall § e ©,,

that minimizes B (@) for every # € ;. Such a test is called a uniformly most powerful
(U.ML.P.) test of level «. The quantity sup,., «(6) is called the size of the test.

In the special case of a simple hypothesis vs. a simple hypothesis, e.g., Hy: 8 =6,
vs. H;: =0, an optimal test based on the likelihood ratio statistic can be constructed
(see Silvey 1975). Unfortunately, it is usually not possible to find a uniformly most
powerful test of a simple hypothesis against a composite (more than one value of )
alternative. This problem can sometimes be solved by searching for uniformly most
powerful tests within the smaller classes of unbiased or invariant tests. For further
information see Lehmann (1986).

B.4.2 Large-Sample Tests Based on Confidence Regions

There is a natural link between the testing of a simple hypothesis Hy: § = 6
vs. Hi: @ # 6, and the construction of confidence regions. To illustrate this
connection, suppose that @ is an estimator of @ whose distribution is approximately
N(O, n~ ! (0)), where /() is a positive definite matrix. This is usually the case, for

example, when 0 is a maximum likelihood estimator and (0) is the Fisher information.
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As in Section B.3.1, we have
Py (n(0 — (3)/1(9) (0 — é) < Xffa(m)) ~1-—a.

Consequently, an approximate «-level test is to reject Hy if
n(00 — é)/l(é)(b‘o — é) > Xffa(m),

or equivalently, if the confidence region determined by those ’s satisfying
n(0 —0)'1(6)(6 — 0) < xi_,(m)

does not include 6.

Example B.4.2. Consider again the problem described in Example B.4.1. Since X, NN(,u, n_l), the
hypothesis Hy: i = 0 is rejected at level « if

=2
n (Xn) > X127a,1,
or equivalently, if

Di_gp
PRV

[Xa| >



Mean Square Convergence

C.1  The Cauchy Criterion

The sequence S, of random variables is said to converge in mean square to the random
variable S if
ES,— 85— 0 asn — oo.

In particular, we say that the sum ) ,;_, X, converges (in mean square) if there exists

a random variable S such that E (ZZ=1 X — S)2 — 0 as n — oo. If this is the case,
then we use the notation S = >~ | X;.

C.1 The Cauchy Criterion

Example C.1.1.

For a given sequence S, of random variables to converge in mean square to some
random variable, it is necessary and sufficient that

E(Sm—S,,)2—>O asm,n — o0

(for a proof of this see Brockwell and Davis (1991), Chapter 2). The point of the
criterion is that it permits checking for mean square convergence without having to
identify the limit of the sequence.

Consider the sequence of partial sums S, = Z:’z_n aZ,n=12,... where {Z;]} ~
WN (O, 02). Under what conditions on the coefficients a; does this sequence converge
in mean square? To answer this question we apply the Cauchy criterion as follows. For
n>m>0,
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Proof.

2

ES, - S =E| > az]| =0> ) 4.

m<l|i|<n m<l|i|<n
Consequently, E(S, — S,,)*> — 0Oif and only if ", _ ., a — 0. Since the Cauchy
criterion applies also to real-valued sequences, this last condition is equivalent to

convergence of the sequence Y 7 a?, or equivalently to the condition

i=—n ">

> af <oo. (C.1.1)

Properties of Mean Square Convergence:
If X, - Xand Y, — Y, in mean square as n — oo, then

(@ E(X;) — E(X?) ,
(b) EX,) — EX),
and

(c) EX,Y,) — EXY).

See Brockwell and Davis (1991), Proposition 2.1.2. |



Lévy Processes, Brownian
Motion and Itd Calculus

D.1  Lévy Processes

D.2  Brownian Motion and the [t6 Integral
D.3  Itd Processes and 1td’s Formula

D.4  It6 Stochastic Differential Equations

D.1 Lévy Processes

Definition D.1.1.

Just as ARMA processes were defined as stationary solutions of stochastic difference
equations driven by white noise, the so-called CARMA (continuous-time ARMA)
models arise as stationary solutions of stochastic differential equations driven by Lévy
processes. In order to discuss these equations in more detail we first present a few
essential facts concerning Lévy processes. (For detailed accounts see Protter 2010;
Applebaum 2004; Bertoin 1996; Sato 1999.) They have already been introduced in
Definition 7.5.1, but for ease of reference we repeat the definition here.

A Lévy process, {L(), t € R} is a process with the following properties:

(i) L) =0.
(i1) L(t) — L(s) has the same distribution as L(t — s) for all s and 7 such that s < 7.

(iii) If (s, #) and (u, v) are disjoint intervals then L(f) — L(s) and L(v) — L(u) are
independent.

(iv) {L(?)} is continuous in probability, i.e. for all ¢ > 0 and for all ¢ € R,
lirqP(|L(t) — L(s)| > €) =0.

© Springer International Publishing Switzerland 2016 375
PJ. Brockwell, R.A. Davis, Introduction to Time Series and Forecasting,
Springer Texts in Statistics, DOI 10.1007/978-3-319-29854-2



376

Appendix D Lévy Processes, Brownian Motion and It6 Calculus

It is known that every Lévy process has a version with sample-paths which are right
continuous with left limits (cadlag for short). We shall therefore assume that our Lévy
processes have this property.

The characteristic function of L(¢), ¢,(0) := E(exp(i@L(r))), has the celebrated
Lévy-Khinchin representation, for ¢t > 0,

#:(0) = exp(t6(0)), 0 € R,

where
. 15, i0x .
EO)=10u — 50 o+ | (" —1—10xI_1,1y(x))v(dx),
R

for some u € R, o0 > 0, and measure v. [_; j is the indicator function of the set
(—1, 1). The measure v is known as the Lévy measure of the process L and satisfies
the conditions

v({0}) =0

and
/min(l, lul?)v(du) < oo.
R

The triplet (o2, v, 1) is often referred to as the characteristic triplet of the Lévy process
and completely determines all of its finite-dimensional distributions.

The measure v characterizes the distribution of the jumps of the process. If, in
particular, v is the zero measure then the characteristic function of L(¢) for ¢t > 0, is
that of a normal random variable with E(L(f)) = ut and Var(L(¢¥)) = ot and the
process {L(¢),t € R} is Brownian motion (Example 7.5.1) with sample-paths which
are continuous (but nowhere differentiable).

If A := v(R) < oo then the expected number of jumps in any time-interval of
length ¢ is At and the expected number of jumps with size in (—oo, x] in the same
time interval is tv((—o00, x]) = AtF(x) where F is a probability distribution function.
The distribution function F is known as the jump-size distribution and X is known as
the mean jump-rate. If 6> = O and m = A f (71’1)xdF (x), then {L(#)} is a compound
Poisson process with parameters A and F' (Example 7.5.2) and with sample paths which
are constant except for jumps.

If A = oo then the expected number of jumps in every interval of positive length
is infinite and the process {L(#)} is said to have infinite activity. The gamma process
of Example 11.5.1 is such a process with characteristic triplet (0, v, a(1 — e~ #)/B),
where v is the measure defined on subsets of (0, co) by,

v(dx) = ocx_le_ﬁxl(o,oo) (x)dx.

The Lévy-Khinchin representation of the characteristic function of L(#) shows that
the distribution of L(¢) can, by appropriate choice of the characteristic triplet, be any
infinitely divisible distribution. This family includes a vast array of distributions such
as the normal distributions, compound Poisson distributions, Student’s t-distributions,
the stable distributions and many others. In particular it includes distributions which
have heavy tails and which are not necessarily symmetric. These features allow for
great flexibility when modelling observed phenomena in both financial and physical
contexts.

In this appendix we shall restrict attention to Lévy processes for which
EL(1)? < co. This constraint is not serious for most applications in finance where
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it is generally believed that second moments exist while higher moments (those of
order four or more) may not. For Lévy processes with EL(1)? < oo it follows from
the definition that there are finite constants m and s > O such that

EL(t) = mt and Var(L(r)) = s*t forall 7> 0.

In the following sections we shall focus on Brownian motion and stochastic
differential equations driven by Brownian motion.

In order to develop the necessary tools we introduce the It6 stochastic integral, 1t6
processes and Itd’s formula. Following this we shall outline some results concerning
the solution of stochastic differential equations and use them to expand on the
treatment of Gaussian CARMA processes and their Lévy-driven generalizations in
Section 11.5.

D.2 Brownian Motion and the It0 Integral

Robert Brown (1828) observed the erratic motion of pollen particles in a liquid which
was later explained by the irregular bombardment of the particles by the molecules of
the liquid. In order to provide a mathematical model for the one-dimensional version of
this process, Einstein (1905) postulated the existence of a process satisfying conditions
(i)—(iii) of Definition D.1.1 with L(#) normally distributed for every ¢. Bachelier (1900)
had in fact already proposed such a model for the prices of stocks on the Paris stock
exchange. It was later shown by Wiener that there is a process with continuous sample-
paths satisfying these conditions, a process which has come to be known as a Brownian
motion or Wiener process. It is in fact the only Lévy process with continuous sample-
paths, a feature which adds to its plausibility as a model for the physical process
originally observed by Brown. Although the sample-paths are continuous they are far
from smooth in the sense that they are nowhere differentiable. We shall not attempt to
prove these properties here but refer to the books of Mikosch (1998), Klebaner (2005)
and Oksendal (2013) for further details. In the following sections we shall give an
outline of the essentials of It6 calculus adapted from the more extensive treatment of
Dksendal.

For modelling more complex physical phenomena it is often appropriate to
suppose that the increment dX () of the observed process {X(#)} in the infinitesimally
small time interval (¢, r + dt) satisfies an equation of the form

dX(®) =b(t,X(t))dt +o(t, X(®)dB(t), S<t<T, (D.2.1)

where dB(t) denotes the increment of a standard Brownian motion in the same time
interval. In order to attach a precise meaning to (D.2.1) we first consider the following
discrete approximation. For any fixed positive integer n, consider the grid of time
points {27"k, k € Z} and define
27", fS<27k<T,
k=158, if 27" < S, (D.2.2)
T, it 27 > T.

A discrete approximation to (D.2.1) is then

X2 = X!+ b(h, X)AG + 0 (5, X AB;, [2'S] <j < [2'T], (D.2.3)
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where X' := X(1)), Atj := 11 — t;, and AB; := B(#;11) — B(#)). For given functions
b and o and for any given initial condition, Xlnzn 5] = X(S), and values of B(t)),j < k,
equation (D.2.3) can be solved recursively for X', j < k. The solution satisfies

X' =X+ Y bt XHAL+ Yot X)AB, [2'S] <j < [2'T].
k<j k<j

(D.2.4)

This suggests that, under suitable conditions, as n — 0o, the random variables
X!, [2"S] = j < [2"T]1+ 1, approximate (in a sense to be specified) a random process
{X(), S <t < T} satisfying

X(1) = X(S)—i—/ b(u,X(u))de—/ o(u, X(w)dBw), S<t<T, (D.2J5)
s s

In order to make sense of these statements, and to solve equations of the form
(D.2.5) we must first define what is meant by the integrals on the right-hand side. We
shall do this for non-anticipating integrands. The random process {X(¢)} is said to be
a non-anticipating function of {B(¢)} if, for each ¢, X () is a function of {B(s), s < t}.
This property is the continuous-time analogue of causality, which we introduced in
connection with ARMA processes in Chapter 3. We shall use the notation .%; to denote
the class of random variables on (€2, .%#, P) (the probability space on which {B(?)} is
defined) which are functions of {B(s), s < t}. In this terminology {X(#)} is a non-
anticipating function of {B(#)} if X(r) € %, for all 1.

To deal with the first integral in (D.2.5) we consider integrals of the form

T
/ m(u)du, S < T, (D.2.6)
S

for functions m on R x € belonging to the family . (S, T) defined by the properties
(i)—(iii) below. For clarity we have suppressed the dependence on w € Q2 in (D.2.5)
and (D.2.6), but in fact X and m are both functions on R x 2 with values X (i, w) and
m(u, w) respectively.

Defining properties of m € . (S, T):

(i) m(-, -) is a measurable function on R x .
(ii) m(t,-) € Z, foreacht e R.
(i) P[fST im(u, @)|du < oo] —1.

For m € .#(S,T) the integrals fSt m(u)du,t € [S,T], can be defined for all w
outside a set of probability zero as straightforward Lebesgue integrals, continuous
in z. Specifying them to be zero on the exceptional subset of €2 defines | St m(u)du, t €
[S, T, as a continuous function of ¢ for each w.

In order to attach a meaning to the second integral in (D.2.5) we need to define
integrals of the form

T
/ fwdB(u), S <T, (D.2.7)
S

where the random variables f (), defined on the same probability space (€2, .%, P) as
{B(1)}, satisfy the properties (i)—(iii) specified below. We shall denote the class of such
functions as .#'(S, T) and an integral of the form (D.2.7) as an Itd integral.
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Proposition D.2.1.

Proof.

Defining properties of f € /'(S, T):

(i) f(.,-) is a measurable function on R x .
(i) f(,-) € &, foreachr e R.

(i) E[ 5 f(t, 02t < o0

The construction of the integral (D.2.7) is achieved by defining it for elementary
functions and then extending the definition to all functions f € .4(S, T). The function
e is an elementary function if for some positive integer r,

o0

e, 0) = Y e@)orangrynW), ueR weQ, (D.2.8)

j=—00

where the random variables e; belong to .7, for all j and the times #; are defined as in
(D.2.2). Since the function e(u, w) is independent of u on the interval (2777, 27" (j+1)],
and since B increases on that interval by AB; := B(tj;1) — B(t)), it is natural to define
(suppressing w as in (D.2.7)),

T 00
Is.zr(e) = / ewdB(u) ==Y ¢AB;, S<T. (D.2.9)
S

j=—00

If e is bounded and elementary then

T
E (/ e(u)dB(u))
s

Observing that E(e;e;AB;AB;) = SUE(e]?)Atj, where §; = 1 if i = j and O otherwise,
we can rewrite the left-hand side of (D.2.10) as

[ 00 00 00 T
E Z Z (e,-ejABiABj) = Z E(ef)Atj =F Z elet] = Efg e([)2 dt.

i=—00 j=—00 Jj=—00 j=—00

2

T
=E ( / e(u)zdu) , S<T. (D.2.10)
S

Remark 1. The left-hand side of (D.2.10) is the squared norm of the random variable
Is 7(e) defined on (2, .#, P). The right-hand side is the squared norm of the function

e(u,w), if (u,w) e[S, T] x Q,

0, otherwise,

e’ (u, w) := {

a square integrable function on the product space [S, T] x 2 with respect to the product
measure £ x P, where £ denotes Lebesgue measure. The mapping e — I5 7(e) thus
determines an isometry from the restrictions e* of the bounded elementary functions
e to [S, T] x € into the space of square integrable random variables on (€2, .%, P).

It can be shown (see e.g., Oksendal 2013) that for every function f € A4(S, T)
there is a sequence of bounded elementary functions {e,} such that

T
E/ (e, (u) —f(u))zdu — 0asn — oo. (D.2.11)
s
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This implies that £ f ST(e,, (u) — e, (u))>du — 0 as m and n both go to co and, by the
isometry, that

E(s 1(en — en))* = E (Is r(en) — Isr(em))’ — 0.

By the Cauchy property of mean square convergence (Appendix C.1) it follows that
{Is r(e,)} has a mean square limit.
If {g,} is another sequence of bounded elementary functions with the property

(D.2.11) then EfST(e,,(u) — gu(u))?du — 0 as n — oo so that

E(Is.7((en — g2))* = E(Is.r(en) — Is.7(g1))* — O.

Hence the mean square limit of I 7(e,) is the same for all sequences of bounded
elementary functions satisfying (D.2.11) and the common limit is defined to be I 7 (f).
Thus Is 7(f) can be defined unambiguously as

Is7(f) := lim I 7(ey), (D.2.12)

where {e,} is any sequence of bounded elementary functions satisfying (D.2.11).
Moreover if f € A°(S, T) and {e,} satisfies (D.2.11), then

T T
E(Isr()?) = lim E (Is r(e,)?) = lim E / ex(u)du = E / f*(wydu,
n—oo n—oo S S

showing that the isometry of the restrictions ¢* of bounded elementary functions
extends to the corresponding restrictions f* of all functions in A4 (S, T).
This means that, in principle, Is 7(f) can be evaluated as the mean-square limit

of f ST X, (u)dB(u) where {x,} is any (not necessarily bounded) sequence of elementary

functions such that £ fST(xn(u) — f(u))’du — 0 as n — oo. In particular it can be
shown in this way that

T
/ B(u)dB(u) = l(192(T) — B%(S)) — l(T —9).
S 2 2

We shall not go into the details as we shall derive this result in a much simpler way
using the tools of Itd calculus to be discussed in the following section. U

Remark 2. If f € _A4(S,T) then for each ¢t € [S,T] so also is the function,
{f(w, s qg(m), w € 2, u € R}, where 15 , is the indicator function of the set [S, 7].
This enables us to define

t T
/S FdB(u) = /5 F) s, )i

foreacht € [S, T] and each f € A4 (S, T). O

Remark 3. If f € A4 :=NA(S, T), where N denotes the intersection over all S € R
and T € R such that § < T, then I ,(f) is defined for all real-valued s and ¢ such that
s < t and the integral has the properties,

(i) EL.(f) =0.

(ii) Is,u(f) = x,t(f) +It,u(f)v s <1t=u
(iii) L, (af + bg) = al,,(f) + bl;,(g) foralla,b € Rand ge .4 .
(v) E[L,(OL. ()] = E [ fuw)g(u)du forall g e A
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(v) Foreach fixed s € R, {I;,(f), t > s} is an .%,-martingale, i.e. E|I; ,(f)] < oo and
E(Is,u(f”B(Y)vy = t) - Is,t(f)a u=t=s.

(vi) For each fixed s € R and for each fixed T > s there is a version of {/;,(f), s <
t < T} which is continuous in ¢. In other words there is a process {X;, s <t < T}
with continuous sample-paths such that

PX, = / f(w)dB(uw)) = 1forallt e [s, T].

Properties (i)-(iv) are clearly true for bounded elementary functions f and g. Their
validity for functions in .#" can be established by taking limits. Property (v) follows
from (ii) and the independence of the increments of {B()}. The proof of property (vi)
is beyond the scope of this book [see, e.g., Oksendal (2013) for details]. U

D.3 1to Processes and 1to’s Formula

Direct evaluation of It6 stochastic integrals from the definition (D.2.12) is very messy.
For example, it can be shown by a lengthy calculation from the definition that

d 1,
/0 BdB(w) = -B®° — 1.

1t6’s formula provides a chain rule for evaluating such integrals. It is clear from this
example that the classic rule for Riemann integration does not apply. If, for example,
we apply it in this particular case we find, from the rule d(x*) = 2xdx, that the integral
is %B (#)? instead of the correct expression above. Before we can derive the appropriate
rule however we first need to define what is meant by an It6 process.

1t6 Process

This is a process which satisfies (suppressing the argument w as before)

t t
X)) =X(@s) + / m(u)du + / fw)dB(u), s <t eR, (D.3.1)
where
X() € F forallt € R, (D.3.2)
me #(S,T)forall S <TeR (D.3.3)
and
feN* S, T)forall S <T e R, (D.3.4)

with .# (S, T) defined as in Section E.2 and A4*(S,T) defined like A4'(S,T) in
Section E.2 except for the replacement of property (iii), E [ /. ST f (u)zdu] < 00, by
the weaker condition,

(i) P[fy f00?du < 00] = 1.
It can be shown that, under this weaker condition, the integrals I, ,(f), s < t € R,

can still be defined, retaining all of the properties in Remark 3 of Section E.2 with the
exception of the martingale property (v).
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Example D.3.1.

Definition (D.3.1) is often written in the shorthand notation,
dX(t) = m(t) dt + f(t) dB(?). (D.3.5)

Both of the integrals in (D.3.1) are assumed to be continuous versions so that the Itd
process {X(¢)} is also continuous. The first integral is usually referred to as the drift
component of {X(#)} and the second as the Brownian component.

It6’s Formula

Itd’s formula is concerned with smooth functions of 1td processes. Specifically it
states that if {X(¢)} is an Itd process satisfying (D.3.5) and {g(¢, x)} is a function on
R x R with continuous partial derivatives dg/dt and d%g/dx> then

(1) Y() := gt X(¢)) is an Itd process and
(ii)
2

dy () = %(t, X)) dt + a—g(l‘, X() dX(r) + EB(t, X(1) (dX(t))z,
ot x 2 9x2

(D.3.6)
where dX(f) = m dt + f dB(t) and (dX(1))* = f? dt.

Writing g;, g, and g,, for the corresponding partial derivatives of g evaluated at
(¢, X(1)), and substituting for dX(¢) and dX()?> as indicated in (ii), we can write the
increment of Y (#) explicitly in the form (D.3.5) as

1
dy(t) = (g +mg, + 5v%gﬂ) dt + fg. dB(?). (D.3.7)

[y Bu)dB(u)

Inspection of (D.3.7) suggests that in order to find a process with increments B(u)dB (u)
we should start with the It6 process X () = B(¢), for whichm = O and f = 1, and define
Y(t) = g(t, X(t)) where g.(t, x) = x. Taking g(t, x) = x?/2 we obtain, from (D.3.7),

dY (1) = % dt + B(t)dB(?),

which gives

/IB( )dB()—Y(t)—Y(O)—lt—lB(t)z—lt
, wanti = 2’732 2"

O
Multivariate Ito Processes
An n-dimensional It6 process {X(¢)} is defined to be an n-dimensional vector-valued
process satisfying an equation (cf. (D.3.5),

dX(t) = m(r) dt + F(¢) dB(1), (D.3.8)

where {B(7)} is m-dimensional standard Brownian motion, i.e. an m-dimensional
random process with components which are independent one-dimensional standard
Brownian motions, the components of the n-vectors X(¢) and m() satisfy (D.3.2) and
(D.3.3) respectively, and each component fj; of the n x m matrix F'(¢) satisfies (D.3.4).
The more explicit form of (D.3.8), corresponding to (D.3.1), is

X() = X(s) + / m(u) du + / F(u) dB(u), s <teR. (D.3.9)

N
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The Multidimensional It6 Formula

The multidimensional version of It6’s formula states that if {X(¢)} is an n-dimensional
It process satisfying (D.3.9) and {g(¢, x)} is a function on R x R” with values in R?
and with continuous second partial derivatives, then

(1) {Y(@®) := g(t, X(?)) is a p-dimensional Itd process and
(ii)

dY(t)——dt—i—Z—dX(t)-l— ZZ‘

j=1 k=1 /

dX (0dX, (1),

(D.3.10)

where X;, Y; and g; are the components of X, Y and g respectively, and the partial
derivatives of g are all evaluated at (7, X(7)). The increments dX; satisfy the relations
dX;(t) = m;dt+Y__, fir dB,(t) and dX;(t)dXy (1) = > __ lf,,fk, dt, where m; and f;;
are the components of m(¢) and F(r) respectively.

In the following section we shall consider solutions of stochastic differential
equations of the form

dX(@®) =bt, X)) dt +o(t, X(®) dB(), S<t<T, Xg=72, (D.3.11)

where {B()} is m-dimensional standard Brownian motion. Conditions on the functions
b and o and the initial random variable Z which guarantee existence and uniqueness
of solutions will be specified in Theorem D.4.1, a proof of which can be found in
Oksendal (2013).

D.4 Ito6 Stochastic Differential Equations

The equation (D.3.11) is known as an It6 stochastic differential equation for the R"-
valued random process {X(#)}. Equations (7.5.6), for geometric Brownian motion,
(11.5.2), for the CAR(1) process, and (11.5.9), for the state vector of a CARMA
process, are special cases. It is trivial to check, in each of these cases, that the conditions
on b and o given in the following theorem are satisfied forall Sand 7 € Rwith T > S.
Provided the conditions on the initial random vector Z are satisfied, these guarantee
the existence and uniqueness of a continuous solution of (D.3.11). After stating the
theorem we shall use 1t6’s formula to derive solutions of the particular Itd equations
(7.5.6) and (11.5.9). The solution of (11.5.2) was discussed in Section 11.5.1.

Theorem D.4.1. Suppose that S < T € R and that the measurable functions b :
[S,TIxR"+— R"and o : [S,T] x R" = R" x R™ in (D.3.11) have the properties
[b(t, x)| + |o(t,x)| < C(1 + |x]), xe R", t €[S, T]
and
|b(t,x = b(t,y)| + |o(t,x —o(t,y)| < DIx—yl,

where C and D are finite positive constants and |M| denotes the (positive) square root
of the sum of squares of the components of the matrix or vector M. If Z is a random
variable independent of {B(t) — B(s), S < s < t < T} such that E|Z|> < oo, then the
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stochastic differential equation (D.3.11) has a unique continuous (in t) solution, each
component of which belongs to NV *[S, T] as defined in (D.3.4).

Geometric Brownian Motion

Geometric Brownian motion was introduced in Section 7.5.2 as a continuous-time
model for asset prices and was the basis for the derivations by Black and Scholes
(1973) and Merton (1973) of the option-pricing formula discussed in Section 7.6. Here
we shall use Itd’s formula to find the solution {P(¢), ¢t > 0} of the defining differential
equation,

dP(t) = P(t)[udt + odB(1)], t = 0, (D.4.1)

where P(0) is a strictly positive random variable, independent of {B(¢#) — B(s),0 <
s <t < oo}. The standard calculus identity, d(log(y)) = dy/y, suggests that we try
applying It6’s formula with X(¢) = P(r) and g(x, ) = log(x). The function g has
continuous partial derivatives, dg/dt = 0, 3g/dx = 1/x and 3%g/dx> = —1/x* on the
set where x > 0. Substituting in (D.3.6) and using (D.4.1) we obtain ]

2

I I
dllog P(1) = 5 dP() = 5o 5 (@P(O)* = pdt + o dB(E) - "7 dr,

(D.4.2)

whence

2
log(P(1)) — log(P(0)) = (u — %)t+ o B(1).

This is equivalent to the solution (7.5.7) given earlier.

Gaussian CARMA Processes
The state equation (11.5.9) for the Gaussian CARMA(p, q) process, i.e.

dX(t) = AX(t)dt + edB(1), (D.4.3)

where X(0) is independent of {B(f) —B(s), 0 < s < t < T}and E|X(0)|*> < oo, clearly
satisfies the conditions of Theorem D.4.1 and therefore has a unique solution which is
continuous in ¢. In order to find the solution we multiply both sides by the integrating
factor e, as we would if {B(f)} were deterministic. Since e~ is non-singular the
state equation is equivalent to the equation

e MdX(t) — e MAX(r)dt = e VedB(r). (D.4.4)

This form of the equation suggests applying the multivariate 1t6 formula with g(¢, x) =
e~Ax. The second derivatives of g are all continuous and satisfy

92%g;
& _ 0 for all i, j and k,

9202

0gi

28 = e;e_A’ 7D

ij

and
g

— = —e;Ae*Atx.
ot
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where e, r € {l,...,p}, denotes a p-component column vector, all of whose
components are zero except for the rth, which is one. Substituting these derivatives
into (D.3.10) and writing the resulting equations in vector form we obtain

d(e™X (1) = —Ae "X (t)dt + e 'dX(1).
Substituting this expression in (D.4.4) gives
d(e™X(1) = e dB(t),

which implies that
e MX(1) — X(0) = /O te*A“edB(u),
or equivalently
X(t) = e"X(0) + /0 teA(’_“)edB(u), 0<r=<T. (D.4.5)
Since equation (D.4.1), with X(S) independent of {B(¢) — B(s),S <s <t < T}

and E|X(S)|> < oo, satisfies the conditions of Theorem D.4.1 forall S € Rand T € R
such that § < T, exactly the same arguments give the more general relation,

13
X(1) = AYX(S) + / e dB(u), t > S, forall S € R. (D.4.6)
S

This is equation (11.5.11) for which we showed (in Section 11.5.2) that the unique
causal stationary solution is

X(r) = / Ae dB(u), t € R.

This led, with (11.5.8), to the definition of the zero-mean causal CARMA (p, g) process
{Y(®),t € R} as

Y(t) = / b’ ""e dB(u)

]

and, more generally in Section 11.5.3, to the second-order Lévy-driven CARMA (p, q)
process,

Y() = / b e dL(u).
(—00,1]
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extras.springer.com and locate the extras for this book either by entering the ISBN
number or by choosing the year 2016. Choose the option Download Entire Contents
and you will receive a zip file containing ITSM.EXE, the data files, an introduction
called README.PDF and a searchable document of Help files, ITSM_HELP.PDF.
For a quick and easy introduction to the use of the package we recommend following
the instructions in README.PDF. For detailed help on each of the functions of the
program refer to ITSM_HELP.PDF. Under older Windows operating systems the Help
files can be accessed from the Help menu within ITSM itself, but this feature is not
yet supported by all versions of Windows so you may need to open ITSM_HELP.PDF
in a separate window while running the program.

When you unzip the downloaded zip file it will create a folder called ITSM2000
which contains all the necessary files for running the program. Double-click on the
ITSM icon or the ITSM-Shortcut icon to open the ITSM window. (You may wish
to copy and paste the ITSM-Shortcut icon to the desktop or some other convenient
location from which it can also be accessed.). The package ITSM2000 supersedes the
versions of the package ITSM2000 distributed with earlier editions of this book.
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E.1 Getting Started

E.1.1 Running ITSM

Double-clicking on the ITSM or the ITSM-Shortcut icon will open the ITSM window.
To analyze one of the data sets provided, select File>Project>Open at the top
left corner of the ITSM window.

There are several distinct functions of the program ITSM. The first is to analyze
and display the properties of time series data, the second is to compute and display the
properties of time series models, and the third is to combine these functions in order to
fit models to data. The last of these includes checking that the properties of the fitted
model match those of the data in a suitable sense. Having found an appropriate model,
we can (for example) then use it in conjunction with the data to forecast future values
of the series. Sections E.2—E.5 of this appendix deal with the modeling and analysis of
data, while Section E.6 is concerned with model properties. Section E.7 explains how
to open multivariate projects in ITSM. Examples of the analysis of multivariate time
series are given in Chapter 8.

It is important to keep in mind the distinction between data and model properties
and not to confuse the data with the model. In any one project ITSM stores one data
set and one model (which can be identified by highlighting the project window and
pressing the red INFO button at the top of the ITSM window). Until a model is entered
by the user, ITSM stores the default model of white noise with variance 1. If the data are
transformed (e.g., differenced and mean-corrected), then the data are replaced in [TSM
by the transformed data. (The original data can, however, be restored by inverting the
transformations.) Rarely (if ever) is a real time series generated by a model as simple
as those used for fitting purposes. In model fitting the objective is to develop a model
that mimics important features of the data, but is still simple enough to be used with
relative ease.

The following sections constitute a tutorial that illustrates the use of some of the
features of ITSM by leading you through a complete analysis of the well-known airline
passenger series of Box and Jenkins (1976) filed as AIRPASS.TSM in the ITSM2000
folder.

E.2 Preparing Your Data for Modeling

Example E.2.1.

The observed values of your time series should be available in a single-column ASCII
file (or two columns for a bivariate series). The file, like those provided with the
package, should be given a name with suffix .TSM. You can then begin model
fitting with ITSM. The program will read your data from the file, plot it on the
screen, compute sample statistics, and allow you to make a number of transformations
designed to make your transformed data representable as a realization of a zero-mean
stationary process.

To illustrate the analysis we shall use the file AIRPASS.TSM, which contains the
number of international airline passengers (in thousands) for each month from January,
1949, through December, 1960.

0
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Example E.2.2.

Example E.2.3.

E.2.1 Entering Data

Once you have opened the ITSM window as described above under Getting Started,
select the options File>Project >Open,and you will see a dialog box in which you
can check either Univariate or Multivariate. Since the data set for this
example is univariate, make sure that the univariate option is checked and then click
OK. A window labeled Open File will then appear, in which you can either type
the name AIRPASS.TSM and click Open, or else locate the icon for AIRPASS. TSM
in the Open File window and double-click on it. You will then see a graph of the

monthly international airline passenger totals (measured in thousands) Xi, ..., X,
with n = 144. Directly behind the graph is a window containing data summary
statistics.

An additional, second, project can be opened by repeating the procedure described
in the preceding paragraph. Alternatively, the data can be replaced in the cur-
rent project using the option File>Import File. This option is useful if you
wish to examine how well a fitted model represents a different data set. (See the
entry ProjectEditorinthe ITSM_HELP Files for information on multiple project
management. Each ITSM project has its own data set and model.) For the purpose of
this introduction we shall open only one project.

E.2.2 Information

If, with the window labeled AIRPASS.TSM highlighted, you press the red INFO
button at the top of the ITSM window, you will see the sample mean, sample variance,
estimated standard deviation of the sample mean, and the current model (white noise
with variance 1).

Go through the steps in Entering Data to open the project AIRPASS.TSM and use the

INFO button to determine the sample mean and variance of the series.
0

E.2.3 Filing Data

You may wish to transform your data using ITSM and then store it in another file. At
any time before or after transforming the data in ITSM, the data can be exported to
a file by clicking on the red Export button, selecting Time Series and File,
clicking OK, and specifying a new file name. The numerical values of the series can
also be pasted to the clipboard (and from there into another document) in the same way
by choosing Clipboardinstead of File. Other quantities computed by the program
(e.g., the residuals from the current model) can be filed or pasted to the clipboard in
the same way by making the appropriate selection in the Export dialog box. Graphs
can also be pasted to the clipboard by right-clicking on them and selecting Copy to
Clipboard.

Copy the series AIRPASS.TSM to the clipboard, open Wordpad or some convenient
screen editor, and choose Edit >Paste to insert the series into your new document.
Then copy the graph of the series to the clipboard and insert it into your document in

the same way.
g
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Example E.2.4.

Example E.2.5.

E.2.4 Plotting Data

A time series graph is automatically plotted when you open a data file (with time
measured in units of the interval between observations, i.e., r = 1,2,3,...). To see
a histogram of the data press the rightmost yellow button at the top of the ITSM
screen. If you wish to adjust the number of bins in the histogram, select
Statistics>Histogram>Set Bin Count and specify the number of bins
required. The histogram will then be replotted accordingly.

To insert any of the ITSM graphs into a text document, right-click on the graph
concerned, select Copy to Clipboard, and the graph will be copied to the
clipboard. It can then be pasted into a document opened by any standard text editor
such as MS-Word or Wordpad using the Edit >Paste option in the screen editor. The
graph can also be sent directly to a printer by right-clicking on the graph and selecting
Print. Another useful graphics feature is provided by the white Zoom buttons at the
top of the ITSM screen. The first and second of these enable you to enlarge a designated
segment or box, respectively, of any of the graphs. The third button restores the original
graph.

Continuing with our analysis of AIRPASS.TSM, press the yellow histogram button
to see a histogram of the data. Replot the histogram with 20 bins by selecting
Statistics>Histogram>Set Bin Count.

O

E.2.5 Transforming Data

Transformations are applied in order to produce data that can be successfully modeled
as “stationary time series.” In particular, they are used to eliminate trend and cyclic
components and to achieve approximate constancy of level and variability with time.

The airline passenger data (see Figure 10-4) are clearly not stationary. The level and
variability both increase with time, and there appears to be a large seasonal component
(with period 12). They must therefore be transformed in order to be represented as
a realization of a stationary time series using one or more of the transformations
available for this purpose in ITSM.

O

Box—Cox Transformations

Box—Cox transformations are performed by selecting Transform>Box-Cox and
specifying the value of the Box—Cox parameter A. If the original observations are
Yy, Y, ..., 7Y,, the Box—Cox transformation f; converts them to f; (Yy),f.(Y2), ...,
£.(Y,,), where

y -1 A0
LHO) = A ’
log(y), A=0.

These transformations are useful when the variability of the data increases or
decreases with the level. By suitable choice of A, the variability can often be made
nearly constant. In particular, for positive data whose standard deviation increases
linearly with level, the variability can be stabilized by choosing A = 0.

The choice of A can be made visually by watching the graph of the data when
you click on the pointer in the Box—Cox dialog box and drag it back and forth along
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Figure E-1
The series AIRPASS.TSM
after taking logs

the scale, which runs from zero to 1.5. Very often it is found that no transformation is
needed or that the choice A = 0 is satisfactory.

For the series AIRPASS.TSM, the variability increases with level, and the data are
strictly positive. Taking natural logarithms (i.e., choosing a Box—Cox transformation
with A = 0) gives the transformed data shown in Figure E-1.

Notice how the amplitude of the fluctuations no longer increases with the level of
the data. However, the seasonal effect remains, as does the upward trend. These will
be removed shortly. The data stored in ITSM now consist of the natural logarithms of
the original data.

g

Classical Decomposition
There are two methods provided in ITSM for the elimination of trend and seasonality.
These are:

i. “classical decomposition” of the series into a trend component, a seasonal com-
ponent, and a random residual component, and

ii. differencing.

Classical decomposition of the series {X;} is based on the model

6.5

6.0
T

I I I I I I I I I I I I I
1949 1951 1953 1955 1957 1959 1961

X =m; +s; + Yy,

where X, is the observation at time ¢, m; is a “trend component,”’ s; is a “seasonal
component,” and Y, is a “random noise component,” which is stationary with mean
zero. The objective is to estimate the components m, and s, and subtract them from the
data to generate a sequence of residuals (or estimated noise) that can then be modeled
as a stationary time series.

To achieve this, select Transform>Clasgsical and you will see the Classical
Decomposition dialog box. To remove a seasonal component and trend, check the
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Figure E-2

The logged AIRPASS.TSM

series after removal of trend
and seasonal components

by classical decomposition

Example E.2.7.
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Seasonal Fit and Polynomial Fit boxes, enter the period of the seasonal
component, and choose between the alternatives Quadratic Trendand Linear
Trend. Click OK, and the trend and seasonal components will be estimated and
removed from the data, leaving the estimated noise sequence stored as the current
data set.

The estimated noise sequence automatically replaces the previous data stored in
ITSM.

The logged airline passenger data have an apparent seasonal component of period
12 (corresponding to the month of the year) and an approximately quadratic trend.
Remove these using the option Transform>Classical as described above. (An
alternative approach is to use the option Regression, which allows the specification
and fitting of polynomials of degree up to 10 and a linear combination of up to 4 sine
waves.)

Figure E-2 shows the transformed data (or residuals) Y;, obtained by removal of
trend and seasonality from the logged AIRPASS.TSM series by classical decomposi-
tion. {Y;} shows no obvious deviations from stationarity, and it would now be reason-
able to attempt to fit a stationary time series model to this series. To see how well the
estimated seasonal and trend components fit the data, select Transform>Show
Classical Fit. We shall not pursue this approach any further here, but turn
instead to the differencing approach. (You should have no difficulty in later returning
to this point and completing the classical decomposition analysis by fitting a stationary

time series model to {Y;}.)
O

Ditferencing

Differencing is a technique that can also be used to remove seasonal components and
trends. The idea is simply to consider the differences between pairs of observations
with appropriate time separations. For example, to remove a seasonal component of
period 12 from the series {X,}, we generate the transformed series
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Figure E-3

The series AIRPASS.TSM
after taking logs

and differencing

atlags 12 and 1

Yi=X, —X_12.

It is clear that all seasonal components of period 12 are eliminated by this trans-
formation, which is called differencing at lag 12. A linear trend can be eliminated
by differencing at lag 1, and a quadratic trend by differencing twice at lag 1 (i.e.,
differencing once to get a new series, then differencing the new series to get a second
new series). Higher-order polynomials can be eliminated analogously. It is worth
noting that differencing at lag 12 eliminates not only seasonal components with period
12 but also any linear trend.

Data are differenced in ITSM by selecting TransformsDifference
and entering the required lag in the resulting dialog box.

Restore the original airline passenger data using the option File>Import File
and selecting AIRPASS.TSM. We take natural logarithms as in Example E.2.6
by selecting Transforms>Box-Cox and setting A = 0. The transformed
series can now be deseasonalized by differencing at lag 12. To do this select
TransformsDifference, enter the lag 12 in the dialog box, and click OK.
Inspection of the graph of the deseasonalized series suggests a further differencing at
lag 1 to eliminate the remaining trend. To do this, repeat the previous step with lag
equal to 1 and you will see the transformed and twice-differenced series shown in
Figure E-3.

O

Subtracting the Mean

The term ARMA model is used in ITSM to denote a zero-mean ARMA process (see
Definition 3.1.1). To fit such a model to data, the sample mean of the data should
therefore be small. Once the apparent deviations from stationarity of the data have been
removed, we therefore (in most cases) subtract the sample mean of the transformed
data from each observation to generate a series to which we then fit a zero-mean
stationary model. Effectively we are estimating the mean of the model by the sample
mean, then fitting a (zero-mean) ARMA model to the “mean-corrected” transformed
data. If we know a priori that the observations are from a process with zero mean, then
this process of mean correction is omitted. ITSM keeps track of all the transformations

0.15
T

0.05
T

0.0

-0.05

-0.10

1949 1951 1953 1955 1957 1959 1961

-0.15
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(including mean correction) that are made. When it comes time to predict the original
series, ITSM will invert all these transformations automatically.

Subtract the mean of the transformed and twice-differenced series AIRPASS.TSM by
selecting Transform>Subtract Mean. To check the current model status press
the red INFO button, and you will see that the current model is white noise with

variance 1, since no model has yet been entered.
0

E.3 Finding a Model for Your Data

After transforming the data (if necessary) as described above, we are now in a position
to fit an ARMA model. ITSM uses a variety of tools to guide us in the search
for an appropriate model. These include the sample ACF (autocorrelation function),
the sample PACF (partial autocorrelation function), and the AICC statistic, a bias-
corrected form of Akaike’s AIC statistic (see Section 5.5.2).

E.3.1 Autofit

Before discussing the considerations that go into the selection, fitting, and checking of
a stationary time series model, we first briefly describe an automatic feature of ITSM
that searches through ARMA(p, ¢) models with p and g between specified limits (less
than or equal to 27) and returns the model with smallest AICC value (see Sections 5.5.2
and E.3.5). Once the data set is judged to be representable by a stationary model,
select Model>Estimation>Autofit. A dialog box will appear in which you
must specify the upper and lower limits for p and ¢. Since the number of maximum
likelihood models to be fitted is the product of the number of p-values and the number
of g-values, these ranges should not be chosen to be larger than necessary. Once the
limits have been specified, press Start, and the search will begin. You can watch the
progress of the search in the dialog box that continually updates the values of p and
g and the best model found so far. This option does not consider models in which the
coefficients are required to satisfy constraints (other than causality) and consequently
does not always lead to the optimal representation of the data. However, like the tools
described below, it provides valuable information on which to base the selection of an
appropriate model.

E.3.2 The Sample ACF and PACF

Pressing the second yellow button at the top of the ITSM window will produce graphs
of the sample ACF and PACF for values of the lag /& from 1 up to 40. For higher
lags choose Statistics>ACF/PACF>Specify Lag, enter the maximum lag
required, and click OK. Pressing the second yellow button repeatedly then rotates
the display through ACF, PACEF, and side-by-side graphs of both. Values of the ACF
that decay rapidly as & increases indicate short-term dependency in the time series,
while slowly decaying values indicate long-term dependency. For ARMA fitting it
is desirable to have a sample ACF that decays fairly rapidly. A sample ACF that is
positive and very slowly decaying suggests that the data may have a trend. A sample
ACF with very slowly damped periodicity suggests the presence of a periodic seasonal
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Figure E-4

The sample ACF

of the transformed AIRPASS.
TSM series

component. In either of these two cases you may need to transform your data before
continuing.

As a rule of thumb, the sample ACF and PACF are good estimates of the ACF and
PACEF of a stationary process for lags up to about a third of the sample size. It is clear
from the definition of the sample ACF, 5 (h), that it will be a very poor estimator of
p (h) for h close to the sample size n.

The horizontal lines on the graphs of the sample ACF and PACF are the bounds
+1.96/,/n. If the data constitute a large sample from an independent white noise
sequence, approximately 95 % of the sample autocorrelations should lie between
these bounds. Large or frequent excursions from the bounds suggest that we need a
model to explain the dependence and sometimes to suggest the kind of model we need
(see below). To obtain numerical values of the sample ACF and PACEF, right-click on
the graphs and select Info.

The graphs of the sample ACF and PACF sometimes suggest an appropriate
ARMA model for the data. As a rough guide, if the sample ACF falls between the
plotted bounds +1.96/,/n for lags h > ¢, then an MA(q) model is suggested, while if
the sample PACF falls between the plotted bounds +1.96/./n for lags & > p, then an
AR(p) model is suggested.

If neither the sample ACF nor PACF “cuts off” as in the previous paragraph, a
more refined model selection technique is required (see the discussion of the AICC
statistic in Section 5.5.2). Even if the sample ACF or PACF does cut off at some lag,
it is still advisable to explore models other than those suggested by the sample ACF
and PACEF values.

Figure E-4 shows the sample ACF of the AIRPASS.TSM series after taking logarithms,
differencing at lags 12 and 1, and subtracting the mean. Figure E-5 shows the
corresponding sample PACF. These graphs suggest that we consider an MA model
of order 12 (or perhaps 23) with a large number of zero coefficients, or alternatively
an AR model of order 12.
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Figure E-5

The sample PACF

of the transformed AIRPASS.
TSM series
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E.3.3 Entering a Model

A major function of ITSM is to find an ARMA model whose properties reflect to
a high degree those of an observed (and possibly transformed) time series. Any
particular causal ARMA(p, g) model with p < 27 and ¢ < 27 can be entered
directly by choosing Model>Specify, entering the values of p, g, the coeffi-
cients, and the white noise variance, and clicking OK. If there is a data set already
open in ITSM, a quick way of entering a reasonably appropriate model is to use
the option Model>Estimation>Preliminary, which estimates the coefficients
and white noise variance of an ARMA model after you have specified the orders p and
g and selected one of the four preliminary estimation algorithms available. An optimal
preliminary AR model can also be fitted by checking Find AR model with min
AICC in the Preliminary Estimation dialog box. If no model is entered or
estimated, ITSM assumes the default ARMA(0,0), or white noise, model

Xl‘ = Zlv

where {Z,} is an uncorrelated sequence of random variables with mean zero and
variance 1.

If you have data and no particular ARMA model in mind, it is advisable to use
the option Model>Estimation>Preliminary or equivalently to press the blue
PRE button at the top of the ITSM window.

Sometimes you may wish to try a model found in a previous session or a
model suggested by someone else. In that case choose Model>Specify and enter
the required model. You can save both the model and data from any project by selecting
File>Project>Save as and specifying the name for the new file. When the new
file is opened, both the model and the data will be imported. To create a project with
this model and a new data set select File>Import File and enter the name of
the file containing the new data. (This file must contain data only. If it also contains
a model, then the model will be imported with the data and the model previously in
ITSM will be overwritten.)
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E.3.4 Preliminary Estimation

The option Model>Estimation>Preliminary contains fast (but not the most
efficient) model-fitting algorithms. They are useful for suggesting the most promising
models for the data, but should be followed by maximum likelihood estimation
using Model>Estimation>Max likelihood. The fitted preliminary model is
generally used as an initial approximation with which to start the nonlinear optimiza-
tion carried out in the course of maximizing the (Gaussian) likelihood.

To fit an ARMA model of specified order, first enter the values of p and g (see Sec-
tion 2.6.1). For pure AR models ¢ = 0, and the preliminary estimation option offers a
choice between the Burg and Yule—Walker estimates. (The Burg estimates frequently
give higher values of the Gaussian likelihood than the Yule—Walker estimates.) If g =
0, you can also check the box Find AR model with min AICC to allow the
program to fit AR models of orders 0, 1, ..., 27 and select the one with smallest AICC
value (Section 5.5.2). For models with g > 0, ITSM provides a choice between two
preliminary estimation methods, one based on the Hannan—Rissanen procedure and
the other on the innovations algorithm. If you choose the innovations option, a default
value of m will be displayed on the screen. This parameter was defined in Section 5.1.3.
The standard choice is the default value computed by ITSM. The Hannan—Rissanen
algorithm is recommended when p and g are both greater than 0, since it tends
to give causal models more frequently than the innovations method. The latter is
recommended when p = 0.

Once the required entries in the Preliminary Estimation dialog box have been
completed, click OK, and ITSM will quickly estimate the parameters of the selected
model and display a number of diagnostic statistics. (If p and g are both greater than
0, it is possible that the fitted model may be noncausal, in which case ITSM sets
all the coefficients to .001 to ensure the causality required for subsequent maximum
likelihood estimation. It will also give you the option of fitting a model of different
order.)

Provided that the fitted model is causal, the estimated parameters are given with
the ratio of each estimate to 1.96 times its standard error. The denominator (1.96 x
standard error) is the critical value (at level .05) for the coefficient. Thus, if the ratio is
greater than 1 in absolute value, we may conclude (at level .05) that the corresponding
coefficient is different from zero. On the other hand, a ratio less than 1 in absolute
value suggests the possibility that the corresponding coefficient in the model may be
zero. (If the innovations option is chosen, the ratios of estimates to 1.96 x standard
error are displayed only when p = g or p = 0.) In the Preliminary Estimates window
you will also see one or more estimates of the white noise variance (the residual
sum of squares divided by the sample size is the estimate retained by ITSM) and
some further diagnostic statistics. These are —2In L( (Aﬁ, é, 82), where L denotes the
Gaussian likelihood (5.2.9), and the AICC statistic

—2InL+2(p+q+Dn/n—p—qg—2)

(see Section 5.5.2).

Our eventual aim is to find a model with as small an AICC value as possible. Small-
ness of the AICC value computed in the preliminary estimation phase is indicative of a
good model, but should be used only as a rough guide. Final decisions between models
should be based on maximum likelihood estimation, carried out using the option
Model>Estimation>Max likelihood, since for fixed p and g, the values of
¢, 0, and o? that minimize the AICC statistic are the maximum likelihood estimates,
not the preliminary estimates. After completing preliminary estimation, ITSM stores



398

Appendix E An ITSM Tutorial

Example E.3.2.

the estimated model coefficients and white noise variance. The stored estimate of the
white noise variance is the sum of squares of the residuals (or one-step prediction
errors) divided by the number of observations.

A variety of models should be explored using the preliminary estimation algo-
rithms, with a view to finding the most likely candidates for minimizing AICC when
the parameters are reestimated by maximum likelihood.

To find the minimum-AICC Burg AR model for the logged, differenced, and mean-
corrected series AIRPASS.TSM currently stored in ITSM, press the blue PRE button,
set the MA order equal to zero, select Burg and Find AR model with min
AICC, and then click OK. The minimum-AICC AR model is of order 12 with an AICC
value of —458.13. To fit a preliminary MA(25) model to the same data, press the blue
PRE button again, but this time set the AR order to 0, the MA order to 25, select
Innovations, and click OK.

The ratios (estimated coefficient)/(1.96 x standard error) indicate that the coeffi-
cients at lags 1 and 12 are nonzero, as suggested by the sample ACF. The estimated
coefficients at lags 3 and 23 also look substantial even though the corresponding ratios
are less than 1 in absolute value. The displayed values are as follows:

MA COEFFICIENTS

—0.3568 0.0673 —-0.1629 —0.0415 0.1268

0.0264 0.0283 —0.0648 0.1326 —-0.0762
—0.0066 —0.4987 0.1789 —0.0318 0.1476
—0.1461 0.0440 —0.0226 —0.0749 —0.0456
—0.0204 —0.0085 0.2014 -0.0767 —-0.0789

RATIO OF COEFFICIENTS TO (1.96*STANDARD ERROR)

—2.0833 0.3703 —0.8941 —0.2251 0.6875

0.1423 0.1522 —0.3487 0.7124 —0.4061
—0.0353 —2.6529 0.8623 —0.1522 0.7068
—0.6944 0.2076 —0.1065 —0.3532 —0.2147
—0.0960 —0.0402 0.9475 —0.3563 —-0.3659

The estimated white noise variance is 0.00115 and the AICC value is —440.93, which
is not as good as that of the AR(12) model. Later we shall find a subset MA(25) model
that has a smaller AICC value than both of these models.

O

E.3.5 The AICC Statistic

The AICC statistic for the model with parameters p, g, ¢, and 6 is defined (see
Section 5.5.2) as

AICC(¢,0) = —2InL(¢, 0,5(¢p,0)/n) +2(p+q+ )n/(n —p — g —2),

and a model chosen according to the AICC criterion minimizes this statistic.
Model-selection statistics other than AICC are also available in ITSM. A Bayesian
modification of the AIC statistic known as the BIC statistic is also computed in the
option Model>Estimation>Max likelihood. It is used in the same way as
the AICC.
An exhaustive search for a model with minimum AICC or BIC value can be
very slow. For this reason the sample ACF and PACF and the preliminary estimation
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techniques described above are useful in narrowing down the range of models to
be considered more carefully in the maximum likelihood estimation stage of model
fitting.

E.3.6 Changing Your Model

The model currently stored by the program can be checked at any time by selecting
Model>Specify. Any parameter can be changed in the resulting dialog box,
including the white noise variance. The model can be filed together with the data for
later use by selecting File>Project>Save as and specifying a file name with
suffix .TSM.

We shall now set some of the coefficients in the current model to zero. To do this choose
Model>Specify and click on the box containing the value —0.35676 of Theta(1).
Press Enter, and the value of Theta(2) will appear in the box. Set this to zero. Press
Enter again, and the value of Theta(3) will appear. Continue to work through the
coefficients, setting all except Theta(1), Theta(3), Theta(12), and Theta(23) equal to
zero. When you have reset the parameters, click OK, and the new model stored in ITSM
will be the subset MA(23) model

X, = Z,—0.357Z_; — 0.163Z,_3 — 0.499Z,_1» + 0.201Z,_3,
where {Z,} ~ WN(0, 0.00115).

E.3.7 Maximum Likelihood Estimation

Once you have specified values of p and g and possibly set some coefficients to zero,
you can carry out efficient parameter estimation by selecting Model>Estimation>
Max likelihood or equivalently by pressing the blue MLE button.

The resulting dialog box displays the default settings, which in most cases will not
need to be modified. However, if you wish to compute the likelihood without maxi-
mizing it, check the box labeled No optimization. The remaining information
concerns the optimization settings. (With the default settings, any coefficients that are
set to zero will be treated as fixed values and not as parameters. Coefficients to be
optimized must therefore not be set exactly to zero. If you wish to impose further
constraints on the optimization, press the Constrain optimization button.
This allows you to fix certain coefficients or to impose multiplicative relationships
on the coefficients during optimization.)

To find the maximum likelihood estimates of your parameters, click OK, and the
estimated parameters will be displayed. To refine the estimates, repeat the estimation,
specifying a smaller value of the accuracy parameter in the Maximum Likelihood
dialog box.

To find the maximum likelihood estimates of the parameters in the model for the
logged, differenced, and mean-corrected airline passenger data currently stored in
ITSM, press the blue MLE button and click OK. The following estimated parameters
and diagnostic statistics will then be displayed:
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Example E.3.5.

ARMA MODEL.:

Xt)=Z(t)+(—.355) «Z(t — 1)+ (—.201) * Z(t — 3)+(—.523) * Z(t — 12)
+H.242) % Z(t — 23)

WN Variance = .001250

MA Coefficients

THETA( 1)=-.355078 THETA( 3)=-.201125
THETA(12)=-.523423 THETA(23)= .241527
Standard Error of MA Coefficients

THETA( 1): .059385 THETA( 3): .059297
THETA(12): .058011 THETA(23): .055828

(Residual SS)/N = .125024E—02
AICC = -.486037E+03
BIC =-.487622E+03

-2 Ln(Likelihood)= -.496517E+03
Accuracy parameter = .00205000

Number of iterations = 5

Number of function evaluations = 46
Optimization stopped within accuracy level.

The last message indicates that the minimum of —2 In L has been located with the
specified accuracy. If you see the message

Iteration limit exceeded,
then the minimum of —2 In L could not be located with the number of iterations (50)
allowed. You can continue the search (starting from the point at which the iterations
were interrupted) by pressing the MLE button to continue the minimization and

possibly increasing the maximum number of iterations from 50 to 100.
0

E.3.8 Optimization Results

After maximizing the Gaussian likelihood, ITSM displays the model parameters (coef-
ficients and white noise variance), the values of —2 In L, AICC, BIC, and information
regarding the computations.

The next stage of the analysis is to consider a variety of competing models and to select
the most suitable. The following table shows the AICC statistics for a variety of subset
moving average models of order less than 24.

Lags AICC
1 3 12 23 —486.04
1 3 12 13 23 —485.78
1 3 5 12 23 —489.95
1 3 12 13 —482.62
1 12 —475.91

The best of these models from the point of view of AICC value is the one with
nonzero coefficients at lags 1, 3, 5, 12, and 23. To obtain this model from the one
currently stored in ITSM, select Model>Specify, change the value of THETA(S)
from zero to .001, and click OK. Then reoptimize by pressing the blue MLE button and
clicking OK. You should obtain the noninvertible model
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X, =7,—0.434Z,_1 — 0.305Z;_5 + 0.238Z,_5 — 0.656Z,_1, + 0.351Z,_»3,

where {Z,} ~ WN(0, 0.00103). For future reference, file the model and data as AIR-
PASS2.TSM using the option File>Project>Save as.
g
The next step is to check our model for goodness of fit.

E.4 Testing Your Model

Once we have a model, it is important to check whether it is any good or not. Typically
this is judged by comparing observations with corresponding predicted values obtained
from the fitted model. If the fitted model is appropriate then the prediction errors should
behave in a manner that is consistent with the model. The residuals are the rescaled
one-step prediction errors,

Wt =X; _}A(t)/«/’”t— )

where X, is the best linear mean-square predictor of X; based on the observations up
totimet — 1, r_; = EX; — )A(,)2 /o? and o2 is the white noise variance of the fitted
model.

If the data were truly generated by the fitted ARMA (p, ¢) model with white noise
sequence {Z;}, then for large samples the properties of {Wt} should reflect those of {Z,}.
To check the appropriateness of the model we therefore examine the residual series
{W,}, and check that it resembles a realization of a white noise sequence.

ITSM provides a number of tests for doing this in the Residuals Menu, which
is obtained by selecting the option Statistics>Residual Analysis. Within
this option are the suboptions

Plot

QQ-Plot (normal)
QQ-Plot (t-distr)
Histogram
ACF/PACF

ACF Abs vals/Squares
Tests of randomness

E.4.1 Plotting the Residuals

Select Statistics>Residual Analysis>Histogram, and you will see
a histogram of the rescaled residuals, defined as

Rt = WI/ o,
where n6? is the sum of the squared residuals. If the fitted model is appropriate, the
histogram of the rescaled residuals should have mean close to zero. If in addition the
data are Gaussian, this will be reflected in the shape of the histogram, which should
then resemble a normal density with mean zero and variance 1.
Select Statistics>Residual Analysis>Plot and you will see a graph
of R, vs. t. If the fitted model is appropriate, this should resemble a realization of

a white noise sequence. Look for trends, cycles, and nonconstant variance, any of
which suggest that the fitted model is inappropriate. If substantially more than 5 % of
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Figure E-6
Histogram of the
rescaled residuals
from AIRPASS.MOD

Example E.4.1.

Example E.4.2.
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the rescaled residuals lie outside the bounds 4-1.96 or if there are rescaled residuals
far outside these bounds, then the fitted model should not be regarded as Gaussian.

Compeatibility of the distribution of the residuals with either the normal distribution
or the r-distribution can be checked by inspecting the corresponding qq plots and
checking for approximate linearity. To test for normality, the Jarque—Bera statistic is
also computed.

The histogram of the rescaled residuals from our model for the logged, differenced,
and mean-corrected airline passenger series is shown in Figure E-6. The mean is close
to zero, and the shape suggests that the assumption of Gaussian white noise is not
unreasonable in our proposed model.

The graph of R, vs. t is shown in Figure E-7. A few of the rescaled residuals
are greater in magnitude than 1.96 (as is to be expected), but there are no obvious
indications here that the model is inappropriate. The approximate linearity of the
normal qq plot and the Jarque-Bera test confirm the approximate normality of the

residuals.
O

E.4.2 ACF/PACF of the Residuals

If we were to assume that our fitted model is the true process generating the data, then
the observed residuals would be realized values of a white noise sequence.

In particular, the sample ACF and PACF of the observed residuals should lie within
the bounds +1.96/,/n roughly 95 % of the time. These bounds are displayed on the
graphs of the ACF and PACF. If substantially more than 5 % of the correlations are
outside these limits, or if there are a few very large values, then we should look for
a better-fitting model. (More precise bounds, due to Box and Pierce, can be found in
Brockwell and Davis (1991) Section 10.4.)

Choose Statistics>Residual Analysis>ACF/PACF,or equivalently press
the middle green button at the top of the ITSM window. The sample ACF and PACF
of the residuals will then appear as shown in Figures E-8 and E-9. No correlations
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are outside the bounds in this case. They appear to be compatible with the hypothesis
that the residuals are in fact observations of a white noise sequence. To check for
independence of the residuals, the sample autocorrelation functions of their absolute
values and squares can be plotted by clicking on the third green button.

O

E.4.3 Testing for Randomness of the Residuals

The option Statistics>Residual Analysis>Tests of Randomness
carries out the six tests for randomness of the residuals described in Section 5.3.3.

Example E.4.3. The residuals from our model for the logged, differenced, and mean-corrected series
AIRPASS.TSM are checked by selecting the option indicated above and selecting the
parameter h for the portmanteau tests. Adopting the value 7 = 25 suggested by ITSM,
we obtain the following results:
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Figure E-9
Sample PACF of
the residuals from
AIRPASS.MOD
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RANDOMNESS TEST STATISTICS (see Section 5.3.3)

LJUNG-BOX PORTM.= 13.76 CHISQUR( 20), p-value = 0.843
MCLEOD-LI PORTM.= 17.39 CHISQUR( 25), p-value = 0.867
TURNING POINTS = 87. ANORMAL( 86.00, 4.79%*2), p-value = 0.835
DIFFERENCE-SIGN = 65. ANORMAL( 65.00, 3.32%*2), p-value = 1.000
RANK TEST = 3934. ANORMAL(4257.50, 251.3%%2), p-value = 0.198
JARQUE-BERA =4.33 CHISQUR(2) p-value =0.115
ORDER OF MIN AICC YW MODEL FOR RESIDUALS =0

Every test is easily passed by our fitted model (with significance level & = 0.05), and
the order of the minimum-AICC AR model for the residuals supports the compatibility
of the residuals with white noise. For later use, file the residuals by pressing the red
EXP button and exporting the residuals to a file with the name AIRRES.TSM.

O

One of the main purposes of time series modeling is the prediction of future observa-
tions. Once you have found a suitable model for your data, you can predict future
values using the option Forecasting>ARMA. (The other options listed under
Forecasting refer to the methods of Chapter 10.)

E.5.1 Forecast Criteria

Given observations X1, ..., X, of a series that we assume to be appropriately modeled
as an ARMA(p, g) process, ITSM predicts future values of the series X1 from the
data and the model by computing the linear combination P, (X, ;) of X1, ..., X, that
minimizes the mean squared error E(X,,, — P, (X,1+h))2.
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Example E.5.1.

E.5.2 Forecast Results

Assuming that the current data set has been adequately fitted by the current
ARMA(p, g) model, choose Forecasting>ARMA, and you will see the ARMA
Forecast dialog box.

You will be asked for the number of forecasts required, which of the transfor-
mations you wish to invert (the default settings are to invert all of them so as to
obtain forecasts of the original data), whether or not you wish to plot prediction
bounds (assuming normality), and if so, the confidence level required, e.g., 95 %. After
providing this information, click OK, and the data will be plotted with the forecasts
(and possibly prediction bounds) appended. As is to be expected, the separation of the
prediction bounds increases with the lead time / of the forecast.

Right-click on the graph, select Info, and the numerical values of the predictors
and prediction bounds will be printed.

We left our logged, differenced, and mean-corrected airline passenger data stored in
ITSM with the subset MA(23) model found in Example D.3.5. To predict the next
24 values of the original series, select Forecasting>ARMA and accept the default
settings in the dialog box by clicking OK. You will then see the graph shown in
Figure E-10. Numerical values of the forecasts are obtained by right-clicking on the
graph and selecting Info. The ARMA Forecast dialog box also permits using a
model constructed from a subset of the data to obtain forecasts and prediction bounds

for the remaining observed values of the series.
0

E.6 Model Properties

Figure E-10

The original AIRPASS
data with 24
forecasts appended

ITSM can be used to analyze the properties of a specified ARMA process without
reference to any data set. This enables us to explore and compare the properties
of different ARMA models in order to gain insight into which models might best
represent particular features of a given data set.
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Example E.6.1.

For any ARMA(p, q) process or fractionally integrated ARMA(p, q) process
with p < 27 and ¢ < 27, ITSM allows you to compute the autocorrelation and
partial autocorrelation functions, the spectral density and distribution functions, and
the MA(c0) and AR(o0) representations of the process. It also allows you to generate
simulated realizations of the process driven by either Gaussian or non-Gaussian noise.
The use of these options is described in this section.

We shall illustrate the use of ITSM for model analysis using the model for the trans-
formed series AIRPASS.TSM that is currently stored in the program.
O

E.6.1 ARMA Models

For modeling zero-mean stationary time series, ITSM uses the class of ARMA (and
fractionally integrated ARMA) processes. ITSM enables you to compute characteris-
tics of the causal ARMA model defined by

X=X 1+ Xi 24+ ¢pXt—p +Zi+ 012+ 602+ + Gth—cp

or more concisely ¢ (B)X; = 6(B)Z,, where {Z,;} ~ WN (0, 02) and the parameters are
all specified. (Characteristics of the fractionally integrated ARIMA(p, d, g) process
defined by

(1-B)¢(B)X, = 60(B)Z,, |d| <0.5,

can also be computed.)

ITSM works exclusively with causal models. It will not permit you to enter a model
for which 1 —¢z—- - - —¢,2” has a zero inside or on the unit circle, nor does it generate
fitted models with this property. From the point of view of second-order properties, this
represents no loss of generality (Section 3.1). If you are trying to enter an ARMA(p, q)
model manually, the simplest way to ensure that your model is causal is to set all the
autoregressive coefficients close to zero (e.g., .001). ITSM will not accept a noncausal
model.

ITSM does not restrict models to be invertible. You can check whether or not the
current model is invertible by choosing Model>Specify and pressing the button
labeled Causal/Invertible in the resulting dialog box. If the model is noninvertible, i.e.,
if the moving-average polynomial 1+ 6,z + - - - + 6,27 has a zero inside or on the unit
circle, the message Non-invertible will appear beneath the box containing the
moving-average coefficients. (A noninvertible model can be converted to an invertible
model with the same autocovariance function by choosing Model>Switch to
invertible. If the model is already invertible, the program will tell you.)

E.6.2 Model ACF, PACF

The model ACF and PACF are plotted using Model >ACF/PACF >Model.If you wish
to change the maximum lag from the default value of 40, select Mode1l >ACF/PACF >
Specify Lag and enter the required maximum lag. (It can be much larger than 40,
e.g., 10,000). The graph will then be modified, showing the correlations up to the
specified maximum lag.

If there is a data file open as well as a model in ITSM, the model ACF and PACF
can be compared with the sample ACF and PACF by pressing the third yellow button
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at the top of the ITSM window. The model correlations will then be plotted in red, with
the corresponding sample correlations shown in the same graph but plotted in green.
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The sample and model ACF and PACF for the current model and transformed series
AIRPASS.TSM are shown in Figures E-11 and E-12. They are obtained by pressing
the third yellow button at the top of the ITSM window. The vertical lines represent the
model values, and the squares are the sample ACF/PACF. The graphs show that the
data and the model ACF both have large values at lag 12, while the sample and model
partial autocorrelation functions both tend to die away geometrically after the peak at
lag 12. The similarities between the graphs indicate that the model is capturing some

of the important features of the data.
O
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Example E.6.3.

E.6.3 Model Representations

As indicated in Section 3.1, if {X;} is a causal ARMA process, then it has an MA(00)
representation

(0.¢]
X = ZW/Zz—j, t=0,%1,4£2,...,
Jj=0

o0
where ) |y;| < oo and ¥y = 1.
Jj=0
Similarly, if {X;} is an invertible ARMA process, then it has an AR(co) represen-
tation

o
Zi=Y mX.j, t=0,£1%2,. ..,
j=0

where } ) 7| < oo and 7o = 1.

For any specified causal ARMA model you can determine the coefficients in
these representations by selecting the option Model>AR/MA Infinity. (If the
model is not invertible, you will see only the MA (oco) coefficients, since the AR(c0)
representation does not exist in this case.)

The current subset MA(23) model for the transformed series AIRPASS.TSM does not
have an AR(0c0) representation, since it is not invertible. However, we can replace the
model with an invertible one having the same autocovariance function by selecting
Model>Switch to Invertible. For this model we can then find an AR(c0)
representation by selecting Model>AR Infinity. This gives 50 coefficients,
the first 20 of which are shown below.

MA — Infinity AR — Infinity

J psij) pi(j)
0 1.00000 1.00000
1 —0.36251 0.36251
2 0.01163 0.11978
3 —0.26346 0.30267
4 —0.06924 0.27307
5 0.15484  —0.00272
6 —0.02380 0.05155
7 —0.06557 0.16727
8 —0.04487 0.10285
9 0.01921 0.01856
10 —0.00113 0.07947
11 0.01882 0.07000
12 —0.57008 0.58144
13 0.00617 0.41683
14 0.00695 0.23490
15 0.03188 0.37200
16 0.02778 0.38961
17 0.01417 0.10918
18 0.02502 0.08776
19 0.00958 0.22791
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E.6.4 Generating Realizations of a Random Series

ITSM can be used to generate realizations of a random time series defined by the
currently stored model.

To generate such a realization, select the option Model>Simulate,and you will
see the ARMA Simulation dialog box. You will be asked to specify the number of
observations required, the white noise variance (if you wish to change it from
the current value), and an integer-valued random number seed (by specifying and
recording this integer with up to nine digits you can reproduce the same realization
at a later date by reentering the same seed). You will also have the opportunity to add
a specified mean to the simulated ARMA values. If the current model has been fitted to
transformed data, then you can also choose to apply the inverse transformations to the
simulated ARMA to generate a simulated version of the original series. The default
distribution for the white noise is Gaussian. However, by pressing the button Change
noise distribution you can select from a variety of alternative distributions
or by checking the box Use Garch model for noise process you can
generate an ARMA process driven by GARCH noise. Finally, you can choose whether
the simulated data will overwrite the data set in the current project or whether they will
be used to create a new project. Once you are satisfied with your choices, click OK,
and the simulated series will be generated.

Example E.6.4. To generate a simulated realization of the series AIRPASS.TSM using the current
model and transformed data set, select the option Model>Simulate. The default
options in the dialog box are such as to generate a realization of the original series as
a new project, so it suffices to click OK. You will then see a graph of the simulated
series that should resemble the original series AIRPASS.TSM.

t

E.6.5 Spectral Properties

Spectral properties of both data and fitted ARMA models can also be computed and
plotted with the aid of ITSM. The spectral density of the model is determined
by selecting the option Spectrum>Model. Estimation of the spectral density
from observations of a stationary series can be carried out in two ways, either by
fitting an ARMA model as already described and computing the spectral density
of the fitted model (Section 4.4) or by computing the periodogram of the data
and smoothing (Section 4.2). The latter method is applied by selecting the option
Spectrum>Smoothed Periodogram. Examples of both approaches are given
in Chapter 4.

E.7 Multivariate Time Series

Observations {xi,...,x,} of an m-component time series must be stored as
an ASCII file with » rows and m columns, with at least one space between
entries in the same row. To open a multivariate series for analysis, select
File>Project>Open>Multivariate and click OK. Then double-click on
the file containing the data, and you will be asked to enter the number of columns (72)
in the data file. After doing this, click OK, and you will see graphs of each component
of the series, with the multivariate tool bar at the top of the ITSM screen. For examples
of the application of ITSM to the analysis of multivariate series, see Chapter 8.
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Accidental deaths (DEATHS.TSM), 2, 11, 27, 28,
96, 180, 183, 313, 315, 317
ACF. See Autocorrelation function (ACF)
AIC, 149, 152
AICC, 125, 134, 137, 142, 151, 153, 167, 248, 396
Airline passenger data (AIRPASS.TSM), 192, 278,
320, 386
All Ordinaries index, 228
All-star baseball games, 2, 7
Alternative hypothesis, 368
APPH.TSM, 256
APPLTSM, 256
APPJ.TSM, 350
APPJK2.TSM, 256
APPK.TSM, 350
Arbitrage, 221, 222, 224
ARAR algorithm, 310-313
forecasting, 311-312
application of, 312-313
ARCH(1) process, 197-199
ARCH(p) process, 197, 224
ARCH.TSM, 200
AR(1) process, 15, 46, 54,295
ACVF of, 46
causal, 47
confidence regions for coefficients, 142
estimation of mean, 51
estimation of missing value, 58, 282
observation driven model of, 295
plus noise, 69
prediction of, 57, 59
sample ACF of, 54
spectral density of, 103
state-space representation of, 261
with missing data, 58, 285, 287
with non-zero mean, 59-60
AR(2) process, 19, 7677
ACVF of, 80-82
AR(p) process. See Autoregressive (AR(p)) process
ARIMAC(1,1,0) process, 158
forecast of, 176177
ARIMA process
definition, 158
forecasting, 173-177
seasonal (see Seasonal ARIMA models)
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state-space representation of, 269
with missing observations, 280
with regression, 184, 203
ARIMA(p, d, q) process with (—.5 < d < .5). See
Fractionally integrated ARMA process
ARMAC(1, 1) process, 48-50, 66, 76
ACVF of, 78
causal, 49, 66
invertible, 49, 76
noncausal, 49, 118
noninvertible, 49, 118
prediction of, 89
spectral density of, 116
state-space representation of, 261-262
ARMA(p, q) process
ACVF of, 78-82
coefficients in AR representation, 77
coefficients in MA representation, 76
causal, 75
definition, 74
estimation
Hannan-Rissanen, 137-139
innovations algorithm, 132-137
least squares, 141
maximum likelihood, 139-140
existence and uniqueness of, 75
invertible, 76
multivariate (see Multivariate ARMA processes)
order selection, 124-129, 151
prediction, 91-96
seasonal (see Seasonal ARIMA models)
spectral density of, 115
state-space representation of, 267-268
with mean u, 74
Asymptotic relative efficiency, 129
Australian red wine sales (WINE.TSM), 2, 7, 18,
319, 320
Autocorrelation function (ACF)
definition, 16
sample ACF
of absolute values, 202-204, 396, 401
of squares, 200, 202-204, 401
approximate distribution of, 51
of MA(g), 79, 82
Autocovariance function (ACVF)
basic properties of, 39
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Autocovariance function (ACVF) (cont.)
characterization of, 41
definition, 13, 16, 45
nonnegative definite, 41
of ARMA processes, 78-87
of ARMAC(1, 1) process, 80
of AR(2) process, 81
of MA(g) process, 79
of MA(1) process, 15, 42
sample, 59-60
spectral representation of, 101
Autofit
for ARMA fitting, 122, 142, 143, 167-169, 187,
203, 341, 392
for fractionally integrated ARMA, 341
Autoregressive integrated moving-average. See
ARIMA process

Autoregressive moving-average. See ARMA process

Autoregressive polynomial, 74-77, 143, 160, 162,
169, 170, 304, 346
Autoregressive (AR(p)) process, 74
estimation of parameters
Burg, 122
maximum likelihood, 142-143, 149
with missing observations, 284
Yule-Walker, 123124
large-sample distributions, 124
confidence intervals, 131
one-step prediction of, 59
order selection, 134, 149, 150
minimum AICC model, 153
multivariate (see Multivariate AR models)
partial autocorrelation function of, 83
prediction of, 89
state-space representation, 266267
subset models, 309, 311
unit roots in, 170
Yule-Walker equations, 124, 128
Autoregressive process of infinite order (AR(00)),
236

B
Backward prediction errors, 130
Backward shift operator, 25, 44, 48, 74, 207, 311,
339
Bandwidth, 109
Bartlett’s formula, 53
AR(1), 54
independent white noise, 53
MA(1), 53
multivariate, 240
Bayesian state-space model, 289
BEER.TSM, 192
Best linear predictor, 40, 246247
Beta function, 307
Beta-binomial distribution, 307
BIC criterion, 149, 152
Bilinear model, 338
Binary process, 7
Binomial distribution, 353
Bispectral density, 337
Bivariate normal distribution, 359-360
Bivariate time series
covariance matrix, 228

mean vector, 228

(weakly) stationary, 228
Box-Cox transformation, 165, 388, 389
Brownian motion, 213, 375-379
Burg’s algorithm, 129-132

C
CAR(1) process, 343-345
estimation of, 344
CARMA(p, g) process, 345
autocovariance function of, 347
mean of, 346, 347
with thresholds, 347
Cauchy criterion, 371-372
Causal
ARCH(1) process, 198, 199
ARMA process, 75
GARCH process, 208, 209
multivariate ARMA process, 244
time-invariant linear filter, 112
Chaotic deterministic sequence, 335-337
Checking for normality, 32
Chi-squared distribution, 31, 125, 353, 361
Classical decomposition, 20, 26, 29, 165, 389,
390
Cochran and Orcutt procedure, 186
Cointegration, 254-255
Cointegration vector, 254, 255
Compound Poisson process, 214-215
Conditional density, 289, 294, 299, 356
Conditional expectation, 40, 149, 285, 289, 357
Confidence interval, 367-368
large-sample confidence region, 368
Conjugate family of priors, 297
Consistent estimator, 108, 133, 237
Continuous distributions
chi-squared, 353
exponential, 352
gamma, 352-353
normal, 352
uniform, 352
Continuous spectrum, 101

Continuous-time ARMA process. See CARMA(p, q)

process
Continuous-time models, 212-220
CAR(1), 343
Covariance function, 13. See also Autocovariance
function (ACVF)
Covariance matrix, 376
factorization of, 358
properties of, 358
square root of, 358
Cumulant, 337, 350
kth-order, 337

D
Delay parameter, 325, 327, 331
Design matrix, 184-186
Deterministic, 67
Diagnostic checking, 144-147. See also Residuals
Difference operator
first-order, 25
with positive lag d, 28
with real lag d, 28, 343
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Differencing to generate stationary data, 12
at lag d, 28
Dirichlet kernel, 114
Discrete distributions
binomial, 353
negative binomial, 353-354, 361
Poisson, 353
uniform, 353
Discrete Fourier transform, 107
Discrete spectral average. See Spectral density
function
Distribution function, 351-355. See also Continuous
distributions; Discrete distributions
properties of, 351
Dow-Jones Utilities Index (DOWIJ.TSM), 126-128,
131, 134-137, 143, 176, 177
Dow-Jones and All ordinaries Indices, (DJAO2.TSM,
DJAOPC2.TSM), 228-229, 249, 251-253
Durbin-Levinson algorithm, 60-62, 64, 65, 125, 126,
132, 133, 247

E
EGARCH (p, g) process, 205
Elementary function, 377-379
EM algorithm, 260, 285-288

Monte Carlo (MCEM), 293
Embedded discrete-time process, 344
Equivalent martingale measure, 223
Error probabilities, 389-390

type I, 369

type 11, 369
Estimation of missing values

in an ARIMA process, 284

in an AR(p) process, 285

in a state-space model, 283
Estimation of the white noise variance

least squares, 140

maximum likelihood, 141

using Burg’s algorithm, 130

using the Hannan-Rissanen algorithm, 138

using the innovations algorithm, 136

using the Yule-Walker equations, 124
European call option, 221, 223
Expectation, 351-355
Exponential distribution, 352
Exponential family models, 296-303
Exponential smoothing, 21, 23, 316

F
FIGARCH (p, d, g) process, 209
Filter. See Linear filter
Financial data, 195-226
Fisher information matrix, 367
Forecasting, 12, 55-67, 147-148. See also Prediction
Forecasting ARIMA processes, 173-177
forecast function, 182-183
h-step predictor, 175
mean square error of, 174
forecast density, 289
forward prediction errors, 130
Fourier frequencies, 107, 109
Fourier indices, 11
Fractionally integrated ARMA process, 339
estimation of, 340

spectral density of, 340
Whittle likelihood approximation, 340
Fractionally integrated white noise, 339
autocovariance of, 339
variance of, 339
Frequency domain, 97, 236

G
Gamma distribution, 206, 218, 295, 352
Gamma function, 339, 352
GARCH(p, g) process, 200

ARMA model with GARCH noise, 203-204

fitting GARCH models, 201-203

Gaussian-driven, 203

generalizations, 203

regression with GARCH noise, 203

t—driven, 203
Gaussian likelihood

in time series context, 367

of a CAR(1) process, 343-344

of a multivariate AR process, 248

of an ARMA(p, ¢) process, 140

with missing observations, 281-283

of GARCH model, 340

of regression with ARMA errors, 186, 187
Gaussian linear process, 334, 335, 337
Gaussian time series, 40, 42, 139, 242, 361
Gauss-Markov theorem, 365, 367
Generalized distribution function, 101
Generalized error distribution (GED), 206
Generalized least squares (GLS) estimation, 184-186
Generalized inverse, 184, 271, 304
Generalized state-space models

Bayesian, 289

filtering, 289, 290

forecast density, 289

observation-driven, 294-295

parameter-driven, 288-294

prediction, 289, 290
Geometric Brownian motion (GBM), 195, 196,

215-217, 381, 382
Gibbs phenomenon, 114
Goals scored by England against Scotland, 299-302
Goodness of fit based on ACF, 18—19. See also Tests
of randomness

H
Hannan-Rissanen algorithm, 122, 136, 137-139
Harmonic regression, 10-12
Hessian matrix, 142, 187
Hidden process, 289
Holt-Winters algorithm, 314-317
seasonal, 317-318
Hypothesis testing, 368-370
large-sample tests based on confidence regions,
369-370
uniformly most powerful test, 369

1
IARCH(00) process, 209
IGARCH(p, g) process, 208
Independent random variables, 30, 36, 214
Identification techniques, 163—169
for ARMA processes, 164



422

Index

Identification techniques (cont.)
for AR(p) processes, 142
for MA(g) processes, 153
for seasonal ARIMA processes, 177
IGARCH(p, g) process, 208, 209
iid noise, 6-7, 14
sample ACF of, 53
multivariate, 235
Innovations, 62, 271
Innovations algorithm, 62—65, 132—137
fitted innovations MA(m) model, 133
multivariate, 247
Input, 45, 112, 333
Integrated volatility, 217, 218, 220, 226
Intervention analysis, 331-334
Invertible
ARMA process, 76
multivariate ARMA process, 244
Investment strategy, 221, 222, 224
1td calculus, 373
1t6 integral, 343, 375-379
1t6 process, 379-380
1t6’s formula, 380
1td stochastic differential equation, 381-383
ITSM, 27-33, 37, 122, 125-127, 165, 327, 329,
385407

J
Joint distributions of a time series, 6
Joint distribution of a random vector, 355

K
Kalman recursions

filtering, 271, 274

prediction, 271

h—step, 272-275

smoothing, 271, 275
Kullback-Leibler discrepancy, 151
Kullback-Leibler index, 151, 152

L

Lake Huron (LAKE.TSM), 9-10, 18-19, 54, 189,

191
Latent process, 289
Large-sample tests based on confidence regions,
369-370
Least squares estimation
for ARMA processes, 141
for regression model, 186
for transfer function models, 326
of trend, 8
Lévy process, 195, 212-218, 347-350, 375-377
Lévy-Itd decomposition, 214
Lévy-Khinchin representation, 374
Lévy market model (LMM), 216
Lévy measure, 374
Likelihood function, 277, 292, 366. See also
Gaussian likelihood
Linear combination of sinusoids, 101-103
Linear difference equations, 47, 175
Linear filter, 36, 45, 48, 74
input, 45
low-pass, 23, 114

moving-average, 22, 36

output, 45

simple moving-average, 112-114
Linear process, 44, 335

ACVF of, 46

Gaussian, 334

multivariate, 235
Linear regression. See Regression
Local level model, 264
Local linear trend model, 264, 265, 304, 315
Log asset price, 195, 197, 212, 216
Log return, 195-197, 209, 219
Logistic equation, 335, 336
Lognormal SV process, 210, 211-212, 274
Long memory, 207-209, 310, 323
Long-memory model, 338-342

M
MA(1) process
ACF of, 42
estimation of missing values, 71
moment estimation, 128-129
noninvertible, 85, 95
order selection, 128-129
PACEF of, 84
sample ACF of, 53
spectral density of, 105-106
state-space representation of, 273
MA(g). See Moving average (MA(q)) process
MA(00), 44
multivariate, 235
Market price of risk, 224
Martingale difference sequence, 334
Maximum likelihood estimation, 366367
ARMA processes, 140
large-sample distribution of, 142
confidence regions for, 142-144
Mean
of a multivariate time series, 236
estimation of, 236-243
of a random variable, 352, 354
of a random vector, 357
estimation of, 50
sample, 50
large-sample properties of, 51, 236
Mean square convergence, 65, 371-372
properties of, 372, 378
Measurement error, 84—86, 172
Memory shortening, 309, 310
Method of moments estimation, 85, 129
Minimum AICC AR model, 147, 256, 396,
402
Mink trappings (APPH.TSM), 256
Missing values in ARMA processes
estimation of, 283-285
likelihood calculation with, 281-283
Mixture distribution, 354
Monte Carlo EM algorithm (MCEM), 293
Moving average (MA(g)) process, 43
ACF of, 79
sample, 82
ACVF of, 79
estimation
confidence intervals, 143
Hannan-Rissanen, 137
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innovations, 133
maximum likelihood, 140, 142
order selection, 133, 134
partial autocorrelation of, 83
unit roots in, 171-173
Multivariate AR process
estimation, 247-249
Burg’s algorithm, 248
maximum likelihood, 248
Whittle’s algorithm, 248
forecasting, 250-254
error covariance matrix of prediction, 251
Multivariate ARMA process, 243-246
causal, 244
covariance matrix function of, 245-246
estimation
maximum likelihood, 248
invertible, 244
prediction, 246247
error covariance matrix of prediction, 252
Multivariate innovations algorithm, 247
Multivariate normal distribution
bivariate, 359-360
conditional distribution, 360
conditional expectation, 357
density function, 356
definition, 358
singular, 359
standardized, 359
Multivariate time series, 223
covariance matrices of, 228, 233, 235
mean vectors of, 228, 233, 235
second-order properties of, 232-236
stationary, 233
Multivariate white noise, 227, 235, 243
Muskrat trappings (APPL.TSM), 256

N

Negative binomial distribution, 292, 353, 361

NILE.TSM, 340-342

NOISE.TSM, 326, 333

Non-anticipating integrand, 376

Nonlinear models, 334-338

Nonnegative definite matrix, 357, 358

Nonnegative definite function, 41

Normal distribution, 352, 355

Normal equations, 363, 364

Null hypothesis, 34, 147, 170, 172, 337, 368,
369

(0}
Observation equation, 260
of CARMA(p, ¢) model, 345
Ordinary least squares (OLS) estimators, 170, 184,
185, 363
One-step predictors, 60, 63, 88, 136, 140, 149, 174,
252,271, 280, 281, 302
Order selection, 124, 133, 137, 141, 149-153
AIC, 149, 152
AICC, 149, 151-153
BIC, 149, 152
consistent, 152
efficient, 152
FPE, 149-150

Ornstein-Uhlenbeck process, 217, 218, 220, 225, 343
Ornstein-Uhlenbeck SV model, 219

Orthogonal increment process, 103

Orthonormal set, 107

Overdifferencing, 169, 171

Overdispersed, 299

Overshorts (OSHORTS.TSM), 84-86, 128, 147, 148,

172, 187-188

structural model for, 85

P
Partial autocorrelation function (PACF), 62, 83-84
estimation of, 85
of an AR(p) process, 83
of an MA(1) process, 84
sample, 83, 84
Periodogram, 106-111, 208, 340
approximate distribution of, 108
Point estimate, 367
Poisson distribution, 296, 299, 300, 355
Poisson exponential family model, 296
Poisson process, 195, 213-215, 217, 351, 374
Polynomial fitting, 24-25
Population of USA (USPOP.TSM), 4, 8-9, 25-26
Portmanteau test for residuals. See Tests of
randomness
Posterior distribution, 289, 294, 297, 298, 306,
307
Power function, 369
Power steady model, 298, 299
Prediction of stationary processes. See also Recursive
prediction
AR(p) processes, 89
ARIMA processes, 173-177
ARMA processes, 87-94
based on infinite past, 65
best linear predictor, 40
Gaussian processes, 94
prediction bounds, 94
large-sample approximations, 93
MA(g) processes, 89
multivariate AR processes, 250-254
one-step predictors, 57
mean squared error of, 92
seasonal ARIMA processes, 182—183
Prediction operator, 58—-60
properties of, 59
Preliminary transformations, 12, 20, 163
Prewhitening, 239, 324
Prior distribution, 289
Probability density function (pdf), 354
Probability generating function, 361
Probability mass function (pmf), 354
Purely nondeterministic, 67, 334

Q

g—dependent, 43

g-correlated, 43, 44

qq plot, 32, 147, 202-203, 401-402

R
R and S arrays, 157
Random noise component, 20, 389
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Random variable
continuous, 353, 354
discrete, 354, 355
Randomly varying trend and seasonality with noise,
266, 317
Random vector, 355-358
covariance matrix of, 357
joint distribution of, 355
mean of, 357
probability density of, 356
Random walk, 7, 14
simple symmetric, 7, 14
with noise, 263, 272, 278, 299
Rational spectral density. See Spectral density
function
Realization of a time series, 6, 409
Realized volatility, 217
Recursive prediction
Durbin-Levinson algorithm, 60, 247
Innovations algorithm, 64—65
Kalman prediction (see Kalman recursions)
multivariate processes
Durbin-Levinson algorithm, 247
innovations algorithm, 247
Regression
with ARMA errors, 184—191
best linear unbiased estimator, 185
Cochrane and Orcutt procedure, 185,
186
GLS estimation, 185
OLS estimation, 184
Rejection region, 368, 369
RES.TSM, 333, 334
Residuals, 30, 144
check for normality, 33, 147
graph of, 145
rescaled, 145
sample ACF of, 146
tests of randomness for, 146147
Risk-neutral, 224

S
Sales with leading indicator (LS2.TSM,
SALES.TSM, LEAD.TSM), 230—
232, 242-243, 249-250, 253-254,
326-327, 329-330
Sample
autocorrelation function, 1618
MA(g), 82
of residuals, 146
autocovariance function, 16
covariance matrix, 16
mean, 16
large-sample properties of, 50
multivariate, 228
partial autocorrelation, 83
SARIMA. See Seasonal ARIMA process
Seasonal adjustment, 5
Seasonal ARIMA process, 177-183
forecasting, 182-183
mean squared error of, 183
maximum likelihood estimation, 180, 181
Seasonal component, 20
estimation of, 21-25
method S1, 26-27

elimination of, 28
method S2, 28-30
Seat-belt legislation (SBL.TSM, SBL2.TSM),
189-191, 333-334
Second-order properties, 6
in frequency domain, 236
Self-financing condition, 221
Short memory, 313, 339
SIGNAL.TSM, 3, 33
Signal detection, 3
Significance level, 153, 369, 402
Size of a test, 369
Smoothing
by elimination of high-frequency components,
23-24
with a moving average filter, 21-23
exponential, 21, 23, 314, 316, 319
the periodogram (see Spectral density estimation)
using a simple moving average, 112
Spectral density estimation
discrete spectral average, 109
large-sample properties of, 110
rational, 117
Spectral density function, 98-106
characterization of, 99
of an ARMA(I, 1), 116
of an ARMA process, 115
of an AR(1), 103-105
of an AR(2), 116
of an MA(1), 105-106
of white noise, 103
properties of, 98
rational, 115
Spectral density matrix function, 236
Spectral distribution function, 101-103, 117
Spectral representation
of an autocovariance function, 101
of a covariance matrix function, 233
of a stationary multivariate time series, 233
of a stationary time series, 97
Spencer’s 15-point moving average, 22-23, 36
Spot volatility, 217
State equation, 260
of CARMA(p, g) model, 345
stable, 262, 267
State-space model, 259-307
estimation for, 275-280
stable, 262
stationary, 262
with missing observations, 280-285
State-space representation, 261
causal AR(p), 266-267
causal ARMA(p, ¢), 267-268
ARIMA(p, d, q), 268-269
Stationarity
multivariate, 227
strict, 13, 43, 361
weak, 13, 361
Steady-state solution, 273, 274, 305, 315
Stochastic differential equation, 196, 215, 218, 343,
345, 348, 383-385
first-order, 343
pth-order, 345
Stochastic volatility model, 197, 209-212, 217-220,
226,274
Stock market indices (STOCK7.TSM), 225, 257
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Strictly stationary series, 13, 43
properties of, 43
Strike price, 221
Strike time, 221
Strikes in the U.S.A. (STRIKES.TSM), 4, 22, 36,
96
Structural time series models, 85, 263
level model, 263-265
local linear trend model, 264, 265, 315
randomly varying trend and seasonality
with noise, 266, 278
estimation of, 275-280
seasonal series with noise, 265
Stylized features, 196, 204
Subordinator, 217
Sunspot numbers (SUNSPOTS.TSM), 70, 86-87,
110-111, 117, 153, 203, 204, 335

T
Testing for the independence of two stationary time
series, 239-240
Test for normality, 33, 147, 400
Tests of randomness
based on sample ACF, 30
based on turning points, 31-33, 146
difference-sign test, 32, 146
Jarque-Bera normality test, 33, 146
minimum AICC AR model, 147
portmanteau tests
Ljung-Box, 31, 146, 402
McLeod-Li, 31, 146, 402
rank test, 32, 146
Third-order central moment, 337
Third-order cumulant function, 337, 350
of linear process, 337, 350
Threshold model, 338
AR(p), 338
Time domain, 97, 248
Time-invariant linear filter (TLF), 111-115
causal, 112
transfer function, 113
Time series, 6
continuous-time, 1
discrete-time, 1
Gaussian, 40, 42, 361
Time series model, 6
Time series of counts, 292-294
Transfer function, 113-115
Transfer function model, 323-330
estimation of, 324-326
prediction of, 327-330

Transformations, 20, 163—-164, 388
variance-stabilizing, 165
Tree-ring widths (TRINGS.TSM), 351
Trend component, 7-10, 20
elimination of
in absence of seasonality, 21-25
by differencing, 25-26
estimation of
by elimination of high-frequency components,
23
by exponential smoothing, 23
by least squares, 10
by polynomial fitting, 24-25
by smoothing with a moving average, 21, 26

U
Uniform distribution, 352, 353
discrete, 353-354
Uniformly most powerful (UMP) test, 369
Unit roots
augmented Dickey-Fuller test, 170
Dickey-Fuller test, 170
in autoregression, 169—171
in moving-averages, 171-173
likelihood ratio test, 172
locally best invariant unbiased (LBIU) test, 173

\"
Variance, 352, 354
Volatility, 196, 209, 216, 349

w
Weight function, 109, 110
White noise, 14
multivariate, 235
spectral density of, 103
Whittle approximation to likelihood, 340
Wold decomposition, 44, 67, 334

Y
Yule-Walker estimation, 86, 123—124. See also
Autoregressive process and multivariate
AR process
for ¢ > 0, 128-129

V4
Zoom buttons, 388
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